ACE User Guide (UG070)

Achronix CAD Environment (v9.2)
Copyrights, Trademarks and Disclaimers

Copyright © 2023 Achronix Semiconductor Corporation. All rights reserved. Achronix, Speedster and VectorPath are registered trademarks, and Speedcore and Speedchip are trademarks of Achronix Semiconductor Corporation. All other trademarks are the property of their prospective owners. All specifications subject to change without notice.

NOTICE of DISCLAIMER: The information given in this document is believed to be accurate and reliable. However, Achronix Semiconductor Corporation does not give any representations or warranties as to the completeness or accuracy of such information and shall have no liability for the use of the information contained herein. Achronix Semiconductor Corporation reserves the right to make changes to this document and the information contained herein at any time and without notice. All Achronix trademarks, registered trademarks, disclaimers and patents are listed at http://www.achronix.com/legal.

Achronix Semiconductor Corporation

2903 Bunker Hill Lane
Santa Clara, CA 95054
USA

Website: www.achronix.com
E-mail : info@achronix.com
Table of Contents

Preface .................................................................................................................. 20
   About This Guide .............................................................................................. 20
   Related Documents ......................................................................................... 20
   Conventions Used in this Guide ...................................................................... 21

Chapter - 1: Getting Started ............................................................................... 22
   Introduction ...................................................................................................... 22
   ACE Quickstart Tutorial .................................................................................. 22
      1. Create your Project .................................................................................. 22
      2. Add your Design Files and Set Implementation Options ....................... 22
      3. Run the Flow ........................................................................................... 22
      4. Analyze the Results ............................................................................... 23
   Congratulations!!! ............................................................................................. 23

Chapter - 2: Concepts ......................................................................................... 24
   Workbench ........................................................................................................ 24
   Perspectives ...................................................................................................... 24
      Projects Perspective ...................................................................................... 24
      Floorplanner Perspective ............................................................................ 25
      IP Configuration Perspective ..................................................................... 25
   2D NoC Performance Perspective ................................................................... 26
   Programming and Debug Perspective ............................................................. 26
   HW Demo Perspective ...................................................................................... 26

Editors ................................................................................................................ 27
   HTML Report Browser ..................................................................................... 27
   Text Editor ........................................................................................................ 28
   VCD Waveform Editor ..................................................................................... 29

Views ................................................................................................................... 33
   Clock Domains View ....................................................................................... 36
   Clock Regions View ......................................................................................... 39
   Clusters View .................................................................................................. 45
   Critical Path Diagram View ............................................................................ 49
   Critical Paths View .......................................................................................... 52
   Download View ............................................................................................... 55
Floorplanner View ............................................................. 57
Flow View ........................................................................... 67
HW Demo View ................................................................. 71
I/O Designer Toolkit Views .................................................. 74
IP Diagram View ............................................................... 82
IP Libraries View ............................................................... 84
IP Problems View ............................................................. 84
Multiprocess View ............................................................. 86
Netlist Browser View ......................................................... 92
NoC Performance View ....................................................... 98
NoC Time Slice View ......................................................... 103
Options View ..................................................................... 106
Outline View ...................................................................... 115
Partitions View ................................................................... 115
Placement Regions View ................................................... 118
Projects View ..................................................................... 123
Properties View ................................................................ 127
Register Browser View ..................................................... 130
Search View ..................................................................... 132
Selection View .................................................................. 136
Snapshot Debugger View ................................................ 139
Tcl Console View ............................................................. 144
Dialogs ................................................................................. 146
Add Signals to Waveform Viewer Dialog .............................. 146
Add Source Files Dialog .................................................... 147
Assign Bussed Signal Names Dialog .................................... 149
Assign Bussed Values Dialog ............................................. 151
Configure Clock Pre-Routes Dialog .................................... 153
Configure Table Columns Dialog ........................................ 155
Create a New Constraints File Dialog ................................. 156
Create a New Flow Step dialog .......................................... 158
Create a New Text File Dialog ........................................... 159
Create a SecureShare Zip File Dialog ................................. 159
Create Implementation Dialog .......................................... 164
Create Placement Region Dialog ...................................... 165
Create Project Dialog ......................................................... 168
Generate a Pin Assignment Report Dialog............................. 169
Generate I/O Ring Design Files Dialog ................................. 169
Generate IP Design Files Dialog .................................................. 170
Load Acxdb Dialog ............................................................... 172
Load Project Dialog ............................................................. 173
New IP Configuration Dialog .................................................. 174
Plot Serdes Diagram Dialog .................................................... 175
Restore Implementation Dialog ............................................... 177
Save Changed Properties Dialog ............................................. 177
Save Implementation Dialog .................................................... 178
Save Placement Dialog .......................................................... 179
Save Placement Regions Dialog ............................................. 182
Save Script File As Dialog ..................................................... 183
Search Filter Builder Dialog ................................................... 183

Toolbars .................................................................................. 185

Preferences ............................................................................. 186
Configure DCC Connection Preference Page .......................... 186
Configure JTAG Connection Preference Page ......................... 187
Critical Path Diagram View Preference Page .......................... 189
Floorplanner View Colors and Layers Preference Page ........... 191
Floorplanner View Optimizations Preference Page ................ 196
I/O Designer Preference Page .................................................. 200
IP Diagram Preference Page .................................................. 200
Multiprocess: Configure Custom Job Submission Tool Preference Page .................................................. 202
Netlist Browser Preference Page ............................................. 204
NoC Performance View Preference Page ................................. 204
Other Colors and Fonts Preference Page ................................. 208
Package View Preference Page ............................................. 209
Placement Regions Preference Page ....................................... 209
Project Management Preference Page .................................. 211
Tcl Console View Preference Page ......................................... 213
Text Editors Preference Page ................................................ 214

Projects .................................................................................. 217
Implementations ..................................................................... 217
Project File ............................................................................. 218
Source Files ........................................................................... 219
IP Configurations .................................................................... 220
Port Mapping Files .................................................................. 220
Output Files ............................................................................ 220
## Log Files ................................................................. 220
Active Project and Implementation ..................................... 223

## Flow ................................................................. 223
Flow Steps .................................................................. 223
Flow Status ................................................................ 227
Flow Mode .................................................................. 228

## Reports ............................................................. 229
Utilization Report .......................................................... 229
Pin Assignment Report ...................................................... 229
Clock Report ................................................................ 229
Timing Report ................................................................ 229
Routing Report .............................................................. 230
Partitions Report .............................................................. 230
Power Dissipation Report ................................................... 230
Design Statistics Report .................................................... 239
Multiprocess Summary Report ............................................ 240
Implementation Options Report .......................................... 242

## Advanced Concepts ................................................. 242
ACE Verilog Attributes ..................................................... 242
Clock Regions ................................................................ 245
Instance States ............................................................... 245
Filter Properties .............................................................. 246
Timing Across All Temperature Corners .............................. 248
ECO Commands ............................................................... 249
Fabric Clusters ............................................................... 261

## Chapter - 3: Tasks .................................................. 262
Running ACE ............................................................... 262
GUI Mode ................................................................... 262
Command-line Mode ......................................................... 262
Batch Mode .................................................................. 263
Lab Mode (Reduced Functionality) ....................................... 263
ACE Initialization Script (ACE_INIT_SCRIPT) ......................... 263
ACE Startup Arguments ................................................... 264

## Working With Perspectives ........................................... 265
Switching Between Perspectives ............................................ 265
Resetting Perspectives ....................................................... 266

## Working with Views and Editors .................................. 266
Opening Views ......................................................... 266
Moving and Docking Views and Editors .......................... 266
Rearranging Tabbed Views and Editors .......................... 267
Detaching Views and Editors ....................................... 267
Tiling Editors .......................................................... 268
Maximizing, Minimizing, and Restoring Views and Editors . 268

Working with Projects and Implementations .................. 271
Creating Projects .................................................. 271
Saving Projects ...................................................... 272
Loading Projects .................................................... 273
Removing Projects .................................................. 275
Opening Project Files in an Editor ................................. 275
Adding Source Files ................................................ 275
Removing Source Files ............................................. 278
Opening Source Files in an Editor ............................... 279
Creating Implementations ........................................ 279
Saving Implementations .......................................... 279
Restoring Implementations ....................................... 280
Copying Implementations ......................................... 280
Setting the Active Implementation ............................... 281
Removing Implementations ....................................... 281
Configuring Implementation Options ............................ 281
Opening Output Files in an Editor ............................... 281
Opening Report Files in an Editor ............................... 281
Cleaning Projects ................................................... 282

Running the Flow .................................................... 283
Running the Entire Flow ............................................ 283
Running a Sub-Flow ................................................ 284
Running Multiple Flows in Parallel .............................. 285
Detecting Changes to Project Source Files ...................... 300
Custom Flow Steps ................................................ 306

Using the Tcl Console .............................................. 310
Sending Commands from GUI Actions .......................... 310
Sending Commands from the Console ........................... 310
Command Highlighting ............................................. 310
Command Auto-Completion ...................................... 310
Command Help ....................................................... 311
ACE User Guide (UG070)

Text Limit ................................................................. 312
Clearing the Console ............................................... 312
Viewing the ACE Log File ........................................ 313
Object Type Prefixes ............................................... 313

Creating an IP Configuration ..................................... 314
Creating and Naming an IP Configuration ..................... 315
Setting the IP Configuration ..................................... 315
Generating the IP Design Files ................................ 317
Adding Configuration Files to a Project ....................... 317
Live Link Tuning for SerDes and Derived Interfaces ........ 317

Viewing the Floorplanner .......................................... 320
Opening and Closing the Floorplanner’s Fly-Out Palette .... 320
Zooming the Floorplanner In and Out ......................... 320
Floorplanner Panning ............................................... 321
Selecting Floorplanner Objects .................................. 321
Deselecting Floorplanner Objects ............................... 322
Toggling Floorplanner Mouse Tools ............................ 322
Filtering the Floorplanner View ................................ 322
Choosing Floorplanner Object Tooltips ....................... 323
Viewing Floorplanner Object Labels ............................ 323
Highlighting Objects in the Floorplanner View .............. 323

Pre-Placing a Design .................................................. 326
Placing an Object ..................................................... 326
Changing Between Fixed and Soft Placement ................ 328
Group Placement Mode ............................................. 329
Removing Placement ............................................... 330
Saving Pre-Placement Constraints ............................. 331
Using Pre-Placement in the Flow ................................. 331

Analyzing Critical Paths ............................................ 332
Generating Timing Reports ....................................... 333
Highlighting Critical Paths ....................................... 333
Selecting Critical Path Objects .................................. 334
Zooming to Critical Paths ........................................ 334
Printing Critical Path Details .................................... 335
Using Critical Path Diagrams .................................... 335
Viewing Critical Paths in the Schematic Viewer ............ 336

Applying and Checking Properties ............................. 337
Applying Properties ................................................................. 337
Checking Whether Properties Were Applied ................................. 337
Configuring External Connections to Hardware .............................. 338
Configuring the DCC Connection ............................................... 338
Configuring the JTAG Connection ............................................. 339
Running the Snapshot Debugger ................................................. 344
Snapshot Design Flow ............................................................. 344
Accessing the Snapshot Debugger ............................................. 345
Configuring the Trigger Pattern ................................................. 347
Configuring the Monitor Signals ................................................ 350
Configuring Test Stimulus ....................................................... 351
Configuring Advanced Options ................................................ 353
Collecting Samples of the User Design ....................................... 355
Viewing the Captured VCD Waveform ....................................... 357
Saving/Loading Snapshot Configurations .................................... 364
Snapshot in Batch Mode ......................................................... 365
Programming a Device ................................................................ 367
Selecting a Bitstream File ......................................................... 367
Selecting Bitstream Programming Options .................................... 368
Downloading the Bitstream to the Target Device ............................. 368
Optimizing a Design .................................................................. 368
Attempting Likely Optimizations Using Option Sets ....................... 369
Placement Regions and Placement Region Constraints .................... 371
Placement Region Preferences .................................................. 371
Creating a New Placement Region ............................................. 371
Resizing an Existing Placement Region ....................................... 373
Moving an Existing Placement Region ....................................... 373
Assigning Placement Region Constraints .................................... 374
Listing all Objects Constrained to a Placement Region ..................... 376
Removing a Placement Region Constraint from an Object ................ 376
Saving Placement Region Definitions and Placement Region Constraints 376
Deleting Placement Regions ..................................................... 377
Running the HW Demo ............................................................ 377
Installing HW Demo Designs .................................................... 377
Selecting The Target Device And Demo ....................................... 377
Loading The Demo JAM File ...................................................... 379
Displaying Board Status ......................................................... 379
Control of Running Demonstration Design .................................................. 380
Using Incremental Compilation (Partitions) .................................................. 380
  Overview of Incremental Compilation and Partitions .................................. 380
Incremental Compile Tutorial ........................................................................ 383
Single-Process Incremental Compile Tutorial ................................................. 384
Multiprocess Incremental Compile Tutorial ................................................... 424
Automatic Flop Pushing into I/O Pads ............................................................ 434
  Background ................................................................................................. 434
Capabilities .................................................................................................... 436
ACE Attributes ............................................................................................. 436
Examples ......................................................................................................... 438
Implementation Options .................................................................................. 441
Timing Analysis Implications ......................................................................... 442
Working with Virtual I/O ................................................................................ 442
  Behavior ....................................................................................................... 442
Implementation Options .................................................................................. 443
Port Attributes ............................................................................................... 444
Runtime Messages ........................................................................................... 445
Schematic View ............................................................................................... 445
Managing I/Os ................................................................................................. 448
Accessing Help ............................................................................................... 449
  Accessing Context-Sensitive Help ............................................................... 449
Navigating Help Topics ................................................................................... 449
Searching Help .............................................................................................. 450
  Using the ACE SecureShare Tool to Create a Support Zip File .................. 452
Importing and Exporting Preferences ............................................................. 453
  Import Preferences ....................................................................................... 453
Export Preferences ........................................................................................ 454
Plotting SerDes Receiver Diagrams Using JTAG ............................................. 456
  Plotting a SerDes Diagram for a SerDes Lane .............................................. 457
Using Partial Reconfiguration ......................................................................... 459
  Partial Reconfiguration Tutorial ................................................................ 459
Chapter - 4: Tcl Command Reference .......................................................... 526
SDC Commands .............................................................................................. 526
  all_clocks .................................................................................................... 526
  all_inputs ................................................................................................. 526
Interactive Timing Commands

check_setup ........................................ 546
prepare_stp ........................................ 547
report_checks ...................................... 548
report_clock_properties ........................... 549
reset_stp ............................................ 550

ACE Tcl Commands ................................... 551
add_clock_preroute ................................. 551
add_project_constraints ........................... 551
add_project_ip ...................................... 552
add_project_netlist ................................. 552
add_region_find_insts ............................. 553
add_region_insts .................................... 553
apply_highlights ................................... 554
apply_placement ..................................... 554
check_project_status .............................. 554
clean_project ................................................................. 555
clear_arcs ................................................................. 555
clear_drawing .............................................................. 555
clear_flow ................................................................. 555
clear_lines ................................................................. 555
clear_ovals ............................................................... 555
clear_polygons ......................................................... 556
clear_rectangles ....................................................... 556
clear_strings ............................................................ 556
clock_info ................................................................. 556
clock_relation ........................................................... 557
create_boundary_pins .................................................. 558
create_equivalent_regions ............................................. 558
create_flow_step ....................................................... 558
create_impl .............................................................. 559
create_path ............................................................... 559
create_project .......................................................... 560
create_region ........................................................... 560
deselect ................................................................. 562
disable_flow_step ....................................................... 562
disable_project_constraints ........................................... 562
display_file .............................................................. 562
display_netlist .......................................................... 563
display_properties ........................................................ 563
draw_arc ................................................................. 563
draw_line ................................................................. 564
draw_oval ................................................................. 565
draw_polygon ............................................................ 565
draw_rectangle .......................................................... 566
draw_string .............................................................. 567
enable_flow_step ........................................................ 567
enable_project_constraints ............................................ 567
export_all_partitions ................................................... 568
export_partition .......................................................... 568
filter ............................................................... 568
find ................................................................. 570
generate_ioring_design_files ........................................ 571
generate_ip_design_files .............................................. 572
generate_route_delay_table ................................................................. 572
get_ace_cputime ............................................................................ 572
get_ace_current_memory_usage ......................................................... 572
get_ace_ext_dir ............................................................................. 572
get_ace_ext_lib ............................................................................. 572
get_ace_peak_memory_usage ............................................................. 573
get_ace_version ........................................................................... 573
get_active_impl ........................................................................... 573
get_active_project ........................................................................ 573
get_best_multiprocess_impl ............................................................... 574
get_clock_region_bounds ................................................................ 574
get_clock_regions .......................................................................... 574
get_clock_type ................................................................................ 574
get_compatible_ordering_codes ......................................................... 574
get_compatible_placements ................................................................. 574
get_current_design .......................................................................... 575
get_current_partname ..................................................................... 575
get_efd_file_path ........................................................................... 575
get_enabled_constraints .................................................................. 575
get_fabricdb_path ............................................................................ 576
get_file_line ................................................................................... 576
get_flow_steps ................................................................................ 576
get_impl_names ............................................................................... 576
get_impl_option ............................................................................... 576
get_impl_option_is_supported .......................................................... 577
get_inst_partition .......................................................................... 577
get_inst_region .............................................................................. 577
get_installation_directory ............................................................... 577
get_location ..................................................................................... 578
get_part_names ............................................................................... 578
get_partition_changed ..................................................................... 578
get_partition_force_changed ............................................................ 578
get_partition_info ........................................................................... 578
get_partition_insts .......................................................................... 579
get_partition_names ......................................................................... 579
get_partition_timestamp .................................................................. 579
get_partition_type ........................................................................... 580
get_path_property ............................................................................ 580
get_placement ................................................................. 580
get_pod_names ............................................................ 580
get_project_constraint_files ........................................... 581
get_project_directory .................................................... 581
get_project_ip_files ...................................................... 581
get_project_names ......................................................... 581
get_project_netlist_files ................................................. 582
get_properties .............................................................. 582
get_property ................................................................. 582
get_pvt_corners ............................................................ 582
get_region_bounds .......................................................... 582
get_region_insts ............................................................ 583
get_regions ................................................................. 583
get_report_sweep_temperature_corners ............................... 583
get_selection ............................................................... 583
get_stapl_actions .......................................................... 584
get_synprj_from_netlist ..................................................... 584
get_synprj_from_project .................................................... 584
get_techlib_name .......................................................... 585
get_techlib_path ............................................................ 585
get_techlibdb_path .......................................................... 585
get_techlibt_name .......................................................... 585
get_techlibt_path ............................................................ 585
get_techlibx_name ........................................................... 586
get_techlibx_path ............................................................ 586
has_ace_ext_lib .............................................................. 586
has_partitions ............................................................... 586
highlight ................................................................. 586
ignore_cancel ............................................................... 587
initialize_flow ............................................................... 587
insert_delay ............................................................... 587
is_incremental_compile .................................................. 587
is_labmode ................................................................. 587
load_flowscripts ............................................................ 587
load_project ............................................................... 588
message ................................................................. 588
move_project_constraints ................................................. 588
move_project_netlists ...................................................... 589
move_relative_paths ............................................................... 589
optimize_tile ................................................................. 589
redirect ................................................................. 590
refresh_drawing ................................................................. 590
regenerate_all_ip_design_files ........................................... 590
remap_partial_bitstream .................................................. 590
remove_clock_preroute .................................................. 591
remove_flow_step .............................................................. 591
remove_impl ................................................................. 591
remove_path ................................................................. 592
remove_project .............................................................. 592
remove_project_constraints ............................................. 592
remove_project_constraints_pvt ...................................... 592
remove_project_ip ............................................................. 593
remove_project_netlist .................................................. 593
remove_region ............................................................... 593
remove_region_insts ..................................................... 593
rename_impl ................................................................. 594
report_clock_regions .................................................. 594
report_clocks ............................................................... 595
report_coverage ............................................................. 595
report_design_stats ...................................................... 595
report_impl_options ..................................................... 596
report_partitions ............................................................ 596
report_performance .......................................................... 597
report_pins ................................................................. 597
report_placement ............................................................ 598
report_power ................................................................. 598
report_routing ............................................................... 599
report_utilization .......................................................... 600
reset_impl_option .......................................................... 600
restore_impl ................................................................. 601
restore_project .............................................................. 601
run ................................................................. 602
run_fanout_control .......................................................... 603
run_final_drc_checks .................................................. 603
run_fpga_download .......................................................... 603
run_generate_bitstream .................................................. 603
run_generate_final_reports ............................................ 603
run_final_drc_checks .................................................. 603
run_fpga_download .......................................................... 603
run_generate_bitstream .................................................. 603
<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>run_generate_final_reports</td>
<td>604</td>
</tr>
<tr>
<td>run_generate_fullchip_sim</td>
<td>604</td>
</tr>
<tr>
<td>run_generate_netlist</td>
<td>604</td>
</tr>
<tr>
<td>run_insert_holdbuffers</td>
<td>604</td>
</tr>
<tr>
<td>run_multiprocess</td>
<td>605</td>
</tr>
<tr>
<td>run_multiprocess_iterator</td>
<td>606</td>
</tr>
<tr>
<td>run_place</td>
<td>608</td>
</tr>
<tr>
<td>run_post_process</td>
<td>608</td>
</tr>
<tr>
<td>run_prepare</td>
<td>608</td>
</tr>
<tr>
<td>run_route</td>
<td>608</td>
</tr>
<tr>
<td>run_secureshare</td>
<td>609</td>
</tr>
<tr>
<td>run_snapshot</td>
<td>610</td>
</tr>
<tr>
<td>run_stapl_action</td>
<td>611</td>
</tr>
<tr>
<td>run_timing_analysis</td>
<td>612</td>
</tr>
<tr>
<td>run_tool</td>
<td>612</td>
</tr>
<tr>
<td>run_un_post_process</td>
<td>613</td>
</tr>
<tr>
<td>run_unplace</td>
<td>613</td>
</tr>
<tr>
<td>run_unroute</td>
<td>613</td>
</tr>
<tr>
<td>save_clock_preroute</td>
<td>614</td>
</tr>
<tr>
<td>save_impl</td>
<td>614</td>
</tr>
<tr>
<td>save_partition_placements</td>
<td>615</td>
</tr>
<tr>
<td>save_placement</td>
<td>615</td>
</tr>
<tr>
<td>save_project</td>
<td>616</td>
</tr>
<tr>
<td>save_properties</td>
<td>617</td>
</tr>
<tr>
<td>save_regions</td>
<td>617</td>
</tr>
<tr>
<td>select</td>
<td>617</td>
</tr>
<tr>
<td>set_active_impl</td>
<td>618</td>
</tr>
<tr>
<td>set_clock_type</td>
<td>618</td>
</tr>
<tr>
<td>set_cluster</td>
<td>619</td>
</tr>
<tr>
<td>set_equivalent_pins</td>
<td>619</td>
</tr>
<tr>
<td>set_flyline_direction</td>
<td>619</td>
</tr>
<tr>
<td>set_impl_option</td>
<td>619</td>
</tr>
<tr>
<td>set_max_flyline_fanout</td>
<td>620</td>
</tr>
<tr>
<td>set_partition_force_changed</td>
<td>620</td>
</tr>
<tr>
<td>set_partition_info</td>
<td>620</td>
</tr>
<tr>
<td>set_placement</td>
<td>621</td>
</tr>
<tr>
<td>set_project_constraints_pvt</td>
<td>622</td>
</tr>
<tr>
<td>set_property</td>
<td>622</td>
</tr>
</tbody>
</table>
Chapter 5: Troubleshooting

ACE Exit Error Codes ......................................................... 628
Duplicate Names for Arrays .............................................. 629
Clock Definitions/Constraints ........................................... 630
Asynchronous Reset of I/O from the Core .......................... 630
Multi-process Functionality License Requirements ............... 630
Non-ASCII Characters in Path ........................................... 630
Unable to Load Project: Project is Locked ......................... 630
Changing ACE Font Sizes ................................................ 631
  Fonts in Views ....................................................... 631
  Fonts in HTML Reports ............................................ 632
Unable to Initialize Reserved Module Name List .................. 632
Startup Error — ACE is Unable to Connect on Port NNNN of Localhost ................................................ 633
  To Determine the Root Cause ...................................... 634
Unexpected ACE GUI problem: java.lang.NoClassDefFoundError: com/achronix/api/APIPlugin ... 636
  If the problem persists after -clean, or if the command prompt is unfamiliar .......................... 636
Multiprocess Summary Report Shows "No Timing Results Found" for Successfully Run Implementations with Existing Timing Reports ............................................... 637
Windows: ACE Incorrectly Reports Read/Write File Permission Problems .................................. 638
Windows: ACE GUI Shown as "Not Responding" .................... 638
Windows: Garbage sometimes appears in the Floorplanner View during panning operations (and remains after panning is completed) ........................................ 638
Windows: ACE Startup Error Due to Missing DLL Component in Windows 10 .......................... 639
Windows: The icons and buttons in ACE are too small ......................................................... 639
  Asking Windows to upscale images and fonts for all applications ...................................... 639
  Asking just ACE to upscale images and fonts ................................................................. 639
Linux: Resource Limits: ACE Reports an OutOfMemory Error, But There is Plenty of Free Memory Available ................................................................. 641
Linux: In the TWM Window Manager, the First Time the ACE GUI is Started After Installation, the ACE Window is So Small Users Might Not See it ........................................ 642
Linux: Odd Behavior When Using X DISPLAY Forwarding if the X Client and X Server Are More than One Major Revision Apart ................................................................. 642
Linux: ACE Menus Do Not Show Icons Next to the Action Names ........................................ 642
Linux: ACE Ignores LD_LIBRARY_PATH .............................................................................. 642
Linux: ACE forces the use of the GDK X11 rendering engine even while running under Wayland ... 643
Linux: Incompatible Default Web Browser .......................................................................... 644
  Solution .......................................................................................................................... 644
  Additional Information ..................................................................................................... 646
Linux: ACE Requires an Unusually Large Amount of Virtual Memory (Due to WebKit2) ....... 647
Linux: ACE forces the use of the Adwaita GTK+3 Theme; Can I Change This? ...................... 647
  Themes ............................................................................................................................ 647
  Animations and Other Effects ......................................................................................... 648
Linux: Views and Editors Detach when Dragged Instead of Docking in the Workbench ............ 649
Linux: CDE: Dialogs and Wizards Sometimes Appear Behind the Main ACE Window, Especially After Minimize/Maximize .................................................................................. 649
Linux: "Failed to create the part’s controls": Some Views and IP Editors may fail to initialize .... 650
Upgrading an ACE Installation .......................................................................................... 650
  On Windows .................................................................................................................... 650
  On Linux ......................................................................................................................... 651
GUI Problems after Upgrading? ......................................................................................... 651
Revision History .............................................................................................................. 653
Preface

About This Guide

This guide is a reference manual for ACE, used for placing, routing, configuring, and debugging Achronix FPGAs. ACE works in conjunction with third-party synthesis and simulation tools to provide a complete design environment for Achronix FPGAs.

This guide consists of the following chapters:

- **Getting Started** (see page 22) includes an Introduction to ACE and a quick Tutorial.
- **Concepts** (see page 24) covers all the basic concepts of ACE, and can be considered a reference manual for the various GUI elements.
- **Tasks** (see page 262) details how to complete various tasks within the GUI, plus provides the related TCL commands.
- **TCL Command Reference** (see page 526) provides a complete TCL command reference, including syntax.
- **Troubleshooting** (see page 628) shows a number of common problems and the recommended solutions.
- **Revision History** (see page 653) lists the changes to each revision of this document

Related Documents

The following documents, as well as the latest version of this document (UG070), are always available for download at https://www.achronix.com/support/docs.

- **ACE Installation and Licensing Guide** (UG002)
- **JTAG Configuration User Guide** (UG004)
- **Snapshot User Guide** (UG016)
- **Synthesis User Guide** (UG018)

The following supplemental document, typically included in the software release download files, should also be consulted for the very latest information:

- **ACE (version) Release Notes**

Further documents are available for each Speedster device on both https://www.achronix.com/support/docs and https://download.achronix.com (login required).

Please consult your Achronix FAE for a complete list of documentation relevant to your Achronix products.
## Conventions Used in this Guide

<table>
<thead>
<tr>
<th>Item</th>
<th>Format</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command-line entries</td>
<td>Formatted with a bold fixed-width font, or in a special code block.</td>
<td><code>$ Open top_level_name.log</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Command-line code example</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>$ Open top_level_name.log</code></td>
</tr>
<tr>
<td>File Names</td>
<td>Formatted with a fixed-width font.</td>
<td><code>filename.ext</code></td>
</tr>
<tr>
<td>GUI buttons, menus, menu or list choices, and radio buttons</td>
<td>Formatted with a variable-width bold font.</td>
<td>Select <strong>File -&gt; Open</strong>, select the desired file, then click <strong>OK</strong> to continue.</td>
</tr>
<tr>
<td>Variables</td>
<td>Formatted with italic emphasis and enclosed by the angle brackets <code>&lt;</code> and <code>&gt;</code>.</td>
<td><code>&lt;design_dir&gt;/output.log</code></td>
</tr>
<tr>
<td>RTL Names</td>
<td>Formatted with italic emphasis.</td>
<td><code>read_clk</code></td>
</tr>
<tr>
<td>Window and dialog box headings and sub-headings</td>
<td>Heading formatted in quotation marks.</td>
<td>Under &quot;Output Files&quot;, select ...</td>
</tr>
<tr>
<td>Window and dialog box names</td>
<td>Name uses initial caps.</td>
<td>From the Add Files dialog box, ...</td>
</tr>
</tbody>
</table>
Chapter - 1: Getting Started

Introduction

The Achronix implementation flow uses an industry standard RTL synthesis flow based on Synplify Pro from Synopsys. Working in conjunction with the synthesis tool, ACE provides:

- Placement
- Routing
- Timing Analysis
- Bitstream Generation
- FPGA Configuration
- On-chip Debugging
- Hard/Soft IP Configuration Tools
- Simulation Netlist Generation

ACE Quickstart Tutorial

Start by copying all the files from `<install_dir>/Achronix/examples/quickstart/<device>` into a new empty directory (`<test_dir>`). Use the `<device>` directory that matches the Target Device implementation option that you select in step 2. Now click the ( ) icon in the upper right corner of the Welcome view to minimize these instructions. Then follow these simple steps to complete your first design in ACE.

1. Create your Project

   In the Projects View (see page 123), click the Create Project ( ) toolbar button. In the Create Project Dialog (see page 168), enter (or browse to) the path to `<test_dir>` in the Project Directory field. Enter "quickstart" in the Project Name field and click OK. You should now see your new project show up in the Projects view.

   See Creating Projects (see page 271) or Working with Projects and Implementations (see page 271) for more details.

2. Add your Design Files and Set Implementation Options

   In the Projects View, click the "quickstart" project to select it. Now click the Add Files ( ) toolbar button. In the Add Source Files Dialog (see page 147), select quickstart.vma, quickstart.pdc, and quickstart.sdc by holding down the CTRL key and clicking each item. Now click the Open button to add the files to your project. Finally, in the Options view, expand the Design Preparation section and select the Target Device that matches the set of design files that you copied earlier. You now have a project that is ready to run through the flow!

   See Adding Source Files (see page 275) or Working with Projects and Implementations (see page 271) for more details.

3. Run the Flow

   In the Flow View (see page 67), click the Run Flow ( ) toolbar button. Output from the Flow (see page 223) is shown in the Tcl Console View (see page 144). When the flow is finished running, you see the Flow Steps (see page 223) in the Flow View updated with a green check mark (✓) to indicate success, and all newly generated reports are displayed in the editor area.
See the Flow (see page 223) concept or Running the Flow (see page 283) for more details.

4. Analyze the Results

On the main toolbar, click the **Floorplanner Perspective** ( ) toolbar button. Within this perspective, use the **Critical Paths View** (see page 52) to analyze critical paths and highlight them in the **Floorplanner View** (see page 57). Clicking the **Zoom To Path** ( ) toolbar button in the Critical Paths View zooms the Floorplanner View (see page 57) to the path currently selected in the Critical Paths View. Use the **Search View** (see page 132) and **Selection View** (see page 136) to locate objects of interest. Clicking the **Zoom To Selection** ( ) toolbar button in the Selection View zooms the Floorplanner View to the objects in the current selection set.

Congratulations!!!

⚠️ You have successfully completed a design in ACE!
Chapter - 2: Concepts

Workbench
The term Workbench refers to the desktop development environment within ACE. The Workbench aims to achieve seamless tool integration by providing a common platform for the creation, management, and navigation of project resources.

Each Workbench window contains one or more Perspectives (see page 24). Perspectives contain views (see page 33) and editors (see page 27) and control what appears in certain menus and tool bars. More than one Workbench window can exist on the desktop at any given time.

Perspectives
There are many different kinds of information that must be viewed within ACE. Perspectives are used to filter the information into usable, logically consistent groupings. A perspective provides a set of functionality aimed at accomplishing a specific type of task or works with specific types of resources. A perspective defines the initial set and layout of views (see page 33), editors (see page 27), menus, and toolbars in the Workbench window.

For example, the Projects perspective combines views (see page 33) commonly used while managing project source files, while the Floorplanner perspective contains the views that are used while viewing chip layout and floorplanning information. Perspectives are frequently switched while working inside the Workbench window.

Note
Within the Workbench window, all perspectives share the same set of Editors (see page 27). All editors are usable/visible from all perspectives. Likewise, each of the Views (see page 33) may optionally be used within any perspective, but they are most useful when grouped with the other views from their native perspective. One of the views, the Tcl Console View (see page 144), is a member of all the perspectives.

Projects Perspective
The Projects Perspective allows selecting an active project and implementation, managing the contents and configuration of the active project/implementation, running the Flow (see page 223), and viewing the reports generated by the Flow.

By default, this perspective contains the Projects View (see page 123), Flow View (see page 67), Options View (see page 106), Tcl Console View (see page 144), and the Editor area, which can contain any ACE Editor or Report. The Multiprocess View (see page 86) is also part of this perspective, but is hidden by default.

For more information, see Working with Projects (see page 271), Running the Flow (see page 283), and Using the Tcl Console (see page 310).
Floorplanner Perspective

The Floorplanner Perspective allows viewing and editing the placement and routing of the active project.

By default, this perspective contains the following:

- Floorplanner View (see page 57)
- Search View (see page 132)
- Selection View (see page 136)
- Critical Paths View (see page 52)
- Critical Path Diagram View (see page 49)
- Netlist Browser View (see page 92)
- Clock Domains View (see page 36)
- Clock Regions View (see page 39)
- Placement Regions View (see page 118)
- Partitions View (see page 115)
- Tcl Console View (see page 144)

For more information on using the views in this perspective, see Viewing the Floorplanner (see page 320), Pre-Placing a Design (see page 326), and Analyzing Critical Paths (see page 332).

Caution!

Unlike most other perspectives, the Floorplanner perspective hides the Editor area. To view editors (see page 27) and reports (see page 229), a different perspective must be selected.

IP Configuration Perspective

The IP Configuration Perspective is used to create and edit IP configuration files (.acxip) through the various IP Configuration Editors.

By default, this perspective contains the following:

- Projects View (see page 123)
- IP Libraries View (see page 84)
- IP Diagram View (see page 82)
- IP Problems View (see page 84)
- Outline View (see page 115)
- Tcl Console View (see page 144)
- I/O Designer Toolkit Views (see page 74)

The IP Configuration Perspective also contains the Editor Area, which can contain any ACE Editor or Report.

See Creating an IP Configuration (see page 314) for more details.
2D NoC Performance Perspective

The 2D NoC Performance Perspective is used to visualize the throughput or congestion of the 2D NoC network by loading a simulation log file produced by the device simulation model (DSM).

By default, this perspective contains the following:

- NoC Performance View (see page 98)
- NoC Time Slice View (see page 103)

**Caution!**

Unlike most other perspectives, the 2D NoC Performance perspective hides the Editor area. To view editors (see page 27) and reports (see page 229), a different perspective must be selected.

Programming and Debug Perspective

The Programming and Debug Perspective allows interaction with Achronix FPGAs via JTAG through a JTAG pod or embedded JTAG controller device. Downloading the device configuration and debugging will typically happen from here.

By default, this perspective contains the following:

- Snapshot Debugger View (see page 139)
- Download View (see page 55)
- Register Browser View (see page 130)
- Tcl Console View (see page 144)

The Programming and Debug Perspective also contains the Editor area, which can contain any ACE Editor or Report.

For more information on using this perspective, see Running the Snapshot Debugger (see page 344) and Programming a Device (see page 367)

HW Demo Perspective

The HW Demo Perspective allows observing various aspects of a particular device, by selecting one of the provided demonstration designs from a list. When the demonstration is loaded into the attached board, LED states and DIP switch states (from the board) are displayed and updated in real-time. Internal device state information such as the temperature of the FPGA and power consumption are also displayed.

By default, this perspective contains the following:

- Snapshot Debugger View (see page 139)
- HW Demo View (see page 71)
- Tcl Console View (see page 144)

The HW Demo Perspective also contains the Editor area, which can contain any ACE Editor or Report.

For more information on using this perspective, see Running the HW Demo (see page 377).
Editors

Most Perspectives (see page 24) in the Workbench (see page 24) are comprised of an editor area and one or more views (see page 33). Different editors are associated with different types of files. For example, when a file is opened by double-clicking in the Projects View (see page 123), the associated editor opens in the Workbench. If there is no associated editor for a resource, the Workbench attempts to launch an external editor outside the Workbench. Any number of editors can be open at once, but only one can be active at a time. The main menu bar and toolbar for the Workbench window contain operations that are applicable to the active editor.

Tabs in the editor area indicate the names of resources that are currently open for editing (usually the filename, and the tab’s tooltip provides the full path to the file). An asterisk (*) displayed in an editor tab indicates that an editor has unsaved changes. By default, editors are stacked in the editor area, but users may choose to tile (see page 268) them in order to view multiple editors simultaneously. The gray border at the left margin of the editor area may contain icons that flag errors, warnings, or problems detected by the system.

In ACE, the editor area is also used to view the Reports (see page 229) generated by ACE. By default, when ACE is running the Flow (see page 223) in single-process mode, ACE opens HTML versions of the reports in the HTML Report Browser (see page 27) as soon as the report data is generated/updated. When ACE is in Multiprocess mode (via the Multiprocess View (see page 86)), only the Multiprocess Summary Report (see page 240) is automatically opened in the editor area – the other reports must be opened manually through the Projects View (see page 123), or by following the Timing Report hyperlinks for each Implementation (see page 217) found within the Multiprocess Summary Report.

ACE also provides a suite of IP Configuration Editors, organized by fabric family/library, used to instantiate and configure the various IP surrounding the core fabric. See Creating an IP Configuration (see page 314).

HTML Report Browser

When HTML versions of generated Reports (see page 229) are opened within ACE, they are displayed within the Editor area using the HTML Report Browser. This is a very limited form of a web browser — it only allows hyperlink traversal, refresh, forward, and back operations. The buttons for Refresh, Back, and Forward are not displayed within the browser itself, but are instead shown in the main (topmost) ACE button-bar.

Note

The HTML Report Browser should not be used to browse the Internet — a dedicated web browser like Firefox would be a much better choice, for both security and performance reasons.
Figure 1: HTML Report Browser, Toolbar Buttons Circled in Red

Table 1: HTML Report Browser Toolbar Buttons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>➡️</td>
<td>Back</td>
<td>Returns to the last HTML location viewed.</td>
</tr>
<tr>
<td>➡️</td>
<td>Forward</td>
<td>Returns to the HTML location viewed before the Back button was selected (the Forward button remains disabled until the Back button has been pressed).</td>
</tr>
<tr>
<td>⚡</td>
<td>Refresh</td>
<td>Refreshes the displayed HTML report to show the current contents of the report file on disk.</td>
</tr>
</tbody>
</table>

Text Editor

Reports, source files, and scripts open in the text editor. The text editor supports typical editing functions, such as insert, delete, copy, cut, and paste.

Figure 2: Text Editor Example
VCD Waveform Editor

The VCD Waveform Editor does not allow editing a VCD file. It only allows viewing. But since it resides in the same location in the GUI as all the other Editors (see page 27), and it opens whenever a VCD file is selected, it can be thought of as an editor in read-only mode.

The waveform viewer allows examining VCD output in a familiar waveform visualization, displaying how signals change values over time. It is typically used to examine the VCD output that gets generated when Running the Snapshot Debugger (see page 344) (see also: Snapshot Debugger View (see page 139), Viewing the Captured VCD Waveform (see page 357)).

As with familiar waveform editors, the placement of a vertical line marker (pink by default, managed by a user preference) can be manipulated with the mouse in the graphical waveform area so that the value of all signals at the same instant of time can be seen. Signals can also be re-ordered (individually moved vertically among peers) and individual signals can be hidden or shown. If necessary, signals may be duplicated in the display so that they can be displayed adjacent to multiple peers for ease of value comparisons. It is, of course, possible to change the zoom level of the graphical waveform area if desired.

For each VCD file, the editor remembers signal name ordering, panel sizes, zoom level, and the sample offset between file loads. These settings are remembered between Snapshot captures within a single session, as well as between ACE sessions.

Note

1. In addition to the graphical waveform view, the raw text content of the VCD file may be viewed. To do so, select the File Preview tab at the bottom of the VCD Waveform Editor. To see the graphical waveform representation again, select the Waveform tab at the bottom of the VCD Waveform Editor.

2. None of the actions available in the VCD Waveform Editor change the content stored in the VCD file.
By default, the waveform area uses alternating foreground colors (black and blue by default) and background colors (light grey and white by default) for even and odd rows. When rows are selected in the signal name/value table, the corresponding rows in the waveform are highlighted with a specified selection foreground color (orange by default) to make them stand out. Multi-bit bus values are also shown in the waveform area when they fit in the available space; when the bus value is too wide for the available area, the value is not shown, though value edges are still visible. The available area may be made wider by zooming in, thus allowing larger bus values to be displayed (the Marker can also be used to display the bus and bit value in the signal table for a chosen point in time).

Table 2: VCD Waveform Editor Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal Value Table</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>The name of the signal as stored in the VCD file.</td>
</tr>
<tr>
<td>Value</td>
<td>The value of the signal at the Marker's indicated point in time.</td>
</tr>
<tr>
<td>Waveform Timing Info</td>
<td></td>
</tr>
<tr>
<td>Left</td>
<td>The time (in ps or tk) indicated by the left edge of the viewable waveform area.</td>
</tr>
<tr>
<td>Right</td>
<td>The time (in ps or tk) indicated by the right edge of the viewable waveform area.</td>
</tr>
<tr>
<td>Marker</td>
<td>The time (in ps or tk) indicated by the vertical marker line (pink by default) shown in the viewable waveform area.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Cursor</td>
<td>The time (in ps or tk) indicated by the current (or last relevant) mouse cursor position over the viewable waveform area.</td>
</tr>
</tbody>
</table>

**Note**

**Cursor Values:** When the mouse moves away from the waveform area, the last position over the waveform is retained by the *Cursor* value. This ps or tk value does not change until the mouse cursor is again over the waveform, even if the view is scrolled or the zoom factor is changed.

Icons are shown to the left of each signal name as an indicator whether the name corresponds to a individual bit signal or a bus.

**Table 3: VCD Waveform Editor Icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Signal Icon]</td>
<td>Signal</td>
</tr>
<tr>
<td>![Bus Icon]</td>
<td>Bus</td>
</tr>
</tbody>
</table>

There are a number of buttons available below the signal name/value table area to allow the altering which signals/buses are visible, and where they are displayed in relation to their peers. Signals and buses are allowed to be displayed more than once within the table, if desired.

**Table 4: Signal Value Table Actions**

<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Up</td>
<td>Y</td>
<td>Moves the currently-selected signals (or buses) one row higher in the table and the waveform area. Signals may also be dragged vertically to new locations with the mouse.</td>
</tr>
<tr>
<td>Move Down</td>
<td>Y</td>
<td>Moves the currently-selected signals (or buses) one row lower in the table and the waveform area. Signals may also be dragged vertically to new locations with the mouse.</td>
</tr>
<tr>
<td>Add...</td>
<td>Y</td>
<td>Opens the Add Signals to Waveform Viewer Dialog (see page 146), which allows previously removed (hidden) signals to be displayed, and allows already-visible signals to be added to the signal list multiple times. (A signal could be duplicated and shown adjacent to multiple associated signals.)</td>
</tr>
<tr>
<td>Remove</td>
<td>Y</td>
<td>Hides the currently-selected signal (or bus), temporarily removing it from the table and the waveform area. The hidden signal/bus may be shown again via the Add... button.</td>
</tr>
<tr>
<td>Copy Signal Name</td>
<td>Y</td>
<td>When a single bus or signal is selected, this right-click context menu choice allows copying the current name of the selected bus or signal (this menu choice is not shown when multiple rows are selected in the table).</td>
</tr>
</tbody>
</table>
There are also a number of buttons that affect the waveform area in particular.

**Table 5: Waveform Buttons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Move Marker" /></td>
<td>Move Marker to Previous Edge</td>
<td>Moves the vertical pink marker line in the waveform area to the previous edge for the signal/bus which is currently selected in the signal value table (has no effect when no signal is selected in the table).</td>
</tr>
<tr>
<td><img src="image" alt="Move Marker" /></td>
<td>Move Marker to Next Edge</td>
<td>Moves the vertical pink marker line in the waveform area to the next edge for the signal/bus which is currently selected in the signal value table (has no effect when no signal is selected in the table).</td>
</tr>
<tr>
<td><img src="image" alt="Zoom In" /></td>
<td>Zoom In</td>
<td>Increases the zoom factor in the waveform area, increasing the visible level of detail.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom Out" /></td>
<td>Zoom Out</td>
<td>Decreases the zoom factor in the waveform area, decreasing the visible level of detail.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom to Marker Position" /></td>
<td>Zoom to Marker Position</td>
<td>Without changing the zoom factor, scrolls the waveform area horizontally to make the marker visible.</td>
</tr>
<tr>
<td><img src="image" alt="Configure Colors..." /></td>
<td>Configure Colors...</td>
<td>Opens the Preferences (see page 186) dialog, switches to the General → Appearance → Colors and Fonts page, and scrolls to the VCD Editor section, allowing the colors and fonts used to be changed within the waveform area.</td>
</tr>
<tr>
<td><img src="image" alt="Show Ticks/Show Times" /></td>
<td>Show Ticks/Show Times</td>
<td>Toggles the Waveform Timing info (left, right, marker, and cursor) between displaying values in ticks (tk) or picoseconds (ps).</td>
</tr>
</tbody>
</table>

**VCD Viewer Preferences**

The colors and fonts used within the VCD waveform viewer are managed by user-editable preferences. These preferences can easily be viewed and edited by selecting the Configure Colors... button found to the upper-right of the waveform. These preferences allow selecting alternate waveform viewer color choices (for example, green-on-black colors similar to a more traditional oscilloscope). When fine-tuning colors, remember to use the Apply button near the bottom of the Colors and Fonts page in the Preference dialog so that choices can be tested immediately without closing the dialog, allowing immediate visual feedback and continued iteration (the Preferences dialog can be made taller/wider to ensure visibility without scrolling).

The following figure shows an example where most of the default colors have been altered in favor of a light-on-dark color configuration.
Views

Views support Editors (see page 27) and provide alternative presentations as well as ways to navigate the information in the Workbench (see page 24). For example, the Projects view (see page 123) displays Projects (see page 217), Implementations (see page 217), and their related file-based resources.

All views have their own context menu showing ways to alter the location or presentation of the view. Simply right-click the view tab to display the menu.

Some views have their own toolbars. The actions represented by buttons on view toolbars only affect the items within that view.
Some views also have their own menus to affect the content of the view. These menus often contain the same actions from the toolbar, potentially an additional link to the relevant page(s) in the Preferences (see page 186) which are specific to this view, as well as additional actions/toggles specific to the view which are used less frequently. When such a menu is available, a vertical ellipsis (.) appears at the far right of the view toolbar. To open the menu for a view, click the icon.

![Figure 6: Example of View Toolbar Including Opened View Menu](image)

Views are grouped by shared context into Perspectives (see page 24). Within a perspective, a view might appear by itself, or stacked with other views in a tabbed notebook. The layout of a perspective can be changed by opening and closing views and by moving/docking them in different positions in the Workbench (see page 24) window. See Working with Views and Editors (see page 266) for more information.

The views contained by the Project perspective are:

- Projects View (see page 123)
- Flow View (see page 67)
- Options View (see page 106)
- Multiprocess View (see page 86)
- Tcl Console View (see page 144)

The views within the Floorplanner perspective are:

- Search View (see page 132)
- Selection View (see page 136)
- Critical Paths View (see page 52)
- Critical Path Diagram View (see page 49)
- Floorplanner View (see page 57)
- Clock Regions View (see page 39)
- Clock Domains View (see page 36)
- Clusters View (see page 45)
- Placement Regions View (see page 118)
- Partitions View (see page 115)
- Netlist Browser View (see page 92)
- Properties View (see page 127)
- Tcl Console View (see page 144)

The views contained within the IP Configuration perspective are as follows, with the subset specific to Speedster FPGAs (with I/O Rings) also summarized at I/O Designer Toolkit Views (see page 74):

- Projects View (see page 123)
- Outline View (see page 115)
- IP Libraries View (see page 84)
- IP Diagram View (see page 82)
- IP Problems View (see page 84)
- I/O Utilization View (see page 75)
- I/O Package Diagram View (see page 76)
- I/O Pin Assignment View (see page 77)
- I/O Core Pin Assignment View (see page 78)
- I/O Layout Diagram View (see page 80)
- Tcl Console View (see page 144)

The views contained within the NoC perspective are:

- NoC Performance View (see page 98)
- NoC Time Slice View (see page 103)

The views of the Programming and Debug perspective are:

- Snapshot Debugger View (see page 139)
- Download View (see page 55)
- Register Browser View (see page 130)
- Tcl Console View (see page 144)

The views of the HW Demo perspective are:

- HW Demo View (see page 71)
- Snapshot Debugger View (see page 139)
- Tcl Console View (see page 144)

Finally, for ease of reference, a combined summary list of all available ACE views from all perspectives, sorted in alphabetical order:

- Clock Domains View (see page 36)
- Clock Regions View (see page 39)
- Clusters View (see page 45)
- Critical Path Diagram View (see page 49)
- Critical Paths View (see page 52)
- Download View (see page 55)
- Floorplanner View (see page 57)
Clock Domains View

The Clock Domains view provides a table listing all the clock domains found in the active design. Counts are also provided of the major logic types within each clock domain. Similar to the Netlist Browser View (see page 92), filters are available for each column of the table, so that in cases where there are many clock domains in a design, the visible content of the table may be limited to just those clock domains meeting the chosen filter criteria. Filters are available for all columns of the table except the Highlight Color column.

By default, the Clock Domains view is included in the Floorplanner perspective (see page 24). To add it to other perspectives, select Window → Show View... → Other... → Achronix → Clock Domains.
The various Achronix target devices contain different mixes of the possible resource types. Accordingly, the resource type columns in this view (i.e., flops, BRAMs, ALUs, etc.) are dynamic, and change to match the target device after the Prepare flow step has been run. The screenshots and example descriptions in this document section might not exactly reflect the current target device.

**Figure 7: Clock Domains View Example**

![Figure 7: Clock Domains View Example](image)

The various Achronix target devices contain different mixes of the possible resource types. Accordingly, the resource type columns in this view (i.e., flops, BRAMs, ALUs, etc.) are dynamic, and change to match the target device after the Prepare flow step has been run. The screenshots and example descriptions in this document section might not exactly reflect the current target device.

### Table 6: Clock Domains View Columns

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clock Domain Name</td>
<td>The name of the clock domain in the active design.</td>
</tr>
<tr>
<td>Highlight Color</td>
<td>If all instances within the clock domain have the same highlight color, the row shows a color square with that same highlight color. If even one contained instance has a differing highlight color, or no highlight at all, then the row displays no color square.</td>
</tr>
<tr>
<td>Resource</td>
<td>A different column is provided for each resource type within the target device. Each table cell in that column shows the sum count of all contained resource instances within the named clock domain for that row.</td>
</tr>
</tbody>
</table>

A number of actions are available in the view, via buttons at the top of the view and (right-click) context menus on the rows of the table.

### Table 7: Clock Domains View Actions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Toolbar Button</th>
<th>Context Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![+]</td>
<td>Add Instances to Selection</td>
<td>Y</td>
<td>Y</td>
<td>Adds the instances within the clock domain to the ACE Selection Set (as shown in the Selection View (see page 136)).</td>
</tr>
<tr>
<td>![ibox]</td>
<td>Choose Highlight Color</td>
<td>Y</td>
<td></td>
<td>Determines which color is applied to the objects chosen the next time the Highlight action is selected for this view.</td>
</tr>
<tr>
<td>![highlight]</td>
<td>Highlight</td>
<td>Y</td>
<td>Y</td>
<td>Applies the currently active Highlight color to the instances within the chosen clock domain (see Highlighting Objects in the Floorplanner View (see page 323)).</td>
</tr>
</tbody>
</table>
### Icon List

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Toolbar Button</th>
<th>Context Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon" alt="Un-Highlight" /></td>
<td>Un-Highlight</td>
<td>Y</td>
<td>Y</td>
<td>Clears the Highlight for the instances within the chosen clock domain.</td>
</tr>
<tr>
<td><img src="icon" alt="Zoom To" /></td>
<td>Zoom To</td>
<td>Y</td>
<td>Y</td>
<td>Zooms the Floorplanner View (see page 57) to a region containing the instances within the clock domain currently chosen in the tree.</td>
</tr>
<tr>
<td><img src="icon" alt="Search for Instances" /></td>
<td>Search for Instances</td>
<td>Y</td>
<td>Y</td>
<td>Searches for instances belonging to the chosen clock domain. A Tcl find command is issued, and the Search View (see page 132) is populated with the results.</td>
</tr>
<tr>
<td><img src="icon" alt="Toggle Filter Row Visibility" /></td>
<td>Toggle Filter Row Visibility (1)</td>
<td>Y</td>
<td></td>
<td>Changes whether the filter row (of filter icons) is visible or not.</td>
</tr>
</tbody>
</table>

### Table Notes

1. Toggle Filter Row Visibility does not alter whether filters are active, it only changes filter icon visibility.

### Organizing Table Data

The following are ways to alter the presentation of the data in the Clock Domains table:

#### Column Resizing

The width of a column can be changed as follows:

1. place the mouse cursor over the boundary between columns (the mouse cursor changes to indicate resizing is possible).
2. Simply left-click and drag left or right to resize the column to the desired width, then release the mouse button.

#### Column Reordering

The order of the columns in the table can be changed as follows:

1. Left-click and hold on any column name
2. Drag left or right to move the column between any other pair of columns
3. Release the left mouse button to insert the column header at the new location

While dragging, the dragged column header appears alongside the mouse cursor, plus a thick column header separator showing where the column insertion occurs when the mouse is released.

#### Filtering

Most columns of the table may filter the displayed clock domains by value. When filtering by column value, only clock domains with column values matching the filter are retained; non-matching values are excluded from the table.

- Columns containing text can be filtered by string value. Simple substring text matching (with optional wildcard) is used by default, but Regular Expression matching, also known as RegEx (see https://en.wikipedia.org/wiki/Regular_expression), is also available. The ACE GUI RegEx matching follows Java rules (see https://docs.oracle.com/en/java/javase/11/docs/api/java.base/java/util/regex/Pattern.html), which are extremely similar to Perl rules.
Columns with checkmarks can be filtered by boolean value.
Columns containing numbers can be filtered by numerical value.
Columns which may not be filtered (i.e., the Overlay Color column) lack a filter icon in the filter row.

To add a filter to a column:

1. The Filter Row must first be visible. Select the ( ⚙️ ) Toggle Filter Row Visibility action to show the row if necessary.
2. Click the ( ☑️ ) filter icon for the desired column, which causes a data-appropriate filter dialog to appear.
3. Fill in the desired filter values and click Apply to apply the filter to the rows in the table.

All values matching that filter are retained, and all other values are excluded. Additionally, the background color of the filtered column changes to a bright yellow to indicate the filter is active, and the filter icon at the head of the column also changes to the ( ☑️ ) active filter icon.

To edit (or clear) an existing filter:

1. Click the ( ☑️ ) active filter icon, which causes the data-appropriate filter dialog to appear pre-populated with the current column filter setting.
2. Change the filter value and click Apply to edit the filter.
3. Click Cancel to leave the filter unchanged.
4. Click Clear to remove the filter from the column.

If the filter is cleared, the background color of the column returns to the default background color, and the filter icon also changes to the ( ☑️ ) inactive version.

### Drag-and-Drop

The Clock Domains view supports a limited set of Drag-and-Drop interactions with other views in the Floorplanner perspective (see page 24). The view only acts as a Drag-and-Drop source; items dropped on the Clock Domains view will be ignored.

Any row of the table may be dragged to the Tcl Console view (see page 144), and when dropped anywhere in the view the clock domain name (with the appropriate object type prefix) is inserted at the beginning of the Tcl command-line.

Any clock domain in the table may be dragged to the Placement Regions view (see page 118) or the Floorplanner View (see page 57) (when that view has the Placement Regions Tool active) to assign placement region constraints (see page 374). Dragging a clock domain is the equivalent of dragging all individual instances which are members of that clock domain. Be aware that since placement regions may only encompass the fabric core and boundary region, but not the I/O ring, any dragged I/O instances are not assigned to placement regions.

Save

### Clock Regions View

The Clock Regions view provides a tabular representation of the site type content of each of the Clock Regions (see page 245) in the currently selected Target Device, and allows toggling the visibility of the overlay within the Floorplanner View (see page 57) for each Clock Region. The view table remains empty until the currently active Implementation has been prepared (i.e., the Run Prepare flow step has been completed).

By default, the Clock Regions view is included in the Floorplanner perspective (see page 24). To add the view to the current perspective, select Window → Show View → Other... → Achronix → Clock Regions.
Figure 8: Clock Regions View Example
**Caution!**

Resource type columns, such as Flops, BRAMs, ALUs, etc. are dynamic and change to match the target device after running the Prepare flow step. The resource type columns shown in the screenshot are examples only, and do not match all target devices.

---

**Table 8: Clock Regions Table Columns**

<table>
<thead>
<tr>
<th>Column</th>
<th>Editable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visibility</td>
<td>Y</td>
<td>When checked, the clock region overlay is painted in the Floorplanner View (see page 57), using the translucent color shown in the Overlay Color column.</td>
</tr>
<tr>
<td>Name</td>
<td></td>
<td>The name of this clock region.</td>
</tr>
<tr>
<td>Overlay Color</td>
<td>Y</td>
<td>The color used to paint the location of the clock region as an overlay in the Floorplanner View. Right-click any row, then choose Change Overlay Color to choose an alternate overlay paint color for that clock region.</td>
</tr>
<tr>
<td>Clock Pre-Routes</td>
<td></td>
<td>If any clock pre-routes exist for a given partition, they are listed here.</td>
</tr>
<tr>
<td>Resource</td>
<td></td>
<td>The number of resource sites contained in this clock region.</td>
</tr>
</tbody>
</table>
### Table 9: Clock Regions View Actions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Toolbar Button</th>
<th>Context Menu</th>
<th>View Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Show/Hide overlay icon]</td>
<td>Show / Hide overlay</td>
<td>Y</td>
<td></td>
<td>Y</td>
<td>Show or Hide the overlay for the chosen clock region in the Floorplanner View.</td>
</tr>
<tr>
<td>![Change color icon]</td>
<td>Change Overlay Color</td>
<td>Y</td>
<td></td>
<td></td>
<td>Allows changing the translucent overlay color which is used to paint the chosen clock region in the Floorplanner View (when the visibility is enabled).</td>
</tr>
<tr>
<td>![Reset color icon]</td>
<td>Reset Overlay Color</td>
<td>Y</td>
<td></td>
<td></td>
<td>Reset the chosen clock region overlay color, allowing ACE to automatically pick a new color. If the overlay colors of two clock regions are too similar for easy discernment, this action pseudo-randomly picks another color. Each time this action is chosen, another color is picked.</td>
</tr>
<tr>
<td>![Zoom icon]</td>
<td>Zoom To</td>
<td>Y</td>
<td></td>
<td></td>
<td>Pans and zooms the Floorplanner View to show the location of the selected clock region.</td>
</tr>
<tr>
<td>![Reset all colors icon]</td>
<td>Reset All Overlay Colors</td>
<td>Y</td>
<td></td>
<td></td>
<td>Pseudo-randomly reassigns new overlay colors for all clock regions.</td>
</tr>
<tr>
<td>![Configure icon]</td>
<td>Configure Clock Pre-Routes...</td>
<td>Y</td>
<td></td>
<td></td>
<td>Allows adding clock pre-route information for the selected partition(s).</td>
</tr>
<tr>
<td>![Show/hide all regions icon]</td>
<td>Show / Hide All Clock Regions</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Toggles the visibility checkboxes for all clock domains in the table, causing all to be alternately shown or hidden in the Floorplanner View.</td>
</tr>
<tr>
<td>![Filter icon]</td>
<td>Toggle Filter Row Visibility</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Changes whether the filter row (of filter icons) at the top of the table is visible or not.</td>
</tr>
</tbody>
</table>

**Table Notes**

1. If the clock region visibility column checkbox is disabled, the clock region overlay is not painted and thus is not visible.
2. This toggle does not alter whether filters are active, it only changes the visibility of the row of filter icons.
Using the Table to Display Clock Regions in the Floorplanner View

Each clock region is automatically given a unique translucent overlay color to represent the clock region when painting the Floorplanner View (see page 57). By default, no clock region overlays are painted in the Floorplanner View. Clock region overlays must be enabled if they are to be displayed. The overlay color may optionally be altered for each/all clock regions, but these color choices do not persist between ACE sessions.

**Note**

While alternate overlay colors are allowed to be chosen for each clock region, these overlay colors are not saved between sessions. Each time a design is loaded, new overlay colors are automatically chosen for each clock region.

The following are ways to alter the presentation of Clock Region data in the Floorplanner View (see page 57):

**Enable/Disable Painting of Individual Clock Regions Within the Target Device:**

When the checkbox in the Visibility column for a clock region is selected, the area of the target device (in the Floorplanner view) representing that clock region is painted in the displayed translucent overlay color. When the checkbox is unchecked, the Floorplanner view is redrawn with the chosen clock region overlay no longer painted.

**Enable/Disable Painting of all Clock Regions Within the Target Device:**

When the Show/Hide All Clock Regions action is selected, the visibility of all clock regions are simultaneously either enabled or disabled, causing the Floorplanner View to be repainted appropriately.

**Temporarily Alter the Overlay Rendering Color of Individual Clock Regions:**

The overlay rendering color of each individual clock region may be chosen as follows:

1. Right-click the mouse pointer anywhere on the row of the desired clock region.
2. Select Choose Overlay Color from the popup context menu.
3. The Color Dialog may then be used to choose the desired color for the clock region.

**Note**

This is a temporary color change — colors are reverted to automatically chosen defaults if changes are made to the active design, the active implementation, the target device, or ACE is closed.

ACE automatically picks a different overlay color for an individual clock region if Reset Overlay Color is selected from the right-click popup content menu.

**Temporarily Alter the Overlay Rendering Color for All Clock Regions:**

ACE automatically picks different overlay colors for all clock regions if the Reset All Overlay Colors action is selected from the Clock Regions View local pull-down menu.

Organizing Table Data

The following are ways to alter the presentation of the data in the Clock Regions table:

**Column Resizing**

The width of a column can be changed as follows:
1. Place the mouse cursor over the boundary between columns — at this point the mouse cursor should change to indicate resizing is possible.
2. Simply left-click and drag left or right to resize the column to the desired width.
3. Release the mouse button.

**Column Reordering**
The order of the columns in the table can be changed as follows:

1. Left-click and hold on any column name
2. Drag left or right to move the column between any other pair of columns.
3. Release the left mouse button to insert the column header at the new location.

While dragging, the dragged column header is visible alongside the mouse cursor, and there is a thick column header separator showing where the column insertion occurs if the mouse is released at the present cursor location.

**Filtering**
Most columns of the table may filter the displayed clock regions by value. When filtering by column value, only clock regions with column values matching the filter are retained; non-matching values are excluded from the table.

- Columns containing text can be filtered by string value. Simple substring text matching (with optional wildcard) is used by default, but Regular Expression matching, also known as RegEx (see https://en.wikipedia.org/wiki/Regular_expression), is also available. The ACE GUI RegEx matching follows Java rules (see https://docs.oracle.com/en/java/javase/11/docs/api/java.base/java/util/regex/Pattern.html), which are extremely similar to Perl rules.
- Columns with checkmarks can be filtered by boolean value.
- Columns containing numbers can be filtered by numerical value.
- Columns which may not be filtered (i.e., the Overlay Color column) lack a filter icon in the filter row.

To add a filter to a column:

1. The Filter Row must first be visible. Select the (Toggle Filter Row Visibility) action to show the row if necessary.
2. Click the ( ) filter icon for the desired column, which causes a data-appropriate filter dialog to appear.
3. Fill in the desired filter values and click **Apply** to apply the filter to the rows in the table.

All values matching that filter are retained, and all other values are excluded. Additionally, the background color of the filtered column changes to a bright yellow to indicate the filter is active, and the filter icon at the head of the column also changes to the ( active filter icon.

To edit (or clear) an existing filter:

1. Click the ( active filter icon, which causes the data-appropriate filter dialog to appear pre-populated with the current column filter setting.
2. Change the filter value and click **Apply** to edit the filter.
3. Click **Cancel** to leave the filter unchanged.
4. Click **Clear** to remove the filter from the column.

If the filter is cleared, the background color of the column returns to the default background color, and the filter icon also changes to the ( inactive version.
Partial Reconfig Cluster Value

The partial reconfig cluster value display at the bottom of the view shows a value representing the set of all clock regions marked as “visible” in the view. Making more or fewer clock regions visible updates this value accordingly.

The Copy hex value to clipboard button copies the current value to the system clipboard.

The Send Tcl command button automatically issues an appropriate set_impl_option bitstream_prc_cluster_map {partial_reconfig_value} command.

Clusters View

The Clusters view allows the toggling the visibility of overlays within the Floorplanner View (see page 57) for each logic cluster. The view table remains empty until the currently active Implementation has been prepared (i.e. the Run Prepare flow step has been completed).

By default, the Clusters view is included in the Floorplanner perspective (see page 24). To add the view to the current perspective, select Window → Show View → Other... → Achronix → Clusters.

![Clusters View Example](image)

**Figure 9: Clusters View Example**

**Table 10: Clusters Table Columns**

<table>
<thead>
<tr>
<th>Column</th>
<th>Editable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visibility</td>
<td>Y</td>
<td>When checked, the logic cluster overlay is painted in the Floorplanner View (see page 57), using the translucent color shown in the Color column.</td>
</tr>
<tr>
<td>Cluster Name</td>
<td></td>
<td>The name of this cluster.</td>
</tr>
<tr>
<td>Color</td>
<td>Y</td>
<td>The color used to paint the location of the cluster as an overlay in the Floorplanner View. Right-click any row, then choose Change Overlay Color to choose an alternate overlay paint color for that cluster.</td>
</tr>
<tr>
<td>Clock Pre-Routes</td>
<td></td>
<td>If any clock pre-routes exist for a given partition, they are listed here.</td>
</tr>
</tbody>
</table>
### Table 11: Clusters View Actions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Toolbar Button</th>
<th>Context Menu</th>
<th>View Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Show/Hide Overlay" /></td>
<td>Show / Hide overlay</td>
<td>Y</td>
<td></td>
<td></td>
<td>Show or Hide the overlay for the chosen cluster in the Floorplanner View.</td>
</tr>
<tr>
<td><img src="image" alt="Change Overlay Color" /></td>
<td>Change Overlay Color</td>
<td>Y</td>
<td></td>
<td></td>
<td>Allows changing the translucent overlay color which is used to paint the chosen cluster in the Floorplanner View (when the visibility is enabled).</td>
</tr>
<tr>
<td><img src="image" alt="Reset Overlay Color" /></td>
<td>Reset Overlay Color</td>
<td>Y</td>
<td></td>
<td></td>
<td>Reset the chosen cluster overlay color, allowing ACE to automatically pick a new color. If the overlay colors of two clusters are too similar for easy discernment, another color is pseudo-randomly selected. Each time this action is chosen, another color is selected.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom To" /></td>
<td>Zoom To</td>
<td>Y</td>
<td></td>
<td></td>
<td>Pans and zooms the Floorplanner View to show the location of the selected cluster. (1)</td>
</tr>
<tr>
<td><img src="image" alt="Reset All Overlay Colors" /></td>
<td>Reset All Overlay Colors</td>
<td>Y</td>
<td></td>
<td></td>
<td>Pseudo-randomly reassigns new overlay colors for all clusters.</td>
</tr>
<tr>
<td><img src="image" alt="Configure Clock Pre-Routes..." /></td>
<td>Configure Clock Pre-Routes...</td>
<td>Y</td>
<td></td>
<td></td>
<td>Allows adding clock pre-route information for the selected partition(s).</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide All Clusters" /></td>
<td>Show /Hide All Clusters</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>This toggles the visibility checkboxes for all logic clusters in the table, causing all to be alternately shown or hidden in the Floorplanner View.</td>
</tr>
<tr>
<td><img src="image" alt="Toggle Filter Row Visibility" /></td>
<td>Toggle Filter Row Visibility</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Changes whether the filter row (of filter icons) at the top of the table is visible or not. (2)</td>
</tr>
</tbody>
</table>

**Table Notes**

1. If the cluster visibility column checkbox is disabled, the cluster overlay is not painted and thus is not visible.
2. This toggle does not alter whether filters are active, it only changes the visibility of the row of filter icons.
Using the Table to Display Clusters in the Floorplanner View

Each cluster is automatically given a unique translucent overlay color to represent the cluster when painting the Floorplanner View (see page 57). By default, no cluster overlays are painted in the Floorplanner View. The cluster overlays must be enabled to be displayed. The overlay color for each/all clusters may optionally be altered, but these color choices are not persisted between ACE sessions.

While choosing alternate overlay colors is allowed for each cluster, these overlay colors are not saved between sessions. Each time a design is loaded, new overlay colors are automatically chosen for each cluster.

The following are ways to alter the presentation of Cluster data in the Floorplanner View (see page 57):

**Enable/Disable Painting of Individual Clusters Within the Target Device:**

When the checkbox in the Visibility column for a cluster is selected, the area of the target device (in the Floorplanner view) representing that cluster is painted in the displayed translucent overlay color. When the checkbox is unchecked, the Floorplanner view is redrawn with the chosen cluster overlay no longer painted.

**Enable/Disable Painting of All Clusters Within the Target Device:**

When the Show/Hide All Clusters action is chosen, the visibility of all clusters are simultaneously either enabled or disabled, causing the Floorplanner View to be repainted appropriately.

**Temporarily Alter the Overlay Rendering Color of Individual Clusters:**

The overlay rendering color of each individual cluster may be chosen as follows:

1. Right-click the mouse pointer anywhere on the row of the desired cluster.
2. Select Choose Overlay Color from the popup context menu.
3. The Color Dialog can then be used to choose the desired color for the cluster.

**Note**

This is a temporary color change — colors are reverted to automatically chosen defaults if changes are made to the active design, the active implementation, the target device, or ACE is closed.

ACE automatically picks a different overlay color for an individual cluster if Reset Overlay Color is chosen from the right-click popup content menu.

**Temporarily Alter the Overlay Rendering Color for All Clusters:**

ACE automatically picks different overlay colors for all clusters if the Reset All Overlay Colors action is chosen from the clusters View local pull-down menu.

**Organizing Table Data**

The following are ways to alter the presentation of the data in the clusters table:

**Column Resizing**

The width of a column can be changed as follows:

1. Place the mouse cursor over the boundary between columns.
2. At this point, the mouse cursor should change to indicate resizing is possible.
3. Simply left-click and drag left or right to resize the column to the desired width.
4. Release the mouse button.

**Column Reordering**

The order of the columns in the table can be changed as follows:

1. Left-click and hold on any column name.
2. Drag left or right to move the column between any other pair of columns.
3. Release the left mouse button to insert the column header at the new location.

While dragging, the dragged column header is visible alongside the mouse cursor and there is a thick column header separator showing where the column insertion is to occur if the mouse is released at the present cursor location.

**Filtering**

Most columns of the table may filter the displayed clusters by value. When filtering by column value, only clusters with column values matching the filter are retained. Non-matching values are excluded from the table.

- Columns containing text can be filtered by string value. Simple substring text matching (with optional wildcard) is used by default, but Regular Expression matching, also known as RegEx (see https://en.wikipedia.org/wiki/Regular_expression), is also available. The ACE GUI RegEx matching follows Java rules (see https://docs.oracle.com/en/java/javase/11/docs/api/java.base/java/util/regex/Pattern.html), which are extremely similar to Perl rules.
- Columns with checkmarks can be filtered by boolean value.
- Columns containing numbers can be filtered by numerical value.
- Columns which may not be filtered (i.e., the Overlay Color column) lack a filter icon in the filter row.

To add a filter to a column:

1. The Filter Row must first be visible. Select the ( 🛡️ ) **Toggle Filter Row Visibility** action to show the row if necessary.
2. Click the ( 🛡️ ) filter icon for the desired column, which causes a data-appropriate filter dialog to appear.
3. Fill in the desired filter values and click **Apply** to apply the filter to the rows in the table.

All values matching that filter are retained, and all other values are excluded. Additionally, the background color of the filtered column changes to a bright yellow to indicate the filter is active, and the filter icon at the head of the column also changes to the ( 🛡️ ) active filter icon.

To edit (or clear) an existing filter:

1. Click the ( 🛡️ ) active filter icon, which causes the data-appropriate filter dialog to appear pre-populated with the current column filter setting.
2. Change the filter value and click **Apply** to edit the filter.
3. Click **Cancel** to leave the filter unchanged.
4. Click **Clear** to remove the filter from the column.

If the filter is cleared, the background color of the column returns to the default background color, and the filter icon also changes to the ( 🛡️ ) inactive version.
Partial Reconfig Cluster Value

The partial reconfig cluster value display at the bottom of the view shows a value representing the set of all clusters marked as "visible" in the view. Making more or fewer clusters visible updates this value accordingly.

The Copy hex value to clipboard button copies the current value to the system clipboard.

The Send Tcl command button automatically issues an appropriate set_impl_option bitstream_prc_cluster_map {partial_reconfig_value} command.

Critical Path Diagram View

The Critical Path Diagram view provides a graphical representation of a single critical path. Selecting a row in the Critical Paths View (see page 52) table updates the Critical Path Diagram view diagram so that it contains a graphical representation of the selected critical path. The graphical representations consist of circular nodes (representing instances) connected by arrows (representing one or more nets). Similar to the Floorplanner View (see page 57), the Critical Path Diagram view contains a Fly-out Palette of display options on the right, and a collection of buttons at the top. The colors used in the Critical Path Diagram view are configured via the Critical Path Diagram View Preference Page (see page 189). For details on usage of the diagram view, please see Using Critical Path Diagrams (see page 335) or Analyzing Critical Paths (see page 332).

By default, the Critical Path Diagram view is included in the Floorplanner perspective (see page 24). To add it to the current perspective, select Window → Show View... → Critical Path Diagram.

Table 12: Critical Path Diagram View Example

When no critical path is selected in the Critical Paths View (see page 52), the diagram displays a warning.

Figure 10: No Critical Path Selected Warning
Table 13: Critical Path Diagram View Toolbar Buttons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Selection tool</td>
<td>Controls the behavior of the mouse while in the Critical Path Diagram view. The selection tool creates a selection rectangle when dragging with the left mouse button. Any objects in the selection rectangle are either added to or removed from the current ACE selection set, as configured in the fly-out palette.</td>
</tr>
<tr>
<td></td>
<td>Movement tool</td>
<td>Controls the behavior of the mouse while in the Critical Path Diagram view. The movement tool pans the view when dragging with the left mouse button.</td>
</tr>
<tr>
<td></td>
<td>Zoom tool</td>
<td>Controls the behavior of the mouse while in the Critical Path Diagram view. The zoom tool creates a zoom-in rectangle when the left mouse button is pressed and held, then dragged to the lower-right. The zoom tool creates a zoom-out line when the left mouse button is pressed and held, then dragged to the upper-left.</td>
</tr>
<tr>
<td></td>
<td>Zoom in</td>
<td>Increases the current zoom level in the Critical Path Diagram view by 200%.</td>
</tr>
<tr>
<td></td>
<td>Zoom out</td>
<td>Decreases the current zoom level in the Critical Path Diagram view by 200%.</td>
</tr>
</tbody>
</table>

Right-clicking on an instance or net within the diagram also displays a context menu of additional actions.

Table 14: Critical Path Diagram View Context Menu Actions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Add to Selection</td>
<td>The instance or net under the mouse is added to the ACE selection set (and painted in the selection color).</td>
</tr>
<tr>
<td></td>
<td>Remove from Selection</td>
<td>The instance or net under the mouse is removed from the ACE selection set if currently selected (and thus no longer is painted the selection color).</td>
</tr>
<tr>
<td></td>
<td>Highlight</td>
<td>Sets the highlight color for the instance or net under the mouse to the currently-chosen view highlight color.</td>
</tr>
<tr>
<td></td>
<td>Choose highlight color</td>
<td>Determines which color is applied to instances/nets the next time the Highlight action is selected for this view.</td>
</tr>
<tr>
<td></td>
<td>Un-Highlight</td>
<td>Turns off the highlight color for the instance or net under the mouse.</td>
</tr>
<tr>
<td></td>
<td>Zoom To</td>
<td>Pans and zooms the Floorplanner view (not this view) to the closest zoom that still displays (centered) the entire instance or net currently under the mouse in the Critical Path Diagram.</td>
</tr>
<tr>
<td></td>
<td>Show in Netlist (1)</td>
<td>Attempts to open a text editor to the file and line number relevant to the instance or net under the mouse.</td>
</tr>
<tr>
<td></td>
<td>Fix Placement of Instance</td>
<td>Causes the placement state of the Instance under the mouse cursor to change from unfixed (or soft) to fixed.</td>
</tr>
</tbody>
</table>
1. Icon | Action | Description
--- | --- | ---
 | Unfix Placement of Instance | Causes the placement state of the Instance under the mouse cursor to change from fixed to unfixed (or soft). |
 | Unplace Instance | Causes the placed instance under the mouse cursor to be unplaced, vacating the site. |
 | Unplace All Selected Instances | Causes all Instances currently in the ACE Selection Set (as listed in the Selection View (see page 136)) to be unplaced at once (this is much more efficient than unplacing multiple instances individually). |

1. **Table Notes**

   1. This Early Access functionality might not always open the text editor to the expected location.

---

**Fly-Out Palette**

The following options are available in the fly-out palette in the Critical Path Diagram view.

**Selection**

The ( ) Selection Options control the selection of objects in the Critical Path Diagram view.

**Table 15: Selection Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select</td>
<td>Enabled</td>
<td>This radio button controls the action applied to objects in the selection region. This setting causes the objects to be added to the current ACE selection set.</td>
</tr>
<tr>
<td>Deselect</td>
<td>Disabled</td>
<td>This radio button controls the action applied to objects in the selection region. This setting causes the objects to be removed from the current ACE selection set.</td>
</tr>
</tbody>
</table>

**Label**

The ( ) Label options control the text labels on graph nodes and arrows (instances and net abstractions) in the Critical Path Diagram view. Note that these labels are only displayed when there is enough room for them to be printed on-screen. It might be necessary to **Zoom In** to provide sufficient area for all the desired text to be displayed.
**Table 16: Label Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance Names</td>
<td>Displays the instance name each graph node represents.</td>
</tr>
<tr>
<td>Instance Types</td>
<td>Displays the instance type (cell) for each graph node.</td>
</tr>
<tr>
<td>Net Names</td>
<td>Displays the net name represented by each arrow.</td>
</tr>
<tr>
<td>Delays</td>
<td>Displays the delay (in ps) to traverse each node or arrow.</td>
</tr>
<tr>
<td>Fanouts</td>
<td>Displays the fanout of the net represented by the arrow.</td>
</tr>
</tbody>
</table>

**ToolTip Text**

The (_tooltip) Tooltips options control the tooltip content while hovering over graph nodes and arrows in the Critical Path Diagram view.

**Table 17: Tooltip Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>No tooltips are displayed for nodes or arrows.</td>
</tr>
<tr>
<td>Instance Names</td>
<td>Displays the instance name each graph node represents.</td>
</tr>
<tr>
<td>Instance Types</td>
<td>Displays the instance type (cell) for each graph node.</td>
</tr>
<tr>
<td>Net Names</td>
<td>Displays the net name represented by each arrow.</td>
</tr>
<tr>
<td>Pin Names</td>
<td>Displays source and sink pin names for nets.</td>
</tr>
<tr>
<td>Delays</td>
<td>Displays the delay (in ps) to traverse each node or arrow.</td>
</tr>
<tr>
<td>Fanouts</td>
<td>Displays the fanout of the net represented by the arrow.</td>
</tr>
</tbody>
</table>

**Critical Paths View**

The Critical Paths view provides a table of critical paths resulting from running timing analysis. This view (in cooperation with the Critical Path Diagram View (see page 49)) displays critical path details, manages selection of objects on critical paths, and highlights critical paths in the Floorplanner View (see page 57).

Clicking a row in the table enables toolbar buttons for analyzing the associated critical path, and causes the display of a graphical diagram of the associated critical path in the Critical Path Diagram View (see page 49). Clicking a column header sorts the table according to the data in that column.

By default, the Critical Paths view is included in the Floorplanner perspective (see page 24). To add it to the current perspective, select **Window → Show View... → Critical Paths**.
Table 18: Critical Path View Actions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Select path" /></td>
<td>Select path</td>
<td>Adds the selected critical path in the table to the current ACE selection set.</td>
</tr>
<tr>
<td><img src="image" alt="Select pins" /></td>
<td>Select pins</td>
<td>Adds pins on the selected critical path in the table to the current ACE selection set.</td>
</tr>
<tr>
<td><img src="image" alt="Select instances" /></td>
<td>Select instances</td>
<td>Adds instances on the selected critical path in the table to the current ACE selection set.</td>
</tr>
<tr>
<td><img src="image" alt="Select nets" /></td>
<td>Select nets</td>
<td>Adds nets on the selected critical path in the table to the current ACE selection set.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom to path" /></td>
<td>Zoom to path</td>
<td>Zooms the Floorplanner view to a region containing the selected critical path in the table.</td>
</tr>
<tr>
<td><img src="image" alt="Print Path Details" /></td>
<td>Print Path Details</td>
<td>Produces a detailed report of the selected critical path in the table to the text output in the Tcl Console view.</td>
</tr>
<tr>
<td><img src="image" alt="Save Script File" /></td>
<td>Save Script File</td>
<td>Displays the Save Script File dialog which allows saving a Tcl script of find commands for use in the schematic viewer of the synthesis tool.</td>
</tr>
</tbody>
</table>

The view is primarily made up of a tree table, with each branch of the tree representing a separate clock domain. The most critical path of each clock domain is the branch node, with all other paths from that clock domain acting as leaves for that branch. Setup violations are considered "worse" than hold violations, thus any setup violation takes precedence over hold violations as the branch node, regardless of relative slack values.

![Critical Path View Example](image)

Entries in the table are always grouped by clock domain, with individual paths sorted within a clock domain. The clock domains themselves are (by default) sorted from most critical to least critical.

The default sort order, from most critical to least critical, of the critical paths is as follows:

1. Setup violations, from the most negative slack value to zero.
2. Hold violations, from the most negative slack value to zero.
3. Setup met, from zero to the most positive slack.

Figure 11: Critical Path View Example

Entries in the table are always grouped by clock domain, with individual paths sorted within a clock domain. The clock domains themselves are (by default) sorted from most critical to least critical.

The default sort order, from most critical to least critical, of the critical paths is as follows:

1. Setup violations, from the most negative slack value to zero.
2. Hold violations, from the most negative slack value to zero.
3. Setup met, from zero to the most positive slack.
4. Hold met, from zero to the most positive slack.

**Table 19: Critical Path View Table Columns**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highlight</td>
<td>Allows highlighting the path in the Floorplanner view, using the checkbox. Also allows configuring the highlight color of the path by clicking the color selector box.</td>
</tr>
<tr>
<td>Clock Domain</td>
<td>Displays the clock domain name of the path.</td>
</tr>
<tr>
<td>Path</td>
<td>Displays the unique path ID (used in the Timing Report (see page 229)).</td>
</tr>
<tr>
<td>Slack</td>
<td>Displays the slack for the path in ns.</td>
</tr>
<tr>
<td>Type</td>
<td>Displays the path type.</td>
</tr>
<tr>
<td>Source</td>
<td>Displays the source instance of the path.</td>
</tr>
<tr>
<td>Destination</td>
<td>Displays the destination instance of the path.</td>
</tr>
</tbody>
</table>

By default, the highlight colors for the Setup Violation and Hold Violation path types ranges from red (the worst slack values) through orange to yellow (any Violation slack values close to zero). The default highlight color of Slack Met and Hold Met path types is always green, and does not vary by reported slack value.

The View local pull-down menu (found to the right of the View Toolbar buttons) contains some additional controls for the view: four filters to control which Types of paths are displayed in the table, as well as shortcuts to run the four stages of timing analysis. As mentioned previously, the most critical path within each clock domain is always displayed, regardless of the type filter settings. (Every clock domain is always represented in the tree table by at least one row of data.)

**Table 20: Critical Paths View Drop-down Menu Actions**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Clock Paths</td>
<td>If checked, highlighted critical paths in the Floorplanner View show the clock routing segments as part of the critical path. If unchecked, only the data portion of the critical path is shown.</td>
</tr>
<tr>
<td>Show Setup Violations</td>
<td>If checked, Setup Violation leaf nodes are shown in the treetable. If unchecked, these leaf nodes are hidden.</td>
</tr>
<tr>
<td>Show Hold Violations</td>
<td>If checked, Hold Violation leaf nodes are shown in the treetable. If unchecked, these leaf nodes are hidden.</td>
</tr>
<tr>
<td>Show Setup Met</td>
<td>If checked, Setup Met leaf nodes are shown in the treetable. If unchecked, these leaf nodes are hidden.</td>
</tr>
<tr>
<td>Show Hold Met</td>
<td>If checked, Hold Met leaf nodes are shown in the treetable. If unchecked, these leaf nodes are hidden.</td>
</tr>
<tr>
<td>Run Prepared Timing Analysis</td>
<td>If selected, runs the Prepared Timing Analysis flow step.</td>
</tr>
</tbody>
</table>
### Action | Description
--- | ---
Run Post-Place Timing Analysis | If selected, runs the Post-Place Timing Analysis flow step.
Run Post-Route Timing Analysis | If selected, runs the Post-Route Timing Analysis flow step.
Run Final Timing Analysis | If selected, runs the Final Timing Analysis flow step.

**Download View**

The Download view provides a graphical interface for choosing and downloading (via JTAG) a bitstream *.hex file to an Achronix FPGA or eFPGA connected to the workstation using USB via a Bitporter2 pod or FTDI FT2232H or FT4232H device. Bitstream *.hex files are generated by ACE during the Generate Bitstream Flow step (see page 223).

By default, the Download view is included in the Programming and Debug perspective (see page 24). To access the Download view if it is not visible in the current perspective, select Window → Show View... → Others → Download View.

When the Download view opens, the windows might need to be resized for optimal viewing.

**Caution!**

- The JTAG connection must be configured before using the Download view!
  - ACE interacts with the FPGA or eFPGA using the JTAG interface through a USB Bitporter2 pod or FTDI FT2232H device. This JTAG interface must be properly configured in ACE before using the Download view. The configuration is managed using the Configure JTAG Connection Preference page (see page 187), which is easily accessible by pressing the (Configure JTAG Interface) button in the Download view. See Configuring the JTAG Connection (see page 339) for more details.
  - (The (Download Bitstream) button and the (Configure JTAG Interface) button each also provide a summary of the current JTAG configuration settings (for pod name and scan chain) in their tooltips for ease of reference.)
  - While using the Download view, it is strongly recommended that the Tcl Console view (see page 144) be kept visible to display any status or error messages reported during the JTAG interactions. (The Tcl Console view and Download view are both visible by default in the Programming and Debug perspective.)

In addition to allowing the choice of a bitstream file and performing actual downloads, this view also allows toggling of some programming options, and some related utility interactions with JTAG-connected devices.

For all buttons and checkboxes, tooltips provide a more verbose description of each, if the summary statement is insufficient. The (Download Bitstream) button and the (Configure JTAG Interface) button each also provide a summary of the current JTAG configuration settings (for pod name and scan chain) in their tooltips for ease of reference.

See also:

- Programming a Device (see page 367)
- JTAG Configuration User Guide (UG004)
• Device family-specific user guide (i.e., Speedster7t Configuration User Guide (UG094))

Figure 12: Download View Example
Table 21: Download View Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JTAG Programming Options</td>
<td></td>
</tr>
<tr>
<td>Perform an FCU reset to clear the (e)FPGA config memory.</td>
<td>When checked, performs a soft reset and clears all device configuration memory before beginning programming. This reset is typically only disabled for multi-stage programming (after stage 0 programming has completed, before programming later stages begins), or for &quot;partial reconfig&quot; when partial bitstreams are in use (see the chapter titled Partial Reconfiguration in the Speedster7t Configuration User Guide (UG094) for more details).</td>
</tr>
<tr>
<td>Close the JTAG connection/device when programming is complete.</td>
<td>By default, the chosen JTAG connection (see Configuring the JTAG Connection (see page 339)) is opened at the beginning of programming (if it was not already open) and is closed when programming is completed. Uncheck this box to leave the named JTAG connection open when programming is complete, allowing additional JTAG interactions to occur over the same open connection.</td>
</tr>
<tr>
<td>Browse</td>
<td>Allows choosing any *.hex bitstream file from the file system using a graphical file system browser.</td>
</tr>
<tr>
<td>Download Bitstream</td>
<td>Pressing this button performs the actual download by calling the appropriate Tcl commands in the jtag:: namespace. See also: JTAG Configuration User Guide (UG004).</td>
</tr>
<tr>
<td>Suggested Bitstream Files</td>
<td>A list of all *.hex bitstream files (shown as hyperlinks) found in the output directory of the current Active Implementation (see page 223). Select any of these hyperlinks to choose that file for download. A list of the most recently used *.hex bitstream files (shown as hyperlinks). Select any of these hyperlinks to choose that file for download.</td>
</tr>
<tr>
<td>JTAG Utilities</td>
<td>Report a list of all available USB-connected JTAG devices by ID. Press the button to run a Tcl command (jtag::get_connected_devices) to report a list of all connected JTAG devices in the Tcl Console view.</td>
</tr>
</tbody>
</table>

Floorplanner View

The Floorplanner view provides a graphical view of the physical layout of the device. This view allows visualizing the device, place and route data, critical paths, and the current selection set. The view allows zooming out to see a general overview of the user design mapped onto the device, or zooming in to see specific details.

Clicking the tall narrow arrow button on the far right of the Floorplanner view shows or hides the Fly-Out Palette (see page 61) of display options. By default, the Floorplanner view is included in the Floorplanner perspective (see page 24). To add it to the current perspective, select Window → Show View → Other... → Floorplanner.
See also:

- Viewing the Floorplanner (see page 320)
- Pre-placing a design (see page 326)
- Floorplanner View Colors and Layers Preference Page (see page 191)
- Floorplanner View Optimizations Preference Page (see page 196).

**Figure 13: Floorplanner View Example, Including Expanded Fly-Out Palette**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon.png" alt="Panning tool" /></td>
<td>Panning tool.</td>
<td>Controls the behavior of the mouse while in the Floorplanner view. The panning tool allows panning of the view when the left mouse button is pressed and held.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Holding SPACE temporarily switches to the Panning tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Releasing SPACE switches back to the previously selected tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tapping ALT cycles to the next tool.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Placement Region tool" /></td>
<td>Placement Region tool.</td>
<td>Controls the behavior of the mouse while in the Floorplanner view. Allows the manipulation of placement regions and placement region constraints (see page 371).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When the Placement Region tool is active, the mouse may be used to create new placement regions (see page 371), move (see page 373) or resize (see page 373) existing placement regions, and/or assign objects to placement region constraints (see page 374).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pressing ALT cycles to the next tool.</td>
</tr>
</tbody>
</table>
### Table 23: Floorplanner View Context Menu Actions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add to selection icon" /></td>
<td>Add to selection.</td>
<td>The instance or net under the cursor is added to the ACE selection set (and is painted in the selection color).</td>
</tr>
<tr>
<td><img src="image" alt="Remove from selection icon" /></td>
<td>Remove from selection.</td>
<td>The instance or net under the cursor is removed from the ACE selection set if currently selected (and thus is no longer painted the selection color).</td>
</tr>
<tr>
<td><img src="image" alt="Highlight icon" /></td>
<td>Highlight.</td>
<td>Sets the highlight color for the instance or net under the cursor to the currently-chosen Floorplanner view highlight color.</td>
</tr>
<tr>
<td><img src="image" alt="Choose highlight color icon" /></td>
<td>Choose highlight color.</td>
<td>Determines which color is applied to instances or nets the next time the Highlight action is selected for this view.</td>
</tr>
<tr>
<td><img src="image" alt="Remove highlight icon" /></td>
<td>Remove highlight.</td>
<td>Turns off the highlight color for the instance or net under the cursor.</td>
</tr>
</tbody>
</table>
**Panning and Zooming**

The Floorplanner view allows zooming in and out, to see more or less details respectively. There are several ways to change the zoom level:

1. Use the mouse scroll wheel.
2. Use the ( ⌬ ) **Zoom In** and ( ⌫ ) **Zoom Out** buttons in the toolbar.
3. Use keyboard shortcuts.

See the task **Zooming the Floorplanner In and Out (see page 320)** for complete details.

Most of the other views within the Floorplanner perspective also include context-sensitive actions to **Zoom To** chosen individual objects or groups of objects — these actions cause the Floorplanner to center the chosen object(s) in the Floorplanner, and to change the zoom level so that the chosen object(s) are as large/detail as possible without overflowing the visible area.

When zoomed in, the FPGA requires more area than can easily fit in the view, making it necessary to pan the view around to see the different areas of the FPGA. Panning is most frequently performed using the arrow keys on the keyboard, mouse interactions with the scrollbars, the Panning Tool, or drag-scrolling during drag-and-drop interactions. See the task **Floorplanner Panning (see page 321)** for complete details.

**Note**

When painting objects in the Floorplanner, when the view is zoomed out, some objects become too small to be rendered with any detail. These objects are painted, at a minimum, as a single pixel of the appropriate color.
Empty sites (those without a placed instance) are a special case. Unless selected, sites that are too small are not painted at all, even if layer settings would otherwise allow them to be visible. Selected sites are always painted, with a minimum size of a single pixel. When a single pixel represents multiple objects, as happens when zoomed all the way out, ACE paints only the most critical or most important object state at that pixel location, so the single pixel is the most critical or most important color. The relative priorities of the states are described in Instance States (see page 245).

Fly-Out Palette
The following options are available in the fly-out palette in the Floorplanner view:

Layers
The ( ) Layer Options control several layers of visible data in the Floorplanner view, allowing filtering the view so it contains a desired subset of all the available information.

Table 24: Layer Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instances</td>
<td>Enabled</td>
<td>This layer shows all placed instances.</td>
</tr>
<tr>
<td>Selected Instance Flylines</td>
<td>Disabled</td>
<td>This layer shows flylines representing the net connections of selected instances (instances in the ACE selection set).</td>
</tr>
<tr>
<td>Clock Nets</td>
<td>Enabled</td>
<td>This layer shows all clock nets.</td>
</tr>
<tr>
<td>Non-clock Nets</td>
<td>Enabled</td>
<td>This layer shows all non-clock nets.</td>
</tr>
</tbody>
</table>

Routing Status

<table>
<thead>
<tr>
<th>Option</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Connections</td>
<td>Disabled</td>
<td>Toggles the display of open portions of a net. Open connections are displayed in the same color as the routed portion of a net, but with a dotted line instead of a solid line. Open connections are a subset of a normal net, and are thus also managed by the layer options for Non-clock Routes, Clock Routes, and Route Drawing Mode.</td>
</tr>
<tr>
<td>Open Pins</td>
<td>Disabled</td>
<td>Toggles the display of squares highlighting the pins (red by default) at the endpoints of open connections.</td>
</tr>
<tr>
<td>Overflows</td>
<td>Disabled</td>
<td>Toggles the display of diamonds highlighting pins (orange by default) where route overflows occur (this is very rare).</td>
</tr>
<tr>
<td>Pins</td>
<td>Disabled</td>
<td>This layer shows all pins on each site.</td>
</tr>
<tr>
<td>Sites</td>
<td>Enabled</td>
<td>This layer shows all the sites on the device.</td>
</tr>
</tbody>
</table>

Table Notes
1. The displayed flylines are filtered by the Non-clock Routes and Clock Routes layer checkboxes. If only Clock Routes is checked, then only the flylines for clock nets of the selected instance(s) are displayed.
2. **Caution**: Dotted lines, as used for open connections, are much slower to render than solid lines. Thus, it is recommended that open connections remain disabled unless they are specifically needed for debugging purposes.
Note

Open Connections and Open Pins
When displaying an open connection for a placed instance, if the specific source and/or sink pins are not yet known (or not yet specified by the router), the connection is rendered to/from the center of the placed instance instead of to/from a specific pin. Likewise, when specific pins are not known, the Open Pins squares (red by default) are rendered in the center of the placed instance instead of on a specific pin (open connections and open pins are not, of course, rendered for unplaced instances). Be aware that in a placed design that has not yet been routed, all nets are considered open connections. Enabling Open Pins can make it much easier to find unrouted portions of a mostly routed design when zoomed out. But be aware this might be overwhelming on a large design that has been placed but not yet routed. Every unrouted net is considered open. Thus, in an unrouted design, every endpoint of every net displays an open pin square, merging into a single large mass of color when zoomed out.

Tip

Objects in the ACE Selection Set Are Always Visible
By default, any/all objects in the current ACE selection set (as shown in the Selection view (see page 136)) are always visible in the Floorplanner, regardless of the chosen "Layers" filter settings. This means even if the Instances layer is disabled, any Instances in the current ACE selection set are still painted in the selected instances color (by default, bright green). Details of this behavior can be configured on the Floorplanner View Colors and Layers preference page (see page 191).

In addition to the layers listed in the table, there are several other types of information displayed in the Floorplanner — enabling and disabling the display of these other types of information is controlled from other views. For example, the visibility of individual clock regions is controlled from the Clock Regions view (see page 39); the visibility of individual Placement regions is controlled from the Placement Regions view (see page 118); and the visibility of individual critical paths is controlled from the Critical Paths view (see page 52).

Highlighting

Special colored highlighting of objects in the Floorplanner is possible via Tcl (see the highlight (see page 586) Tcl command) and/or may be triggered via associated highlighting actions in most of the other views in the Floorplanner perspective. Highlighted objects are only visible in the Floorplanner if the appropriate layer is enabled, and the highlight color is only used if the object is not currently a member of the ACE selection set.

By default, the selection color takes precedence over the highlight color, which in turn takes precedence over the default color of the object. Further information about precedence of these states for instances can be found under Instance States (see page 245), and can be partially reconfigured in the Floorplanner View Colors and Layers preference page (see page 191). Additional information regarding highlighting can be found at Highlighting Objects in the Floorplanner View (see page 323).

Selection

The ( ) Selection Options control the selection of objects with the mouse in the Floorplanner view. Selected objects are added to the ACE selection set, and displayed appropriately in the Selection view (see page 136).
Table 25: Selection Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instances</td>
<td>Enabled</td>
<td>Enables visible instances to be selected. If not checked, instances in the selection region are not added to the ACE selection set.</td>
</tr>
<tr>
<td>Nets</td>
<td>Enabled</td>
<td>Enables visible nets to be selected. If not checked, nets in the selection region are not added to the ACE selection set.</td>
</tr>
<tr>
<td>Pins</td>
<td>Disabled</td>
<td>Enables visible user design pins to be selected. If not checked, pins in the selection region are not added to the ACE selection set.</td>
</tr>
<tr>
<td>Paths</td>
<td>Disabled</td>
<td>Enables visible paths to be selected. If not checked, paths in the selection region are not added to the ACE selection set.</td>
</tr>
<tr>
<td>Sites</td>
<td>Disabled</td>
<td>Enables visible sites to be selected. If not checked, sites in the selection region are not added to the ACE selection set.</td>
</tr>
</tbody>
</table>

Action

<table>
<thead>
<tr>
<th>Action</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select</td>
<td>Enabled</td>
<td>Controls the action applied to objects in the selection region. Causes the objects to be added to the current ACE selection set.</td>
</tr>
<tr>
<td>Deselect</td>
<td>Disabled</td>
<td>Controls the action applied to objects in the selection region. Causes the objects to be removed from the current ACE selection set.</td>
</tr>
<tr>
<td>Remove Placement</td>
<td>Disabled</td>
<td>Controls the action applied to enabled objects in the selection region. Causes the placed instances to be un-placed.</td>
</tr>
<tr>
<td>Fix Placement</td>
<td>Disabled</td>
<td>Controls the action applied to enabled objects in the selection region. Causes the soft-placed instances to attempt to have fixed placement at the same site.</td>
</tr>
<tr>
<td>Un-fix Placement</td>
<td>Disabled</td>
<td>Controls the action applied to enabled objects in the selection region. Causes any fixed-placed instances to change to soft placement at the same site.</td>
</tr>
</tbody>
</table>

Note

**Mouse Selection Actions Are Filtered by Layers Visibility**

If **Instances** is checked under Selection but not under Layers, it is not possible to perform selection actions upon instances in the Floorplanner view using the mouse.

For example, this allows performing selection actions on only clock routes or only non-clock routes as desired, by simply setting the Layers filters appropriately.
**Placement**

The (icontroller) Placement Options control the drag-and-drop placement behavior in the Floorplanner view.

**Table 26: Placement Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Placement</td>
<td>Disabled</td>
<td>[Expert Functionality] This option controls whether single instances or groups of instances are placed with the drag-and-drop action of the Placement tool. Group Placement requires a group of instances to be in the ACE Selection Set prior to initiating drag and drop. Group Placement only succeeds in very specific circumstances, thus this setting should only be enabled by expert users who understand the caveats.</td>
</tr>
<tr>
<td>Fixed Placement</td>
<td>Enabled</td>
<td>This option controls whether the drag-and-drop placement of an instance should be considered fixed or soft. Fixed placements are not changed by the placer. Soft placements are taken as a placement hint and might be changed by the placer.</td>
</tr>
</tbody>
</table>

⚠️ **Caution**

When pre-placing objects (for a pre-placement constraints .pdc file), **Fixed Placement** should always be enabled.

**Tool Tip Text**

The (icontroller) Tooltip options control the tooltip content while hovering over visible objects in the Floorplanner view.

**Table 27: Tooltip Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Tooltips</td>
<td>Enabled</td>
<td>Allows enabling/disabling Tooltip support for the Floorplanner without needing to toggle all the individual checkboxes.</td>
</tr>
<tr>
<td>Instance Names</td>
<td>Enabled</td>
<td>Includes the names of all placed instances under the current mouse position in the tooltip text.</td>
</tr>
<tr>
<td>Port Names</td>
<td>Enabled</td>
<td>Includes the RTL port names of placed instances under the current mouse position in the tooltip text.</td>
</tr>
<tr>
<td>Net Names</td>
<td>Enabled</td>
<td>Includes all net names under the current mouse position in the tooltip text.</td>
</tr>
<tr>
<td>Pin Names</td>
<td>Disabled</td>
<td>Includes all user design pin names under the current mouse position in the tooltip text.</td>
</tr>
<tr>
<td>Site Names</td>
<td>Enabled</td>
<td>Includes all leaf site names under the current mouse position in the tooltip text.</td>
</tr>
<tr>
<td>Site Types</td>
<td>Enabled</td>
<td>Includes the site cell type of each leaf site under the current mouse position in the tooltip text.</td>
</tr>
</tbody>
</table>
### Table 1: Tool Tip Text

<table>
<thead>
<tr>
<th>Option</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Pin Names</td>
<td>Disabled</td>
<td>Includes all site pin names under the current mouse position in the tooltip text.</td>
</tr>
<tr>
<td>Device Port Names</td>
<td>Enabled</td>
<td>Includes the top-level port names of the target device under the current mouse position in the tooltip text.</td>
</tr>
<tr>
<td>Subtile Coordinates (1)</td>
<td>Enabled</td>
<td>Includes the subtile coordinates under the current mouse position in the tooltip text.</td>
</tr>
<tr>
<td>Partition Names</td>
<td>Enabled</td>
<td>Includes all partition names under the current mouse position in the tooltip text.</td>
</tr>
<tr>
<td>Clusters</td>
<td>Enabled</td>
<td>Includes the name of the cluster under the current mouse position in the tooltip text.</td>
</tr>
</tbody>
</table>

### Table Notes

1. Subtile coordinates may be used with placement region commands on the Tcl command line.

### Note

**Tooltips Are Filtered by Layers Visibility**

If **Instance Names** is checked under "Tool Tip Text" but **Instances** is not checked under "Layers", it is not possible to see instance names in the tooltips.

### Label

The ( ) Label options control the text labels on objects in the Floorplanner view.

#### Table 28: Label Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Enabled</td>
<td>This option disables label display.</td>
</tr>
<tr>
<td>Instance Names</td>
<td>Disabled</td>
<td>This option displays the instance names on placed instances.</td>
</tr>
<tr>
<td>Port Names</td>
<td>Disabled</td>
<td>This option displays the RTL port names on placed instances.</td>
</tr>
<tr>
<td>Site Names</td>
<td>Disabled</td>
<td>This option displays the full site names on each leaf site.</td>
</tr>
<tr>
<td>Site Types</td>
<td>Disabled</td>
<td>This option displays the site cell type on each leaf site.</td>
</tr>
<tr>
<td>Device Port Names</td>
<td>Disabled</td>
<td>This option displays the top-level port names of the target device connected to the I/O site.</td>
</tr>
</tbody>
</table>
Flow View

The Flow view provides a hierarchical view of Flow steps (see page 223) that can be performed on the Active Project and Implementation (see page 223). From here, flow steps can be run and flow status (see page 227) viewed. Flow steps are not able to run unless an active implementation is selected in the Projects view (see page 123). When running flow steps, the implementation options (see page 106) of the active implementation are used to govern the behavior of the flow. Be aware that altering the value of an implementation option clears the flow state of all downstream flow steps, changing them from the Complete state back to Incomplete.

By default, the Flow view is included in the Projects perspective (see page 24). To add it to the current perspective, click Window → Show View → Other... → Achronix → Flow.

For more details, see the Flow (see page 223) concept and the tasks for Running the Flow (see page 283).

![Flow View Example](image)

**Table 29: Flow View Icons**

<table>
<thead>
<tr>
<th>State</th>
<th>Flow Category</th>
<th>Flow Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incomplete</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>Running</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>Complete</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>State</td>
<td>Flow Category</td>
<td>Flow Step</td>
</tr>
<tr>
<td>---------</td>
<td>---------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Disabled</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Warning</td>
<td>![Icon]</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Error</td>
<td>![Icon]</td>
<td>![Icon]</td>
</tr>
</tbody>
</table>
Note

If the (⚠️) icon appears on a Flow category or Flow step, this typically means ACE has detected changes to project source files, where the current source files on disk no longer match the design currently in memory. See Detecting Changes to Project Source Files (see page 300).

### Table 30: Flow View Actions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Toolbar Button</th>
<th>Context Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Run Flow</td>
<td>Y</td>
<td></td>
<td>Runs all the enabled flow steps sequentially from the beginning of the flow.</td>
</tr>
<tr>
<td>🔄</td>
<td>Resume Flow</td>
<td>Y</td>
<td></td>
<td>Resumes running the flow from the last completed flow step. If no flow steps have been attempted yet, this action behaves identically to Run Flow.</td>
</tr>
<tr>
<td>🔄</td>
<td>Show Multiprocess View</td>
<td>Y</td>
<td></td>
<td>Launches the Multiprocess View (see page 86), which allows managing multiple runs of the flow in parallel.</td>
</tr>
<tr>
<td>⏸️</td>
<td>Stop flow (1)</td>
<td>Y</td>
<td>Y</td>
<td>Stops the execution of any flow steps after the currently running flow step. Also attempts to interrupt the currently running flow step if possible.</td>
</tr>
<tr>
<td>🔄</td>
<td>Run Selected Flow Step (2)</td>
<td>Y</td>
<td></td>
<td>Runs the selected flow step, also running any required preceding flow steps that have not yet run. Preceding flow steps that are enabled but not required are skipped.</td>
</tr>
<tr>
<td>🔄</td>
<td>Re-Run Flow</td>
<td>Y</td>
<td></td>
<td>Runs all the enabled flow steps sequentially from the beginning of the flow. Behavior is now identical to Run Flow.</td>
</tr>
<tr>
<td>🔄</td>
<td>Re-Run Flow with init (3)</td>
<td>Y</td>
<td></td>
<td>Behaves identically to Re-Run Flow, unless Incremental Compilation is enabled. If Incremental Compilation is enabled, this additionally forces a full recompile of all partitions; any prior partition state is ignored (and overwritten).</td>
</tr>
<tr>
<td>🔄</td>
<td>Clear Flow (4)</td>
<td>Y</td>
<td></td>
<td>Issues a clear_flow (see page 555) TCL command. All flow categories and flow steps with the state of Complete or Error are reset to the state of Incomplete. Additionally, the state of the current active project and implementation are cleared, as if they had not yet been run through the flow.</td>
</tr>
<tr>
<td>🔄</td>
<td>Create Flow Step (5)</td>
<td>Y</td>
<td></td>
<td>Displays an interactive dialog for creating a user-defined flow step (the dialog includes a prompt for which a single Tcl command should be invoked for this step) at the selected location within the flow.</td>
</tr>
<tr>
<td>🔄</td>
<td>Remove Flow Step</td>
<td>Y</td>
<td></td>
<td>Removes a selected user-defined flow step. Only steps the user has created with Create Flow Step may be removed; this action cannot be used to remove “reserved” steps.</td>
</tr>
</tbody>
</table>

Table Notes

1. Some flow steps, such as FPGA Download, are currently unable to be interrupted while running.
2. Double-clicking a flow step is equivalent to this action.
3. Caution: This action is only relevant when using Incremental Compilation (Partitions) (see page 380). If Incremental Compilation is disabled, this action behaves identically to Re-Run Flow.
4. Clear Flow does not remove any prior saved state from the hard drive. Any prior saved state may subsequently be (re-)loaded, including any partition state for incremental compilation.
5. Caution: Creation of user-defined flow steps is only recommended for advanced users.
Warning!

Current Flow Mode Setting Impacts Which Flow Steps Are Executed

The implementation option for Flow Mode (see page 228) affects which flow steps are executed during the Run Flow, Resume Flow, Re-Run Flow, and Re-Run Flow using -ic init actions (or related Tcl commands).

If warnings or errors are encountered while a flow step is running, they appear in the Flow view next to the name of the flow step where they occurred.

The colors used for the warning and error text are the same as those used to display warnings and errors in the Tcl Console view (see page 144). They can be adjusted through the Colors and Fonts link on the Tcl Console Preference Page (see page 213).

![Flow View Warnings and Errors Example](image)

**Figure 15: Flow View Warnings and Errors Example**

Clicking the colored "warning" or "error" text brings up a dialog listing all problems.

Clicking any of the problems in the list opens the corresponding log file in an editor, scrolled to the location of the problem in question.
Warning!

- **The JTAG connection must be configured before using the HW Demos.**
  ACE interacts with the FPGA using the JTAG interface through a Bitporter pod or FTDI FT2232H device. This JTAG interface must be properly configured in ACE before using the HW Demo functionality. The configuration is managed using the Configure JTAG Connection Preference Page (see page 187). See Configuring the JTAG Connection (see page 339) for more details.

- **The DCC connection must be configured before using the HW Demos.**
  ACE interacts with the HW Demo designs (and reference designs) using the DCC interface to the FPGA through a USB cable (not the Bitporter). This interface must be properly configured in ACE before using the HW Demo functionality. The configuration is managed using the Configure DCC Connection Preference Page (see page 186). See Configuring the DCC Connection (see page 338) for more details.

The HW Demo view provides a graphical interface for demonstrating particular aspects of a user selected device, using provided sample designs. These sample designs are typically provided as self-documenting overlays for the standard ACE installation.

By default, the HW Demo view is included in the **HW Demo Perspective** (see page 24). To access the HW Demo view from any other perspective, select **Window → Show View → Other... → Achronix → HW Demo**.

Before any demo overlays are installed, there are no demo designs available. In that case, the view will display minimal information:
After demos are installed as ACE overlays, from this view the status of various board components can be observed updating in real-time as the demonstration design is running on the connected board. For example, in a basic fabric demonstration, when an associated DIP switch is changed, it is reflected in the view display; likewise when an LED on the board changes state (on/off) it is reflected in the view. Individual memory locations may be read and examined, and new values may be entered and "pushed" out to the target device.

Most hardware demos (including reference designs) are designed to show the features of the various hard IP blocks integrated into the target Achronix FPGA. Each demo or reference design installation package comes with associated documentation specific to the design.

Talk to your Achronix Marketing contact or FAE to request access to the demos appropriate to your development board.

See also: Running the HW Demo (see page 377).

**Table 31: HW Demo View Toolbar Buttons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure DCC Interface</td>
<td>Open preferences dialog to the Configure DCC Connection Preference Page (see page 186).</td>
<td></td>
</tr>
<tr>
<td>Configure JTAG Interface</td>
<td>Open preferences dialog to the Configure JTAG Connection Preference Page (see page 187).</td>
<td></td>
</tr>
</tbody>
</table>

**Table 32: HW Demo View Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demo Selection and Download</td>
<td></td>
</tr>
<tr>
<td>Target Device</td>
<td>List of FPGA devices that have demonstration designs.</td>
</tr>
<tr>
<td>Demo Design</td>
<td>List of demonstration designs for the currently selected device.</td>
</tr>
<tr>
<td>Download</td>
<td>Loads the currently selected demonstration design into the attached board.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Board Status</strong></td>
<td></td>
</tr>
<tr>
<td>LED State</td>
<td>Visually represents relevant LEDs from the attached board. When an LED changes state on the board, it is reflected in the view LED display. Clicking an individual LED in the view causes the corresponding LED on the attached board to toggle its state.</td>
</tr>
<tr>
<td>DIP Switch State</td>
<td>Visually represents the eight DIP switches from the attached board. When a switch changes state on the board, it is reflected in the DIP switch display. Clicking an individual switch in the view does not cause the corresponding switch on the attached board to toggle its state.</td>
</tr>
<tr>
<td>Device State</td>
<td>Displays DCC connection status and demo version number.</td>
</tr>
<tr>
<td><strong>Demo Control and Status</strong></td>
<td></td>
</tr>
<tr>
<td>Each specific demonstration design has a simple user interface that is presented in the bottom section of the view. An example interface might provide a facility for reading and writing values to user specified addresses.</td>
<td></td>
</tr>
</tbody>
</table>
I/O Designer Toolkit Views

The I/O Designer Toolkit views provide a set of fully integrated I/O ring design tools. With these tools it is possible to:

- Combine I/O ring IP configuration (.acxip) files into a complete I/O ring design
- View and update dynamic I/O ring resource utilization
- View and update (using drag and drop) dynamic I/O ring floorplan layout
- View dynamic I/O ring package ball layout and pin assignment report
- Automatically complete the following:
  - Full I/O ring final DRC, in real time
  - Full I/O ring timing closure, in real time
  - Full I/O ring place and route, in real time
- Generate complete package ball pin assignment, power, and utilization reports
- Generate a full I/O ring simulation model that is 100% correctly configured, and has wrappers tailored specifically to the user design
- Generate pin placements PDC, Verilog wrappers, and port lists for the core user design
- Generate the full I/O ring bitstream
- Quickly and easily combine existing I/O ring IP configuration (.acxip) files from an existing ACE project into new ACE projects to create multiple designs

Caution!
The I/O Designer views and features are only applicable to specific Achronix Speedster devices, such as the Speedster7t AC7t1500.

I/O Designer Toolkit Views

The views in the I/O Designer Toolkit are:

- I/O Utilization View (see page 75)
- I/O Package Diagram View (see page 76)
- I/O Pin Assignment View (see page 77)
- I/O Core Pin Assignment View (see page 78)
- I/O Layout Diagram View (see page 80)

I/O Ring Design File Generation

Clicking the Generate I/O Ring Design Files toolbar button opens the Generate I/O Ring Design Files Dialog (see page 169), which allows selection of the output directory for all the customized I/O ring design files, including:

- Complete package ball pin assignment, power, and utilization reports
- Pin placements PDC, Verilog wrappers, and port lists for the core user design
- The full I/O ring bitstream, which is automatically combined with the core user design bitstream in ACE at the end of the normal place-and-route flow for the core user design
- Customized I/O ring simulation files, including Verilog wrappers for the top-level and I/O ring configuration data

### Batch Mode Support

I/O ring design files may also be generated in batch mode for a given ACE project by calling the `generate_ioring_design_files` (see page 571) Tcl command. This command loads up all the I/O ring IP configuration (.acxip) files from an existing ACE project, and performs full design rule checks prior to generating the output files. I/O ring IP configuration files can also be edited in a text editor to support batch mode configuration prior to calling the `generate_ioring_design_files` Tcl command.

#### Table 33: I/O Designer Toolbar Buttons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Opens the Generate I/O Ring Design Files Dialog (see page 169), which allows selecting the directory into which the customized I/O ring design files are generated.</td>
</tr>
</tbody>
</table>

See also Creating an IP Configuration (see page 314) and Adding Source Files (see page 275).

### I/O Utilization View

The I/O Utilization view provides a combined utilization summary of the active ACE project I/O ring IP configuration (.acxip) files, including shared resources such as clocks. Each resource type is summarized in a table inside an expandable section. These tables can be used for navigating between various IP configuration files in the project. Configuration errors are also summarized in the Status column for each row. Right-clicking a row brings up a context menu of actions that can be performed on the IP in that row. Double-clicking the table row opens the source IP configuration file for the data in that row.
Figure 18: I/O Designer View (Utilization Tab)

Table 34: I/O Designer View Actions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📋</td>
<td>Open IP</td>
<td>Opens the selected IP file in an editor within ACE.</td>
</tr>
<tr>
<td>🔄</td>
<td>Clone IP</td>
<td>Creates a duplicate of the selected IP and adds it to the project.</td>
</tr>
<tr>
<td>✏️</td>
<td>Rename IP</td>
<td>Renames the selected IP.</td>
</tr>
<tr>
<td>❌</td>
<td>Remove IP from project</td>
<td>Allows removal of the selected IP project. See also remove_project_ip (see page 593).</td>
</tr>
<tr>
<td>🌐</td>
<td>Show in file manager</td>
<td>Opens the operating system default file manager to the directory containing the IP file.</td>
</tr>
</tbody>
</table>

I/O Package Diagram View

The I/O Package Diagram view shows a live diagram of the target package balls and all I/O ring user design top-level pin ball assignments. Click and drag to pan the diagram and use the mouse wheel to zoom in and out. Package balls with yellow fill indicate placed user design pins on those package balls. Tooltip text provides extra information about each package ball location.
The I/O Pin Assignment view shows a live table of I/O ring user design top-level pin assignment information, including user design port name, I/O bank, package ball, top-level device port name, and pad/macro site name (for debugging in the full-chip simulation hierarchy). Columns can be sorted by left-clicking on the column headers. Columns can be filtered using the Toggle Filter Row Visibility button.

**Figure 19: I/O Package Diagram View**
The I/O Core Pin Assignment view shows a live table of I/O ring user design top-level core pin assignment information, including user design signal name, direction, data type, group, and core pin name. Columns can be sorted by left-clicking the column headers. Columns can be filtered using the **Toggle Filter Row Visibility** button.
Figure 21: I/O Core Pin Assignment View

Table 36: I/O Core Pin Assignment View Buttons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌐</td>
<td>Generate I/O Ring Design Files.</td>
</tr>
<tr>
<td>🔍</td>
<td>Clear Sorting.</td>
</tr>
<tr>
<td>🕵️‍♂️</td>
<td>Toggle Filter Row Visibility.</td>
</tr>
</tbody>
</table>
## Icon Description

| Icon | Remap Port/Signal Name (available in **Remapped Name** column right-click menu). |

### I/O Layout Diagram View

The I/O Layout Diagram view shows an interactive floorplan of the target device.

Empty IP Sites are shown in white. Sites with legally-placed IP are shown in green. Sites with IP placement overlap violations are shown in red.

IP can be moved from one site to another by dragging and dropping. IP can be cloned onto another compatible site by holding down the CTRL key while dragging and dropping.

Double-clicking a placed IP opens an editor for that IP. Double-clicking an empty site opens the "Create new IP" dialog, preselecting the appropriate type of IP for that site, and placing the new IP at that site when the dialog is completed.

Changes to placement in the diagram result in updates to the source IP configuration (.acxip) files. Tooltip text provides extra information about each IP site.

Right-clicking a site brings up a context menu of actions that can be performed on that site, or the IP placed on that site.

![I/O Layout Diagram](image)

**Figure 22: I/O Designer View (Layout Tab)**
Table 37: I/O Designer View Actions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Open IP icon]</td>
<td>Open IP</td>
<td>Opens the selected IP file in an editor within ACE.</td>
</tr>
<tr>
<td>![Create new IP here icon]</td>
<td>Create new IP here</td>
<td>Creates a new IP at the chosen site.</td>
</tr>
<tr>
<td>![Clone IP icon]</td>
<td>Clone IP</td>
<td>Creates a duplicate of the selected IP and adds it to the project.</td>
</tr>
<tr>
<td>![Rename IP icon]</td>
<td>Rename IP</td>
<td>Renames the selected IP.</td>
</tr>
<tr>
<td>![Add IP to another project... icon]</td>
<td>Add IP to another project...</td>
<td>Adds the selected IP to another project in the ACE workspace.</td>
</tr>
<tr>
<td>![Add copies of IP to another project... icon]</td>
<td>Add copies of IP to another project...</td>
<td>Adds a copy of the selected IP to another project in the ACE workspace.</td>
</tr>
<tr>
<td>![Remove IP from project icon]</td>
<td>Remove IP from project</td>
<td>Allows removal of the selected IP project. See also remove_project_ip (see page 593)</td>
</tr>
</tbody>
</table>

By default, if one or more IP editors are currently open, the diagram is configured to display a yellow highlight indicating the currently active IP editor.

![I/O Layout Diagram View Currently Active Highlight Example](image)

**Figure 23: I/O Layout Diagram View Currently Active Highlight Example**

The I/O Designer page in the Preferences can be used to adjust the highlight color, or to hide it.
IP Diagram View

The IP Diagram view is meant to provide a graphical visualization of the configuration of the IP currently being edited. As different IP configurations are selected (by selecting their Editor), the IP Diagram view contents change to reflect the selected IP configuration.

Some IP supports multiple pages of diagrams (e.g., a logic block diagram page and a placement diagram page). In these cases, there are multiple labeled tabs at the bottom of the IP Diagram view to allow switching diagram pages.

Figure 24: I/O Designer Highlighted Placement Color Preference Example
When a supported IP Configuration Editor is selected, the IP Diagram view shows a dynamic block diagram of the selected IP. Displayed labels change, and logic blocks may appear and disappear depending upon the configuration options currently selected in the IP Editor. Tool tips are available on all text displayed in the IP Diagram. Text representing Configuration Options with Warnings or Errors are displayed with appropriate colors to indicate the condition (by default, Warnings have a yellow background and Errors have a red background, though these colors may be overridden from the IP Diagram Preference Page (see page 200)).

Clicking any text label in the IP Diagram immediately turns the IP Editor to the associated page so that the related Configuration Options may be edited.

There are a number of preferences available allowing visual customization (colors and fonts) of the IP Diagram view. These preferences are changed on the IP Diagram Preference Page (see page 200).

See also: Creating an IP Configuration (see page 314)

**Note**

If the selected Editor is not an IP Configuration Editor, or if the selected IP does not support a diagrammatic visualization, the IP Diagram view displays a notice that there is no diagram available for the selected Editor as shown.
IP Libraries View

The IP Libraries view provides an alternate method for creating IP configuration (.acxip) files versus the main menu (File → New → IP Configuration...). Expanding a device family name (IP Library) displays a list of available IP types for that family, double-clicking the IP type or clicking the Create New IP Configuration button opens the New IP Configuration Dialog (see page 174).

![IP Libraries View](image)

**Figure 26: Screenshot of IP Libraries View**

**Note**

The displayed IP Libraries and IP types are dynamic and change based on which technology libraries and devices are installed and licensed. The screenshots and example descriptions in this section do not necessarily reflect the IP types of the actual device currently in use.

**Table 38: IP Libraries Toolbar Buttons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Opens the New IP Configuration Dialog (see page 174) to allow creating a new IP configuration file.</td>
</tr>
</tbody>
</table>

See also: Creating an IP Configuration (see page 314).

IP Problems View

The IP Problems view displays all of the warnings and errors for all of the currently open IP Configuration Editors.

The top half of the view displays a sorted tree table of all errors in order by IP configuration (.acxip) file, then all warnings in order by file. When an IP problem is selected in this tree table, further details about the problem are displayed below the tree table (in the bottom half of the view).

Double-clicking an error or warning opens the relevant IP Configuration Editor to the appropriate page (see also Creating an IP Configuration (see page 314)).

**Note**

Unlike other IP-related views, this view shows information for all open IP Configuration Editors, not just the top /active Editor.
Figure 27: Example Screenshot of the IP Problems View

Table 39: IP Problems View Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚠️</td>
<td>Warning</td>
</tr>
<tr>
<td>❌</td>
<td>Error</td>
</tr>
</tbody>
</table>

Table 40: IP Problems View Table Columns

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>A brief summary statement of the IP Configuration problem.</td>
</tr>
<tr>
<td>File</td>
<td>The IP Configuration file containing the error. This is the name of the file being edited in an open IP Configuration Editor.</td>
</tr>
<tr>
<td>Property</td>
<td>The property which is part of the IP Configuration problem. Individual properties are usually similar to the field names shown in the IP Configuration Editor. The raw properties and their values can be viewed in the IP Configuration Editor by selecting the File Preview tab at the bottom of each IP Configuration Editor. The Configuration tab shows a more user-friendly representation of the same data.</td>
</tr>
</tbody>
</table>
**Multiprocess View**

Similar to the Tcl command `run_multiprocess` (see page 605), the Multiprocess View ( ) allows **Running Multiple Flows in Parallel** (see page 285) and **Attempting Likely Optimizations Using Option Sets** (see page 369).

The Multiprocess View provides a means to select multiple **Implementations** (see page 217) within a single project (see page 217) for flow execution. Depending upon how this view is configured, the selected implementations may be queued for sequential flow execution, run all at the same time in parallel, or (a combination) in a configurable number of parallel sequential queues. The selected implementations may be executed in the background of the workstation running ACE, or may optionally be sent to an external cloud/grid/batch job system for execution.

The Multiprocess view may also help to explore the solution space provided by various ACE optimizations. The Multiprocess View can optionally generate new implementations derived from the current **Active Project and Implementation** (see page 223), where each newly generated implementation applies an overlay of likely implementation option (see page 217) optimizations over the active implementation options. These collections of potentially optimized implementation options are termed **option sets** (see page 217).

By default, the Multiprocess View is a part of the **Projects perspective** (see page 24). To make the Multiprocess View visible from within any perspective, select **Window → Show View → Other... → Achronix → Multiprocess**.

This view is broken up into several sections:

- Execution Queue Management
- Multiprocess Flow Management
- Select Implementations
- Multiprocess Run Logs

Each section includes a brief descriptive paragraph describing its purpose. Each section may be collapsed and expanded by clicking the section title. Collapsing or expanding any section causes the other sections to be resized to fit the available data and view area.

For more detailed information on how to use this view, please see **Running Multiple Flows in Parallel** (see page 285) and **Attempting Likely Optimizations Using Option Sets** (see page 369).
Figure 28: Multiprocess View Example
Table 41: Multiprocess View Toolbar Buttons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Start Background Queue Execution</td>
<td>Starts execution of all implementations selected in the Select Implementations table in the number of parallel processes specified by Parallel Queue Count.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Stop All Background Queue Execution</td>
<td>Stops/cancels execution of all currently running/queued implementations.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Open Multiprocess Report</td>
<td>Opens the Multiprocess Summary Report (see page 240) for the selected project.</td>
</tr>
</tbody>
</table>

Execution Queue Management

This section configures the number of background processes allowed to run in parallel, and how/where they are executed.

Table 42: Execution Queue Management Controls

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parallel Job Count</td>
<td>Sets the number of implementations allowed to execute in parallel. Defaults to 2. When in background mode, the maximum allowed value is the number of available processor cores detected. When in Job Submission System mode, the maximum allowed value is 99.</td>
</tr>
<tr>
<td>Enable Job Submission System Support</td>
<td>When unchecked, background processes run locally on the workstation currently running the ACE GUI. When checked, ACE uses the cloud/grid/batch job submission system as configured in the preferences.</td>
</tr>
<tr>
<td>(configured in Preferences)</td>
<td>When selected, brings up the Multiprocess: Configure Custom Job Submission Tool Preference Page (see page 202) to fully configure which cloud/grid/batch job submission system is used.</td>
</tr>
</tbody>
</table>

When the Parallel Job Count is set to the minimum value of 1, all selected implementations are executed sequentially, one at a time. A value of 2 causes all selected implementations to be queued, and then the first two queued implementations are allowed to execute at the same time. As soon as an implementation completes its flow execution, the next queued implementation starts flow execution and the Multiprocess Summary Report (see page 240) is updated with information gathered from the just-completed implementation.

By default, ACE executes implementations in parallel by starting a background process on the host workstation for each implementation (termed "background mode"). In this case, the effectiveness of parallel implementation execution is naturally limited by the resources of the host workstation (the number of processor cores and the physical RAM).

Alternately, ACE may execute the implementations in processes distributed among multiple hosts via an external job submission system, which theoretically allows for far greater parallel compute resources. The job submissions are performed through a user-configured command line executable. This executable is configured via the Multiprocess: Configure Custom Job Submission Tool Preference Page (see page 202), reached easily by following the (configured in Preferences) hyperlink.

See Running Multiple Flows in Parallel (see page 285) for important details regarding parallel implementation execution, configuration, and external job submission tool support.
Multiprocess Flow Management

This section allows altering how far the flow is executed for the multiprocess implementations.

**Table 43: Multiprocess Flow Management Controls**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop Flow After (1)</td>
<td>Allows overriding standard flow behavior and stopping the flow early — the flow step selected becomes the final flow step executed by all multiprocess implementations. Useful when steps late in the flow are known to fail with reported errors, but it is still desired to run multiple implementations through earlier parts of the flow.</td>
</tr>
</tbody>
</table>

**Table Notes**
1. The flow step chosen here is always enabled when the multiprocess run executes, regardless of whether it was enabled before the multiprocess run is launched.

See Running Multiple Flows in Parallel (see page 285) for further details regarding multiprocess flow configuration.

Select Implementations

This section allows:
- Selecting which implementations to execute (implementations derived from option sets (see page 217) are created if selected).
- Starting or stopping the execution of all selected implementations.
- Providing simple execution state feedback.

See Running Multiple Flows in Parallel (see page 285) for further details regarding selecting the implementations to be run in parallel, starting/stopping/cancelling parallel execution, etc.

See Attempting Likely Optimizations Using Option Sets (see page 369) for explanations of how to use option sets to achieve better QoR.

**Table 44: Select Implementations Controls**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Existing Implementations</td>
<td>Updates the contents of the Implementation Table to show all existing implementations for the current active project (see page 223).</td>
</tr>
<tr>
<td>Generate Implementations from Option Sets</td>
<td>Updates the contents of the Implementation Table to show the current active implementation (see page 223) and a number of to-be-generated implementations, one per Option Set (see page 217). The use of this radio button selection is covered in more detail at Attempting Likely Optimizations Using Option Sets (see page 369). If the Implementation Table does not show any implementations besides the active implementation while in this mode, click the Refresh Option Sets button.</td>
</tr>
<tr>
<td>Refresh Option Sets(1)</td>
<td>Causes ACE to analyze the current Active Project and Implementation (see page 223) to (re-)generate customized option sets most likely to improve QoR, then the Implementation Table is updated with a list of to-be-generated implementations.</td>
</tr>
</tbody>
</table>
1. **Seed Sweep of prime numbers**

   Updates the contents of the Implementation Table to show a number of to-be-generated implementations. Each of these implementations is identical to the currently active implementation, with the implementation option "seed" being automatically set to the next consecutive prime number. The **seedcount** text field beside this radio button can be used to choose how many such implementations should be created.

2. **Implementation Table**

   A table containing implementation names along with their selection state and execution state. The implementations listed vary based upon the active project and implementation (see page 223), in combination with the state of the radio buttons.

3. Select All

   Selects all implementations in the Implementation Table.

4. Deselect All

   Deselects all implementations listed in the Implementation Table.

5. Start Selected

   Queues all implementations selected in the Implementation Table and begins executing in the configured number of parallel processes.

6. Stop All

   If clicked, all currently queued implementations are removed from the queue(s) and all currently executing implementations are killed. The Multiprocess Summary Report (see page 240) is updated with any and all captured information.

**Table Notes**

- This button must be clicked prior to clicking the ( ) **Start Selected** button whenever the active project or implementation has changed significantly, as well as the first time **Generate Implementations** from a new active project or implementation is chosen.

All the controls in this section center around what is in the table. The radio buttons change which implementations are listed in the table, and the push-buttons below the table change the selection state of the listed implementations, or alter the execution state of the implementations (the purpose of the entire view).

The table contents are kept in sync with the current Active Project and Implementation (see page 223). Changing active projects (which implicitly changes active implementations) updates the Implementation Table contents according to the current radio button selection.

The Implementation Table columns are each described in the following table.

**Table 45: Implementation Table Columns**

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Implementation</td>
<td>Contains the implementation name, along with a checkbox indicating implementation selection, and an icon representing the implementation.</td>
</tr>
<tr>
<td>Execution State</td>
<td>Contains the execution state of the implementation.</td>
</tr>
<tr>
<td>Column Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Description</td>
<td>Blank when Existing Implementations is selected. When Generate Implementations from Option Sets is selected, contains a description of the Option Set (see page 217) which is used as the overlay on the active implementation (see page 223) when generating the new implementation.</td>
</tr>
</tbody>
</table>

**Tip**

If the implementation table is not large enough (or is too large) for the full implementation list, simply collapse and/or expand one of the other sections in this view (click the section title). This causes the table to resize to exactly fit the entire current implementation list.

**Implementation Execution States**

There are a number of possible Execution States (as listed in the second column) for the implementations in the table corresponding to the lifetime of a Multiprocess View background process. The icons from these states are also used on the tabs within the Multiprocess Run Logs section.

**Table 46: Implementation Execution States and Icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Execution State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>blank</td>
<td>This implementation has not been selected for execution.</td>
<td></td>
</tr>
<tr>
<td>Selected</td>
<td>This implementation is currently selected for execution, and execution has not been started.</td>
<td></td>
</tr>
<tr>
<td>Zzz In Queue</td>
<td>Execution of the selected implementations has been started, this implementation was selected for execution and is currently waiting in the queue for execution.</td>
<td></td>
</tr>
<tr>
<td>Zzz Scheduled</td>
<td>Execution of the selected implementations has been started, this implementation was selected for execution, is at the head of the queue and is being prepared for execution (this state typically only lasts for a fraction of a second).</td>
<td></td>
</tr>
<tr>
<td>Running</td>
<td>This implementation was selected for execution, and is currently executing. Log messages should be visible in the tabbed logging area.</td>
<td></td>
</tr>
<tr>
<td>Complete</td>
<td>This implementation was (and still is) selected for execution, and its last execution was completed without flow errors (but does not mean that the design met timing). Log messages should be visible in the tabbed logging area. Summary information should be visible in the Multiprocess Summary Report (see page 240).</td>
<td></td>
</tr>
<tr>
<td>Stopped</td>
<td>This implementation was (and still is) selected for execution, but its last execution was stopped (possibly canceled before it even started). If its execution had started, log messages should be visible in the tabbed logging area. If Post-Route Timing Analysis or Sign-off Timing Analysis were completed for this implementation, the timing results should be visible in the Multiprocess Summary Report (see page 240).</td>
<td></td>
</tr>
<tr>
<td>Error</td>
<td>This implementation was (and still is) selected for execution, but its last execution exited with reported errors. A tooltip for the error icon provides a summary of the detected error messages. Detailed log messages should be visible in the tabbed logging area. If Post-Route Timing Analysis or Sign-off Timing Analysis were completed for this implementation, the timing results should be visible in the Multiprocess Summary Report (see page 240).</td>
<td></td>
</tr>
</tbody>
</table>

**Multiprocess Run Logs**

This section shows the logs for each selected implementation as they execute. A separate tab is provided for each individual implementation. The log info is updated live as background processes execute. Depending upon configuration, external cloud/grid/batch jobs may have their log info updated live, or it may not be updated until the job is completed (the displayed log info mirrors the information captured in the log file for each implementation).
Each tab includes the name of the implementation and the execution state, which updates live. If an implementation enters the Error state, the tooltip for the tab title is updated to include a summary of the captured error messages. Error details are visible in the log shown in the tab, as well as within the Log Files (see page 220) for each implementation.

Netlist Browser View

The Netlist Browser view provides a graphical, tree-based visualization of the user design hierarchy, as found in the netlist. The displayed netlist includes the results of any transformation, legalization, etc. that have happened through the current stage in the Flow.

For large designs, there are a tremendous number of objects in the netlist. To simplify the view, the Netlist Browser provides a number of ways to filter the flood of data down to just the most useful information (there are no filters active by default).

Each instance node in the tree includes the instance name and the cell type. Macros include the macro name, and the counts of the various major logic types contained within that macro. Be aware that these logic type counts are not affected by the filters; the numbers shown always represent the unfiltered total counts. Clock domain names and Partitions names also are listed when appropriate.

By default, the Netlist Browser view is included in the Floorplanner perspective (see page 24). To add it to other perspectives, select Window → Show View... → Other... → Achronix → Netlist Browser.

As can be seen in the second column of the example below, three instances have been highlighted:

- inb1_ibuf[3].x_ipad_i_io_buff in cyan
- All members of the z0_obuf.* macro hierarchy in pink
- inb1_int_z[2] in dark blue

![Netlist Browser Example](image-url)
Note

- The small colored square in the toolbar shows the active highlighting color. If highlighting is applied to a macro then all “child” instances within are also set to the current highlight color.
- Resource type columns, such as Flops, BRAMs, ALUs, etc. are dynamic and change to match the target device after running the Prepare flow step. The screenshots and example descriptions in this section do not reflect the resource types of actual devices.

Table 47: Netlist Browser Table Columns

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance Name</td>
<td>The name of the instances in the netlist. Instances within a macro are grouped together as leaves under the macro branch. Additionally, an icon is used to indicate the placement state of the instance. The possible icons are shown in a separate table below.</td>
</tr>
</tbody>
</table>
| Highlight Color    | • For instances, shows a color square to indicate the instance highlight color, if any.  
                     • For macros, if all contained instances have the same highlight color, the macro shows a color square for that same highlight color. If even one contained instance has a different highlight color, or no highlight at all, the macro displays no color square. This value does not change for macros during filtering. |
| Cell Type          | • For instances, shows the cell type of the instance.  
                     • For macros, this column is blank. |
| Clock Domain       | • For instances, shows a list of all the clock domains of which the instance is a member.  
                     • For macros, shows a summary list of the clock domains for all the contained instances. This value does not change for macros during filtering. |
| Core               | • For instances, this is checked if the instance is considered a member of the Core, or blank if it is not.  
                     • For macros, this is checked if any contained instances are considered a member of the Core, or blank if no contained instances are in the Core. This value does not change for macros during filtering. |
| IORing             | • For instances, this is checked if the instance is considered a member of the IORing, or blank if it is not.  
                     • For macros, this is checked if any contained instances are considered a member of the IORing, or blank if no contained instances are in the IORing. This value does not change for macros during filtering. |
| Partition          | For both instances and macros, the name of the Partition to which the item belongs, if any. See Using Incremental Compilation (Partitions) (see page 380) |
| Resource           | • For instances, this is one if the instance is of type resource, or zero otherwise.  
                     • For macros, this is the sum count of all contained resource instances (regardless of filtering). |

Icons decorate all the nodes in the tree in the Instance Name column.
Table 48: *Netlist Browser View Icons*

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Macro Icon]</td>
<td>Macro</td>
</tr>
<tr>
<td>![Unplaced Instance Icon]</td>
<td>Unplaced Instance</td>
</tr>
<tr>
<td>![Placed Instance (Soft) Icon]</td>
<td>Placed Instance (Soft)</td>
</tr>
<tr>
<td>![Placed Instance (Fixed) Icon]</td>
<td>Placed Instance (Fixed)</td>
</tr>
</tbody>
</table>

A number of actions are available in the view via:
- Buttons at the top of the view
- The (...) ellipsis view menu button
- Right-click context menus on the nodes of the tree

**Note**

If these actions are performed upon macros, all child leaf nodes, even those currently filtered to be hidden in the tree, are affected by the chosen action.

Table 49: *Netlist Browser View Actions*

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Toolbar Button</th>
<th>Context Menu</th>
<th>View Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Add to Selection Icon]</td>
<td>Add to Selection</td>
<td>Y</td>
<td></td>
<td></td>
<td>Adds the item(s) to the ACE Selection Set (as shown in the <strong>Selection View</strong> (see page 136)).</td>
</tr>
<tr>
<td>![Remove from Selection Icon]</td>
<td>Remove from Selection</td>
<td>Y</td>
<td></td>
<td></td>
<td>Removes the item(s) from the ACE Selection Set (as shown in the <strong>Selection View</strong> (see page 136)).</td>
</tr>
<tr>
<td>![Choose Highlight Color Icon]</td>
<td>Choose Highlight Color</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td>Determines which color is applied to the objects chosen from the tree the next time the Highlight action is selected for this view.</td>
</tr>
<tr>
<td>![Highlight Icon]</td>
<td>Highlight</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td>Applies the currently active Highlight color to the chosen item(s) in the tree. See <strong>Highlighting Objects in the Floorplanner View</strong> (see page 323).</td>
</tr>
<tr>
<td>![Un-Highlight Icon]</td>
<td>Un-Highlight</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td>Clears the Highlight for the chosen item(s) in the tree. When painted in the Floorplanner view, the chosen item(s) now use their default color(s) instead of a highlight color.</td>
</tr>
<tr>
<td>![Auto-Highlight Icon]</td>
<td>Auto-Highlight</td>
<td>Y</td>
<td></td>
<td></td>
<td>Automatically applies unique highlight colors to all visible core hierarchy levels in the tree. IORing hierarchy levels are skipped.</td>
</tr>
<tr>
<td>![Zoom To Icon]</td>
<td>Zoom To</td>
<td>Y</td>
<td></td>
<td></td>
<td>Zooms the Floorplanner view to a region containing the instances currently chosen in the tree.</td>
</tr>
<tr>
<td>![Show in Netlist Icon]</td>
<td>Show in Netlist (1)</td>
<td>Y</td>
<td></td>
<td></td>
<td>Attempts to open a text editor to the file and line number relevant to the chosen instance. Available only when a single instance is chosen in the view.</td>
</tr>
<tr>
<td>Icon</td>
<td>Action</td>
<td>Toolbar Button</td>
<td>Context Menu</td>
<td>View Menu</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>----------------</td>
<td>--------------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Unfix Placement of Instance" /></td>
<td>Unfix Placement of Instance</td>
<td>Y</td>
<td></td>
<td></td>
<td>Changes the state of an already-placed instance from Fixed Placement to Soft Placement. This choice is only available when an instance already has Fixed Placement.</td>
</tr>
<tr>
<td><img src="image" alt="Fix Placement of Instance" /></td>
<td>Fix Placement of Instance</td>
<td>Y</td>
<td></td>
<td></td>
<td>Changes the state of an already-placed instance from Soft Placement to Fixed Placement. This choice is only available when an instance already has Soft Placement.</td>
</tr>
<tr>
<td><img src="image" alt="Unplace Instance" /></td>
<td>Unplace Instance</td>
<td>Y</td>
<td></td>
<td></td>
<td>Completely removes the site assignment for an instance, making it Unplaced. This choice is only available when an instance is already Placed.</td>
</tr>
<tr>
<td><img src="image" alt="Expand All" /></td>
<td>Expand All</td>
<td>Y</td>
<td></td>
<td></td>
<td>Expands all collapsed macro branches in the tree, making all leaf instances visible.</td>
</tr>
<tr>
<td><img src="image" alt="Collapse All" /></td>
<td>Collapse All</td>
<td>Y</td>
<td></td>
<td></td>
<td>Collapses all expanded macro branches in the tree.</td>
</tr>
<tr>
<td><img src="image" alt="Show Power and Grounds" /></td>
<td>Show Power and Grounds</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Disabled by default. When disabled, all instances of power and ground are hidden within the tree, effectively acting as a filter. Therefore, the Cell Type column gains the active filter indicator (yellow background by default) when power and ground are hidden. This filter is a higher priority than user custom filters applied to the Cell Type column (if a custom filter is created to expose only &quot;GND&quot; grounds, but Show Power and Grounds is disabled, the &quot;GND&quot; instances remain hidden).</td>
</tr>
<tr>
<td><img src="image" alt="Show Boundary Pins" /></td>
<td>Show Boundary Pins</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td>Disabled by default. When disabled, all instances of boundary pins are hidden within the tree, effectively acting as a filter. Therefore, the Cell Type column gains the active filter indicator (yellow background by default) when boundary pins are hidden. This filter is a higher priority than user custom filters applied to the Cell Type column (if a custom filter is created to expose only &quot;OPIN&quot; instances, but Show Boundary Pins is disabled, the &quot;OPIN&quot; instances remain hidden).</td>
</tr>
<tr>
<td><img src="image" alt="Show Feedthrough LUTs" /></td>
<td>Show Feedthrough LUTs</td>
<td>Y</td>
<td></td>
<td></td>
<td>Toggles the visibility of all feedthrough instances, most often created by Achronix optimizations. These always have &quot;<em>ft</em>&quot; plus some additional notation in the (ACE-generated) instance name. Enabled by default. When disabled, all feedthrough instances (might be more than just LUTs in some cases) are hidden within the tree, effectively acting as a filter. Therefore, the Instance Name column gains the active filter indicator (yellow background by default) when feedthroughs are hidden. This filter is a higher priority than the user custom filters applied to the Instance Name column (if a custom filter is created to expose only instances that contain &quot;LUT&quot; in the name, but Show Feedthrough LUTs is disabled, any instances that have a feedthrough-based name remain hidden, even if they have an explicit &quot;LUT&quot; in the name).</td>
</tr>
<tr>
<td><img src="image" alt="Show Constants" /></td>
<td>Show Constants</td>
<td>Y</td>
<td></td>
<td></td>
<td>Toggle the visibility of all instances with &quot;const&quot; somewhere in the name, most often created by Achronix optimizations. Enabled by default. When disabled, all instances with &quot;const&quot; anywhere in the name are hidden within the tree, effectively acting as a filter. Therefore, the Instance Name column gains the active filter indicator (yellow background by default) when constants are hidden. This filter is a higher priority than the user custom filters applied to the Instance Name column (if a custom filter is created to expose only instances that contain &quot;LUT&quot; in the name, but Show Constants is disabled, any instances that have a &quot;const&quot; in their name remain hidden, even if they have an explicit &quot;LUT&quot; in the name).</td>
</tr>
</tbody>
</table>
Table 50: Netlist Browser View Actions (cont.)

<table>
<thead>
<tr>
<th>Action</th>
<th>Show Duplicates/Clones (2)</th>
<th>Toggle Filter Row Visibility (3)</th>
<th>Configure view...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>

- **Show Duplicates/Clones**: Toggle the visibility of instances with various forms of "\_DUP\_" in the name, most often created by Achronix optimizations. Enabled by default. When disabled, instances with "\_DUP\_" or "\_dup\_" in the name (typically with some additional notation) are hidden within the tree, effectively acting as a filter. Therefore, the **Instance Name** column gains the active filter indicator (yellow background by default) when duplicates/clones are hidden. This filter is a higher priority than the user custom filters applied to the **Instance Name** column (if a custom filter is created to expose only instances that contain "LUT" in the name, but **Show Duplicates/Clones** is disabled, any instances that have a "\_DUP\_" in their name remain hidden, even if they have an explicit "LUT" in the name).

- **Toggle Filter Row Visibility**: Changes whether the filter row (of filter icons) is visible or not.

- **Configure view...**: Jumps to the Netlist Browser view in the Preferences dialog.

### Table Notes
1. **Caution**: This is Early Access functionality and might not always open the text editor to the expected location.
2. **Caution**: This filter uses an imperfect name-string-matching heuristic and might, in rare cases, intercept user instances as false-positives.
3. **Toggel row visibility does not alter whether filters are active, it only changes the visibility of the row of filter icons.**

### Warning!
- Be aware that when actions are performed upon macros, all the children of that macro, even the invisible/filtered nodes, are affected.
- With default preference settings, in the **Floorplanner View (see page 57)**, Highlight colors of (placed) instances are only visible when the Instances Layer is enabled, and the instances are not members of the ACE Selection Set. This is because the Instance Selection color has a higher priority than the Highlight color.

### Filtering Displayed Instances
Some convenience filters for **Cell Type** are already present as visibility toggles in the Netlist Browser. These filters are represented by the ( ), **Show Boundary Pins** and ( ), **Show Power and Grounds** toggle actions/buttons. Be aware that the "hide" functionality of these actions (when the Show toggle is disabled) is considered a higher-priority filter than any user custom filters. For example, when boundary pins are hidden due to this toggle, even if a custom filter tries to expose boundary pins, the toggled filter wins, and the pins remain hidden.

Additionally, some convenience filters for **Instance Name** are already present as visibility toggles. These filters are represented by the **Show Feedthrough Luts**, **Show Constants**, and **Show Duplicates/Clones** toggled menu items. Be aware that the "hide" functionality of these actions (when the Show toggle is disabled) is considered a higher-priority filter than any user custom filters. For example, when Constant instances are hidden due to this toggle, even if a custom filter tries to expose constants, the toggled filter wins, and the constant instances remain hidden.

To enable custom instance filter manipulations, it might be necessary to click ( ) **Toggle Filter Row Visibility** to cause the filter manipulation row to become visible. This toggle action is available in a context menu when right-clicking any table column header and is also available in the view supplemental menu (the small down arrow icon in the upper-right of the view, to the left of the **Minimize View** button).
Most columns of the table can filter the displayed instances (not the macros) by value. When filtering by column value, only instances with column values matching the filter are retained; non-matching values are excluded from the table.

Be aware that macro rows do not directly respond to filters, and remain visible as long as any single child instance remains visible. When all child instances of a macro are hidden, the parent macro is hidden as well. On a related note, macro summary counts in numeric columns (as when counting LUTs in a macro) do not change when filters are applied. The displayed counts are always the complete, unfiltered counts.

**Warning!**

- When using filters, the values being filtered are those of the individual instances, not the macros. Macros are filtered out only if all of their children are filtered out. As a result, when filtering by the logic types, the only possible filter numeric values in this table are 0 or 1, because these are the only legal values for an instance.
- Also, be aware that when filtering the **Instance Name** column, the parent macro names are considered part of the instance name — the prefix (the fully qualified instance name is used, not just the terminating leaf name).

Columns containing text can be filtered by string value (simple wildcard substring matching by default, but Regular Expression matching using Java rules is also available, see https://en.wikipedia.org/wiki/Regular_expression). Columns with checkmarks can be filtered by Boolean value. Columns containing numbers can be filtered by numerical value.

To add a filter to a column:

1. Click the (asco) filter icon, which causes a data-appropriate filter dialog to appear.
2. Fill in the desired filter values.
3. Click **Apply** to apply the filter to the instances in the table.

All values matching that filter are retained, and all other values are excluded. Additionally, the background color of the column changes to a bright yellow to indicate the filter is active, and the filter icon at the head of the column also changes to the (asco) active filter icon.

An example filter for the **Cell Types** column that uses Regular Expressions to block PWR, GND, ASC, SAC, and bit* cell types is shown below.

![Netlist Browser Filter Configuration](image)

**Figure 30: Cell Types Column Filter Example**

To edit (or clear) an existing filter:

1. Click the (asco) active filter icon causing the data-appropriate filter dialog to appear, this time pre-populated with the existing filter setting.
2. Change the filter value and click Apply again to edit the filter.
3. Click Cancel to leave the filter unchanged.
4. Click Clear to remove the filter from the column.

If the filter is cleared, the background color of the column returns to the default background color, and the filter icon also changes to the ( ☑ ) inactive version.

Drag-and-Drop
The Netlist Browser supports a limited set of Drag-and-Drop interactions with other views in the Floorplanner perspective (see page 24). The Netlist Browser view only acts as a Drag-and-Drop source; items dropped on the Netlist Browser view are ignored.

Any node of the tree may be dragged to the Tcl Console view (see page 144), and when dropped anywhere in the view, appropriate text is inserted at the beginning of the Tcl command-line.

Instance nodes may also be dragged to the Floorplanner view (see page 57). When dropped on the Floorplanner view, the behavior depends upon the current Tool mode. When the Floorplanner Placement/Panning Tool is active, placement is attempted.

Any node of the tree may be dragged to the Placement Regions view (see page 118) or the Floorplanner view (when that view has the Placement Regions Tool active) to assign placement region constraints (see page 374). Dragging a macro is the equivalent of dragging all individual instances which are members of that macro.

NoC Performance View
The NoC Performance view shows an interactive diagram that includes the I/O ring and the 2D NoC resources for the target device. Loading a simulation log file produced by the device simulation model (DSM) into the view provides graphic visualization of traffic between Network Access Points (NAPs) for different periods of time during the simulation ("time slices").

Loading Simulation Log Files
Load simulation log files by clicking Browse on the view control bar as shown:

![Figure 31: Simulation Log File Loading Example](image)

When a log file has been loaded, hover the mouse pointer over the Log text field to see the full path to the loaded file, as well as the name of the target device on which the simulation was running:

![Figure 32: Simulation Log File Path Example](image)
Browsing Time Slices

Use the Time Slice combo box on the view control bar to choose a time slice to visualize. The statistics in the chosen time slice are used to colorize portions of the view diagram.

There is a "tool box" of additional controls in a collapsible flyout panel to the right of the diagram, similar to the one found in the Floorplanner View (see page 57):

![Time Slice Tool Box Panel Example](image)

Figure 33: Time Slice Tool Box Panel Example

The tool box contains three main sections:

- Traffic Type – toggles that allow choosing which types of traffic data to display in the diagram.
- Traffic Mode – the diagram can be switched between two display modes: Throughput or Blockage.
- Legend – displays the gradient range coloring for the selected Traffic Mode.

In Throughput mode, the diagram is colored using the following gradient range:
**Table 51: Throughput Mode Gradient Range**

<table>
<thead>
<tr>
<th>Throughput Gradient</th>
<th>Default Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Green</td>
</tr>
<tr>
<td>Medium</td>
<td>Light blue</td>
</tr>
<tr>
<td>Low</td>
<td>Darker blue</td>
</tr>
</tbody>
</table>

The Throughput mode diagram coloring is illustrated below:

![Figure 34: Throughput Mode Diagram Coloring Example](image-url)
In Blockage mode, the diagram is colored using the following gradient range:

**Table 52: Blockage Mode Gradient Range**

<table>
<thead>
<tr>
<th>Blockage Gradient</th>
<th>Default Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>Green</td>
</tr>
<tr>
<td>Medium</td>
<td>Yellow</td>
</tr>
<tr>
<td>High</td>
<td>Red</td>
</tr>
</tbody>
</table>

The Blockage mode diagram coloring is illustrated below:

![Figure 35: Blockage Mode Diagram Coloring Example](image-url)
Hover the mouse pointer over any colored portion of the diagram and a tool tip is displayed showing the raw data from the simulation log file used to determine the color.

There is also a breakdown of how much time was spent "idle" versus "trying," with the "trying" time further broken down into time spent "blocked" and time spent "transferring":

![Simulation Data Tool Tip Example](image)

**Figure 36: Simulation Data Tool Tip Example**

**Zooming**

The view can be zoomed in or out several levels with the mouse wheel while the mouse pointer is hovering over the diagram.

**Drag-Scrolling**

When zoomed in, the diagram can be scrolled in any direction by clicking and dragging the mouse pointer anywhere inside of the diagram.

**Adjusting Diagram Properties**

The font used in the diagram, as well as the colors used to generate the throughput and blockage gradients, can be configured in the Preferences dialog.

The Preferences dialog can be accessed through the main application menu (Window → Preferences), or by clicking the "down arrow" shortcut in the upper right of the view and clicking **Configure view...**:

![Preferences Dialog Shortcut Location](image)

**Figure 37: Preferences Dialog Shortcut Location**

The Preferences Dialog and the available settings are shown below.
Figure 38: NoC Performance Preferences

Table 53: NoC Performance Preferences

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>See Also: 'Colors and Fonts'</td>
<td>Clicking this hyperlink moves to the NoC Performance section of the Colors and Fonts preferences area.</td>
</tr>
</tbody>
</table>

| Log File Browse Path        | By default, the Log File Browse button in the NoC Performance view begins browsing at the last path used. To always start browsing in a specific folder, enter that path here. |

NoC Time Slice View

The NoC Performance time slice view displays information about the time slice currently selected in the NoC Performance View (see page 98).

Statistics and "Notes" from the simulation log data can be rendered in different colors that can be specified in the application preferences.

Word-wrap can be toggled via a button in the upper-right of the view tool bar.

As with all views in ACE, this view can be dragged and dropped to any convenient location: left of the NoC Performance View, below it, etc.
**Figure 39: NoC Performance Time Slice View Example**

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>AXI Read Requests, Responses</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>map_ax1_slave_c1_r1 -- [AR 95/5 38] [ R 0/28 212]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>map_ax1_slave_c2_r1 -- [AR 95/5 38] [ R 0/28 212]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>map_ax1_slave_c3_r1 -- [AR 95/5 38] [ R 0/28 212]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>map_ax1_slave_c4_r1 -- [AR 95/5 38] [ R 0/28 210]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>map_ax1_slave_c5_r1 -- [AR 95/5 38] [ R 0/28 208]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>map_ax1_slave_c6_r1 -- [AR 95/5 37] [ R 0/28 207]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>map_ax1_slave_c7_r1 -- [AR 95/5 38] [ R 0/28 208]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>map_ax1_slave_c8_r1 -- [AR 95/5 36] [ R 0/26 198]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>fabric_axi_w_r1 -- [AR 87/13 251] [ R 0/84 1685]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>AXI Write Requests/Data/Responses</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>ddr4_dc0_axi -- [AW 0/9 90] [ W 0/72 721] [ B 0/9 90]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>gddr6_1_dc0_axi -- [AW 0/9 90] [ W 0/72 721] [ B 0/9 90]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>gddr6_2_dc0_axi -- [AW 0/9 90] [ W 0/72 721] [ B 0/9 90]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>gddr6_2_dc1_axi -- [AW 0/9 90] [ W 0/72 721] [ B 0/9 90]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>gddr6_5_dc0_axi -- [AW 0/9 90] [ W 0/72 721] [ B 0/9 90]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>gddr6_5_dc1_axi -- [AW 0/9 90] [ W 0/72 721] [ B 0/9 90]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>gddr6_6_dc0_axi -- [AW 0/9 90] [ W 0/72 721] [ B 0/9 90]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>gddr6_6_dc1_axi -- [AW 0/9 90] [ W 0/72 721] [ B 0/9 90]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>PCIe_x16_dc_slave_axi -- [AW 0/9 90] [ W 0/72 721] [ B 0/9 90]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>PCIe_x16_dc_master_axi -- [AW 0/9 90] [ W 0/72 721] [ B 0/9 90]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>Flit Requests/Responses</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>noc_vs_to_ws -- [Rq 10/18 10] [Rs 33/2 100]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>noc_ws_to_vs -- [Rq 50/18 25] [Rs 75/2 80]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>noc_vs_to_n -- [Rq 18/18 75] [Rs 33/2 60]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>noc_n_to_vs -- [Rq 50/18 100] [Rs 75/2 40]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>noc_n_to_n -- [Rq 18/18 75] [Rs 33/2 60]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>noc_n_to_an -- [Rq 50/18 100] [Rs 75/2 40]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>noc_es_to_en -- [Rq 10/18 10] [Rs 33/2 100]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>noc_es_to_es -- [Rq 50/18 25] [Rs 75/2 80]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>noc_es_to_s -- [Rq 10/18 75] [Rs 33/2 60]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>noc_s_to_es -- [Rq 50/18 100] [Rs 75/2 40]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>noc_ws_to_s -- [Rq 10/18 75] [Rs 33/2 60]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>noc_s_to_ws -- [Rq 50/18 100] [Rs 75/2 40]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>noc_es_to_s -- [Rq 10/18 75] [Rs 33/2 60]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>noc_s_to_es -- [Rq 50/18 100] [Rs 75/2 40]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>Channel 0/1 Flits</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>ethernet_flit_s_c1 -- [C0 0/37 745]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>ethernet_flit_n_c2 -- [C0 0/37 745]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>ethernet_flit_s_c2 -- [C0 0/37 745]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>ethernet_flit_n_c4 -- [C0 0/37 745]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>ethernet_flit_s_c4 -- [C0 0/37 745]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>ethernet_flit_s_c1 -- [C1 18/100 1000]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>ethernet_flit_n_c2 -- [C1 28/100 1000]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>ethernet_flit_s_c2 -- [C1 38/100 1000]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>ethernet_flit_n_c4 -- [C1 48/100 1000]</td>
</tr>
<tr>
<td><code>axc_perf&gt;</code></td>
<td>ethernet_flit_s_c4 -- [C1 58/100 1000]</td>
</tr>
</tbody>
</table>
Adjusting View Properties

The font used in the Time Slice View, as well as the colors used to differentiate statistics from notes, can be configured in the Preferences dialog.

The Preferences dialog can be accessed through the main application menu, Window → Preferences. The dialog can also be opened by double-clicking the gradient Legend section in the NoC Performance View toolbox.

The Preferences Dialog and the available settings are shown in the following example:

![Preferences dialog](image)

**Figure 40: NoC Time Slice View Colors and Fonts Preferences**

**Table 54: NoC Performance Preferences**

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NoC Time Slice View font</td>
<td>The font to be used in the NoC Time Slice view.</td>
</tr>
<tr>
<td>Time Slice View: Notes</td>
<td>The color used to render &quot;notes&quot; in the NoC Time Slice view.</td>
</tr>
<tr>
<td>Time Slice View: Stats</td>
<td>Color used to render &quot;statistics&quot; in the NoC Time Slice view.</td>
</tr>
</tbody>
</table>
Options View

The Options view displays project (see page 217) implementation options (see page 217) for the active implementation (see page 217). From this view, the active project implementation (see page 223) can be configured for its run through the flow (see page 223).

This view does not display any information unless an active implementation is selected in the Projects View (see page 123). When Running the Flow (see page 283), the implementation options of the active implementation are used to govern the flow.

By default, the Options view is included in the Projects perspective (see page 24). To add the Options view to the current perspective, select Window → Show View... → Options.

![Figure 41: Options View Example](image-url)
Tip

Tcl Equivalence
Each implementation option that can be configured via this graphical view may also be configured via the `set_impl_option` (see page 619) Tcl command. The current value of each option can be retrieved with the `get_impl_option` (see page 576) Tcl command. The values of options may be reset back to their default values with the `reset_impl_option` (see page 600) Tcl command.

Note

The Options view does not show all available options.

- The implementation options included in this view while ACE is running are the most used standard supported options, but are only a subset of all options available.
- The implementation options shown in the tables below are the subset of non-advanced options in the view that are relevant to all libraries/devices. Library-specific or device-specific options are not listed within these tables.
- Power users of ACE may also configure the Options View to display all "advanced" implementation options by setting the GUI preference under the main menu: Window → Preferences → User Advanced Preferences → Display Advanced Impl Options.
- A complete list (with descriptions) of all available library-specific, device-specific, and advanced implementation options, along with default values and current values, is available in the Implementation Options Report (see page 242), which can be generated with the `report_impl_options` (see page 596) Tcl command. Be aware that the report content varies with the chosen active device/library and as new ACE releases alter the available options/values.
### Table 55: Design Preparation Implementation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Tcl Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Device (1)</td>
<td>partname</td>
<td>Specifies the name of the FPGA part for this implementation.</td>
</tr>
<tr>
<td>Package</td>
<td>package</td>
<td>Specifies the FPGA package for the target device.</td>
</tr>
<tr>
<td>Speed Grade</td>
<td>speed_grade</td>
<td>Selects the desired speed grade for the target device.</td>
</tr>
<tr>
<td>Core Voltage</td>
<td>core_voltage</td>
<td>Selects the core voltage for the target device.</td>
</tr>
<tr>
<td>Junction Temperature</td>
<td>junction_temperature</td>
<td>Selects the junction temperature for the target device.</td>
</tr>
<tr>
<td>Flow Mode (2)</td>
<td>flow_mode</td>
<td><strong>Evaluation</strong> mode – ignores non-fatal DRCs as long as possible, allows I/O Virtualization, and ignores missing SDC constraints to get a post-route timing report quickly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Normal</strong> mode – enforces all DRC checks necessary to generate a correct bitstream. Some checks are flagged as warnings early on in the flow to provide an opportunity to fix the problems (for example, fixing the placement of I/Os). These same checks may change to report an error during final DRC checks.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Strict</strong> mode – similar to <strong>Normal</strong> flow mode, but enforces all DRC checks and errors out as early in the flow as possible.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See also: Flow Mode (see page 228)</td>
</tr>
<tr>
<td>Auto-Select Top Module</td>
<td>autoselect_top_module</td>
<td>Specifies whether the top module name for this implementation should be automatically selected. A value of 1 automatically selects the name. A value of 0 forces use of the -top_module implementation option value.</td>
</tr>
<tr>
<td>Top Module Name</td>
<td>top_module</td>
<td>Specifies the top module name for this implementation when the -autoselect_top_module implementation option is set to 0.</td>
</tr>
<tr>
<td>Constraint Files (3)</td>
<td>enable_project_constraints and disable_project_constraints commands</td>
<td>Enables or disables the use of an existing project SDC/PDC constraint file for this implementation flow. All constraint files defined for the active project are listed.</td>
</tr>
</tbody>
</table>
1. **Caution:** The Chosen "Target Device" Affects Other Implementation Options.

   Each target device can have unique implementation options available within ACE, and may even have different default values for those implementation options which are shared or common between devices.

   Changing the target device value may have a ripple effect upon other option values. Thus, reviewing the values of all other options after changing the target device value may be necessary.

2. Bitstream generation requires **Normal** or **Strict** flow mode.

3. Constraint files are loaded in the order listed. To change the order constraint files are loaded, see Adding Source Files (see page 275).

### Table 56: Advanced Design Preparation Implementation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Tcl Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timing-Driven Clustering</td>
<td>timing_driven_clustering</td>
<td>Specifies whether timing-driven clustering is enabled during placement.</td>
</tr>
<tr>
<td>Fanout Control</td>
<td>fanout_control</td>
<td>When fanout control is enabled, nets with a fanout higher than the Fanout Limit are refactored.</td>
</tr>
<tr>
<td>Fanout Limit</td>
<td>fanout_limit</td>
<td>Specifies the maximum fanout any net can have when Fanout Control is enabled.</td>
</tr>
<tr>
<td>Fanout Limit for Critical Nets</td>
<td>critical_fanout_limit</td>
<td>Specifies the maximum fanout critical nets can have when Fanout Control is enabled.</td>
</tr>
<tr>
<td>Resynthesis Mode</td>
<td>synthesis_remap</td>
<td>Specifies whether resynthesis should optimize for timing, area, or should be disabled. Off disables all resynthesis. Optimize for Area can be used to reduce the total number of LUTs. Optimize for Timing can be used to improve timing, but may increase area. The optimizations performed depend upon the strategies chosen below. If the “Place and Route” Implementation Option Timing-Driven PnR is disabled, resynthesis timing optimizations are also disabled.</td>
</tr>
</tbody>
</table>
Table 57: Advanced Design Preparation Implementation Options (cont.)

<table>
<thead>
<tr>
<th>Option</th>
<th>Tcl Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Rewrite Rule-1                | resynthesis_rewrite_rule1   | When enabled, and Resynthesis Mode is set to Optimize for Timing, attempts to reduce the number of LUTs in series. In critical paths, Rewrite looks at the LUT programs and the number of used inputs to determine where to apply the transformation. The following transformation is then applied when feasible:  

![Rewrite Rule 1 Diagram](image)

| Move Flip-flop Reset          | resynthesis_move_ff_reset   | Specifies whether resynthesis moves flip-flop reset logic to LUTs when Resynthesis Mode is Optimize for Timing.                                                                                               |
| Period of Anti-Aging Oscillator (in ns) (1) | areafill_clock_period       | Period of areafill oscillator in ns (0 to disable). For anti-aging purposes, setting this option to a non-zero value causes ACE to automatically insert logic during Run Prepare to fill the area in the core fabric not consumed by the user design logic, driven by a ring oscillator which toggles at the specified period in nanoseconds. When 0, disables insertion of anti-aging area fill logic.  

| Limit Anti-Aging to Clocks Paths | anti_aging_onlyclock        | Use anti-aging areafill only on clock nodes. Data paths are not filled.                                                                                                                                   |
| Virtual IO Style              | virtual_io_style            | Reduces the number of I/O pads by collapsing bussed ports. Only applies in Evaluation flow mode when I/O pad utilization exceeds the value of Virtual IO Utilization.  

Off disables this feature.  
Stubout using Floating LUTs converts the pads into unconnected LUTs.  
Serialize using LUTs reduces the bus into a single pad feeding a scan chain made of LUTs, with a second pad used to select between "load" and "shift" modes.  
Serialize using DFFs builds the scan chain from DFFs, allowing the boundary connections to be timed.  
Port buses to be virtualized can be specified manually in the RTL or PDC file with the port attribute, ace_virtualize, or automatically by ACE. Working with Virtual I/O (see page 442) contains more details. |
Table 58: Advanced Design Preparation Implementation Options (cont.)

<table>
<thead>
<tr>
<th>Option</th>
<th>Tcl Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual IO Utilization</td>
<td>virtual_io_utilization</td>
<td>The I/O pad utilization percentage targeted by I/O virtualization. Must be an integer between 0 and 100. An error is returned if the given utilization cannot be met. The value 0 requests that all possible port buses and non-bused ports are to be virtualized to achieve the smallest possible number of pads. The value 100 requests that port buses and non-bussed ports are to be virtualized until the number of remaining ports fit in the target device.</td>
</tr>
<tr>
<td>Push Flops Into Pads</td>
<td>push_flops_into_pads</td>
<td>Control over whether the first level of flip-flops is to be automatically pushed into the I/O pins. Automatic Flop Pushing into I/O Pads (see page 434) contains further details. Disabled – turns off pushing of flip-flops into the I/O pins. Automatic – enables full automatic pushing of all possible flip-flops into the I/O pins except for pins with the attribute &quot;syn_useioff=0&quot;. Manual – push flip-flops only into the I/O pins which have the attribute &quot;syn_useioff=1&quot;.</td>
</tr>
<tr>
<td>Pad Flop Pushing Clock Type</td>
<td>pad_flop_pushing_clock_type</td>
<td>Control over flop pushing into I/O pins by clock type. Automatic Flop Pushing into I/O Pads (see page 434) contains further details. Boundary – Only enable flop pushing into I/O pins clocked by a boundary clock. Trunk – Only enable flop pushing into I/O pins clocked by a trunk clock. All – Enable flop pushing into all I/O pins.</td>
</tr>
</tbody>
</table>

**Table Notes**

1. Setting the Period of Anti-Aging Oscillator option to a **non-zero** value increases the size of the user design in place and route and the corresponding bitstream to near maximum size.
### Table 59: Place and Route Implementation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Tcl Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| PnR Mode                | timing_driven_pnr        | If **Timing Driven** mode is selected, data from timing analysis is used to optimize the design for high speed.  
If **Fast** mode is selected, placement and routing are optimized for runtime. |
| Multi-Threaded PnR      | mt_pnr                   | Enable Multi-Threaded Place and Route. Enabling this can speed up your compile time.                   |
| PnR Seed                | seed                     | The place and route seed is used to initialize the random number state in the place and route algorithms. |
| Placement Effort        | placement_effort         | **Low** – effort placement has a shorter runtime, but may yield less design QoR than High effort placement.  
**High** – effort placement increases placement runtime to further optimize the design QoR if possible.  |
| Router Hold-Violation Fix Limit (ps) | router_max_hold          | Specifies the maximum hold-time violation (in picoseconds) that the Router attempts to fix.             |
| Post-PnR Buffer Limit   | max_postpnr_buffer_limit | This limit specifies the maximum number of post-placement buffers that can be inserted.             |
| Post-PnR Rewiring       | postpnr_rewire           | If turned on, allows post-pnr rewiring to improve the design performance and resource usage.           |

### Table 60: Report Generation Implementation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Tcl Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Utilization Reports</td>
<td>report_utilization</td>
<td>Enable utilization analysis and report generation in the flow.</td>
</tr>
<tr>
<td>Output Partition Reports</td>
<td>report_partitions</td>
<td>Enable partition report generation in the flow.</td>
</tr>
<tr>
<td>Output Pin Assignment Reports</td>
<td>report_pins</td>
<td>Enable pin assignment report generation in the flow.</td>
</tr>
<tr>
<td>Output Clock Reports</td>
<td>report_clocks</td>
<td>Enable clock analysis and report generation in the flow.</td>
</tr>
<tr>
<td>Output Placement Reports</td>
<td>report_placement</td>
<td>Enable placement report generation in the flow.</td>
</tr>
<tr>
<td>Output Routing Reports</td>
<td>report_routing</td>
<td>Enable routing report generation in the flow.</td>
</tr>
<tr>
<td>Output Power Reports</td>
<td>report_power</td>
<td>Enable power analysis and report generation in the flow.</td>
</tr>
</tbody>
</table>
### Table 61: Timing Analysis Implementation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Tcl Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of critical paths</td>
<td>sync_timing_num_paths</td>
<td>Maximum number of critical paths per clock group.</td>
</tr>
<tr>
<td>Number of worst paths</td>
<td>sync_timing_num_worst</td>
<td>Maximum number of worst paths per end point.</td>
</tr>
<tr>
<td>Report unconstrained paths</td>
<td>report_unconstrained_timing_paths</td>
<td>When enabled, ACE includes unconstrained timing paths in the timing analysis reports.</td>
</tr>
</tbody>
</table>

### Table 62: Bitstream Generation Implementation Options — Additional Outputs

<table>
<thead>
<tr>
<th>Option</th>
<th>Tcl Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial Flash (.flash)</td>
<td>bitstream_output_flash</td>
<td>Enables the generation of an additional serial flash formatted output file. This file is named the same as the STAPL file, but with a .flash extension. This file contains a binary image that can be directly loaded into a single serial flash memory.</td>
</tr>
<tr>
<td>4x Serial Flash (.flash4x_[0-3])</td>
<td>bitstream_output_4xflash</td>
<td>Enables the generation of four additional 4x serial flash formatted output files. These files are named the same as the STAPL file, but with an extension ranging from .flash4x_0 to .flash4x_3. Each file contains a binary image that can be directly loaded into each serial flash memory in a x4 configuration.</td>
</tr>
<tr>
<td>CPU Mode (.cpu)</td>
<td>bitstream_output_cpu</td>
<td>Enables the generation of an additional CPU Mode formatted output file. This file is named the same as the STAPL file, but with a .cpu extension. The file contains hexadecimal-formatted data organized in “CPU Bus Width” number of bits per file line. Data from this file is sent to the FCU CPU interface line by line (one line per clock cycle) from the top to the bottom of the file, where the left-most bit on each line is the MSB and the right-most bit is the LSB. In simulation, this file may be loaded using the readmemh function. For convenience, an additional binary representation of the CPU Mode output file is written, named the same as the STAPL file, but with a .cpu extension. The file contains the same data in the same bit order as the .cpu file.</td>
</tr>
<tr>
<td>CPU Bus Width</td>
<td>bitstream_output_cpu_width</td>
<td>Controls the bit width of the CPU-mode formatted output file. When using the CPU interface in ×8 mode, set this value to 8. If using the CPU interface in ×128 mode, set this to 128. The value determines how many bitstream bits are printed per line in the .cpu output file. The bit sequence required by the FCU (and output in the generated bitstream file) may be different for each CPU Bus Width setting. Therefore, it is important to set this option to match the actual CPU hardware interface width.</td>
</tr>
<tr>
<td>Raw Hex (.hex)</td>
<td>bitstream_output_hex</td>
<td>Enables the generation of an additional Raw Hex formatted output file. This file is named the same as the STAPL file, but with a .hex extension. This file is used for debug purposes.</td>
</tr>
</tbody>
</table>
### Table 63: Bitstream Generation Implementation Options — JTAG Scan Chain

<table>
<thead>
<tr>
<th>Option</th>
<th>Tcl Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Device Chain</td>
<td>bitstream_single_device</td>
<td>Specifies whether the bitstream STAPL file is output for a single-device JTAG scan chain (the target device is the only device on the JTAG scan chain). Set this to 1 to indicate a single device. If this option is set to 0 (indicating multiple devices in the scan chain), either the chain description file is used or the pre-IR, post-IR, and chain offset options are used to generate the bitstream STAPL file with knowledge of the scan chain.</td>
</tr>
<tr>
<td>Use JESD32 Chain Description File</td>
<td>bitstream_use_chain_file</td>
<td>When using a multi-device JTAG scan chain, specifies whether to use a JESD32 chain description file, or to use the explicit pre-IR, post-IR, and chain offset implementation options.</td>
</tr>
<tr>
<td>Chain Description File</td>
<td>bitstream_chain_file</td>
<td>This option specifies the optional JESD32 chain description file used by the bitstream generator to automatically pad the JTAG IR chain for multi-device chains.</td>
</tr>
<tr>
<td>Chain Offset of Target</td>
<td>bitstream_chain_offset</td>
<td>Specifies the offset of the target device on the JTAG scan chain for multi-device chains. Setting this to 0 selects the first device on the chain, 1 selects the second device on the chain, and so on.</td>
</tr>
<tr>
<td>IR Bits Before Target</td>
<td>bitstream_preir_padding</td>
<td>Specifies the total number of Instruction Register bits on the JTAG scan chain prior to the target device Instruction Register. This option is used for multi-device scan chains in order to pad the IR chain properly with 1s to put other devices in bypass mode.</td>
</tr>
<tr>
<td>IR Bits After Target</td>
<td>bitstream_postir_padding</td>
<td>Specifies the total number of Instruction Register bits on the JTAG scan chain after the target device Instruction Register. This option is used for multi-device scan chains in order to pad the IR chain properly with 1s to put other devices in bypass mode.</td>
</tr>
</tbody>
</table>

#### Note

For more details about JTAG scan chain settings and download/programming device configurations, see Configuring the JTAG Connection (see page 339).

### Table 64: FPGA Download Implementation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Tcl Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JTAG Device Name (1)</td>
<td>download_pod_names</td>
<td>Specifies, by name, the JTAG device to be used for programming. The device naming schemes are described in the Bitstream Programming and Debug Interface User Guide (UG004).</td>
</tr>
</tbody>
</table>

#### Table Notes

1. This implementation option is stored for this implementation Flow only, and thus does not affect Bitporter pod selection for the Download View (see page 55) or Snapshot Debugger View (see page 139). The pod selection for those views is a user preference, which is managed by the Configure JTAG Connection Preference Page (see page 187), and is not a per-implementation setting. See Configuring the JTAG Connection (see page 339) for more details.
Outline View

The Outline view displays a tree of all pages in the currently active IP Configuration Editor (see page 27). Each page has its own title, and an icon to indicate the cumulative validity of all IP configuration contained on that page.

The information in the tree is dynamic, and changes as corresponding values are changed in the active IP Configuration Editor. As pages in the Editor are added or removed, entries in the tree are added or removed accordingly. As values in the Editor page change validity, the validity of the corresponding page in the Outline view tree also change.

In addition to showing the page validity, the Outline view provides an alternate method for navigating between the various dynamic pages of the IP Configuration Editors (see page 27). Selecting (clicking) an item in the Outline view causes the IP Configuration Editor to turn to the associated page.

![Outline View Example](image)

**Figure 42: Outline View Example**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Checkmark]</td>
<td>No errors or warnings on the page.</td>
</tr>
<tr>
<td>![Warning]</td>
<td>At least one warning on the page, but no errors.</td>
</tr>
<tr>
<td>![Error]</td>
<td>At least one error on the page.</td>
</tr>
</tbody>
</table>

See also: Creating an IP Configuration (see page 314)

Partitions View

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Partitions View is only relevant when Incremental Compilation is enabled and partitions (compile points) have been defined in the project constraints files. Otherwise, this view table is empty.</td>
</tr>
</tbody>
</table>

The Partitions View displays the state of the active implementation partitions, and allows (through interactions with the Floorplanner View (see page 57), Search View (see page 132), and Selection View (see page 136)) visualizations of the partitions and their relationships with the rest of the active implementation.

The Partitions View is a default member of the Floorplanner perspective, and can be added to any other perspective by selecting **Window → Show View → Other... → Partitions View**.

See also: Using Incremental Compilation (Partitions) (see page 380)
Caution!

Resource type columns, such as Flops, BRAMs, ALUs, etc. are dynamic and change to match the target device after running the Prepare flow step. The screenshots and example descriptions in this section do not reflect the resource types of the actual device being used.

Table 66: Partitions View Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition Name</td>
<td>The name of the partition as specified in the design constraints file(s).</td>
</tr>
<tr>
<td>Highlight Color</td>
<td>If all instances within the partition have the same highlight color, the row shows a color square with that same highlight color. If even one contained instance has a differing highlight color, or no highlight at all, then the row displays no color square.</td>
</tr>
<tr>
<td>Time Stamp</td>
<td>The timestamp of the last compile for this partition (compile point) in the upstream synthesis tool.</td>
</tr>
<tr>
<td>Clock Pre-Routes</td>
<td>If any clock pre-routes exist for a given partition, they are listed here.</td>
</tr>
<tr>
<td>Anchor Instance</td>
<td>The instance in the partition to &quot;anchor&quot; drag-and-drop operations.</td>
</tr>
<tr>
<td>Re-compiled</td>
<td>Contains a checkmark if the partition was recompiled, requiring placement and routing to be re-run.</td>
</tr>
<tr>
<td>Force Re-compile on Next Run</td>
<td>Indicates whether the partition is forced to re-compile during the next pass through ACE. This checkbox may be toggled on or off using the right-click Context Menu choices <strong>Force Partition Changed</strong> and <strong>Un-Force Partition Changed</strong>.</td>
</tr>
<tr>
<td>Resource</td>
<td>The sum count of all resource instances contained in this partition and no other partitions.</td>
</tr>
<tr>
<td>Cumulative Resource</td>
<td>The sum count of all contained resource instances, including in child partitions (below this partition in the RTL hierarchy).</td>
</tr>
</tbody>
</table>

A number of actions are available within the view, available in the toolbar at the top of the view and/or in right-click context menus for each partition in the table.
### Table 67: Partitions View Actions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Toolbar Button</th>
<th>Context Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="search_icon" alt="Search" /></td>
<td>Search for Instances</td>
<td>Y</td>
<td>Y</td>
<td>Issues a <code>find Tcl</code> command that returns the names of all the instances in the selected partition(s).</td>
</tr>
<tr>
<td><img src="add_icon" alt="Add" /></td>
<td>Add Instances to Selection</td>
<td>Y</td>
<td>Y</td>
<td>Adds the instances within the partition to the ACE Selection Set (as shown in the Selection View (see page 136)).</td>
</tr>
<tr>
<td><img src="highlight_icon" alt="Highlight" /></td>
<td>Highlight</td>
<td>Y</td>
<td>Y</td>
<td>Applies the currently active Highlight color to the instances within the chosen partition (see Highlighting Objects in the Floorplanner View (see page 323)).</td>
</tr>
<tr>
<td><img src="unhighlight_icon" alt="Un-Highlight" /></td>
<td>Un-Highlight</td>
<td>Y</td>
<td>Y</td>
<td>Clears the Highlight for the instances within the chosen partition.</td>
</tr>
<tr>
<td><img src="choose_highlight_icon" alt="Choose Highlight Color" /></td>
<td>Choose Highlight Color</td>
<td>Y</td>
<td>Y</td>
<td>Determines which color is applied to the objects chosen the next time the Highlight action is selected for this view.</td>
</tr>
<tr>
<td><img src="autohighlight_icon" alt="Auto-Highlight" /></td>
<td>Auto-Highlight</td>
<td>Y</td>
<td></td>
<td>Automatically assigns a unique highlight color to each partition.</td>
</tr>
<tr>
<td><img src="zoom_icon" alt="Zoom To" /></td>
<td>Zoom To</td>
<td>Y</td>
<td>Y</td>
<td>Zooms the Floorplanner view to a region containing the instances within the partition currently chosen in the tree.</td>
</tr>
<tr>
<td><img src="toggle_filter_icon" alt="Toggle Filter Row Visibility" /></td>
<td>Toggle Filter Row Visibility</td>
<td>Y</td>
<td></td>
<td>Changes whether the filter row (of filter icons) is visible.</td>
</tr>
<tr>
<td><img src="configure_clock_icon" alt="Configure Clock Pre-Routes" /></td>
<td>Configure Clock Pre-Routes</td>
<td>Y</td>
<td></td>
<td>Allows adding clock pre-route information for the selected partition(s).</td>
</tr>
<tr>
<td><img src="force_partition_icon" alt="Force Partition Changed" /></td>
<td>Force Partition Changed</td>
<td>Y</td>
<td></td>
<td>Override the partition timestamp during the next pass through Ace: A check mark appears in the Force Re-compile on Next Run column, and the partition is re-placed and re-routed the next time the flow is run, even if there were no RTL changes and it was not re-compiled in the upstream synthesis tool. <strong>Un-Force Partition Changed</strong> removes the check mark in the column.</td>
</tr>
<tr>
<td><img src="unforce_partition_icon" alt="Un-Force Partition Changed" /></td>
<td>Un-Force Partition Changed</td>
<td>Y</td>
<td></td>
<td>Removes the check mark from the Force Re-compile on Next Run column, so the compilation timestamp is no longer overridden. This is essentially an undo operation for the Force Partition Changed action.</td>
</tr>
<tr>
<td><img src="export_icon" alt="Export Partition" /></td>
<td>Export Partition</td>
<td>Y</td>
<td></td>
<td>Exports the selected partition to an <code>.epdb</code> file under <code>{impl_name}/output/partitions</code>, and exports a blackbox netlist for the partition to a <code>.v</code> file under <code>{impl_name}/output/blackboxes</code>.</td>
</tr>
</tbody>
</table>

**Table Notes**

1. Toggle Filter Row Visibility does not alter whether filters are active, it only changes the visibility of the row of filter icons.

**Note**

All actions upon a partition act only upon the members of that partition, not upon the members of any child partitions.
Drag-and-Drop

The Partitions view supports a limited set of Drag-and-Drop interactions with other views in the Floorplanner perspective (see page 24). The view only acts as a Drag-and-Drop source; items dropped on the Partitions view are ignored.

Any row of the table may be dragged to the Tcl Console view (see page 144), and when dropped anywhere in the view the partition name (with the appropriate object type prefix) is inserted at the beginning of the Tcl command-line.

Any partition in the table may be dragged to the Placement Regions view (see page 118) or the Floorplanner View (see page 57) (when that view has the Placement Regions Tool active) to assign placement region constraints (see page 374). Dropping in the Placement Regions view uses the add_region_find_insts Tcl command. Dropping onto the Floorplanner view uses the set_placement -partition Tcl command. Dragging a partition is the equivalent of dragging all individual instances which are members of that partition.

Partial Reconfig Cluster Value

The partial reconfig cluster value display at the bottom of the view shows a value representing the set of all selected partition rows in the view. Selecting more or fewer rows in the view updates this value accordingly.

The Copy hex value to clipboard button copies the current value to the system clipboard. The Send Tcl command button automatically issues an appropriate set_impl_option bitstream_prc_cluster_map {partial_reconfig_value} command.

Placement Regions View

The Placement Regions view provides a tabular representation of the content of all user-created Placement Regions (see page 371) for the design. The view allows the manipulation of the visibility of the Placement Region itself as painted (as a colored overlay) in the Floorplanner View (see page 57), and the content (the instances constrained to the region) of each Placement Region. The view table remains empty until the currently active Implementation has completed the Run Prepare flow step.

Because Placement Regions are manually defined, and Instances are manually constrained to the Placement Regions, it is necessary to track the total number of sites and associated Instances for each Resource type. Accordingly, based upon the chosen Target Device Implementation Option, there are columns for each available Resource type found within the device. If more Instances are ever assigned to a Placement Region than there are available sites of that type within that Placement Region, the view displays an error for that placement region and resource type combination.

The section Placement Regions and Placement Region Constraints (see page 371) describes the creation and usage of Placement Regions in greater detail.

By default, the Placement Regions view is included in the Floorplanner perspective (see page 24). To add the view to another perspective, select Window → Show View → Other... → Achronix → Placement Regions.

![Placement Regions View Example](image)

In the above example screenshot, error icons are shown for the CLK_IPIN assignments of region_2, indicating that too many instances (1) are assigned for the available sites (0) within the region. The region itself also shows an error icon to indicate when an erroneous resource type is scrolled offscreen.
Resource type columns, such as Flops, BRAMs, ALUs, etc. are dynamic. When the Run Prepare flow step has completed, the columns appropriate to the target device are chosen and values are updated. The resource type columns shown in the screenshots should be considered examples only — they might not match the exact resources of any particular target device.

Table 68: Placement Regions Table Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visibility</td>
<td>When selected (this is user-editable), this placement region overlay is painted in the Floorplanner View (see page 57), using the chosen translucent Overlay Color.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of this placement region.</td>
</tr>
<tr>
<td>Overlay Color</td>
<td>The (user editable) translucent color used to paint an overlay in the Floorplanner View, showing the location of the placement region.</td>
</tr>
<tr>
<td>Clock Pre-Routes</td>
<td>If any clock pre-routes exist for a given partition, they are listed here.</td>
</tr>
<tr>
<td>Soft</td>
<td>When the placement region is created, it can be defined as a Soft region. Soft regions contain a checkmark in this column. The &quot;soft&quot; placement region status cannot be changed after creation.</td>
</tr>
<tr>
<td>Keep Out</td>
<td>When the placement region is created, it can be defined as a Keep Out region. Keep Out regions contain a checkmark in this column. The &quot;keep out&quot; placement region status cannot be changed after creation.</td>
</tr>
<tr>
<td>Include Routing</td>
<td>Treats the region as a routing constraint as well as a placement constraint, keeping all routing wires and instances inside the region boundary box.</td>
</tr>
<tr>
<td>PR Zone</td>
<td>When the placement region is created, it can be defined as a Partial Reconfiguration (PR) zone. PR Zone regions contain a checkmark in this column. The &quot;PR zone&quot; placement region status cannot be changed after creation.</td>
</tr>
<tr>
<td>Resource</td>
<td>The number of Resource Instances constrained to this placement region or the number of Resource sites contained within the bounds of this placement region.</td>
</tr>
</tbody>
</table>

Table 69: Placement Regions View Actions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Toolbar Button</th>
<th>Context Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show/Hide overlay: region_name</td>
<td>Show or Hide All</td>
<td>Y</td>
<td>Y</td>
<td>Toggles the Visibility checkbox for all placement regions, showing or hiding their colored translucent overlays in the Floorplanner View.</td>
</tr>
<tr>
<td>Select Constrained Instances</td>
<td>Select Constrained Instances</td>
<td>Y</td>
<td>Y</td>
<td>Adds all Instances constrained within this placement region to the ACE Selection Set (see Selection View (see page 136)).</td>
</tr>
</tbody>
</table>
### Table 70: Placement Regions View Actions (cont.)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Toolbar Button</th>
<th>Context Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![X]</td>
<td>Deselect Constrained Instances</td>
<td>Y</td>
<td>Y</td>
<td>Removes all Instances constrained within this placement region from the ACE Selection Set.</td>
</tr>
<tr>
<td>![ ]</td>
<td>Change Overlay Color</td>
<td>Y</td>
<td></td>
<td>Allows the choice of which translucent Overlay Color is used to represent this placement region in the Floorplanner View.</td>
</tr>
<tr>
<td>![ ]</td>
<td>Reset Overlay Color</td>
<td>Y</td>
<td></td>
<td>Resets the chosen placement region overlay color, allowing ACE to automatically pick a new color. If the overlay colors of two placement regions are too similar for easy discernment, another color is pseudo-randomly picked. Each time this action is chosen, another color is picked.</td>
</tr>
<tr>
<td>![ ]</td>
<td>Reset All Overlay Colors</td>
<td>Y</td>
<td></td>
<td>Pseudo-randomly reassigns new overlay colors for all placement regions.</td>
</tr>
<tr>
<td>![ ]</td>
<td>Un-Highlight Constrained Instances</td>
<td>Y</td>
<td>Y</td>
<td>Clears the opaque Highlight color for all instances constrained to the selected Placement Region.</td>
</tr>
<tr>
<td>![ ]</td>
<td>Highlight Constrained Instances</td>
<td>Y</td>
<td>Y</td>
<td>Highlights all instances constrained to the currently selected placement region with the currently-selected opaque highlight color. The highlighted results are visible in the Floorplanner view (see Highlighting Objects in the Floorplanner View (see page 323)).</td>
</tr>
<tr>
<td>![ ]</td>
<td>Choose Highlight Color for next Highlight command</td>
<td>Y</td>
<td>Y</td>
<td>Allows the changing of the current placement region constrained instances opaque highlight color (which is different from the placement region translucent overlay color). This opaque highlight color is used in the Floorplanner view when the Highlight Constrained Instances ( ) action is chosen in the Placement Regions view.</td>
</tr>
<tr>
<td>![ ]</td>
<td>Zoom to: region_name</td>
<td>Y</td>
<td>Y</td>
<td>Zooms and pans the Floorplanner view to show the location of the selected Placement Region (the Placement Region itself is not visible as an overlay unless the appropriate Visibility checkbox is enabled in the Placement Region View table).</td>
</tr>
<tr>
<td>![ ]</td>
<td>Print Instances: region_name</td>
<td>Y</td>
<td></td>
<td>Causes a list of all Instances constrained to the selected placement region to be printed in the Tcl Console. Issues the get_region_insts Tcl command.</td>
</tr>
<tr>
<td>![X]</td>
<td>Remove All Instance Constraints</td>
<td>Y</td>
<td></td>
<td>Removes all Instances from this Placement Region, thus clearing their placement region constraints.</td>
</tr>
<tr>
<td>![X]</td>
<td>Delete Placement Region</td>
<td>Y</td>
<td></td>
<td>Removes the selected Placement Region and all associated placement region constraints from the design.</td>
</tr>
<tr>
<td>![ ]</td>
<td>Configure Clock Pre-Routes...</td>
<td>Y</td>
<td></td>
<td>Allows adding clock pre-route information to the selected partition(s).</td>
</tr>
<tr>
<td>![ ]</td>
<td>Save Placement Regions</td>
<td>Y</td>
<td></td>
<td>Brings up the Save Placement Regions Dialog (see page 182) to save one or all of the Placement Regions definitions and all associated instance placement region constraints.</td>
</tr>
<tr>
<td>![ ]</td>
<td>Toggle Filter Row Visibility</td>
<td>Y</td>
<td></td>
<td>Changes whether the filter row (of filter icons) at the top of the table is visible or not. This does not alter whether filters are active, it only changes the visibility of the row of filter icons.</td>
</tr>
</tbody>
</table>
Using the Table to Display Placement Regions in the Floorplanner View

Each Placement Region is automatically given a unique translucent overlay color to represent the Placement Region when painting the Floorplanner View (see page 57). By default, no Placement Region overlays are painted in the Floorplanner View. The Placement Region overlays to be displayed must be enabled. The overlay color may optionally be altered for each or all Placement Regions, but these color choices are not persistent between ACE sessions.

Note

While alternate overlay colors may be chosen for each Placement Region, these overlay colors are not saved between sessions. Each time a design is loaded, new overlay colors are automatically chosen for each Placement Region.

The following are ways to alter the presentation of Placement Region data in the Floorplanner View (see page 57):

Enable/Disable Painting of Individual Placement Regions Within the Target Device

When the checkbox in the Visibility column for a Placement Region is selected, the area of the target device (in the Floorplanner view) representing that Placement Region is painted in the displayed translucent overlay color. When the checkbox is unchecked, the Floorplanner view is redrawn with the chosen Placement Region overlay no longer painted.

Enable/Disable Painting of all Placement Regions Within the Target Device

When the Show/Hide All Placement Regions action is chosen, the visibility of all Placement Regions is simultaneously either enabled or disabled, causing the Floorplanner View to be repainted appropriately.

Temporarily Alter the Overlay Rendering Color of Individual Placement Regions

The overlay rendering color of each individual Placement Region may be chosen as follows:

1. Right-click anywhere on the row of the desired Placement Region.
2. Select Choose Overlay Color from the popup context menu.
3. Use the Color Dialog to choose the desired color for the Placement Region.

This is a temporary color change — colors are reverted to automatically chosen defaults every time ACE starts. During a session, colors are also reverted to the defaults if any of the following are changed:

- The active design
- The active implementation
- The target device

ACE automatically picks a different overlay color for an individual Placement Region if Reset Overlay Color is chosen from the right-click popup content menu.

Temporarily Alter the Overlay Rendering Color for All Placement Regions

ACE automatically picks different overlay colors for all Placement Regions if the Reset All Overlay Colors action is chosen.

Organizing Table Data

The following are ways to alter the presentation of the data in the Placement Regions table:
Column Resizing

The width of a column can be changed as follows:

1. Place the mouse cursor over the boundary between columns. The mouse cursor changes to indicate resizing is possible.
2. Click and drag left or right to resize the column to the desired width.
3. Release the mouse button.

Column Reordering

The order of the columns in the table can be changed as follows:

1. Click and hold any column name.
2. Drag left or right to move the column between any other pair of columns.
3. Release the mouse button to insert the column header at the new location.

While dragging, the dragged column header appears alongside the mouse cursor. A thick column header separator appears at the present cursor location to show where the column insertion occurs if the mouse button is released.

Filtering

Most table columns can filter the displayed Placement Regions by value. When filtering by column value, only Placement Regions with column values matching the filter are retained; non-matching values are excluded from the table.

- Columns containing text can be filtered by string value. Simple substring text matching (with optional wildcard) is used by default, but Regular Expression matching, also known as RegEx (see https://en.wikipedia.org/wiki/Regular_expression), is also available. The ACE GUI RegEx matching follows Java rules (see https://docs.oracle.com/en/java/javase/11/docs/api/java.base/java/util/regex/Pattern.html), which are extremely similar to Perl rules.
- Columns with checkmarks can be filtered by boolean value.
- Columns containing numbers can be filtered by numerical value.
- Columns which may not be filtered (i.e., the Overlay Color column) lack a filter icon in the filter row.

To add a filter to a column:

1. The Filter Row must first be visible. Select the (Toggle Filter Row Visibility) action to show the row if necessary.
2. Click the ( ) filter icon for the desired column, which causes a data-appropriate filter dialog to appear.
3. Fill in the desired filter values and click Apply to apply the filter to the rows in the table.

All values matching that filter are retained, and all other values are excluded. Additionally, the background color of the filtered column changes to a bright yellow to indicate the filter is active, and the filter icon at the head of the column also changes to the ( ) active filter icon.

To edit (or clear) an existing filter:

1. Click the ( ) active filter icon, which causes the data-appropriate filter dialog to appear pre-populated with the current column filter setting.
2. Change the filter value and click Apply to edit the filter.
3. Click Cancel to leave the filter unchanged.
4. Click **Clear** to remove the filter from the column.

If the filter is cleared, the background color of the column returns to the default background color, and the filter icon also changes to the (☑️) inactive version.

**Partial Reconfig Cluster Value**

The partial reconfig cluster value display at the bottom of the view shows a value representing the set of all placement regions marked as "visible" in the view. Making more or fewer placement regions visible updates this value accordingly. The **Copy hex value to clipboard** button copies the current value to the system clipboard.

The **Send Tcl command** button automatically issues an appropriate `set_impl_option bitstream_prc_cluster_map {partial_reconfig_value}` command.

**Projects View**

The Projects view provides a hierarchical view of the Projects (see page 217) in the Workbench (see page 24). From here, projects can be added and removed, project configurations edited, the active implementation (see page 217) can be chosen, saved, or restored, files may be opened for editing, etc.

Clicking an implementation activates (see page 223) it. Similarly, clicking a project activates the first implementation in the project definition. The active project and active implementation are both displayed in a bold font.

The various Source Files (see page 219) making up a project are added and removed from this view. Source files of the project are listed in the order in which they are loaded. To change the order the source files are listed or loaded, see Adding Source Files (see page 275).

By default, the Projects view is included in the Projects perspective (see page 24). To add it to the current perspective, click **Window → Show View... → Projects**.

For detailed information about managing projects, implementations, source files, etc., see Working with Projects and Implementations (see page 271). See also: Project Management Preference Page (see page 211).
**Figure 45: Projects View Example**

**Table 71: Projects View Actions**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Toolbar Button</th>
<th>Context Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Open File Icon" /></td>
<td>Open File</td>
<td>Y</td>
<td>Y</td>
<td>Opens the selected file in a text editor within ACE. See also: display_file (see page 562).</td>
</tr>
<tr>
<td><img src="image" alt="Create Project Icon" /></td>
<td>Create project</td>
<td>Y</td>
<td></td>
<td>Opens the Create Project Dialog (see page 168) to allow creating a new project definition in the tool. See also: create_project (see page 560).</td>
</tr>
<tr>
<td><img src="image" alt="Load Project Icon" /></td>
<td>Load project</td>
<td>Y</td>
<td></td>
<td>Opens the Load Project Dialog (see page 173) to allow loading an existing ACE Project File into the tool. See also: load_project (see page 588).</td>
</tr>
<tr>
<td><img src="image" alt="Save Project Icon" /></td>
<td>Save project</td>
<td>Y</td>
<td>Y</td>
<td>Saves the changes to the selected ACE Project to its ACE Project File on disk. See also: save_project (see page 616).</td>
</tr>
<tr>
<td><img src="image" alt="Save Project As... Icon" /></td>
<td>Save Project As...</td>
<td>Y</td>
<td></td>
<td>Saves the selected ACE project to a newly-chosen filename and location on disk.</td>
</tr>
<tr>
<td>Icon</td>
<td>Action</td>
<td>Toolbar Button</td>
<td>Context Menu</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>----------------</td>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Reload project icon" /></td>
<td>Reload project</td>
<td>Y Y</td>
<td>Enables reloading the selected ACE Project. See also: <code>restore_project</code> (see page 601).</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Add source files icon" /></td>
<td>Add source files (1)</td>
<td>Y Y</td>
<td>Enables adding source netlist and constraint files to the selected project in the Projects view. Also allows adding IP Configuration files (.acxip) to the project as a convenience. See also: <code>add_project_ip</code> (see page 552), <code>add_project_netlist</code> (see page 552) and <code>add_project_constraints</code> (see page 551).</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Create implementation icon" /></td>
<td>Create implementation</td>
<td>Y Y</td>
<td>Enables creating a new project implementation definition for the selected project in the Projects view. See also: <code>create_impl</code> Tcl command.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Restore implementation icon" /></td>
<td>Restore implementation</td>
<td>Y Y</td>
<td>Enables restoring the active project implementation from an Acxdb Archive File. See also: <code>restore_impl</code> Tcl command.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Rename implementation icon" /></td>
<td>Rename implementation</td>
<td>Y Y</td>
<td>Enables renaming the Implementation. See also: <code>rename_impl</code> Tcl command.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Save implementation icon" /></td>
<td>Save implementation</td>
<td>Y Y</td>
<td>Enables saving the active project implementation to an Acxdb Archive File. See also: <code>save_impl</code> Tcl command.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Open Multiprocess Report icon" /></td>
<td>Open Multiprocess Report</td>
<td>Y Y</td>
<td>Enables opening the Multiprocess Summary Report for the selected project, if the project has one. See also: <code>display_file</code> Tcl command.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Refresh contents icon" /></td>
<td>Refresh contents</td>
<td>Y Y</td>
<td>Enables refreshing the listing of supporting files contained within the selected project or implementation.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Remove icon" /></td>
<td>Remove</td>
<td>Y Y</td>
<td>Enables removing the selected items from the Projects view. Removing items from a project does not delete the corresponding resources from the file system, except for removing implementation output and report files. See also: <code>remove_project</code>, <code>remove_project_constraints</code>, <code>remove_project_netlist</code>, <code>remove_project_ip</code> and <code>remove_impl</code> Tcl commands.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Clone IP icon" /></td>
<td>Clone IP</td>
<td>Y Y</td>
<td>Enables creating a duplicate of the selected IP and adding it to the project.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Rename IP icon" /></td>
<td>Rename IP</td>
<td>Y Y</td>
<td>Enables renaming the selected IP.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Add IP to another project icon" /></td>
<td>Add IP to another project...</td>
<td>Y</td>
<td>Enables adding the selected IP to another project in the ACE workspace.</td>
<td></td>
</tr>
</tbody>
</table>
## Table 72: Project View Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Project" /></td>
<td>Project</td>
</tr>
<tr>
<td><img src="image" alt="Project (Active)" /></td>
<td>Project (Active)</td>
</tr>
<tr>
<td><img src="image" alt="Project (Save Needed)" /></td>
<td>Project (Save Needed)</td>
</tr>
<tr>
<td><img src="image" alt="Project (Active, Save Needed)" /></td>
<td>Project (Active, Save Needed)</td>
</tr>
<tr>
<td><img src="image" alt="Implementation" /></td>
<td>Implementation</td>
</tr>
<tr>
<td><img src="image" alt="Implementation (Active)" /></td>
<td>Implementation (Active)</td>
</tr>
<tr>
<td><img src="image" alt="File" /></td>
<td>File</td>
</tr>
</tbody>
</table>

### Table Notes

1. Constraint files are loaded by ACE in the same order they are displayed within this view. For details on how to change this display/load order, see Adding Source Files (see page 275).
Note

Some files in the "Constraints" section of the tree may appear greyed-out to indicate that those constraint files are not enabled in the Active Implementation (see page 223) as shown in the following figure. Various constraint files in a project can be enabled or disabled for an implementation in the Options View (see page 106), under Design Preparation → Constraint Files.

![Disabled Constraints File Example](image)

**Figure 46: Disabled Constraints File Example**

Properties View

The Properties View can provide in-depth specifics about many types of pin, net, and instance items on demand, and the view then allows navigating many of the relationships between connected items.

To initialize the Properties View with desired information, use the Display Properties For... choices found on the right-click context menus of many of the views within the Floorplanner Perspective. The Tcl command display_properties can also be used to populate the Properties View.

![Properties View Example](image)

**Figure 47: Properties View Example**
General Tab
The General tab shows the basic, top-level information about the item.

![General Tab Example](image)

**Figure 48: General Tab Example**

**Note**
Double-click a **Source Netlist File** filename to immediately open that file in the Editor area, or double-click a **Source Netlist Line Number** to immediately open the source netlist file, showing the given line number, in the Editor area.

Parameters Tab
The Parameters tab shows the type, name, and value of all of the configurable parameters for the item.

![Parameters Tab Example](image)

**Figure 49: Parameters Tab Example**
Pins Tab

The Pins tab shows a variety of information about the item pins.

![Figure 50: Pins Tab Example](image)

A number of actions are available on the Pins tab right-click menus.

**Table 73: Properties View Pins Tab Actions**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Copy Cell Text" /></td>
<td>Copy Cell Text</td>
<td>Advanced</td>
<td>Copies the text onto the system clipboard.</td>
</tr>
<tr>
<td><img src="image" alt="Add to Selection" /></td>
<td>Add to Selection</td>
<td></td>
<td>Adds the item to the ACE selection set (as shown in the Selection View (see page 136)).</td>
</tr>
<tr>
<td><img src="image" alt="Remove from Selection" /></td>
<td>Remove from Selection</td>
<td></td>
<td>Removes the item from the ACE selection set (as shown in the Selection View (see page 136)).</td>
</tr>
<tr>
<td><img src="image" alt="Highlight" /></td>
<td>Highlight</td>
<td></td>
<td>Applies the currently active highlight color to the chosen item (see Highlighting Objects in the Floorplanner View (see page 323)).</td>
</tr>
<tr>
<td><img src="image" alt="Choose Highlight Color" /></td>
<td>Choose Highlight Color</td>
<td></td>
<td>Determines which color is applied the next time the Highlight action is selected.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom To" /></td>
<td>Zoom To</td>
<td></td>
<td>Zooms the Floorplanner view to a region containing the item.</td>
</tr>
<tr>
<td><img src="image" alt="Show in Netlist" /></td>
<td>Show in Netlist (1)</td>
<td></td>
<td>Attempts to open a text editor to the file and line number relevant to the chosen item (available only when a single item is chosen in the view).</td>
</tr>
<tr>
<td><img src="image" alt="Display Properties" /></td>
<td>Display Properties</td>
<td></td>
<td>Display properties for the chosen item in the Properties view.</td>
</tr>
</tbody>
</table>

**Table Notes**

1. **Caution**: The Show in Netlist feature is Early Access functionality and might not always open the text editor to the expected location.

**Note**

Reminder: Instances Selection color vs Highlight color priority
With default preference settings, in the Floorplanner View (see page 57), highlight colors of (placed) instances are only visible when the Instances Layer is enabled, and the instances are not members of the ACE selection set. This behavior is due to the instance selection color having a higher priority than the highlight color.

Properties Navigation

- Move from one item to another by using the Display Properties right-click menu items in the Pins tab.
- Use Display Properties to move between related pins, nets, and instances.

Diagram Tab

Some items are complicated or interesting enough to warrant a supplemental diagram. For these types of items, a diagram showing the current item configuration can be found on the Diagram tab. Tooltips over the diagram can provide supplemental information where useful.

![Diagram Tab Example](image)

**Figure 51: Diagram Tab Example**

Save Properties

The Save Properties action can be used to save all changed properties on objects in the database after prepare has been run. See the `save_properties` Tcl command reference for details.

This action can be performed by clicking Save Properties on the Properties view tool bar:

![Save Properties Example](image)

**Figure 52: Save Properties Example**

Register Browser View

The Register Browser view can be used to read/write values from/to actual hardware using the (e)FPGA JTAG interface with Tcl commands (see the JTAG Configuration User Guide (UG004) for details about the available Tcl commands). The view is typically used for very targeted interactions with a connected FPGA. This tool is not designed for efficient bulk reads of block RAM.
JTAG Connection Requirement

To use the Register Browser view, a valid JTAG connection is required. See Configuring the JTAG Connection (see page 339) and the Configure JTAG Connection Preference Page (see page 187).

Be aware that not all Achronix devices support Register Browser functionality. If the target device for the active implementation does not support this functionality, the view is not interactive.

Values can be read from or written to hardware by right-clicking any row in the table and choosing Read Values From Chip or Write Values To Chip in the popup context menu. All child rows are read from or written to as well.

The Register Browser interacts with the FPGA at the register level with all reads and writes happening at that level. When writing register field values to hardware, the entire register value is updated via a read-modify-write operation, combining the current hardware register value with the updated register field values.

![Figure 53: Register Browser View Example](image)

When the view first appears, even if a compatible device is connected and running, no current register values are pre-populated in the table. Values are only read from the device when commanded to do so. Drill down to just the specific register values needed to query. Be aware that the more rows read or written at a time, the longer it takes. Be careful not to read or write more than is needed.

The tree of register namespaces is organized hierarchically by memory addresses and by conceptual relationships. Fields which are read-only have their entire row colored with a blue background.

Fields with a green background in the Update Value column are writable but have not been given a value to be written. Click in any of these cells to enter a hexadecimal value to be written to that field. Invalid values or values that are too large for the given register field are rejected automatically.
When any field within a register has its **Update Value** populated, the background of the field being edited plus those of all other fields within that same register turn yellow, indicating a write is pending but has not yet been committed. The **Update Value** column shows a register value combining the current hardware value of the register (as of the last time one of the fields of that register was edited) combined with any register field values just entered. Put another way, the current register value is read from hardware, and then any values in the yellow register fields for that register are applied to it.

When using **Write Values To Chip**, the current register value at that time is read into ACE, any register field values entered are applied to it, and the updated register value is written back to the device. The **Last Value** column is updated for the register and all fields within that register. All register writes are always performed as a read-modify-write, including when all fields within the register are being edited.

**Search View**

The Search view provides an interface for searching the ACE design database for design objects (instances, nets, ports, pins, sites, and paths), displaying the results of a search in a list, organized by object type. Optionally, all or part of the results of a search can be added to the current ACE Selection Set, as displayed in the **Selection view** (see page 136). The Search View is a graphical interface to the `find` Tcl command.

Instances and Ports in the results list may be dragged and dropped onto the **Floorplanner View** (see page 57) to assign placement or add **placement region** (see page 371) constraints (the behavior depends upon the Floorplanner active tool /mode). Instances and Paths in the results list may be dragged to the **Placement Regions View** (see page 118) to add placement region constraints.

By default, the Search view is included in the **Floorplanner perspective** (see page 24). To add it to the current perspective, select **Window → Show View... → Search**.

See also: **Object Type Prefixes** (see page 313)

---

**Note**

A maximum of 200 objects are displayed in the Search view at a time. Use the arrow buttons (← and →) on the view toolbar to page through the full set of search results.
**Figure 54: Search View Example**

**Table 74: Search View Icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Object" /></td>
<td>Object (unplaced instances and ports; all pins, nets, and paths).</td>
</tr>
<tr>
<td><img src="image" alt="Placed Object" /></td>
<td>Placed Object (applies to instances and ports).</td>
</tr>
<tr>
<td><img src="image" alt="Fixed-Placed Object" /></td>
<td>Fixed-Placed Object (applies to instances and ports).</td>
</tr>
<tr>
<td><img src="image" alt="I/O Macro" /></td>
<td>I/O Macro (applies to ports).</td>
</tr>
<tr>
<td><img src="image" alt="Instances" /></td>
<td>Instances (all instances are under this branch of the search results).</td>
</tr>
<tr>
<td><img src="image" alt="Ports" /></td>
<td>Ports (all ports are under this branch of the search results).</td>
</tr>
<tr>
<td><img src="image" alt="Pins" /></td>
<td>Pins (all pins are under this branch of the search results).</td>
</tr>
<tr>
<td><img src="image" alt="Nets" /></td>
<td>Nets (all nets are under this branch of the search results).</td>
</tr>
<tr>
<td><img src="image" alt="Paths" /></td>
<td>Paths (all paths are under this branch of the search results).</td>
</tr>
<tr>
<td><img src="image" alt="Sites" /></td>
<td>Sites (All sites are under this branch of the search results).</td>
</tr>
</tbody>
</table>
Many of the actions in the Selection view are available as both toolbar buttons and right-click context menu choices. Toolbar buttons typically act upon all the listed Search results items, while context menu actions only affect the subset of items currently chosen within the Results list.

**Table 75: Search View Actions**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Toolbar Button</th>
<th>Context Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Find objects" /></td>
<td>Find objects</td>
<td>Y</td>
<td></td>
<td>Searches for objects in the ACE design database using the search criteria from the Search view.</td>
</tr>
<tr>
<td><img src="image" alt="Display next 200 results" /></td>
<td>Display next 200 results</td>
<td>Y</td>
<td></td>
<td>Displays the next 200 objects in the search results list.</td>
</tr>
<tr>
<td><img src="image" alt="Display previous 200 results" /></td>
<td>Display previous 200 results</td>
<td>Y</td>
<td></td>
<td>Displays the previous 200 objects in the search results list.</td>
</tr>
<tr>
<td><img src="image" alt="Add to selection" /></td>
<td>Add to selection</td>
<td>Y</td>
<td>Y</td>
<td>Adds all objects that are currently chosen in the Search view &quot;Results&quot; list to the current selection set (as displayed in the Selection View).</td>
</tr>
<tr>
<td><img src="image" alt="Remove from selection" /></td>
<td>Remove from selection</td>
<td></td>
<td>Y</td>
<td>Removes all objects that are currently chosen in the Search view &quot;Results&quot; list from the current selection set (as displayed in the Selection View).</td>
</tr>
<tr>
<td><img src="image" alt="Un-highlight Results" /></td>
<td>Un-highlight Results (1)</td>
<td>Y</td>
<td>Y</td>
<td>Turns off the highlight color for objects.</td>
</tr>
<tr>
<td><img src="image" alt="Highlight Results" /></td>
<td>Highlight Results</td>
<td>Y</td>
<td>Y</td>
<td>Highlights objects with the currently-selected search highlight color. The highlighted results are visible in the Floorplanner View (other views are not affected by highlights).</td>
</tr>
<tr>
<td><img src="image" alt="Choose Highlight Color" /></td>
<td>Choose Highlight Color</td>
<td>Y</td>
<td></td>
<td>Allows changing the current highlight color for search result highlighting. This color is used in the Floorplanner View when the Search view (Highlight Results) button is clicked.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom To Object" /></td>
<td>Zoom To Object</td>
<td>Y</td>
<td></td>
<td>Zooms the Floorplanner view to a region containing the item currently chosen in the results list.</td>
</tr>
<tr>
<td><img src="image" alt="Show in Netlist" /></td>
<td>Show in Netlist (2)</td>
<td>Y</td>
<td></td>
<td>If relevant data exists, opens a text editor to the file and line number relevant to the chosen result item (available only when a single item is chosen in the results list, and that item is an Instance or Net).</td>
</tr>
<tr>
<td><img src="image" alt="Fix Placement of Instance" /></td>
<td>Fix Placement of Instance</td>
<td>Y</td>
<td></td>
<td>Causes the placement state of the chosen Instance to change from unfixed (or soft) to Fixed.</td>
</tr>
<tr>
<td><img src="image" alt="Unfix Placement of Instance" /></td>
<td>Unfix Placement of Instance</td>
<td>Y</td>
<td></td>
<td>Causes the placement state of the chosen Instance to change from Fixed to unfixed (soft).</td>
</tr>
</tbody>
</table>
Table 76: Search View Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patterns</td>
<td>Enter a Tcl regular-expression pattern which is used to perform a name-based search. Previously used search patterns may be selected from the drop-down menu.</td>
</tr>
<tr>
<td>Filters</td>
<td>Enter a search filter to further restrict the search results by properties other than name. Previously used search filters may be selected from the drop-down menu. See Filter Properties (see page 246).</td>
</tr>
<tr>
<td>... (Search Filter Builder)</td>
<td>This button opens the Search Filter Builder Dialog (see page 183) providing a guide through the options available for search filters.</td>
</tr>
<tr>
<td>Instances (1)</td>
<td>When checked, includes Instances in the search results.</td>
</tr>
<tr>
<td>Ports (1)</td>
<td>When checked, includes Ports in the search results.</td>
</tr>
<tr>
<td>Pins (1)</td>
<td>When checked, includes Pins in the search results.</td>
</tr>
<tr>
<td>Nets (1)</td>
<td>When checked, includes Nets in the search results.</td>
</tr>
<tr>
<td>Paths (1)</td>
<td>When checked, includes Paths in the search results.</td>
</tr>
<tr>
<td>Sites (1)</td>
<td>When checked, includes Sites in the search results.</td>
</tr>
<tr>
<td>Add Results to Selection</td>
<td>If selected when a search is performed, all the results of that search are added to the ACE selection set.</td>
</tr>
</tbody>
</table>
ACE User Guide (UG070)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Notes</td>
<td>1. Caution: If none of the object-type option checkboxes are checked, the search is performed as if all types were checked.</td>
</tr>
</tbody>
</table>

**Search Results and ACE Selection**

The complete results of a search may be added to the current ACE Selection Set (and thus rendered in a special color, by default a bright green, in the Floorplanner View) by checking the **Add Results to Selection** checkbox before starting the search. A subset of the search results may be added to the current ACE selection set by selecting the desired additions in the search "Results" list and pressing the (  ) **Add to Selection** button, or, double-clicking a single entry in the "Results" list adds it to the current selection.

**Search Highlights**

There is typically a tremendous amount of visualization data available in the Floorplanner view. The granular highlighting allowed by the Search view, the Selection view, and the Highlight functionality (see Highlighting Objects in the Floorplanner View (see page 323)) is an attempt to help turn this data into useful information, to find and focus on specific information within the user designs.

By highlighting multiple search result sets in the same or different colors, desired information is made more visible in the graphical views. By selectively un-highlighting or re-highlighting smaller (more specific) result sets (which are a subset of already-highlighted objects), focus may be directed to just the objects of interest.

When used in combination with the layering functionality (see the Layers portion of the toolbox for the Floorplanner view) and Selection functionality (see the Selection view (see page 136) as well as the select and deselect Tcl commands), a graphical visualization can be achieved at whatever granularity is desired.

⚠️ **Caution!**

The Selection color takes precedence over the Highlight color by default. If design objects are both highlighted and selected, they are painted the selection color (bright green by default) in the Floorplanner view. To see the design objects painted in the Highlight color (with default precedence settings), the objects must first be removed from the current Selection set (as shown in the Selection view). The Floorplanner view settings (including precedence) for Highlight and Selection colors can be manipulated on the Floorplanner View Colors and Layers Preference Page (see page 191).

**Selection View**

The Selection view provides an interface that allows viewing and managing the current selection set. A selection set consists of a collection of ACE design database objects. The selection set may also be manipulated with the select and deselect Tcl commands.

The Selection view displays the current selection set in a list, organized by object type. The object type groupings are Instances, Ports, Pins, Nets, Paths, and Sites; these are the only object types which may be Selected.
Note

A maximum of 200 objects are displayed in the Selection view at a time. Use the arrow buttons (← and →) on the view toolbar to page through the full content of the ACE selection set.

The (current page of) selected objects in the Selection view is also displayed with special coloration (by default a bright green) in the Floorplanner view (see page 57).

Objects may be added to the selection set from the Search view (see page 132) (if Add Results to Selection is checked when a search is issued, or by choosing individual objects from the search results and selecting Add to Selection), or from the Floorplanner view (see Selecting Floorplanner Objects (see page 321)).

Various drag-and-drop operations may be initiated by dragging single or (in some cases) multiple items from the selection list to other views in the Floorplanner perspective. If dragging all selected objects of a given type (i.e., Instances), including those not in the current page of 200 selected objects, the node with that type name (i.e., Instances) may be dragged. (Be aware that some drag-and-drop operations, such as pre-placement assignment, does not work with multiple, simultaneously selected objects.)

Instances and Ports in the selection list may be dragged and dropped onto the Floorplanner view to assign pre-placement or add placement region (see page 371) constraints (the behavior depends upon the active Floorplanner tool or mode). Instances and Paths in the results list may be dragged to the Placement Regions view (see page 118) to add placement region constraints.

By default, the Selection view is included in the Floorplanner perspective (see page 24). To add it to the current perspective, select Window → Show View... → Other... → Selection.

![Figure 55: Selection View Example](image)
### Table 77: Selection View Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Object" /></td>
<td>Object.</td>
</tr>
<tr>
<td><img src="image" alt="Placed Object" /></td>
<td>Placed Object (applies to instances and ports).</td>
</tr>
<tr>
<td><img src="image" alt="Fixed-Placed Object" /></td>
<td>Fixed-Placed Object (applies to instances and ports).</td>
</tr>
<tr>
<td><img src="image" alt="I/O Macro" /></td>
<td>I/O Macro (applies to ports).</td>
</tr>
<tr>
<td><img src="image" alt="Instances" /></td>
<td>Instances (all instances are under this branch of the selection).</td>
</tr>
<tr>
<td><img src="image" alt="Ports" /></td>
<td>Ports (all ports are under this branch of the selection).</td>
</tr>
<tr>
<td><img src="image" alt="Pins" /></td>
<td>Pins (all pins are under this branch of the selection).</td>
</tr>
<tr>
<td><img src="image" alt="Nets" /></td>
<td>Nets (all nets are under this branch of the selection).</td>
</tr>
<tr>
<td><img src="image" alt="Paths" /></td>
<td>Paths (all paths are under this branch of the selection).</td>
</tr>
<tr>
<td><img src="image" alt="Sites" /></td>
<td>Sites (all sites are under this branch of the selection).</td>
</tr>
</tbody>
</table>

Many of the actions available in the Selection view are available as both toolbar buttons and right-click context menu choices. Toolbar buttons act upon all the listed Selection items, while context menu actions only affect the subset of items currently chosen within the Selection list. Be aware that available right-click context menu choices vary depending upon the context: the number and the type of the items alter the available actions.

### Table 78: Selection View Actions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Toolbar Button</th>
<th>Context Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Zoom to Full Selection Set" /></td>
<td>Zoom to Full Selection Set</td>
<td>Y</td>
<td></td>
<td>Zooms the Floorplanner view to a region containing the current list of chosen objects in the Selection view.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom to Object" /></td>
<td>Zoom to Object</td>
<td></td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Display next 200 objects" /></td>
<td>Display next 200 objects</td>
<td>Y</td>
<td></td>
<td>Displays the next 200 objects in the selection set.</td>
</tr>
<tr>
<td><img src="image" alt="Display Previous 200 objects" /></td>
<td>Display Previous 200 objects</td>
<td>Y</td>
<td></td>
<td>Displays the previous 200 objects in the selection set.</td>
</tr>
<tr>
<td><img src="image" alt="Deselect object" /></td>
<td>Deselect object</td>
<td>Y</td>
<td>Y</td>
<td>Deselects objects in the Selection view list, removing them from the current selection set in ACE.</td>
</tr>
</tbody>
</table>
### Icon | Action | Toolbar Button | Context Menu | Description
--- | --- | --- | --- | ---
Deselect all objects | | Y | | Deselects all objects in the current selection set in ACE, resulting in an empty selection set.
Un-Highlight Selection (1) | | Y | | Turns off the highlight color for objects in the current selection.
Highlight Selection | | Y | | Sets the highlight color for objects in the current ACE selection set to the currently-chosen highlight color (the highlight coloring is only visible in the Floorplanner view after the objects are no longer Selected, since the Selection color overrides the highlight color.
Choose Highlight Color | | Y | | Allows changing the current ACE selection set highlight color (which is different from and overridden by the Selection color). This color is used in the Floorplanner view when the ( ) Highlight Selection action is chosen in the Selection view.
Show in Netlist (2) | | Y | | If relevant data exists, opens a text editor to the file and line number relevant to the chosen Selection item (available only when a single item is chosen in the Selection list, and that item is an Instance or Net).
Fix Instance Placement | | Y | | Causes the placement state of the Instance under the mouse cursor to change from unfixed (or soft) to Fixed.
Unfix Instance Placement | | Y | | Causes the placement state of the Instance under the mouse cursor to change from Fixed to unfixed (or soft).
Unplace Instance(s) | | Y | | Unplaces the Instances chosen in the view.
Unplace All Instances in ACE Selection Set | | Y | | Unplaces all Instances that are members of the current ACE selection set.
Save Placement of Selection Set | | Y | | Opens the Save Placement Dialog (see page 179), pre-populating its Specific List of Instances field with the query to obtain the active Selection Set.

**Table Notes**
1. Stops highlighting the ACE selection set in the Floorplanner view. Other views are not affected by highlighting.
2. The Show in Netlist action is Early Access functionality and may not always open the text editor to the expected location.

For more information about the interaction between Selection and Highlighting, please see Search Highlights (see page 136) as well as Highlighting Objects in the Floorplanner View (see page 323).

See also: Object Type Prefixes (see page 313).

### Snapshot Debugger View

The Snapshot Debugger view provides a graphical interface for controlling an embedded Snapshot IP block in a programmed Achronix device. By default, the Snapshot Debugger view is included in the Programming and Debug Perspective (see page 24). To access the Snapshot Debugger view from any other perspective, select **Window → Show View → Other... → Achronix → Snapshot Debugger**.

This view allows running the Snapshot Debugger (see page 344) embedded in the design. A simple button press collects Live Sample Data (see page 355) in a VCD file. This view also allows Configuring the Debug Capture Trigger Pattern(s) (see page 347), Configuring a Test Stimulus (see page 351), and Configuring the Data Capture Ranges (see page 353) before and after the trigger(s).
For convenience, favorite Snapshot configurations can be saved (see page 364) and loaded (see page 364) via the view toolbar buttons. Saved configurations may also be used to drive the Snapshot in Batch Mode (see page 365) via Tcl.

When a user design containing the `ACX_SNAPSHOT` macro completes the Flow Step (see page 223) `Run Prepare`, a `names.snapshot` configuration file, is automatically generated. This file contains harvested information from the design including the widths, depths and signal names for the monitor, trigger, and stimulus busses, user clock frequency, and default log and `.vcd` file path settings. When an Active Project and Implementation (see page 223) is available, the Snapshot View automatically loads the `names.snapshot` file to pre-populate the relevant fields of the view.

### Note

When the `names.snapshot` file is generated, the file contains only a subset of a complete Snapshot configuration, and thus a generated `names.snapshot` file should not be used to drive Snapshot in Batch Mode (see page 365) via Tcl.

See also: Running the Snapshot Debugger (see page 344), Assign Bussed Values Dialog (see page 151), Assign Bussed Signal Names Dialog (see page 149), VCD Waveform Editor (see page 29), and the Snapshot User Guide (UG016).

### Table 79: Snapshot Debugger View Toolbar Buttons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Arm Snapshot Icon](icon-arm-snapshot.png) | Arm Snapshot | Performs the following steps:  
1. Sends the trigger conditions configuration to the Snapshot Debugger core.  
2. Send the Stimulus value to the Design-Under-Test.  
3. Waits for the trigger condition to be met.  
4. Retrieves the trace buffer contents.  
5. Outputs a VCD file. |
| ![Cancel Snapshot Icon](icon-cancel-snapshot.png) | Cancel Snapshot | Cancels the Snapshot Arm by stopping the polling process and then resetting the `ACX_SNAPSHOT` macro. |
| ![Save Snapshot Configuration Icon](icon-save-snapshot-config.png) | Save Snapshot Configuration | Saves the current settings of the Snapshot view to a text file.  
See Saving/Loading Snapshot Configurations (see page 364). |
| ![Load Snapshot Configuration Icon](icon-load-snapshot-config.png) | Load Snapshot Configuration | Loads a previously saved configuration file.  
See Saving/Loading Snapshot Configurations (see page 364). |
| ![Capture Snapshot Startup Trigger Icon](icon-capture-snapshot-startup-trigger.png) | Capture Snapshot Startup Trigger | Requires that the initial startup trigger parameters on the `ACX_SNAPSHOT` macro have been configured to enable the Startup Trigger feature, and that the Arm Snapshot action has not been executed since the bitstream has been programmed.  
Performs the following steps:  
1. Waits for the startup trigger condition to be met.  
2. Retrieves the trace buffer contents.  
3. Outputs a VCD file. |
| ![Configure JTAG Interface Icon](icon-configure-jtag-interface.png) | Configure JTAG Interface | Opens the preferences dialog with the Configure JTAG Connection Preference Page (see page 187) visible.  
See Configuring the JTAG Connection (see page 339). |
1. Figure 56: Snapshot Debugger View Example

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Trigger Conditions</strong></td>
<td></td>
</tr>
<tr>
<td>Trigger Mode</td>
<td>Allows selecting the trigger mode to use when the Arm Snapshot action is run.</td>
</tr>
<tr>
<td>Trigger Conditions</td>
<td>The default trigger mode is Single:</td>
</tr>
<tr>
<td>1. The trigger conditions are</td>
<td>1. The trigger conditions are programmed into the ACX_SNAPSHOT macro.</td>
</tr>
<tr>
<td>programmed into the ACX_SNAPSHOT macro.</td>
<td></td>
</tr>
<tr>
<td>2. The GUI waits for a single trigger event to occur which matches those trigger conditions.</td>
<td></td>
</tr>
<tr>
<td>3. A single VCD file is recorded.</td>
<td></td>
</tr>
<tr>
<td>Immediate trigger mode is selected, pressing the Arm button results in the same behavior as Single trigger mode, except that all 3 trigger patterns are treated as &quot;Don't Care&quot; (X) so that the trigger event occurs as soon as the Arm button is pressed.</td>
<td></td>
</tr>
<tr>
<td>Repetitive trigger mode is selected:</td>
<td></td>
</tr>
<tr>
<td>1. The trigger conditions are programmed into the ACX_SNAPSHOT macro.</td>
<td></td>
</tr>
<tr>
<td>2. Samples are captured repetitively until the upper limit of trigger event records is reached.</td>
<td></td>
</tr>
<tr>
<td>When Repetitive trigger mode is selected, an additional set of repetitive trigger mode options appear allowing the configuration of:</td>
<td></td>
</tr>
<tr>
<td>2. The way in which the output VCD files are managed.</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Number of Sequential Triggers** | Allows selecting the use of either 1, 2, or 3 sequential triggers:  
• 1 – Trigger 2 and Trigger 3 are ignored during the match  
• 2 – Trigger 3 is ignored during the match and Snapshot triggers when Trigger 1 is matched, followed on any subsequent clock by a match on Trigger 2  
• 3 – snapshot triggers after a match on Trigger 1, followed by Trigger 2, followed by Trigger 3  
See Configuring the Trigger Pattern (see page 347), Configuring Test Stimulus (see page 351), and Configuring the Monitor Signals (see page 350). |
| **Trigger Channel Width**     | The Snapshot debugger module can be configured to trigger channel widths of 1 to 40 channels. The Trigger Channel Width must be set to the value that corresponds with the configured Snapshot RTL instantiation. The trigger width is automatically extracted from the user design and saved in the generated names.snapshot file, which can be loaded and edited. |
| **Channel**                  | The trigger channel number connected to the Snapshot Debugger core.                                                                            |
| **Trigger 1**                | Sets the Trigger 1 value for each channel. Valid options are:  
• X – don’t care  
• R – rising edge  
• F – falling edge  
• 0 – level 0  
• 1 – level 1  
See Configuring the Trigger Pattern (see page 347). |
| **Trigger 2**                | Sets the trigger 2 value for each channel. Valid options are:  
• X – don’t care  
• R – rising edge  
• F – falling edge  
• 0 – level 0  
• 1 – level 1  
This column is only editable if 2 or 3 triggers are selected.  
See Configuring the Trigger Pattern (see page 347). |
| **Trigger 3**                | Sets the trigger 3 value for each channel. Valid options are:  
• X – don’t care  
• R – rising edge  
• F – falling edge  
• 0 – level 0  
• 1 – level 1  
This column is only editable if 3 triggers are selected.  
See Configuring the Trigger Pattern (see page 347). |
| **Signal Name**              | Sets the user-defined name for the trigger channel. This signal name is automatically extracted from the user design and saved in the generated names.snapshot file, which can be loaded and edited. |
| **Load Signal Names From Active Project** | When clicked, loads the names.snapshot file generated during design preparation (the Run Prepare flow step), which renames all signals with their project-specific names and loads other harvested project-specific settings. |
| **Reset Signal Names**       | When clicked, renames all signals back to their default names, which is “signal” with a suffix corresponding to the channel number. |
| **Repetitive Trigger Settings** |                                                                                                                                              |
| **Record Limit**             | The repetitive trigger Record Limit setting determines how many times (number of records) the GUI repeatedly Arms the Snapshot debugger and captures samples. This may be set to automatically run Snapshot up to 128 times. |
1. **VCD Record Limit**
   - Determines how many repetitively triggered Snapshot records to capture in a single VCD file. Essentially concatenates the VCD files from consecutive runs of Snapshot (records) into a single VCD file. The VCD file waveform contains a set of virtual signals to indicate the system timestamp at which each Snapshot record was captured. Up to 10 Snapshot records may be concatenated in a single VCD file.

2. **Overwrite VCD File**
   - When selected, the VCD Waveform File name specified in the Advanced Options section is used to store the output VCD file. The file is overwritten with the new VCD file each time the VCD record limit is reached. If not selected, multiple VCD files are written out and a unique VCD record number is added to the VCD Waveform File name specified in the Advanced Options section for each VCD.
   - For example, if the Record Limit is set to 8, the VCD Record Limit is set to 2, and the VCD Waveform file path set to ".
   - 8
   - 2
   - ./snapshot.vcd", Snapshot outputs 4 VCD files:
   1. "./snapshot1.vcd"
   2. "./snapshot2.vcd"
   3. "./snapshot3.vcd"
   4. "./snapshot4.vcd"
   - Each file contains 2 Snapshot capture records.

### Monitor Channels

1. **Monitor Channel Width**
   - The Snapshot debugger module can be configured to monitor channel widths of 1 to 4087 channels. The Monitor Channel Width must be set to the value that corresponds with the parameterized Snapshot RTL instantiation. The monitor width is automatically extracted from the user design and saved in the generated `names.snapshot` file, which can be loaded and edited.

2. **Number of Samples**
   - The Snapshot debugger module can be configured to capture between 512 and 16384 samples. The Number of Samples must be set to the value that corresponds with the parameterized Snapshot RTL instantiation. The number of samples is automatically extracted from the user design and saved in the generated `names.snapshot` file, which can be loaded and edited.

3. **Channel**
   - The monitor channel number connected to the Snapshot Debugger core.

4. **Signal Name**
   - Sets the user-defined name for the monitor channel. This signal name is automatically extracted from the user design and saved in the generated `names.snapshot` file, which can be loaded and edited. This signal name is used in the VCD file waveform output.

5. **Load Signal Names From Active Project**
   - When clicked, loads the `names.snapshot` file generated during design preparation (the Run Prepare flow step), which renames all signals with their project-specific names and loads other harvested project-specific settings.

6. **Reset Signal Names**
   - When clicked, renames all signals back to their default names, which are "signal" with a suffix corresponding to the channel number.

### Stimuli

1. **Stimuli Channel Width**
   - The Snapshot debugger module can be configured to stimuli channel widths of 0 (no stimuli) to 512 channels. The Stimuli Channel Width must be set to the value that corresponds with the parameterized Snapshot RTL instantiation. The stimuli width is automatically extracted from the user design and saved in the generated `names.snapshot` file, which can be loaded and edited.

2. **Channel**
   - The stimuli channel number connected to the Snapshot Debugger core.

3. **Value**
   - The value to drive out on this stimuli channel ARM_DELAY cycles before Snapshot is Armed (when the Arm button is pressed).

4. **Signal Name**
   - Sets the user-defined name for the stimuli channel. This signal name is automatically extracted from the user design and saved in the generated `names.snapshot` file, which can be loaded and edited.

### Advanced Options

1. **Pre-Store**
   - Controls the ratio of samples collected before and after the trigger. See Configuring Advanced Options (see page 353).
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger 1 Select</td>
<td>When set to <strong>Select Using AND</strong>, Snapshot ANDs the values within the active Trigger to determine a match. This setting indicates that <strong>ALL</strong> signal values not masked must match the specified pattern in order to generate a trigger match event. When set to <strong>Select Using OR</strong>, Snapshot ORs the values within the active Trigger to determine a match. This setting indicates the trigger match event is generated if <strong>ANY</strong> of the non-masked signal values match the specified pattern. See Configuring the Trigger Pattern (see page 347).</td>
</tr>
<tr>
<td>Trigger 2 Select</td>
<td>When set to <strong>Select Using AND</strong>, Snapshot ANDs the values within the active Trigger to determine a match. This setting indicates that <strong>ALL</strong> signal values not masked must match the specified pattern in order to generate a trigger match event. When set to <strong>Select Using OR</strong>, Snapshot ORs the values within the active Trigger to determine a match. This setting indicates the trigger match event is generated if <strong>ANY</strong> of the non-masked signal values match the specified pattern. See Configuring the Trigger Pattern (see page 347).</td>
</tr>
<tr>
<td>Trigger 3 Select</td>
<td>When set to <strong>Select Using AND</strong>, Snapshot ANDs the values within the active Trigger to determine a match. This setting indicates that <strong>ALL</strong> signal values not masked must match the specified pattern in order to generate a trigger match event. When set to <strong>Select Using OR</strong>, Snapshot ORs the values within the active Trigger to determine a match. This setting indicates the trigger match event is generated if <strong>ANY</strong> of the non-masked signal values match the specified pattern. See Configuring the Trigger Pattern (see page 347).</td>
</tr>
<tr>
<td>Frequency (MHz)</td>
<td>Must be configured to match the <code>user_clk</code> timing constraint set in the SDC file of the design being debugged. This is automatically set according to the values captured in the <code>names.snapshot</code> file when an active implementation is available. See Configuring Advanced Options (see page 353).</td>
</tr>
<tr>
<td>File Paths Relative To</td>
<td>Chooses whether the <strong>Log File</strong> and <strong>Waveform File</strong> paths are understood to be relative to the <strong>Active Project</strong> directory or to the <strong>Working Directory</strong> (only matters when the file paths provided are relative paths, not absolute paths).</td>
</tr>
<tr>
<td>Log File</td>
<td>File name for the Snapshot log file, where raw Snapshot output (including warning and error messages) is logged. The default file name can be overwritten, and the accompanying <strong>Browse</strong> button may be used to graphically navigate to the desired directory or file. See Configuring Advanced Options (see page 353).</td>
</tr>
<tr>
<td>Waveform File</td>
<td>File name for the Snapshot VCD waveform output file, where the Snapshot sampled values (the trace buffer) is stored. The default file name can be overwritten, and the accompanying <strong>Browse</strong> button may be used to graphically navigate to the desired directory or file. See Configuring Advanced Options (see page 353).</td>
</tr>
<tr>
<td>Startup Trigger</td>
<td>This is the same as the ( ) <strong>Capture Snapshot Startup Trigger</strong> button in the view toolbar. See Collecting Samples of the User Design (see page 355).</td>
</tr>
<tr>
<td>Arm</td>
<td>This is the same as the ( ) <strong>Arm Snapshot</strong> button in the view toolbar. See Collecting Samples of the User Design (see page 355).</td>
</tr>
<tr>
<td>Cancel</td>
<td>This is the same as the ( ) <strong>Cancel Snapshot</strong> button in the view toolbar. See Collecting Samples of the User Design (see page 355).</td>
</tr>
</tbody>
</table>

**Tcl Console View**

The Tcl Console view provides an interactive Tcl console for ACE. All user interactions that change design and project data go through the Tcl command interface, including all commands executed while in the GUI. From here, executed commands and their information are displayed, including any warning and error messages. This console can also be used interactively by typing Tcl commands directly into the console to manipulate projects or the current design.
Valid ACE commands are highlighted in bold green. Informational messages are displayed in italic blue text. Warning messages are displayed in italic yellow text, and error messages are displayed in italic red text.

When the cursor is at the `cmd>` prompt, pressing the up arrow on the keyboard (↑) will move backward through the history of recently-issued commands to allow editing and re-issuing any prior command.

When typing in a command or filepath at the `cmd>` prompt, pressing the **TAB** key opens a dynamic content-assist list showing auto-completion candidates as well as command help text (if there are no valid choices available to complete the typing when TAB is pressed, a beep error tone sounds and no content-assist list appears). Pressing the up or down arrows on the keyboard moves through entries in the content-assist list, and pressing **Enter** chooses the selected entry in the list. Entries in the list may also be clicked with the mouse.

By default, the Tcl Console view is included in all Perspectives (see page 24). If it is not presently visible, to add it to the current perspective, select **Window → Show View → Tcl Console**.

For more details, see Using the Tcl Console (see page 310), check the available preferences on the Tcl Console View Preference Page (see page 213), and see the available commands in the Tcl Command Reference (see page 526).

![Tcl Console View Example](image)

**Figure 57: Tcl Console View Example**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Send command" /></td>
<td>Send command</td>
<td>Sends the current Tcl command at the console prompt. Alternatively, press <strong>ENTER</strong> on the keyboard to send the current command.</td>
</tr>
<tr>
<td><img src="image" alt="Clear console" /></td>
<td>Clear console</td>
<td>Clears the text in the console up to the current prompt line.</td>
</tr>
<tr>
<td><img src="image" alt="Display log file" /></td>
<td>Display log file</td>
<td>Opens the ACE log file for the current session in the Editor Area.</td>
</tr>
</tbody>
</table>
Warning!

When Tcl command return values are displayed in the Tcl Console, any long returned values are visually truncated at 500 characters in the console. The actual returned value is not edited, just the textual representation shown in the console. Thus, scripts using long return values still behave properly.

Dialogs

Several dialogs are used within ACE. These dialogs are typically shown in response to specific menu choices or button clicks.

Add Signals to Waveform Viewer Dialog

The Add Signals to Waveform Viewer Dialog appears when the Add... button is clicked in the VCD Waveform Editor (see page 29) editor.

This dialog allows:

1. Making signals visible which were previously hidden by clicking the Remove button in the VCD Waveform editor.
2. Adding duplicates of already-shown signals to the table and waveform.

Signals selected in the Add Signals to Waveform Viewer Dialog may be inserted after the first row currently selected in the VCD signal table, or at the top of the table if no rows are selected. The selected signals are added or inserted using the Append and Insert buttons. The Move Up and Move Down buttons on the VCD Waveform editor may be used to move the selected signals from wherever they are initially inserted or appended.

![Add Signals to Waveform Viewer Dialog Example](image)
The majority of the dialog is taken up by an area listing the signals. The listed signals vary depending upon the radio-button currently selected in the dialog.

### Table 82: Add Signals to Waveform Viewer Dialog Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select from All Signals</td>
<td>When selected, causes the list to be populated with all signals contained in the current VCD file.</td>
</tr>
<tr>
<td>Select from Hidden Signals</td>
<td>When selected, causes the list to be populated with all signals found in the VCD file which are currently hidden (signals removed from the VCD Waveform editor signal table are considered hidden). If no signals are currently hidden, the list of hidden signals is empty.</td>
</tr>
<tr>
<td>Append</td>
<td>Appends the currently-selected signal to the bottom of the VCD Waveform Editor signal table.</td>
</tr>
<tr>
<td>Insert</td>
<td>Inserts the signal currently selected in the dialog list below the signal currently selected in the VCD Waveform Editor signal table. If no signal was selected in the VCD Waveform Editor signal table when the Add... button was pressed to bring up this dialog, the signal selected in the dialog is inserted at the top of the VCD Waveform Editor signal table.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the dialog.</td>
</tr>
</tbody>
</table>

#### Note

- The **Append** and **Insert** buttons may each be clicked multiple times for a given signal, which adds the signal selected in the dialog list to the VCD Waveform Editor signal table multiple times.
- These buttons are disabled if no signal is currently selected in the dialog signal list.
- If either button is used to un-hide a previously-hidden signal, the signal is removed from the list of hidden signals since it is no longer considered hidden.

There are also some icons used by content displayed in the dialog signal list as shown below.

### Table 83: Add Signals to Waveform Viewer Dialog Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="signal_icon" alt="Signal Icon" /></td>
<td>Signal</td>
</tr>
<tr>
<td><img src="bus_icon" alt="Bus Icon" /></td>
<td>Bus</td>
</tr>
</tbody>
</table>

### Add Source Files Dialog

The Add Source Files dialog is used to browse for netlist (.v, .vm, and .vma), constraints (.sdc and .pdc), and IP Configuration (.acxip) **Source Files** (see page 219) to add to the selected Project (see page 217). After selecting the files to add, click **Open** (in Windows) or **OK** (in Linux) to add them to the project.
Figure 59: Add Source Files Dialog Example

Note
ACE loads source files in the same order they were added to the project. If ACE is loading files in an incorrect order:

1. Remove all source files from the project.
2. Add files, one at a time, to the project in the desired order.

When files with unrecognized file extensions are added to a project (possible when the "* . *") file filter is selected in the Add Source Files dialog), a second dialog appears requesting the categorization of the unknown file extensions.
The categorization dialog contains the list of unknown files on the left, with the allowed categories for each file on the right. Files may be moved into and out of the categories with the \textgreater\textgreater{} and \textless\textless{} buttons, respectively.

When all the files are categorized, click the \textit{Finish} button to add the files to the active ACE project, or click Cancel to add none of the files.

See also: \textit{Adding Source Files} (see page 275) and \textit{Adding Configuration Files to a Project} (see page 317).

\section*{Assign Bussed Signal Names Dialog}

The Assign Bussed Signal Names Dialog wizard allows the assigning multiple signal names from the SnapShot Debugger view (see page 139) "Monitor Channels", "Trigger Channels", or "Stimuli Channels" tables using bus notation. After configuring the bus in the dialog, the bus name and indices are propagated to all the selected signals, changing the signal names appropriately. Monitor channel signal names are then used in the SnapShot sampled output, visible in the VCD Waveform Editor (see page 29).

\begin{quote}
\textbf{Note}

This dialog is only useful when creating a Snapshot configuration from scratch. Typically, this dialog is not needed since ACE automatically outputs all the signal names from the user design into the names.snapshot file as part of the normal ACE Place and Route flow.
\end{quote}
**Figure 61: Assign Bussed Signal Names Dialog Example**

**Table 84: Assign Bussed Signal Names Dialog Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal Name</td>
<td>The desired name of the bus.</td>
</tr>
<tr>
<td>Width</td>
<td>The width (in bits) of the bus. This value is not editable. It reflects the number of signals which were selected from the table in the SnapShot Debugger View (see page 139).</td>
</tr>
<tr>
<td>Starting Index</td>
<td>The desired starting index of the bus, sometimes also called the offset into the bus.</td>
</tr>
<tr>
<td>Ascending Order</td>
<td>When selected, the bus indices start at <strong>Starting Index</strong> and increment <strong>Width</strong> times.</td>
</tr>
<tr>
<td>Descending Order</td>
<td>When selected, the bus indices start at <strong>Starting Index</strong> and decrement <strong>Width</strong> times.</td>
</tr>
<tr>
<td>Finish</td>
<td>Accepts the specified bus configuration, closes the dialog, and applies the changes to the SnapShot Debugger view (see page 139) table.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Discards the specified bus configuration and closes the dialog. No changes are applied to the SnapShot Debugger view (see page 139) table.</td>
</tr>
</tbody>
</table>
Assign Bussed Values Dialog

The Assign Bussed Values Dialog allows assigning a value to multiple signals from the SnapShot Debugger view (see page 139) "Trigger Channels" or "Stimuli Channels" tables as a bus. After configuring the bus in the dialog, the values of each signal are propagated to all the selected signals in the SnapShot Debugger View (see page 139). There are two ways to launch this dialog to allow bus assignment of values:

1. Click to select a single row in the SnapShot Debugger View (see page 139) table which has a bussed signal name (i.e., din[2]). Then, right click to edit the Value by Bus. This method automatically finds all other bits in the bus with the same signal name (e.g., din[0], din[1], din[2], etc.) and opens the dialog to allow editing of the entire bus of signals.

2. Hold CTRL or SHIFT and click to select multiple rows in the SnapShot Debugger View (see page 139) table. Then, right-click to edit the Value by Selection. This method opens the dialog to allow editing of all selected signals as a bussed value.

See also: Configuring the Trigger Pattern (see page 347).
**Assign Bussed Values Dialog Examples**

**Table 85: Assign Bussed Values Dialog Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary Value</td>
<td>The desired value for the bus in binary. Valid values for each bit for Trigger Channels are X (don't care), R (rising edge), F (falling edge), 1 (level 1), and 0 (level 0). Valid values for each bit for Stimuli Channels are 1 (level 1), and 0 (level 0). The right-most bit corresponds to bit 0 in the table of signal names, and the left-most bit corresponds to the MSb in the table.</td>
</tr>
<tr>
<td>Hex Value</td>
<td>The desired value for the bus in hexadecimal. This field is only capable of representing level (1 or 0) values for each channel. X (don't care), R (rising edge), and F (falling edge) binary values result in a &quot;?&quot; character in this field.</td>
</tr>
<tr>
<td>Decimal Value</td>
<td>The desired value for the bus in decimal. This field is only capable of representing level (1 or 0) values for each channel. X (don't care), R (rising edge), and F (falling edge) binary values result in a &quot;?&quot; character in this field.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bit</td>
<td>The bit offset into the bus value being edited.</td>
</tr>
<tr>
<td>Value</td>
<td>The bit value at the bit offset into the bus value being edited.</td>
</tr>
<tr>
<td>Signal Name</td>
<td>The signal name at the bit offset into the bus value being edited.</td>
</tr>
<tr>
<td>Finish</td>
<td>Accepts the specified bus configuration, closes the dialog, and applies the changes to the corresponding SnapShot Debugger view (see page 139) table.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Discards the specified bus configuration and closes the dialog. No changes are applied to the corresponding SnapShot Debugger view (see page 139) table.</td>
</tr>
</tbody>
</table>

Configure Clock Pre-Routes Dialog

The Configure Clock Pre-Routes Dialog appears after the Configure Clock Pre-Routes... action is selected from a context menu in the Clock Regions View (see page 39), Clusters View (see page 45), Partitions View (see page 115), or Placement Regions View (see page 118). This dialog allows the creation of new clock pre-route constraints.

![Configure Clock Pre-Routes Dialog Example](image.png)

*Figure 63: Configure Clock Pre-Routes Dialog Example*
Table 86: Configure Clock Pre-Routes Dialog

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clock Regions/Clusters/Partitions/Placement</td>
<td>A list of the targets to which pre-route table changes are to be applied.</td>
</tr>
<tr>
<td>Regions/Clusters/Partitions/Placement</td>
<td></td>
</tr>
<tr>
<td>Net Name</td>
<td>Each row in the table contains the name of a net to be constrained.</td>
</tr>
<tr>
<td>Numbered columns</td>
<td>Each numbered column represents a numbered clock track. Checking a cell in the table</td>
</tr>
<tr>
<td></td>
<td>constrains the given net to the given clock track.</td>
</tr>
<tr>
<td>Add Net</td>
<td>Type the name of any net in the design into the text field, press ENTER or click the (+)</td>
</tr>
<tr>
<td></td>
<td><strong>Add</strong> button to add that net to the table.</td>
</tr>
</tbody>
</table>

The table in this dialog uses background colors to indicate the actions performed since the dialog appeared:

- A red background indicates that a check box was removed. Red cells indicate that one or more `remove_clock_preroute` commands are to be issued if the **OK** button is clicked.
- A green background indicates that a check box was added. Green cells indicate that one or more `add_clock_preroute` commands are to be issued if the **OK** button is clicked.
- A purple background indicates that a check box exists somewhere in the given clock track column. Only one net at a time may be associated with any clock track. Checking any cell in the table automatically unchecks all other cells in that column.
- Hovering over a green or red cell shows the `add_clock_preroute` or `remove_clock_preroute` commands to be issued for that row in the table when the **OK** button is clicked.

**Note**

If some, but not all, targets have a given net associated with a given clock track, all targets can be assigned that net/clock track association by unchecking and then re-checking the appropriate check box. When the dialog was first shown, the check box had a purple background. After unchecking and then re-checking, the box has a green background to indicate that new `add_clock_preroute` commands are to be executed to cover any additional targets.

For example, in the following example, the previous example was changed as follows:

- `(i_reset_n_pr_1_ipin_net : 1)` was clicked, unchecking it
- `(i_clk_ipin_net : 2)` was clicked, checking it and automatically unchecking `(i_clk_pr_1_ipin_net : 2)`
- `(i_clk_pr_1_ipin_net : 4,5,6)` were all clicked, checking them
Configure Table Columns Dialog

The Configure Table Columns Dialog allows configuring the columns shown in the active view. Currently this dialog is only available for the IO Assignment View. From the dialog, the columns which are visible and the width (in pixels) of each column may be configured. The current column configuration may also be saved to a file, or a previous column configuration may be loaded from a file.
Create a New Constraints File Dialog

The Create a New Constraints File Dialog is used to easily create a new, empty constraints file and optionally add it to the currently active project. The dialog is available in all perspectives, and can be accessed by selecting **File → New → SDC Constraints File**...
Figure 66: Create a New Constraints File Dialog Example

The dialog allows typing the file destination Directory, or selecting it graphically using the Browse... button. The Directory name provided must already exist. (If selected, the Browse... button displays a Directory Selection Dialog, which also allows creating a new directory and then selecting it.)

The File Name must be unique — a file with that name must not already exist in the destination Directory.

If there is currently an active project in ACE, the Add to active project checkbox will be enabled and checked by default. If there is no project active, the checkbox will be disabled and deselected.

When Finish is selected, the text file is created, and a Text Editor (see page 28) is opened in ACE for the new text file.

Note

This dialog may be used to create PDC files as well as SDC files. Simply use .pdc instead of .sdc for the file extension.
Create a New Flow Step dialog
The Create a New Flow Step dialog allows creating a custom step to add to the flow.

![Create a New Flow Step Dialog Example](image)

**Figure 67: Create a New Flow Step Dialog Example**

**Table 87: Create a New Flow Step**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flow Step ID</td>
<td>A unique ID for the new flow step.</td>
</tr>
<tr>
<td>Label</td>
<td>The label to appear in ACE.</td>
</tr>
<tr>
<td>Parent</td>
<td>The parent flow step. Leave blank to create a new &quot;top level&quot; flow step.</td>
</tr>
<tr>
<td>Run after</td>
<td>Name of the flow step after which the new step should be run. Leave blank to create a new &quot;first&quot; flow step.</td>
</tr>
<tr>
<td>Tcl Command</td>
<td>The Tcl command to run for the new flow step.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the new step to be displayed in a tool tip when the cursor hovers over the step in the Flow view (see page 67).</td>
</tr>
<tr>
<td>Required</td>
<td>Checked if this step must always be run, cleared if the step is optional.</td>
</tr>
</tbody>
</table>
Create a New Text File Dialog

The Create a New Text File Dialog simply allows creating a new text file and opening the file in the ACE text editor in a single action. The dialog is available in all Perspectives (see page 24), and can be selected via File → New → Text File.

![Create a New Text File Dialog Example](image)

The dialog allows typing the file destination directory, or selecting it graphically using the Browse... button. The Directory name provided must already exist (if selected, the Browse... button displays a Directory Selection Dialog, which also allows creating a new directory and then selecting it).

The File name must be unique — a file with that name must not already exist in the destination Directory.

When Finish is selected, the text file is created, and the ACE Text Editor (see page 28) is opened for the new text file.

Create a SecureShare Zip File Dialog

The Create a SecureShare Zip File Dialog allows choosing or refining the contents of a SecureShare file, which is then zipped (and placed in the chosen directory), ready for delivery to Achronix Technical Support at https://support.achronix.com/hc/en-us/. By default, the Zip file contains all of the important details of the design, enabling Achronix support engineers to examine the design and all output files created during the ACE flow.

Optionally, files may be removed from the default lists of chosen files if it is preferred that those files are not sent to Achronix. In addition, the information may be optionally encrypted in the SecureShare Zip file.

There are presently three main sections of information in the dialog:

1. The Configuration section
2. The ACE input files section
3. The ACE output files section

More sections are planned to appear in future ACE releases, covering additional support categories, such as synthesis.
This dialog is accessed by selecting **Help → Start SecureShare**, or by using the keyboard shortcut **Ctrl-Alt-Shift-s**. When the dialog is shown, it is completely populated by default based upon information gathered from the Active Project and Implementation (see page 223). See also Using the ACE SecureShare Tool to Create a Support Zip File (see page 452).

**Configuration**

![Create a SecureShare Zip File Dialog](image)

**Figure 69: Create a SecureShare Zip File Dialog**

**Table 88: Create a SecureShare Zip File Options**

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path to Zip file (to be generated)</td>
<td>This is the SecureShare file to be generated by ACE when the <strong>Finish</strong> button is clicked. By default, the Zip file is written to the output subdirectory of the active implementation, with the file name being the design name as a prefix, followed by &quot;SecureShare&quot;, then a suffix comprised of the date the file is generated. For example, <code>&lt;active_impl_output_directory&gt;/active_project_name_SecureShare_&lt;yyyy&gt;_&lt;mm&gt;_&lt;dd&gt;.zip</code>.</td>
</tr>
<tr>
<td>Encrypt included files</td>
<td>Defaults to false/unchecked. When checked, the Zip file (above) is encrypted, and placed in an additional file with the extension <code>.zip.encrypted</code>.</td>
</tr>
</tbody>
</table>

**ACE Input Files**

Each file category (other than the project file) can hold an arbitrary number of files. Files can be added to (or removed from) any of these categories as desired. Clicking any **Add** button pops up a file selection dialog (which defaults to the correct file extensions for filtering) where one or more files to be added to the associated file list can be chosen.

**Note**

Be aware that every file selection dialog also allows setting the file extension filter to "*. *", allowing any filename to be chosen.
Selecting one or more files from a file list category enables the associated **Remove** button which, when clicked, removes the selected files from the list.

![ACE Input Files Dialog](image)

**Figure 70: ACE Input Files Dialog**

### Table 89: SecureShare Input File Categories

<table>
<thead>
<tr>
<th>File Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project file (.acxprj)</td>
<td>Defaults to the .acxprj file for the active project.</td>
</tr>
<tr>
<td>Netlist source files</td>
<td>Defaults to all the netlist source files (.v, .vm, .vma, .sv, .vhdl) found within the active project.</td>
</tr>
<tr>
<td>Constraint files (1)</td>
<td>Defaults to all the enabled constraint files (.hex, .pdc, .prt, .scf, .sdc, .xml) for the active implementation within the active project.</td>
</tr>
<tr>
<td>*.acxip files</td>
<td>Defaults to all of the .acxip files found within the active project.</td>
</tr>
<tr>
<td>Other</td>
<td>Defaults to empty. This entry allows the addition of any other arbitrary ACE input files which are not covered by the earlier categories.</td>
</tr>
</tbody>
</table>

**Table Notes**

1. Constraint files within the active project which are not part of the active implementation are not included by default.
ACE Output Files

Similar to input files, each output file category (other than the project file) can hold an arbitrary number of files. Add files to (or remove files from) any of these categories as desired. Clicking any Add button pops up a file selection dialog (which defaults to the correct file extensions for filtering) where one or more files to be added to the associated file list can be chosen.

Note

Be aware that every file selection dialog also allows setting the file extension filter to "*.*", allowing any filename to be chosen.

Selecting one or more files from a file list category enables the associated Remove button which, when clicked, removes the selected files from the list.
Figure 71: ACE Output Files Dialog
### Table 90: SecureShare Input File Categories

<table>
<thead>
<tr>
<th>File category</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Log files** | Defaults to a list of all the files found within the active implementation log subdirectory (which might include several multiprocess logs), plus:  
  • Any detected GUI log files  
  • The latest ACE session log file  
  • The latest ACE rlm_diagnostics.log file (to help track down any ACE license-related problems). |
| **Reports** | Defaults to a list of all the files found within the active implementation reports subdirectory, plus the latest Multiprocess Summary Report for the active project. |
| ***.acxdb files** | Defaults to a list of all of the .acxdb files found within the active implementation directory. |
| **Output files** | Defaults to a list of all the files found within the active implementation output subdirectory. |
| **Debug files** | Defaults to a list of all the files found within the active implementation .debug subdirectory. |
| **Other** | Defaults to empty. This entry allows adding any other arbitrary ACE-related output files which are not covered by the earlier categories. |

### Create Implementation Dialog

The Create Implementation Dialog is used to create a new implementation in the selected project. After indicating a new name for the implementation and whether to copy option values from the active implementation, click **Finish** to create the implementation in the selected project.

![Create Implementation Dialog Example](image)

**Figure 72: Create Implementation Dialog Example**
Table 91: Create Implementation Dialog Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Implementation Name</td>
<td>impl_</td>
<td>The name of the new project implementation to be created. This name must be unique among existing implementations in the selected project. The new name is used to create a new directory under the project directory for the selected project.</td>
</tr>
<tr>
<td>Copy Option Values from Active Implementation</td>
<td>Unchecked</td>
<td>If this field is checked, option values from the current Active Implementation are copied into the new implementation.</td>
</tr>
</tbody>
</table>

Create Placement Region Dialog

This wizard dialog appears after a drag-and-drop to define a rectangular area in the Floorplanner View (see page 57) while the Placement Region Tool is active. This dialog allows naming the new Placement Region, and defining its bounds.

See also: Creating a New Placement Region (see page 371).
Create Placement Region

You can create placement regions in the Core and constrain instances to them later via drag and drop or TCL commands.

Region Name: region_1

Is Partial Reconfiguration Zone

Region Alignment
- None
- Snap to Tile Boundaries
- Snap to Fabric Clusters
- Snap to Clock Region Boundaries

Region Type
- Inclusive
- Keep out
- Soft

Include Routing

Subtile Grid Coordinates
- X1 Coordinate: 26
- Y1 Coordinate: 90
- X2 Coordinate: 79
- Y2 Coordinate: 129

Figure 73: Create Placement Region Dialog Example
Table 92: Create Placement Region Dialog Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region Name</td>
<td>The name for the new Placement Region. ACE pre-populates this field with a default incrementing value.</td>
</tr>
<tr>
<td>Include Routing</td>
<td>Treats the region as a routing constraint as well as a placement constraint, keeping all routing wires and instances inside the region boundary box.</td>
</tr>
<tr>
<td>Is Partial Reconfiguration Zone</td>
<td>Indicates the region is intended to be used for partial reconfiguration.</td>
</tr>
</tbody>
</table>

Region Alignment

| None                          | No snapping.                                                                                                                                  |
| Snap to Tile Boundaries(1)    | If selected, ACE creates a Placement Region that encompasses all Tiles selected within the drag-and-drop rectangle.                          |
| Snap to Fabric Clusters(2)    | If selected, ACE creates a Placement Region that encompasses all Fabric Clusters within the drag-and-drop rectangle.                     |
| Snap to Clock Region Boundaries(3) | If selected, ACE creates a Placement Region that encompasses all Clock Regions which contain any of the selected Tiles.                 |

Region Type

| Inclusive                     | Instances added to the region are placed within the region bounding box. Permits instances to be placed inside the region even if they do not belong to the region. |
| Keep out                      | Prevents any instances from being placed inside the region. No instances may be added to a Keep Out region.                                |
| Soft                          | Instances added to the region are pulled toward the region center during placement, but instances are permitted to overflow the bounds of the soft region. Soft Placement Regions are rendered as ellipses in the Floorplanner View (see page 57), and the center of the ellipse acts as a center-of-gravity for placement. Soft regions do not limit the contained number of constrained instances, nor do they have a true count of contained sites of each resource. See Placement Regions and Placement Region Constraints (see page 371) for more details. |

Subtile Grid Coordinates

| X1 Coordinate                 | The upper-left X coordinate within the subtile grid, corresponds to the left edge.                                                          |
| Y1 Coordinate                 | The upper-left Y coordinate within the subtile grid, corresponds to the top edge.                                                           |
| X2 Coordinate                 | The lower-right X coordinate within the subtile grid, corresponds to the right edge.                                                         |
| Y2 Coordinate                 | The lower-right Y coordinate within the subtile grid, corresponds to the bottom edge.                                                        |

Table Notes

1. Since Placement Regions can only contain entire sites (no partial sites), the Placement Region can potentially grow larger than the outline rectangle.
2. In this mode, since Placement Regions can only contain entire Fabric Clusters (no partial Fabric Clusters), the Placement Region almost certainly grows larger than the outline rectangle.
3. If selected, ACE creates a Placement Region that encompasses all Clock Regions which contain any of the selected Tiles.
Create Project Dialog

The Create Project Dialog helps create a new project in the Workbench. After indicating a name and location for the project, click Finish to create the project.

![Create Project Dialog Example](image)

**Figure 74: Create Project Dialog Example**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Directory</td>
<td>The location in the file system where the project is created. Either type the new location or browse to select a file system location for the new project.</td>
</tr>
<tr>
<td>Project Name</td>
<td>The name of the new project to be created. This name is the base name of the .acxprj file created in the project directory.</td>
</tr>
<tr>
<td>Implementation Name</td>
<td>The name of the new implementation to be created with the project. Leaving this blank causes a name to be chosen automatically.</td>
</tr>
</tbody>
</table>
Generate a Pin Assignment Report Dialog

The Generate a Pin Assignment Report Dialog allows generating a customized Pin Assignment report (see page 229) with a column organization identical to that of the IO Assignment view.

![Generate a Pin Assignment Report Dialog](image)

**Figure 75: Generate a Pin Assignment Report Dialog Example**

Generate I/O Ring Design Files Dialog

The Generate I/O Ring Design Files Dialog selects the directory into which all the customized I/O Ring design files are output, including:

- Complete package ball pin assignment, power, and utilization reports
- Pin placements PDC, Verilog wrappers, and port lists for the Core user design
- The full I/O Ring bitstream, which is automatically combined with the Core user design bitstream in ACE at the end of the normal place-and-route flow for the Core user design
- Customized I/O Ring simulation files, including Verilog wrappers for the top-level and I/O Ring configuration data

The files generated are based upon the I/O Ring IP Configuration files (.acxip) in the active ACE project created via the active IP Configuration Editor (see page 27). See also: Creating an IP Configuration (see page 314) and I/O Designer Toolkit Views (see page 74).
Figure 76: Generate I/O Ring Design Files Dialog Example

Table 94: Generate I/O Ring Design Files Dialog Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directory</td>
<td><code>&lt;active_ace_project_dir&gt;/ioring_design</code></td>
<td>Selects the target directory path for the I/O ring design files when generated.</td>
</tr>
<tr>
<td>Add to active project</td>
<td>Selected</td>
<td>When selected, the necessary generated I/O ring design files (e.g., PDC pin placement constraints, Verilog wrappers, and SDC files for the core user design logic) are automatically added to the active ACE project file.</td>
</tr>
</tbody>
</table>

Generate IP Design Files Dialog

The Generate IP Design Files Dialog is used to create the necessary RTL models, timing constraints and bitstream files for configuring embedded IP. The files generated are based upon the configuration file (.acxip) created via the active IP Configuration Editor (see page 27).

See also: Creating an IP Configuration (see page 314).
Note

Each IP Configuration Editor has its own set of output files which are specific to the type of IP being configured. For example, some types of IP require PDC or SDC constraints files, while other types of IP do not. The table of dialog field descriptions below describes the common output files for most types of IP.

Table 95: Generate IP Design Files Dialog Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTL Models</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Verilog Model</td>
<td>Selected</td>
<td>Selects whether a Verilog model for the configuration is generated.</td>
</tr>
<tr>
<td>VHDL Model</td>
<td>Deselected</td>
<td>Selects whether a VHDL model for the configuration is generated.</td>
</tr>
<tr>
<td>Timing Constraints</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SDC Constraints</td>
<td>Selected</td>
<td>Selects whether an SDC constraints file for the configuration is generated.</td>
</tr>
</tbody>
</table>
Load Acxdb Dialog

After cancelling the Flow (see page 223) in the Flow View (see page 67), the Load Acxdb dialog allows restoring the database of the active implementation to a previously saved state (the state found in the .acxdb archive file). This restoration is useful because canceling a running flow might otherwise leave the database in a partially processed state.

After populating the Acxdb File field with the desired archive file (which defaults to the .acxdb file with the most recent timestamp), click Finish to restore the implementation to the state preserved in the file. To avoid loading a file and to proceed with the database in the current (incomplete flow) state, click Cancel.

**Note**

When canceling the flow, this dialog only appears if the run is cancelled after the Run Prepare stage is complete.
Load Acxdb Dialog Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acxdb File</td>
<td>The latest archive file found in the active implementation directory.</td>
<td>The file path to the desired .acxdb archive file, which is used to restore the implementation to an earlier saved state. Enter the desired path directly into this field. A drop-down list provides easy access to all archive files in the default directory for the active implementation. The Browse... button allows graphically navigating to alternate files.</td>
</tr>
</tbody>
</table>

Load Project Dialog

The Load Project Dialog allows browsing to find an existing project file to load into the Workbench. After selecting the project file and choosing to activate an implementation, click Finish to load the project.

![Load Project Dialog Example](image)

**Figure 79: Load Project Dialog Example**

Load Project Dialog Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project File</td>
<td>The path to the ACE Project File (.acxprj) to load. Either type the new location or browse to select a file system location for the project. A history of previously loaded projects can be accessed via the drop-down list. This previous project history may be cleared at any time by clicking the Clear History button.</td>
</tr>
<tr>
<td>Activate an Implementation</td>
<td>Choose to activate an implementation upon loading the project. If another project is already loaded, this field can be unchecked to preserve the current active implementation in the ACE session.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Impl Name | The name of the implementation to activate after loading the project. A drop-down list allows selecting from any implementation defined within the specified project file.

---

**New IP Configuration Dialog**

The New IP Configuration Dialog helps create a new IP configuration file (.acxip). After indicating a name and location for the configuration file, click **Finish** to create the file and open the relevant IP Configuration Editor (see page 27). See also: Creating a New IP Configuration (see page 314).

![Create a New IP Configuration](image)

**Figure 80: New IP Configuration Dialog Example**
**Note**

The displayed IP Libraries and IP types are dynamic and change based on which technology libraries and devices are installed and licensed. The screenshots and example descriptions in this section do not necessarily reflect the IP types of the actual device being used.

### New IP Configuration Dialog Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available IP</td>
<td>–</td>
<td>Lists the available IP blocks by FPGA family.</td>
</tr>
<tr>
<td>Description</td>
<td>–</td>
<td>Provides a description of the IP block.</td>
</tr>
<tr>
<td>Directory</td>
<td>Current active project directory</td>
<td>The location in the file system where the configuration file is created. Either type the new location or browse to select a file system location for the new configuration.</td>
</tr>
<tr>
<td>File Name (1)</td>
<td>new_.acxip</td>
<td>The name of the new configuration file to be created. The file name (without the .acxip suffix) also becomes the module name in the generated IP.</td>
</tr>
<tr>
<td>Add to active project</td>
<td>Enabled</td>
<td>This check box allows the IP configuration file to be added to the current project (this option is only available if a project is active). If unchecked, the IP configuration file is created at the chosen path but not automatically added to any project. Because it is not a member of a project, the new .acxip file is not visible in the Projects view.</td>
</tr>
</tbody>
</table>

**Table Notes**

1. Names that collide with Achronix reserved module names are prohibited.

### Plot Serdes Diagram Dialog

The Plot Serdes Diagram Dialog appears after selecting **Plot Serdes Diagram** from the option menu option when right-clicking a Serdes Lane in the I/O Layout Diagram View (see page 80). The dialog allows plotting a diagram (Eye plot, Histogram, or Bathtub) for the selected Serdes RX lane using the built-in capture hardware.

**Note**

This tool requires the free Matlab runtime executable to be installed in addition to ACE with an open JTAG connection in your ACE session to access the Serdes HW on the chip.

See also: Plotting SerDes Receiver Diagrams Using JTAG (see page 456).
Figure 81: Plot Serdes Diagram Dialog Example

Table 98: Plot Serdes Diagram Dialog Fields

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Block Name</td>
<td>The name of the Serdes IP Block selected from the right-click option menu in the I/O Layout Diagram View.</td>
</tr>
<tr>
<td>JTAG Device ID</td>
<td>The ID of the connected JTAG device (an FTDI USB chip or a Bitporter2 pod). This ID can be specified with a hard-coded string such as &quot;AC12345&quot; or with a Tcl variable.</td>
</tr>
<tr>
<td>Number of Samples</td>
<td>The number of samples to capture in the Serdes Rx capture hardware. The default for an Eye Plot is 500 samples. Over JTAG, this requires approximately 10 minutes to read back and plot. More samples produces a more accurate diagram, while less samples can reduce runtime.</td>
</tr>
<tr>
<td>Capture Point</td>
<td>Selects the internal Serdes block from which to capture data.</td>
</tr>
<tr>
<td>Diagram Type</td>
<td>Select an Eye Plot, Histogram, or Bathtub plot.</td>
</tr>
<tr>
<td>Figure Name</td>
<td>Specifies a label to appear on the generated diagram image.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Figure Number</td>
<td>Specifies a figure number label to appear on the generated diagram image.</td>
</tr>
<tr>
<td>Capture Data File</td>
<td>Enter the file path to the diagram capture data retrieved from the Serdes hardware via JTAG. Click Browse... to graphically select the file. This file can be used to plot multiple diagram types from the same data.</td>
</tr>
</tbody>
</table>

### Restore Implementation Dialog

The Restore Implementation dialog restores the database state of the active implementation from an Acxdb (.acxdb) archive file. After indicating the path to the archive file from which to restore the implementation, click Finish to restore the active implementation.

![Figure 82: Restore Implementation Dialog Example](image)

**Table 99: Restore Implementation Dialog Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acxdb File</td>
<td>The newest .acxdb file in the directory</td>
<td>The path to the Acxdb archive file from which to restore the implementation. A drop-down list provides easy access to all other archive files in the directory.</td>
</tr>
</tbody>
</table>

### Save Changed Properties Dialog

The Save Changed Properties Dialog allows saving to an .sdc file any properties that have been changed since the Run Prepare flow step was last executed.
To perform this action without using the dialog, use the Tcl command `save_properties`.

See also: IO Assignment View and Managing I/Os (see page 448).

**Save Implementation Dialog**

The Save Implementation dialog saves the database state of the active implementation to an archive file (.acxdb). After indicating the path to the .acxdb file to which the implementation is saved and whether to include the log file, click **Finish** to save the active implementation.
Implementations may only be saved after the Run Prepare flow step has been completed. Prior to that, there is no meaningful content in the database to save.

Table 100: Save Implementation Dialog Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acxdb File</td>
<td>.acxdb</td>
<td>The .acxdb archive file path to which the implementation is saved.</td>
</tr>
<tr>
<td>Save Log Information</td>
<td>On</td>
<td>If this field is checked, the log file for the current active implementation is included in the archive file.</td>
</tr>
</tbody>
</table>

Save Placement Dialog

The Save Placement Dialog saves the current placement to pre-placement constraints file(s). After selecting the appropriate options, click Finish to save the placement. This dialog can be triggered from the Floorplanner view (see page 57), the Search view (see page 132), and the Selection view (see page 136).
Figure 85: Save Placement Dialog Example

Table 101: Save Placement Dialog Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save I/O Pin Placement</td>
<td>Enabled</td>
<td>Indicates whether placement of instances in the Boundary ring should be saved.</td>
</tr>
<tr>
<td>Use Default Location for I/O Pin Placement File</td>
<td>Enabled</td>
<td>Specifies using the default I/O pin placement file path.</td>
</tr>
<tr>
<td>Field</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>(Text Box)</td>
<td>(blank)</td>
<td>Specify the I/O pin placement file path if the above option is disabled.</td>
</tr>
<tr>
<td><strong>Save Core Instance Placement</strong></td>
<td>Enabled</td>
<td>Indicates whether placement of instances in the core fabric should be saved.</td>
</tr>
<tr>
<td><strong>Use Default Location for Core Placement File</strong></td>
<td>Enabled</td>
<td>Specifies using the default core placement file path.</td>
</tr>
<tr>
<td>(Text Box)</td>
<td>(blank)</td>
<td>Specify the core placement file path if the above option is disabled.</td>
</tr>
<tr>
<td><strong>Automatically Add to Project</strong></td>
<td>Enabled</td>
<td>Controls whether the output placement files are automatically added to the current project as pre-placement constraints files.</td>
</tr>
<tr>
<td><strong>Create Boundary Pins</strong></td>
<td>Enabled</td>
<td>Indicates whether the placement of boundary pin instances should be saved.</td>
</tr>
<tr>
<td><strong>Output Region Constraints</strong></td>
<td>Enabled</td>
<td>Controls whether Placement regions and Placement region constraints (see page 371) are exported to the PDC file.</td>
</tr>
<tr>
<td><strong>Save Fixed Placement Only</strong></td>
<td>Enabled</td>
<td>Controls whether only the current fixed-placement constraints are saved to the output files. If set, all other placement information (such as that generated by the placer) is ignored.</td>
</tr>
<tr>
<td><strong>Fix Placement of Saved Instances/Pins</strong></td>
<td>Enabled</td>
<td>Forces all saved placements to be &quot;fixed&quot; placement, to allow lock down of all placed instances.</td>
</tr>
<tr>
<td><strong>Save Specific List of Instances</strong></td>
<td>Contextual</td>
<td>Enabled by default when created from the Search view (see page 132) or Selection view (see page 136). Disabled by default when created from the Floorplanner view (see page 57).</td>
</tr>
<tr>
<td><strong>Specific List of Instances</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Text Box)</td>
<td>(blank)</td>
<td>Enter a Tcl list of instance names, or a Tcl statement that returns a list of instance names. This list is then used (instead of all instances in the design) in combination with the other dialog settings when choosing what to save.</td>
</tr>
</tbody>
</table>

**Table Notes**

1. It is recommended to always use this option when saving pre-placement constraints.
Save Placement Regions Dialog

The Save Placement Regions Dialog appears after selecting the **Save Placement Regions** action in the Placement Regions view. This dialog allows saving placement region definitions, including the instance constraints for those placement regions.

See also: Saving Placement Region Constraints (see page 376).

![Save Placement Regions Dialog](image)

**Figure 86: Save Placement Regions Dialog Example**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output File</td>
<td>The full path to the <code>.pdc</code> file which contains the region definitions and constraints.</td>
</tr>
<tr>
<td>Save all Regions</td>
<td>Saves the data for all regions listed in the Placement Regions view.</td>
</tr>
<tr>
<td>Save Specified Region</td>
<td>Saves the data for a single region (specified below).</td>
</tr>
<tr>
<td>Region Name</td>
<td>The name of the Placement Region to be saved. This field is disabled unless <strong>Save Specified Region</strong> is selected.</td>
</tr>
<tr>
<td>Automatically Add to Project</td>
<td>When selected, if the <strong>Output File</strong> is not already a member of the constraints for the active project, the file is added to the project as a constraint file.</td>
</tr>
</tbody>
</table>
Save Script File As Dialog

The Save Script File As dialog appears when the **Write Script for Schematic View** button ( ) is selected in the **Critical Paths View** (see page 52).

The Save Script File As dialog is used to create a Tcl script of `find` commands for the current list of critical paths. The script is intended for use in the schematic viewer of the synthesis tool.

After indicating a filename and location for the Tcl script, click **OK** to write the script to disk, or **Cancel** to close the dialog without saving.

![Save Script File As Dialog Example](image)

**Figure 87: Save Script File As Dialog Example**

Search Filter Builder Dialog

The Search Filter Builder Dialog allows building simple or compound search filters for the **Search View** (see page 132) (the dialog is accessed from the ... button in the **Filters** row of the Search View).

Search filters are used to find objects in the design based upon properties other than object name. Simple filters may be combined into a compound filter by joining them with Boolean operators. See **Filter Properties** (see page 246) for a table of the available filter properties with descriptions.
**Figure 88: Search Filter Builder Dialog Example**

Table 103: Search Filter Builder Dialog Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>The filter string itself. Type directly into this field, or populate this field by using the <strong>Insert Operator</strong> and <strong>Insert Filter</strong> buttons.</td>
</tr>
<tr>
<td>Operators</td>
<td></td>
</tr>
<tr>
<td>AND</td>
<td>Select this radio button to join two filters into a compound filter where both sub-filters are true.</td>
</tr>
<tr>
<td>OR</td>
<td>Select this radio button to join two filters into a compound filter where either sub-filter is true.</td>
</tr>
<tr>
<td>EQUAL</td>
<td>Select this radio button to join two filters into a compound filter where the Boolean value of both sub-filters is identical.</td>
</tr>
<tr>
<td>Insert Operator</td>
<td>Click this button to insert the selected Boolean operator into the <strong>Filter</strong> field at the current cursor position within that field.</td>
</tr>
</tbody>
</table>
### Filters

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>A combo box showing all choices of supported filter parameter names. The value of this field affects the content of the Description areas, as well as the possible values for the Comparison, and Values options. For a list of all available types of filters, see Filter Properties (see page 246).</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Provides a textual description of the current filter parameter selected in the Name field. This field may also provide hints or details on how the Comparison or Values fields may be populated.</td>
</tr>
<tr>
<td><strong>Comparison</strong></td>
<td>Selects from the set of possible comparisons relevant to the selected filter parameter Name. The contents of this combo box change according to the current Name selection.</td>
</tr>
<tr>
<td><strong>Values</strong></td>
<td>Enter the desired value(s) to compare against. For some filter parameter Name values, the combo box may contain possible values. The contents of this combo box change according to the current Name selection.</td>
</tr>
<tr>
<td><strong>Insert Filter</strong></td>
<td>Click this button to insert the selected filter specification into the Filter field at the current cursor position within that field.</td>
</tr>
<tr>
<td><strong>Finish</strong></td>
<td>Click this button to close the dialog, copying the current value of the Filter text field into the Filters field of the Search View.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Click this button to close the dialog without changing the current value of the Filters field of the Search View.</td>
</tr>
</tbody>
</table>

### Toolbars

There are three kinds of toolbars in the Workbench (see page 24): main, view, and trim.

The main toolbar, sometimes called the Workbench toolbar, is displayed at the top of the Workbench window directly beneath the menu bar. The contents of this toolbar change based on the active perspective. Items in the toolbar might be enabled or disabled based on the state of either the active view (see page 33) or editor (see page 27). Sections of the main toolbar can be rearranged using the mouse.

There are also individual view toolbars, which appear in the title bar of a view (see page 33). Actions in a view toolbar apply only to the view in which they appear. Some view toolbars include a Menu button, shown as an inverted triangle, which contains additional actions for that view.

Minimizing a view/editor tab stack also produces a toolbar in the trim at the outer edge of the workbench window (a Trim Stack). This bar contains an icon for each of the views in the stack and/or a single icon for each stack of editors. Clicking one of these icons results in the view/editor being displayed as an overlay onto the workbench window.

In all cases, when the cursor is positioned over a toolbar button, a tooltip describing its function appears.
Preferences

The Preferences dialog sets user preferences. The dialog pages can be searched using the filter function. To filter by matching the page title, simply type the name of the page being sought, and the available pages are presented below. The filter also searches on keywords such as "appearance" and "text". The history controls allow navigation through previously viewed pages. To step back or forward several pages at a time, click the drop-down arrow to see a list of the most recently viewed preference pages.

The Preferences dialog can be found from the main workbench Window menu under Window → Preferences....

Configure DCC Connection Preference Page

The Configure DCC Connection Preference Page configures the Preferences (see page 186) for the DCC (Demo Command and Control) connection, as used with the HW Demo View (see page 71).

See also: Configuring the DCC Connection (see page 338), Running the HW Demo (see page 377).
Configure DCC Connection Preference Page Example

Table 104: Configure DCC Connection Preference Page Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Name</td>
<td>Enter the serial port name used for the DCC connection. For further information about determining which serial port should be used, please see Configuring the DCC Connection (see page 338).</td>
</tr>
</tbody>
</table>

Configure JTAG Connection Preference Page

The Configure JTAG Connection preference page configures which Bitporter2 or FTDI FT2232H or FT4232H device is used to communicate via JTAG to the desired device under test (the test board). The page also specifies where the Achronix device is found in the JTAG scan chain, which might potentially contain multiple Achronix and non-Achronix devices.

Warning!

Bitporter2 JTAG pods and test boards can be damaged if connected improperly. Always be aware of ESD safety concerns. Before attempting to use a USB JTAG connection, with or without a Bitporter2 pod, please consult the JTAG Configuration User Guide (UG004) at https://www.achronix.com/documentation/jtag-configuration-user-guide-ug004.

Multiple views use these configuration preferences, including the Download view (see page 55), the Snapshot Debugger view (see page 139), the Register Browser view (see page 130), and the HW Demo view (see page 71). Specialized functionality for some IP configuration editors might also use these JTAG preferences. Some Tcl commands may also use these JTAG preferences by default, though these can always be overridden with Tcl command arguments /flags.

The section Configuring the JTAG Connection (see page 339) explains the proper use of all fields of this page in detail.
Figure 90: Configure JTAG Connection Preference Page Example

Table 105: Configure JTAG Interface Preference Page Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JTAG Programmer Device Name</td>
<td>The name of the JTAG device which should be used for all ACE JTAG interactions with the chosen FPGA or eFPGA. If the name is not specified, auto-detection of JTAG devices is attempted.</td>
</tr>
<tr>
<td></td>
<td><strong>Performance Tip</strong></td>
</tr>
<tr>
<td></td>
<td>Even if only one JTAG device is connected, specifying the JTAG device by name (instead of relying upon auto-detection) can save up to several seconds of initialization time on every JTAG connection.</td>
</tr>
<tr>
<td>JTAG Scan Chain</td>
<td></td>
</tr>
<tr>
<td>IR Bits Before the Target FPGA Device</td>
<td>Sets the (decimal) number of instruction register bits between the board JTAG TDI pin and the target device.</td>
</tr>
<tr>
<td>(2)</td>
<td></td>
</tr>
<tr>
<td>IR Bits After the Target FPGA Device</td>
<td>Sets the (decimal) number of instruction register bits between the target device and the board JTAG TDO pin.</td>
</tr>
<tr>
<td>(2)</td>
<td></td>
</tr>
<tr>
<td>Target FPGA Device Offset in Scan Chain</td>
<td>Sets the device count (in decimal) between the board JTAG TDI pin and target FPGA device.</td>
</tr>
<tr>
<td>(2)</td>
<td></td>
</tr>
</tbody>
</table>

Table Notes

1. Auto-detection can only be used safely when just one JTAG pod/device is connected. If more than one pod/device is automatically detected while no name is specified, JTAG interactions fail, stating that it is required to specify which pod/device to use. The Tcl command `jtag::get_connected_devices` provides a list of connected JTAG device names. See the JTAG Configuration User Guide (UG004) for more information.
Option | Description
---|---
2. | The default value of zero is always correct for single-device JTAG scan chains. For multi-device scan chains, the default values of all zeros never work.

Multi-device JTAG Scan Chain (IEEE 1149.1) Example

The following high-level diagram summarizes how ACE must be configured for JTAG daisy-chains. For an explanation of daisy-chained JTAG scan chains, visit https://en.wikipedia.org/wiki/Jtag#Daisy-chained_JTAG_.28IEEE_1149.1.29.

![Diagram of a Multi-device JTAG Scan Chain](image)

**Figure 91: Example High-Level Diagram of a Multi-device JTAG Scan Chain**

When multiple FPGA devices are attached to the same JTAG scan chain, the target FPGA device must be specified. The FPGA device closest to the Bitporter2 (more accurately, closest to the board JTAG TDI pin) has a target offset of 0.

Because different FPGA devices have different instruction register (IR) sizes, the total IR bit length before and after the target must be specified as well. Achronix devices have a JTAG instruction register size of 23 bits. Hence, in the above example diagram, if all devices were Achronix FPGA devices, there would be 23 IR bits before the target FPGA device, (23 IR bits within the target FPGA device,) and 46 IR bits after the target FPGA device.

**Note**

For a more thorough explanation regarding ACE multi-device JTAG scan chain configurations, refer to Configuring the JTAG Connection (see page 339).

Critical Path Diagram View Preference Page

The Critical Path Diagram View Preference Page configures the display Preferences (see page 186) of the Critical Path Diagram View (see page 49).
Table 106: Critical Path Diagram View Preference Page Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labels</td>
<td>Configures the color of the label text printed for graph nodes and arrows in the diagram.</td>
</tr>
<tr>
<td>Outline</td>
<td>Configures the color of the outline of the graph nodes in the diagram.</td>
</tr>
<tr>
<td>Instances</td>
<td>Configures the background color of graph nodes in the diagram.</td>
</tr>
<tr>
<td>Selected Instances</td>
<td>Configures the background color of graph nodes representing Instances in the ACE Selection Set in the diagram.</td>
</tr>
<tr>
<td>Nets</td>
<td>Configures the color of the arrows in the diagram.</td>
</tr>
<tr>
<td>Selected Nets</td>
<td>Configures the color of arrows representing Nets in the ACE Selection Set in the diagram.</td>
</tr>
<tr>
<td>Restore Defaults</td>
<td>Returns all preferences on this page to their ACE default values.</td>
</tr>
<tr>
<td>Apply</td>
<td>Immediately applies any configuration changes on this page to the current diagram in the Critical Path Diagram View (see page 49). These config values are also saved and are used in all future ACE sessions. The Preferences dialog stays open to allow other preference configuration changes, if desired.</td>
</tr>
<tr>
<td>OK</td>
<td>Immediately applies any preference configuration changes (including on other preference pages). These config values are also saved and are used in all future ACE sessions.</td>
</tr>
</tbody>
</table>
Floorplanner View Colors and Layers Preference Page

The Floorplanner View Colors and Layer Preference Page configures the colors of multiple layers (and states within the layers) for the Floorplanner view (see page 57). Additionally, options are provided allowing a degree of control over the display priorities of the possible Instance States (see page 245) and Net/Route highlighting vs. selection. For more about Highlighting, see Highlighting Objects in the Floorplanner View (see page 323). For more about Selection, see the Selection View (see page 136).

![Floorplanner View Colors and Layers Dialog](image)

**Figure 93: Floorplanner View Colors and Layers Dialog**

The meanings of the various Instance States (see page 245) are defined elsewhere. While Instances can have multiple states at once, they can only show a single state at a time, thus there is some ability to alter the display priority of the various Instance states.

Similarly, the display of the Floorplanner Nets/Routes layers can be adjusted. (Both Clock and non-Clock nets are affected identically by these settings.)
### Table 107: Instances and Nets/Routes Preferences

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Instances</strong></td>
<td></td>
</tr>
<tr>
<td>Grab focus on mouse-over</td>
<td>If enabled, the Floorplanner view grabs focus whenever the cursor moves into the view.</td>
</tr>
<tr>
<td>Drag scroll margin size</td>
<td>The size, in pixels, of the &quot;drag scroll margins.&quot; Defines how close the cursor must get to an edge of the Floorplanner view to start drag scrolling.</td>
</tr>
<tr>
<td>Drag scroll speed</td>
<td>Defines How far, in pixels, the view moves on each drag scroll.</td>
</tr>
<tr>
<td>Show Highlight Color of Instances on top of Overassigned/Fixed/Locked Color</td>
<td>When enabled, the Instance Highlight color has a higher priority than all other Instance states except Selection.</td>
</tr>
<tr>
<td>Show Overassignment Color on Instances with Site Overassignment Errors</td>
<td>Allows toggling whether site over-assignment errors are displayed visually on the Floorplanner view.</td>
</tr>
<tr>
<td>Show Fixed Color on Instances with Fixed Placement</td>
<td>If disabled, both fixed placement and non-fixed placement instances are shown in the same color, grey by default.</td>
</tr>
<tr>
<td>Show Locked Color on Instances with Locked Placement</td>
<td>If disabled, locked and non-locked instances are shown with the same color.</td>
</tr>
<tr>
<td>Show Site Borders on Placed Instances</td>
<td>If enabled, all placed instances are rendered with the Site border color as an outline around the instance. If disabled, placed instances are rendered without a site border.</td>
</tr>
<tr>
<td>Always Show Highlighted Instances</td>
<td>If enabled, Highlighted instances are always displayed, even if their layer (Instances/Selected Instances) is otherwise disabled. If disabled, Highlighted instances are only displayed when their layer (Instances/Selected Instances) is enabled.</td>
</tr>
<tr>
<td><strong>Nets/Routes</strong></td>
<td></td>
</tr>
<tr>
<td>Allows altering how Non-clock Routes and Clock Routes are drawn (when the Non-clock Routes or Clock Routes layers are enabled, respectively, in the Floorplanner palette). Choices are Actual Route and 1 Corner.</td>
<td><img src="image" alt="Diagram" /> Actual Route mode draws a single straight line from wire sources to wire sinks for each route segment.</td>
</tr>
</tbody>
</table>
### Preference Description

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Route Rendering Mode</strong></td>
<td><img src="image" alt="1 Corner mode" /> 1 Corner mode draws two lines for each wire: from each wire source, draws a vertical line to the wire sink Y coordinate, then a horizontal line to the wire sink; no diagonal lines are used, which speeds rendering in complex designs.</td>
</tr>
<tr>
<td><strong>Always Show Highlighted Nets</strong></td>
<td>If enabled, Highlighted nets are always displayed, even if their layer (Clock Routes or Non-clock Routes) is otherwise disabled. If disabled, Highlighted nets are only displayed when their layer (Clock Routes or Non-clock Routes) is enabled.</td>
</tr>
<tr>
<td><strong>Always Show Selected Nets</strong></td>
<td>If enabled, Selected nets are always displayed, even if their layer (Clock Routes or Non-clock Routes) is otherwise disabled. If disabled, Selected nets are only displayed when their layer (Clock Routes or Non-clock Routes) is enabled.</td>
</tr>
<tr>
<td><strong>Show Selected Nets on Top of Highlighted Nets</strong></td>
<td>Allows changing whether the Selection or Highlight color takes priority, and is painted &quot;on top&quot; of the other state during rendering.</td>
</tr>
<tr>
<td><strong>Thickness of Highlighted Nets</strong></td>
<td>The highlight color of a net is rendered this many pixels wide.</td>
</tr>
<tr>
<td><strong>Thickness of Selected Nets</strong></td>
<td>The selection color of a net is rendered this many pixels wide.</td>
</tr>
</tbody>
</table>

### Table Notes

1. **Caution:** When Show Site Borders on Placed Instances is enabled while the view is extremely zoomed out, the site border render color might actually hide the placement state color. Thus, this preference is disabled by default.

### Note

- The 1 Corner route drawing mode is significantly faster (up to 5×) than the Actual Route drawing mode, but it can make individual routes harder to differentiate from each other. When Floorplanner performance is a concern, use 1 Corner mode when possible, and only switch to Actual Route mode when needed.
- It is possible to show both the selection and highlight state of a single net simultaneously. Simply ensure the higher priority (top) state has a narrower thickness than the lower priority (bottom) state, and the bottom state color is rendered as a "halo" effect around the top state color.
- Having the "Always Show..." preferences enabled might be most useful in designs with massive numbers of nets/routes. Both the Clock and Non-clock route layers can be disabled, and then Select or Highlight the interesting routes, and only the Selected and/or Highlighted routes are displayed, without the distractions of the less-interesting routes cluttering up the view.
Figure 94: Colors and Fonts | Floorplanner View section

Table 108: Color Preferences

<table>
<thead>
<tr>
<th>Color Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Color</td>
<td>Used to render the background of the device.</td>
</tr>
<tr>
<td>Instances, placed</td>
<td>Represents instances with default (Soft) placement.</td>
</tr>
<tr>
<td>Instances, fixed placement</td>
<td>Represents instances with Fixed placement.</td>
</tr>
<tr>
<td>Instances, locked placement</td>
<td>Represents instances with Locked placement.</td>
</tr>
<tr>
<td>Color Preference</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Instances, placement error</td>
<td>Represents an instance that shares a site assignment with another instance. Since a site can only legally contain a single instance, this is an error state.</td>
</tr>
<tr>
<td>Nets</td>
<td>Represents all net Routes for both clock and non-clock nets.</td>
</tr>
<tr>
<td>Flylines</td>
<td>Flylines are only rendered for Selected Instances, and only when the Layer called <strong>Selected Instance Flylines</strong> is enabled. These are straight single-segment lines directly connecting a net source instance and sink instance, where either the source or sink is a Selected Instance.</td>
</tr>
<tr>
<td>Selected Instances</td>
<td>Represents any Instance that is a member of the Selection Set (and is thus also visible in the Selection View (see page 136)).</td>
</tr>
<tr>
<td>Selected Nets</td>
<td>Represents any Net that is a member of the Selection Set (and is thus also visible in the Selection View).</td>
</tr>
<tr>
<td>Selected Pins</td>
<td>Represents any Pin that is a member of the Selection Set (and is thus also visible in the Selection View).</td>
</tr>
<tr>
<td>Selected Paths</td>
<td>Represents any Path that is a member of the Selection Set (and is thus also visible in the Selection View).</td>
</tr>
<tr>
<td>Selected Sites</td>
<td>Represents any Site that is a member of the Selection Set (and is thus also visible in the Selection View).</td>
</tr>
<tr>
<td>Routing Status – Open Pins</td>
<td>Represents Open Pins, the endpoints of Open Connections (which are the unrouted portions of a net). Open Pin squares are only visible when enabled in the Layers section of the Floorplanner view Palette.</td>
</tr>
<tr>
<td>Routing Status – Overflows</td>
<td>Represents Overflow pins, a rare routing error state. Overflow diamonds on pins are only visible when enabled in the Layers section of the Floorplanner view Palette.</td>
</tr>
</tbody>
</table>
Floorplanner View Optimizations Preference Page

The Floorplanner View Optimizations Preference Page configures rendering optimizations for the Floorplanner View (see page 57). The following Floorplanner View Optimizations Page example includes default values for Windows:

![Floorplanner View Optimizations Preference Page Example](image)

**Figure 95: Floorplanner View Optimizations Preference Page Example**

Designs on modern FPGAs are continuing to increase in complexity. To maintain acceptable Floorplanner performance, highly complex designs require significant rendering optimizations. The set of preferences on this page allows advanced users, FAEs, and tech support to tweak the Floorplanner optimization settings in rare cases when it proves necessary.
ACE tracks three levels of design complexity (High, Med, and Low) and, by default, enables or disables individual optimization settings based upon the design complexity. Because drawing the routing has the most significant impact upon Floorplanner render performance, design complexity is measured in terms of the route segment count. The cutoffs between complexity levels are user configurable.

**Note**

By default, all optimization features are disabled for the simplest designs. As design complexity increases, more optimizations are enabled by default. Some optimizations have overhead, and actually hinder render performance on small designs — for this reason, all optimizations are typically disabled for the simplest (Low complexity) designs.

The current (active) design Floorplanner complexity is always reported in this preference page as **Current Design's Complexity**: (near the middle of the page). This detail helps to determine which column of optimization settings impacts the rendering of the current design in the Floorplanner. Be aware that the route segment count used to compute the design complexity only includes route segments of routed nets. The same design often reports a Low complexity before it is routed, and a High complexity after routing is complete.

### Table 109: Optimization Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Technical Description</th>
<th>Usability Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Optimization settings which may vary with design complexity</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>When panning, show only background layer:</td>
<td>Reduces the amount of rendering performed while panning / scrolling; the detailed render only occurs after panning / scrolling is completed.</td>
<td>Enable this if panning / scrolling the Floorplanner feels too slow.</td>
</tr>
<tr>
<td>Enable incremental rendering:</td>
<td>The render work is broken up into small chunks within each render layer and performed asynchronously, instead of performing the entire render of all layers at once.因为 the work chunks are performed asynchronously, the application has a chance to respond to subsequent mouse and keyboard input earlier, instead of waiting for the entire render to complete.</td>
<td>If enabled, each Floorplanner render is slightly (5% to 10%) slower overall, but the Floorplanner Perspective becomes significantly more responsive to mouse and keyboard actions. Obsolete renders might then be interrupted (allowing faster renders when quickly changing zoom levels with the mouse wheel, for example). In some cases (for example, if a great deal of Floorplanner panning/scrolling occurs), there might be noticeable rendering latency/lag.</td>
</tr>
<tr>
<td>Show intermediate render stages:</td>
<td>When renders are slow, it can be frustrating to stare at an empty grey/black window waiting for something to change. When this setting is enabled, the user can observe as render layers are built up into the final rendered image.</td>
<td>Provides more frequent visual feedback during rendering, (so it can feel faster, because something is visibly happening,) but renders are actually slightly slower overall.</td>
</tr>
<tr>
<td>Render large areas as smaller tiled areas:</td>
<td>The total render area, if greater than the <a href="#">Max unsegmented area</a>, are broken into quadrants which are rendered individually. Rendered areas are checked for (re-)quartering up to <strong>Max re-quartering recursion</strong> times. Because the quadrant area is smaller, it completes rendering faster than the whole.</td>
<td>Large render areas are each broken into four smaller chunks for increased visual feedback. Enabling this increases total render times, but it might feel faster, because something is visibly happening.</td>
</tr>
<tr>
<td>• Max re-quartering recursion:</td>
<td>The maximum number of times a render area may be broken into smaller (and smaller) pieces. Only relevant when <strong>Render large areas as smaller tiled areas</strong> is enabled.</td>
<td>Relevant at the outermost zoom levels. Increasing this value might increase total render times, but can provide more frequent visual feedback.</td>
</tr>
<tr>
<td>Option</td>
<td>Technical Description</td>
<td>Usability Notes</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>• Max unsegmented area:</td>
<td>Areas larger than this are broken into smaller chunks up to <strong>Max re-quartering recursion</strong> times. Only relevant when <strong>Render large areas as smaller tiled areas</strong> is enabled.</td>
<td>Relevant at the outermost zoom levels. Decreasing this can increase total render times, but can provide more frequent visual feedback.</td>
</tr>
<tr>
<td>Reduce overdraw with route preprocessing and caching:</td>
<td>Significantly improves render speeds by reducing route line overdraw via culling. Routing data is pre-processed and cached at multiple zoom levels when the routing data is loaded/updated. Due to memory constraints, only the outermost zoom levels may be cached.</td>
<td>By pre-processing routes at multiple zoom levels when the routes are loaded, we reduce the number of route lines we draw over preexisting routes lines of the same color. This slightly increases the memory footprint and load times, but significantly reduces render times for large designs (when overdraw is most frequent).</td>
</tr>
<tr>
<td>• Max zoom level to be preprocessed/cached:</td>
<td>0=zoomed all the way out, 1=zoomed in one step, etc.</td>
<td>This number must be kept small to avoid running out of memory. (Floorplanner route render cache sizes can more than double at each increasing zoom level.)</td>
</tr>
</tbody>
</table>

**Settings used for all complexities**

<p>| Route segment count complexity cutoff, High/Med: | Designs with a route segment count greater than this number use the optimization settings for High complexity designs (the first column of checkboxes/fields). | – |
| Route segment count complexity cutoff, Med/Low: | Designs with a route segment count less than (or equal to) this number use the optimization settings for Low complexity designs (the third column of checkboxes/fields). | – |
| Nets processed per incremental render work unit: | The number of nets to process per discrete work unit when rendering the routing layers. Used when the current zoom is NOT in the route overdraw reduction cache. Only relevant when <strong>Enable incremental rendering</strong> is on. | Increasing this number might very slightly improve rendering performance, but decrease the frequency of visual feedback. |
| Route segments processed per incremental render work unit: | The number of route segments to process per discrete work unit when rendering cached route segments. Used when the current zoom is in the route overdraw reduction cache. Only relevant when both <strong>Enable incremental rendering</strong> and <strong>Reduce overdraw with route preprocessing and caching</strong> are on. | Increasing this number might very slightly improve rendering performance, but decrease the frequency of visual feedback. |
| Enable polyline rendering (Early Access)(1) | – | Polyline rendering of the routes is a known major Floorplanner performance advantage in Windows, but only minor advantages were seen in tested Linux configurations. The advantages are most noticeable in the largest designs. |
| Enable temp collection route rendering:(2) | – | Might slow rendering when using route overdraw reduction cache, but other route rendering might speed up slightly. |
| Force faster classic rendering APIs when possible: | – | The classic rendering APIs are significantly faster in all tested cases, but might produce slightly cruder visual output due to a lack of anti-aliasing. (The modern/advanced render APIs are still automatically used when absolutely required.) |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Technical Description</th>
<th>Usability Notes</th>
</tr>
</thead>
</table>
| **Table Notes**                            | 1. **Caution: Enable polyline rendering** is new, Early Access functionality. While Achronix found no negative stability or performance impacts when testing this optimization, customer hardware and software have a wider variety of configurations than in our test labs. If any new performance or stability issues are observed in the GUI, please contact Achronix Technical Support. Achronix notes the specifics of your configuration (to reproduce and correct the problem), and might then suggest disabling this new polyline rendering functionality to determine if performance or stability improves.  
2. **Caution: Enable temp collection route rendering** requires significantly more ACE GUI memory when enabled! |                                                                                                                                                        |

**Technical Note for Windows Users**

The Windows operating system requires that applications check-in every five seconds, or the application is deemed non-responsive. Non-responsive applications are given a figurative kick-in-the-pants by Windows, and asked to repaint the screen. When the screen paint itself is taking more than five seconds, as might happen with poor Floorplanner Optimization settings, an application can be forced into an effective infinite-loop of paint requests from the operating system.

If a Windows user ever notices ACE being called non-responsive by Windows (check the application title bar), ACE has most likely entered this looped painting state. To escape, change back to the Project perspective (or any other perspective without the Floorplanner view visible), then on this Floorplanner View Optimizations Preference Page, ensure that incremental rendering and tiled rendering are both enabled for the current design's complexity level. If both are already enabled, please call Achronix Technical Support for guidance on further Floorplanner optimization tweaks.

⚠️ **Warning!**

Disabling optimizations that are enabled by default is not recommended.
I/O Designer Preference Page

The I/O Designer Preference Page contains a number of preferences for the I/O Designer views.

![I/O Designer Preference Page Example](image)

**Figure 96: I/O Designer Preference Page Example**

### Table 110: I/O Designer Preferences Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout Diagram Font</td>
<td>The font used on shapes in the I/O Layout diagram.</td>
</tr>
<tr>
<td>Valid Placement Color</td>
<td>The color used for sites with valid placements.</td>
</tr>
<tr>
<td>Invalid Placement Color</td>
<td>The color used for sites with invalid placements.</td>
</tr>
<tr>
<td>Highlighted Placement Color</td>
<td>The color used to highlight the currently selected site.</td>
</tr>
<tr>
<td>Show active editor highlight...</td>
<td>Toggles whether the currently selected site is drawn with a highlight.</td>
</tr>
<tr>
<td>External file poll interval (secs)</td>
<td>Specifies how often IP files are checked for external modification.</td>
</tr>
</tbody>
</table>
IP Diagram Preference Page

The IP Diagram Preference Page contains a number of preferences for the IP Diagram View (see page 82) relating to colors and fonts.

Figure 97: IP Diagram Preference Page Example

Table 111: IP Diagram Preferences Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block Diagram Font</td>
<td>The font used to title logic blocks in the diagram.</td>
</tr>
<tr>
<td>Default Font</td>
<td>The font used for all diagram text except the logic block titles.</td>
</tr>
<tr>
<td>Normal Foreground Color</td>
<td>The color used for logic blocks, signals, and text.</td>
</tr>
<tr>
<td>Alternate Foreground Color</td>
<td>The color used to highlight portions of the diagram.</td>
</tr>
<tr>
<td>Wrapper Foreground Color</td>
<td>The color used to represent the IP RTL wrapper itself. Everything enclosed by this color is within the wrapper.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Normal Background Color</td>
<td>The default background color for the entire diagram.</td>
</tr>
<tr>
<td>Warning Background Color</td>
<td>Text representing IP Options with warnings have their backgrounds painted this color.</td>
</tr>
<tr>
<td>Error Background Color</td>
<td>Text representing IP Options with errors have their backgrounds painted this color.</td>
</tr>
</tbody>
</table>

**Multiprocess: Configure Custom Job Submission Tool Preference Page**

The Multiprocess: Configure Custom Job Submission Tool Preference Page allows configuring the ACE Multiprocess View (see page 86) to submit Multiprocess jobs to a third-party cloud/grid/job submission system using a command-line tool. As a useful example, by default, ACE is configured to use an Oracle Grid Engine derivative via the `qsub` command (see https://en.wikipedia.org/wiki/Oracle_Grid_Engine). Be aware that the Oracle Grid Engine `qsub` arguments are not 100% compatible with the `qsub` standard (documented at http://pubs.opengroup.org/onlinepubs/9699919799/utilities/qsub.html).
Figure 98: Multiprocess: Configure Custom Job Submission Tool Preference Page

Example commandline:
```
qsub -set <ImplWorkingDir> -o <PathToImplJobSubmissionLog> -N <JobName> -sync -j -y -b -y -q ^@@linux64 -v RLM_LICENSE -l mem_free=8G,h_vmem=12G
```

When the third-party job submission system support is enabled, ACE calls the specified executable, using the specified command-line arguments, to submit ACE Multiprocess jobs.

See Configuring ACE to use an External Job Submission System (see page 288) for more information.

Warning!

Debugging job submission configurations:

- If the job submission system is properly configured on the host machine (meaning it is possible to successfully submit non-ACE jobs from the command-line) and ACE is still unable to successfully submit jobs, please contact Achronix technical support.

- **DO NOT** copy the text of the attempted command and manually attempt to submit from the command-line.
Netlist Browser Preference Page
The Netlist Browser preference page contains a number of preferences for the Netlist Browser view.

![Netlist Browser Preference Page Example](image)

**Figure 99: Netlist Browser Preference Page Example**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double-clicks update the Properties view</td>
<td>Toggles whether double-clicking an item in the Netlist browser view shows that item in the Properties view.</td>
</tr>
<tr>
<td>Warn before applying context-menu actions to large selections</td>
<td>Applying actions to very large selections can take a very long time. Toggling this option causes a warning message to appear before an action is run against a large selection.</td>
</tr>
</tbody>
</table>

NoC Performance View Preference Page
The NoC Performance view preference page offers preferences related to the 2D NoC Performance view.
Figure 100: NoC Performance View Preference Page

Table 113: NoC Performance View Preferences

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log File Browse Path</td>
<td>By default, browsing for simulation log files starts in whatever directory was last browsed. Setting the log file directory path causes browsing to always start at the specified path.</td>
</tr>
</tbody>
</table>
Figure 101: Colors and Fonts | NoC Performance View Section

Table 114: Color Preferences

<table>
<thead>
<tr>
<th>Color Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blockage:1:Low</td>
<td>Selects the color to render shapes with &quot;low&quot; blockage.</td>
</tr>
<tr>
<td>Blockage:2:Medium</td>
<td>Selects the color to render shapes with &quot;medium&quot; blockage.</td>
</tr>
<tr>
<td>Blockage:3:High</td>
<td>Selects the color to render shapes with &quot;high&quot; blockage.</td>
</tr>
<tr>
<td>Data Flow Arrows</td>
<td>Selects the color to render &quot;data flow direction&quot; arrows.</td>
</tr>
<tr>
<td>NoC Performance Diagram font</td>
<td>Selects the font used to label diagram shapes.</td>
</tr>
<tr>
<td>Noc Time Slice View font</td>
<td>Selects the font used to render text in the NoC Time Slice view</td>
</tr>
<tr>
<td>Throughput:1:High</td>
<td>Selects the color to render shapes with &quot;high&quot; throughput.</td>
</tr>
<tr>
<td>Throughput:2:Medium</td>
<td>Selects the color to render shapes with &quot;medium&quot; throughput.</td>
</tr>
</tbody>
</table>
### Color Preference

<table>
<thead>
<tr>
<th>Color Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Throughput:3:Low</td>
<td>Selects the color to render shapes with &quot;low&quot; throughput.</td>
</tr>
<tr>
<td>Time Slice View: Notes</td>
<td>Selects the color to render &quot;notes&quot; in the Time Slice view.</td>
</tr>
<tr>
<td>Time Slice View: Stats</td>
<td>Selects the color to render &quot;stats&quot; in the Time Slice view.</td>
</tr>
</tbody>
</table>
Other Colors and Fonts Preference Page

The Other Colors and Fonts Preference Page allows setting many of the fonts, colors and components used by ACE. The page is accessed by selecting **General → Appearance → Other Colors and Fonts**.

![Other Colors and Fonts Preference Page Example](image)

**Figure 102: Other Colors and Fonts Preference Page Example**

A tree is used to navigate among and show a short preview of the various colors and fonts. The current face (but not size) of any font is previewed in its label. Colors are previewed in the icon associated with its label. Additionally, some categories (Workbench in particular) provide a more detailed preview of their contributions (shown below the description area, if available).

- Font settings can be changed either by selecting the font from the list and clicking **Use System Font** to use the operating system font, or by clicking **Edit** to open up a font selection dialog. **Reset** can be used to return to the default value.
- Color settings can be changed by clicking **Edit** to the right of the tree area when a color is selected. **Reset** can be used to return to the default value.
- The **Colors and Fonts** text field can be used to filter the contents. Simply type in an entry and any matching results remain in the tree view.
- The **Description** and **Preview** sections provide details when the Workbench colors and font settings are selected.
Package View Preference Page

The Package View Preference Page provides color configuration for several graphics layers in the Package view.

![Package View Preference Page Example](image)

**Figure 103: Package View Preference Page Example**

Placement Regions Preference Page

The Placement Regions Preference Page determines how Placement Regions (see page 371) are handled in the Placement Regions view (see page 118) and the Floorplanner view (see page 57) (when the Floorplanner Placement Region Tool is active).
Figure 104: Placement Regions Preference Page Example

Table 115: Placement Region Preferences

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Placement Region Boundary Alignment</td>
<td></td>
</tr>
<tr>
<td>Snap to Clock Region Boundaries</td>
<td>When creating, resizing, or moving Placement Regions, the Placement Region boundaries are forced to align with Clock Region Boundaries. Use this for a simple, coarse-grained approach to Placement Regions. This setting is recommended for most use cases.</td>
</tr>
<tr>
<td>Snap to Tile Boundaries</td>
<td>When creating, resizing, or moving Placement Regions, the Placement Region boundaries are forced to align with Tile Boundaries, for a very fine-grained region. This setting is only recommended for advanced users.</td>
</tr>
<tr>
<td>Drag and Drop Actions</td>
<td></td>
</tr>
<tr>
<td>Add only flops to the constraint</td>
<td>When using drag-and-drop to assign Placement Region Constraints, this setting ensures only flops are assigned to the region constraint. All other dropped items are excluded from the constraint.</td>
</tr>
<tr>
<td>Include constants in the constraint (1)</td>
<td>When using drag-and-drop to assign Placement Region Constraints, this setting includes constants in the constraint.</td>
</tr>
</tbody>
</table>

Table Notes
1. The Include constants in the constraint setting is ignored if Add only flops to the constraint is enabled.
Project Management Preference Page

The Project Management Preference Page sets the behavior of Editors (see page 27) and Reports (see page 229).

![Project Management Preference Page Example](image)

**Figure 105: Project Management Preference Page Example**

**Table 116: Project Management Preferences**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>See also:</td>
<td>Link to Colors and Fonts preferences allowing choice of the font used in the Projects view.</td>
</tr>
<tr>
<td>Close editors on active implementation change</td>
<td>Can be used to automatically close open editors when the active implementation changes.</td>
</tr>
<tr>
<td>Open Multiprocess summary on active project change</td>
<td>Can be used to automatically open the Multiprocess summary report when the active project changes.</td>
</tr>
<tr>
<td>Open reports on active implementation change</td>
<td>Can be used to automatically open implementation-specific reports when the active implementation changes.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Only open most-recent report of a given type</td>
<td>Can be used to automatically open only the most-recent report of a given type.</td>
</tr>
<tr>
<td>Save changed editors from the active project before running the flow</td>
<td>Can be used to automatically save all open editors before running the flow.</td>
</tr>
<tr>
<td>Reload Project overwrites unsaved local project changes automatically</td>
<td>Can be used to automatically overwrite unsaved local project changes when Reload Project is used (without a confirmation prompt).</td>
</tr>
<tr>
<td>Enable background checking for project source file changes during the flow</td>
<td>If enabled, project source files are periodically polled in the background to look for any changes made outside of ACE.</td>
</tr>
<tr>
<td>Hide the pop-up dialog when project source files change during the flow</td>
<td>If enabled, source file change notification is suppressed until the flow has finished running.</td>
</tr>
<tr>
<td>Project source file change background checking frequency (seconds)</td>
<td>Determines how often to poll for background source file changes.</td>
</tr>
<tr>
<td>Group reports by type</td>
<td>If enabled, reports are grouped into subfolders in the Projects view tree.</td>
</tr>
<tr>
<td>Only show HTML reports</td>
<td>If enabled, only HTML reports are shown in the Projects view tree.</td>
</tr>
<tr>
<td>Only show the most recent report</td>
<td>If enabled, only the most recent report is shown in any subfolder in the Projects view tree.</td>
</tr>
</tbody>
</table>
Tcl Console View Preference Page

The Tcl Console View Preference Page contains settings that alter the behavior and/or presentation of information in the Tcl Console View (see page 144).

![Preferences](image)

**Figure 106: Tcl Console View Preference Page Example**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>See also:</td>
<td>Link to Colors and Fonts Preferences allowing choice of the font used in the Tcl Console.</td>
</tr>
<tr>
<td>Show Tcl feedback in italics</td>
<td>Enabling this option causes the Tcl console feedback to be shown in italics.</td>
</tr>
<tr>
<td>Beep when long running Tcl commands (over 5 seconds) have completed execution</td>
<td>Enabling this option provides audible feedback (the default system beep/bell sound) upon completion of long-running commands.</td>
</tr>
</tbody>
</table>
Text Editors Preference Page

The Text Editors Preference Page sets the behavior and appearance of the text editor.

![Text Editors Preference Page Example](image)

**Figure 107: Text Editors Preference Page Example**
### Table 118: Text Editor Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo history size</td>
<td>200</td>
<td>Sets the number of undo events in the history queue.</td>
</tr>
<tr>
<td>Display tab width</td>
<td>4</td>
<td>Sets the editor tab width in spaces.</td>
</tr>
<tr>
<td>Insert spaces for tabs</td>
<td>Deselected</td>
<td>Enables insertion of spaces in place of tab characters.</td>
</tr>
<tr>
<td>Highlighting current line</td>
<td>Selected</td>
<td>Enables/disables the highlighting of the current line. The highlight color is set in Appearance color options.</td>
</tr>
<tr>
<td>Show print margin</td>
<td>Deselected</td>
<td>Selects whether the print margin is visible.</td>
</tr>
<tr>
<td>Print margin column</td>
<td>80</td>
<td>Sets the print margin column position.</td>
</tr>
<tr>
<td>Show line numbers</td>
<td>Selected</td>
<td>Enables/disables the display of line numbers in the Editor view.</td>
</tr>
<tr>
<td>Show range indicator</td>
<td>Selected</td>
<td>Enables the display of range indicators in the text editor.</td>
</tr>
<tr>
<td>Show whitespace characters</td>
<td>Deselected</td>
<td>Enables the display of whitespace characters (·) in text editors.</td>
</tr>
<tr>
<td>Show affordance in hover on how to make sticky</td>
<td>Selected</td>
<td>Enable the affordance (visual clue) in the hover text and make it sticky.</td>
</tr>
<tr>
<td>When mouse moved into hover</td>
<td>Enrich after delay</td>
<td>Sets the hover display mode.</td>
</tr>
<tr>
<td>Enable drag and drop of text</td>
<td>Selected</td>
<td>Enables/disables the ability to drag and drop selected text.</td>
</tr>
<tr>
<td>Warn before editing a derived file</td>
<td>Selected</td>
<td>Enables warning if a derived file is going to be edited.</td>
</tr>
<tr>
<td>Smart caret position at line start and end</td>
<td>Selected</td>
<td>Controls whether the editor automatically positions the caret and the start or end of a line.</td>
</tr>
<tr>
<td>Appearance color options</td>
<td>Various</td>
<td>Sets custom colors for various aspects of the text editor.</td>
</tr>
</tbody>
</table>
Quick Diff Preference Page

The Quick Diff Preference Page, enables the Quick Diff option and configures its appearance. The page is accessed via Text Editors → Quick Diff.

![Quick Diff Preference Page](image)

**Table 119: Quick Diff Preference Page**

<table>
<thead>
<tr>
<th>Option</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable quick diff</td>
<td>Selected</td>
<td>Enables/disables the quick diff option.</td>
</tr>
<tr>
<td>Show differences in overview</td>
<td>Deselected</td>
<td>Shows differences in the overview ruler.</td>
</tr>
<tr>
<td>Colors</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Changes</td>
<td>–</td>
<td>Sets the color used to indicate changes. (1)</td>
</tr>
<tr>
<td>Additions</td>
<td>–</td>
<td>Sets the color used to indicate additions. (1)</td>
</tr>
<tr>
<td>Deletions</td>
<td>–</td>
<td>Sets the color used to indicate deletions. (1)</td>
</tr>
</tbody>
</table>

**Use this reference source**

- **Version on Disk**: Current file is compared against the last saved version on disk.

(1) This option sets which reference to use as the base for generating quick diff comparisons.
Projects

Projects represent the collection of source netlist and constraints files, flow options, IP configuration files, and output files for a particular design.

Implementations

A Project (see page 217) may have multiple implementations. Each implementation contains the set of flow options (also called implementation options) configuring the run of that project through the Flow (see page 223), and the flow outputs for this particular configuration. With this capability, the same design (netlist) can be implemented (run through the flow) with different sets of timing constraints, placement and routing optimizations, or even different target devices, just by creating multiple implementations for the same project.

Each implementation is associated with an implementation directory located under the project directory (where the Project File (see page 218) is located). Implementation directories are named with the implementation name and contain flow output files. Output Files (see page 220) are divided into two sub-directories under the implementation directory: output and reports. The output directory contains files that are intended to be consumed by other tools later in the flow, such as netlists for simulation or the FPGA bitstream for programming. The reports directory contains files intended to be viewed and analyzed while running the ACE flow, such as timing reports and flow statistics.

Implementation definitions are not individually saved to their own files. Instead they are stored as part of the Project File (see page 218). In the GUI, project implementations can be browsed in the Projects View (see page 123). Selecting an implementation activates it and displays its implementation options in the Options View (see page 106).

When an implementation has been run through the flow, the state of the database (netlist, constraints, placement, and routing data) may be saved to an .acxdb file (see Saving Implementations (see page 279)). Implementations may later be restored from previously saved .acxdb files (see Restoring Implementations (see page 280)).

Implementation Options

There are a wide variety of configurable implementation options which alter how ACE processes that implementation of the design as it moves through the flow (see page 223). The most-commonly used option settings are displayed in the Options View (see page 106) for the current Active Project and Implementation (see page 223). Within the Options view, implementation options are grouped by flow steps (see page 223) to indicate which flow step the option affects. Changing the value of an option causes the current results of that flow step (if any) to become invalid or cleared, and that flow step (and all later flow steps) must be rerun, making use of the newly-changed option.

An Implementation Options Report (see page 242) of all available implementation options may be generated via the Tcl command report_impl_options (see page 596). This command may also be used to compare the current options configuration of an implementation with the default values for all options.

The values of implementation options may be set with the Tcl command set_impl_option (see page 619), or reset back to the default values with reset_impl_option (see page 600).

Option Sets

Because some implementation options have a large impact upon runtime, and because the QoR benefits of these implementation options may vary significantly by design (often a QoR gain, but sometimes a slight QoR loss), many of the performance-related implementation options are disabled by default for newly created projects and implementations.

<table>
<thead>
<tr>
<th>Option</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

Table Notes

1. The button to the right of the option allows changes to the display color (refer to “Changing Color Coding”).
Achronix QoR experts have compiled subsets of implementation options known to optimize a wide variety of design types based upon design details. These "option sets" are made available (with description) to users in the Multiprocess View (see page 86), and through that view, may be used to generate new implementations with the indicated implementation options enabled.

Each Option Set shown in the Multiprocess View consists of override values for a small subset of all the implementation options. These overriding values are applied to newly generated implementations over the existing implementation option values inherited from a user-selected template implementation.

It is worth repeating that the Option Sets do not contain a complete assignment of all the implementation options. Each Option Set only contains a small subset of option values, which override the implementation options inherited from the template implementation. The overriding implementation options in each set are subsets of the entire set of QoR oriented implementation options. They only change some of the implementation options, and all the rest of the values are inherited from the template implementation. The Option Sets only enable performance-related implementation options, and (currently) never disable any already-enabled implementation options. So each generated implementation starts with the exact same implementation options as the template implementation, and then just the few implementation options named in the Option Set description are overwritten with the described values.

Achronix broke up the Option Sets into small granular chunks because of QoR/runtime trade-offs. Some of the options have a large runtime cost, and on some designs, there is a minimal performance gain. Based upon the observed runtimes reported in the Multiprocess Summary Report (see page 240), hours of runtime may be saved while only losing 0.01% frequency by using one Option Set over another Option Set as a design is iterated.

It is expected that among all the Option Sets, at least one can be found that provides the necessary QoR gain for an acceptable runtime impact, allowing the fastest possible design iteration. See the Multiprocess View (see page 86) and Attempting Likely Optimizations Using Option Sets (see page 369) for more information.

**Project File**

Projects are persisted in .acxprj project files created automatically by the tool whenever a project is saved. A project file is actually just a Tcl script supporting only a defined subset of Tcl commands. Project files can be edited manually and then loaded into the tool to use as a script or for running regressions.

**Note**

Currently, the Option Set overrides only enable optimization-oriented implementation options, not disable them. Thus, if the implementation options in the template implementation are already the same values as those in the Option Set, the results from the two implementations (the implementation generated from the Option Set, and the template implementation) are identical.

When ACE loads a project file, it locks that file to prohibit other ACE sessions from loading the same file. This prevents project data corruption, which could occur if two sessions attempt to work with the same project at the same time.

In the GUI, loaded project file contents are displayed in a tree structure in the Projects View (see page 123). Project file contents may also be viewed in a Text Editor (see page 28) in the GUI by double-clicking the project name in the Projects view (example file contents follow):
Example Project file contents

# proj2
# AUTOMATICALLY GENERATED FILE
# MAY BE OVERWRITTEN AT ANY TIME DURING USE OF TOOL
# Netlist Files
add_project_netlist -project proj2 "C:/test_projects/proj2/top.vma"
# Constraint Files
add_project_constraints -project proj2 "C:/test_projects/proj2/clock_mode2.sdc"
add_project_constraints -project proj2 "C:/test_projects/proj2/clock_mode1.sdc"
# Implementations
# impl_1
create_impl -project proj2 impl_1
set_impl_option -project proj2 -impl impl_1 partname ACDevice1
set_impl_option -project proj2 -impl impl_1 speed_grade "standard"
set_impl_option -project proj2 -impl impl_1 core_voltage "1.00"
enable_project_constraints -project proj2 -impl impl_1 "C:/test_projects/proj2/clock_mode2.sdc"
disable_project_constraints -project proj2 -impl impl_1 "C:/test_projects/proj2/clock_mode1.sdc"
# impl_2
create_impl -project proj2 impl_2
set_impl_option -project proj2 -impl impl_2 partname ACDevice1
set_impl_option -project proj2 -impl impl_2 speed_grade "standard"
set_impl_option -project proj2 -impl impl_2 core_voltage "0.95"
enable_project_constraints -project proj2 -impl impl_2 "C:/test_projects/proj2/clock_mode2.sdc"
enable_project_constraints -project proj2 -impl impl_2 "C:/test_projects/proj2/clock_mode1.sdc"
# impl_3
create_impl -project proj2 impl_3
set_impl_option -project proj2 -impl impl_3 partname ACDevice1
set_impl_option -project proj2 -impl impl_3 speed_grade "standard"
set_impl_option -project proj2 -impl impl_3 core_voltage "0.95"
disable_project_constraints -project proj2 -impl impl_3 "C:/test_projects/proj2/clock_mode2.sdc"
disable_project_constraints -project proj2 -impl impl_3 "C:/test_projects/proj2/clock_mode1.sdc"
# End of file

Source Files

A project contains source files used as inputs to the ACE flow. There are two types of source files:

1. Synthesized netlist files
2. SDC/PDC/PRT constraints files

In the GUI, source files may be browsed in the Projects View (see page 123) and viewed in the built-in Text Editor (see page 28) by double clicking the file name in the Projects View.

The synthesized netlist files must be the gate-level Verilog output of the Synthesis tool and must use a `.v` or `.vma` file extension.

The constraints file types must be the gate-level Verilog output of the Synthesis tool and must use a `.sdc` or `.scf` file extension.

The constraints file types are defined in the following table.

### Table 120: Project Source File Types

<table>
<thead>
<tr>
<th>File Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.sdc, *.scf</td>
<td>Timing constraints files in SDC format. These files are read by the timer in ACE. All timing constraints must be placed in these files.</td>
</tr>
</tbody>
</table>
### File Type | Description
--- | ---
`.pdc` | Placement constraints files for ACE. ACE can support many functions in this type of file, including placement and insertion of boundary pins. No timing constraints can be placed in these files.

`.prt` | Partition definition file for incremental compile in ACE. There should be only one `.prt` file per project in ACE. This file is generated by Synplify and controls which partitions will be re-compiled in the next ACE run.

#### Note
All `.sdc`, `.scf`, and `.pdc` constraints files are read in and executed in the order specified in the ACE project file. Constraints files that are added to the project first are executed first, and likewise, constraints files which are added to the project last are executed last. If there is any order dependency between commands in your constraints, please make sure to add the constraints files in the correct order for execution in ACE.

### IP Configurations
ACE provides GUI support to ease configuration of the most complicated embedded IP in Achronix FPGAs. The data files used by the IP Configuration Editors (see page 27) (files with the `.acxip` extension) may optionally be associated with a project. When associated with a project, these IP Configuration files may then be browsed in the Projects view (see page 123) under the project IP folder, and the associated editor may be started by double clicking the file name in the Projects View.

For more details, see Creating an IP Configuration (see page 314), or one of the many IP Configuration Editors.

### Port Mapping Files
The I/O Designer I/O Pin Assignment View (see page 77) and I/O Core Pin Assignment View (see page 78) provide the option to remap port names from the values used in the IP editors to the name desired for use in the user RTL (top-level port list). This action creates an "alias" to be used in all files created when the Generate IORing Design Files button in the IO Designer is clicked (or similarly, calling the generate_ioring_design_files Tcl command).

These remapped names are placed in the `board.acxpm` (remapped pin ports) and `core.acxpm` (remapped core pin ports) files, stored in the project directory (the directory containing the `.acxprj` Project file (see page 218)). These files are later read when generating the design files and are not needed within the design/netlist, nor are they explicitly named in the `.acxprj` Project file (see page 218).

These are simple text files, with the contents automatically managed by the I/O Pin Assignment View (see page 77) and I/O Core Pin Assignment View (see page 78). Each line in the port mapping file contains a key/value pair, of the form:

`original_port_name=remapped_name_alias`

See Creating an IP Configuration (see page 314) for more details on handling IP configurations and the I/O Designer.

### Output Files
Output files are generated for project implementations (see page 217) by running certain steps in the Flow (see page 223). By default, output files are automatically written to the project implementation directory under the output or reports directory as appropriate. Alternate output locations can be specified when running individual flow steps (see page 223) with command line options.

In the GUI, output files can be browsed in the Projects view (see page 123) under their implementation and viewed in the editor area by double clicking the file name in the Projects view.
Log Files

A number of log files are automatically generated while ACE is running. They include the following:

- ACE Session Log
- Implementation Log
- Multiprocess Log
- SnapShot Log
- ACE GUI Log

The contents of these logs are typically the series of Tcl commands and resulting return values occurring during the execution of ACE. Achronix support may sometimes request one or more of these log files to assist in requested support efforts.

ACE Session Log

Every time ACE is started, a new ACE session log is created in the directory `<user_home_dir>/achronix/`. This file is named `ace_<date_timestamp>.log`, where `<date_timestamp>` is `<year>_<month>_<day>_<hour>_<minute>_<second>`, in 24-hour format. For example, if ACE was started in Linux with a username of `example_user`, on January 11th of 2023 at 2:34:56 PM, the complete log file name would be:

```
/home/example_user/.achronix/ace_2023_01_11_14_34_56.log
```

ACE session log messages are also sent to the Tcl Console View (see page 144). For more information, see Viewing the ACE Log File (see page 313).

Implementation Log

In addition to the session log, each project (see page 217) implementation (see page 217) has a log maintained for the complete life of the implementation. All changes to the implementation, including running the Flow (see page 223) for that implementation, are appended to the implementation log. This log is stored in the directory `<project_dir>/log/impl.log`.

Multiprocess Log

Unlike normal flow executions, implementation runs initiated from the Multiprocess View (see page 86) do not have their log information appended to the ACE Session Log. The reason is because multiple processes would be appending info to the log file simultaneously, leaving log entries interleaved in an unreadable mess. Instead, each implementation executed in the background creates a new log file named `multiprocessImpl.log` in the log directory for that implementation, overwriting any prior multiprocess log created for that implementation. Each implementation executed via the Multiprocess View does still append information to its lifetime implementation log file.

When running Multiprocess with an external job submission system (i.e., the example GridEngine default configuration), two additional log files may be created:

- The `jobExecution.log` contains a raw (unfiltered) copy of the implementation log for that multiprocess session, plus any additional info that the user custom job submission system might choose to inject. This file only exists if the (optional) job submission logging functionality is configured appropriately.

- The `jobScheduler.log` is only used during Multiprocess Batch Mode (see page 295) (when in GUI mode instead of batch mode, similar info is captured in the individual implementation feedback tabs within the Multiprocess View). This file captures the standard output and error streams from the job submission system itself. This log file is particularly useful when initially configuring ACE to work with the user job submission system as it captures submission configuration errors (such as typos in job queue names).
**Snapshot Log**

The Snapshot log file is discussed in Collecting Samples of the User Design (see page 355).

**ACE GUI Log**

On rare occasions, Achronix Support may request the ACE GUI Log. This log file may be found by selecting: Help → About Ace → Installation Details → Configuration → View Error Log, which opens the GUI log in a non-ACE text file editor or HTML browser. The editor/browser typically reports the full path of the opened file.
Active Project and Implementation

The active project is the project containing the active implementation in the current tool session. The active implementation is the project implementation on which flow and project management commands are operating. Only one implementation can be active at a time. The active state applies across all projects and only in the context of the current tool session. This state does not persist across sessions and is not saved in a project file.

In the ACE GUI, the active project name, active implementation name, and target device name are all shown on the ACE titlebar in the format “Project -> Implementation (Device)”. Additionally, within the Projects View (see page 123) tree, the active project and its active implementation are both shown in a bold font.

Flow

The flow is the set of steps that must be run to complete a design in ACE. These steps are listed, in order, within the Flow view (see page 67). The current Flow Mode implementation option (selected in the Options view (see page 106)) affects which Flow Steps may be executed.

A flow can only be run on a single project (see page 217), and within that project a single implementation (see page 217) at a time (these are the active project and implementation (see page 223)) during an interactive ACE session.

To run multiple implementations from the same project through the flow simultaneously, use the Multiprocess view (see page 86).

To run multiple separate projects through the flow simultaneously, multiple sessions of ACE must be run.

The flow can be customized by creating custom flow steps (see page 306).

Additional details may be found in the section, Running the Flow (see page 283).

- Flow Steps (see page 223)
  - Prepare Steps (see page 225)
  - Place and Route Steps (see page 225)
  - Design Completion Steps (see page 226)
  - FPGA Programming Steps (see page 227)
- Flow Status (see page 227)
- Flow Mode (see page 228)

Flow Steps

The Flow (see page 223) is composed of a series of flow steps, each representing a command operating on the design in the Active Project and Implementation (see page 223). Some flow steps are required (such as preparing the design), and some are optional (such as writing out a netlist for simulation). Flow steps are generally order-dependent, and running the steps out of order may result in errors.

The default order of flow steps is displayed in the ACE GUI Flow View (see page 67), with flow steps grouped into categories for organizational purposes.

The implementation option for Flow Mode (see page 228) (typically configured through the Options View (see page 106)) affects which flow steps can be executed.

**Table 121: Achronix Default Flow Steps and IDs**

<table>
<thead>
<tr>
<th>Name</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prepare</td>
<td>prepare</td>
</tr>
</tbody>
</table>
### ACE User Guide (UG070)

<table>
<thead>
<tr>
<th>Task</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Prepare</td>
<td>run_prepare</td>
</tr>
<tr>
<td>Run Estimated Timing Analysis</td>
<td>report_timing_prepared</td>
</tr>
<tr>
<td>Generate Pre-Placed Simulation Netlist</td>
<td>write_netlist_prepared</td>
</tr>
<tr>
<td><strong>Place and Route</strong></td>
<td>place_and_route</td>
</tr>
<tr>
<td>Run Place</td>
<td>run_place</td>
</tr>
<tr>
<td>Run Post-Placement Timing Analysis</td>
<td>report_timing_placed</td>
</tr>
<tr>
<td>Run Route</td>
<td>run_route</td>
</tr>
<tr>
<td>Run Post-Route Timing Analysis</td>
<td>report_timing_routed</td>
</tr>
<tr>
<td><strong>Design Completion</strong></td>
<td>design_completion</td>
</tr>
<tr>
<td>Post-Process Design</td>
<td>post_process</td>
</tr>
<tr>
<td>Run Final DRC Checks</td>
<td>final_drc_checks</td>
</tr>
<tr>
<td>Run Sign-off Timing Analysis</td>
<td>report_timing_final</td>
</tr>
<tr>
<td>Generate Final Reports</td>
<td>write_reports_final</td>
</tr>
<tr>
<td>Generate Final Simulation Netlist</td>
<td>write_netlist_final</td>
</tr>
<tr>
<td><strong>FPGA Programming</strong></td>
<td>fpga_program</td>
</tr>
<tr>
<td>Generate Bitstream</td>
<td>write_bitstream</td>
</tr>
<tr>
<td>FPGA Download</td>
<td>fpga_download</td>
</tr>
</tbody>
</table>

### Table Notes

- All flow step IDs can be executed at the ACE GUI Tcl console (see Tcl Console View (see page 144)) or as part of the user Tcl script that can be invoked when running ACE (see page 262) in batch mode. The following Tcl command allows executing the various flow steps IDs listed:
  
  ```tcl
  run [-step <string>] [-stop_at_step <string>] [-resume] [-ic <string>]
  ```

- Because advanced users are allowed to create their own flow steps (create_flow_step (see page 558)), this list may be a subset of the flow steps available to users. To see a complete list of current flow step IDs, use the Tcl command get_flow_steps (see page 576).
Prepare Steps

Run Prepare

The first flow step required for any design is Run Prepare. This step (in order):

1. Clears all previously loaded netlists and constraints.
2. Loads and compiles the device.
3. Loads all the design files for the active implementation into ACE.
4. Runs design checks.
5. Transmutes the design into an Achronix design.

The active project is saved to disk automatically when this step is successfully completed. In addition, this step automatically generates a pin assignment and an utilization report.

When the active implementation is prepared, the design is ready to be placed or analyzed for timing results. An encrypted Verilog netlist can also be generated for the prepared implementation for simulation. I/O pre-placement can also be performed when the design is prepared (see Pre-Placing a Design (see page 326)).

This flow step has the id run_prepare for Tcl commands.

Run Estimated Timing Analysis (Optional)

After Run Prepare has successfully completed on an implementation, the Run Estimated Timing Analysis step can be run. This step generates and writes a pre-place-and-route timing report file for the prepared design. The generated report is automatically displayed in the editor area upon successful completion. This step is run by default when Run Flow is executed.

This flow step has the id report_timing_prepared for Tcl commands.

Generate Pre-Placed Simulation Netlist (Optional)

After Run Prepare has successfully completed on an implementation, the Generate Pre-Placed Simulation Netlist step can be run. This step generates and writes an encrypted, pre-place-and-route Verilog netlist file from the prepared design. This netlist may be used to simulate the prepared design. This step is not run by default when Run Flow is executed.

This flow step has the id write_netlist_prepared for Tcl commands.

Place and Route Steps

Run Place

After Run Prepare has successfully completed on an implementation, the Run Place step must be run in order to place the design. If place and route has already been run on this implementation, this step may be skipped, and the place and route data from the previous run may be loaded by using the File → Load Place and Route Data menu option. When the design is successfully placed, the encrypted placement data is stored to disk and is ready to be loaded again later.

This flow step has the id run_place for Tcl commands.
Run Post-Placement Timing Analysis (Optional)

After Run Place has successfully completed on an implementation, the Run Post-Placement Timing Analysis step can be run. This step generates and writes a timing report file for the placed design, without requiring all final DRC checks to pass. The generated report is automatically displayed in the editor area upon successful completion. This step is not run by default when Run Flow is executed.

This flow step has the id report_timing_placed for Tcl commands.

Run Route

After Run Place has successfully completed on an implementation, the Run Route step must be run in order to route the design. If place and route has already been run on this implementation, this step may be skipped, and the place and route data from the previous run may be loaded by using the File → Load Place and Route Data menu option. When the design is successfully routed, the encrypted placement data is stored to disk and is ready to be loaded again later.

This flow step has the id run_route for Tcl commands.

Run Post-Route Timing Analysis (Optional)

After Run Place and Run Route have successfully completed on an implementation, the Run Post-Route Timing Analysis step can be run. This step generates and writes a timing report file for the placed and routed design, without requiring all final DRC checks to pass. The generated report is automatically displayed in the editor area upon successful completion. This step is not run by default when Run Flow is executed.

This flow step has the id report_timing_routed for Tcl commands.

Design Completion Steps

Caution!

All Flow Steps (see page 223) under the Design Completion category are skipped by default when the flow mode is set to Evaluation. See Flow Mode (see page 228) for more details.

Post-Process Design

After Run Place and Run Route have successfully completed (or a .acxdb file containing place and route data has been loaded) on an implementation, the Post-Process Design step must be run. This step post-processes the design by inserting Achronix-specific technology (such as reset, compensation block, and vmode insertion) that relies on final placement and routing information. This step should not affect timing results.

This flow step has the id post_process for Tcl commands.

Run Final DRC Checks

After Post-Process Design has successfully completed on an implementation, the Run Final DRC Checks step must be run. This step performs all final DRC checks in order to ensure that the bitstream, final timing, and final simulation netlist can be generated without errors. If a design fails final DRC checks, a Post-Route timing report can still be generated for experimental purposes. However, no bitstream may be generated to run the design on the hardware unless all final DRC checks pass.

This flow step has the id final_drc_checks for Tcl commands.
Run Sign-off Timing Analysis (Optional)

After Run Final DRC Checks has successfully completed on an implementation, the Run Sign-Off Timing Analysis step can be run. This step generates and writes a final sign-off timing report file for the placed and routed design, after all final DRC checks have passed. The generated report is automatically displayed in the editor area upon successful completion. This step is run by default when Run Flow is executed.

This flow step has the id report_timing_final for Tcl commands.

Generate Final Reports (Optional)

After Run Final DRC Checks has successfully completed on an implementation, the Generate Final Reports step can be run. This step generates various report files, including clocks, pins, power, etc. Implementation options are used to control which report files are generated. The generated report is automatically displayed in the editor area upon successful completion. This step is run by default when Run Flow is executed.

This flow step has the id write_reports_final for Tcl commands.

Generate Final Simulation Netlist (Optional)

After Run Final DRC Checks has successfully completed on an implementation, the Generate Final Simulation Netlist step can be run. This step generates and writes an encrypted, post-place-and-route Verilog simulation netlist file from the final DRC-free design. This netlist may be used to simulate the post-place-and-route design. This step is not run by default when Run Flow is executed.

This flow step has the id write_netlist_final for Tcl commands.

FPGA Programming Steps

Caution!

The Generate Bitstream flow step fails if attempted in Evaluation flow mode. Additionally, all Flow Steps (see page 223) under the FPGA Programming category are skipped by default when the flow mode is set to Evaluation. See Flow Mode (see page 228) for more details.

Generate Bitstream

After a design is placed and routed, the Generate Bitstream step can be run. This step generates a bitstream (*.hex file) for the current implementation based on the settings in the Options view (see page 106) (see the Options settings for Bitstream Generation). This step is run by default when Run Flow is executed. The flow mode must be set to Normal (or Strict) before bitstream generation can complete successfully (while it typically produces much shorter flow runtimes, the Evaluation flow mode relaxes the DRCs too much to produce a reliable bitstream).

This flow step has the id write_bitstream for Tcl commands.

FPGA Download

After the bitstream is generated, it is ready for downloading to the FPGA via either the Achronix Bitporter 2 pod or an FTDI FT232H (or FT4232H) device as specified under the Options view settings (see the Options settings for FPGA Download). This step is not run by default when Run Flow is executed.

This flow step has the id fpga_download for Tcl commands.

A bitstream can also be downloaded to the FPGA via the Download view (see page 55) (see Programming a Device (see page 367))

For more details, refer to the JTAG Configuration User Guide (UG004).
Flow Status

Flow Steps (see page 223) each have a status associated with them. The current status of each flow step for the Active Project and Implementation (see page 223) can be seen in the GUI in the Flow View (see page 67).

Each step can be in one of the following flow states:

**Table 122: Flow State Icons**

<table>
<thead>
<tr>
<th>State</th>
<th>Flow Category</th>
<th>Flow Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incomplete</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Running</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Complete</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Disabled</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Error</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Complete (but out of sync with source files)</td>
<td></td>
<td>![Icon]</td>
</tr>
</tbody>
</table>

Be aware that changing or Configuring Implementation Options (see page 281) which affect a flow step can cause the status of a flow step to be reset back to Incomplete.

See the concepts for the Flow (see page 223) and Flow View (see page 67), as well as the task for Running the Flow (see page 283) for more details.

Flow Mode

The flow mode is managed as an Implementation (see page 217) Option, typically through the Options View (see page 106).

The chosen flow mode determines which DRCs are executed at different points in the Flow (see page 223), and in some configurations prohibit the final Flow Steps (see page 223) from executing successfully.

- **Evaluation** – this mode ignores non-fatal DRCs as long as possible, allows IO Virtualization, and ignores missing SDC constraints to get a post-route timing report quickly. This mode allows iterating more quickly during preliminary or early design stages.

- **Normal** – this flow mode enforces all DRC checks prior to generating a bitstream. Some checks are flagged as warnings early on in the flow to provide an opportunity to correct the problems (i.e., fixing the placement of I/Os). These same checks may change to report an error during final DRC checks. This mode should be used when developing a real design for a product, and enables bitstream generation.

- **Strict** – this mode is similar to Normal flow mode, but to reduce runtime, strictly enforces all DRC checks, erroring out as early in the flow as possible. This more restrictive mode should be used during the later, more mature design iterations.

When in Evaluation flow mode, the Run Flow and Re-run Flow actions in the Flow View (see page 67) stop after the Place and Route flow step category is completed. By default, the flows steps under Design Completion and FPGA Programming are not run unless the implementation is in Normal or Strict flow mode.
1. Note
   The **Generate Bitstream** flow step fails if attempted while in **Evaluation** flow mode. Bitstream generation requires **Normal** or **Strict** flow mode, so that ACE may ensure all DRCs have passed.

Some examples of error checks in **Strict** flow mode, applicable to Speedcore devices, are as follows:

1. If any Speedcore boundary pins (IPIN/OPIN/CLK_IPIN/CLK_OPIN) are not explicitly instantiated in the user design RTL or PDC files, ACE errors out in the Run Prepare flow step.

2. If any Speedcore boundary pins (IPIN/OPIN/CLK_IPIN/CLK_OPIN) are not explicitly placed with “fixed” placement in the project PDC files, ACE errors out at the beginning of the Run Place flow step.

In other flow modes, these checks do not happen until Final DRC Checks prior to bitstream generation.

**Reports**

ACE generates a number of reports to provide information on how user designs are being handled in the selected Achronix device. These reports are meant to assist in making design decisions.

Each of the listed reports is generated in HTML format by default, and with the noted Tcl command, each report can optionally (unless otherwise noted) be generated in plain text format, or in CSV format for easy import into spreadsheet programs. As soon as the reports are generated, they are opened for viewing within the ACE Editor area.

**Utilization Report**

The Utilization Report shows a summary and details of the utilization of the device resources for the current design. This report is automatically generated as part of the **Run Prepare** flow step (see page 223).

To generate this report manually, see the `report_utilization` Tcl command.

**Pin Assignment Report**

The Pin Assignment Report shows detailed information on each of the user design top-level ports, including placement and configuration details.

Typically, the report is automatically generated by the **Flow** (see page 223) at multiple stages (as part of the **Run Prepare**, **Run Place**, and **Post-Process Design** flow steps (see page 223)).

To generate this report manually, see the `report_pins` Tcl command.

**Clock Report**

The Clock Report shows all clocks used in the design, their frequencies/periods, their relationships, and their constraints. Related information regarding device Clock Regions is also included in the report.

The report is automatically generated by the **Flow** (see page 223) at multiple stages of the flow.

To generate this report manually, see the `report_clocks` Tcl command.

**Timing Report**

The Timing Report provides details on how well the current design is meeting timing on the selected device.

Timing analysis can be performed at several stages in the **Flow** (see page 223), each stage generating a different report. If the design has not yet been routed, placement and/or routing are estimated.

This report is automatically generated by the flow during any of the **Run … Timing Analysis** Flow Steps (see page 223).
To generate this report manually, see the `run_timing_analysis` Tcl command.

If **Timing Across All Temperature Corners** (see page 248) is enabled, a separate timing report is generated for each temperature corner, with the file name of the report noting the corner being reported.

**Report Content**

The report contains a Summary section and a Details section.

The Summary section contains three tables. There is a table for Critical Setup (max) Timing Paths, one for Critical Hold (min) Timing Paths, and one for the resulting Clock Frequencies. Each summary section table contains a single row for each Clock/Group, showing the most critical path for that Clock/Group.

The Details section contains a configurable maximum number of critical setup paths and critical hold paths for each Clock/Group, and each of those critical paths includes a configurable maximum number of worst paths for the critical path endpoint.

The number of critical paths and worst paths are **Implementation Options** (see page 217) configured in the **Options View** (see page 106) under "Timing Analysis".

**Routing Report**

The Routing Report collects a number of routing-related statistics and any related errors into an easily readable report format.

This report is automatically generated by the **Flow** (see page 223) during the **Run Route** and **Post-Process Design** flow steps (see page 223).

To generate this report manually, see the `report_routing` Tcl command.

**Partitions Report**

The Partitions Report collects a number of partition-related statistics into an easily readable report format.

This report is automatically generated by the **Flow** (see page 223) (and opened in the GUI) during the **Run Prepare** flow step (see page 223) when **Using Incremental Compilation (Partitions)** (see page 380).

To generate this report manually, see the `report_partitions` Tcl command.

**Power Dissipation Report**

The Power Dissipation report shows an estimate for the amount of power, in Watts, dissipated by the current design on the selected Achronix device under normal operating conditions. This report is typically generated after place-and-route, and therefore includes the effects of all transistor and wiring parasitics in the power calculation. This is in contrast to the Speedster7t Power Estimator and Speedcore Power Estimator tools, which are used early in the design process, prior to actual design activity.

Total power dissipation is reported so that thermal requirements can be estimated for the user design. Total power is also broken down into several different categories, such as power dissipated for each power rail, for each cell type, and instance power vs. interconnect power. Therefore the report can also be used for the design and sizing of the power supplies, and the selection of hard IP blocks such as DDR4 vs. GDDR6.

This User Guide provides an example power dissipation report, with an explanation of each section of the report, as well as detailed information about how power dissipation is calculated, and how to generate the report.

**Example Power Dissipation Report**

The Power Dissipation Report consists of eight sections, each of which presents the power dissipation from a different perspective.

- Report Header
• Power Summary
• Hard IP Power
• Dynamic Power Per Cell
• Power Per Rail
• Core Dynamic Power Details
• Core Dynamic Instance Power Details
• Core Dynamic Interconnect Power Details section

The following describes each section in more detail.

**Section: Report Header**

This section, common to all ACE reports, provides information about how and when the report was generated. It can be seen that the design name is `pcie_gddr6_ddr4_vp_demo_top`, which is a VectorPath® card demonstration design that configures the PCIe, GDDR6, and DDR4 interfaces. The operating conditions assumed for this report can also be seen: C2 speed grade, 0.85 volts, and 0 degrees Celsius.

**Power Dissipation Report**

ACE – Achronix CAD Environment – Version 9.2 – Build 463545 – Date 2023-09-20 15:15
Design: pcie_gddr6_ddr4_vp_demo_top - impl_1 - pcie_gddr6_ddr4_vp_demo_top
Device: AC701500ES0
Generated on Wed Sep 20 15:28:29 PDT 2023
Host: bob.achronix.local

**Disclaimer**

This is an estimation, based on the design characteristics and frequencies specified below. Power consumption is reported as worst case across all operating modes, including bitstream programming and user mode. Actual power results may vary from the estimates.

Operating conditions: C2, 0 deg. C, 0.85 V (Core), Fast Corner

**Figure 109: Example of Power Dissipation Report Header Section**

**Section: Power Summary**

This section reports the total power dissipation, which is about 82 Watts in the example design, and then breaks that total down into four major sub-categories:

• The relative contributions of dynamic (switching) vs. static (leakage) power to the total
• The relative contributions of core (programmable) logic power vs. hardened IP power, both static and dynamic
• The relative contributions of instance vs. interconnect power in the programmable core, not including clock power
• Dynamic clock network power, which includes clock interconnect and clock instances, such as clock gates, clock dividers, and clock switches
**Power Summary**

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Power:</td>
<td>81.7951 W</td>
</tr>
<tr>
<td>Total Dynamic Power:</td>
<td>63.5311 W</td>
</tr>
<tr>
<td>Total Static Power:</td>
<td>18.2640 W</td>
</tr>
<tr>
<td>Core Dynamic Power:</td>
<td>0.7087 W</td>
</tr>
<tr>
<td>Core Static Power:</td>
<td>1.5786 W</td>
</tr>
<tr>
<td>Hard IP Dynamic Power:</td>
<td>62.8223 W</td>
</tr>
<tr>
<td>Hard IP Static Power:</td>
<td>16.6854 W</td>
</tr>
<tr>
<td>Dynamic Instance Power:</td>
<td>0.5354 W</td>
</tr>
<tr>
<td>Dynamic Interconnect Power:</td>
<td>0.0848 W</td>
</tr>
<tr>
<td>Dynamic Clock Network Power:</td>
<td>0.0885 W</td>
</tr>
</tbody>
</table>

*Figure 110: Example of Power Dissipation Report Power Summary Section*

**Section: Hard IP Power**

This section reports details of the power contributed by each hard IP block in the design. The example design contains many of the available hard IP blocks, so the report contains many rows. For example, it can be seen that more than half of the total power dissipation in the design, which contains very little core logic, is used by the GDDR6 controller.

In order to include the power contribution of hard IP blocks, those IPs must have been configured in the IP Configuration editors (see page 314), and the associated IP Configuration Files (see page 220) must be included in their ACE project.
This section reports details of the dynamic power contributed by instances of each cell type, such as Reconfigurable Logic Blocks (LUT6s, DFFs, MUXes and ALUs), Block RAMs, Network Access Points, etc. This design contains very little programmable core logic, so these numbers are quite small relative to the Hard IPs.

**Dynamic Power Per Cell**

<table>
<thead>
<tr>
<th>Component</th>
<th>Power (W)</th>
</tr>
</thead>
<tbody>
<tr>
<td>RLB Power</td>
<td>0.0062 W</td>
</tr>
<tr>
<td>BRAM Power</td>
<td>0.0026 W</td>
</tr>
<tr>
<td>LRAM Power</td>
<td>0.0016 W</td>
</tr>
<tr>
<td>MLP Power</td>
<td>0.0000 W</td>
</tr>
<tr>
<td>NAP Power</td>
<td>0.5250 W</td>
</tr>
<tr>
<td>Hard IP Power</td>
<td>85.8727 W</td>
</tr>
<tr>
<td>Other Power</td>
<td>0.0000 W</td>
</tr>
</tbody>
</table>
**Section: Power Per Rail**

This section reports the power dissipation for each power rail in the design (rows), breaking it down into categories (columns) such as dynamic vs. static power, and core logic vs. hard IPs. For example, the VDDL power rail represents the programmable logic core of the design, and it contributes all of the core static and dynamic power. The rest of the power rails are used exclusively by the hard IPs.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CLKO_NE_VDDIO</td>
<td>0.4124</td>
<td>0.3592</td>
<td>0.0532</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.3592</td>
<td>0.0532</td>
</tr>
<tr>
<td>CLKO_NW_VDDIO</td>
<td>0.4124</td>
<td>0.3592</td>
<td>0.0532</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.3592</td>
<td>0.0532</td>
</tr>
<tr>
<td>CLKO_SE_VDDIO</td>
<td>0.4124</td>
<td>0.3592</td>
<td>0.0532</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.3592</td>
<td>0.0532</td>
</tr>
<tr>
<td>CLKO_SW_VDDIO</td>
<td>0.4124</td>
<td>0.3592</td>
<td>0.0532</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.3592</td>
<td>0.0532</td>
</tr>
<tr>
<td>DDR4_SD_0A</td>
<td>0.0129</td>
<td>0.0108</td>
<td>0.0021</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0108</td>
<td>0.0021</td>
</tr>
<tr>
<td>DDR4_SD_VDDQ</td>
<td>0.7491</td>
<td>0.7098</td>
<td>0.0393</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.7098</td>
<td>0.0393</td>
</tr>
<tr>
<td>FCU_VDDIO</td>
<td>0.8452</td>
<td>0.1690</td>
<td>0.6762</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.6762</td>
<td>0.0000</td>
</tr>
<tr>
<td>GCS_NE_PULL_VDDA</td>
<td>0.0120</td>
<td>0.0015</td>
<td>0.0105</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0105</td>
<td>0.0105</td>
</tr>
<tr>
<td>GCS_NW_PULL_VDDA</td>
<td>0.0120</td>
<td>0.0015</td>
<td>0.0105</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0105</td>
<td>0.0105</td>
</tr>
<tr>
<td>GCS_SE_PULL_VDDA</td>
<td>0.0120</td>
<td>0.0015</td>
<td>0.0105</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0105</td>
<td>0.0105</td>
</tr>
<tr>
<td>GCS_SW_PULL_VDDA</td>
<td>0.0166</td>
<td>0.0061</td>
<td>0.0105</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0105</td>
<td>0.0105</td>
</tr>
<tr>
<td>DDR8_E_VDDQ</td>
<td>8.4480</td>
<td>8.1413</td>
<td>0.3067</td>
<td>0.0000</td>
<td>0.0000</td>
<td>8.1413</td>
<td>0.3067</td>
</tr>
<tr>
<td>DDR8_E_VDDP</td>
<td>4.3530</td>
<td>4.2197</td>
<td>0.1453</td>
<td>0.0000</td>
<td>0.0000</td>
<td>4.2197</td>
<td>0.1453</td>
</tr>
<tr>
<td>DDR8_E_VDQR</td>
<td>3.3330</td>
<td>2.8442</td>
<td>0.4858</td>
<td>0.0000</td>
<td>0.0000</td>
<td>2.8442</td>
<td>0.4858</td>
</tr>
<tr>
<td>DDR8_W_VDDQ</td>
<td>8.4480</td>
<td>8.1413</td>
<td>0.3067</td>
<td>0.0000</td>
<td>0.0000</td>
<td>8.1413</td>
<td>0.3067</td>
</tr>
<tr>
<td>DDR8_W_VDDP</td>
<td>4.3530</td>
<td>4.2197</td>
<td>0.1453</td>
<td>0.0000</td>
<td>0.0000</td>
<td>4.2197</td>
<td>0.1453</td>
</tr>
<tr>
<td>DDR8_W_VDQR</td>
<td>3.3330</td>
<td>2.8442</td>
<td>0.4858</td>
<td>0.0000</td>
<td>0.0000</td>
<td>2.8442</td>
<td>0.4858</td>
</tr>
<tr>
<td>GPO1_N1_VDDIO</td>
<td>0.4905</td>
<td>0.4888</td>
<td>0.0017</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.4888</td>
<td>0.0017</td>
</tr>
<tr>
<td>GPO1_N2_VDDIO</td>
<td>0.3250</td>
<td>0.3234</td>
<td>0.0017</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.3234</td>
<td>0.0017</td>
</tr>
<tr>
<td>SDRS_N_PA_VDDH</td>
<td>5.9022</td>
<td>0.9466</td>
<td>5.0466</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.9466</td>
<td>5.0466</td>
</tr>
<tr>
<td>SDRS_N_PA_VDDL</td>
<td>7.7171</td>
<td>0.7401</td>
<td>6.4369</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.7401</td>
<td>6.4369</td>
</tr>
<tr>
<td>TS_VDDA</td>
<td>0.0004</td>
<td>0.0001</td>
<td>0.0004</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0001</td>
<td>0.0004</td>
</tr>
<tr>
<td>VCC</td>
<td>26.8372</td>
<td>19.7863</td>
<td>1.0509</td>
<td>0.0000</td>
<td>0.0000</td>
<td>19.7863</td>
<td>1.0509</td>
</tr>
<tr>
<td>VDDL</td>
<td>2.2874</td>
<td>0.7087</td>
<td>1.5786</td>
<td>0.7087</td>
<td>0.0000</td>
<td>1.5786</td>
<td>0.0000</td>
</tr>
</tbody>
</table>

**Figure 113: Example of Power Dissipation Report Power Per Rail Section**

**Section: Core Dynamic Power Details**

This section reports the programmable core dynamic power by power rail and clock domain (rows), breaking it down into categories (columns) for non-clock instance power, non-clock interconnect power, and clock instance and interconnect power.

**Core Dynamic Power Details**

<table>
<thead>
<tr>
<th>Power Rail</th>
<th>Clock</th>
<th>Frequency (MHz)</th>
<th>Total Dynamic Power (W)</th>
<th>Instance Power (W)</th>
<th>Interconnect Power (W)</th>
<th>Clock Power (W)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VDDL</td>
<td>l_nap_cik</td>
<td>499.88</td>
<td>0.2035</td>
<td>0.1447</td>
<td>0.0252</td>
<td>0.0336</td>
</tr>
<tr>
<td>VDDL</td>
<td>l_reg_cik</td>
<td>249.94</td>
<td>0.4460</td>
<td>0.3530</td>
<td>0.0464</td>
<td>0.0466</td>
</tr>
<tr>
<td>VDDL</td>
<td>l_therm_cik</td>
<td>124.97</td>
<td>0.0575</td>
<td>0.0376</td>
<td>0.0127</td>
<td>0.0072</td>
</tr>
<tr>
<td>VDDL</td>
<td>tclk</td>
<td>25.00</td>
<td>0.0015</td>
<td>0.0001</td>
<td>0.0004</td>
<td>0.0011</td>
</tr>
<tr>
<td>VDDL</td>
<td>v_acclc_GPIO_H_IOB1_1_GB_GEN_CLK</td>
<td>10.00</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
</tr>
<tr>
<td>VDDL</td>
<td>Combinational</td>
<td>-----</td>
<td>0.0001</td>
<td>0.0000</td>
<td>0.0001</td>
<td>0.0000</td>
</tr>
</tbody>
</table>

**Figure 114: Example of Power Dissipation Report Core Dynamic Power Details Section**
Section: Per-Tile Core Dynamic Instance Power Details

This section reports the programmable core dynamic instance power by power rail and clock domain (rows), breaking it down into categories (columns) for each type of logic tile, such as clock tiles, boundary IO pin tiles, Machine Learning Processor (MLP) tiles, 2D Network on Chip (NoC) tiles, and Reconfigurable Logic Block (RLBs) tiles.

<table>
<thead>
<tr>
<th>Power Rail</th>
<th>Clock</th>
<th>Frequency (MHz)</th>
<th>Total Instance Power (W)</th>
<th>Clock Power (W)</th>
<th>IO Pin Power (W)</th>
<th>MLP Power (W)</th>
<th>NOC Power (W)</th>
<th>RLB Power (W)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VDDL</td>
<td>l_nap_clk</td>
<td>499.88</td>
<td>0.1447</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0016</td>
<td>0.1416</td>
<td>0.0016</td>
</tr>
<tr>
<td>VDDL</td>
<td>l_reg_clk</td>
<td>249.94</td>
<td>0.3530</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0016</td>
<td>0.3480</td>
<td>0.0034</td>
</tr>
<tr>
<td>VDDL</td>
<td>l_adm_clk</td>
<td>124.97</td>
<td>0.0376</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0011</td>
<td>0.0354</td>
<td>0.0012</td>
</tr>
<tr>
<td>VDDL</td>
<td>tk</td>
<td>25.00</td>
<td>0.0001</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
</tr>
<tr>
<td>VDDL</td>
<td>v_axi_s_exchange_GPIIO_H_IQBILL_GLB_SER_GEN_CLK</td>
<td>10.00</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
</tr>
<tr>
<td>VDDL</td>
<td>Combinational</td>
<td>----</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
</tr>
</tbody>
</table>

Figure 115: Example of Power Dissipation Report Per-Tile Core Dynamic Instance Power Details Section

Section: Per-Tile Core Dynamic Interconnect Power Details

This section reports the programmable core dynamic interconnect power by power rail and clock domain (rows), breaking it down into categories (columns) for each type of logic tile, such as clock tiles, boundary IO pin tiles, Machine Learning Processor (MLP) tiles, 2D Network on Chip (NoC) tiles, and Reconfigurable Logic Block (RLBs) tiles. Interconnect power includes the actual routing wires, as well as the statically programmable FPGA routing MUXes used to connect different wire segments to form a complete route.

<table>
<thead>
<tr>
<th>Power Rail</th>
<th>Clock</th>
<th>Frequency (MHz)</th>
<th>Total Interconnect Power (W)</th>
<th>Clock Power (W)</th>
<th>IO Pin Power (W)</th>
<th>MLP Power (W)</th>
<th>NOC Power (W)</th>
<th>RLB Power (W)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VDDL</td>
<td>l_nap_clk</td>
<td>499.88</td>
<td>0.0252</td>
<td>0.0194</td>
<td>0.0000</td>
<td>0.0017</td>
<td>0.0012</td>
<td>0.0396</td>
</tr>
<tr>
<td>VDDL</td>
<td>l_reg_clk</td>
<td>249.94</td>
<td>0.0464</td>
<td>0.0256</td>
<td>0.0000</td>
<td>0.0077</td>
<td>0.0035</td>
<td>0.0563</td>
</tr>
<tr>
<td>VDDL</td>
<td>l_adm_clk</td>
<td>124.97</td>
<td>0.0127</td>
<td>0.0027</td>
<td>0.0000</td>
<td>0.0010</td>
<td>0.0003</td>
<td>0.0158</td>
</tr>
<tr>
<td>VDDL</td>
<td>tk</td>
<td>25.00</td>
<td>0.0004</td>
<td>0.0007</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0007</td>
</tr>
<tr>
<td>VDDL</td>
<td>Combinational</td>
<td>----</td>
<td>0.0001</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0001</td>
</tr>
</tbody>
</table>

Figure 116: Example of Power Dissipation Report Per-Tile Core Dynamic Interconnect Power Details Section
Power Calculation Methodology

Power dissipation is calculated using the following basic equation:

\[
\text{power}_{\text{total}} = \sum_{\text{nets}} (\text{energy}_{\text{net}} \times \text{frequency}_{\text{net}} \times \text{activity}_{\text{net}})
\]

Here total power is summed up over the individual contribution of every net in the design, including nets internal to logic gates and hard IP blocks. Power for each net is calculated as the product of the total energy dissipated in each zero-to-one or one-to-zero transition, measured in units of joules, which is derived from extracted layout data and present in the technology library being used; the target frequency of that net clock domain, measured in units of 1/seconds; and a unitless quantity called activity, which is defined as the average number of transitions per clock cycle.

Activity can be larger than one if a net experiences a lot of glitching. The activity factor for clock nets is, by definition, 2.0, since there are two transitions per cycle. ACE typically uses a default value of 0.125 for the activity value of non-clock nets. This value reflects an assumption that non-clock nets switch, on average, about once every eight clock cycles. This has been shown to be a reasonable assumption across a wide variety of designs, but it is, of course, only an approximation and not always correct.

In order to produce the most accurate power report possible, per-net activity values can be specified in a Switching Activity Interchange Format (SAIF) file. SAIF files are typically produced by a gate-level logic simulator. However, if necessary, the file can be written by hand. The accuracy of the activity values in a SAIF file depend on the quality of the simulation testbench, and are only reflective of the operating mode(s) exercised in that testbench. See the section How to Generate a Simulation-Driven Power Dissipation Report (see page 236) below for more information.

How to Generate the Power Dissipation Report

This report is generated automatically when running the ACE Flow (see page 223) as part of the write_reports_final flow step. However, it is not generated by default. The report_power implementation option (see page 281) must be set to "1" in the project before running the write_reports_final flow step.

This report can also be generated on-demand by restoring the routed implementation (see page 280) and then calling the report_power (see page 598) Tcl command.

As power dissipation varies across different process corners and operating conditions, a separate power dissipation report is generated for each temperature corner, with the file name of the report noting the corner being reported. See the page Timing Across All Temperature Corners (see page 248) for more information.

The Power Dissipation Report can optionally include the contribution of hard IP blocks, such as the PCIe controller and the 2D Network on Chip. In order to include those contributions (which can often dominate the contribution of the programmable logic), those hard IP blocks must have been configured in the IP Configuration editors (see page 314), and also have included the associated IP Configuration Files (see page 220) in the ACE project.

How to Generate a Simulation-Driven Power Dissipation Report

As discussed above in the Power Calculation Methodology section, per-net activity values can be specified in a text file called a Switching Activity Interchange Format (SAIF) file. SAIF files are typically produced by a gate-level logic simulator such as Synopsys VCS, Cadence Incisive, Siemens QuestaSim, or Aldec Riviera. This section covers the format of a SAIF file, how to use a SAIF file in ACE, and how to generate a SAIF file in the VCS and QuestaSim simulators. The documentation for your simulator of choice should be consulted for definitive instructions.
**Format of a SAIF File**

SAIF files are written in a clear-text format defined in IEEE Standard 1801-2009 (see https://ieeexplore.ieee.org/document/8686430). Therefore, if desired, small SAIF files can be generated by hand or with a script. The standard defines both backward and forward SAIF file formats. Here we are using a backward SAIF file which is intended for back-annotation into EDA tools. Below is an example of a complete SAIF file that is accepted by ACE.

**Sample SAIF File**

```plaintext
(SAIFILE
  (SAIFVERSION "2.0")
  (DIRECTION "backward")
  (DURATION 5950100.00)
  (INSTANCE tb_test1
    (INSTANCE DUT
      (NET
        (ina[0]
          (T0 3750100) (T1 2200000) (TX 0)
          (TC 22) (IG 0)
        )
        (clk
          (T0 3000100) (T1 2950000) (TX 0)
          (TC 118) (IG 0)
        )
      )
    )
  )
)
```

The file must:

1. Begin with the **SAIFILE** keyword.
2. Give the version number.
3. Specify that it is a backward SAIF file.
4. Give the duration of the simulation as the number of verilog timesteps.

Most important are the **INSTANCE** and **NET** sections of the file. It can be seen that this design has two levels of hierarchy. The instance **tb_test1** is the testbench containing behavioral verilog that applies test vectors to the device under test. The instance **DUT** is the Device Under Test, which is an instance of the top level design being compiled in ACE. The design contains two nets, an input net, **ina[0]**, and a clock net, **clk**. Square brackets and other reserved characters must be escaped with "\" in the SAIF file.

Under each net are five values, **T0**, **T1**, **TX**, **TC**, and **IG**. The **T0**, **T1**, and **TX** values are the number of timesteps that the net spent at the logic values 0, 1, and X respectively. The **IG** value is the number of inertial glitch values — for details see the documentation. The only important value for ACE is the **TC** value, which is the total number of zero-to-one and one-to-zero transitions over the duration of the simulation. Since the clock net had 118 transitions during simulation, and the **ina[0]** net had 22 transitions, ACE calculates the activity value, which is defined as the average number of transitions per clock cycle, as \( \frac{22}{118} = 0.1864 \) (not very different from the default activity value of 0.125).

**How to Use a SAIF File in ACE**

To use a SAIF file, two implementation options (see page 281) must be specified to ACE:

1. The pathname to the SAIF file
2. The name of the top-level instance in the simulation testbench

The Tcl interpreter normalizes the pathname, so it can be an absolute or relative path, a direct pathname or a symbolic link, and in Windows or Linux format. The name of the top-level instance in the SAIF file must be specified because ACE only knows the name of the top-level module in the RTL. Since the testbench is not being compiled, ACE does know the name of the instance of that module in the behavioral simulation testbench module. The default SAIF file pathname is the empty string (no file specified). The default top-level instance name is "DUT", as in this example.

When generating the Power Dissipation Report during the normal ACE flow, specify the pathname to the SAIF file in the ACE project file using the report_power_saif_file implementation option, and the name of the top-level instance in the report_power_saif_top_level implementation option:

```
set_impl_option -project test1 -impl impl_1 report_power_saif_file "../vcs-routed/sim_output.saif"
set_impl_option -project test1 -impl impl_1 report_power_saif_top_level "DUT"
```

When generating the Power Dissipation Report from the ACE command line, simply call the report_power command with the following two options:

```
report_power -saif_file ../vcs-routed/sim_output.saif -saif_top_level DUT
```

---

### How to Generate a SAIF File Using Synopsys VCS

In this section, for convenience, we provide instructions for how to generate a SAIF file using Synopsys VCS. However, note that VCS behavior may change at any time, and these instructions may be incorrect or incomplete. More than one method of generating a SAIF file may be supported. Consult your simulator documentation for definitive instructions.

There are four steps required:

1. Generate a Final Simulation Netlist (a post-routing simulation netlist that matches the netlist used by the power report) using ACE. The Generate Final Simulation Netlist (see page 226) flow step is an optional flow sub-step that runs under the Design Completion flow step, so that sub-step must be enabled before running the ACE flow.

2. From within the verilog testbench, several additional system functions must be called to specify which part of the design to be observed, and to start and stop the recording of data. The following code can be used as a rough template for a simulation testbench:

   ```
   initial begin
   $set_gate_level_monitoring("on");
   $set_toggle_region(mixedHdlScope);
   // initialization of Verilog signals, and then:
   $toggle_start;
   // testbench
   $toggle_stop;
   $toggle_report("sim_output.saif", $timeUnit, mixedHdlScope);
   end
   ```

3. Call the VCS compiler to generate the simv executable. To generate a SAIF file, the -debug_access+pp flag must be added:

   ```
   vcs <input_files> <testbench> -debug_access+pp
   ```
4. Call the simulation executable. To generate a SAIF file, the \(-lcs\) (limited customer access) flag must be added:

\[
\text{simv -lcs}
\]

**How to Generate a SAIF File Using Siemens QuestaSim**

In this section, for convenience, we provide instructions for how to generate a SAIF file using Siemens QuestaSim. However, note that QuestaSim behavior may change at any time, and these instructions may be incorrect or incomplete. More than one method of generating a SAIF file may be supported. Consult your simulator documentation for definitive instructions.

There are seven steps required:

1. Generate a Final Simulation Netlist (a post-routing simulation netlist that matches the netlist used by the power report) using ACE. The **Generate Final Simulation Netlist** (see page 226) flow step is an optional flow sub-step that runs under the Design Completion flow step, so that sub-step must be enabled before running the ACE flow.

2. Launch QuestaSim in interactive mode, while specifying the additional option \(-v\text{optargs}="+acc"\). This option prevents QuestSim from compressing the netlist and throwing away nodes that must be reported.

\[
\text{vsim -voptargs="+acc"}
\]

3. After the simulator returns to the prompt, run the following command to request the simulator to stop rather than exiting after the simulation completes:

\[
\text{onfinish stop}
\]

4. Specify the scope of the data to be collected, which should include all nets in the DUT. Using the example SAIF file above, this would be as follows:

\[
\text{power add -in -inout -internal -out tb_test1.DUT.*}
\]

5. Run the simulation:

\[
\text{run -all}
\]

6. After the simulation completes, request the simulator to write out the SAIF file:

\[
\text{power report -al -b\text{sai}f sim_output.saif}
\]

7. Quit QuestaSim:

\[
\text{quit}
\]

**Design Statistics Report**

The Design Statistics Report is meant to show various statistics about the current design.

Presently, the only statistics being reported are a histogram showing LUT Function usage counts. This information is primarily meant as a tool for Achronix Technical Support to assist ACE users unable to share their full design. It allows Achronix to better understand the nature of the design and thus provide advice on QoR improvements.
This report is not automatically generated by the Flow (see page 223), but can be generated manually with the report_design_stats Tcl command.

Multiprocess Summary Report

The Multiprocess Summary Report provides a comparative summary of the achieved frequencies and worst-case slacks (if the "Run Post-Route Timing Analysis" or "Run Sign-off Timing Analysis" Flow Steps (see page 223) are enabled), as well as process execution times, for selected Implementations (see page 217) of a single Project when executed from the Multiprocess View (see page 86). This report is automatically shown (and refreshed) in the ACE Editor Area as new results become available during Multiprocess execution.

The Multiprocess Summary Report is generated/updated multiple times during a Multiprocess execution as new data becomes available from the executing Implementations (see page 217). While the Multiprocess flow is still executing, the report contains incomplete results — rows containing incomplete data are marked as such. Similarly, if errors are encountered during flow execution for one of the selected Implementations (see page 217), the row(s) of data for that implementation are marked accordingly.

Because the Multiprocess Summary Report summarizes the results of multiple Implementations (see page 217) (unlike the other reports, which are generated for a single implementation), the HTML file containing the report is not placed in any implementation subfolder. Instead, this report is placed in the directory containing the .acxprj ACE Project File (see page 218), and is named multiprocess_summary.html.

Tip

If closed, the Multiprocess Summary Report can be re-opened at any time.

To re-open the Multiprocess Summary Report for the active project, select the ( ) Open Multiprocess Report button in the upper-right of Multiprocess view, or from the context menu when right-clicking the project in the Projects View (see page 123).

This report is only available in HTML format. There is no Tcl command available to generate this report manually.

For more information on how this report is used, see Running Multiple Flows in Parallel (see page 285) and Attempting Likely Optimizations Using Option Sets (see page 369).

Timing Results Summary Section

The Timing Results Summary section of the report is only generated if either the "Run Post-Route Timing Analysis" or "Run Sign-off Timing Analysis" Flow Steps (see page 223) are executed during the Multiprocess Flow.

Caution!

Any desired optional flow steps in the Flow View (see page 67) must be enabled before Multiprocess execution is started.

The completed implementations in this section are sorted in approximate QoR order by their timing results. The implementation with the best results is at the top (also see the get_best_multiprocess_impl Tcl command.)

While an implementation is waiting to be executed or is currently executing, the Clock Domain column of the report contains a message to indicate the implementation execution status.
When an implementation has completed execution, the timing results for that implementation are populated in the Report. By default, each implementation provides timing results (Upper-Limit Frequency, Worst Setup Slack, and Worst Hold Slack) for a single PVT combination (named in a column group header). However, if the "Report all temperature corners" implementation option is enabled (see the Options View (see page 106)), multiple PVT combinations are reported, each under its own column group header. The active PVT combination (the specific combination chosen for an implementation, which would otherwise be the only one reported) are shown in bold to differentiate it from other PVT combinations shown for that implementation.

The Upper-Limit Frequency, Worst Setup Slack, and Worst Hold Slack cells are independently color-coded to indicate whether the timing constraints were met for each of the defined clock domain/PVT combinations for that implementation. If the timing constraints were met for all clocks and all reported PVT combinations in an implementation, the appropriate Implementation Name cell is also color coded green to indicate success. If errors are encountered during flow execution, the " (Flow Error) " appears in that row.

Hyperlinks to each detailed Timing Report (see page 229) are made available under the first clock domain Upper-Limit Frequency column for each PVT (one is created for each implementation for each reported PVT).

In some cases, some implementations provide Sign-Off timing results but other implementations do not. This difference can happen most often when some implementations are in Evaluation Flow Mode (see page 228) while others are not. It may also happen when the multi-process flow is cancelled, or in rare flow error cases. When this mix of timing results from differing flow steps occurs, the column headings indicate that the report contains Sign-Off data. All earlier Post-Route timing results are footnoted to indicate that they are not showing Sign-Off data.

Runtime Results Summary Section

This section of the report is always generated and indicates the total flow execution time and peak memory utilization for each implementation. The flow runtimes reported are wall-clock runtimes (not CPU times) harvested from the run logs. Rows in the table indicate whether an implementation flow execution is incomplete (running or still waiting to run), or has encountered errors.

Many factors affect runtimes:

- Selected Implementation Options (see page 217) for an implementation (and thus the Option Sets (see page 217)) can have a significant impact.
- The available processors, available memory, and total load on the workstation executing ACE have a significant impact.
  - On multi-user workstations, workstation load may vary widely over the multiprocess execution period.
  - Even on single-user workstations, if using a Parallel Queue Count greater than one, be aware that the last-executed implementation(s) likely can be executing (at least partially) with a reduced machine load compared to the first-executed implementations. As the parallel execution queue is emptied, new implementation processes are not started, thus fewer processes are executing, meaning that the last-executed implementations have the lowest contention for processing cores, caches, memory, I/O, etc.
- Additionally, when using external cloud/grid/batch Job Submission systems:
  - The reported times do not include the time spent waiting in the external system queue(s). The runtimes reported only include time spent actually running the ACE flow.
  - The processor speeds and system loads may vary widely for the nodes running each job, making runtime comparisons difficult (at best).
  - If meaningful runtime comparisons are required, extra care must be taken to ensure that each node system load and hardware is identical for all jobs for the duration of the multiprocess session.
Implementation Options Report

The Implementation Options Report provides information about available options for the currently active implementation. This report is not automatically generated by the Flow (see page 223), but can be generated on demand using the `report_impl_options` Tcl command.

By default, the report only displays the names, descriptions and default values of the most commonly used implementation options (meaning the subset which is shown within the Options View (see page 106)). In addition, by default, the report displays the options applicable to the target device of the currently active implementation.

The `-project` and `-impl` arguments can be used to show the options applicable to a different project implementation.

The `-show_values` argument can be used to include the current implementation value of each option in the report.

The `-show_all` argument can be used to include all possible options for the specified implementation in the report, instead of only the most-commonly-used subset shown within the Options View (see page 106).

**Note**

The values of hidden options (those which are not shown in the GUI Options View) should only be altered after guidance from Achronix support.

Advanced Concepts

The following are advanced concepts intended primarily for extremely experienced users, or users being actively guided by Achronix FAEs.

ACE Verilog Attributes

This page lists various attributes that can be applied to instances, nets, pin, ports, or other objects in the ACE data model. Each attribute is listed with the type of object or objects to which it may be applied, and a description of how it effects the ACE synthesis, placement, and routing flow.

**locked**

Applies to nets only.

Nets marked with this attribute are not unrouted by the `run_unroute` command, or when the `run_route` flow step is re-run on a routed design.

**fanout_limit**

Applies to nets only.

This is a dual-use property and can be applied globally and also individually to nets.

The global limit is specified with the `fanout_limit` impl option.

When applied to an individual net, this attribute overrides the global limit. Net drivers are cloned, or buffer trees inserted, to keep each (non clock/reset) net fanout under this limit. Applies only when the fanout_control impl option is enabled.
Note
ACE never inserts more fanout buffers than the maximum specified by the max_buffer_limit impl_option.

In order to find the correct net name, if the name of the driving register is known, the following Tcl command can be used:

```tcl
set_property fanout_limit 50 [ find {*} -nets -filter @driving_pin={get_pins *<source_reg>*q} ]
```

**must_keep**
Applies to instances or nets.

The instance or net cannot be deleted by any of the netlist optimization flow commands.

Note
If the instance or net is logically redundant, it might be left dangling with no input and no output connections.

**do_not_rewire**
Applies to instances, nets, pins.

Rewiring permutes input pins among equivalent nets (i.e., nets in a tree of fanout-control buffers) to minimize wirelength and improve timing. This attribute disables rewiring for a given instance, net, or pin. Some rewiring can happen during run_prepare, but the majority of changes are made after run_place and run_route. Subject to the run_prepare, run_place, run_route, and postpnr_rewire implementation options.

**do_not_clone**
Applies to instances only.

Prevents a given instance from being cloned during fanout control optimization. However, fanout buffers may still be inserted for nets above the fanout_limit.

**do_not_cluster**
Applies to instances only.

Prevents an instance from being clustered during structural or timing-driven clustering. Structural clustering (enabled with the structural_clustering_mode implementation option) creates clusters from groups of LUTs and Flops when certain pre-defined structures are encountered. Timing-driven clustering (enabled by the timing_driven_clustering implementation option) creates larger clusters from LUT-to-LUT and ALU-to-LUT connections to keep timing-critical net routing short. Instances in a cluster are placed together.

**clock_type**
Applies to nets or driver (output) pins.

Normally, this property is set on a net or driver (output) pin using the set_clock_type TCL command in the SDC constraints, but it can also be specified using this attribute. Applies globally to all target pins driven by that net or pin. For more information see the documentation for the set_clock_type Tcl command. The attribute must be a comma-separated list of the following strings: {"boundary", "trunk", "direct_trunk", "minitrunk" (Speedcore only), "blocked", "data_region", "data_center", "data_local", "branch_fast", "branch_nominal", "none", "low_jitter", "local", "global", "immediate"}. 
Note
Not all attribute combinations make sense.

**local_clock_type**
Applies to pins only.
Has all of the same properties as the clock_type attribute above, but use this attribute when the type is being specified for a specific target (input) pin, and the routing type needs to be different than the global value specified for the driving net /pin. Useful for certain kinds of data-generated clocks: parts of the clock that feed back should be "data" but the rest should be "data_region" or "data_center".

**syn_useioff**
Applies to ports, nets, I/O pad/pin instances, or on flop flop instances.
Depending on the value of the push_flops_into_pads implementation option, the presence of this property causes boundary flop flop instances to be pushed into the attached input or output pad/pin instance. For more information see the Automatic Flop Pushing into I/O Pads (see page 434) section.

**ace_virtualize**
Applies to ports only.
Allows specifying which ports and port busses are virtualized when ACE is run in evaluation flow mode, and when the design contains more top level ports than available I/O pads/pins. For more information see the Working with Virtual I/O (see page 442) section.

**ace_virtualize_clock_port**
Applies to ports only.
When the virtual_io_style implementation option is set to the value serialize_dff, allows specifying the top-level port name to be connected to the clock input of the new serialization flop instances. Cannot be used with the ace_virtualize_clock_net attribute (they are mutually exclusive). For more information see the Working with Virtual I/O (see page 442) section.

**ace_virtualize_clock_net**
Applies to ports only.
When the virtual_io_style implementation option is set to the value serialize_dff, allows specifying the top-level net name to be connected to the clock input of the new serialization flop instances. Cannot be used with the ace_virtualize_clock_port attribute (they are mutually exclusive). For more information see the Working with Virtual I/O (see page 442) section.

**async_capture**
Applies to a DFF "d" input pin only.
Suppresses setup-and-hold checks at the input pin of a DFF instance during Standard Delay Format (SDF) export for the Timing Annotated Gate Level Simulation flow. This attribute is used on the capture flop of user-supplied clock domain crossing synchronizer macros. For more information, refer to the relevant IP Component Library User Guide for that product family.
location

Applies to instances only.

A string attribute giving the site name on which the instance is to be pre-placed. Equivalent to the "set_placement - fixed" PDC constraint.

Clock Regions

Device fabrics deal with numerous clocks. Due to physical routing limitations, only a finite number of clocks can be routed to each individual site within the fabric. To keep the placement/routing problem space manageable for the most complex designs, a fabric is divided up into Clock Regions of a relatively coarse granularity, where each Clock Region as a whole allows a finite number of clocks to be routed within that clock region.

Each fabric is divided up into a number of Clock Regions of roughly similar area. The exact numbers of clock regions, the dimensions of each region, the number and types of sites within the region, the allowed sources of the clocks routed to each region, and the differences (like skew) of clock behavior between clock regions all are specified by the chosen target device. A subset of this information is presented in the Clock Regions View (see page 39). See the technical specification of the target device for complete details.

For designs with an extremely large number of clocks, the use of Placement Regions and Placement Region Constraints (see page 371) may be necessary to guide placement decisions regarding Clock Regions. This should be discussed thoroughly with an Achronix FAE first, as improper use of Placement Region Constraints can lower QOR or even cause Placement or Routing to become unsolvable.

Instance States

An individual Instance can have a variety of states simultaneously in ACE, and only the highest priority state is used to color the Instance in the Floorplanner View (see page 57). The states are listed below in the default render priority order. Higher priority states (earlier in the table) take precedence over lower priority states (if an instance has Fixed Placement and is also Selected, the Selection color has priority, and the Selection color is used to paint the instance).

Additionally, several of the states have associated icons, which normally are displayed alongside the instance when the instance appears in tables and lists, as in the Search View (see page 132), Selection View (see page 136), and Netlist Browser View (see page 92). Similar to the colors, the highest priority icon is used. Thus, an instance that is both Fixed and Locked uses the Fixed icon.

Table 123: Instance States By Priority Order

<table>
<thead>
<tr>
<th>Priority</th>
<th>State</th>
<th>Default Color</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Selected</td>
<td>bright green</td>
<td>–</td>
<td>This instance has been added to the ACE Selection Set, typically either by using the Selection View (see page 136) or the Tcl select (see page 617) command. For more information, see Selecting Floorplanner Objects (see page 321).</td>
</tr>
<tr>
<td>2</td>
<td>Highlighted</td>
<td>(user-defined)</td>
<td>–</td>
<td>An instance chosen to Highlight, typically by using the Highlight Instance commands in one of the views within the Floorplanner Perspective, or by the highlight Tcl command. See Highlighting Objects in the Floorplanner View (see page 323) for more information.</td>
</tr>
<tr>
<td>Priority</td>
<td>State</td>
<td>Default Color</td>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
<td>---------------</td>
<td>------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>3</td>
<td>Overassigned Site</td>
<td>bright red</td>
<td></td>
<td>An instance that shares a site assignment with another instance. Since a site can only legally contain a single instance, this is an error state.</td>
</tr>
<tr>
<td>4</td>
<td>Fixed Placement</td>
<td>bright yellow</td>
<td></td>
<td>An instance whose site assignment has been marked as &quot;fixed&quot;. As long as an instance is defined with hard fixed placement, ACE does not change the site assignment for that instance during the Placement phase of PnR. For more information, see Placing an Object (see page 326).</td>
</tr>
<tr>
<td>5</td>
<td>Locked Placement</td>
<td>dark yellow</td>
<td></td>
<td>An instance that is a member of a Locked Partition that has remained unchanged since the prior incremental compilation. ACE does not change the site assignment for that instance during the Placement phase of PnR. For more information, see Using Incremental Compilation (Partitions) (see page 380).</td>
</tr>
<tr>
<td>6</td>
<td>Default (Soft) Placement</td>
<td>dark grey</td>
<td></td>
<td>A placed instance with no other specially defined state is displayed in this manner.</td>
</tr>
<tr>
<td>7</td>
<td>Unplaced</td>
<td>–</td>
<td></td>
<td>An instance without a current site assignment (placement).</td>
</tr>
</tbody>
</table>

**Note**

The colors mentioned are the default colors. These colors may be modified on the Floorplanner View Colors and Layers Preference Page (see page 191). On that same preference page, it is possible to toggle whether some states are shown at all, and to partly alter the render priority of some states.

**Filter Properties**

Several Tcl commands [find, filter] allow Tcl command-line filtering of object lists. Additionally, the Search Filter Builder dialog (see page 183) performs a similar function for the Search view (see page 132) in the ACE GUI. The allowed filtering properties, operators, and values (where applicable) are as follows:

**Table 124: Supported Filter Properties**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Operators</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@async_reset</td>
<td>=</td>
<td>true, false</td>
<td>Allows filtering ports, nets, and pins based on whether they connect to an async reset.</td>
</tr>
<tr>
<td>@attribute</td>
<td>=</td>
<td>property:value</td>
<td>Allows filtering instances, nets, and ports based on verilog attribute/defparam values. Values of the @attribute filter must be a property-value pair separated by a semicolon (i.e., prop:value).</td>
</tr>
<tr>
<td>@clock</td>
<td>=</td>
<td>true, false</td>
<td>Allows filtering ports, nets, and pins based on whether they connect to a clock net.</td>
</tr>
<tr>
<td>@clock_as_data</td>
<td>=</td>
<td>true, false</td>
<td>Allows filtering instances and nets based on whether they have any data pins being driven by a clock signal.</td>
</tr>
<tr>
<td>Property Name</td>
<td>Operators</td>
<td>Values</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>@clock_domain</td>
<td>=</td>
<td>$clockDomainName$</td>
<td>Allows filtering instances, nets, paths, and pins based on clock domain name.</td>
</tr>
<tr>
<td>@clock_region</td>
<td>=</td>
<td>$clockRegionName$</td>
<td>Allows filtering instances, nets, paths, sites, and pins based on clock region name. Some nets and paths may be part of multiple clock regions.</td>
</tr>
<tr>
<td>@data_as_clock</td>
<td>=</td>
<td>true, false</td>
<td>Allows filtering nets based on whether they have any clock pins being driven by a data signal.</td>
</tr>
<tr>
<td>@direction</td>
<td>=</td>
<td>in, out, inout</td>
<td>Allows filtering ports and pins based on direction.</td>
</tr>
<tr>
<td>@driver_type</td>
<td>=</td>
<td>(device-dependent)</td>
<td>Allows filtering nets and pins based on the type (cell name) of the driving instance.</td>
</tr>
<tr>
<td>@driving_net</td>
<td>=</td>
<td>$netName$</td>
<td>Allows filtering instances based on a net name that is driving them.</td>
</tr>
<tr>
<td>@driving_pin</td>
<td>=</td>
<td>$pinName$</td>
<td>Allows filtering instances and nets based on the name of a pin that is driving them.</td>
</tr>
<tr>
<td>@enable</td>
<td>=</td>
<td>true, false</td>
<td>Allows filtering ports, nets, and pins based on whether they connect to an enable signal.</td>
</tr>
<tr>
<td>@fanout</td>
<td>=, &lt;, &gt;</td>
<td>(integers &gt; 0)</td>
<td>Allows filtering nets and pins based on the number of fanout connections. Valid @fanout values must be integers greater than 0.</td>
</tr>
<tr>
<td>@fixed_placement</td>
<td>=</td>
<td>true, false</td>
<td>Allows filtering instances based on whether placement is fixed.</td>
</tr>
<tr>
<td>@partition</td>
<td>=</td>
<td>$partitionName$</td>
<td>Allows filtering instances, nets, paths, and pins based on partition name.</td>
</tr>
<tr>
<td>@placed</td>
<td>=</td>
<td>true, false</td>
<td>Allows filtering instances, nets, and pins based on whether they are placed. In this context, &quot;placed&quot; means the net is routed.</td>
</tr>
<tr>
<td>@power</td>
<td>=, &lt;, &gt;</td>
<td>(floating point numbers &gt; 0.0)</td>
<td>Allows filtering nets based on power consumption. Valid @power values must be a floating point number greater than 0.0.</td>
</tr>
<tr>
<td>@power_rank</td>
<td>=, &lt;, &gt;</td>
<td>(integers ≥ 0)</td>
<td>Allows filtering nets based on the level of power consumption relative to other nets. The most power-consuming net is ranked 1 while the least power consuming net is ranked n. Valid @power_rank values must be integers greater than or equal to 0.</td>
</tr>
<tr>
<td>@region</td>
<td>=</td>
<td>$placementRegionName$</td>
<td>Allows filtering instances, nets, paths, and pins based on placement region name.</td>
</tr>
</tbody>
</table>
### Property Name | Operators | Values | Description
--- | --- | --- | ---
@reset | = | true, false | Allows filtering ports, nets, and pins based on whether they connect to a reset signal.
@sink_type | = | (device-dependent) | Allows filtering nets and pins based on the type (cell name) of instance(s) the net is driving.
@type | = | (device-dependent) | Allows filtering instances based on the type (cell name) of the instance.

### Table Notes
1. Some instances may be part of multiple clock domains, such as a CDC instance.

---

**Timing Across All Temperature Corners**

ACE supports place and route across all temperature corners as well as reporting timing across all temperature corners of interest for a given place-and-route result at a specific junction temperature. This feature helps the designer to confirm whether the optimized placed-and-route result is able to close timing at the desired frequency \(F_{\text{MAX}}\) at all temperature corners of interest.

**Note**

By default, ACE only optimizes place and route for a single user-chosen temperature corner per implementation, but then reports the timing analysis results of that routed netlist for all temperatures of interest. If it is desired to optimize place and route for multiple temperatures, the impl-option `pnr_optimize_corners` should be set to 1.

ACE requires setting the desired junction temperature at which the design is placed and routed for the target \(F_{\text{MAX}}\) (unless `pnr_optimize_corners` is not 0). This selected junction temperature is used to load the corresponding timing libraries and to optimize the place and route to close timing at the requested frequency.

If `pnr_optimize_corners` is not zero, the basic junction temperature setting is only used for timing reports up to and including the routed timing report. The final timing report always consists of multiple reports, one for each available corner.

This temperature target can be set within the Options View (see page 106) under **Design Preparation → Junction Temperature**. With the desired junction temperature selected, place and route is performed. The Final timing reports are always generated for all corners, because any given corner might be worse than any other given the underlying hardware technology used (due to the effects of temperature inversion).

**Note**

The **Power Dissipation Report** (see page 230)s are generated for each temperature corner as well.

When reports are generated for multiple corners, the report file names are extended with a suffix describing the PVT corner contained within the report. The suffix includes the speed grade, the voltage, and the temperature, in that order, separated by underscores: \_<speed_grade>_\_<voltage>_\_<junction_temp>

For example:
In addition to the above, there is an additional opportunity to apply different optimization strategies by putting the design through a Multiprocess run via the Multiprocess View (see page 86) GUI. In Multiprocess:

- Different place-and-route optimization strategies are applied
- Timing is reported across all temperature corners for each of the Multiprocess place-and-route strategy (called seed/implementation) applied
- A Multiprocess summary report is generated that lists all timing results across all temperature corners.

ECO Commands

ECO Use Cases

The ECO Command Tool Chain is a set of useful tools that allow editing a design with a high level of granularity. These tools can be used to achieve highly specific goals, such as manually adding logic blocks to the fabric, improving timing, performing analysis on the FPGA itself, and more.

Net Legality Definition

Throughout this documentation, the concept of net legality is mentioned frequently. For a net to be legal, all of the following must be true:

- There is exactly one and only one driving/output pin connected to the net.
- There is at least one input/sink pin connected to the net.
- All instances to which the net connects must be placed (with the exception of their respective site pins which do not need to be placed).

When a net is legal, the router may route the net. An illegal net causes the router to silently exit. When performing ECO changes, it is necessary to tie-off and/or correct any nets that become illegal. ECO commands indicate illegal nets caused by each ECO command, including why such nets were deemed illegal. It is necessary to manually keep track of such nets and correct them along the way.

Disclaimers

**Caution!**

ECO commands are intended for advanced users only. Use at your own risk!

ECO commands are intended to be performed at the end of the place-and-route Flow Steps (see page 223). Performing ECO before or during place-and-route is possible, but this requires more caution.

Although optional, it is highly recommended to specify the name of a site when inserting an instance, or else ACE refuses to perform net-routing with nets connected to unplaced instances. If desired, optionally execute run_place after instance insertion to let ACE handle placement automatically. The flow step run_place:

- May perform automatic placement of an ECO-inserted instance, but if the new instance is deemed redundant or useless by the ACE reconditioner, it is removed from the design.
- Is not incremental; it always places all instances in the design, which can be time consuming. As such, when using ace_eco::insert_instance, consider placing the new instance manually.
While performing ECO, certain nets may become partially routed (i.e., calling `rewire_net -connect` without specifying `-reroute`) or derouted (i.e., the nets lost a pin connection that kept them legal). In these circumstances, a warning is displayed on the Tcl console. All such illegal nets must be identified and resolved before proceeding.

When any illegal nets have been made legal (a driver added to a floating net, a sink pin added to a dangling net, drivers removed from a multi-driven net), `rewire_net <netName> -reroute` must be called to physically create the connections specified in the ECO-modified netlist.

If it is decided to perform `run_prepare` after performing ECO, all changes made are overwritten since `run_prepare` sources the original netlist(s) specified in the ACE project, but not any ECO modifications. As such, keep in mind that all work might be accidentally undone by calling `run_prepare`. 
Running ECO commands but failing to resolve issues created by the resulting changes may potentially lead to errors within ACE if certain functions are subsequently called. For instance, a set of ECO commands could disconnect an output pin from a net, but fail to connect a new one. If another (non-ECO) command is then called that assumes that each net has a driving pin, ACE reports errors.

ECO commands modify the gate-level netlist generated from run_prepare, and rerunning run_place or run_route with a modified netlist may lead to unintended consequences to the design.

Tip

It is recommended to save often when performing ECO as inadvertently executing a wrong command may either break the design beyond repair or cause ACE to report errors, forcing a restart from scratch.

ECO Commands

The ECO commands are all in a special ace_eco:: Tcl Namespace; they are not included in the global namespace. These commands are:
- ace_eco::delete_instance
- ace_eco::delete_net
- ace_eco::get_instance_pins
- ace_eco::insert_instance
- ace_eco::insert_net
- ace_eco::rewire_instance
- ace_eco::rewire_net

delete_instance

Command Syntax

```
ace_eco::delete_instance {<i:instance_name> <i:instance_name> ...} [-reroute]
```

The delete_instance command deletes the named instances and disconnects the pins of those instances from their respective nets. Any nets left with no connections are not automatically deleted. These nets must be deleted manually using ace_eco::delete_net.

<table>
<thead>
<tr>
<th>Table 125: delete_instance Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arg Name</td>
</tr>
<tr>
<td>&lt;instances&gt;</td>
</tr>
<tr>
<td>[-reroute]</td>
</tr>
</tbody>
</table>

delete_net

Command Syntax

```
ace_eco::delete_net {<n:net_name> <n:net_name> ...}
```
The `delete_net` command deletes the named nets.

**Table 126: delete_net Arguments**

<table>
<thead>
<tr>
<th>Arg Name</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;nets&gt;</td>
<td>No</td>
<td>List of user design nets to be deleted. The &quot;n:&quot; prefix is optional on each net.</td>
</tr>
</tbody>
</table>

**get_instance_pins**

**Command Syntax**

```
ace_eco::get_instance_pins {<i:instance_name> <i:instance_name> ...}
```

The `get_instance_pins` command returns a list of all pins (and nets, if connected) for the named instances. The returned lists takes the form of:

```
{{t:instance1:pin1 n:net1} {t:instance1:pin2 n:net2} {t:instance1:disconnected_pin3}} {{t:instance2:pin1 n:net1} ...} ...
```

**Table 127: get_instance_pins Arguments**

<table>
<thead>
<tr>
<th>Arg Name</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;instances&gt;</td>
<td>No</td>
<td>List of user design instances to be queried. The &quot;i:&quot; prefix is optional on each instance.</td>
</tr>
</tbody>
</table>

**insert_instance**

**Command Syntax**

```
ace_eco::insert_instance <i:instance_name> <cell_type_name> [-site <s:site_name>] [-pins {{<p:pin_name> <n:net_name}> {<p:pin_name> <n:net_name}> ...}]} [-parameters {{<param_name> <param_value}> {<param_name> <param_value}>} ...]} [-fixed] [-reroute]
```

The `insert_instance` command generates a new instance of the specified cell type and inserts it into the netlist. If `-site` is specified, the command places the new instance on the named site (given that the site is legal to use).

**Table 128: insert_instance Arguments**

<table>
<thead>
<tr>
<th>Arg Name</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;instance_name&gt;</td>
<td>No</td>
<td>The name which is given to the newly inserted instance. The &quot;i:&quot; prefix is optional.</td>
</tr>
<tr>
<td>&lt;cell_type_name&gt;</td>
<td>No</td>
<td>Type of instance. This must be a valid cell type for the current fabric.</td>
</tr>
<tr>
<td>-site</td>
<td>Yes</td>
<td>The optional <code>-site</code> argument names the site where the new instance is placed. The site named must be compatible with the cell type, or the command aborts before the instance is created. The &quot;s:&quot; prefix is optional.</td>
</tr>
</tbody>
</table>
Table 129: insert_net Arguments

<table>
<thead>
<tr>
<th>Arg Name</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;net_name&gt;</td>
<td>No</td>
<td>The name to be given to the newly inserted net. The &quot;n:&quot; prefix is optional.</td>
</tr>
<tr>
<td>&lt;pins&gt;</td>
<td>No</td>
<td>List of fully-qualified (including instance) pin names. Each named pin is connected to the new net. The &quot;t:&quot; pin prefixes are optional.</td>
</tr>
<tr>
<td>-route</td>
<td>Yes</td>
<td>The optional -rout argument is used to automatically route the new net after it has been inserted.</td>
</tr>
</tbody>
</table>
Warning!

- The new net name is currently not verified to follow Verilog/VHDL identifier standards.
- The `insert_net` command does not connect to pins already connected to a net; those pins must be disconnected first before calling this command.
- The user-specified net must be legal (has at least one input pin and exactly one driving pin) upon creation, or else the net is not created. However, instances which the new net connects to do not have to be placed.

**rewire_instance**

**Command Syntax**

```
ace_eco::rewire_instance <i:instance_name> "{{p:pin_name} [n:net_name]} {{p:pin_name} [n:net_name]} ..." [-reroute] [-disconnect]
```

The `rewire_instance` command allows connecting or disconnecting the pins of an instance to/from specific nets. Both of these operations can be performed at the same time. Connections from user-specified nets to user-specified pins may be created, deleted, or changed.

**Table 130: rewire_instance Arguments**

<table>
<thead>
<tr>
<th>Arg Name</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;instance_name&gt;</td>
<td>No</td>
<td>The name of the instance whose wiring is to be changed. The &quot;i:&quot; prefix is optional.</td>
</tr>
<tr>
<td>&lt;pin_net_pairs&gt;</td>
<td>No</td>
<td>List of user design pins/ports paired with the optional nets to which each are to be connected. The &quot;p:&quot; and &quot;n:&quot; prefixes are optional. Example: &quot;'{{pin1 net1} {disconnected_pin2}}'&quot;</td>
</tr>
<tr>
<td>-reroute</td>
<td>Yes</td>
<td>The optional -reroute argument is used to re-route nets after the instance has been inserted.</td>
</tr>
<tr>
<td>-disconnect</td>
<td>Yes</td>
<td>The optional -disconnect argument causes all existing connections to be disconnected before applying new pin/net connections.</td>
</tr>
</tbody>
</table>

**Note**

- If a named pin/net connection already exists as specified, that argument is safely ignored.
- If a pin name is provided without a net name, that pin is disconnected from any currently connected net.
- If -disconnect is used with an empty pin_net list, all prior connections are removed without any new connections being created.
**rewire_net**

**Command Syntax**

```
ace_eco::rewire_net <n:net_name> [-connect "<p:pin_name> | <n:net_name> ..."] [-disconnect "<p:pin_name> ..."] [-clocktype <type>] [-reroute] [-verbose]
```

The `rewire_net` command allows connecting/disconnecting pins from the specific net. The same action could also be accomplished with `ace_eco::rewire_instance` commands, but that can quickly become very cumbersome if most of the pins on one net should now connect to another net. A single `ace_eco::rewire_net` command can do the work that would require hundreds of `ace_eco::rewire_instance` commands, each specifying the same net.

**Note**

The command `rewire_net` may be used on a net with no arguments except for `-reroute`, to perform routing on the specified net. This option is useful for cleanup work as it is necessary to route any remaining partially or unrouted nets.

**Table 131: rewire_net Arguments**

<table>
<thead>
<tr>
<th>Arg Name</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;net_name&gt;</code></td>
<td>No</td>
<td>The name of the net whose wiring is to be changed. The &quot;n:&quot; prefix is optional.</td>
</tr>
<tr>
<td><code>-connect</code></td>
<td>Yes</td>
<td>The optional <code>-connect</code> argument specifies a list of pins to be connected to a net. If already connected, they are first disconnected from their original nets.</td>
</tr>
<tr>
<td><code>-disconnect</code></td>
<td>Yes</td>
<td>The optional <code>-disconnect</code> argument specifies a list of pins that should be disconnected from net.</td>
</tr>
<tr>
<td><code>-clocktype</code></td>
<td>Yes</td>
<td>The optional <code>-clocktype</code> argument indicates the clock type of the pins to be connected.</td>
</tr>
<tr>
<td><code>-reroute</code></td>
<td>Yes</td>
<td>The optional <code>-reroute</code> argument is used to re-route nets after the instance has been inserted.</td>
</tr>
<tr>
<td><code>-verbose</code></td>
<td>Yes</td>
<td>The optional <code>-verbose</code> argument generates additional feedback as the command is running.</td>
</tr>
</tbody>
</table>

**GUI Support**

GUI support for ECO functionality is hidden by default. To enable ECO actions in the GUI, enable the checkbox found at: **Window → Preferences → User Advanced Preferences → Enable ECO Functionality**.

When enabled, ECO actions for the ECO commands appear in right-click context menus available on most views in the Floorplanner Perspective. For example, right-click a net to display the available ECO net commands; right-click an instance to display available ECO instance commands, etc.

**Warning!**

The GUI ECO wizards do not provide extra safety checks or guidance at this time. Errors, warnings, and success feedback from the ECO changes are only shown in the **Tcl Console View (see page 144)** as the ACE ECO Tcl commands themselves are executed by the wizards.
Add Instance Pin Dialog

The Add Instance Pin Dialog selects an existing pin to add to an existing instance.

Table 132: Add Instance Pin Dialog Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance</td>
<td>A valid instance name. If an invalid name is specified, the green check mark next to the Instance field changes to indicate the error.</td>
</tr>
<tr>
<td>Pin</td>
<td>A list of the instance pins.</td>
</tr>
</tbody>
</table>
ECO Insert Instance Dialog

The ECO Insert Instance Dialog allows the addition of a new instance.

![ECO Insert Instance Dialog Example]

**Figure 119: ECO Insert Instance Dialog Example**

**Table 133: ECO Insert Instance Dialog Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance Name</td>
<td>The name for the new instance. The name must be unique to the design. If an instance with the given name already exists, the green check mark next to the Instance Name field changes to indicate the error.</td>
</tr>
<tr>
<td>Cell Type</td>
<td>The cell type for the new instance.</td>
</tr>
</tbody>
</table>
### Table 134: ECO Insert Net Dialog Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Net Name</strong></td>
<td>The name for the new net. The name must be unique to the design. If a net with the given name already exists, the green check mark next to the Net Name field changes to indicate the error.</td>
</tr>
</tbody>
</table>
### Add Pin
The Instance Pins table in the dialog lists the pins to which the new nets are connected. Use the **Add Pin** button to add pins to this table.

### Remove Pin
Use the **Remove Pin** button to remove all currently selected pins from the Instance Pins table.

### Immediately reroute after insert
If enabled, the design is rerouted immediately after the new net is inserted.

---

**ECO Rewire Instance Dialog**

The ECO Rewire Instance Dialog allows adjusting the properties of an existing instance.

![ECO Rewire Instance Dialog Example](image)

**Figure 121: ECO Rewire Instance Dialog Example**

**Table 135: ECO Rewire Instance Dialog Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin/Net Connections</td>
<td>Click a cell in the Net column to connect the pin to a different net.</td>
</tr>
<tr>
<td>Force disconnect of all prior nets before rewiring</td>
<td>Causes all existing connections to be disconnected before applying new pin/net connections.</td>
</tr>
</tbody>
</table>
Immediately route after instance insertion

If enabled, the design is rerouted immediately after the new instance is inserted.

ECO Rewire Net Dialog

The ECO Rewire Net Dialog allows an existing net’s pin connections to be adjusted.

![ECO Rewire Net Dialog Example](image)

**Figure 122:** ECO Rewire Net Dialog Example

**Table 136:** ECO Rewire Net Dialog Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Pin</td>
<td>The Instance Pins table in the dialog lists the pins to which the new net is connected. Click this button to add pins to the table.</td>
</tr>
<tr>
<td>Remove Pin</td>
<td>Click this button to remove all currently selected pins from the Instance Pins table.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Immediately reroute after insert</td>
<td>If enabled, the design is rerouted immediately after the Insert Net dialog is completed.</td>
</tr>
</tbody>
</table>

Fabric Clusters

Device fabrics in the Achronix Speedster and Speedcore families consist of a device-specific pattern of functional resources called tiles. For example, reconfigurable logic block (RLB) tiles contain LUT, DFF, and ALU sites. BRAM tiles contain block RAM sites. The tiles are arranged in rows and columns, with all columns in the device core (not including the I/O ring) consisting of identical tile types. The arrangement of tiles into columns may look somewhat irregular (e.g., 5 columns of LUTs, a BRAM column, 5 more columns of LUTs, and an LRAM column). However, at a coarse level, those tile arrangements do follow a regular pattern. All fabrics are constructed by arranging rows and columns of tiles into a basic unit of layout called a fabric cluster. A complete device is created by replicating the fabric clusters into a larger grid of rows and columns. For example, the Speedster7t AC7t1500 has 8 rows and 10 columns of fabric clusters, for a total of 80. See the Speedster7t FPGA Datasheet (DS015) for additional details.

All fabric clusters are identical, containing exactly the same pattern of tile rows and columns. The exact numbers of fabric clusters, the dimensions of each cluster, and the arrangement and types of tiles within each cluster, are all specified by the chosen target device. A designer can make use of this regularity if the design consists of a number of identical cores. If the cores are designed to fit exactly within one or more fabric clusters, a complete design can be created by replicating that core multiple times across the device using the fabric cluster grid.

The use of placement regions and placement region constraints (see page 371) might be necessary to guide the placement of multi-core designs in order to align them with the fabric cluster grid. This should be discussed thoroughly with an Achronix FAE first, as improper use of placement region constraints can lower QOR or even cause placement or routing to become unsolvable.
Chapter - 3: Tasks

While the Concepts (see page 24) section was primarily concerned with which features exist in ACE, this Tasks section is concerned with how features in ACE may be best utilized.

Running ACE

ACE can be run with full functionality in three different modes:

- **GUI Mode** (see page 262)
- **Command-line Mode** (see page 262)
- **Batch Mode** (see page 263)

A fourth mode, **Lab Mode** (see page 263), is also available, with reduced functionality.

An optional **ACE_INIT_SCRIPT** (see page 263) can be configured to load a user-defined Tcl script during ACE startup, prior to running any other Tcl commands or scripts. This enables users, or groups of users, to customize ACE settings, define custom Tcl proc's, or define custom ACE flow steps.

Finally, a table of typical supported **ACE startup arguments** (see page 264) is provided at the end of this section.

**GUI Mode**

To run in GUI mode, invoke the `ace` executable either with no options or with the `-gui` option. GUI mode launches the interactive GUI, from which all commands are issued.

```
Starting ACE in GUI Mode, implicit
% ./ace
```

or

```
Starting ACE in GUI Mode, explicit
% ./ace -gui
```

**Command-line Mode**

To run in command-line mode, invoke the ACE executable with the `-b` option from a console. Command-line mode takes control of the console and allows interactively entering Tcl commands at a command prompt.

```
Starting ACE in Command-line Mode
% ./ace -b
-- ACE -- Achronix CAD Environment -- Version 5.4 -- Build 84486-- Date 2015-02-11 19:58
-- (c) Copyright 2006-2015 Achronix Semiconductor Corp.  All rights reserved.
-- all messages logged in file /home/username/.achronix/ace_2015_02_13_11_00_11.log, created at 11:00:11 on 02/13/2015
INFO: License ace-v1.0 on server acxlicense (9 of 10 licenses available). Running on docs.achronix.local (x86_64).
```
Batch Mode

To run in batch mode, invoke the ACE executable with the `-b` option and the `-script_file` option.

```
Starting ACE in Batch Mode
% ./ace -b -script_file path_to_script_file.tcl
```

Lab Mode (Reduced Functionality)

ACE also supports a reduced functionality mode, intended for use in Lab environments. The primary purpose of this mode is to allow a lighter-weight tool for chip programming and debugging, and/or for demonstrating hardware functionality with demo designs. In this mode, a license is not required (no license check occurs), and thus most Tcl functionality is unavailable (because most ACE Tcl functionality requires an appropriate license). In lab mode, the user is unable to work with project files, run the Flow, view the Floorplanner, configure IP, etc.

When the ACE GUI is in lab mode, only the default views within the Programming and Debug Perspective and HW Demo Perspective are usable. Only the subset of ACE Tcl commands needed to support those views is functional. The views within the Projects Perspective, Floorplanner Perspective, IP Configuration Perspective, and NoC Performance Perspective are non-functional (and inaccessible), since these views and editors require licensed ACE functionality.

```
Starting ACE GUI in Lab Mode
% ./ace -lab_mode
```

```
Starting ACE in Command-line Lab Mode
% ./ace -b -lab_mode
```

```
Starting ACE in Batch Lab Mode
% ./ace -b -lab_mode -script_file path_to_jtag_script_file.tcl
```

ACE Initialization Script (ACE_INIT_SCRIPT)

An optional ACE_INIT_SCRIPT can be configured to load a user-defined Tcl script during ACE startup, prior to running any other Tcl commands or scripts. This enables users, or groups of users, to:

- Customize ACE settings
- Define custom Tcl procedures/commands
- Define custom ACE flow steps
Extend ACE features and functions

There are three ways to enable the ACE_INIT_SCRIPT feature in ACE, which use the following order of precedence:

1. Use the \texttt{-ace_init_script} commandline. This is useful when creating wrapper scripts to call ACE with an explicit ACE_INIT_SCRIPT, or when debugging or testing different ACE_INIT_SCRIPTs.

2. Define the $\texttt{ACE\_INIT\_SCRIPT}$ environment variable as the file path to your ACE initialization Tcl script. This can be useful for development teams or organizations wanting to share and standardize the use of the ACE_INIT_SCRIPT across multiple ACE users.

3. Define the $\texttt{ACE\_INIT\_SCRIPT}$ environment variable as an empty string. This causes ACE to look for the ACE_INIT_SCRIPT in $\texttt{HOME}/achronix/ace_init.tcl. This is useful for an individual developer to customize ACE specifically for that individual, without impacting other users.

Relative paths

If a relative path is used to specify the file path to the ACE_INIT_SCRIPT Tcl file, that path is evaluated relative to the current working directory from which ACE was launched (which need not be the ACE installation directory).

Example Log Output

To confirm the ACE_INIT_SCRIPT was loaded in your ACE session properly, look for the "Running initialization script" message near the beginning of the ACE session log file.

```
Starting ACE in Command-line Lab Mode

% ./ace -b -ace_init_script ./my_init_script.tcl
-- ACE -- Achronix CAD Environment -- Version x.x -- Build xxxx -- Date 2023-xx-xx xx:xx
-- (c) Copyright 20xx-20xx Achronix Semiconductor Corp. All rights reserved.
-- all messages logged in file /home/username/achronix/ace_20xx_xx_xx_xx_x_xx.log, created at xx:xx:xx
on xx/xx/xxxx
INFO: Running initialization script /full/path/to/my_init_script.tcl
ACE>
```

ACE Startup Arguments

The most common startup arguments are listed in the following table. Other arguments exist, but should only be used under the guidance of an Achronix FAE (or as specified in one of the Troubleshooting sections of an Achronix User Guide).

\textbf{Table 137: Common ACE Startup Arguments}

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{-b} or \texttt{-batch}</td>
<td>Starts ACE in non-GUI mode, also known as Batch or Command-line mode. See also: the \texttt{-script_file} argument</td>
</tr>
<tr>
<td>\texttt{-lab_mode}</td>
<td>Starts ACE in (unlicensed) Lab Mode, with limited functionality. May be used in combination with ACE GUI mode, Command-line mode, and/or Batch mode. See the prior section in this chapter for more details about ACE Lab Mode.</td>
</tr>
<tr>
<td></td>
<td>Use this to override default ACE session logging behavior, which would otherwise default to creating a session log file at $&lt;user_home_dir&gt;/achronix/ace_&lt;datestamp&gt;_&lt;timestamp&gt;.log. A session log file covers all ACE activity across all projects and implementations touched during the process lifetime of ACE.</td>
</tr>
<tr>
<td>Argument</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>-log_file &lt;path_to_log_file&gt;</td>
<td>Keep in mind that the -log_file argument has no impact upon implementation log files; individual implementation log files are always created under each implementation directory whenever that implementation is being accessed. There is currently no way to override the path of the implementation log files.</td>
</tr>
<tr>
<td>-print_progress</td>
<td>Enables verbose progress messages to be logged during execution of the Flow. Verbose progress logging is disabled by default.</td>
</tr>
<tr>
<td>-project_file &lt;path_to_acxprj_file&gt;</td>
<td>Only allowed when in ACE is started in GUI mode. Allows pre-specifying which *.acxprj file should be loaded by ACE at startup. This is similar to immediately calling the following ACE Tcl command at the Tcl command prompt after ACE has started:</td>
</tr>
<tr>
<td></td>
<td>load_project &lt;path_to_acxprj_file&gt;</td>
</tr>
<tr>
<td>ace_init_script &lt;path_to_ace_init_script_file&gt;</td>
<td>An optional ACE_INIT_SCRIPT can be configured to load a user-defined Tcl script during ACE startup, prior to running any other Tcl commands or scripts. This option overrides the $ACE_INIT_SCRIPT environment variable and any init script in the user home workspace directory.</td>
</tr>
<tr>
<td>-script_file &lt;path_to_script_file&gt; [-script_args &lt;string&gt;]</td>
<td>After the ACE session is initialized (and any ACE_INIT_SCRIPT is executed), ACE immediately executes the script contained in the script file. If the optional -script_args &lt;string&gt; is also used, then the arguments are passed to the script file when the script is executed.</td>
</tr>
<tr>
<td>-snapshot_version &lt;int&gt;</td>
<td>Allows specifying which version of Achronix Snapshot should be used during the ACE session. Version 2 was used for AC22i devices. Version 3 is the modern version, used for all subsequent devices.</td>
</tr>
<tr>
<td>-version</td>
<td>Intended for use in ACE Batch mode. Requests that ACE report its version number and then immediately exit. Example:</td>
</tr>
<tr>
<td></td>
<td>Using the -version argument (in Linux)</td>
</tr>
<tr>
<td></td>
<td>% ./ace -b -version</td>
</tr>
<tr>
<td></td>
<td>-- ACE -- Achronix CAD Environment -- Version 8.8 -- Build xxxx -- Date 2022-xx-xx xx:xx</td>
</tr>
<tr>
<td></td>
<td>-- (c) Copyright 2006-2022 Achronix Semiconductor Corp. All rights reserved.</td>
</tr>
<tr>
<td></td>
<td>%</td>
</tr>
</tbody>
</table>

**Table Notes**

1. When using script files in Microsoft Windows, starting ACE in batch mode with a script file opens a new console that only survives for the life of the script file, and then immediately closes. This typically makes it difficult to read any logged results which might have appeared in that console. For best results, be sure your script logs its output to a file, or review the session log file after script execution. See also: the -log_file argument.

2. This argument has no effect in GUI Mode. ACE always logs the version number to the Tcl Console immediately at ACE startup in all modes. As when using the -script_file argument in Windows, ACE starts a separate console window for the session. Because ACE immediately exits after reporting/logging the version banner, this console window is only visible for a fraction of a second. The requested version information can be found in the session log file. See also: -log_file argument.

---

**Working With Perspectives**

Perspectives define the initial set and layout of views in the Workbench window, providing a set of functionality aimed at accomplishing a specific type of task or working with specific types of resources.
Switching Between Perspectives

Each perspective has an associated icon on the main toolbar. Switch between perspectives by clicking one of these icons. It is also possible to view the available choices as a menu by selecting Window → Open Perspective from the menu bar. Descriptions of the available perspectives are found in the section describing the Perspectives (see page 24) concept.

Resetting Perspectives

Often, when altering positions of Editors (see page 27) and Views (see page 33) within a perspective, this can result in an arrangement that is no longer appealing. Rather than try to manually move the Views and Editors back to the original positions, it is much faster and simpler to reset the perspective.

To restore a perspective to its original layout:

1. Select Window → Reset Perspective from the menu bar.
2. Click OK on the resulting dialog.

Working with Views and Editors

Views and editors are the main visual entities appearing in the Workbench. In any given perspective there is a single editor area which can contain multiple editors with a number of surrounding views providing context.

Opening Views

Perspectives offer pre-defined combinations of views and editors. To open a view not included in the current perspective, select Window → Show View from the menu bar.

Moving and Docking Views and Editors

To change the location of a view or editor in the current perspective:

1. Without releasing the left mouse button, drag the view or editor by its tab.

   ![Note]
   
   A group of stacked views or editors can be dragged using the empty space to the right of the tabs.

2. While dragging the tab (or tab stack), as the mouse is moved around the Workbench, the area under the mouse changes to display (sometimes subtle) feedback indicating where the tab (or stack) can dock if the left mouse button is released at the current location.
   - Drag the tab near the left, right, top, or bottom border of another view or editor to see how that view/editor splits its available area with the dragged tab.
   - Drag the tab near the tabs of another tab stack to see where the dragged tab can be inserted/appended in the existing stack.
   - A tab may be dragged outside of the Workbench area to turn it into a detached view (a view shown in its own separate window).
3. When the view is in the desired location relative to the view or editor area under the cursor, release the left mouse button.
Table 138: View and Editor Tab Docking Feedback

<table>
<thead>
<tr>
<th>Feedback</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical bar between tabs</td>
<td>Marks the insertion point between other tabs.</td>
</tr>
<tr>
<td>Translucent rectangles overlaid upon existing view/editor</td>
<td>Shows the positioning of the dragged view/editor alongside the pre-existing views/editors already in that docking location.</td>
</tr>
<tr>
<td>Translucent rectangle floating outside the ACE window</td>
<td>Shows the position where the detached (see page 267) view/editor can appear.</td>
</tr>
<tr>
<td>✗</td>
<td>No changes. This docking location is either identical to the present layout, or is an illegal position. If the left mouse button is released, no change occurs.</td>
</tr>
</tbody>
</table>

Caution!

In Linux, there is currently a known bug, in the application frameworks underlying ACE, that may cause view/editor tab movements to detach (see page 267) instead of docking when the Help Window is open. See the Troubleshooting (see page 628) section for more details, including several workarounds.

Rearranging Tabbed Views and Editors

In addition to dragging and dropping (docking) views/editors inside the Workbench, the order of views/editors can be rearranged within a tabbed stack:

1. Click the tab of the view/editor to be moved and drag it to the desired location. As the tab is dragged across other tabs, a vertical bar insertion cursor appears.
2. Release the mouse button when the insertion cursor is in the desired location.

Note

A group of stacked views/editors can be moved by starting the drag using the empty space to the right of the tabs.

Detaching Views and Editors

Detached views and editors are shown in a separate window with a smaller trim. These views work like other views and editors, except that they are always shown in front of the Workbench window. To detach views/editors:

1. If the Workbench window is maximized, resize it so that it does not fill the entire screen.
2. Click and hold the tab of the view/editor to be detached.
3. Drag the tab (or tab group) outside of the Workbench window and release the mouse button. The tab can also be dragged into the window of a previously detached view/editor to have multiple detached views/editors together.

To restore the view/editor to appear inside of the Workbench window, drag its tab into the Workbench window.
Tiling Editors

The Workbench allows multiple files to be open in multiple editors. Unlike views, editors cannot be dragged outside the Workbench to create new windows. However, editor sessions can be tiled within the editor area in order to view source files side by side:

1. With two or more files open in the editor area, select one of the editor tabs.
2. While holding down the left mouse button, drag that editor tab over the left, right, top or bottom border of the editor area. The mouse pointer changes to a drop cursor, indicating where the editor session is to be moved.
3. Release the mouse button.
4. Optionally, Drag the borders of the editor area, or each editor, to resize as desired.

**Note**

This operation is similar to moving and docking views inside the Workbench, except that all editor sessions must be contained within the editor area.

Maximizing, Minimizing, and Restoring Views and Editors

ACE provides a rich environment which, in its basic form, consists of the following:

- An Editor Area which contains one or more stacks showing the open editors
- One or more View Stacks which surround the Editor Area and contain one or more views

These elements compete for valuable screen area and correctly managing the amount of area given to each can greatly enhance your productivity within ACE.

The two most common mechanisms for managing this issue are "minimize" (use as little space as possible) and "maximize" (provide as much space as possible). ACE provides two ways to access these operations:

1. Use the minimize and maximize buttons provided on a stack border.
2. Double-click an individual tab or the blank area to the right of the tabs.

**Maximize:**

It is desirable at times to focus attention on one particular view or editor to the exclusion of the others. The most popular candidates for this are maximizing the editor area in order to view a report, or maximizing the Floorplanner View (see page 57) to make as much of the display available for floorplanning as possible.

ACE implements the maximize behavior by minimizing all stacks except the one being maximized. This allows the maximized stack to completely occupy the window while still allowing access to any open views in the perspective by using the icons located in the area around the edges of the window which are called the "Trim Stack".

Editor maximization operates on a complete Editor Area which includes all Editor Stacks, rather than simply maximizing the particular Editor Stack. This allows for "compare" workflows which require the ability to see multiple editor files in a split editor area at the same time.

**Minimize:**

Another way to optimize the use of the screen area is to directly minimize stacks that are of no current interest. Minimizing a stack causes it to be moved into the trim area at the edges of the workbench window, creating a Trim Stack.
1. **Note**

The first time a stack is minimized, the Trim Stack may end up on any edge of the window. If the Trim Stack is manually moved to a particular window edge, that same edge is typically reused when that stack is again minimized.

View Stacks get minimized into a trim representation that contains the icons for each view in the stack:

![Figure 123: Example View Stack Before Minimization](image)

![Figure 124: Example Trim Stack After View Stack is Minimized](image)

The minimize behavior for the Editor Area is somewhat different. Minimizing the Editor Area results in a trim stack containing only a placeholder icon representing the entire editor area rather than icons for each open editor (since in most cases all of the icons would be the same, making them essentially useless).

![Figure 125: Example of Editor Area Before Minimization](image)

![Figure 126: Example of Minimized Editor Area Trim Stack](image)

For workflows needing more than one element visible (i.e., having the Editor Area and a View Stack in the presentation at the same time) additional screen space can still be gained by minimizing the stacks that are not of current interest. This removes them from the main presentation and places them on the Trim Stack, allowing more space for the remaining stacks in the window.

2. **Note**

There are two ways to end up with a stack in the trim:
1. Directly by minimizing the stack.
2. Indirectly by maximizing another stack.

Depending on how the Trim Stack was created, its behavior is different: when restoring a stack from a maximized state, only those trim stacks that were automatically minimized during the initial maximize are restored to the main presentation, while stacks that were manually minimized, stay minimized.

**Tip**

This difference is important in that it allows fine-grained control over the presentation. While using maximize is a one-click operation, it is an "all or nothing" paradigm (i.e., no other stack is allowed to share the presentation with a maximized stack). While adequate for most tasks, it may be desired to have the presentation show more than one stack. In this case, instead of maximizing, minimize all the other stacks except the ones wanted in the presentation. When set up, the editor area can still be subsequently maximized, but the subsequent restore only restores the particular stack(s) that were sharing the presentation, not the ones explicitly/manually minimized.

![Figure 127: Example Default Presentation of the Projects Perspective](image)
Working with Projects and Implementations

Creating Projects

To create a new project in the workspace:

1. Click the ( ) Create Project toolbar button in the Projects view.
2. In the Create Project dialog, type in or browse to the location of the new project directory.
3. Type in the new project name and click Finish.

After clicking Finish, the new project appears in the Projects view. The new project contains a default implementation named impl_1, which is set as the new active implementation. A project file is also created and saved in the new project directory.
Saving Projects

Some project operations cause changes to a project to be saved to the project file automatically, while others change project data without saving. Each Project with unsaved changes is marked in the GUI with an asterisk on the lower left corner of its project icon ( ). If any project in the workspace has unsaved changes, the Projects view title is also marked with an asterisk:

![Projects View Title Unsaved Changes Example](image)

**Figure 129: Projects View Title Unsaved Changes Example**

To save the changes to a project:

1. Select the project in the Projects view.
2. Either press **CTRL+S** on the keyboard, select the ( ) **File Save** toolbar button on the main toolbar, or select the **File → Save** menu option.

To save a project to a different file:

1. Select the project in the Projects view.
2. Select the **File → Save As...** menu option.
3. Browse to a new file location.
4. Enter a project name and click **Save**.

When exiting, ACE prompts to save changes to any projects with unsaved changes:
Loading Projects

By default, when the ACE GUI starts, it attempts to automatically re-load all projects which were open in the prior ACE GUI session.

**Caution!**

Be aware that any projects which are still locked by another ACE session are not automatically re-loaded, nor is any related error reported. Additionally, project files from the prior session which are no longer found in the file system are not loaded, nor are any related errors reported.

Loading a Project Using the GUI

To load existing Projects (see page 217) into the workspace:

1. Click the ( 📈 ) **Load Project** toolbar button in the **Projects View** (see page 123).
2. In the **Load Project Dialog** (see page 173), **Browse** to the location of the project directory. Or, if the project has been opened by ACE previously, find the previously opened `.acxprj` project file in the list of choices in the drop-down combo box within the dialog.
3. Select the project file and click **Open**.

After clicking **Open**, the **load_project** (see page 588) Tcl command is issued and the project now appears in the Projects view. This project is restored from its previous state, and its last implementation is set as the new active implementation. Any place-and-route data for the active implementation is not loaded by default. See **Restoring Implementations** (see page 280) for details on loading a prior place-and-route state.

![Figure 130: Project Unsaved Changes Prompt](image)
Note

Default Implementation Options Change Over Time
The default Implementation Options (see page 217) for ACE change over time as new optimizations become available and existing optimizations are refined. When a project is loaded from an earlier version of ACE, a "Project Version Mismatch" popup dialog is shown offering to reset all Implementation Options of all implementations to the latest default values.

To avoid risking the loss of old optimizations saved in implementation options, say no to the offered reset. To see how the new default implementation options could affect the design, simply create a new implementation for the project. The new implementation contains all the new default values for implementation options, but contains no place-and-route data. Be aware that since no constraint files from the project are enabled by default in a new implementation, it is necessary to choose which constraint files to enable for the new implementation before running the flow.

Loading a Project Using Tcl

The Tcl commands load_project (see page 588) and restore_project (see page 601) may be used to open projects (and potentially also the most recent project implementation) in ACE:

- The load_project command is simple, and only opens the specified project for later use, without loading any additional place-and-route state of an implementation.

- The restore_project command is capable of much more and by default, attempts to load the most recent .acxdb file (potentially containing place-and-route data) for the most recent implementation in the specified project.

Project Locking and Lock Files

Warning!

Project locks protect users from data corruption
ACE uses project locks and lock files to protect user data. Do not attempt to bypass ("-force") the project locks or lock files.

Achronix does not support running multiple ACE sessions on the same project (directory) simultaneously. Having a single project open in multiple ACE sessions is known to cause problems.

Every project opened by ACE is locked by that ACE session for as long as the project is open. Locking is primarily used to prevent file corruption, which could occur if multiple ACE sessions attempt to operate within the same project simultaneously. If another ACE session attempts to open a project while the project is still locked, ACE reports an error in the Tcl Console. The error message mentions the username and hostname of the session which created the project lock, allowing the coordination of sequential (not simultaneous!) project access.

Example error message for a locked project

```bash
cmd> load_project "~/output/quickstart/quickstart.acxprj" -activeimpl "impl_1"
Project: "~/output/quickstart/quickstart.acxprj" is locked by another ACE session and cannot be loaded.
This project is locked by user: TestUser1 on host: TestStation1. [...]"
```

Instead of forcing project lock overrides or deleting lock files, when needing simultaneous access to a design, consult your Achronix FAE. Some potential options include Using Incremental Compilation (Partitions) (see page 380), or using version control tools to store the project.
Caution!

While it is possible to keep multiple copies of the same project in separate project directories, this method is extremely difficult to coordinate, and is thus not recommended by Achronix.

In the unlikely occurrence of an ACE crash, a project may mistakenly remain locked after ACE has closed. Because the project is still locked, subsequent attempts to load the project fail with an error message similar to the one above. To recover from such situations, see "Unable to Load Project: Project is Locked (see page 630)" under Troubleshooting (see page 628).

Removing Projects

To remove a project from the workspace:

1. Select a project in the Projects view.
2. Click the ( \( \times \) ) Remove toolbar button in the Projects view.

After clicking Remove, the project no longer appears in the Projects view. The project files are not deleted from the file system during this operation, and it is the responsibility of the user to clean up unwanted files on the disk. The project is left untouched on the disk so that it can be loaded again, later, if desired.

Opening Project Files in an Editor

To open a project file in the editor area, double-click the project in the Projects view. The project file now appears in a text editor in the editor area. Editing a project file in the workspace does not affect the project unless the project is removed and then re-loaded from the changed project file.

Adding Source Files

To add source netlist and constraint files to a project in the workspace:

1. Select the Project (see page 217) in the Projects View (see page 123) to which the source files are to be added.
2. Click the ( \( \text{\(\nabla\)}} \) Add Source Files toolbar button in the Projects view.
3. In the Add Source Files Dialog (see page 147), browse to the location of the source files.
4. Select the desired file in the dialog, and click Open.

Caution!

By default, ACE loads source files in the same order they were added to the project. If ACE is loading files in an incorrect order, drag and drop them into the desired order within the project Netlists and/or Constraints nodes in the Projects View (see page 123).

After clicking Open, the source files appear in the appropriate netlist or constraints folder under the selected project in the Projects view. The source files are not actually loaded into the design until the Run Prepare flow step is run (or run_prepare is called). Adding a source file to a project simply creates a link to the file so that it may be loaded during flow execution.

See also:

- add_project_netlist (see page 552)
- add_project_constraints (see page 551)
Source File Load Order

Note

Source file load order is shared by all Implementations (see page 217) within a given Project (see page 217). Enabling of constraint files (choosing which constraint files are actually loaded) is allowed to differ in each implementation and is managed by the checkboxes in the Options View (see page 106).

To assist with the understanding of the load order of the source files, the netlist and constraint files are listed in the Projects View (see page 123) in the same order in which they are loaded (the constraint files are additionally listed in order within the Options View (see page 106)).

By default, ACE loads source files in the same order they were added to the Project. Frequently, the order in which source files are loaded is important. For example, the creation of a clock may occur in the source file create_clocks.sdc, while operations upon that created clock may happen in the source file alternate_clocks.sdc. To avoid errors, first add create_clocks.sdc to the project as a source file, then add alternate_clocks.sdc as a source file. If attempting to add all the files to the project in a single operation, the results are platform dependent, but often the operating system "helpfully" sorts the bulk-added files alphabetically behind the scenes, which causes ACE to add them to the project in a potentially incorrect order (and thus later try loading them in that same incorrect order).

When the displayed source file load order is incorrect, there are a few ways to alter the load order:

- add_project_ip (see page 552)
- Removing Source Files (see page 278)
- enable_project_constraints (see page 567)
- disable_project_constraints (see page 562)
Changing the order of existing netlist source files and constraint source files can be performed quickly using mouse drag-and-drop operations in the Projects View (see page 123) (or by using Tcl commands created explicitly for this purpose). The tree should be expanded to show all the netlist and/or constraint files, then drag-and-drop the files to re-order them within the appropriate Project View node until they achieve the desired order. The next time the Flow is Run (see page 283), the constraint files are loaded in the chosen order.

See also:
- get_project_netlist_files (see page 582)
- move_project_netlists (see page 589)
- get_project_constraint_files (see page 581)
- move_project_constraints (see page 588)

A more tedious way to alter the order (but possibly the easiest way to script) is by removing all the constraint source files from the project.

see:
- Removing Source Files (see page 278)
- remove_project_netlist (see page 593)
- remove_project_constraints (see page 592)
- remove_project_ip (see page 593)

Add them to the project again, one at a time, in the desired order.

See:
- add_project_netlist (see page 552)
- add_project_constraints (see page 551)
- add_project_ip (see page 552)

**Enabling/Disabling Constraint Files for Implementations**

Implementations (see page 217) are allowed to individually enable and disable the loading of constraint files within their owning Project (see page 217). This selective loading is managed through the Options View (see page 106), under the Design Preparation category of Implementation Options. Simply uncheck the checkbox next to the constraint files which should not be loaded for the implementation.

See also:
- disable_project_constraints (see page 562)
- enable_project_constraints (see page 567)

Constraint files which are disabled (unchecked) for the current Active Project and Implementation (see page 223) are displayed in grey (instead of black) within the Projects View (see page 123).
Removing Source Files

To remove a source file from a Project (see page 217) in the workspace:

1. Select a source file in the Projects View (see page 123).
2. Click the ( ✗ ) Remove toolbar button in the Projects view.

Or:

1. Right-click the source file in the Projects View.
2. Choose ( ✗ ) Remove in the popup context menu.

After clicking Remove, the source file no longer appears in the Projects view. Source files are not deleted from the file system during this operation, and it is the responsibility of the user to clean up unwanted files on the disk. The source file is left on the disk so that it can be loaded again later, if desired.

See also:
- remove_project_netlist (see page 593)
- remove_project_constraints (see page 592)
- remove_project_ip (see page 593)
- Adding Source Files (see page 275)

Disabling Constraint Files

It is often not necessary to completely remove constraint files from a project. Instead, constraint files can be individually disabled for any Implementations (see page 217) within a project.
1. Select/activate an implementation within the Projects View. The Options View (see page 106) is updated to show the implementation options for that implementation. At the bottom of the Design Preparation implementation options category, there is a list displayed of the Constraint Files for the project.

2. In the Options View, expand the Design Preparation implementation options category. At the bottom of the category, there is a list displayed of the Constraint Files in the project.

3. Deselect (clear) the checkbox(es) of constraint files which should not be loaded for the implementation.

See also:
- disable_project_constraints (see page 562)
- enable_project_constraints (see page 567)

Opening Source Files in an Editor

To open a source file in the editor area, double-click the source file in the Projects view. The source file now appears in a text editor in the editor area. Editing a source file in the workspace does not affect the results of the flow unless the flow is re-run on the affected project implementations.

Opening Source Files in an Editor

To open a source file in the editor area, double-click the source file in the Projects view. The source file now appears in a text editor in the editor area. Editing a source file in the workspace does not affect the results of the flow unless the flow is re-run on the affected project implementations.

Opening Source Files in an Editor

To open a source file in the editor area, double-click the source file in the Projects view. The source file now appears in a text editor in the editor area. Editing a source file in the workspace does not affect the results of the flow unless the flow is re-run on the affected project implementations.

Creating Implementations

To create a new implementation (see page 217) in a project (see page 217) in the workspace:

1. Select a project in the Projects view (see page 123).

2. Click the ( CREATE IMPLEMENTATION ) toolbar button in the Projects view.

3. In the Create Implementation dialog (see page 164), type in the name of the new implementation and click Finish.

After clicking Finish, the new implementation appears under the selected project in the Projects view. The new implementation is set to be the active implementation (see page 223) and contains default values for all implementation options (see page 217). A new implementation directory structure is also created under the project directory if it does not already exist.

Saving Implementations

To save the state of the database (options, netlist, constraints, placement, and routing data) for an implementation in a project in the workspace:

1. Activate an implementation in the Projects View.

2. Run the flow (at least through Run Prepare).

3. Optionally edit placement or routing information.

4. Click the ( SAVE IMPLEMENTATION ) toolbar button in the Projects view.

5. In the Save Implementation Dialog (see page 178), type the file path to the .acxdb Archive File to which the implementation data is to be saved and click Finish.

After clicking Finish, the state of the database (options, netlist, constraints, placement, and routing data) for the implementation is stored in the .acxdb Archive file, which can be restored again later.

See also:
Restoring Implementations

To restore the state of the database (options, netlist, constraints, placement, and routing data) for an implementation in a project in the workspace:

1. Activate an implementation in the Projects View.
2. Click the ( ) Restore Implementation toolbar button in the Projects view.
3. In the Restore Implementation Dialog (see page 177), enter the file path to the .acxdb Archive File from which to restore the implementation data and click Finish.

After clicking Finish, the state of the database (options, netlist, constraints, placement, and routing data) for the implementation is restored from the .acxdb Archive file.

The Run Prepare, Run Place, and Run Route flow steps automatically save checkpoint .acxdb files (by default) that may be restored later.

See also:
- restore_impl (see page 601)
- save_impl (see page 614)

Copying Implementations

To create a new implementation (see page 217) that is a copy of an existing implementation,

1. In the Projects View (see page 123), select (activate (see page 223)) the implementation to be copied.
2. Select the ( ) Create Implementation toolbar button in the Projects View.
3. In the pop-up Create Implementation dialog (see page 164):
   a. Enter the name of the new implementation.
   b. Check the Copy Option Values from Active Implementation checkbox.
   c. Click Finish.
After clicking **Finish**, the new implementation appears under the selected project in the Projects view. The new implementation is set to be the **active implementation (see page 223)** and contains **implementation options (see page 217)** values copied from the source implementation. A new implementation directory structure is also created under the project directory if it does not already exist.

**Setting the Active Implementation**
To change the **active implementation (see page 223)** in the GUI, do one of the following:

- Click an implementation in the Projects view, which activates the selected implementation
- Click a project in the Projects view, which activates the first implementation of the selected project

Changing the active implementation causes the flow status to be cleared and changes the target for all flow operations to the new active implementation.

**Removing Implementations**
To remove an implementation from a project in the workspace:

1. Select an implementation in the Projects view.
2. Click the (**X**) **Delete** toolbar button in the Projects view.

After clicking **Delete**, the implementation no longer appears in the Projects view. Removing an implementation from a project causes all settings for the implementation to be deleted from the project file when the project is saved.

**Configuring Implementation Options**
To configure **implementation (see page 217)** options in the workspace:

1. Select an implementation in the **Projects view (see page 123)**, changing the active implementation to the selection.
2. In the **Options view (see page 106)**, use the controls to configure the available implementation options for the active implementation.

After changing implementation options in the **Options view (see page 106)**, the **flow status (see page 227)** is cleared. A change to an implementation option requires the **flow (see page 223)** to be re-run for that implementation in order for the changes to affect the results of the flow. The changes to the implementation options are not saved until the affected project is saved.

**Opening Output Files in an Editor**
To open an output file in the editor area, double-click the output file in the Projects view. The output file appears in a text editor in the editor area.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Editing an output file is <strong>NOT</strong> recommended.</td>
</tr>
</tbody>
</table>

**Opening Report Files in an Editor**
To open a report file in the editor area, double-click the report file in the Projects view. The report file now appears in a web browser in the editor area.
Cleaning Projects

In the Projects (see page 217) Perspective, while running the Flow (see page 223) for active Implementations (see page 217), ACE generates output files and sub-directories under the active implementation directory. When the configuration is changed and the entire flow or a sub-flow is re-run, any previously generated output files with the same filenames are overwritten. However, some organizations prefer to clean the active implementation directory (and sub-directories) before every flow run to avoid having any lingering stale files.

ACE provides a simple and easy way to delete (clean) these sub-directories and output files through the clean_project Tcl command and/or related actions in the Projects View (see page 123). Specifically, the implementation sub-directories which are cleaned include:

- .debug/
- output/
- reports/

Additionally, the *.acxdb files for the selected implementation(s) are deleted.

**Warning**

Cleaning projects (or implementations) is an irreversible action – the files are deleted from the file system. In contrast, see also Removing Implementations (see page 281), which removes an implementation from a project without deleting any files from the file system.

**Note**

Multiprocess Reports are a special case

The Multiprocess Summary Report (see page 240) files are a special case. These files are not stored at the Implementation level, but at the Project level. Thus, these reports are not deleted when individual Implementations are deleted (Clean Implementation), but are deleted when an entire Project is cleaned (Clean Project).

**Note**

Log files are never cleaned/deleted

To ensure the full history of an implementation is always maintained, cleaning a project or implementation never deletes *.log files (or any other files found within the <implementation_directory>/log/subdirectories).

To clean the implementations of a project from the workspace:

1. Select a project in the Projects view.
2. Right click the selected project and select (🪴) Clean Project from the menu.
3. This option selects all implementations of the selected project by default. Choose one or more implementations to clean from the Clean project dialog.
4. Click OK.

This operation can also be performed on an implementation:

1. Select an implementation from a project in the Projects view.
2. Right click the selected implementation and select (✔) **Clean implementation** from the menu.
3. This option selects only the current implementation by default while the rest of the implementations for the selected project are not selected. Choose one or more implementations to clean from the **Clean project** dialog.
4. Click OK.

See also:
- Projects View (see page 123)
- clean_project
- remove_project
- remove_impl
- Removing Projects (see page 275)
- Removing Implementations (see page 281)

### Running the Flow

A flow can only be run on the current **Active Implementation** (see page 223). If no active implementation is set in the Projects View (see page 123), then the Flow Steps (see page 223) in the Flow View (see page 67) are disabled. Some flow steps are optional while others are required. Optional flow steps may be enabled or disabled in the Flow view by checking or clearing the checkbox to the left of each flow step label.

### Running the Entire Flow

To run the current **Active Project and Implementation** (see page 223) through the entire flow (sequentially run each of the Flow Steps (see page 223) in order):

1. Enable the desired optional flow steps (and disable the unwanted optional flow steps) by clicking the checkboxes next to the flow steps. Required flow steps cannot be disabled.
2. Choose the (▶) **Run Flow** or **Re-Run Flow** action in the Flow View (see page 67), either as a toolbar button or context menu choice.
3. (Optionally) Stop the flow from continuing to the next flow step at any time by clicking the (■) **Stop Flow** toolbar button in the Flow view. When this occurs, ACE displays a dialog allowing the optional restoration of a prior flow state for the implementation by loading an .acxdb file.

See also:
- restore_impl
- Load Acxdb Dialog (see page 172)

Disabled flow steps are skipped (not executed) during this operation.

As each individual flow step is run, its **Flow Status** (see page 227) changes from incomplete, to running, to either error or complete. If an error occurs during the execution of a flow step, the flow is stopped, and no further steps are attempted.

See also:
- run
• enable_flow_step
• disable_flow_step

**Note**

**Special note regarding the Flow and Incremental Compilation:**
When Incremental Compilation is enabled, it might be necessary sometimes to recompile all partitions. This operation can be performed by managing the individual partitions using the Partitions View (see page 115), but an easier way to trigger the recompile is to select the Flow View context menu choice Re-Run Flow with "-ic init", which re-initializes the state of all partitions before starting the full flow. See Using Incremental Compilation (Partitions) (see page 380) for more details. See also: run -ic init.

**Note**

**Special note regarding Evaluation Flow Mode:**
When the Flow Mode implementation option is set to Evaluation, the flow steps under Design Completion and FPGA Programming are not executed. See Flow Mode (see page 228) for more details.

**Running a Sub-Flow**

When using the Flow View (see page 67), there are several ways to run a subset of the available Flow Steps (see page 223) on the Active Project and Implementation (see page 223).

It is possible to run individual flow steps one-at-a-time, to run all required flow steps up to a specified step (stopping when the specified step is completed), and to resume running a partial flow to flow completion.

As each flow step is run, its Flow Status (see page 227) (as displayed in the Flow View) visibly changes from incomplete, to running, to either complete or error. If an error occurs during the execution of a flow step, the flow stops running any further steps. Disabled Flow steps are not executed during these operations.

**Run an Individual Flow Step**

Simply right-click the chosen flow step, and select the Run Selected Flow Step context menu item. Alternately, double-click the chosen flow step.

If any prerequisite required flow steps have not yet been executed, they are run in standard order prior to the chosen step. Any preceding optional steps are not run, even if they are enabled.

After any prerequisite required steps are complete, the chosen flow step is executed.

**Warning!**

Run Selected Flow Step runs the selected step even if that step is optional and not currently enabled (its checkbox is unchecked). Also, this action executes not only the selected step, but any preceding required steps.

Again, only the preceding required flow steps are run, not any preceding optional steps, even if they were selected (had their checkboxes checked).

See also:
• run -step <id>
Run Remaining Enabled Flow Steps (Resume Flow)

When the flow has been stopped before completion, or when a partial flow state has been loaded (see page 273) from a saved .acxdb file, ACE can continue the flow if the (Resume Flow) action is chosen. This action causes ACE to start running at the first enabled flow step which follows the latest successfully completed flow step.

1. Ensure the desired optional steps are enabled (checked) in the Flow View.
2. Choose the (Resume Flow) action from the view toolbar, or from the right-click context menu.

**Note**
If the current flow mode is set to Evaluation, the flow stops after the Place and Route category completes. See Flow Mode (see page 228) for details.

See also:
- run -resume
- enable_flow_step
- disable_flow_step

Stopping the Flow

At any time while a flow step is running, it is possible to ask ACE to stop running the flow with the Flow View (Stop Flow) action.

Some flow steps might respond by stopping immediately, while others need to perform some additional work before exiting the flow step. In both cases, the Flow Status (see page 227) of that step typically is changed to the Error status to indicate that the flow step did not complete successfully.

It is frequently the case that when the flow is interrupted in this manner, the Tcl Console shows many logged error messages for the interrupted flow step. Typically the (Resume Flow) or Run Selected Flow Step can be selected and ACE resumes normal work from the last successfully completed flow step.

Running Multiple Flows in Parallel

Normally, ACE only allows a single project (see page 217) implementation (see page 217) to be run through the flow (see page 223) at a time. Using the Multiprocess View (see page 86), ACE allows running multiple implementations within a single project through the flow in parallel, via a configurable number of parallel processes. Executing multiple implementations in this manner allows ACE to provide a Multiprocess Summary Report (see page 240) of the resulting frequencies, permitting QOR performance comparisons between implementations utilizing different starting clock constraints, placement constraints, and potential optimizations.

Finding the Multiprocess View

The Multiprocess view is, by default, present in the Projects perspective (see page 24), in a tab group shared with the Options view (see page 106). If it is not visible for some reason, the Multiprocess view may be displayed within any perspective by selecting Window → Show View → Other... → Achronix → Multiprocess.

Configuring the Execution Queues

Within the Multiprocess view, the Execution Queue Management (see page 88) section allows the configuring the desired number of parallel processes used to consume the queue of selected implementations. Simply set the value of Parallel Job Count to the desired number of parallel processes. Using the minimum value of 1 causes all queued implementations to be executed sequentially, one after another.
ACE may be configured to execute the parallel processes in the background on the host workstation running the ACE GUI, or ACE may submit each implementation as an independent executable job to an external cloud/grid/batch job submission system. Detailed configuration of the external job submission command is handled on the Multiprocess: Configure Custom Job Submission Tool Preference Page (see page 202).

License Management Considerations with Multiprocess

**Warning**

Each parallel ACE process needs access to an ACE software license.

**Floating licenses:**
When running using the Multiprocess View in the ACE GUI, to run $N$ parallel execution queues, $N+1$ ACE licenses are needed (the extra license is for the GUI itself, as it is managing all the queues running in the background). Talk to your Achronix FAE to ensure that your site has enough licenses to enable running with Multiprocess functionality.

**Node-locked licenses:**
When running using the Multiprocess View in the ACE GUI, provide a node-locked license for every host machine running ACE. When running local/background execution, a single node-locked license is sufficient for all ACE sessions running on that host. When running using an external job submission system, every execution host needs its own node-locked license installed on that execution host. Talk to your Achronix FAE to ensure that your site has enough licenses to enable running with Multiprocess functionality.

The following is a common best practice when determining the needed ACE floating license counts to support multiprocess runs at a specific site, as well as choosing the best value for **Parallel Job Count** based upon the available floating license count.

- Start with the number of ACE users ($U$).
- Determine the maximum number ($P$) of parallel job execution hosts available to the job submission system. Alternately, if job execution hosts are each allowed to run more than one job at a time, determine the maximum number ($P$) of ACE multiprocess jobs the system could theoretically handle in parallel, which is usually determined by ACE memory requirements.

**Note**

Remain aware that ACE memory requirements vary widely based upon design size/complexity, target device, and other factors. Remember that ACE logs its peak memory consumption at the completion of every flow step — this peak memory value is a useful guideline when determining expected multiprocess memory consumption.

Sites trying to minimize license usage, or where users must share the available execution hosts equally, the minimum number of required ACE licenses ($L_{\text{min}}$) would then be $L_{\text{min}} = U + P$. Each user is then allowed to consume up to $L_{\text{user}}$ licenses during their multiprocess sessions, where $L_{\text{user}} = 1 + (P ÷ U)$.

Sites that want to maximize job throughput, where individual users may be allowed to completely saturate the execution hosts, the maximum number of required ACE licenses ($L_{\text{max}}$) would then be $L_{\text{max}} = U + (P \times U)$. Each user is then allowed to consume up to $L_{\text{user}}$ licenses during their multiprocess sessions, where $L_{\text{user}} = 1 + (P \times U)$.

Each user must then set their **Parallel Job Count** to their personal value of $L_{\text{user}} - 1$ (one license is reserved for the ACE session coordinating Multiprocess), which should then ensure that no multiprocess jobs run out of licenses.
**Important Considerations When Using Background Execution on the Local Host Workstation**

Be aware that if the configured number of parallel processes is too high, total execution time actually takes longer than it would at lower values. The constraints are available memory and available processor cores, as well as the load from other processes running on the host workstation.

When choosing how many parallel background implementations to allow, it is very important that users ensure they do not exhaust the physical memory (RAM) available on the executing workstation, otherwise flow execution times quickly increase (due to the OS swapping memory pages to disk). Do take into account any other users on the same workstation, as well as the memory currently in use by the already-running ACE GUI and associated back-end acx process.

Each additional background ACE process takes multiple Gigabytes (GB) of memory — the exact amount varies depending upon the size of the design and the size of the target Achronix device (smaller designs and smaller devices, of course, take less memory). An estimate for large designs on a very large FPGA device is around 16GB of memory used for each background process. Again, this is only an estimate — designs nearing 100% device utilization may require more memory.

Be aware that with modern multi-core hyper-threading workstations, memory limits are usually the reason to constrain the parallel process count. It is not unusual to find workstations capable of running 8 simultaneous threads while only having 32GB of RAM. While on this example workstation, if the ACE user is running the flow on a very large FPGA design (where our estimate was around 16GB per background process), the most efficient parallel process count would likely be 1 or 2; it would depend upon the Operating System, how much memory ACE and other currently-running processes are already using, and whether the user planned to continue using the workstation interactively while the background processes were executing. Since multiple iterations through the flow are likely, it may be worthwhile to track the total multiprocess duration at multiple parallel process counts, so as the user continues working, they can use the most efficient settings for that workstation.

In the majority of cases, the parallel process count should *at most* be the lesser of the following two values (remaining aware that lower values may be even faster):

- **processor constraint: \( 1 + T \)**
  
  where
  
  \( T = \) the total number of simultaneous threads supported by the workstation,
  
  \( T = ( P \times ( C \times H ) ) \), where
  
  \( P = \) the total number of processors in the workstation
  
  \( C = \) the number of physical cores per processor
  
  \( H = 2 \) if the cores are hyper-threaded, 1 if not
memory constraint: \( A / D \)

where

\( D = \) amount of memory needed by the design, as reported in ACE log files (or the Tcl Console) during a prior flow execution

\( A = \) the total available (unused) RAM memory,

\( O = \) amount of memory required by the Operating System

\( R = \) total RAM installed in the workstation

\( G = \) amount of memory required by the currently-running ACE GUI

\( B = \) amount of memory required by the currently-running ACE backend process (named \texttt{acx} or \texttt{acx.exe} in process lists)

\( U = \) amount of memory required by all other user processes expected to execute while the background processes are running

Continuing the example of the 8 thread 32GB workstation: If the workstation is running Linux, estimate the OS requires 0.5GB, the ACE GUI process requires 1GB, the GUI backend process (\texttt{acx}) requires 3GB, and no other user processes are running; the available memory \( A = (32GB - (0.5GB + 1GB + 3GB + 0GB)) = 27.5GB \). If the log files of a prior run report the user design requiring a peak memory usage of 7GB, then the memory constraint value is \((27.5GB / 7GB) \approx 3.9\). The processor constraint would be \((8 \text{ threads} + 1) = 9\). The lesser of the two values is the 3.9 for the memory constraint. So following the guidelines, the ideal parallel process count would be between 3 and 4. To completely balance the two constraints for the design, the example user would need 7GB \times 9\) threads = 63GB of available memory before they could expect optimal performance running 9 parallel processes.

ACE Memory Utilization

ACE logs the amount of memory (RAM) used by the backend as a design proceeds through the flow. This number is reported at the end of every flow step (see page 223) in the log files and (when the GUI is running the flow in single process mode) in the Tcl Console. It is also possible to directly query ACE at any time to find out the peak backend memory usage in KB with the \texttt{get\_ace\_peak\_memory\_usage} Tcl command. These features should allow an educated decision to be made as to how much memory each parallel background process requires for the design, and thus how many processes may be executed in parallel within the current memory constraints.

Example from log

Flow step "report\_timing\_final" completed in 1 seconds. Peak memory usage is 4917 MB.

Example from Tcl Console View query showing peak memory use in KB

\verbatim
cmd> get\_ace\_peak\_memory\_usage
5035008
\endverbatim

Configuring ACE to Use an External Job Submission System

Due to the wide variety of grid, batch, queue and cloud job submission systems available, it is not possible for ACE to support each individual product specifically. Instead ACE Multiprocess can be configured to interface with whatever job submission system is available at the user site.

Minimum Requirements

Currently, the following are required for the minimum functionality:
The name of the job submission executable or script (providing a full directory path to the executable or script is recommended, though it may not be necessary in some PATH configurations).

The job must be submitted in synchronous/blocking mode (the job submission process must not complete until the ACE child process/job has completed execution). ACE itself currently has no support for the tracking of job status through periodic queries as would be necessary with asynchronous/non-blocking jobs.

**Warning!**

A non-blocking/asynchronous job submission system currently risks data corruption, because ACE can no longer guarantee it knows when the job is complete, so ACE cannot properly manage data locking states across the simultaneously executing implementations.

An exit code of zero from the job submission process indicates success.

A non-zero exit code from the job submission process indicates failure. The Multiprocess system simply reports success/failure based upon the exit code value.

Presently, if the job system at the user site is not already a synchronous/blocking system, then it is necessary for the user to write their own script or executable which approximates synchronous/blocking functionality.

In theory, this should be possible:

1. Submit the job.
2. Capture the unique identifier for that job.
3. Loop while querying the job status (using the previously captured unique job identifier from the job system) until completion is indicated.
4. Capture the job exit code.
5. Return the appropriate exit code (to ACE) indicating the success or failure of the job status.

After the job submission request completes, and after any network files have been written, the ACE Multiprocess GUI reads the output files from the submitted job, gathering the information needed for the Multiprocess Summary Report. The read of the result files only happens once per job.

If the user job submission process finishes before the submitted ACE job is complete (as would happen with a non-blocking job submission system), the ACE implementation output files are either missing or incomplete when queried, and the Multiprocess Summary Report shows that no results were found for that ACE job.

**Optional Improvements**

When external job submission systems are properly configured, the following features are also available within ACE Multiprocess:

- Support for killing or cancelling submitted jobs
- Assignment of the job working directory
- Assignment of a job name
- Streaming real-time log output for each Job
Killing or Cancelling Already-submitted Jobs

For simplicity, the ACE Multiprocess system only manages the job through the (blocking) job submission process. The Multiprocess system currently does not track job identifiers or any special job status logged by the job submission process itself. When ACE needs to cancel or kill the job, it essentially sends a "kill" (technically a "SIGINT" in Linux) to the (blocking) job submission process. It is expected that this also kills/cancels the underlying ACE job. If this does not actually kill the underlying ACE job (or remove it from the appropriate job queue, etc.), then it becomes the responsibility of the ACE user to manually kill the job with the job submission tool.

Job Working Directory

In some cases it might be necessary to specify the working directory of the ACE job as a command line argument to the job submission process. While ACE jobs lacking an explicit working directory assignment are known to run without errors in most situations, some job submission systems may require the explicit assignment of a working directory. The working directory specified by ACE for a job changes for each implementation and, typically, is the implementation directory itself.

Job Name

It is extremely convenient for ACE Multiprocess to have a way to pass in the job name as a command line argument to the job submission process.

The job name does not aid ACE directly, but is intended to assist external users of the job submission system in tracking job status, job lifetime, queue management, etc. through other (non-ACE) tools.

The job name is currently made unique by concatenating the following information, with items in brackets replaced by their logical values:

- ACE_Multiprocess_[user name]_[project name]_[implementation name]

Additionally, special characters found in the variable values are replaced by the underscore (_) character.

Streaming Real-Time Job Log Output

ACE logs all of its normal output in a log file, which gets post-processed after job completion to verify how far ACE went through the flow, and to harvest the reported timing information for inclusion in the Multiprocess Summary Report. However, properly configuring the following can help the user track the progress of the ACE jobs as they run.

If the job submission process redirects or pipes the standard output and standard error streams from the underlying ACE job, so that the job submission process re-transmits that same data on its own standard output and standard error streams, then ACE may be able to show the streamed job output during the Multiprocess run.

If the underlying ACE job standard output and standard error streams are redirected to a file, preferably through user-managed command line options for the job submission process itself, then ACE may be able to show the streamed job output from the file during the Multiprocess run.

Note

Due to various concerns such as network file write caching and the occasional complexity of shell redirection in spawned processes, this job submission log file option may be difficult to get working properly.

Configuring ACE

The external job submissions are performed via a user-configurable command-line executable. The configuration is managed through the Multiprocess: Configure Custom Job Submission Tool Preference Page (see page 202), reached by following the (configured in Preferences) hyperlink in the Multiprocess View. As a potentially useful example, by default ACE is configured to use GridEngine (see http://en.wikipedia.org/wiki/Oracle_Grid_Engine) through the qsub command. (When using a system other than the GridEngine, users need to clear all fields on that preference page and provide the values which are appropriate for their own system.) For the configuration to work, the job submission command must be in the path (or have its path fully specified), and the ACE executable must be reachable from the job system execution hosts.
ACE is able to optionally provide some values to the job submission system if the related argument fields are populated. The optional values ACE may provide are:

- The working directory for the ACE Multiprocess job
- The job name
- The path and filename to be used by the job submission log file

It is extremely likely that additional command-line arguments are required by the job submission executable in order to meet the ACE minimum requirements. Additional arguments are also typically needed to assign execution queues, memory limits, etc. These additional arguments (and any argument values) should be specified on the preference page as well.

Caution!

Command-line arguments must not be specified in the Job Submission Executable field. Attempts to do so fail.

Debugging Job Submission System Configurations:

If the job submission system is properly configured on the host machine, (meaning it is possible to successfully execute non-ACE tasks using the job submission executable from the command line), and ACE is still unable to successfully submit jobs to the system, please contact Achronix technical support.

Warning!

Potential for File Corruption

Attempting to manually run the logged command on the command line (without the Multiprocess View additional automated safety locks in place) might cause ACE data file corruption.

While ACE does provide the complete attempted job submission command in the "Multiprocess Run Logs" section of the Multiprocess view, DO NOT copy the text of the attempted command and manually attempt execution from the command line. A large number of assumptions are made (including bypassing the normal project-level and implementation-level safety checks which prohibit file corruption) when ACE is executed using the provided command options and Tcl batch script — these assumptions are violated during manual execution attempts.

Network File System Latency Concerns

When dealing with external job submission systems, network drive latency becomes a concern. The ACE multiprocess system waits for each external process to complete before it harvests the timing information for that implementation. To avoid potential hangs (where the multiprocess system mistakenly waits forever for a file to appear, or for a file to be completely written), there is a configurable timeout setting, which is by default 5 seconds. If, after the external process for an implementation has completed, the timing summary information cannot be found within the allowed number of seconds, then the Multiprocess Summary Report (see page 240) shows the message "No Timing Results Found" for that implementation.

Note

A "No Timing Results Found" message for an implementation in the summary report means the timing information needed for the summary was not available within the allotted time. The allotted time may be increased using the Allowed seconds of NFS write latency setting in the Multiprocess: Configure Custom Job Submission Tool Preference Page (see page 202), as shown in the image below.
Configuring the Desired Flow to be Followed by the Selected Implementations

All the implementations run through the Multiprocess View follow the same flow steps (see page 223) through the flow (see page 223), as configured in the Flow View (see page 67). Thus, ensure that all optional flow steps are enabled /disabled as desired before starting multiprocess execution.

Additionally, in the section of the Multiprocess View labeled "Multiprocess Flow Management (see page 89)", it may be chosen to stop the multiprocess flows early, prior to traditional "completion". For example, when designs are known to be incomplete, and thus known to fail the Run Final DRC Checks flow step, it may be chosen to stop the flow prior to running that flow step.

To stop all the multiprocess flows at a given flow step, simply select that flow step in the Stop Flow After: drop-down list. No subsequent flow steps are executed for the selected multiprocess implementations.

As a convenience, since optional flow steps are frequently chosen to be the final multiprocess flow step, there is a Force Selected Flow Step to be Enabled checkbox. When checked, if the selected final flow step is optional and not enabled, then as the multiprocess implementations are scheduled, the selected flow step is enabled for all the multiprocess implementations before they begin execution. If this checkbox is left unchecked, and a disabled optional flow step is selected as the final step, then the final step executed is the last enabled flow step prior to the selected step.
For example, if **Stop Flow After** is set to **Run Post-Route Timing Analysis** (an optional step), but this flow step is disabled in the Flow View, and if **Force Selected Flow Step to be Enabled** is not checked, then the multiprocess flows stop after the (required) **Run Route** flow step, since that is the last enabled step prior to **Run Post-Route Timing Analysis**.

### Selecting the Implementations to be Run in Parallel

To select the implementations to be run in parallel:

1. In the Projects View (see page 123), select the desired project (see page 217). The Implementation Table within the Multiprocess view Select Implementations (see page 89) section is updated to display data for the active project and implementation (see page 223).

2. In the Multiprocess View, ensure the **Existing Implementations** radio button within the "Select Implementations" section is selected. This limits the contents of the Implementation Table to just the implementations which already exist for the active project (generating and executing new implementations using **option sets** (see page 217) is covered in Attempting Likely Optimizations Using Option Sets (see page 369)).

3. In the Implementation Table, all listed implementations are selected (the checkbox in the Implementation column will be checked) by default. Implementations may be selected/deselected in bulk with the **Select All** and **Deselect All** buttons. Individual implementations may have their selection toggled by clicking their checkboxes in the first column of the Implementation Table.

**Tip**

If the implementation table is not large enough (or is too large) for the full implementation list, simply collapse and/or expand one of the other sections in this view (left-click the section title). This causes the table to resize to exactly fit the current implementation list.

### Starting Background Execution

To start background execution:

1. When the parallel count has been set, the flow has been configured, and the desired implementations have been selected, click the **Start Selected** button, or the equivalent ( ) **Start Background Queue Execution** action in the Multiprocess view local button-bar or menu, to begin background multiprocess execution.

2. After multiprocess execution has been started, the **Parallel Queue Count** and Implementation Table is disabled. They are not re-enabled until multiprocess execution is completed. In the Multiprocess Run Logs (see page 91) section, a new tab is created for the logged output of each selected implementation. The log info in each tab is updated live as the corresponding implementation process executes (the displayed log info mirrors the information captured in the log files (see page 220) for each implementation).

3. As implementations are queued, start execution, and complete execution, the implementations execution states (see page 91) are updated in the implementation table, and each implementation log tab icon is also updated to show the current execution state.

**Note**

Presently, it is not possible to control the order of implementation execution.
Caution!

For safety, all ACE Tcl commands (i.e., most ACE GUI interactions) are blocked while multiprocess execution is underway. Blocked Tcl commands are queued and allowed to run when multiprocess execution is completed. Similarly, multiprocess execution is blocked until all in-process and already-queued ACE Tcl commands (including running the Flow in the foreground) are completed.

Stopping/Canceling Background Execution

All queued and executing background implementations may be quickly cancelled by selecting the ❌ Stop All button below the Implementation Table, or the equivalent ( ❌ ) Stop All Background Queue Execution action in the Multiprocess view local button bar or menu.

It is also possible to cancel execution of individual implementations. This may only be done via the ( ❌ ) Progress View. During multiprocess execution, a ( ❌ ) button to show this view is visible in the lower-right of the ACE status bar. This view is also available by selecting Window → Show View → Other... → General → Progress. The Progress View displays all queued and currently-executing background tasks, including the tasks for the background implementation processes. To the right of each listed incomplete background task is a ( ❌ ) stop icon, which cancels/stops execution of that task. Because the Progress View can list more tasks than just the background multiprocess implementations, caution should be used to avoid cancelling/stopping the wrong task.

Viewing the Results

After the first implementation completes execution, an HTML Multiprocess Summary Report (see page 240) file is created and opened in ACE (the report file is created in the project directory, and is named multiprocess_summary.html. This action automatically overwrites previous multiprocess summary reports without prompting). As each subsequent implementation completes execution, the multiprocess summary report is updated with the latest data.

As implementations complete execution, their execution states (see page 91) change appropriately. If an implementation encounters errors while running the flow, the execution state for that implementation becomes the Error state, which is reflected by the icon shown both in the log tab and the Implementation Table. In addition, the tooltip for the appropriate log tab and Implementation Table entry is updated to include a summary of the captured error messages. Error details are visible in the log messages shown in the tab, as well as within the Implementation Log (see page 221) and Multiprocess Log (see page 221) for that implementation.

Caution!

There is a known sequence whereby all multiprocess results are identical. If there is an existing project with previously generated option sets, and ACE has been upgraded to a newer version, it prompts when opening the existing project to reset the implementation (see page 217) options to the defaults for the new version of ACE. The recommendation is to accept this reset as a new version of ACE may include new implementation options which are only applied by accepting this reset. At the same time, older implementation options that have been deprecated are removed.

The issue is that currently ACE resets all of the option sets (see page 217) to the same default values. Subsequently, when a multiprocess flow is run with the new project, all results are identical. The workaround is, after having upgraded ACE to the new version and accepting the implementation (see page 217) option reset, delete all the implementations other than the original base implementation and then regenerate the option sets (see page 217).
**Multiprocess Batch Mode**

**Overview**
To obtain the highest QoR, ACE supports running multiple different implementations in parallel using Multiprocess. Multiprocess is available from the ACE GUI and is described in:

- Multiprocess View (see page 86)
- Running Multiple Flows in Parallel (see page 285)
- Attempting Likely Optimizations Using Option Sets (see page 369)

Multiprocess batch mode provides the same functionality as the GUI, but can be run from the ACE Tcl console command line or by using an external Tcl script. The relevant Tcl command is `run_multiprocess` (see page 605).

**Modes**
Similar to running Multiprocess from the GUI, Multiprocess batch mode must be run in the context of a currently Active Project and Implementation (see page 223). The current active project is used as the basis for all the implementations that are run, with the current active implementation used as the basis for any newly-generated implementations.

Multiprocess batch mode supports three modes of operation:

1. Generate implementations from option sets (default setting).
2. Seed sweep (`-seed_sweep`).
3. Use existing implementations (`-use_existing_impls`).

A full list of all options is given in the `run_multiprocess` (see page 605) manual page.

**Generate Implementations From Option Sets**
Running from option sets is the default mode of operation for Multiprocess batch mode and is used when neither `use_seeds` nor `use_existing_impls` is specified. This mode generates fresh implementations for every available option set definition. Previously existing implementations with the same name are overwritten. See Attempting Likely Optimizations Using Option Sets (see page 369) for additional details.

The currently active implementation is always included as one of the executed flows when this mode is used.

**Seed Sweep**
The seed sweep mode generates fresh implementations (based upon the active implementation) for every specified seed value. Previously existing implementations with the same name are overwritten.

Seed sweep mode is selected by use of the `-use_seeds` argument:

```
run_multiprocess `-use_seeds` {5 7 13}
```

The current active project and implementation forms the basis of each generated implementation, with the implementation option "seed" set to the given seed value as an override of the seed inherited from the active implementation.

Implementations created during seed sweep are named `{active_impl_name}_seed{value}` (e.g., `impl_1_seed18` for a seed value of 18 and an active implementation name of `impl_1`).

The currently active implementation is always included as one of the executed flows when this mode is used.
Use Existing Implementations

The Use Existing Implementations mode does not generate any new implementations, but simply runs each of the named implementations. Use Existing Implementations mode is selected by use of the `-use_existing_impls` argument:

```bash
run_multiprocess -use_existing_impls {impl_1 impl_1_improved impl_1_experimental}
```

To run all existing implementations, specify:

```bash
run_multiprocess -use_existing_impls [get_impl_names]
```

Unlike the other modes, the currently active implementation is NOT included as one of the flows run unless it is explicitly named in the `-use_existing_impls` list.

Flow Steps

An important principle to understand is that the enabled or disabled Flow steps (see page 223) of the currently active implementation are inherited by all implementations executed during Multiprocess batch mode. Therefore, before commencing the Multiprocess batch mode, ensure that the currently active implementation has the desired flow steps enabled (and has the unwanted flow steps disabled).

In addition, Multiprocess batch mode can be configured to stop at an explicit flow step via the `-stop_flow_at` argument. This argument can be used to terminate each flow at a particular step. For example, if `report_timing_routed` is specified as the stop step, then none of the DRC or bitstream flow steps are performed (because those flow steps occur later than the chosen stop step; see the Flow Steps (see page 223) page for the ordered complete listing of all default flow steps). Using the `-stop_flow_at` argument reduces the overall time taken for Multiprocess batch mode, as each implementation runs a reduced number of flow steps. After Multiprocess batch mode has completed and an implementation has been found which achieves the desired QoR, then that implementation can be loaded into ACE, and the final flow steps executed. With the aforementioned example, which was stopped at `report_timing_routed`, the routed .acxdb can be loaded into ACE, and the DRC and bitstream generation flow steps subsequently executed to produced the required bitstream.

**Note**

If the flow step specified by `-stop_flow_at` is disabled in the active implementation when the multiprocess run begins, (as long as the current Flow mode (see page 228) allows it) the step is explicitly enabled for the active implementation and all executed implementations.

Getting Started

The commands to start Multiprocess batch mode vary according to whether ACE is running in command-line mode, batch mode (using a script file), or from within the ACE GUI.

Command-line Mode (Interactive)

1. Open ACE in command line mode (`ace-b`). See Running ACE (see page 262).
2. Use `restore_project` (see page 601) to load the project.
3. Set the active implementation (see page 618).
4. (Optional) Use `disable_flow_step` (see page 562) and `enable_flow_step` (see page 567) to configure any flow steps desired/needed or bypassed for all of the implementations that are to be run.
5. Issue `run_multiprocess` (see page 605) command. See examples (see page 298) below.
Batch Mode (Script File)

1. Open ACE in command-line mode, passing in a script file. Use script arguments to specify the project name (`ace -b -script_file <my_mp_batch_script.tcl>`). See Running ACE (see page 262).

```bash
$ ace -batch -script_file <my_mp_script> -script_args <my_project_name>
```

An example script file, using the project names as the first argument is shown below.

```tcl
# Script file to run Multiprocess batch mode
set my_proj [lindex $argv 0]

# 1. Restore the project
restore_project $my_proj

# 2. Set active implementation (to the default)
set_active_impl impl_1

# 3. (Optional) Ensure Run Estimated Timing Analysis flow step is enabled. Disable Generate Bitstream
enable_flow_step report_timing_routed
disable_flow_step write_bitstream

# 4. Run Multiprocess batch mode generating new implementations from option sets
#     Set to a maximum of 8 jobs
#     Stop after Post-Route Timing Analysis.
run_multiprocess -parallel_job_count 8 -stop_flow_at report_timing_routed
```

**Note**

When running in the command-line mode, or batch mode, in order to cancel a Multiprocess batch mode run, CTRL+C must be used.

ACE GUI

1. Open ACE GUI.
2. Load the project (see page 273).
3. Set the active implementation (see page 281).
4. (Optional) Using the Flow View (see page 67), select or deselect any flow steps desired/needed or bypassed for all of the implementations that are to be run.
5. In the Tcl console window, issue the `run_multiprocess` (see page 605) command. See examples (see page 298) below.
Examples

Running all Option Sets
To run all option sets, using the existing maximum job count as specified in your ACE GUI preferences:

```
run_multiprocess
```

To run all option sets, limiting concurrent jobs to 8:

```
run_multiprocess -parallel_job_count 8
```

Running a Seed Sweep
To run a seed sweep using preferred seed values:

```
run_multiprocess -use_seeds {2, 3, 5, 7, 11, 13, 17, 19, 23, 29, 31}
```

Re-running Four Existing Implementations
To re-run four existing implementations all at the same time:

```
run_multiprocess -use_existing_impls {impl_1 impl_1_acx_mux_utl_seed impl_1_acx_seed21 impl_1_acx_seed33} -parallel_job_count 4
```

Re-running an Existing Implementation
To re-run an existing implementation, stopping just after running "write netlist final":

```
run_multiprocess -use_existing_impls {impl_1_seed88} -stop_flow_at write_netlist_final
```

Running all Option Sets
To run all option sets on the grid, with custom job submission parameters:

```
run_multiprocess -use_job_submission 1 -jobs_wd my_jobs_working_dir -jobs_name my_job_name -jobs_log my_jobs_logfile -jobs_args {{-sync y} {-j y} {-b y}}
```

Progress Monitoring
Within the Tcl console or shell, `run_multiprocess` checks each of the input arguments to ensure they are correct (including checking that any specified existing implementations exist) and then launches the requested number of parallel implementations runs. Within the Tcl console or shell, `run_multiprocess` indicates the start and completion (success or failure) of each implementation run.

To monitor progress, use the Multiprocess Summary Report (see page 240) file that indicates which implementations have completed and their timing summary. This report is generated regardless of whether the Multiprocess batch mode was run from a command shell, or from within the ACE Tcl console. This report can either be viewed external to ACE using a web browser, or within ACE as detailed below.
Viewing Multiprocess Summary Report within ACE

Open the Multiprocess Summary Report from the Projects view, by right-clicking the project.

![Figure 134: Open Multiprocess Report](image)

The report can be refreshed by right-clicking the view and selecting **Refresh**, or by pressing the refresh hotkey, **F5**, when the report tab has focus (click the report first). The report view does not automatically update when using Multiprocess batch mode. This behavior differs from when Multiprocess is run directly from the GUI Multiprocess view, where the report view is automatically updated after each implementation completes execution.
Furthermore, progress monitoring can be achieved if a job submission system is used — completed jobs might be able to be monitored using the job submission system tool suite. Finally, to see the status of an individual implementation, open the `<implementation>/log/multiprocessimpl.log` file, and monitor updates to the individual implementation progress.

**Stopping the Running Implementations**

When running in command-line or batch mode, use CTRL+C to cancel a Multiprocess batch mode run. When calling `run_multiprocess` in the ACE GUI Tcl Console view (see page 144), (as with all other Tcl commands,) the command can be cancelled using the Progress view (Window → Show View... → Other → Progress).

**Detecting Changes to Project Source Files**

ACE provides a rich set of features to enable detecting changes to project source files against the state of the project files loaded into the ACE database during the Run Prepare flow step, as described in the following sections.

**Files Open in the ACE Editor Area**

If a project source file is open in a text editor window, a pop-up dialog box appears offering to refresh the contents of the stale file in the ACE editor tab if the source file is changed on disk.
Smart Change Detection Using Custom Checksums

Instead of caching timestamps for files to perform the checking, ACE caches custom file checksum values. The checksums are computed in a robust way that ignores comment lines and whitespace lines, so that only the actual Verilog netlist or SDC/PDC constraints commands are used in the checksum. This allows generated files, such as the Synplify netlist, to be regenerated from the same RTL which produces the same gate level netlist, but with different comments at the top, to be treated as an unchanged file. Timestamps are inherently fragile and change when a project is copied from one directory to another. This checksum approach is much more robust and does not flag a source file as changed unless its content is meaningfully changed.

Saving the Active Implementation

When ACE saves an ACXDB file (when the state of the ACE database is saved for the active implementation), it caches the checksums of all project source files used to create that state in the DB. The project source file checksums are saved inside the .acxdb file.

Restoring the Active Implementation

When ACE loads/restores an ACXDB file (when saved place and route data is loaded from the .acxdb file on disk into the ACE database for the active implementation), ACE checks all project source files and checksums on disk against the cached project source files and checksums inside the ACXDB file. If a project source file has been added to the current ACE project, removed from the current ACE project, or if its file checksum has changed, ACE prints a warning message to the Tcl Console and ACE log file. This alerts users that the saved ACXDB is out of sync with the current project source files.

Caching the Project Source File State

The Run Prepare flow step is the first flow step, and is where all project source files are loaded into the ACE database from disk. Whenever the Run Prepare flow step is run, ACE caches the project source files and checksums for all files used in the active ACE project implementation.

Automatic Checking while Running the Flow

Each flow step (Run Place, Run Route, Timing Analysis, Final DRC checks, etc.) checks the project source files (including the .acxprj ACE project file itself) and checksums on disk against the files and checksums cached at the beginning of Run Prepare. If any file is missing, added, or out of sync, ACE reports a warning at the end of each flow step to the Tcl Console and ACE log file:

![Tcl Console](image)

**Figure 136: Missing, Added, or Out of Sync File Warning Example**
Warning Visualization in the Flow View

If any flow step reports a warning about out-of-sync files, all completed flow steps in the Flow View (see page 67) are marked with a yellow warning icon instead of the green checkmark icon to indicate that the step is complete, but is out of sync with the source files on disk. The tooltip text in the Flow View shows all the warning messages.

Even when no flow step Tcl commands are running, the GUI checks the project source files and checksums every 5 seconds (by default) in a background thread. If any file becomes out-of-sync, all completed flow steps in the Flow View are marked with a yellow warning icon instead of the green checkmark icon to indicate that the step is complete, but is out of sync with the source files on disk.

Figure 137: Out of Sync File Warning Example

Pop-up Dialog Warnings

If the flow is running, a “Project Source Files Changed” dialog appears if a change to project source files is detected during the built-in check at the end of each flow step. The same warning messages that are printed to the Tcl console are displayed in the dialog. Optionally choose to cancel running the rest of the flow, or let the flow continue. The flow continues to run in the background until the choice is made. The pop-up dialog has a preference checkbox which allows disabling the pop-up from being shown in the future.

Figure 138: Project Source Files Changed Dialog Example
If the flow is not running, a different "Project Source Files Changed" dialog appears if a change to project source files is detected during the built-in check at the end of each flow step. The same warning messages that are printed to the Tcl console are displayed in the dialog. There is no choice for cancelling the running flow, since the flow is not running. The pop-up dialog has a preference checkbox which allows disabling the pop-up from being shown in the future.

![Project Source Files Changed dialog](image)

**Figure 139: Project Source Files Changed Dialog Example When Flow Is Stopped**

---

**Note**  
**Minimal Pop-up Interruptions**

In general, pop-ups are minimized to only alert new changes. The Project Source Files Changed dialog appears only when a new change is detected. So if the gate level netlist file is changed while the flow is running, the pop-up (if enabled by the user preference) appears. If the same gate level netlist file is then changed several more times, no further pop-up appears since there has already been a notification that the file is different than the original source file. However, if a project constraints file (in addition to the gate level netlist) is then changed, the Project Source Files Changed dialog appears again to alert that now 2 source files are changed.

---

**Managing Pop-up Preferences**

There is a user preference to enable/disable the Project Source File Changed pop-up at the bottom of the Project Management Preference Page (see page 211). This preference setting is the same as that controlled with a checkbox in the Project Source File Changed Dialog. From the main menu bar, select **Window → Preferences** and select **Project Management** on the left-hand side of the Preferences dialog. This preference page can be used to re-enable the pop-up if the checkbox in the dialog is enabled.
Table 139: Project Management Preferences

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>See also:</td>
<td>Link to Colors and Fonts preferences allowing choice of the font used in the Projects view.</td>
</tr>
<tr>
<td>Close editors on active implementation change</td>
<td>Can be used to automatically close open editors when the active implementation changes.</td>
</tr>
<tr>
<td>Open Multiprocess summary on active project change</td>
<td>Can be used to automatically open the Multiprocess summary report when the active project changes.</td>
</tr>
<tr>
<td>Open reports on active implementation change</td>
<td>Can be used to automatically open implementation-specific reports when the active implementation changes.</td>
</tr>
<tr>
<td>Only open most-recent report of a given type</td>
<td>Can be used to automatically open only the most-recent report of a given type.</td>
</tr>
<tr>
<td>Save changed editors from the active project before running the flow</td>
<td>Can be used to automatically save all open editors before running the flow.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Reload Project overwrites unsaved local project changes automatically</strong></td>
<td>Can be used to automatically overwrite unsaved local project changes when Reload Project is used (without a confirmation prompt).</td>
</tr>
<tr>
<td><strong>Enable background checking for project source file changes during the flow</strong></td>
<td>If enabled, project source files are periodically polled in the background to look for any changes made outside of ACE.</td>
</tr>
<tr>
<td><strong>Hide the pop-up dialog when project source files change during the flow</strong></td>
<td>If enabled, source file change notification is suppressed until the flow has finished running.</td>
</tr>
<tr>
<td><strong>Project source file change background checking frequency (seconds)</strong></td>
<td>Determines how often to poll for background source file changes.</td>
</tr>
<tr>
<td><strong>Group reports by type</strong></td>
<td>If enabled, reports are grouped into subfolders in the Projects view tree.</td>
</tr>
<tr>
<td><strong>Only show HTML reports</strong></td>
<td>If enabled, only HTML reports are shown in the Projects view tree.</td>
</tr>
<tr>
<td><strong>Only show the most recent report</strong></td>
<td>If enabled, only the most recent report is shown in any subfolder in the Projects view tree.</td>
</tr>
</tbody>
</table>
**Tcl Command Support**

The `check_project_status` Tcl command can be called to manually check file and checksum consistency outside of the built-in checks performed at the end of each flow step. If any file is missing, added, or out of sync, ACE reports a warning to the Tcl Console and ACE log file. This command only applies if the flow has run at least through the **Run Prepare** flow step and there is a design loaded in the ACE DB.

**Custom Flow Steps**

Custom flow steps can be created by right-clicking the Flow view (see page 67) tree and selecting **Create Flow Step**. The Create a new Flow Step dialog (see page 158) appears:
Remove a custom flow step by right-clicking the Flow view tree and selecting **Remove Flow Step**.
Persistent Custom Flow Steps

Custom flow steps can be defined in an `ACE_INIT_SCRIPT` (see page 262) to make them persistent across ACE sessions, so they are defined every time you launch ACE.
Using the Tcl Console

Any operation that changes project or design data can be performed from the command line via a Tcl command. The Tcl Console view (see page 144) provides an interface from within the GUI for viewing and executing Tcl commands.

Sending Commands from GUI Actions

Any action in the GUI that changes project or design data automatically sends a Tcl command through the Tcl Console view (see page 144) to do the work. All Tcl commands generated by GUI actions are displayed in the Tcl console along with any output from the command.

Figure 141: Tcl Console Example

Sending Commands from the Console

To send a command from the Tcl console:

1. Enter or paste the command text at the available cmd> prompt in the Tcl console view. Valid commands are highlighted in bold green.
2. Either press ENTER or click the ( ) Send Command toolbar button in the Tcl console view.

All output from the command is displayed in the Tcl Console view under the command prompt. Informational messages are displayed in italic blue text. Warning messages are displayed in italic yellow text. Error messages are displayed in italic red text.

Command Highlighting

Text entered in the Tcl console is checked against the valid set of user Tcl commands. Valid commands are highlighted in bold green.

Command Auto-Completion

When typing into the Tcl console, pressing the TAB key pops up a Tcl command auto-completion dialog if the current cursor position in the text has any possible matches. If no possible matches are found, an error beep sounds.
Pressing the TAB key at an empty cmd> prompt pops up the full list of available commands. When the command auto-completion dialog is open, use the arrow keys to navigate up and down the list of choices and press the Enter key on a selected command to complete it at the command prompt. Typing while the command auto-completion dialog is open shortens or lengthens the list of valid commands, depending on the cursor position in the Tcl console view.

![Figure 142: Tcl Command Auto Completion Dialog Example](image)

Command Help

When the command auto-completion dialog is open, help text appears to the right of the command list for the selected command.
To view help text for commands, either bring up the command auto-completion dialog and select the desired command, or enter the command name at the `cmd>` prompt and use the `-help` argument to output the help text to the Tcl console.

**Figure 143: Tcl Command Auto Completion Dialog Help Text Example**

**Text Limit**

The Tcl console view has a limit of 2000 lines. When this limit is reached, any new lines entered via commands or message text causes the text at the top of the Tcl Console to be pruned.

Additionally, when Tcl command return values are displayed in the Tcl console, any long returned values are visually truncated at 500 characters in the console. The actual returned value is not edited, just the textual representation shown in the console.

**Note**

- Performance of the Tcl console is much higher when there are fewer than 2,000 lines of text.
- Hitting the text limit does not clear the contents of the ACE log file. All messages continue to be logged in the log file and earlier messages are not removed.
Clearing the Console

Text in the Tcl console view can be cleared by clicking the ( ) Clear Console toolbar button in the Tcl console view. This action truncates all text in the console up to the current cmd> prompt line.

**Note**
- Clearing the console increases console messaging performance.
- Clearing the console does not clear the contents of the ACE log file.

Viewing the ACE Log File

All Tcl commands and messages issued during an ACE session are recorded in the ACE log file. If the text limit is reached from excessive messages, it is sometimes useful to browse the log file for previous messages. To open the ACE log file in the editor area, simply click the ( ) Display Log File toolbar button in the Tcl Console view.

Object Type Prefixes

There are a variety of different object types supported by ACE. Most of these object types have a special single-letter prefix designating the type. These type prefixes are useful to avoid name collisions (i.e., between a net and a pin with the same name).

Many Tcl commands (i.e., select) require that these prefixes be used when commands are issued. Other commands (i.e., find), by default, include these prefixes on the return values.

**Table 140: Object Type Prefixes Used in ACE Tcl Commands (Sorted Alphabetically by Prefix)**

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Object Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>c:</td>
<td>Critical Path</td>
</tr>
<tr>
<td>d:</td>
<td>Device Port</td>
</tr>
<tr>
<td>f:</td>
<td>Fabric Pin</td>
</tr>
<tr>
<td>i:</td>
<td>Instance</td>
</tr>
<tr>
<td>k:</td>
<td>Clock Domain</td>
</tr>
<tr>
<td>n:</td>
<td>Net</td>
</tr>
<tr>
<td>p:</td>
<td>Port</td>
</tr>
<tr>
<td>s:</td>
<td>Site</td>
</tr>
<tr>
<td>t:</td>
<td>Pin</td>
</tr>
</tbody>
</table>
### Table 141: Object Type Prefixes Used in ACE Tcl Commands (Sorted Alphabetically by Object Type)

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Prefix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clock Domain</td>
<td>k:</td>
</tr>
<tr>
<td>Critical Path</td>
<td>c:</td>
</tr>
<tr>
<td>Device Port</td>
<td>d:</td>
</tr>
<tr>
<td>Fabric Pin</td>
<td>f:</td>
</tr>
<tr>
<td>Instance</td>
<td>i:</td>
</tr>
<tr>
<td>Net</td>
<td>n:</td>
</tr>
<tr>
<td>Pin</td>
<td>t:</td>
</tr>
<tr>
<td>Port</td>
<td>p:</td>
</tr>
<tr>
<td>Site</td>
<td>s:</td>
</tr>
</tbody>
</table>

## Creating an IP Configuration

Achronix FPGAs feature a wide variety of embedded IP. These highly flexible IP blocks require configuration for proper operation.

ACE includes a number of IP editors (see page 27) and views (see page 33) which work together to provide a guide through the process of correctly configuring IP. The data for these IP configuration editing sessions is stored in `.acxip` files, which may be saved and loaded for future reuse or modification.

Using the data stored in the `.acxip` files, ACE generates RTL wrappers (Verilog and VHDL) containing the specified configuration parameters around the appropriate Achronix macro cells, as well as appropriate `.sdc` and `.pdc` files to complete the IP timing and pre-placement configuration. These generated files may then be incorporated into the user design for synthesis and simulation.

### Note

Use of a generated VHDL wrapper also requires the generated Verilog wrapper (the VHDL simply wraps the Verilog instantiation).

Creating and editing IP configurations is typically performed from the (IP configuration perspective (see page 24). In addition to the IP Configuration editors, this perspective incorporates supporting views allowing:

- Creating new IP configurations (IP libraries view (see page 84))
- Viewing a graphical diagram of the IP configuration currently being edited (IP diagram view (see page 82)); the diagram may show the macro interface, the dataflow, and/or the placement of the IP instance within the chip.
Navigating instantly to any page of the active IP configuration editor, while displaying the names and validity of each page (outline view (see page 115))

Viewing a detailed list of all the errors and warnings pertaining to all IP configuration files currently opened (IP problems view (see page 84))

Navigating directly to the source of the problem in the relevant IP configuration editor (IP problems view (see page 84))

The major subtasks regarding IP Configuration management are covered in the following sections.

Creating and Naming an IP Configuration

Switch to the IP configuration perspective either by clicking the ((IP configuration perspective icon or selecting Open Perspective → IP Configuration from the main menu. Select File → New → IP Configuration... from the main menu, or use the IP libraries view (see IP libraries view (see page 84)) to open the New IP Configuration Dialog (see page 174). After setting the location and name for the .acxip configuration file, click Finish to complete the process and activate the appropriate IP editor.

**Caution!**

The file name chosen for the .acxip configuration file is used as the module name for the generated Verilog module. A name must be chosen for the .acxip configuration file that is both a valid file name and also a valid Verilog module name which does not conflict with any other module names defined in the Achronix libraries. For example:

- If the .acxip configuration file is named foo.acxip, the generated Verilog module is named module foo.
- If the .acxip configuration file is named LRAM.acxip, the generated Verilog module is named module LRAM.

If LRAM is a primitive in the Achronix libraries, the user design errors out in simulation or synthesis with module name conflicts.

Setting the IP Configuration

From the IP Editor, use either the « Back and Next » or the Outline view (see page 115) to navigate the editor pages, setting the appropriate values needed for the desired configuration. Any errors and warnings are displayed in the IP Problems view (see page 84). Some IP editors also display supplemental graphical information in the IP Diagram view (see page 82).

In addition to the list of problems within the IP problems view, to the left of most fields (sometimes also called properties) there is a button with an icon indicating the validity of the value in that field. The green checkmark (✔) indicates the value in the field has no problems. A warning (⚠️) or error (❌) icon is shown when the field value does have one or more problems. The tooltip for the button then shows the problem being reported for the associated field. Clicking the button transfers the application focus to the IP problems View, and within that view, selects all the problems associated with that field.

**Note**

In complicated IP, where there are many interactions between fields, there might be more than one problem entry associated with a single field.
Editable Fields

Most of the properties/fields within the IP Editor pages are editable and correspond (sometimes loosely) to parameters in the underlying Verilog macros.

Editable fields are meant to be modified in a top-down, left-to-right order. This order is recommended because some of the field values affect the validity of downstream values, and ACE often tries to help keep configurations legal by automatically changing downstream values when they are incompatible with newly-edited upstream values.

Often, editable fields may be temporarily disabled when upstream choices cause the field to become irrelevant, or to have only a single legal value. Disabled editable fields become read-only and are shown with an alternate background color, typically grey.

Tip

Modifications should be made to fields within the IP configurations editors in a top-down, left-to-right order. When editing an upstream value, it often causes downstream values to be overwritten without warning.

Calculated Fields

Some of the fields in the IP editor pages are never editable. These fields contain calculated values based upon the current contents of user-editable fields. These calculated fields are provided for informational purposes.

Many of these calculated values have limited ranges of legal values — when the calculated value falls outside the legal range, the calculated value background color changes to indicate a problem. As when user-editable IP configuration properties fall outside a legal range, an IP problem entry (see IP problems view (see page 84)) is created. But an IP problem created by a calculated value field does not "blame" the calculated value field, it instead blames one of the user-editable properties involved in its calculation. While only one field is blamed in an IP problem entry, be aware that all active fields that might be involved in the calculation are listed in the IP problem entry as potential fields which, when changed, might fix the IP problem.

Note

While only one field is allowed to be blamed in an IP problem entry, remain aware that all active fields that might be involved in the calculation are listed in the IP Problem entry. Any one of these listed fields, when changed, might fix the IP Problem.

IP Editor Navigation

Navigate between sequential IP editor pages by using the « Back and Next » buttons. When one of these buttons becomes disabled, it means there are no further pages of configuration information in the indicated direction.

The currently active page is always selected in the outline view (see page 115). Navigate directly to a given IP configuration page simply by selecting the desired page name in the Outline View. Be aware that pages may be created or removed from the outline view based upon user changes to the IP configuration editable fields.

Left-click any text in the IP diagram view (see page 82) to turn to the IP configuration editor page containing the settings for that text.

Double-click a table entry in the IP problems view (see page 84) to turn to the IP configuration editor page containing the property being blamed for the selected IP problem.
Generating the IP Design Files

After setting the IP configuration, click the (Generate IP Design Files) icon to open the Generate IP Design Files dialog (see page 170). Select the desired options such as whether to generate the Verilog wrapper, VHDL wrapper, timing constraints, placement constraints, etc. After selecting the desired options and file paths, click Finish to create the selected files.

**Note**
The generated VHDL RTL wrapper is not standalone. It requires the generated Verilog RTL file.

Adding Configuration Files to a Project

Existing configuration files (from other projects, or that were removed from the current project at some point) can be manually added to the active project. Use the procedure under adding source files (see page 275) to add the configuration file and its related source files to the active project.

Live Link Tuning for SerDes and Derived Interfaces

**Warning!**
This section is only a summary; external references contain complete details.

A complete GUI Link Tuning reference is available as a separate document, the SerDes Link Tuning GUI User Guide. Despite the specificity of the document name, that reference is presently expected to cover the GUI Link Tuning behavior for all Speedster FPGA SerDes-derived interfaces requiring link tuning.

Other reference documents are planned for alternate (non-GUI) link tuning procedures, including (in some cases) automated tuning that can be managed from within the logic of user designs (without requiring manual user intervention).

The remainder of this section of the ACE User Guide should be considered only an overview of the GUI link tuning procedure. See the external reference(s) for more complete link tuning details, including valuable troubleshooting information.

Several of the high-speed interface IP flavors on Achronix Speedster FPGAs are derived from the SerDes interface, or potentially use a specialized subset of the full SerDes functionality. The SerDes PMA Rx Equalization must be tuned specifically to each type of application, board, usage, or data pattern to get optimal link quality. The Rx Eq settings used for a 10G Ethernet application might not work for a 10G Interlaken application, and optimized values for one board may or may not be optimal values for another board with that same application. That said, a group of settings can usually be found that work across a wide range of applications/boards for a given protocol.

The Achronix Speedster SerDes PMA hardware comes equipped with an adaptive equalization engine that enables computing new Rx Equalization settings to find the best possible eye opening for the link. The adaptive equalization feature (Auto Eq) can be run via a sequence of register reads / writes to the SerDes PMA. As a result, new PMA Rx equalization settings are computed and stored in the PMA registers.

The hardware also allows measurement of the quality of the Rx four-point eye opening, which is translated into a single number called the Figure of Merit (FOM). The larger the Figure of Merit, the larger the eye opening. The FOM is also captured using a sequence of PMA register reads and writes.
To access the SerDes Link Tuning feature in the ACE GUI, go to the IP Configuration Perspective (see page 24) and open the existing ACXIP file for the SerDes, Interlaken, or Ethernet interface. This opens the appropriate IP Configuration Editor for the chosen IP. While each of these editors includes its own Link Tuning Page, the pages are currently identical for all three IP flavors. The Link Tuning pages support simultaneous tuning of 1 to 12 SerDes lanes (as defined by the Number of Lanes on the Overview page of each ACXIP file). The Rx PMA Eq and Tx PMA Driver parameters may be viewed and altered (for all used lanes) live on these pages, but there is presently no support for automated tuning of the Tx parameters.

Note

A properly configured ACXIP file is required before beginning Link Tuning.

It is assumed that customers are using the ACE IP Configuration GUI to generate the wrappers for the SerDes (etc.) interface when integrating the SerDes (etc.) IP into RTL. As a result, an existing ACXIP file must be had before commencing GUI-managed Link Tuning. If an ACXIP file is not available, a new SerDes, Interlaken, or Ethernet ACXIP file can be created (see Creating an IP Configuration (see page 314)) and configured to match the settings used in the design, including (very important) the exact number and placement of the SerDes lanes. A properly configured ACXIP file is an absolutely necessary starting point for the GUI Link Tuning process.

The GUI Link Tuning pages interact with a live FPGA through the Bitporter JTAG interface. It is assumed that the ACE <-> FPGA JTAG connection is already properly configured, since it is also required when Programming a Device (see page 367), a necessary precursor to Link Tuning.

Note

The Bitporter/JTAG connection must be configured before using the Link Tuning functionality!

During Link Tuning, ACE interacts with the FPGA using the JTAG interface through a Bitporter pod. This Bitporter / JTAG interface must be properly configured in ACE before using the Link Tuning functionality. The configuration is managed using the Configure JTAG Connection Preference Page (see page 187). See Configuring the JTAG Connection (see page 339) for more details.

A Summary of the Link Tuning Process

The Link Tuning page is a portion of the full IP Configuration Editor. As such, the rest of the IP Configuration Editor pages must be properly configured for the interface to be tested, before beginning tuning. Most importantly, the configured number of lanes and the lane placement must be correct, and identical to the SerDes lanes being used on the running FPGA.

1. Create a Speedster SerDes, Interlaken, or Ethernet IP Configuration by creating a new ACXIP file and filling in all needed configuration options. See Creating an IP Configuration. (see page 314)
2. Complete the configuration process for the selected IP. Pay special attention to the proper setting of the number of lanes, and the placement of the lanes on the FPGA. See Setting the IP Configuration (see page 315).
3. Save the ACXIP file and generate the IP design files (RTL, SDC, PDC, etc). Integrate these files into the full design. See Generating the IP Design Files (see page 317).
4. Run the design through Synthesis, and then Place and Route. When timing is met, generate a bitstream. See Running the Flow. (see page 283)
5. Make sure all ref clocks are connected and running on the board, including for each of the SerDes lanes used in the design.
5. **Note**

Do not forget the ref clocks!

Connecting and running the ref clocks to the utilized SerDes lanes is the detail most often forgotten when attempting Link Tuning. Save everyone a support call, and double-check that the clocks are connected and running to all the lanes configured in the ACXIP file before starting link tuning! There is an easy-to-read Placement Diagram in the IP Diagram View (see page 82) which shows the exact lanes being used by the current ACXIP file. As an example, see the diagram for the Speedster22i SerDes Configuration Editor.

6. Program the FPGA with the generated bitstream (from step 4). See Programming a Device (see page 367).

7. Run either real data traffic or an appropriate test pattern (PRBS31, etc) which closely matches the expected data pattern/encoding into the FPGA over the link to be tuned. This is used for the initial FOM capture.

8. Open the ACXIP file (the same one used during the above preparation) in ACE and go to the Link Tuning Page.

9. Press the **Update from Chip** button to see the status of the PMA and initial FOM for each lane.

**Note**

Do not proceed to the next step until all the PMA Status lights for all lanes are green!

After the update from chip completes, if the PMA status is not all green (good) for a given lane, then no FOM can be computed, and Rx Auto Eq cannot be run on that lane. The issue with the PMA status must first be fixed before continuing. The fix might involve manually changing some Tx Driver or Rx Eq settings to get the status to become green (good).

10. When the PMA status is good, observe the initial FOM for each lane. It is good practice to write down the FOM values, along with the Rx and Tx settings used. Taking screenshots is an easy alternative (ACE presently does not log the full tuning process).

11. Press **Run Rx Auto Eq** and wait for it to complete.

**Warning!**

Rx Auto Eq tuning should not be run with live traffic over the link.

While FOM capture may be performed as a background procedure at any time with live data, the Rx Auto Eq tuning algorithm cannot.

Rx Auto Eq tuning is not supported as a background process. Changing any Rx Eq parameter (including those affected during automated tuning) while receiving live traffic results in bit errors. Rx Auto Eq tuning should only be performed as a foreground tuning procedure while sending idle characters.

12. Observe the new FOM for each lane. The new FOM should be much better than the initial FOM. Again, it is good practice to capture the new FOM along with the settings used.

13. Press **Sync GUI with Chip** and then save the ACXIP file (File -> Save) to store the new tuned Rx Eq settings back into the source ACXIP file.

14. Re-generate the IP design files (RTL, SDC, PDC, etc) from the ACXIP file and double-check that the newly updated files are included in the full design.

15. Re-run Synthesis, Place and Route, and Bitstream Generation to capture the new optimal Rx Eq settings back into the bitstream.
Viewing the Floorplanner

This section covers working with the floorplanner.

Opening and Closing the Floorplanner's Fly-Out Palette

To open and close the Floorplanner view fly-out palette of view options:

1. Click the ( ) Fly-out button on the far right side of the Floorplanner View (see page 57) to open the fly-out palette.

   **Note**
   While the fly-out palette is open, it may be resized by clicking and dragging its left border.

2. When the view options are configured, click the ( ) Fly-in button on the left side of the fly-out palette to close the fly-out palette.

Zooming the Floorplanner In and Out

There are several ways to zoom in and out in the Floorplanner View (see page 57).

**Note**
Zoom levels are always in powers of 2 (i.e., zoom in is at 200% and zoom out is at 50%). Therefore, it might not be possible to zoom in to perfectly fit a given area.

To zoom in and out with the mouse wheel:

1. Hover the mouse cursor over the desired point from which to zoom in or out in the Floorplanner view.
2. Move the mouse wheel forward to zoom in or backward to zoom out.

To zoom in and out using keystrokes:

1. Hover the mouse cursor over the center of the desired area from which to zoom in or out in the Floorplanner view.
2. Type either "Z" or "+" on the keyboard to zoom in or "z" or "-" to zoom out.

To zoom in and out using the **Zoom Tool**:

1. Select the ( ) Zoom Tool from the view toolbar.
2. To zoom in on an area, click in the upper left corner of the area desired and drag the mouse to the lower right until the zoom rectangle encloses the area desired. To zoom out, click the point on the Floorplanner view from which to zoom out and drag the mouse to the upper left until the zoom out label indicates the desired zoom level.

To zoom in and out with the **Placement Tool**:

1. Select the ( ) Placement Tool from the view toolbar.
2. Hover the mouse cursor over the point from which to zoom in or out in the Floorplanner view. Click the left mouse button to zoom in or the right mouse button to zoom out.

To zoom in and out with the **Zoom In** and **Zoom Out** buttons:
1. Pan to the area from which to zoom in to or out in the Floorplanner view.
2. Click the ( Zoom In) button to zoom in or the ( Zoom Out) button to zoom out.

**Floorplanner Panning**

To pan with the scroll bars:

1. Click and drag the vertical scroll bar to pan up and down or click and drag the horizontal scroll bar to pan left and right.
2. In Linux, place the mouse cursor over a scroll bar, then roll the mouse wheel.

To pan with key-strokes:

1. Use the arrow keys on the keyboard to pan left, right, up and down.
2. To scroll faster, press the CTRL key while pressing the arrow keys.

To pan with the **Panning** tool:

1. Select the ( Panning) tool from the view toolbar.
2. Click and drag the view with the mouse to pan around.

To pan with the **Placement** tool:

1. Select the ( Placement) tool from the view toolbar.
2. Ensure that drag-scrolling is enabled. This setting can be toggled by tapping the "Q" key, or by clicking the ( Toggle Drag-Scrolling) tool bar button.
3. Begin dragging an instance. When close to any of the view edges, the view automatically scrolls in that direction. The size of the view "drag scroll margins" as well as the speed the view drag-scrolls, can be adjusted on the Floorplanner view Colors and Layers Preference page (see page 191).

**Tip**

If panning the view is too slow, in the Floorplanner view Optimizations Preference page (see page 196), there is a setting, **When panning, show only background layer**, to improve panning/scrolling performance by reducing the amount of graphic rendering performed during the pan/scroll operation.

**Selecting Floorplanner Objects**

To select objects with keystrokes:

1. In the ( Selection) section of the view fly-out palette, check the object types to select.
2. Press and hold the S key on the keyboard to start a selection rectangle at the current mouse cursor position (clearing/replacing the previous selection).
   Optionally, press and hold the SHIFT+S keys to start a selection rectangle at the current mouse cursor position (adding to the current selection instead of replacing it).
3. Drag the mouse while holding down the key or keys on the keyboard to create a selection rectangle which includes the objects desired.
4. Release the key(s) to apply the selection.

To select objects with the Selection Tool:
1. Click the ( ) **Selection Tool** on the view toolbar.
2. From the **Selection** section of the view fly-out palette, check the object types you wish to select.
3. Also, ensure the **Action** control in the fly-out palette is set to **Select**.
4. Click the desired object, or click and drag with the left mouse button in the view to create a selection area rectangle (clearing/replacing any previous selection).
   Optionally, hold the CTRL key when clicking/dragging (adding to the previous selection instead of replacing it).
5. Release the mouse button to apply the selection.

Additionally, right-click individual objects and select **Add to Selection** from the context menu popup.

Further details about the ACE selection set are available on the **Selection View (see page 136)** page.

**Deselecting Floorplanner Objects**

To deselect objects with key strokes:

1. Select the ( ) **Selection Tool** from the view toolbar.
2. From the **Selection** section fly-out palette, check the object types to deselect.
3. Press and hold the D key on the keyboard to start a selection rectangle at the current mouse position.
4. Drag the mouse while holding down the key to create a selection rectangle including the objects to deselect.
5. Release the D key to remove the objects within the rectangle from the current selection set.

To deselect objects with the **Selection Tool**:

1. Select the ( ) **Selection Tool** from the view toolbar.
2. From the **Selection** section of the fly-out palette, check the object types to deselect. Also, ensure the Action control is set to **Deselect**.
3. Click and drag with the left mouse button in the view to create a selection rectangle.
4. Release the mouse button to remove the objects from the current selection set.

**Toggling Floorplanner Mouse Tools**

To toggle the mouse tools:

1. Press the ALT key on the keyboard to switch between tools, or simply click the desired mouse tool on the view toolbar.

**Filtering the Floorplanner View**

It is often useful to filter the **floorplanner view (see page 57)** graphics to see only objects of interest.

**Filtering with Layers**

Simple filtering of the view by object type is accomplished with the **Layer** options in the view fly-out palette.

By checking or unchecking the individual layers, all members of a given object type may be shown or hidden. Sites, Instances, Clock Routes, and Non-clock Routes may be manipulated in this way.

Because routes are always painted on top of instances, which themselves are painted on top of sites, it is often necessary to disable the painting of the topmost layers when they obscure the lower layers.
Note

The hiding of individual objects of a given object type layer may be overridden if that object is selected or highlighted, depending upon the current preference settings. See the floorplanner view colors and layers preference page (see page 191) for more information about changing these preferences.

Filtering with Selection

Selection overrides the layer filters. When a layer is turned off, selected objects (those in the current ACE selection set) remain visible. So, for example, to see just the selected instances, turn off the instances and routes layers. The selected instances remain visible, while all other placed instances (and all non-selected nets) are hidden.

To filter with selection in the floorplanner view:

1. Add the desired objects to the current ACE selection set.
2. In the (Layers) section of the fly-out palette, un-check the object types to hide.

Choosing Floorplanner Object Tooltips

For instant feedback on instance, net, or site names in the floorplanner view (see page 57), a tooltip (hover text) can be enabled. In addition, the contents of the tooltip can be printed to the Tcl Console View (see page 144) for easy copy and paste.

To get object tooltip text:

1. In the (Tool Tip Text) section of the fly-out palette (see page 61), enable the checkboxes for the object types with data that should be contained in the tool tip text.
2. In the floorplanner view, hover the mouse cursor over objects to display the tool tip text.

Tip

Capturing Tooltip Content:

Optionally, press the P key on the keyboard while tooltip text is visible to print the tooltip text to the TCL console view, allowing easy copy and pasting to create TCL commands or scripts.

Viewing Floorplanner Object Labels

A variety of object labels are available when displaying objects in the floorplanner view (see page 57) (see "Fly-Out Palette").

To display object labels in the Floorplanner view:

1. In the (Labels) section of the fly-out palette, select which object labels to display.
2. Pan and zoom to objects of interest to view the object labels.

Note

Some labels are not painted unless the view is zoomed in far enough to display the full extent of the text.

Highlighting Objects in the Floorplanner View

There is typically a tremendous amount of visualization data available in the floorplanner view (see page 57). Because viewing all of the data simultaneously can be overwhelming, ACE provides tools such as selection and highlighting so that a particular subset of the entire design may be visualized within the floorplanner view. For simple, short-term subset
visualizations, this functionality is provided by the ACE selection set as managed in the selection view (see page 136). For longer-term visualizations, or to simultaneously compare and contrast multiple design subsets, ACE provides the highlight Tcl command. As with the ACE selection set, applied highlights are visibly displayed on placed/routed objects in the floorplanner view. Highlight colors are also shown in several tabular views such as the netlist browser view (see page 92), where the highlight colors of instances are displayed in their own table column.

Note

Only instances, nets, and paths may be highlighted.
Currently highlights are only supported for individual instance, net, and path object types (remember to use the correct object type prefixes (see page 313) when using the Tcl commands).

Most of the views within the floorplanner perspective provide context-sensitive functionality to manage highlights, through buttons in each supporting view to ( ) Highlight chosen objects, ( ) Un-highlight chosen objects, or to ( ) Choose Highlight Color which is next used from that view (each view tracks an active highlight color independently of the other views, allowing one color for a selection highlight, and an alternate color for a netlist browser highlight). Additionally, some of the views (typically those representing multiple aggregations of objects) include a button to ( ) Auto-highlight all objects within that view, with each aggregation automatically using a different color.

Caution!

In tabular views (such as the clock domains view (see page 36)), highlights may be shown and manipulated for aggregations of objects (as with the highlight color of a clock domain row representing the shared highlight color of all instances within that clock domain).
Be aware that if there are multiple highlight colors within the aggregation, then no highlight color is shown for the aggregation row in the table. The aggregation only displays a highlight color in the table if every single object within the aggregation has the exact same highlight color.
Additionally, when a new highlight (or un-highlight) is applied to an aggregation, it affects all individual members of that aggregation. The highlight color of all contained individual objects are overwritten with the new highlight value.

The following Tcl commands are available to manage highlights:

- highlight
- apply_highlights

Note

There is no specific Tcl command to remove existing highlights. Instead, exclude the -rgb flag when calling highlight, which effectively applies a non-highlight to the specified object(s).

Selection vs. Highlighting

Despite some similarities, selection and highlighting serve two different purposes in ACE. They are compared and contrasted in the table below.

**Table 142: Selection and Highlighting Differences**

<table>
<thead>
<tr>
<th>Selection</th>
<th>Highlighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is a single ACE Selection Set.</td>
<td>Each object in a design may have its own unique highlight color, or a single highlight color may be applied to multiple objects, even if they are different object types.</td>
</tr>
</tbody>
</table>
The Selection color (a very bright green by default) is managed globally for each object type, through the floorplanner view colors and layers preference page (see page 191).

Each Tcl call to highlight an object must specify which color to use for that call. When using the (_highlight) action from within a view, the (Choose Highlight Color) for that view is used.

A highlight is expected to be long-term, and highlight colors on objects are saved in acxdb files when Implementations (see page 217) are saved. As a result, prior highlights are restored when an implementation acxdb file is loaded.

Selection membership may be managed through the selection view (see page 136) There is presently no special view to manage highlights.

The selection color of an object (or aggregation) is only rendered within the floorplanner view.

The highlight color is rendered not only within the floorplanner view, but also (sometimes as individual objects, sometimes in aggregate) as a color tile in most of the tabular supporting views of the floorplanner perspective. When the highlight color is displayed in a tabular view, it is typically shown within its own column of color tile values.

Objects May Be Both Selected and Highlighted Simultaneously

It is possible for objects to be both selected and highlighted at the same time. When this occurs, the exact precedence of the color used to render the object is handled differently depending upon the object type, and which view is being rendered.

When paths are displayed in the floorplanner view, the selection color for a path takes precedence over the highlight color (the selection color for a path is managed on the floorplanner view colors and layers preference page (see page 191)).

When instances are displayed in the floorplanner view, the selection color of an instance takes precedence over every other color (the selection color for an instance within the floorplanner view is managed on the floorplanner view colors and layers preference page (see page 191)).

Note

It is possible to change the relative render priorities of some of the states of an instance on that same floorplanner preference page. The instance states (see page 245) section discusses this in further detail.

Uniquely among the object types, nets may display both their selection and highlight states simultaneously in the floorplanner view, though this is disabled by default (for performance reasons). By default, when nets are displayed in the floorplanner view, the selection color takes precedence over the highlight color. But nets, being simple lines, are handled specially, as configured in the floorplanner view colors and layers preference page (see page 191). There, it is possible to choose to have the net highlight rendered on top of the net selection, or vice versa. It is also possible to choose which

Figure 145: Floorplanner Preferences Instance State Render Management
line thickness (width) shall be used to render both the selection line and the highlight line for the net. By making the bottom line thicker than the top line, it is thus possible to have a "halo" effect of one color outlining the other color for the same net(s).

![Figure 146: Non-Default Preference Configuration Showing Both Selection and Highlights for Nets](image)

**Warning**

**Floorplanner Performance:**
Choosing to render highlighted nets thicker than a single pixel wide might have a significant negative performance impact upon floorplanner rendering speeds of large designs at some customer sites. Exact details depend upon specifics of the workstation hardware, OS/kernel version, and the active desktop graphics rendering library.

Rendering selected nets at a thickness greater than one is expected to have little-to-no performance impact upon floorplanner rendering speeds.

**Batch Mode Highlighting**

Batch-mode highlights in Tcl are supported through the use of the optional `-batch` command-line argument for the `highlight` command. This flag blocks the transmission of incremental highlight updates to the ACE GUI, significantly speeding up execution times when applying multiple scripted highlight changes in sequence. When all batched changes to the highlights have completed, `apply_highlights` must then be called to send the highlight updates to the GUI for display.

```tcl
Example Tcl sequence to highlight all instances orange, except instance names starting with

highlight [find {*} -insts] -rgb {255 128 0} -batch ;# applies orange highlight to all insts
highlight [find {temp*} -insts] -batch              ;# removes highlights from all insts starting with "temp"
apply_highlights                                    ;# sends pending highlight changes to GUI
```

**Pre-Placing a Design**

This section details manual pre-placement of instances in ACE.

**Placing an Object**

Currently in ACE, there are two types of objects that can be placed: instances and ports. Placing a port is equivalent to placing the instance that the port is connected to in the design.

There are two types of manual pre-placement in ACE: soft and fixed. Fixed placement locks the placement of an instance to a site such that the placer is not allowed to move the instance to another site. Fixed placement is the only type of pre-placement command recommended. Soft placement is used as a global placement hint to the placer.
Caution!

Soft placement is not fully functional.

To begin pre-placement activity, the Run Prepare flow step for the active implementation must be run. Placing an object automatically resets the flow status to start over from the Run Prepare step.

To place an object from the Search View (see page 132), Selection View (see page 136), or Netlist Browser View (see page 92):

1. In the Placement ( ) section of the Floorplanner View (see page 57) fly-out palette, check the placement options desired.

   **Note**
   - Fixed placement is recommended for all pre-placement.

2. Pan and zoom the Floorplanner view until the destination placement site is visible.

3. In the starting view (Search view, Selection view, or Netlist Browser view), click and drag the desired object from the starting view onto the desired destination placement site in the Floorplanner view.

   **Note**
   - The icon on the now-placed object in the Search view, Selection view, and/or Netlist Browser view is now updated to reflect the placement status.

To re-place an object within the Floorplanner view (move from one placement site to another):

   **Note**
   - This operation alters an existing site assignment (placement) for an instance. Sometimes it is helpful to start with a fully placed and routed design, and then fine-tune the placement using this operation.
   - Be aware that changing the placement of an already-placed object clears the current routing data for all connections to and from that instance.

1. In the Placement ( ) section of the fly-out palette, check the placement options desired.

   **Note**
   - Fixed placement is recommended for all pre-placement.

2. Click the Placement Tool ( ) on the view toolbar to change the mouse behavior within the view to drag and drop placement mode.

3. Pan and zoom the Floorplanner view until both the to-be-moved instance and its intended destination placement site are visible.

4. In the Floorplanner view, click and drag the placed instance from its current placement site onto the new placement site.
Changing Between Fixed and Soft Placement

There are two types of placement in ACE: soft and fixed. Fixed placement locks the placement of an instance to a site such that the placer is not allowed to move the instance to another site. Fixed placement is the only type of pre-placement command recommended. Soft placement is used as a global placement hint to the placer.

**Caution!**
Soft placement is not fully functional.

**Fixing placement of soft-placement objects**

To fix placement with key-strokes:

1. In the **Selection** (§) section of the Floorplanner View (see page 57) fly-out palette, check the object types having placement that should be fixed.
2. Press and hold the **f** key on the keyboard to start a selection rectangle at the current mouse position.
3. Drag the mouse while holding down the **f** key on the keyboard to create a selection rectangle which includes the objects desired.
4. Release the key to fix the placement of the enclosed objects.

To select objects with the Selection Tool:

1. Select the **Selection Tool** (§) from the Floorplanner View (see page 57) toolbar.
2. From the **Selection** section of the fly-out palette, check the object types having placement that should be fixed. Also, ensure the **Action** control is set to **Fix Placement**.
3. Click and drag with the left mouse button in the view to create a selection rectangle. Optionally, hold **CTRL** while dragging to add to the selection.
4. Release the mouse button to fix the placement of the activated objects in the selection.

**Note**
Not using **CTRL** clears the previous selection!

**Un-fixing (softening) placement of fixed-placement objects**

To un-fix placement with key-strokes:

1. In the **Selection** (§) section of the Floorplanner View (see page 57) fly-out palette, check the object types with placement that should be un-fixed.
2. Press and hold the **u** key on the keyboard to start a selection rectangle at the current mouse position.
3. Drag the mouse while holding down the **u** key to create a selection rectangle which includes the desired objects.
4. Release the key to un-fix the placement of the enclosed objects.

To select objects with the Selection Tool:

1. Select the **Selection Tool** (§) from the Floorplanner View (see page 57) toolbar.
2. From the Selection section of the fly-out palette, check the object types with placement to be fixed. Also, ensure the Action control is set to Un-fix Placement.

3. Click and drag with the left mouse button in the view to create a selection rectangle. Optionally, hold CTRL down to add to the selection.

4. Release the mouse button to un-fix the placement of the activated objects in the selection.

Note
Not using CTRL clears the previous selection!

Group Placement Mode

Caution!
Advanced Functionality
Group placement mode is advanced functionality, and has multiple failure cases. Group placement should only be attempted by expert users who understand all the caveats.

During normal drag-and-drop placement operations (when Group Placement is disabled), only the placement of a single instance is altered.

When Group Placement is enabled, ACE attempts to shift the placement of all instances in the current ACE selection set. Group placement cannot be used on instances that are not already placed — attempting to perform group placement on unplaced instances results in failure.

When group placement is attempted, the placement shift is based upon the relative change in placement site coordinates of a single anchor instance. The anchor instance is the instance which is dragged-and-dropped. The relative change is calculated based upon the coordinates of the anchor instance initial site and the destination site.

If the starting site coordinates of the anchor instance are at (X=15000, Y=30000) and the destination site coordinates for the anchor instance are at (X=20000, Y=40000), the coordinate shift is (X=+5000, Y=+10000). For each instance in the selection set, this coordinate shift is applied to that instance starting site coordinates; the resulting X and Y values are the coordinates where the destination site is sought for that instance. If no destination site is found at those adjusted coordinates, the entire group placement adjustment is aborted for all instances, and none of the instances are moved. All instances are left untouched in their initial placements, including the dragged-and-dropped anchor instance.

Tip!
Reminder: The anchor instance must already be a member of the ACE selection set when the drag is initiated. All other instances in the selection set must also already be placed before the group placement drag is initiated. When choosing a drop location for the anchor instance, keep in mind that all other instances in the selection set must have sites at the same relative coordinate offsets from both the anchor instance starting placement and ending placement. If an ending placement site is not found for any instance at the expected coordinate offsets, the entire group placement adjustment operation is aborted, and all instances remain in their initial placements.

Adjusting the Existing Placement of a Group of Selected Instances

1. Empty the ACE Selection Set (as seen in the Selection View (see page 136)).

2. Select all the instances that should take part in the group placement adjustment, so that they are added to the ACE Selection Set.

3. Ensure that all instances in the ACE Selection Set are already placed (the icon for the instances in the Selection View should be either ✔️ for Soft Placement or ✉️ for Fixed Placement).
4. Ensure that the **Fixed Placement** checkbox (within the **Floorplanner View** (see page 57) fly-out palette) is in the desired state.

5. Enable **Group Placement** mode by clicking the checkbox (within the Floorplanner View fly-out palette).

6. Choose which placed, selected instance is to be the anchor instance, then scroll and zoom the Floorplanner until both the initial site and destination site for the anchor instance are plainly visible.

7. Double-check that all other instances in the selection set have corresponding destination sites.

8. Drag the anchor instance from its initial placement to the destination site. If all initial requirements are met, and if destination sites were found for all selected instances at the calculated offsets, the GUI will issue a bulk Tcl `set_placement` command for all selected instances, and the instances should move to the new sites.

9. Disable **Group Placement** mode by clicking the checkbox (within the Floorplanner View fly-out palette).

---

**Caution!**

**Group Placement pays attention to the Fixed Placement checkbox:**

Be aware that when a group placement adjustment succeeds, when the new placement is applied, the current state of the Floorplanner View **Fixed Placement** checkbox affects all adjusted placements.

If **Fixed Placement** is checked, all adjusted placements are fixed, regardless of whether they initially had soft or fixed placement. If **Fixed Placement** is unchecked, all adjusted placements are soft, regardless of whether they initially had soft or fixed placement.

All routing to and from the moved instances will be cleared after the placement.

---

See also: **Floorplanner View** (see page 57), **Selection View** (see page 136), **Selecting Floorplanner Objects** (see page 321), **Deselecting Floorplanner Objects** (see page 322), `select`, `deselect`, `set_placement`

### Removing Placement

To un-place objects with key-strokes in the **Floorplanner View** (see page 57):

1. Ensure the **Instances** checkbox is checked in the **Selection** ( ) section of the view Fly-out Palette.

2. With the mouse positioned in the Floorplanner view, press and hold the **r** key on the keyboard to start a selection rectangle at the current mouse position to remove placement of objects.

3. Drag the mouse while still holding down the **r** key to create a selection rectangle including the objects to be un-placed.

4. Release the key to un-place all the objects contained by the selection rectangle.

To un-place objects with the **Selection Tool** ( ) in the Floorplanner view:

1. Select the **Selection Tool** ( ) from the view toolbar.

2. In the **Selection** ( ) section of the view fly-out palette:
   a. Set the Action control to **Remove Placement**.
   b. Ensure the **Instances** checkbox is checked.

3. Click and drag with the left mouse button in the view to create a selection rectangle.

4. Release the mouse button to un-place all the objects within the selection rectangle.

It is also possible to un-place objects using the right-click context menu in the Floorplanner view, **Search View** (see page 132), and **Selection View** (see page 136).
The fastest way to un-place multiple objects is to add them all to the ACE Selection Set (as shown in the Selection view; see Selecting Floorplanner Objects (see page 321)), and then un-place all of them at once by performing any one of the following:

- In the Selection view, right-click the mouse on the **Instances** node in the tree, then choose **Unplace All Instances in ACE Selection Set**.
- In the Floorplanner view, right-click the mouse anywhere on the floorplan, then choose **Unplace All Selected Instances**.
- In the **Tcl Console View (see page 144)**, type: 
  ```tcl
  run_unplace -insts [get_selection]
  ```
  (See **run_unplace.**)

**Performance Tip:**

It is always faster to un-place multiple objects at once instead of individually, especially when a very complex net (like a clock net) is affected.

### Saving Pre-Placement Constraints

To save the current placement to disk as pre-placement constraints in .pdc files:

1. Place objects in the design as described in **Placing an Object (see page 326)**.
2. In the Floorplanner view or Package view, click the **Save Pre-placement Constraints** toolbar button to bring up the **Save Placement Dialog (see page 179)**.
3. Configure the dialog with appropriate options and click **Finish**.

After clicking **Finish**, the pre-placement files are saved to disk. If the option was selected to automatically add the files to the current project, the Projects view shows the new files under the active project Constraints folder.

### Using Pre-Placement in the Flow

#### Types of Pre-Placement

There are three ways to pre-place instances in ACE:

- After the **Run Prepare** flow step, interactively pre-place instances using the ACE GUI drag-and-drop placement features, or use the `set_placement -fixed` TCL command in the TCL Console.
- Include a PDC constraints file in your ACE project that uses `set_placement -fixed` TCL commands to pre-place the instances.
- Set the location parameter on the instance primitive in the user design RTL (not recommended; the location parameter is effectively the same as using the `set_placement -fixed` Tcl command on that instance).

Using the `set_placement -fixed` Tcl commands in a PDC constraints file is recommended. If using the location parameter in the user design RTL, the RTL must be changed and re-synthesized to update the pre-placement.

ACE applies pre-placement from user design RTL and PDC constraints at the end of **Run Prepare** in two stages:

1. ACE loops over all instances that have the location parameter set and internally calls `set_placement -fixed` on each instance and then prints the log file message “Applying defparam placement of <$instance> to location <$location>.”. The log file or TCL console shows messages for each instance placed with the location parameter.
2. The Run Prepare step applies all of the set_placement commands in the PDC files. If there is a set_placement command in your PDC for an instance that is already placed with the location parameter, the PDC set_placement overrides the placement set in the location parameter. There is no warning message. It is the same as having two set_placement commands in the same PDC file that place the same instance. The last set_placement command always wins.

It is recommended to use only the PDC method.

Recommended Typical Flow

To use pre-placement in the flow, it is recommended to first create the pre-placement constraints:

1. Run the Run Prepare flow step on the active implementation.
2. Switch to the Floorplanner perspective and place all the objects for pre-placement (using fixed placement). See Placing an Object (see page 326) for details.
3. Save the pre-placement and automatically add it to the project (see Saving Pre-Placement Constraints (see page 331)).
4. Optionally, a pin assignment report can be generated for the current placement with the report_pins (see page 597)Tcl command.
5. Resume running the flow. The pre-placement data is used in the place and route solution.

When the pre-placement constraints are in place, it is recommended to include them in the project for future runs:

1. The next time the flow is run with this implementation, ensure that in the Options View (see page 106), the new pre-placement constraints files are enabled.
2. Simply run the Run Prepare flow step. The pre-placement constraints are automatically applied. A pin assignment report is also automatically generated during Run Prepare.
3. Optionally, to see that the objects are pre-placed, switch to the Floorplanner perspective to view the placement.

Analyzing Critical Paths

Critical paths are computed by timing analysis. Timing analysis can be run at several points in the flow (see page 223), as indicated in the flow view (see page 67). Timing analysis can be repeated with different implementation (see page 217) options without having to re-run the rest of the flow, by double-clicking the appropriate Run Timing Analysis flow step (see page 223).

The results of timing analysis are shown in a timing report (see page 229), which is automatically displayed as timing analysis completes. The most recently generated version of each timing report file is always available in every implementation reports sub-directory.

The active critical paths may also be viewed in the critical paths view (see page 52) and the critical path diagram view (see page 49). Unlike the reports, the views only show the critical paths for the active project and implementation (see page 223). When the active implementation changes, the two views are cleared. Also, the views are only populated when timing analysis is run for the active implementation during that same ACE session. The timing analysis data is not saved in the .acxdb file, and must be re-created every session to guarantee correctness.

Tip

While a generated timing report may be viewed from an implementation reports directory at any time, including in later ACE sessions, the two critical path views only show data from the most recent timing analysis within the current ACE session.
Generating Timing Reports

A timing report (see page 229) is generated and displayed in the GUI whenever one of the Run ... Timing Analysis flow steps (see page 223) is run. Timing reports may also be generated at any time from Tcl by running the appropriate flow step (run -step <flow_step_name>) or with the run_timing_analysis Tcl command.

Timing reports can be found in the implementation (see page 217) reports directory, available for browsing via the projects view (see page 123). In addition to the HTML report files displayed in the GUI, there are equivalent report files in text and .csv (spreadsheet) formats.

The Timing Analysis implementation options (see page 217) in the options view (see page 106) determine how timing analysis is run and the amount of report information which is generated.

Critical paths are also displayed in the critical paths view (see page 52). The path ID can be used to cross-reference between the critical paths view and the timing reports.

ACE also allows generating a timing report across all temperature corners. This is the default behavior for a complete flow (i.e., post_process is complete).

ACE supports place and route across all temperature corners (i.e., place and Route is optimized and timing reported across all temperature corners by checking Enable all-corner PnR optimization from the Options → Timing Analysis menu item (please refer to the table: Timing Analysis Implementation Options under Options View (see page 106)).

The corresponding example ACE Tcl command (see page 551) to set the required implementation option to enable this feature is:

```
set_impl_option -project "wgl" -impl "impl_1" "pnr_optimize_corners" "1"
```

Highlighting Critical Paths

Note

The Floorplanner can only display routed paths. Paths which are not routed cannot be displayed in the Floorplanner.

To highlight a routed critical path in the Floorplanner View (see page 57):

1. First, run one of the timing analysis flow steps to generate critical path data.
2. Then, in the Critical Paths View (see page 52), browse through all reported critical paths.
   a. By default, highlight colors of setup/hold violations are arranged in a gradient from red to yellow according to the slack's distance from zero.
   b. Paths with a positive slack (setup/hold met) are colored green by default.
3. To highlight a path in the Floorplanner, simply check the box for the desired path in the Highlight column of the table within the Critical Paths View (see page 52). To un-highlight a path, simply uncheck the box.

Tip: Critical Path Highlight Colors May Be Changed

The highlight color of each individual critical path can be changed by clicking on the color chooser box in the Highlight column of the Critical Paths View (see page 52) table. In the color chooser dialog, select the desired color for that path and click OK.
Selecting Critical Path Objects

In order to manipulate objects (for example, by pre-placing them) on a critical path, it is convenient to add them to the current ACE selection set (as displayed in the selection view (see page 136)) for easy access.

**Note**

When objects are in the ACE selection set, they change to the selection color which overrides all other colors, including highlight colors.

To add a critical path to the current selection:

1. In the critical paths view (see page 52), click the table row containing the data for the path for which objects are to be selected.
2. To add the path to the current ACE selection set, click the (Select Path) toolbar button on the critical paths view (see page 52) toolbar.
3. The path is now added to the selection in the selection view (see page 136) and is shown with the selection color in the floorplanner view (see page 57).

To add a the pins of a critical path to the current selection:

1. In the critical paths view (see page 52), click the table row containing the data for the path for which objects are to be selected.
2. To add the path pins to the current ACE selection set, click the (Select Pins) toolbar button on the critical paths view (see page 52) toolbar.
3. The pins are now added to the selection in the selection view (see page 136) and are shown with the selection color in the floorplanner view (see page 57).

To add the instances of a critical path to the current selection:

1. In the critical paths view (see page 52), click the table row containing the data for the path for which objects are to be selected.
2. To add the path instances to the current ACE selection set, click the (Select Instances) toolbar button on the critical paths view (see page 52) toolbar.
3. The instances are now added to the selection in the selection view (see page 136) and are shown with the selection color in the floorplanner view (see page 57).

To add the nets of a critical path to the current selection:

1. In the critical paths view (see page 52), click the table row containing the data for the path for which objects are to be selected.
2. To add the path nets to the current ACE selection set, click the (Select Nets) toolbar button on the critical paths view (see page 52) toolbar.
3. The nets are now added to the selection in the selection view (see page 136) and are shown with the selection color in the floorplanner view (see page 57).

Zooming to Critical Paths

To zoom the floorplanner view (see page 57) to the region of a critical path:
1. In the critical paths view (see page 52), click the table row containing the desired critical path data.
2. To zoom to the path in the floorplanner view (see page 57), click the (🔍) Zoom to Path toolbar button on the critical paths view (see page 52) toolbar.

**Note**
This action only applies to routed designs.

### Printing Critical Path Details

To print the details of a critical path to the Tcl console view (see page 144):

1. In the critical paths view (see page 52), click the table row containing the data for the path for which details are to be printed.
2. To print the details text, click the ( файла ) Print Path Details toolbar button on the critical paths view (see page 52) toolbar.

**Tip**
Critical path details are also available in the timing report (see page 229)

### Using Critical Path Diagrams

The Critical Path Diagram View (see page 49) provides a graphical representation of a single critical path. These paths are each selected from the table in the Critical Paths View (see page 52). The graphical representations consist of circular nodes (representing instances) connected by arrows (representing one or more nets).

**Tip**
To quickly look at the diagrams for all the critical paths:

1. Make sure both the Critical Paths View (see page 52) and Critical Path Diagram View (see page 49) are visible.
2. Click a row in the Critical Paths view table.
3. Use the keyboard up arrow and down arrow keys to change which row is selected in the table.
4. The Critical Path view diagram is updated to graph the relevant critical path.

### Graph Elements

The graphical diagram is made up of nodes and arrows. The information represented by the nodes, arrows, and their supporting text, can vary depending upon the current settings in the diagram fly-out palette (see page 51).

**Nodes**

The larger circles in the diagram are the primary graph nodes which represent the key instances or turn points on the critical path. Intermediate nodes, when enabled, are smaller circles, representing instances the data passes through while flowing between turn points. Several useful pieces of information are available for each graph node. These may be enabled and disabled via the fly-out palette.
**Note**

Some information is hidden when the graph node circle is too small to contain it. To see all enabled information, the diagram must be zoomed in. Configurable tooltips can be used to see information that would otherwise be hidden due to insufficient drawing area.

**Arrows**

The arrows connecting the graph nodes in the diagram represent the nets connecting the object instances and can also display various pieces of information that may be enabled and disabled via the fly-out palette. In addition to the direction of the arrow, the line types making up the arrow also represent important information:

- **Bold arrows**, visible when the Intermediate Nodes fly-out palette setting is disabled, represent one or more nets and any hidden intermediate nodes, lumped into a single abstraction. Bold arrows, since they potentially represent multiple nets and hidden intermediate instances, may only display text for the cumulative time in picoseconds of their Delays. Net Names and Fanouts are never displayed for bold arrows, since they make no sense in this context.

- **Thinner arrows** are shown when the Intermediate Nodes fly-out palette setting is enabled. Each of these represent an individual net. Because these thinner arrows each represent individual nets connecting the instances, the individual net Fanouts and Net Names may also be displayed for each arrow, in addition to the Delays.

**Critical Path Diagram Types**

Different types of critical paths may have different visual representations. The Type column in the Critical Paths View (see page 52) table provides the critical path type of each row.

All path types are displayed as a straight line of objects connected by arrows.

**Adding Portions of the Graph to the ACE Selection Set**

When the graph has helped track down which nets and/or instances to adjust for timing purposes, it can be helpful to find those objects in the Floorplanner View (see page 57). To do so, use the techniques described in Selecting Critical Path Objects (see page 334), or add specific nodes and arrows from the graph to the ACE selection set, and use the Zoom to Selection button in the Selection View (see page 136) to cause the Floorplanner View (see page 57) to scroll and zoom so that all the selected objects are visible.

**Viewing Critical Paths in the Schematic Viewer**

Currently, ACE does not have its own built-in schematic viewer. Viewing critical paths requires the synthesis tool. In order to facilitate this, ACE can optionally generate a Tcl script with find commands for objects along each critical path.

To view critical paths in the synthesis tool:

1. In the Critical Paths view (see page 52), click the (📄) Save Script File toolbar button to open the Save Script File dialog (see page 183).
2. Enter a valid file name in the Save Script File dialog (see page 183) and click Save.
3. Source the saved script file from within the synthesis tool Tcl prompt.
4. After the file is sourced, open the synthesis tool schematic viewer.
5. At the Tcl prompt, enter: `select_one_path <path_id>` to view a given path, where the `<path_id>` is the value from the Path column of the table in the Critical Paths view, and/or the Path Id value from one of the Timing Reports (see page 229).
Applying and Checking Properties

Applying Properties

There are three methods to apply properties, detailed below. More information and examples can be found in the Synthesis Optimizations chapter of the Synthesis User Guide (UG071).

**defparam**

Properties can be applied as defparams on a module or module port in the RTL black-box library. Applying defparams is an internal only method and sets the default value of the property for all instances of that module, or instance pins of a port.

**RTL Attribute**

Attributes can be set in the RTL to show the design intent and to guide both Synplify and ACE. Synplify attributes are detailed in the Synplify help manual. ACE attributes can also be set in the RTL, and these are passed by Synplify to ACE. Attributes can be applied in both Verilog-2001 and SystemVerilog formats, as shown below:

```
Equivalent methods for applying properties

reg my_reg /* synthesis syn Preserve=1, must_keep=1 */;
(* must_keep=1 *) reg my_reg /* synthesis syn Preserve=1 */;
(* must_keep=1, syn Preserve=1 *) reg my_reg;
```

In certain cases it is necessary to set both a Synplify and an ACE attribute when if, without the Synplify attribute, the object may be optimized or reduced. For example, if it is required to keep a register, then Synplify will require the `syn Preserve` attribute to ensure the register is in the netlist output to ACE, and ACE will require the `must_keep` attribute to keep the subsequent register. Similar situations arise with directing and controlling fanout, where both `syn Maxfan` (Synplify) and `fanout Limit` (ACE) may be required. This requirement is a result of the fact that Synplify Pro does not propagate its own `syn_*` attributes on to ACE in the gate-level netlist.

**set_property Tcl Command**

The `set_property` command can be applied in a PDC file to an object. See `set_property (see page 622)` for full details.

```
set_property IOSTANDARD {"LVCMOS18"} {p:led_anode[0]}
```

Checking Whether Properties Were Applied

It is recommended to use the Synplify technology viewer to verify that properties were applied during Synplify. Selecting the object and then selecting "properties" will list the properties which will be passed to ACE. In addition, the netlist can be searched for the appropriate object, and the properties checked.

Within ACE, examine the object using the Properties View (see page 127), or use the display_properties (see page 563), get_properties (see page 582), or get_property (see page 582) Tcl commands.
Configuring External Connections to Hardware

ACE includes features supporting interactions with running hardware through both the JTAG and DCC interfaces. The ACE JTAG connection utilizes a Bitporter2 pod or FTDI FT2232H (or FT4232H) device various Tcl commands to interact with an Achronix FPGA. The JTAG interface is used by the:

- Download view (see page 55)
- Snapshot Debugger view (see page 139)
- HW Demo view (see page 71)

The automated SerDes link tuning functionality available for some FPGAs also uses JTAG.

Note
For more details on managing the physical connection between the workstation, the Bitporter2 pod or FTDI device, and the FPGA board, see the JTAG Configuration User Guide (UG004), as well as any documentation specific to the development board.

The ACE DCC connection utilizes a direct serial connection (over a dedicated USB cable, kept separate from the JTAG connection) to interact with the Achronix development board. The DCC interface is used by the HW Demo view (see page 71).

Configuring the DCC Connection

The ACE DCC (Demo Command and Control) connection allows the ACE software to communicate with demo and/or reference designs running on Achronix hardware. The DCC connection is managed using the Configure DCC Connection Preference Page (see page 186).

Background Info

The ACE DCC connection utilizes a direct serial RS232 connection through a simple on-board 2-pin interface, over a dedicated FTDI USB Serial Port cable. The DCC interface does not make use of the Bitporter. The DCC protocol is currently not a published standard, and is only meant to be used with Achronix demo/reference designs running on Achronix FPGAs on Achronix boards. The DCC interactions perform individual register reads and writes, and are executed using a handful of simple Tcl commands.

Installing DCC USB Drivers

The necessary USB drivers for the DCC cable are included in the ACE download. They will need to be installed before the DCC cable is connected.

Windows

When running the ACE installer, simply make sure the setting FTDI CDM USB drivers for the Development Board DCC interface is checked. When the installer completes, the DCC cable may be connected.

Linux (not currently supported)

The necessary FTDI USB drivers are already included in supported Linux distros. If the distro-supplied USB drivers do not work correctly, the necessary drivers may be downloaded from the FTDI website. Contact Achronix support if you need help finding the Linux drivers.
Configuring the USB drivers

The DCC cable USB drivers automatically choose a serial port to be redirected to the USB cable. It may be necessary to view and/or change which serial port is chosen.

Windows

To see which serial (COM) port is being used by the driver, go to the Windows Device Manager, and look under Ports (COM and LPT). The correct COM port is shown as USB Serial Port (COM*), with the actual COM port number included.

![Windows Device Manager COM Ports Example](image)

To change which COM port is being used by the USB cable, right-click the USB Serial Port entry, and then choose Port Settings → Advanced, and select the alternate COM port to be used.

Linux (not currently supported)

Contact Achronix support for the latest information about finding or changing the DCC cable serial port assignment.

Configuring ACE

When it is determined which serial port is being used by the DCC cable, ACE needs to be configured to use that same serial port.

Open the Configure DCC Connection Preference Page (see page 186) (Window → Preferences → Configure DCC Connection), then populate the Port Name field with the serial port name the DCC cable is using. The exact port names used vary according to the operating system in use.

In Windows, this is a COM port, typically one of COM1 through COM9. COM3 is the most frequent (and thus default) choice. In Linux, the serial ports are named /dev/ttyS* with the * being replaced by a number. This is typically one of /dev/ttyS0 through /dev/ttyS9.

Configuring the JTAG Connection

Achronix currently supports two JTAG programmer device types:

- Bitporter2
- FTDI FT2232H (or FT4232H)
While in the simplest cases, a test bench may only have a single JTAG programmer device connected to a JTAG scan chain containing a single Achronix FPGA (or eFPGA), many may have multiple JTAG programmer devices, and/or multiple devices within the connected JTAG scan chain. For these reasons, the ACE tools must specify which JTAG programmer device connection to use, and which JTAG scan chain member is relevant.

The various tools within ACE obtain their choice of JTAG programmer device and JTAG scan chain configuration from a few different locations, mostly based upon the usage model of the ACE tool itself.

The primary sources of JTAG programmer device and JTAG configuration information include:

- The GUI Configure JTAG Connection preference page (see page 187)
- Command-line overrides
- The implementation options (see page 217), as managed within the Options view (see page 106)

The GUI views and editors responsible for live FPGA interactions retrieve their JTAG programmer device and JTAG connection details from the Configure JTAG Connection preference page (see page 187).

The various Tcl commands that perform JTAG interactions typically require the JTAG device name to be provided as an argument, and there are specific Tcl commands to list available device connections, open and close individual device connections, and initialize the JTAG scan chain for a device with the desired configuration details. See the JTAG Configuration User Guide (UG004) for a complete listing of these Achronix Tcl commands in the jtag:: and device-specific namespaces.

The JTAG scan chain implementation options are currently only used during the FPGA Download flow step (see page 223).

**Note**

The `acx_stapl_player`, deprecated starting with ACE 9.2, is currently still being shipped (for backwards compatibility) as a part of the ACE software, though it is to be removed from future releases. While `acx_stapl_player` has previously been used behind-the-scenes by ACE for any JTAG interactions involving the now-obsolete STAPL *.jam files, it remains available for manual use from the operating system shell /command-line. The use of this tool is covered in detail within the JTAG Configuration User Guide (UG004) (available from www.achronix.com/support/docs).

**Caution!**

Special note for sites with more than one connected FPGA/eFPGA:

The interactive members of the ACE tools currently assume that only a single FPGA/eFPGA is of interest at a time, and those interactive tools all share a single configuration on the Configure JTAG Connection preference page (see page 187). This single configuration is stored per-user, and is not unique per-design or per-implementation.

At sites with more than a single connected FPGA/eFPGA, remember to change the JTAG programmer device and JTAG scan chain values stored on that preference page every time when alternating between FPGAs/eFPGAs.

**JTAG Programmer Device Connection**

It is often possible that multiple JTAG programmer devices are visible from a single workstation. Because of this, ACE software must be configured to know which JTAG programmer device is intended to be used. The ACE GUI JTAG programmer device and JTAG connection details are managed primarily through the Configure JTAG Connection preference page (see page 187) (for interactive GUI tools) and the implementation options within the Options view (see page 106) (for any JTAG tools called within the flow (see page 223)).
**Warning!**

Bitporter2 pods may be damaged if improperly connected!

Read the *JTAG Configuration User Guide* (UG004), as well the user guide(s) specific to your development kit, before physically connecting the Bitporter2 JTAG ribbon cable to the JTAG header on the development board.
Important!

This section describes how to configure ACE to communicate with an already-connected JTAG programmer device. For more details on managing the physical connection between the workstation, the JTAG programmer device, and the FPGA board, see the JTAG Configuration User Guide (UG004), as well the user guide(s) specific to the development kit, and any related release notes. The JTAG Configuration User Guide (UG004) also covers additional details about testing JTAG programmer device connections, JTAG programmer device naming/addressing, and managing connections to multiple devices.

Starting in ACE 9.2, ACE uses the Achronix `jtag::` Tcl library to perform all ACE JTAG operations. High-level JTAG Tcl commands may automatically detect the presence of available JTAG devices over USB, though all allow specifying JTAG devices by name. If multiple JTAG devices are detected, and ACE has not been informed which of the JTAG devices (by name) should be used, the Tcl command execution fails because, for safety, ACE does not pick a JTAG device randomly.

It is strongly recommended to specify the chosen JTAG device by name in all cases, instead of relying upon auto-detection. Not only does this avoid problems if additional JTAG devices are connected at a later date, but connections to named devices are faster to initiate.

Tip

Several seconds of initialization time can be saved on every JTAG connection if the JTAG programmer device is specified by name instead of using auto-detection.

The details of JTAG device naming and name retrieval are covered thoroughly in the JTAG Configuration User Guide (UG004). As a simple summary, the device names for supported JTAG devices are derived from their device serial number. The Tcl command `jtag::get_connected_devices` provides a list of connected JTAG device names.

JTAG Scan Chain

The JTAG specification (see en.wikipedia.org/wiki/JTAG) supports multiple devices being connected in sequence, sharing a single set of JTAG pins on the board. These devices are treated as being on the same JTAG scan chain. In order for ACE to successfully communicate with any target device in a scan chain, ACE must be told the scan chain configuration on the Configure JTAG Connection preference page (see page 187).

![JTAG Scan Chain](image)

**Figure 148: JTAG Scan Chain Fields, Configure JTAG Connection Preference Page**

Note

The default JTAG scan chain preference values, all zeros, is always correct for single-device scan chains. For multi-device scan chains, the default values never work.

When multiple FPGA devices are attached to the same JTAG scan chain, the target FPGA device must be specified. Because different FPGA devices have different instruction sizes, the total instruction length before and after the target must be specified as well.
Figure 149: Multi-device Scan Chain with Bitporter Example

The **Target FPGA Device Offset in Scan Chain** specifies the ordinal position relative to the Bitporter. The device closest to the Bitporter (technically, the device closest to the board JTAG TDI pin) has a target offset of 0.

The number of instruction register (IR) bits before the target FPGA device is specified under **IR Bits Before Target FPGA Device**, while **IR Bits After Target FPGA Device** specifies the number of IR bits that follow the target FPGA device in the chain. Achronix FPGA devices have an instruction size of 23 bits. Hence, in the above example, if all devices were Achronix FPGA devices, there would be 23 instruction bits before the target, (23 instruction bits in the target), and 46 instruction bits after the target.

In JTAG, the least significant bit enters the scan chain first, while the most significant bit enters the scan chain last. From the perspective of ACE, **before** refers to the more significant bits in the scan chain, and **after** refers to the less significant bits. Instruction bits before the target are not scanned through the target FPGA. Instruction bits after the target instruction bits are scanned through the target FPGA before arriving at their scan chain destination. The key detail is that ACE regards the before/after terminology from the perspective of where the bits ultimately land in the instruction registers, NOT in terms of when the bits pass through the JTAG TDI pin, and NOT in terms of the sequence in which the bits pass through the target device.

Thus, in a chain of four Achronix FPGAs (each FPGA instruction register consists of 23 bits, the total IR bits = 4 × 23 = 92 IR bits), to specify the device closest to the TDI pin, the initial device (IR scan chain bits [91:69]) requires an entry of 0:69:0 for the three ACE scan chain configuration values. The first 0 for **IR Bits Before Target FPGA Device**, 69 for **IR Bits After Target FPGA Device**, and 0 for **Target FPGA Device Offset in Scan Chain**. The second Achronix FPGA in a chain of four would be 23:46:1, the third would be 46:23:2, and the fourth would be 69:0:3.

Table 143: Example Scan Chain Values: Four Achronix FPGAs in the Same Scan Chain

<table>
<thead>
<tr>
<th>Device (IR bit Range Within 92-bit IR Scan Chain)</th>
<th>IR Bits Before Target FPGA Device</th>
<th>IR Bits After Target FPGA Device</th>
<th>Target FPGA Device Offset in Scan Chain</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (bits [91:69])</td>
<td>0</td>
<td>69</td>
<td>0</td>
</tr>
<tr>
<td>1 (bits [68:46])</td>
<td>23</td>
<td>46</td>
<td>1</td>
</tr>
<tr>
<td>2 (bits [45:23])</td>
<td>46</td>
<td>23</td>
<td>2</td>
</tr>
<tr>
<td>3 (bits [22:0])</td>
<td>69</td>
<td>0</td>
<td>3</td>
</tr>
</tbody>
</table>

Specifying a single-device chain (where there is nothing in the chain except the solo target device) would always require an entry of 0:0:0. There are zero IR bits before the target device, zero IR bits after the target device, and it is the device closest to the TDI pin in the JTAG scan chain. This single-device scan chain configuration is the default configuration.
Note

Instruction register lengths vary by vendor and device.
For those new to JTAG, it might be worth mentioning that if non-Achronix devices are in the scan chain, it is
extremely likely that their instruction registers are not 23 bits long, thus the before/after bit counts required
would not be multiples of 23.
The scan chain Offset number is independent of the IR bit numbers, and is used to derive data register pre- and
post-padding, since according to the JTAG specifications, devices being bypassed each always have a DR
length of one.

Running the Snapshot Debugger

The following sections describe how to configure and use the snapshot debugger in an end-user design.

Note

Snapshot hardware architecture details and use of the ACX_SNAPSHOT user macro can be found in the
Snapshot User Guide (UG016), though there may also be supplemental details specific to some Achronix
device families. These documents are available from www.achronix.com/support/docs, download.achronix.com
(account required), or from an Achronix FAE.
The Snapshot content here in the ACE User Guide provides a general overview of functions which are common
to all Achronix devices, and is focused on the snapshot debugger user interface for real time in-system
debugging.

Snapshot Design Flow

Warning!

The JTAG connection must be configured before using the snapshot debugger.
ACE interacts with the FPGA using the JTAG interface through a Bitporter2 pod or FTDI FT2232H device. This
JTAG interface must be properly configured in ACE before using the Snapshot Debugger view. The
configuration is managed using the Configure JTAG Connection preference page (see page 187), which is
easily accessible by clicking the ( ) Configure JTAG Interface button in the Snapshot Debugger view. See
Configuring the JTAG Connection (see page 339) for more details.

Snapshot is the real-time design debugging tool for Achronix FPGAs and eFPGAs. Snapshot, which is embedded in the
ACE software, delivers a practical platform to evaluate the signals of a user design in real-time and optionally send
stimuli to the user design.
To utilize the Snapshot debugger tool, the Snapshot macro must be instantiated inside the RTL for the design under test
(DUT). After instantiating the macro and programming the device, the design can be debugged in the ACE GUI using the
Snapshot Debugger view (see page 139) and the VCD Waveform Editor (see page 29), found within the Programming
and Debug perspective (see page 24).
When instantiated in a design, the Snapshot macro can be used to interface with any logic mapped to the Achronix FPGA core. The Snapshot macro provides a JTAG/JTAP interface to control/observe debug logic mapped to the core. This interface allows the ACE Snapshot Debugger view, which drives the JTAG interface, to control/observe the signals associated with the debug logic.

Within the ACE GUI, the Snapshot Debugger view allows configuring an embedded Snapshot Debugger core, interactively arm the core, and generate a VCD waveform output of the collected samples. By default, the generated VCD waveform output is displayed in the ACE editor area using the VCD Waveform Editor (see page 29). The VCD output can also be read into a third-party waveform viewer.

At a high level, to utilize Snapshot, first:

1. Instantiate the Snapshot macro `ACX_SNAPSHOT` in the user design.
2. Set the required constraints in the `.sdc` files.
3. Synthesize the design.
4. Place and route the design in ACE.
5. Generate the Bitstream for the design in ACE.
6. Configure the ACE JTAG connection to the FPGA (see Configuring the JTAG Connection (see page 339))
7. Program the Achronix device with the Bitstream.
   - Use of the ACE GUI Download view (see page 55) is documented in the section Programming a Device (see page 367)
   - Use of the library of JTAG commands executable on the Tcl command-line is documented in the JTAG Configuration User Guide (UG004)

When these prerequisite steps are complete, the ACE GUI Snapshot Debugger view (see page 139) allows the evaluation /interaction with the running design in real-time.

The following sections further explain Snapshot and provide a guide through the process.

Accessing the Snapshot Debugger

Open the ACE GUI and Select the Project

Open the ACE GUI tool, and load or activate the selected project in the Projects View as shown below. See:

- Loading Projects, (see page 273)
- Setting the Active Implementation (see page 281)
Open the Snapshot Debugger

Click the toolbar button to change to the ( Programming and Debug Perspective as described in the Working with Perspectives (see page 265) section. The Snapshot Debugger view (see page 139) should be visible by default, as shown below. If not, select Window → Show View → Snapshot Debugger from the main menu bar.

The Snapshot Debugger view (see page 139) should have automatically loaded the default Snapshot configuration file for the project, generated when the design ran through place and route, located in <ace_project_dir>/output/names.snapshot. If the file loaded, the correct signal names from the user design appear in the Trigger Channels, Monitor Channels, and Stimuli tables. If the file did not automatically load, click the ( Load Snapshot Configuration toolbar button in the Snapshot Debugger view (see page 139) to browse to the location of the preferred *.snapshot configuration file, or manually enter the signal names, channel widths, etc. to match the design.
Configuring the Trigger Pattern

**Note**

The Trigger Channel signal names are automatically configured to the correct values when the names.snapshot file is loaded. The `names.snapshot` file is generated during design preparation (the Run Prepare Flow Step (see page 223)), which contains the user design signal names connected to Snapshot, along with the trigger width and the maximum number of sequential triggers.

Configuring the Trigger Mode

The **Trigger Mode** option allows the user to select the trigger mode to use when the Arm action is run.

**Single**

The default trigger mode is **Single**, which means the trigger conditions are programmed in to the ACX_SNAPSHOT macro and then the GUI waits for a single trigger event to occur which matches those trigger conditions, and then a single VCD file is recorded. This option arms Snapshot and captures data only once.

**Immediate**

If **Immediate** trigger mode is selected, pressing the Arm button results in the same behavior as **Single** trigger mode, except that all 3 trigger patterns are treated as "Don't Care" (X's) so that the trigger event will occur as soon as the Arm button is pressed. This mode is useful to quickly capture the state of the running design without waiting for any trigger pattern to be met.
**Repetitive**

If **Repetitive** trigger mode is selected, the trigger conditions are programmed in to the ACX_SNAPSHOT macro and samples are captured repetitively until the upper limit of trigger event records is reached. When **Repetitive** trigger mode is selected, an additional set of repetitive trigger mode options will appear to allow the user to configure the number of sequential times Snapshot should be armed repetitively using the configured trigger conditions, and the way in which the output VCD files are managed. This mode is useful when the trigger conditions do not narrow in on the exact data pattern and the pattern you intend to observe occurs sporadically at the trigger conditions. You can let the repetitive trigger mode run for a long period of time, taking several capture records at the trigger conditions, to help find the pattern you are interested in. The user can optionally cancel the remaining Snapshot session once the desired data is captured.

The repetitive trigger Record Limit setting determines how many times (number of records) the GUI will repeatedly Arm the Snapshot debugger and capture samples. The user may set this to automatically run Snapshot up to 128 times.

The repetitive trigger VCD Record Limit setting determines how many Snapshot records to capture in a single VCD file. This essentially concatenates the VCD files from consecutive runs of Snapshot (records) into a single VCD file. The VCD file waveform contains a set of virtual signals to indicate the system timestamp at which each Snapshot record was captured. The user may concatenate up to 10 Snapshot records in a single VCD file.

If the Overwrite VCD File option is selected, the VCD Waveform File name specified in the Advanced Options section will be used to store the output VCD file. The file will be overwritten with the new VCD file each time the VCD record limit is reach. If the Overwrite VCD File option is not selected, then multiple VCD files will be written out and a unique VCD record number will be added to the VCD Waveform File name specified in the Advanced Options section for each VCD. For example, if you set the Record Limit to 8 and set the VCD Record Limit to 2, and set the VCD Waveform file path the "./snapshot.vcd", then Snapshot would output 4 VCD files to "/snapshot1.vcd", "/snapshot2.vcd", "/snapshot3.vcd", "/snapshot4.vcd", each containing 2 Snapshot capture records.

**Configuring Trigger Patterns**

The Snapshot Debugger can be configured to use a **Trigger Channel Width** of 1 to 40 bits. The value entered in the Snapshot Debugger View must match the value of the TRIGGER_WIDTH parameter set on the ACX_SNAPSHOT module in the user design RTL. (This will be the width of the i_trigger bus.)

The Snapshot Debugger is capable of handling one to three sequential trigger patterns. The post-trigger data is sampled once the last trigger pattern in the sequence is matched.

The user may specify the number of desired sequential trigger patterns using the **Number of Sequential Triggers** option in the Snapshot Debugger View (see page 139). If 1 is selected, Trigger 2 and Trigger 3 are ignored. If 2 is selected, Trigger 3 is ignored and Snapshot will trigger when Trigger 1 is matched, followed (on any subsequent clock) by a match on Trigger 2. If 3 is selected, then Snapshot will trigger after a match on Trigger 1, followed (on any subsequent clock) by a match on Trigger2, followed (on any subsequent clock) by a match on Trigger3.

Each sequential trigger is hooked up to the trigger channels on the Snapshot Debugger core. The LSb of the trigger pattern is hooked to trigger channel 0, and the MSb is hooked to upper most trigger channel bit (TRIGGER_WIDTH - 1).

Each sequential trigger is made up of three parts: the pattern mask, the edge mask, and the don't care mask. In the Snapshot Debugger View, these 3 masks are combined for ease of use into a single trigger pattern value, which allows each bit to be specified as **X** (don't care), **R** (rising edge), **F** (falling edge), **0** (level 0), or **1** (level 1). The trigger pattern defines the trigger channel signal conditions that are required to detect a match. If a given trigger channel value is set to **X** (don't care), then this trigger channel is ignored when computing a match. If a given trigger channel value is set to **R** (rising edge), then this trigger channel is is evaluated as a match when a rising edge of this signal is seen by Snapshot. If a given trigger channel value is set to **F** (falling edge), then this trigger channel is is evaluated as a match when a falling edge of this signal is seen by Snapshot. If a given trigger channel value is set to **0** (level 0), then this trigger channel is is evaluated as a match as long as this signal's level is seen as a '1' by Snapshot (it is not edge sensitive). If a given trigger channel value is set to **1** (level 1), then this trigger channel is is evaluated as a match as long as this signal's level is seen as a '0' by Snapshot (it is not edge sensitive).
Warning!

If any active Trigger is configured with as all X's (don't care), the trigger pattern will be a match on the first clock cycle that trigger is evaluated.

The values within a trigger pattern may cause a trigger match event either by AND'ing or OR'ing. If AND'ing, then all signal values not masked (set to X) must match their pattern for the trigger match event to occur. If OR'ing, then the trigger match event will occur if any of the non-masked (not set to X) signal values match the specified pattern. The AND/OR configuration is set per sequential trigger using the Select using AND or Select using OR radio buttons. This selection can be different for each sequential trigger.

In the "Trigger Channels" table of the Snapshot Debugger View, the trigger patterns can be viewed and edited.

Setting Pattern Values Using the Table

For each channel, a value of X (don't care), R (rising edge), F (falling edge), 0 (level 0), or 1 (level 1) can be specified via a pull-down menu under each "Trigger" column as shown below.

![Figure 153: Trigger Channels Setting Example](image)

Setting Multiple Pattern Values as a Bus

The Assign Bussed Values Dialog wizard allows assigning a value to multiple signals from the Snapshot Debugger view "Trigger Channels" or "Stimuli Channels" tables as a bus. After configuring the bus in the dialog, the values of each signal are propagated to all the selected signals in the Snapshot Debugger View. There are 2 ways to launch this dialog to allow bus assignment of values:

1. With your mouse, left click to select a single row in the Snapshot Debugger View (see page 139) "Trigger Channels" or "Stimuli Channels" table which has a bussed signal name (i.e. din[2]). Then right mouse click to edit the Value by Bus. This method will automatically find all the other bits in the bus with the same signal name (i.e. din[0], din[1], din[2], etc.) and open the dialog to allow editing of the entire bus of signals.

2. With your mouse, hold CTRL or SHIFT and left click to select multiple rows in the Snapshot Debugger View (see page 139) table. Then right mouse click to edit the Value by Selection. This method will open the dialog to allow editing of all selected signals as a bussed value.
Configuring the Monitor Signals

**Note**

The Monitor Signals are automatically configured to the correct values when the `names.snapshot` file is loaded. The file is generated during design preparation (the **Run Prepareflow Step (see page 223)**) which contains the user design signal names connected to Snapshot, along with the monitor width and number of samples.

The value of **Monitor Channel Width** in the **SnapShot Debugger view (see page 139)** must be configured to match the value of the `MONITOR_WIDTH` parameter of the `ACX_SNAPSHOT` instance inside the RTL of the design being debugged (this is the width of the `i_monitor` bus).

The value of **Number of Samples** in the **SnapShot Debugger view (see page 139)** should be configured to match the value of the `MONITOR_DEPTH` parameter of the `ACX_SNAPSHOT` instance inside the RTL of the design being debugged. If the value in the GUI does not match the value in the RTL, the value from the RTL is used and a warning is entered into the Snapshot log file.

**Naming Captured Signal Data**

Custom signal names for each channel can be entered under the **Signal Name** heading within the "Monitor Channels" table. The signal/bus names in the table are then used as labels on the captured signal data in the VCD waveform output, and are visible in the **VCD Waveform Editor (see page 29)**.

---

**Figure 154: Assign Bussed Values Dialog Example**

See **Assign Bussed Values Dialog (see page 151)** for more information on this dialog.
Multiple signals can be combined into a bus by selecting multiple rows in the "Monitor Channels" table, right-clicking a selected signal row to bring up a popup context menu, and selecting (Assignment) Assign Bus Name from the context menu to bring up the Assign Bussed Signal Names dialog (see page 149). After configuring the bus in the dialog, the bus name and indices are propagated to all the previously-selected signals.

To select a contiguous range of rows:

1. Select the first signal.
2. Hold the Shift key and select the last signal.

To select a non-contiguous set of rows:

1. Select the first signal.
2. While holding down the Ctrl key, select the other signals.

Signal names may be returned to their defaults by clicking the Reset Signal Names button under the "Monitor Channels" table.

### Note

**Reset Signal Names** resets all signal names in the table at once, not just the currently selected rows/signals.

The Load Signal Names From Active Project button loads the names.snapshot file generated during design preparation (the Run Prepare flow step (see page 223)) which renames all signals with their project-specific names, and also loads the project-specific default settings for monitor width, user clock frequency, default .log and .vcd file path, etc.

### Configuring Test Stimulus

The stimuli channel signal names are automatically configured to the correct values when the names.snapshot file is loaded. The names.snapshot file is generated during design preparation (the Run Prepare flow step (see page 223)), which contains the user design signal names connected to Snapshot, along with the stimuli width.

Snapshot has the capability to send 0 to 512 bits of test stimuli (the ACX_SNAPSHOT macro output signal o_stimuli) to the Design Under Test (DUT). This data is sent once per arming session, is only valid while the o_stimuli_valid signal is high.

This o_stimuli output is optional, and need not be connected to the DUT — it may safely be left floating when Snapshot is used to only read signals.

The value of Stimuli Channel Width in the SnapShot Debugger view (see page 139) must be configured to match the value of the STIMULI_WIDTH parameter of the ACX_SNAPSHOT instance inside the RTL of the design being debugged (this is the width of the o_stimuli bus).

In the Stimuli Channels table of the Snapshot Debugger View, the stimuli values can be viewed and edited.

### Setting Stimuli Values Using the Table

For each channel, an output value of 0 (level 0), or 1 (level 1) can be specified via a pull-down menu under the Value column as shown.
Setting Multiple Stimuli Values as a Bus

The Assign Bussed Values Dialog wizard allows assigning a value to multiple signals from the SnapShot Debugger view (see page 139) Stimuli Channels table as a bus. After configuring the bus in the dialog, the values of each signal are propagated to all the selected signals in the SnapShot Debugger View (see page 139). There are two ways to launch this dialog to allow bus assignment of values:

1. Left click to select a single row in the SnapShot Debugger View (see page 139) table which has a bussed signal name (i.e., din[2]).
   Right click to edit the Value by Bus. This method automatically finds all other bits in the bus with the same signal name (i.e., din[0], din[1], din[2], etc.) and opens the dialog to allow editing of the entire bus of signals.

2. Hold CTRL or SHIFT and left click to select multiple rows in the SnapShot Debugger View (see page 139) table. Right click to edit the Value by Selection. This method opens the dialog to allow editing of all selected signals as a bussed value.
Figure 156: Assigned Bus Values Dialog Wizard Example

See Assign Bussed Values Dialog (see page 151) for more information on this dialog.

Configuring Advanced Options

**Pre-Store**

In the Snapshot Debugger View (see page 139), the Pre-Store setting configures the portion of samples that are collected before the trigger, and (indirectly) how many are collected after the trigger.

For example, assume that Snapshot is configured to use a monitor depth of 1024 samples. See the table below:
Table 144: Effect of "Pre-store" on samples collected before and after the trigger event

<table>
<thead>
<tr>
<th>&quot;Pre-Store&quot; value</th>
<th>Samples collected before trigger</th>
<th>Samples collected after trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>0%</td>
<td>0</td>
<td>1024</td>
</tr>
<tr>
<td>25%</td>
<td>256</td>
<td>768</td>
</tr>
<tr>
<td>50%</td>
<td>512</td>
<td>512</td>
</tr>
<tr>
<td>75%</td>
<td>768</td>
<td>256</td>
</tr>
</tbody>
</table>

When a Pre-Store value other than 0% is selected, the .vcd file contains a signal snapshot_pre_store that transitions (goes low) at the point where the (last sequential) trigger event occurred. Thus, the trigger event may easily be found without needing to actually count the samples.

Trigger Pattern Match Behavior

The values within a trigger pattern may cause a trigger match event either by AND'ing or OR'ing. If AND'ing, then all signal values not masked (set to X) must match their pattern for the trigger match event to occur. If OR'ing, the trigger match event occurs if any of the non-masked (not set to X) signal values match the specified pattern. The AND/OR configuration is set per sequential trigger using the Select using AND or Select using OR radio buttons. This selection can be different for each sequential trigger.

User Clock Frequency

The Frequency field must be configured to match the the user_clk frequency in the target user design, which typically matches the timing constraint set in the SDC file of the design being debugged. The value from the user design SDC file is set automatically in the names.snapshot file when an active implementation is available. The frequency value entered in the Snapshot GUI (or .snapshot configuration file) determines the time (in picoseconds) for all signals shown in the captured VCD file. All samples are captured at the rising edge of the Snapshot user_clk signal.

Configure Output File Locations

The final Snapshot configuration steps specify the locations of the output files which contain the log messages and sample data collected by Snapshot.

File Paths Relative To

Chooses whether the Log File and Waveform File paths are understood to be relative to the Active Project directory or to the Working Directory (this only matters when the file paths provided are relative paths, and not absolute paths).

Log File

configures the file name and path for the log file generated by the Snapshot Debugger run. The associated Browse button provides a directory/file selection dialog for the selection of a location different than the default (the default is <active_impl_dir>/log/snapshot.log, or if there is no Active Project and Implementation (see page 223), <user_home>/snapshot.log). If an error occurs during setup or while reading back the sample information, the Snapshot log file contains the error messages.

Waveform File

configures the file name and path for storing downloaded sample waveform information from the SnapShot Debugger core in VCD format. The Browse button allows for the selection of a location different than the default (the default is <active_impl_dir>/output/snapshot.vcd, or if there is no active implementation, <user_home>/snapshot.vcd).
Collecting Samples of the User Design

**Caution!**

The JTAG connection must be configured before collecting Snapshot samples!

ACE interacts with the FPGA or eFPGA using the JTAG interface through a USB Bitporter2 pod or FTDI FT2232H device. This JTAG interface must be properly configured in ACE before using the Snapshot Debugger View (see page 139). The configuration is managed using the Configure JTAG Connection Preference Page (see page 187), which is easily accessible by pressing the (Configure JTAG Interface) button in the upper-right of the view. See Configuring the JTAG Connection (see page 339) for more details. The (Configure JTAG Interface) button provides a summary of the current JTAG configuration settings (for pod name and scan chain) in its tooltips for ease of reference.

Starting in ACE 9.2, Snapshot uses Tcl JTAG commands instead of STAPL commands for all JTAG interactions (see JTAG Configuration User Guide (UG004) and Snapshot User Guide (UG016) for details). If taking advantage of the Tcl JTAG libraries, this slightly complicates things, because now it must be ensured that the JTAG device is not connected when starting to use Snapshot (at present, using the Snapshot Debugger view requires sole ownership of the JTAG device connection, and errors are reported if Snapshot fails to open the device connection on its own. Achronix plans to relax this limitation in a future release of ACE, ensuring that Snapshot can share an already-open JTAG connection with others). What this means is that `jtag::close` must be called on the connection (if already open) before Snapshot can use the connection.

**Caution! The JTAG connection must be closed before collecting Snapshot samples!**

Snapshot must be the sole owner of the Tcl JTAG connection to the JTAG device for the lifetime of the polling /collection. This means `jtag::close` must be called (if the Tcl JTAG connection was previously opened) before starting the (Arm) or (Capture Startup Trigger) actions. If the Tcl JTAG connection to the JTAG device name remains open when either action is started, the attempted action fails, and an error message is placed in the .log file reporting that Snapshot was unable to open the named JTAG connection.

Arming the Snapshot Debugger

When all the fields in the Snapshot Debugger view (see page 139) are configured, and the design is running on the target device, Snapshot is ready to be armed.

Select the (Arm) button (or the (Arm Snapshot) button in the Snapshot Debugger view toolbar), and the ACE Snapshot Debugger sends the configuration data (including the optional stimulus) to the ACX_SNAPSHOT (or ACX_SNAPSHOT_JTAG_UNIT) circuit running on the Achronix device, waits for the trigger condition(s) to be met, retrieves the trace buffer contents, and outputs a VCD file as well as a LOG file.

When Armed, Snapshot begins to analyze the already-executing design in real-time.

The Snapshot log file and Snapshot waveform file are populated with the captured results, and the files are opened in ACE (the log file opens in an ACE text editor (see page 28), while the waveform (.vcd) file opens in the ACE VCD waveform editor (see page 29)). If an error occurs during Snapshot Debugger configuration or while reading back the sampled information (trace buffer), the Snapshot log file contains the relevant error messages, and the Snapshot waveform file is not created/updated.

The (Cancel) button aborts the Snapshot arming process. The Snapshot log file is updated, but the Snapshot waveform file is not created/updated if the cancel button is clicked. Cancel is useful if accidentally sending in trigger conditions that are never matched.
If using **Repetitive** trigger mode, Snapshot repetitively executes the arm action for the number of records specified, or until the cancel button is clicked. See Configuring the Trigger Pattern (see page 347) for details on the Repetitive Trigger feature.

![Snapshot Debugger Arming Example](image)

**Figure 157: Snapshot Debugger Arming Example**

### Using the Startup Trigger

The Startup Trigger feature is a very special case of Snapshot sample collection, intended specifically to fill the trace buffer based upon captured trigger events that happen very soon after the Achronix FPGA enters user mode. When Snapshot is configured to use the Startup Trigger feature, unlike typical interactive Arming, this means the macro automatically arms as soon as the FPGA enters user mode, so that trigger analysis (and potentially sample collection) can begin immediately. When the ( ![Capture Startup Trigger](image) ) action is selected, ACE does not arm the Snapshot circuit (and does not send any stimuli), but simply starts polling the Snapshot circuit already running on the Achronix device, waits for the trigger conditions to be met (if not already met prior to the button being pressed), and retrieves the populated trace buffer contents. It is not unusual for the trace buffer to already be filled, ready and waiting (because the trigger conditions had already been met), when the user starts the ( ![Capture Startup Trigger](image) ) action in ACE. After the trace buffer data has been retrieved, Snapshot creates the VCD file based on the collected trace buffer contents. Of course, a Snapshot .log file (with the name and path chosen in the **Advanced Options** section in the **Log File** field) is also always populated to provide additional success/failure details, and is opened in the ACE GUI when the action is complete, along with the VCD file.

Be aware that before the Startup Trigger functionality can be used in the Snapshot Debugger view, the Startup Trigger feature must have already been specifically enabled using the initial startup trigger parameters on the **ACX_SNAPSHOT** (or **ACX_SNAPSHOT_JTAG_UNIT**) macro, which includes the needed circuit configuration in the bitstream used to program the Achronix FPGA/eFPGA (see the **Snapshot User Guide** (UG016) for details). This of course means that any time the macro parameters are changed, the bitstream needs to be regenerated and the Achronix device need to be reprogrammed.

Because the Startup Trigger functionality can only be used at chip startup, the FPGA needs to be reset and reprogrammed between Startup Trigger attempts.
Be aware that as soon as the (Arm) action is triggered in any session where the Startup Trigger function was configured in the Snapshot circuit, (before the FPGA has been reset/reprogrammed) the startup trigger conditions and any pre-existing trace buffer contents are cleared when the interactive Arm action re-initializes the Snapshot circuit.

Viewing the Captured VCD Waveform

ACE includes a built-in simple VCD waveform viewer, called the VCD Waveform Editor (see page 29), which is used whenever any *.vcd file is opened within ACE. This is typically only used when viewing VCD files generated by Snapshot, typically from the Snapshot Debugger View (see page 139) when Running the Snapshot Debugger (see page 344) or after using the run_snapshot (see page 610) Tcl command in ACE batch mode.

If the VCD Waveform Editor (see page 29) has insufficient functionality for some use cases, be aware that the *.vcd file created by Snapshot uses the industry standard format, thus any third party VCD viewer can also be used to examine the ACE-generated VCD files.

The VCD waveform viewer does not allow editing the content of a *.vcd file, but it does allow altering which of the signals captured within the VCD are displayed, to change the order of the displayed signals, and to compare/contrast the captured values graphically as waveforms.

The example screenshot below shows an example dataset from a Snapshot session where relatively few signals were captured, but with a higher sample count. Three signal names are visibly selected (with a grey background) in the name /value table, with their waveforms displayed in bold orange. The marker line is also visible in the waveform area, in pink, with the values of each of the signals at that exact marker time displayed in the table on the left (in the Value column). Bussed signals also have their values displayed in the table in hex format, and bus values are also displayed in the waveform area (when the visible area between bus edges is wide enough to fit the bus value). Buttons can be seen below the table on the left to change the table content. Buttons can be seen in the upper-right above the waveform to scroll and zoom the content of the waveform area. Below the waveform area are live feedback labels describing the tick (or time) counts for the onscreen area, the marker position, and the mouse cursor position. At the very bottom left of the screenshot, tabs can be shown that allow switching between the Waveform view of the file data, and the File Preview (raw textual) view.
The VCD Waveform Editor (see page 29) page describes each of these features at a high level, while the following sections describe in more detail how each feature may be utilized.

**Opening a VCD file**

When using the Snapshot Debugger View (see page 139), Snapshot automatically opens any VCD files as soon as they are created (or updated) during a Snapshot session.

When ACE starts, ACE also automatically re-opens any VCD files that were previously open the last time ACE was closed.

There are also a couple ways to manually open previously-generated VCD files:

- With the drop-down application menu choice File → ( 🕯️ ) Open Files and/or the ( 🕯️ ) Open Files button (in the upper left, in the application button bar), arbitrary files can be browsed to and opened graphically, including VCD files.
- If a Snapshot VCD file was previously output to one sub-directory of an implementation (for example, output or reports), the file can be opened by selecting it from the corresponding file listings in the Projects View (see page 123).
- The Tcl command display_file (see page 562) can be used (from the Tcl Console View (see page 144)) to open VCD files (or any other files) in ACE.

**Re-Opening the Same Filename Restores Prior State**

ACE includes the ability to remember many details, by filename/path, of the chosen configuration in the VCD editor. When a previously-used filename/path is re-opened, either manually or automatically, ACE tries to restore many details from the prior session, like the exact signals which were chosen to be visible, and their relative ordering, in the signals.
table. Restoring the exact prior configuration is not always possible, of course, if certain details (like the signal names being captured) are changed between sessions.

**Viewing the Raw Text Content**

While ACE always defaults to showing the VCD file content as waveforms, the raw textual content of the file can always be viewed by selecting the File Preview tab in the lower-leftmost corner of the view.

There are no special features available when viewing the VCD file textual content in this manner.

**Viewing the Signal Data as Waveforms**

When opening a VCD file, ACE always defaults to showing the VCD file content as waveforms. If using the File Preview to view the raw text, viewing the waveform data can always be returned to by selecting the Waveform tab in the lower-leftmost corner of the view.

There are a wide variety of ways that ACE allows altering which portion of the captured data is visible and in what order. These are mentioned in detail in the following sections.

**What is Displayed by Default**

When opening a VCD file for the first time, ACE defaults to showing every captured signal, and when encountering a bus signal, shows both the consolidated bus and every individual captured bit within the bus.

The order of the signals in the table (and accompanying waveforms) initially match the order of the signals as found in the VCD file.

The initial position of the waveform marker is the first moment of the trace, at tick 0. Thus, in the signals table, the values shown are also from tick 0. (The values column always represent the value found for the signal at the time of the marker.)

**Adjusting the Table and Table Column Widths**

The width of the entire signals table may be adjusted by dragging the separator between the table and the waveform to the right/left. If the table width is too narrow to display all the contained columns, a horizontal scrollbar allows scrolling the table content to the right or left.

As with most tables in ACE, the column widths within the signals table can be adjusted by dragging the vertical column separator (the vertical grey line between the column header titles) to the right/left to widen/narrow each column. When a column is too narrow to display its full content, the column content is truncated and an ellipsis suffix is appended. On some operating systems/desktop environments/themes, it is also possible to double-click any table column separator to cause the column (to the left of the separator) to automatically resize its width to accommodate its widest content.

**Panning/Scrolling the Table and Waveform Contents**

The signals table can be scrolled vertically using the table vertical scrollbar or the waveform vertical scrollbar. Both the table and the waveform scroll vertically in lockstep, so that the signal name/value and the waveform for that signal are always aligned (as if the waveform was just another column in the table). The mouse scroll wheel can be used over the signals table (and the table vertical scrollbar) to scroll vertically. On some operating systems/desktop environments/themes, using the scroll wheel over the waveform area vertical scrollbar also scrolls the table and waveform area vertically (though on others, it changes the zoom level of the waveform area).

Scrolling horizontally, the signals table and waveform are are not in lockstep, and are independent. Horizontal scrolling of each can be done clicking/dragging their horizontal scrollbars independently. On some operating systems/desktop environments/themes, using the mouse scroll wheel over the waveform area horizontal scrollbar also scrolls the waveform area horizontally (though on others, it changes the zoom level of the waveform area).

The (←) **Move marker to previous edge** and (→) **Move marker to next edge** buttons can also be used to move the marker, and the waveform is panned to center horizontally on the marker position. When a single signal is selected in the...
table, the marker finds the previous/next edge for that signal. When multiple signals are selected in the table, the marker finds the previous/next edge detected for any of the signals selected in the table. (When there are no signals selected in the table, these buttons become disabled.)

The up/down arrow keys on the keyboard may also be used to change the selected table row vertically, and when the top/bottom of the table are reached, pan/scroll the table vertically (with the waveform area moving vertically in lockstep). After clicking the mouse in the waveform area to give the waveform area focus (which also moves the marker to the clicked position), the up/down/left/right arrow keys on the keyboard can also be used to pan/scroll the waveform area vertically or horizontally, with the signals table moving vertically in lockstep with the waveforms.

**Changing the Waveform Zoom Level**

The (Zoom in) button (found in the upper-right of the waveform area) causes the horizontal space used to represent one tick (or unit of time) to get wider. The rescaled visible area is based around the center of the current visible area, not around the mouse position nor the marker position.

The (Zoom out) button (found in the upper-right of the waveform area) causes the horizontal space used to represent one tick (or unit of time) to get wider. The rescaled visible area is based around the center of the current visible area, not around the mouse position nor the marker position.

Using the mouse vertical scroll wheel over the waveforms similarly changes the zoom level in the waveform area. Be aware that when using the mouse wheel, the mouse position is taken into account, so the tick/time under the mouse stays visible as the zoom changes.

There are also several keyboard shortcuts that may be used when/if the waveform area has application focus. (Click the mouse in the waveform area, including either waveform scrollbar, to move application focus so that the keyboard shortcuts work.) The "Z" and "+" (plus) keys zoom in based on the mouse cursor position, and the "z" and "-" (minus) keys zoom out also based on the mouse cursor position.

**Changing the Order of Displayed Signals**

There are two ways to change the position of a single signal within the signals table:

- Select one (or more, as long as they are adjacent) row(s) in the table, then press the **Move Up** and **Move Down** buttons (found below the table) to move the selected rows up and down with respect to their neighbors.

- Select one row in the table, then vertically drag that row to the desired destination position in the table. Visible feedback is provided (a horizontal bar, bold and/or colored, the details vary based on the OS/desktop environment/theme) to indicate the drop/insertion point between the current rows of the table.

Similarly, multiple adjacent selected signals in the table can be moved together as a unit using the same actions. To select multiple rows, click the first row, press and hold the **Shift** key on the keyboard, then click and release the mouse button over the second row, causing all intervening rows to be selected at once. (Note that when using drag-and-drop, the **Shift** key on the keyboard must remain pressed during the drag-and-drop operation, and should not be released until the mouse button has already been released at the drop/insertion location.)

Keep in mind that if a signal is going to be moved a significant distance, it may be faster to hide/remove the signal, and then re-add the signal directly at the new desired location.

**Adding VCD File Signals to the Display**

With the Add button and the accompanying Add Signals to Waveform Viewer Dialog (see page 146), one or more signals can be added and placed anywhere within the signals table.

To insert a signal at the top of the table:

1. Ensure that no rows of the table are selected. If necessary, deselect any selected rows by holding the keyboard Ctrl key while clicking a selected row.
2. Press the Add... button to bring up the Add Signals to Waveform Viewer Dialog (see page 146).
3. Find and select the desired signal(s) in the list. (If your desired signals are not in the list of hidden signals, which is shown by default, first select the Select from All Signals mode in the dialog.)
   To select more than one signal, press and hold the Shift key when clicking the mouse to select multiple adjacent signals. Press and hold the Ctrl key on the keyboard when clicking to select multiple non-adjacent signals.
4. Press the Insert button in the dialog to insert the chosen signals at the top of the table.

To append a signal at the bottom of the table:

1. (The selection state in the table does not matter when appending signals to the bottom of the table).
2. Press the Add... button to bring up the Add Signals to Waveform Viewer Dialog (see page 146),
3. Find and select the desired signal(s) in the list. (If your desired signals are not in the list of hidden signals, which is shown by default, first select the Select from All Signals mode in the dialog.)
   To select more than one signal, press and hold the Shift key when clicking the mouse to select multiple adjacent signals. Press and hold the Ctrl key on the keyboard when clicking to select multiple non-adjacent signals.
4. Press the Append button in the dialog to append the chosen signals to the bottom of the table.

To insert a signal in the middle of the table:

1. Select the one row immediately above the desired row where the signals should be inserted.
2. Press the Add... button to bring up the Add Signals to Waveform Viewer Dialog (see page 146),
3. Find and select the desired signal(s) to be added from the list. (If your desired signals are not in the list of hidden signals, which is shown by default, first select the Select from All Signals mode in the dialog.)
   To select more than one signal, press and hold the Shift key when clicking the mouse to select multiple adjacent signals. Press and hold the Ctrl key on the keyboard when clicking to select multiple non-adjacent signals.
4. Press the Insert button in the dialog to insert the chosen signals after the row that was selected.

**Duplicating Signals**

It is often desirable to have a signal included in the table (and waveform area) multiple times to ease value comparisons. Simply choose your insertion point in the table as mentioned above, then use the Add.. button to add another copy of the desired signal to the table. (Make sure the Select from All Signals mode in the Add Signals to Waveform Viewer Dialog (see page 146) is chosen, because the signal is already displayed, and, thus, is not in the list of currently hidden signals.)

If necessary, then use the Move Up and Move Down buttons (or drag-and-drop signals in the table using the mouse) to align the copied signal in relation to its peers.

**Removing/Hiding Display Signals**

Signals can also be hidden/removed from the table (and simultaneously the waveform area).

Simply select the row(s) in the signals table containing the signal(s) to be hidden/removed, then press the Remove button below the table. The chosen signal(s) are hidden. Keep in mind, this does not affect the content of the VCD file, and the signal(s) may still be revealed/added again at any time (and at any desired position in the table).

**Examining Signal Values**

While it is possible to see the values of all the signal traces by simply examining the waveform, proper use of the signals table in combination with the waveform area can make things much easier.

**Bits Versus Buses**

Icons are shown to the left of each signal name as an indicator whether the name corresponds to a individual bit signal or a bus.
### Table 145: Signal Name/Value Table Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Signal Icon]</td>
<td>Signal</td>
</tr>
<tr>
<td>![Bus Icon]</td>
<td>Bus</td>
</tr>
</tbody>
</table>

The values of bit signals are shown as a simple 0 or 1. Bus values are shown in (unsigned) hexadecimal format. Additionally, bus hex values are displayed within the waveform area when there is sufficient space, such as enough horizontal space between edges of the value to contain the rendered value string. Zooming in on the waveform area increases the horizontal distance between bus edges, causing wider bus values to become visible.

When dealing with wide buses, it might make sense to make the waveform font choice as small a point size as remains legible, allowing wider bus values to be shown in the same amount of horizontal space. Use the (Configure colors...) button to quickly access these preferences.

#### Highlighting Signal Rows

When rows are selected in the signal table, the corresponding waveforms are rendered with a special selection foreground color (orange by default). Optionally, using font preference settings (see below), selected bus values in the waveform area may also be rendered in a user-selected font to make them stand out even more, if the selection foreground color change is insufficient.

Multiple rows in the table may be selected simultaneously by holding the CTRL key on the keyboard while clicking on each desired signal row.

#### Understanding How the Waveform Area Represents Time

The Snapshot signal traces are captured with respect to both a snapshot clock (ticks, abbreviated "tk") and an elapsed time (shown in s, ms, us, ns, ps, or fs, whichever is most appropriate). Ticks and elapsed time may be toggled between by pressing the button centered below the waveform area (which alternates between the labels **Show Ticks** and **Show Times** each time it gets pressed).

There are four labels below the waveform area that show the times for various portions of the interface:

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>The tick or elapsed time value at the leftmost visible part of the waveform area.</td>
</tr>
<tr>
<td>Right</td>
<td>The tick or elapsed time value at the rightmost visible part of the waveform area.</td>
</tr>
<tr>
<td>Marker</td>
<td>The tick or elapsed time value at the marker bar, which may be offscreen, and may thus have a value less than the left value or greater than the right value.</td>
</tr>
<tr>
<td>Cursor</td>
<td>The tick or elapsed time value at the cursor horizontal position.</td>
</tr>
</tbody>
</table>
Note about Cursor values

When the mouse moves away from the waveform area, the last position over the waveform is retained by the Cursor value. This ps or tk value does not change until the mouse cursor is again over the waveform, even if the view is scrolled or the zoom factor is changed.

Using the Marker

The waveform area includes support for a user-managed marker, represented as a pink colored vertical bar by default, to allow examining signal values at chosen points in time/ticks.

When the marker is moved, the Values column in the signals table are immediately updated to contain the values of all signals at the point in time/ticks represented by the marker location. Additionally, the value of the "marker" label below the waveform area is updated to show the exact time/tick value of the marker.

Targeted Marker Placement

Clicking the primary mouse button anywhere within the waveform area moves the vertical marker bar to the horizontal position that was clicked. (When zoomed far enough out, the marker may even be placed after the trace has ended.)

The "m" (for marker) and "s" (for select) keyboard shortcuts also causes the marker to be placed under the current cursor position. (If the cursor is over the signals table, the marker is moved to the left edge of the visible waveform area, such that the tick/time value shown for the "Left" and "Marker" values below the waveform area matches.)

Using the Marker to Find the Next or Previous Signal Edge

The ( ) Move marker to previous edge and ( ) Move marker to next edge buttons (found in the upper-right of the waveform area) can also be used to move the marker from its current position to a new signal edge position, and the waveform is panned to center horizontally on the marker position. When a single signal is selected in the table, the marker finds the previous/next edge for that single signal. When multiple signals are selected in the table, the marker finds the previous/next edge detected for any of the signals selected in the table. (When there are no signals selected in the table, these buttons become disabled.)

Editing Waveform Color and Font Preferences

All of the colors and fonts used within the waveform area are allowed to be adjusted as Preferences (see page 186). These can be reached quickly by pressing the ( ) Configure colors... button in the upper-right of the waveform area, or by navigating to Window → Preferences → General → Appearance → Colors and Fonts → VCD Editor.
These preferences can be altered to, for example, provide a green-on-black color scheme, as would be seen on a traditional lab scope. Some prefer to have a bold font for the selected signals (for bus values). An example of this sort of color and font scheme is visible in the screenshot at the end of the VCD Waveform Editor (see page 29) description.

Saving/Loading Snapshot Configurations

An existing known-good Snapshot configuration (the collection of settings in the Snapshot Debugger View (see page 139)) may be re-used at a later date, or in batch mode.

Snapshot configurations may be saved to a Snapshot configuration file (with the .snapshot file extension) using the ( ) **Save SnapShot Configuration** button found in the Snapshot Debugger view (see page 139) toolbar.

These Snapshot configurations may then be loaded later by using the ( ) **Load SnapShot Configuration** button, found in the Snapshot Debugger view (see page 139) toolbar.

**Note**

Previously saved Snapshot configuration files are necessary to run **Snapshot in Batch mode (see page 365)**.
Tip

When a user design containing the ACX_SNAPSHOT macro completes the Run Prepare, a names.snapshot configuration file is automatically generated. This file contains harvested information from the design including the monitor width, monitor depth, monitored signal names, trigger width, maximum number of triggers, trigger signal names, stimuli width, stimuli signal names, and user clock frequency. When an active project and implementation (see page 223) is available, the Snapshot Debugger view automatically loads the implementation names.snapshot file to pre-populate the relevant fields of the view. When generated, the file contains only a subset of a complete Snapshot configuration, and thus a generated names.snapshot file should not be used to drive Snapshot in batch mode (see page 365) via Tcl. The names.snapshot configuration file can be loaded as a starting point to map the Snapshot RTL configuration into the Snapshot Debugger View. The Snapshot settings can be further customized and saved as custom Snapshot configuration files for later use.

Snapshot in Batch Mode

It is also possible to run Snapshot from ACE in batch mode. To do so, use the TCL command run_snapshot. Note that run_snapshot requires the use of a previously-saved (see page 364) Snapshot configuration file (.snapshot), and allows some values to be overridden from the TCL commandline. See the run_snapshot command in the TCL Command Reference section for further details.

The Snapshot configuration file may be edited manually in a text editor, or by configuring the Snapshot Debugger view (see page 139) in the ACE GUI and saving the Snapshot configuration (see page 364).

Example Snapshot Configuration File

```
# Snapshot Configuration File
# Tue Sep 12 13:52:54 PDT 2017
files_relative_to_project=1
frequency=322.0
log_file=./impl_1/log/snapshot.log
monitor_ch0.name=reset_n
monitor_ch1.name=stimuli_valid
monitor_ch10.name=limit_a[7]
monitor_ch11.name=counter_a[0]
monitor_ch12.name=counter_a[1]
monitor_ch13.name=counter_a[2]
monitor_ch14.name=counter_a[3]
monitor_ch15.name=counter_a[4]
monitor_ch16.name=counter_a[5]
monitor_ch17.name=counter_a[6]
monitor_ch18.name=counter_a[7]
monitor_ch19.name=counter_b[0]
monitor_ch2.name=arm
monitor_ch20.name=counter_b[1]
monitor_ch21.name=counter_b[2]
monitor_ch22.name=counter_b[3]
monitor_ch23.name=counter_b[4]
monitor_ch24.name=counter_b[5]
monitor_ch25.name=counter_b[6]
monitor_ch26.name=counter_b[7]
monitor_ch27.name=counter_b[8]
monitor_ch28.name=counter_b[9]
monitor_ch29.name=counter_b[10]
monitor_ch3.name=limit_a[0]
```
monitor_ch30.name=counter_b[11]
monitor_ch31.name=counter_b[12]
monitor_ch32.name=counter_b[13]
monitor_ch33.name=counter_b[14]
monitor_ch34.name=counter_b[15]
monitor_ch4.name=limit_a[1]
monitor_ch5.name=limit_a[2]
monitor_ch6.name=limit_a[3]
monitor_ch7.name=limit_a[4]
monitor_ch8.name=limit_a[5]
monitor_ch9.name=limit_a[6]
monitor_width=38
num_samples=4096
num_triggers=3
pre_store=0%
repetitive_trigger.overwrite_vcd=0
repetitive_trigger.record_limit=10
repetitive_trigger.vcd_record_limit=10
snapshot_version=3
stimuli=110010100
stimuli_ch0.name=stimuli[0]
stimuli_ch1.name=stimuli[1]
stimuli_ch2.name=stimuli[2]
stimuli_ch3.name=stimuli[3]
stimuli_ch4.name=stimuli[4]
stimuli_ch5.name=stimuli[5]
stimuli_ch6.name=stimuli[6]
stimuli_ch7.name=stimuli[7]
stimuli_ch8.name=do_reset
stimuli_ch9.name=stimuli_ch9
stimuli_width=9
trigger1=XXXXXXXXXXXXXXXXXXXXXXXXXXX00110101XXXXXXXXXXX
trigger1.select_using_and=1
trigger2=XXXXXXXXXXXXXXXXXXXXXXXXXXXXX1111R000XXXXXXXXXXX
trigger2.select_using_and=1
trigger3=XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXFXXXXXXXXXXXXXX
trigger3.select_using_and=1
trigger_ch0.name=reset_n
trigger_ch1.name=stimuli_valid
trigger_ch10.name=limit_a[7]
trigger_ch11.name=counter_a[0]
trigger_ch12.name=counter_a[1]
trigger_ch13.name=counter_a[2]
trigger_ch14.name=counter_a[3]
trigger_ch15.name=counter_a[4]
trigger_ch16.name=counter_a[5]
trigger_ch17.name=counter_a[6]
trigger_ch18.name=counter_a[7]
trigger_ch19.name=counter_b[0]
trigger_ch2.name=arm
trigger_ch20.name=counter_b[1]
trigger_ch21.name=counter_b[2]
trigger_ch22.name=counter_b[3]
trigger_ch23.name=counter_b[4]
trigger_ch24.name=counter_b[5]
trigger_ch25.name=counter_b[6]
trigger_ch26.name=counter_b[7]
trigger_ch27.name=counter_b[8]
trigger_ch28.name=counter_b[9]
Programming a Device

**Warning!**
The JTAG connection must be configured before using the Download View!

ACE interacts with the FPGA using the JTAG interface through a Bitporter2 pod, or a FTDI FT2232H or FT4232H device. This JTAG interface must be properly configured in ACE before using the Download view. The configuration is managed using the Configure JTAG Connection preference page (see page 187), which is easily accessible by clicking the **Configure JTAG Interface** button in the Download view. See Configuring the JTAG Connection (see page 339) for more details.

A bitstream (*.hex) file can be downloaded to the FPGA or eFPGA device from the Download view (see page 55). To access the Download view, change to the **Programming and Debug** perspective, or select Window → Show View... → Others → Download View.

From this view, bitstream files can be selected for downloading, programming options can be adjusted, utility functions can be called against connected devices, and the actual download to the target device may be triggered.

Selecting a Bitstream File

By default, the Download View (see page 55) automatically remembers the last *.hex bitstream file opened by the current userid, and pre-populates the filename/path with the last-used value when ACE is started.

When a different bitstream file is desired, it can be chosen by either selecting a hyperlink from the provided lists of bitstream files, or by pressing the **Browse** button.

As elsewhere in ACE, pressing the **Browse** button allows searching for *.hex files in the filesystem using the graphical file browser native to the operating system desktop environment.

The view also remembers the last dozen or so files the chosen, and lists them in the Suggested Recently Used lists as hyperlinks. The list only displays files which are still valid choices. Previously used files which have been deleted from the file system are not be displayed in the list of suggestions. Select any listed hyperlink to make that file the active *.hex bitstream file to be downloaded.

ACE also includes a suggestion list of all the *.hex files that exist for the Active Project and Implementation (see page 223). ACE updates this suggested file list whenever new files are created or when files are deleted. Unlike in prior versions, ACE no longer attempts to automatically pick which bitstream file should be used. A hyperlink must now be
manually chosen when switching to a file to be the active bitstream used. Recent configuration feature improvements, such as support for Partial Reconfiguration and Multi-Stage Programming, make it impossible for the Download view to always display the bitstream file that is most needed.

**Lab Mode**

The **Browse** button continues to work normally when in Lab Mode. The list of suggested **Recently used** files continues to be populated and usable. This list is updated if any new files (not already in the list) are chosen using the **Browse** button. But when ACE is in Lab Mode, it is impossible to load projects/implementations meaning there is never a "current" active project/implementation. Thus the list of suggested file hyperlinks from the active implementation is empty in Lab Mode.

**Selecting Bitstream Programming Options**

While getting ready to use the **Download view (see page 55)** to program a device with a bitstream *.hex file, there are some configuration options available to be adjusted by toggling checkboxes in the view. Any adjustments should be made prior to each bitstream file download.

**Table 146: JTAG Programming Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform an FCU reset to clear the (e) FPGA config memory</td>
<td>When checked, performs a soft reset and clears all device configuration memory before beginning programming. This reset is typically only disabled for multi-stage programming after stage 0 programming has completed but before programming later stages begins, or for Partial Reconfiguration when partial bitstreams are in use (see the chapter titled Partial Reconfiguration in the <em>Speedster7t Configuration User Guide</em> (UG094) for more details).</td>
</tr>
<tr>
<td>Close the JTAG connection /device when programming is complete</td>
<td>By default, the chosen JTAG connection (see Configuring the JTAG Connection (see page 339)) is opened at the beginning of programming (if it was not already open) and is closed when programming is completed. Uncheck this box to leave the named JTAG connection open when programming is complete, allowing additional JTAG interactions to occur over the same open connection.</td>
</tr>
</tbody>
</table>

**Downloading the Bitstream to the Target Device**

When using the **Download view (see page 55)**, after finishing **Selecting a Bitstream File (see page 367)**, and **Selecting Bitstream Programming Options (see page 368)**, perform the download to the target device by pressing the **Download Bitstream** button.

This causes the Tcl command `jtag::download_bitstream` to be executed in the **Tcl Console view (see page 144)** using the appropriate arguments. All feedback from the command (informational, warnings, and errors) appears in the Tcl Console view, and also is saved in the ACE session **Log file (see page 220)**.

For more information about the JTAG Tcl interface commands, and for troubleshooting information regarding common programming problems, please see the *Speedster7t Configuration User Guide* (UG094).

**Optimizing a Design**

There are numerous methods of design optimization available in ACE.

Many optimizations can be performed automatically by ACE, at the cost of additional runtime. These automatic optimizations are managed at a granular level through the **implementation options (see page 217)**, which may be configured from the **Options view (see page 106)** and/or the `set_impl_option` Tcl command.
Achronix optimization experts have also collected together into option sets (see page 217) the implementation options which are known to work well together. These option sets may be used to create new implementations for user designs, to allow comparing/contrasting how various optimizations affect achieved frequencies and required runtimes.

Other optimizations must be performed manually, typically by editing the design source RTL or .sdc timing constraints. Analyzing critical paths (see page 332) is an important part of this process. Optimization through RTL changes is currently beyond the scope of this document — ask your Achronix Field Applications Engineer for more information regarding source optimization possibilities.

### Attempting Likely Optimizations Using Option Sets

In addition to running multiple flows in parallel (see page 285), the Multiprocess view (see page 86) allows generating new implementations with auto-generated combinations of implementation options (see page 217). These known-good subsets of implementation options are called option sets (see page 217).

ACE can generate customized option sets based on design details (such as the target device) found within the active project and implementation (see page 223). These customized option sets are only generated by request, and are specific to the details of each implementation. To generate the customized option sets for the active implementation, use the Refresh Option Sets button in the Multiprocess view (see page 86), or the option -create_option_sets when calling the run_multiprocess Tcl command.

The Multiprocess view allows selecting a starting template implementation (see page 217) and then generating new implementations using the template implementation as a base. Each generated implementation overrides the implementation options found in the template implementation with the specified option set configuration (an overriding subset of the full collection of implementation options). The majority of the implementation options within the generated implementation are left with the same settings as existed in the template implementation. Only the options specified in the option set are overridden to take on new values. The newly generated implementation is given a name which includes the option set name for clarity (the generated name uses the template implementation name as a prefix, with the option set name as the suffix).

See the information in Running Multiple Flows in Parallel (see page 285), which discusses the basic use of the Multiprocess view (see page 86) and Multiprocess Summary report (see page 240) — the rest of this section builds upon those descriptions.

### Selecting the Implementations to be Generated and Run in Parallel

After finding the Multiprocess view (see page 285), configuring the execution queues (see page 285), and configuring the desired flow to be followed by the selected implementations (see page 292), the implementations to be generated may be selected:

1. In the Projects view (see page 123), select (activate) the desired project (see page 217) and implementation (see page 217).

2. Select the radio button labeled Generate Implementations from Option Sets, found within the Multiprocess view Select Implementations (see page 89) section.

3. Click the Refresh Option Sets button to generate new option sets particular to the details of the active project /implementation. All of these custom option sets include "auto" in their names.

4. The Implementation Table within the Multiprocess view Select Implementations (see page 89) section is then updated to display a collection of potential implementations based upon the active implementation (see page 223), with names derived from the refreshed option sets.

The first entry in the Implementation Table is the active implementation itself. This implementation is the template from which all the generated implementations are derived. All other implementations in the table are generated, one for each option set, if they are selected (their checkbox is checked) when background execution is started. The Description column of the table indicates succinctly what implementation option changes are caused by each option set (thus describing how each generated implementation differs from the template, the active implementation).
**Generating Option Set Implementations and Starting Background Execution**

After the (Start Selected) button has been pressed, but before the behavior described in Starting Background Execution (see page 293) commences, ACE:

1. removes implementations in the active project with the same name as to-be-generated implementations
2. creates new implementations (exact copies of the template implementation) with the required names
3. applies the appropriate option set implementation options to the new implementations (overriding the inherited implementation option values with the subset making up the option set)
4. adds all selected (checked) implementations to the background processing queue(s), to be run through the flow

From this point on, the available functionality and behavior is identical to that described in Running Multiple Flows in Parallel (see page 285), beginning with starting background execution (see page 293).

⚠️ **Warning!**

Each generated implementation which is selected overwrites without prompting any already-existing implementation with the same name in the active project. The template (active) implementation is not changed /overwritten. If a previously-existing implementation with a to-be-generated name collision is kept, the previously-existing implementation must be renamed to avoid the name collision before the (Start Selected) button is pressed.

**Interpreting/Utilizing the Results**

After viewing the results (see page 294), the final step of an optimization pass is usually comparing the results and choosing which generated option set implementation provides the best QoR in comparison to the template implementation.

By default, the implementations in the multiprocess summary report (see page 240) are sorted approximately by QoR, though it is likely still preferred to analyze the results in detail to choose which implementation is the best by preferred criteria.

**Note**

**Early Access Functionality**

The automatic QoR sorting of the Multiprocess Summary report should be considered early access functionality. The sort details are likely to change (and improve) in future ACE releases.

That best generated implementation could then be renamed, so that it does not get overwritten by future multiprocess runs (e.g., it might be named "fastest1", "lowestpower1", etc.).

With the newly-renamed implementation selected in the Projects view (making it the active implementation), it also becomes the new template implementation in the Multiprocess view, ready for another multiprocess iteration through the option sets.

By iterating through several best template implementations (perhaps each with a new implementation name for "breadcrumb" purposes), the desired QoR may be reached.

⚠️ **Caution!**

Ensure Generate Implementations from Option Sets is selected for each optimization iteration, otherwise any changed implementation options in the template implementation are not inherited by the option set implementations.
Also, there is a scenario where all multiprocess results can be identical. The cause and a workaround are described in Running Multiple Flows in Parallel (see page 294).

Placement Regions and Placement Region Constraints

Warning!
Placement Regions and Placement Region Constraints are an advanced feature, and should only be used under the guidance of an Achronix FAE. Unguided use of placement region constraints can cause loss of QOR, or may make a design impossible for the Placer or Router to solve.

Note
ACE automated placement often produces better QOR than user-defined placement regions/constraints
When attempting to use Placement Regions and Placement Region Constraints, it is highly recommended that a parallel implementation of the project lacking the user-defined Placement Regions be kept. In a number of tested cases, completely automated placement in ACE was able to produce better QOR than with user-defined Placement Regions and Placement Region Constraints. This can easily be achieved by keeping the placement region constraints in a separate pdc file, which can then be enabled or disabled for the place and route flow.

Placement Regions are user-defined rectangular areas of the core fabric (not the IO Ring), to which the user can inclusively constrain the placement of multiple instances from their design, without needing to manually assign instances to specific sites within that region.

Because of clock distribution limitations, only a finite number of clocks can be routed to each of the Clock Regions (see page 245) in the fabric. Placement regions allow advanced users to ensure that those constraints are met if the automated tools need guidance. When necessary, clocked instances (flops, BRAMs, etc) may be constrained to placement regions to guarantee ACE does not attempt routing more clocks into a region than the region can support.

Placement Regions and the associated instance placement constraints may be manipulated through Tcl, or via the ACE GUI using the Floorplanner View (see page 57) and Placement Regions View (see page 118). The Search View (see page 132), Selection View (see page 136), Critical Paths View (see page 52), and Netlist Browser View (see page 92) may also be used to assign instance placement constraints by using drag-and-drop operations.

Be aware that Placement Regions are not treated as distinct objects in the ACE design database. Thus, they do not have their own object type prefix (see page 313), nor are they directly searchable in the Search View (see page 132) or with the Tcl find command (see page 570).

Placement Region Preferences
There are a number of user preferences which may be configured to alter how the mouse creates placement regions and assigns placement region constraints. These preferences are found on the Placement Regions Preference page (see page 209).

Creating a New Placement Region
Placement regions may be created/defined by using the mouse in the Floorplanner View, or by directly calling the Tcl command create_region. In both cases, the bounds of the created region may "snap to" (grow to encompass) the entirety of all enclosed Clock Region boundaries or tile boundaries.

To create a Placement Region using the mouse in the Floorplanner view:

1. Ensure the ( ) Floorplanner Placement Region Tool is active.
2. (Optional) If the Placement region is meant to align with one or more Clock regions (see page 245), enable the overlays for those regions from the Clock Regions view (see page 39). This does not affect the functionality in any way, but makes it easier to know where to define the region bounds.

3. Press and hold the left mouse button with the cursor at one of the corners of the area to be defined as the new Placement region.

4. While still holding the left mouse button, drag the cursor to the opposite corner of the desired Placement region area. Release the left mouse button when the cursor reaches the desired location.

5. ACE calculates the enclosed subtile grid coordinates, growing the grid as necessary to ensure all partially-enclosed tiles are fully enclosed.

6. The Create Placement Region dialog (see page 165) pops up pre-populated with the calculated subtile coordinates:

![Create Placement Region Dialog](image)

7. Fill in the desired Placement region name.
8. Select whether the Placement region should be snapped to align with the edges of the Clock regions (see page 245), or the fabric clusters (see page 261), or with the more granular grid of basic resource tiles.

9. Select whether the Placement region should be an inclusive region, a "keep out" region, or a soft region (see the create_region Tcl command documentation for more information on these options).

10. Click the Finish button to create the new Placement Region.

11. ACE adds the new Placement Region to the table in the Placement Regions View (see page 118) and displays it as a translucent overlay within the Floorplanner (at this point, the region contains no constraints).

Resizing an Existing Placement Region

Existing Placement Regions may be resized with the set_region_bounds Tcl command, or with the mouse in the Floorplanner view. Any existing Placement Region Constraints for that region are kept — only the enclosed area is updated.

To resize a Placement Region with the mouse in the Floorplanner View (see page 57):

1. Ensure the ( ) Floorplanner Placement Region tool is active.

2. In the Placement regions view (see page 118), ensure the checkbox in the first column is selected for the desired Placement region. This makes the Placement region overlay visible within the Floorplanner view.

3. Ensure the Snap To: option in the Placement Regions Preference page (see page 209) is configured as desired.

4. (Optional) If the Placement region is meant to align with (snap to) one or more Clock regions (see page 245), enable the overlay for those regions from the Clock Regions view (see page 39). This action does not affect the functionality during the resize in any way, but makes it easier to know where to define the region bounds.

5. Move the mouse over any of the four corners of the placement region to be resized. The mouse cursor changes to a diagonal resize cursor when in a potential resize location.

6. Press and hold the left mouse button and drag the mouse to expand or shrink the Placement region area as desired.

7. Release the left mouse button when the mouse is at the desired location.

8. ACE calculates the enclosed subtile grid coordinates, growing as necessary to ensure all partially-enclosed subtiles (or Clock regions) are fully enclosed.

9. The Placement Region View table content is updated to show the new site counts enclosed by the Placement region, and the Floorplanner is updated to show the new Placement region overlay.

Moving an Existing Placement Region

Existing Placement Regions may be moved with the set_region_bounds Tcl command, or with the mouse in the Floorplanner view (see page 57). Any existing Placement Region Constraints for that region will be kept — only the enclosed area will be updated.

Be aware that the Snap To setting is enforced during the move — the enclosed area might not stay the same dimensions after the move. As with creating/resizing a region, the area will grow to ensure there are no partial sites in the enclosed area. It is frequently desired to resize (shrink) the Placement Region after a move, as it can easily grow larger than expected if sites/Clock Regions were partially enclosed at the ending mouse location.

To move a Placement Region with the mouse in the Floorplanner:

1. Ensure the ( ) Floorplanner Placement Region Tool is active.

2. In the Placement Regions view, ensure the checkbox in the first column is selected for the desired Placement Region. This selection makes the Placement Region visible within the Floorplanner view.

3. Ensure the Snap To option in the Placement Regions Preference Page (see page 209) is configured as desired.
4. (Optional) If the Placement Region is meant to align with (snap to) one or more Clock Regions (see page 245), enable the overlay for those regions from the Clock Regions view (see page 39). Enabling the overlay does not affect the functionality during the resize in any way, but makes it easier to know where to define the region bounds.

5. Move the mouse over the placement region to be moved. The mouse pointer changes to a "move" cursor when the mouse is over any placement region.

6. Hold the left mouse button while dragging the mouse to the desired new location for the placement region.

7. Release the left mouse button when the upper-left corner of the dragged region is at the desired location.

8. ACE calculates the enclosed subtile grid coordinates, growing as necessary to ensure all partially-enclosed subtiles (or Clock regions) are fully enclosed.

9. The Placement Region View table content is updated to show the new site counts enclosed by the Placement region, and the Floorplanner is updated to show the Placement region overlay at the new location (and with the latest dimensions).

Assigning Placement Region Constraints

Placement region constraints may only be assigned to core and boundary instances (not IO pads). Instances may be assigned placement region constraints interactively from the Tcl console, or from a PDC constraint file, with the add_region_insts and add_region_find_insts Tcl commands, or interactively with drag-and-drop mouse actions in the ACE GUI.

When using the add_region_insts or add_region_find_insts Tcl commands, the instances to constrain may be specified using an explicit list of instance names, or by clock domain name or critical path ID.

If specified as an explicit list of instance names the list may be formatted explicitly, or it may be the output of a find Tcl command.

```tcl
add_region_insts "region_1" {i:inst1 i:inst2}
add_region_insts "region_1" [find -insts inst*]
add_region_insts "region_1" [find -insts inst* -filter {
  @type=DFF &&
  @clock_domain=clk1}]
```

If specified by critical path ID, ACE determines which instances are part of that critical path, and assigns the placement region constraint to those instances.

```tcl
add_region_insts "region_1" {c:sc_s0}
```

Likewise, if specified by clock domain name, ACE determines which instances are part of that clock domain, and assigns the placement region constraint to all of those instances.

```tcl
add_region_insts "region_1" {k:clka}
```

When writing PDC constraint files, the recommended practice is to use the add_region_find_insts command instead of the add_region_insts command. This is because:

1. When the instance list is specified with a find command, or by critical path ID or clock domain name expression, the command/expression is evaluated and expanded into a list at the time at which the add_region_insts command is evaluated (which happens at the beginning of the run_prepare flow step), not at the time at which it is applied with the apply_placement command (which happens at the end of the run_prepare flow step).
2. New instances which may be created during the `run_prepare` flow step, even if they would have matched the command/expression, are not included. Therefore, the `add_region_insts` command is best reserved for interactive use.

3. The `add_region_find_insts` command, on the other hand, specifies the `find` command as a string argument to be batched and evaluated later during the `apply_placement` command.

```text
add_region_find_insts "region_1" "find -insts inst"
add_region_find_insts "region_1" "find -insts inst* -filter {@type=DFF && @clock_domain=clk1}"
```

**Note**

**Saving Critical Path or Clock Domain Constraints**

When critical paths or clock domains are used to specify the constraint, they are immediately expanded into a list of the corresponding instances within ACE at the time at which the `add_region_insts` command is evaluated. If the placement region constraints are later exported from ACE (and saved into a pdc file), they are exported as explicit lists of instance names and the original association with a critical path or clock domain is lost. More concise constraints for user designs may be created by manually entering the placement region constraint in the PDC file using the clock domain name instead of the list of explicit instances.

If any instance which was previously assigned a placement region constraint is assigned a new placement region, the prior constraint is overridden and discarded.

Optionally, placement region constraints may be restricted to allow only flops, in which case all other instances are excluded. (Setting these inclusion/exclusion preferences for mouse actions is done on the Placement Regions Preference page (see page 209).)

```text
add_region_insts -flops_only "region_1" [find -insts * -filter {@clock_domain=clk1}]
add_region_find_insts -flops_only "region_1" "find -insts * -filter {@clock_domain=clk1}"
```

When placement region constraints are assigned to instances interactively using drag-and-drop mouse actions in the ACE GUI, the mouse drag-assign actions can start from:

- the Search view, where individual Instances and/or Paths, groups of Instances and/or Paths, or all Instances and/or Paths in the search results (if the titled branch nodes themselves are dragged, even the Instances/Paths not in the current set of 200 on the visible page of results) may be drag-assigned.
- the Selection view, where individual Instances and/or Paths, groups of Instances and/or Paths, or all Instances and/or Paths in the selection set (if the titled branch nodes themselves are dragged, even the Instances/Paths not in the current set of 200 on the visible page of results) may be drag-assigned.
- the Critical Paths view, where individual Paths or groups of paths may be drag-assigned.
- the Clock Domains view, where clock domains may be drag-assigned to include all applicable Instances from that clock domain in the assignment.
- the Netlist Browser view, where any node of the tree may be dragged, and all child nodes are included.

Mouse drag-assign actions can end at:

- An individual Placement Region row in the table within the Placement Regions View. After the assignment of the dropped Core/Boundary Instances completes, the site utilization counts are updated.
- A visible Placement Region overlay in the Floorplanner view, if the Placement Region Tool is active in the Floorplanner. After the assignment of the dropped Core/Boundary Instances completes, the site utilization counts in the Placement Regions view for that region are updated.
### Note

**Overlapped Placement Regions**

If multiple placement regions overlap visibly in the Floorplanner view, any Instances dropped within the visibly overlapping area are ignored. In such cases, instances must either be dropped in the Placement Regions view, or dropped in the Floorplanner view where there is no visible overlap (Placement Region overlays may be disabled from the Placement Regions view to eliminate visible overlaps — in these cases, constraint assignment occurs to whichever placement region remains visible at the Floorplanner drop location).

---

**Listing all Objects Constrained to a Placement Region**

The count of total sites of each type within each placement region is listed in the Placement Regions view (see page 118), along with the count of each Instance type for the sites.

If there are more instances constrained to a region than there are sites for that region, the corresponding cell in the Placement Regions view table turns red to indicate the problem.

To view a list in the Tcl Console view (see page 144) of all objects constrained to a placement region, do one of the following:

- Use the `get_region_insts` Tcl command.
- Right-click the desired Placement region in the Placement Regions view and select Print Instances.

**Removing a Placement Region Constraint from an Object**

Placement region constraints may be removed from individual core/boundary instances, or from all instances assigned to a region at once.

To un-assign a placement region constraint for individual core instances, use the `remove_region_insts` Tcl command.

To remove all instance constraints from a placement region, use the same Tcl command, or in the Placement Regions view (see page 118), right-click the desired placement region, and select Clear Placement Region.

---

**Saving Placement Region Definitions and Placement Region Constraints**

Placement region constraints may be saved:

- from the Floorplanner view (see page 57) with the "Save Pre-placement Constraints" action (which displays the Save Placement dialog (see page 179))
- from the Placement Regions view (see page 118) with the "Save Placement Regions" action (which displays the Save Placement Regions dialog (see page 182))
- by using the `save_regions` Tcl command directly

---

**Note**

**Important Consideration When Saving Placement Region Constraints**

Only the final list of all individual instances being constrained is saved. The individual Tcl commands which built up the final list of constraints (including "find" commands, the extraction of instances from critical paths, or from clock domains) is lost. The saved PDC file may be edited to replace explicit lists of instances with `find` commands or clock domain names.
Deleting Placement Regions

Unwanted Placement Regions may be deleted from the Placement Regions view (see page 118) by right-clicking the region in the table and selecting Remove Placement Region.

Alternately, the remove_region Tcl command may be called directly.

Running the HW Demo

The HW Demo facility is primarily intended as an aide to Achronix field application engineers (FAEs) that allows them to conveniently demonstrate particular features of Achronix FPGAs. Demonstration designs built into the ACE GUI software can easily be loaded into the attached board/device and executed. As the demonstration design is executing, the status of the design can be monitored in real-time, and visually represented within the HW Demo display.

The HW Demo facility uses fully functional designs (not included within an ACE installation, but provided as directory overlays) to demonstrate the real world application of hardened IP blocks. A given design may consist of a single IP block type, but typically they combine several IP block types working in a coordinated manner. These prebuilt designs are also useful to new ACE users as a way to gain experience setting up the Bitporter and prototyping environments.

Installing HW Demo Designs

Each HW demo or reference design (including bitstreams, additional software, documentation, and source files when possible) is packaged into and delivered in a single tarball, ZIP, or Windows installer file, downloadable from the Achronix support site. A set of installation instructions is provided as a separate document (not here) as the details may vary for each design. Installation might require several steps, depending on the software tools and drivers needed.

There are expected to be two types of designs available. Reference designs are meant to be modified, while demo designs are black boxes. Reference designs typically are installed into the user home directory (to encourage editing), while demo designs may be installed into the <ace_install> directory (which often has read-only permissions to discourage accidental overwrites). Both design types use the same framework within ACE, and both are presented through the HW Demo view in the ACE GUI.

Ask your FAE for further details about acquiring and installing the HW demo and reference designs for your specific development kit.

HW Demo Installation Paths

By default, when ACE starts up, it searches for installed HW demos in the following paths:

- <userhome>/achronix/ref_designs/
- <ace_install>/ref_designs/

After downloading a design tarball or zip, the design should be unpacked into either of those directories.

Selecting The Target Device And Demo

At the top of the HW Demo view (see page 71) are controls for selecting the target device and an associated demonstration design. After selecting a target device (or the default device matches the device you are working with) the list of available designs is accessible in the Demo Design control.
Figure 161: Demo Design Control Example
Note

If no demos are installed, these controls remain disabled (which indicates the lack of installed designs).

Loading The Demo JAM File

After selecting the target device and demonstration design, the name of the *.jam file appears to the right of the Download button. Click the Download button to initiate loading of the design into the attached FPGA device. Any designs that are running when Download is clicked are terminated without warning. If there are any errors or problems during the download process, a pop up dialog will be displayed with an explanatory message. When the selected design has been loaded and started, monitoring of the attached FPGA device is initiated using the DCC connection.

![Download button](image)

Bitstream File: demo_bf1.jam Created: 2013/03/30

**Figure 162: Demonstration Design Download Example**

Displaying Board Status

After a design has been loaded and started running, ACE may monitor the status of the demonstration board LEDs and DIP switches, as well as key internal conditions such as core voltage, temperature, etc. Clicking the visualization of an LED in the HW Demo view causes the corresponding actual LED (on the demonstration board) to toggle state.

Note

The visualized DIP switches are only used for reporting the state of the corresponding actual switch on the demonstration board. The physical DIP switch cannot be set by clicking its image in ACE.
Control of Running Demonstration Design

While the Snapshot Debugger has extensive facilities for collecting data samples from a running design, it does not currently provide any direct mechanisms for controlling or interacting with a design. The HW Demo view (see page 71) may provide a simple set of on-screen controls for reading and writing register values in some demo designs. In a demo similar to the example shown below, to read a register value, enter its address and click the Read button. The current value of the specified register appears in the Data: field to the right. Likewise, to modify a register value, enter its address and new value in the provided fields, and click the Write button.

![Figure 164: HW Demo View Example](image)

Using Incremental Compilation (Partitions)

This section begins with a high-level overview, and then continues with detailed tutorials.

Overview of Incremental Compilation and Partitions

Upstream synthesis tools have the ability to break a design up into smaller logical units (see: Synplify Pro for Achronix User Guide, Chapter 11: Working with Compile Points). Within ACE these smaller logical units are called "Partitions". These partitions can each be thought of as a nearly independent block — each partition can potentially be synthesized, optimized, placed, and routed independently. Because of this independence, when only one partition changes, only that partition needs to be re-run through the flow, leading to a significant runtime savings.

Defining Partitions

It is expected that partitions are defined primarily by the upstream synthesis tool. The synthesis tool typically exports a partition definition/constraint file. For example, the file below is an example of a *.prt file exported by Synplify Pro for Achronix.

```
Example partition definition (*.prt) file

set_partition_info -name "/fpu_top" -view "fpu_top" -timestamp "1476335212" -cp_type "hard"
set_partition_info -name "/fpu_top/fpu_inst[0].i_fpu/fpu_out/fpu_out_ctl" -view "fpu_out_ctl" -timestamp "1476335212" -cp_type "locked"
set_partition_info -name "/fpu_top/fpu_inst[0].i_fpu/fpu_div/fpu_div_ctl" -view "fpu_div_ctl" -timestamp "1476335212" -cp_type "locked"
```
Enabling Incremental Compilation

Enabling incremental compilation support within ACE is quite easy, assuming the partitions are already defined through the upstream synthesis tool:

1. In the Projects view (see page 123), add the partition definition file(s) to the ACE project (see Adding Source Files (see page 275)). The new partition definition file appears in the Projects view as a Constraints file and, in the Options view (see page 106), in the Design Preparation section in the list of Constraints Files (and should already have its checkbox selected).

2. In the Options View (see page 106), within the Design Preparation section, select the checkbox labeled Enable Incremental Compile.

3. In the Projects View, save the current project (see page 272).

From this point forward, this Project/Implementation uses incremental compilation when running the flow.

Note

The presence of the partition definition constraint file in the project, plus the checked Enable Incremental Compile implementation option, are the only configuration changes that distinguish the incremental compile flow from the standard non-incremental flow.

Tracking Partition Status

ACE provides two main tools for checking the compilation state, timestamps, and other statistics of each partition.

Partitions Report

The Partitions report (see page 230), automatically generated (and opened in the GUI) during the Run Prepare flow step (see page 223), shows the current status of each of the partitions, including resource counts and re-compilation states.

Partitions View

Similar to the Partitions report, the Partitions view (see page 115) shows the status of each partition and a variety of other statistics. Additionally, the view allows for ease of visualization of the partitions and their relationships to the instances and each other.

Forcing an Unchanged Partition to Recompile

When using the Partitions view, ACE provides a mechanism to override the partition timestamp during the next pass through the flow (see page 223). The column named Force Re-compile on Next Run displays the status of this override mechanism.
To mark a partition as needing forced compilation:

1. Click the partition in the Partitions view.
2. Right-click anywhere in the partition row to open the context menu, and choose **Force Partition Changed**.

A check mark appears in the **Force Re-compile on Next Run** column of the view in the row containing the partition. The next time the flow is executed, the partition is re-placed and re-routed, even if there were no RTL changes and it was not re-compiled in the upstream synthesis tool.

To remove the mark for forced recompilation:

1. Click the partition in the Partitions View.
2. Right-click anywhere in the partition row to open the context menu, and choose **Un-Force Partition Changed**.

The check mark disappears in the **Force Re-compile on Next Run** column of the view in the row containing the partition. The next time the Flow is executed, the partition is only re-placed and re-routed if the partition was re-compiled in the upstream synthesis tool.

**Note**

The ACE forced recompilation flag is a one-time trigger. When compilation is completed, any force flags for that implementation are cleared.

**Tip**

**Forcing all Partitions to Re-compile**

The easiest way to force all partitions to immediately be recompiled (run through the entire flow) is:

- Enter the following Tcl command in the **Tcl Console view** (see page 144):
  
  ```
  run -ic init
  ```

- Alternately:
  1. Change to the Projects Perspective.
  2. In the **Flow view** (see page 67), enable and disable the optional **Flow steps** (see page 223) as desired.
  3. Right-click any flow step, and select the context menu item **Re-Run Flow with "-ic init"**.

See Running the Entire Flow (see page 283) for additional details.

**Viewing Instances In Partitions**

There are multiple ways to quickly see which instances belong to a given partition:

- The **Search view** (see page 132) and the `find` Tcl command can both be used to list all the instances within a partition or list of partitions, using the `@partition` filter. The **Search Filter Builder dialog** (see page 183) might ease the building of the filter for the Search view.

- Adding all the instances within a partition to the ACE Selection set (using the **Selection view** (see page 136), especially when populated with search results) is an easy way to see where members of a partition are within the **Floorplanner view** (see page 57). When the Floorplanner layer for **Selected Instance Flylines** is enabled, the connectivity of the selected partition is also visible.
• The Netlist Browser view (see page 92) is a table of the instances (and enclosing macros) making up the design, with a column indicating the partition for each instance. This table can be filtered by column values, thus the table can be filtered to include only the instances within a given partition.

• Using highlight colors assigned from any of the above views (especially using the Partitions view Auto-Highlight functionality) can make it easy to see how members of various partitions are placed in relation to each other in the Floorplanner.

The Floorplanner view also includes a new color in the Instance states (see page 245) for the new "Locked" state relating to partitions. Instances that are locked are a member of a locked partition that has remained unchanged since the prior incremental compilation. ACE does not change the site assignment for that instance during the Placement phase of place-and-route.

Related Tcl Commands
The following Tcl commands were created specifically to interact with partitions:

• `get_partition_changed` (see page 578)
• `get_partition_force_changed` (see page 578)
• `get_partition_info` (see page 578)
• `get_partition_insts` (see page 579)
• `get_partition_timestamp` (see page 579)
• `get_partition_type` (see page 580)
• `is_incremental_compile` (see page 587)
• `report_partitions` (see page 596)
• `set_partition_force_changed` (see page 620)
• `set_partition_info` (see page 620)

Additionally, the following Tcl commands were enhanced with additional options specific to incremental compilation and/or partitions:

• `run` (see page 602)
• `filter` (see page 568)
• `find` (see page 570)

Incremental Compile Tutorial

Overview
This tutorial demonstrates the process of running incremental design compile within ACE. This tutorial consists of two parts:

• Single-Process Incremental Compile Tutorial (see page 384) – covers how to process a single-pass incremental compile. This first tutorial must be run before the Multiprocess Incremental Compile tutorial

• Multiprocess Incremental Compile Tutorial (see page 424) – details how to run a set of changes in order to select an optimal implementation. This second tutorial expands upon concepts from the first and cannot be run standalone.
**Tutorial Files**

**Note**

The files needed for this tutorial are no longer available due to their use of obsolete components. Despite this fact, the procedure outlined in the tutorial remains valid and is presented here to provide a detailed overview of the incremental compile procedure.

This is an advanced tutorial. It assumes that both Synplify Pro and ACE are installed in your system search path and that you are already familiar with the use of both tools. If that is not the case, start with an introductory tutorial for those tools.

---

**Single-Process Incremental Compile Tutorial**

The goal of this tutorial is to illustrate the incremental compile flow from an initial version of RTL, through the following steps:

2. ACE place and route.
3. A modification of the original RTL.
4. Back through the flow.

The goal of the flow is to help minimize the time it takes to make incremental changes to existing RTL and get those changes through ACE with the minimum amount of time and perturbation to the existing design implementation in ACE.

*Figure 165: Incremental Compile Flow Chart*
Step 1: Obtaining the Files

The tutorial reference design ZIP file is no longer available. Please refer to the following tutorials for procedural details using your own design files.

### Directory Structure

<table>
<thead>
<tr>
<th>Directory</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;ZIP root&gt;</td>
<td>Root directory of ZIP file.</td>
</tr>
<tr>
<td>/ace</td>
<td>ACE generated project, report and log files (empty).</td>
</tr>
<tr>
<td>/constraints</td>
<td>SDC, PDC and FDC constraint files.</td>
</tr>
<tr>
<td>/rtl</td>
<td>Synplify Pro RTL project files.</td>
</tr>
<tr>
<td>/rtl_V1</td>
<td>Synplify Pro RTL project files.</td>
</tr>
<tr>
<td>/rtl_V2</td>
<td>Synplify Pro RTL project files.</td>
</tr>
<tr>
<td>/rtl_V3</td>
<td>Synplify Pro RTL project files.</td>
</tr>
<tr>
<td>/rtl_V4</td>
<td>Synplify Pro RTL project files.</td>
</tr>
<tr>
<td>/syn</td>
<td>Synplify project, log and output files (empty).</td>
</tr>
</tbody>
</table>

**Figure 166: Tutorial Directory Structure**

Step 2: Set up the Synplify Pro Project

Start the Synplify Pro GUI. For Linux:

```
% cd <your work area>/Speedcore_Incremental_Compile_RevDesign_RD012/synplify
% synplify_pro
```

For Windows, double-click the Synplify Pro Icon.

Create a new project with ( ) Open Project → New Project (or File → New Project in Windows). Windows users need to ensure that the project is saved to the chosen work area (File → Save As). To follow the directory structure used in this tutorial, use <your work area>/Speedcore_Incremental_Compile_RevDesign_RD012/synplify. The Synplify Pro home screen appears with an empty project named proj_1 and an implementation named rev_1, as in the following screen shot:
Figure 167: Synplify Pro Home Screen

Select **Project → Add Source File** to bring up the **Add Files to Project** dialog box. Click the blue (↑) button to navigate up to the parent directory. In the "Files of type:" combo-box, select **All Files (*)**. Then double-click **constraints** to navigate to that directory and click the ←**Add All** button to add all of the constraint files. Click the blue up-arrow to navigate up one level and add all of the Verilog files in the *rtl* directory; click **OK**.
All of the files just added are now listed under the proj_1 project in the Project Files tab (click + to expand each file type).

Ensure that the file fpu_top.v (the top-level module) appears last in the list of Verilog files. If it does not, correct the order by using the mouse to select the file name and drag it to the end of the list. For Windows users, the Result Base Name is set to the project name used earlier, the default being Proj_1. To have the file names match this document exactly, manually change the Project → Implementation Options → Implementation Results → Result Base Name to "open_sparc_fpu_icf_demo", and click OK.
Depending on how Synplify Pro is installed, the locations of the Achronix macro libraries may need to be specified. Open the Implementation Options window and then click the Verilog tab (Project → Implementation Options → Verilog). Ensure that \(<ACE\ install\ location>/libraries\) is present in the Include Path Order box. If not, add them by clicking the green + and navigating to the \(<ACE\ install\ location>/libraries\) directory. Click Choose, then click OK.

**Figure 169: Synplify Pro Home Screen After File Additions**
Ensure that the Verilog file `<ACE install location>/libraries/device_models/16t_synplify.v` has been added to the project. If it has not, use the Project → Add Source File dialog box again to add it. Then drag this file to the top of the Verilog files listed to ensure that it is the first one read in.

Finally, select the Achronix technology and part name. Open the Implementation Options Device tab (Project → Implementation Options → Device) and select the Technology: and Part: name.
Figure 171: Implementation Option Device Tab

Step 3: Compile the Design in Synplify Pro

Select Run → Compile Only (or click F7) to parse the Verilog and constraints files and enable viewing. If this is the first time the design was compiled and the project has not been saved yet, Synplify Pro may ask to save the project file. Click Save to continue.

In order to see the nine compile point constraints defined for this project, open the constraints file as a text file by navigating to the Project Files tab, expand the Logic Constraints (FDC) section, and left-mouse click the file, and Open as Text. All nine of them are of type locked, as in the example below:
Each compile point becomes a partition in the ACE tool. If one or more RTL source files are later edited and changed, Synplify Pro and ACE only need to recompile the partitions that have changed, rather than the whole design.
Optionally; instead of adding the `open_sparc_fpu_icf_demo.fdc` file to define the compile points, constraints can also be created or edited using the SCOPE tool. To manually add a new constraint file, click the ( ) **new constraint file** button, and then click the **Compile Points** tab. To open the existing `open_sparc_fpu_icf_demo.fdc` file in the SCOPE tool, double-click the file name in the **Project Files** tab, and then click the **Compile Points** tab. Then, to add a new Compile Point, select the first blank row in the table, double-click in the View field to bring up a drop-down list of available view names, and select the one desired. Then double-click in the Type field to set the compile-point type. ACE treats all compile points as locked for purposes of placement and routing, but soft or hard compile points can be used in synthesis if locked results in poor QoR.

![Image of Compile Points Tab](synplify-pro-scope-view.png)

**Figure 173:** Compile Points Tab Within the Synplify Pro SCOPE View
Close the SCOPE View window and do not save any changes.

**Note**

Synplify-Pro can be configured to create the compile points automatically. To experiment with this option, open the Implementation Options window, select the Options tab, and check the Auto Compile Point option. This option uses various heuristics (such as the sizes of the modules, the number of pins and the presence of timing constraints) to select a set of module views as compile points. These may be in addition to any compile points manually specified as constraints.

For this tutorial ensure that the Auto Compile Point option is un-checked, then click **OK** to close the Implementation Options window.

Lastly, click **Run** to complete the mapping of the design.


**Caution!**

Windows users may encounter an error with *m_generic.exe* while using compile points. This condition is caused by an issue with parallel synthesis jobs in the current version of Synplify Pro for Achronix. This situation is being addressed by Synopsys and is expected to be rectified in an upcoming release. If Synplify encounters this error, select **Options → Configure Compile Point Process**, change the "4" in the box to "1" as shown below.

![Configure Compile Point Process Dialog Box](image)

**Figure 174: Configure Compile Point Process Dialog Box**

**Step 4: Review Synplify Results**

This step reviews some of the files and features available to better understand the behavior of Synplify Pro with compile-point constraints.

**Synplify-Pro Log File**
Using either the Synplify Pro GUI or another text editor, open the Synplify Pro log file Speedcore_Incremental_Compile_RefDesign_RD012/synplify/rev_1/open_sparc_fpu_icf_demo.srr and search for the section titled “Summary of Compile Points”.

![Synplify-Pro Log File Showing Summary of Compile Points Section](image)

The log file `rev_1/synlog/open_sparc_fpu_icf_demo_fpga_mapper.srr` lists a summary line for each of the defined compile points. Each compile point is an instance of the modules defined in the FDC file. All of these compile points are marked as Mapped (in this case “No database” because the design is being mapped for the first time). The timestamp of the last compile for each indicate they are all mapped at about the same time. Immediately below that section is a reference to a separate .srr log file for each compile point.

**Note**

The “Summary of Compile Points” section may contain different Name entries than those that were defined in the FDC file. These can be instances of those modules.

The log file may contain the following warnings:

- N: MF104 :| Found compile point of type locked on View view:work.fpu_in_ctl(verilog)
- N: MF104 :| Found compile point of type locked on View view:work.fpu_in(verilog)
- N: MF104 :| Found compile point of type locked on View view:work.fpu_mul_ctl(verilog)
- N: MF104 :| Found compile point of type locked on View view:work.fpu_mul_exp_dp(verilog)
- N: MF104 :| Found compile point of type locked on View view:work.fpu_mul(verilog)
- N: MF104 :| Found compile point of type locked on View view:work.fpu_div_ctl(verilog)
These warnings are due to a caveat when using attributes with compile points. Attributes can be used when setting constraints for compile points. However, when using `syn_hier` on a compile point, the only valid value is `flatten`. All other values of this attribute (e.g., `hard`) are ignored for compile points. The `syn_hier` attribute behaves normally for all other module boundaries not defined as compile points.

**ACE Partitioning Constraints File**

The file `/path/to/open_sparsfpu.icf.dem_partition.prt` is written by Synplify for inclusion in the ACE project. This file contains TCL commands that define the Synplify-Pro compile points as partitions in ACE. Each command contains both the instance and view names of each partition, as well as its timestamp and compile-point type. There are many more partitions (37) listed in the `.prt` file than there were compile points listed in the Synplify log file because the partitions represent instances, while the compile points represent modules (many of the modules are instantiated multiple times in this design). The number of these instances match the number of the compile points found in the "Summary of Compile Points" section.

**Figure 176: Contents of the open_sparc_fpu_icf_demo_partition.prt File**

**Technology View**

Click the ( ) Technology View button to open the design schematic, then select one of the `fpu_inst` instances. These instances can be identified by expanding the Instances/Groups folder and then left-mouse click one to select it. The selected instance is highlighted with a red boundary in the Tech popup view.
Use the right mouse button to push into that level of the hierarchy. The schematic then updates. The locked and hard partitions have a green background color while the default instance background color is yellow. In the schematic area, use the right now to either push or pop hierarchy levels, depending on where the mouse is located when clicked.
Exit from Synplify Pro. Next, the design must be placed and routed in ACE.

**Step 5: Set up the ACE Project**

Start the ACE GUI. Under Linux, execute:

```
% cd <your work area>/Speedcore_Incremental_Compile_RefDesign_RD012/ace
% ace
```

Under Windows, double click the ACE icon.

Then create a new project with **File → Create Project**. Click **Browse** to navigate through the filesystem to ensure that the project is created under the subdirectory `Speedcore_Incremental_Compile_RefDesign_RD012/ace` and click **OK**. Use **proj_1** for the project name, and **impl_1** for the implementation name. Click **Finish**.

The ACE home screen appears with an empty project named `proj_1` and an implementation named `impl_1`, as in the following screen shot:

**Figure 179: Synplify Pro Technology View**
Figure 180: ACE Home Screen

Select **File → Add Project Source Files...**, then click `Speedcore_Incremental_Compile_RefDesign_RD012` in the pathname bar to locate the source files and open the following dialog box:
Navigate to the constraints directory, select the open_sparc_fpu_icf_demo.sdc file, and then click OK. Bring up the Add Project Source Files dialog box again, navigate to the directory synplify/rev_1/, control-click to select the files open_sparc_fpu_icf_demo.vm and open_sparc_fpu_icf_demo_partition.prt, and click OK to add them to the project.

Finally, in the Options tab under "Design Preparation", verify that the Target Device is the same device name used in Synplify, and verify that the Enable Incremental Compile implementation option checkbox is checked. All of the files just added appear under the ace/Netlists and ace/Constraints folders of the Projects tab.

Tip
In the Projects Perspective → Projects View click the triangle next to Constraints to list out the constraint files, etc.
Recall from Step 4 (see page 393) that the open_sparc_fpu_icf_demo_partition.prt file (added to the project above) contains the partition definitions exported from Synplify Pro. The presence of this constraint file and the Enable Incremental Compile implementation option are the only configuration changes that distinguish the incremental compile flow from the standard non-incremental flow.

Immediately under the Enable Incremental Compile implementation option checkbox is a drop-down box for the Incremental Compile Mode implementation option. Available values are strict and smart. Strict mode ensures that Incremental Compile placement of locked instances in unchanged partitions are completely preserved. Smart mode (the default) allows ACE to try to intelligently preserve placement in locked partitions for better design performance.

Step 6: Compile the Design in ACE

In the Flow tab, uncheck the Run Sign-off Timing Analysis and Generate Bitstream flow step checkboxes to save some runtime. Then click the green triangle ( ) in the upper-right corner of the Flow view to run the prepare, placement, and routing flow. When the ACE flow completes, a green check mark appears by the Run Final DRC Checks flow step in the Flow view.

Step 7: Review ACE Results

Next is a review of some of the features available to help in understanding and optimizing the partition constraints.
Partition Report

While the ACE flow is running, the Partition Report can be viewed at any time after the completion of the Run Prepare flow step. In the ACE GUI, the report opens automatically in the Editor Area of the Project perspective.

First look at the Summary section. The report shows the total number of partitions and the number that were recompiled (in this case 100% because this was the first pass through the flow). Also listed are the number of instances and nets that are owned by a partition, plus the number that were recompiled by ACE (again, 100% of each). Placement runtimes are proportional to the number of recompiled instances, and routing runtimes are proportional to the number of recompiled nets.

The Details section displays a table with one row for each partition. Columns are printed as follows:

- Partition Name (which are the same as the instance name in the unflattened RTL)
- Module Name (derived from the module name in the RTL)
- Re-Compiled? column ("yes" or "no")
- Timestamp (time and date when it was last compiled in Synplify Pro)
- Type (only "Hard" and "Locked" are supported by ACE)
- The number of nets and instances owned by the partition
A series of columns with instance counts for LUTs, Flops (DFFs), ALUs, LRAMs, BRAMs, etc.

The final eleven columns in the Details section provide information about the boundary nets of each partition. This information is useful in analyzing the suitability of each module for partitioning and to suggest ways in which the design may be improved to make it more amenable to partitioning. These include:

- Two columns counting the number of input nets and output nets crossing the boundary. These correspond to the ports of the original RTL module that have been flattened away. An input net has its driver outside the partition, while an output net has its driver inside the partition. The larger the ratio of boundary nets to instances in a partition, the more likely it is that the placement and routing of the partition is disturbed when neighboring partitions are recompiled (this is a corollary of Rent's Rule).
- Two columns with the number of input and output boundary nets that are registered. Registering boundary ports is always a good idea as it can be harder to maintain timing closure of cross-boundary paths when a partition or its parent needs to be recompiled.
- Two columns with the number of input and output boundary nets driven by a constant. Designers often tie-off unused inputs or outputs of a block and assume that those constants are optimized away by the logic synthesis tools. However, logic synthesis must assume that those constants may change in the future, so constant propagation cannot be performed across locked partition boundaries. Locking can result in a netlist that is much larger than expected. It is better to define a compile point on an RTL wrapper module that encloses input pin constants inside the partition and output-pin constants outside the partition. This method provides logic synthesis with the freedom to eliminate gates made redundant by the constants.
- Four columns with the number of input and output boundary nets that are floating and dangling, respectively. Floating nets have input pin loads with no driver, and dangling nets have a driver with no input pin loads. Similarly to constant boundary nets, logic synthesis is not able to optimize away floating and dangling logic across locked partition boundaries. Again, if a design has pins on a module that can logically be left unconnected, it is usually best to create a wrapper module so that unconnected inputs are enclosed within the partition and unconnected outputs are outside the partition, and then define the wrapper module as the partition instead.
- One column with the number of feedthrough nets. A feedthrough net enters an input pin of a module and exits through an output pin without driving any logic inside the partition. Again because logic synthesis cannot optimize logic across Locked partition boundaries, and it cannot eliminate pins on either Locked or Hard partition boundaries, it is best to eliminate feedthrough nets from the design. Feedthroughs impose constraints on synthesis, placement, and routing that can results in unnecessary delay and routing congestion.

**Note**

The table is sorted so that partitions with a recompiled state of "Yes" appear first, then sorted by number of instances.

**Floorplan View**

After the Routing flow step has completed, switch to the Floorplanner perspective to view the results. In the Floorplanner View (see page 57) flyout palette, under the Layers section, turn on visibility for Instances, but turn off visibility for Sites, Clock Routes, and Non-clock Routes.
Figure 184: **ACE Floorplanner Perspective After First Incremental Compile Iteration**

Switch to the **Partitions View** (see page 115) to see a table with one row for each partition name. Columns exist for the Partition Timestamp; Re-Compiled status (a check-mark or not); the number of Flops, LUTs, ALUs, BRAMs, LRAMs, and Others (IOs, sources, etc); and the number of Cumulative Flops, LUTs, ALUs, BRAMs, LRAMs, and Others. The number of instances of each type includes only those instances directly owned by the given partition. The number of cumulative instances of each type includes instances owned by the given partition, as well as all child partitions below that partition in the RTL hierarchy.

The column named Force Recompile on Next Run provides a mechanism to override the partition timestamp during the next pass through ACE. Right-click anywhere in the row for a partition and select **Force Partition Changed**. A check mark appears in the Force Recompile on Next Run column, and the partition is re-placed and re-routed the next time the flow is run during this ACE session, even if there were no RTL changes nor recompilation in Synplify-Pro. Right-click again and select **Un-Force Partition Changed** to remove the check mark, or else the checkmark is removed automatically when the flow is run later in this ACE session.
The column named Highlight Color displays a box with the partition highlight color. It should currently be empty. Right-click the row for a partition and select Highlight Partition to highlight the partition instances in the Floorplanner view with the current highlight color for the Partition tab. In the toolbar above the table, click the ( ) Choose Highlight Color tool to change the highlight color to be used in the next Highlight command. Right-click the partition row and select Un-Highlight Partition to disable highlighting of the partition instances. Alternatively, the ( ) Highlight Partition and ( ) Un-Highlight Partition tools in the toolbar can be used to highlight the currently selected partition in the table.

Finally, ensure that none of the partitions are highlighted, and click the ( ) Auto-Highlight Partitions tool in the toolbar to highlight all of the partitions with an automatically selected color.

Figure 185: Highlighting Partitions in ACE After First Incremental Compile Iteration
The ( ) auto-highlight feature is an extremely powerful tool in understanding the logical and physical connectivity relationships between partitions. Generally, instances in a partition are placed in close proximity to each other if the connectivity within the partition is stronger than the connectivity outside (i.e., Rent's Rule: the number of ports on the partition being much smaller than the number of instances). The instances in one partition are generally placed close to the instances of other partitions with strong connectivity between them, and farther away from other partitions with weak connectivity. Specifically, if a partition has instances scattered over a wide area, it means that the instances are more strongly connected to other partitions than they are to each other. It may be better to remove that partition from the partition constraints. Placement and routing QoR may improve if that partition is recompiled every time the RTL is recompiled, allowing those instances to adapt to changes in their neighbors. This behavior may even be a sign that the RTL should be re-architected to absorb those glue logic instances into the top-level block or their neighboring instances.

Tools also exist in the toolbar to zoom (see Zooming the Floorplanner In and Out (see page 320)) to the instances of the selected partition, search for the instances of the selected partition (this generates the appropriate Tcl find (see page 570) command to populate the Search View (see page 132)), and add the instances of the selected partition to the selection set (done with the Tcl select (see page 617) command, with results displayed in the Selection View (see page 136)).

The partition table includes filtering functionality, which can be used to control visibility of the partition rows. To enable filtering, click the ( ) button. The filter row allows a content-appropriate filter to be applied to one or more table columns. Numeric columns filter based upon number ranges, while name columns filter based upon string matching or even regular expressions. For example, clicking the ( ) filter icon above the LUTs column allows viewing only partitions with, for example, greater than 3,000 LUTs. This filter functionality is most useful when there are a large number of partitions.

Tip

After using the ( ) Placement Region Tool in the Floorplanner view to create a new placement region, if using partitions, drag-and-drop a row from the Partitions view onto the newly created placement region (either the appropriate row of the table in the Placement Regions View (see page 118), or directly into the placement region painted in the Floorplanner view). This action generates the correct add_region_find_insts (see page 553) command to add all instances in the dragged partition to the designated placement region.

Netlist Browser

The Netlist Browser View (see page 92) also contains several features dedicated to the Incremental Compile Flow. There is a column (Partition) naming which partition owns all instances represented by that row in the table. No partition name is given if the instances are not owned by a partition, or if they are split between two or more partitions. When a partition is highlighted in the Partitions view, that highlight color is also present in the Highlight Color column of the Netlist Browser in all rows owned by the given partition.
Figure 186: ACE Netlist Browser
End of the First Pass of ACE Place and Route

At this point, exit out of ACE if desired.

Note

ACE can stay in memory and "incremental" runs can be implemented in the same ACE session because ACE recognizes that inputs to the ACE flows have changed, and runs incremental flows appropriately.

Step 8: Change the RTL (rtl_V1)

It is at this point where the utility of the Incremental Compile Flow begins to become apparent. The next steps simulate the actions of a product development team in the middle of a design iteration by modifying the RTL for one of the partitions, and then rerunning Synthesis, Prepare, Placement, and Routing (SPP&R).

First, navigate to the top-level directory of the tutorial project and start Synplify-Pro if it is no longer running. Under Linux, execute:

```
% cd <your work area>/ Speedcore_Incremental.Compile_Reference_Design_RD012
% synplify_pro
```

Under Windows, double-click the Synplify Pro icon.

This step simulates an RTL change by replacing the source file rtl/fpu_mul_ctl.v with the version in the directory rtl_V1. To do this in Synplify Pro, in the Project Files tab, navigate to the Verilog folder and left click the file to be changed to select it by clicking its name, in this case fpu_mul_ctl.v, and then right-click to bring up popup menu followed by Change File... or select Project → Change File. In the dialog box that appears, use the drop-down box of the Look in field and navigate from the directory rtl to the directory rtl_V1. Then double-click the file fpu_mul_ctl.v, or select it and click OK. The old version of the file is then removed from the project and replaced by the modified version. Diff the old and new versions of the file to see the changes:

```
$ diff rtl_V1/fpu_mul_ctl.v rtl
```

Note

A flop has been added to the 5-bit wire mul_exc_out.

Step 9: Recompile the Design in Synplify Pro (rtl_V1)

Click Run on the Synplify Pro home screen to recompile and remap the design.

Note

Runtime is much faster than in the first iteration because only the changed module needs to be recompiled.
Step 10: Review Synplify Results (rtl_V1)

**Synplify Pro Log File (rtl_V1)**

Once again, open the Synplify Pro log file `Speedcore_Incremental.CompileReference.Design_RD012/synplify/rev_1/open_sparc_fpu_icf_demo.srr` and search for the section titled “Summary of Compile Points”. All of the partitions have a status of "unchanged" except for the partition `fpu_mul_ctl` and its parent partition, which have status "remapped" and a reason of "design changed". The timestamp of the remapped partitions have also been advanced.

![Synplify Pro Log File Showing Changed Compile Points](image)

**Figure 187: Synplify Pro Log File Showing Changed Compile Points**

**ACE Partitioning Constraints File (rtl_V1)**
Also re-open file Speedcore_Incremental_Compile_RefDesign_RD012/synplify/rev_1/open_sparc_fpu_icf_demo_partition.prt and observe that the same changes are also reflected in the constraints file written out for ACE. Again, the timestamp has advanced when compared with the unmodified partitions.

Figure 188: ACE Partitioning Constraints File: open_sparc_fpu_icf_demo_partition.prt

Use File → Close to close Synplify Pro, and click Save changes to project proj_1.

Step 11: Recompile the Design in ACE (rtl_V1)

If ACE was exited earlier, navigate to the same ace directory as before, and start ACE again. Otherwise, continue on from the current ACE session.

Ensure that this tutorial project is the active project. Again, uncheck the Run Sign-off Timing Analysis and Generate Bitstream flow steps to save some runtime.

Click the green triangle ( ) in the upper-right corner of the Flow view to rerun the Prepare, Placement, and Routing flow.

Note

The runtime of the flow is also significantly reduced over the first non-incremental compile.
In this second pass, ACE reads the new `open_sparc_fpu_icf_demo.vm` netlist file and the new `open_sparc_fpu_icf_demo_partition.prt` constraints file from the synplify directory. During the run_prepare flow step, ACE then executes an operation called Tear & Stitch. Each partition which has not been recompiled during synthesis is torn out of the database, and a copy from the previous pass is stitched back in. The copy from the previous run contains the complete set of placement and routing data. The placement of all stitched instances are locked, and all routes are marked as preroutes to prevent their modification when the remainder of the netlist is placed and routed.

**Step 12: Review ACE Results (rtl_V1)**

**Partition Report (rtl_V1)**

Maximize the Partition Report tab in the Editor Area of the Projects perspective. In the summary section, only 4 of the 37 partitions (10.81%) were recompiled by ACE, resulting in 3.05% of the instances being re-placed and 3.33% of the nets being rerouted. Also note in the Details section that only 4 `fpu_mul_ctl` partitions were recompiled, and their new timestamps are displayed. The counts of instances and nets in those partitions have changed by a small amount.
Switch to the Floorplanner perspective. In the Floorplanner view, compared to figure above (see page 403) from the first iteration, about 3% fewer instances are now drawn with a locked fill color (dark yellow by default).

The locked placement state is just one of several potential placement states (see Instance States (see page 245)) that an instance can have when painted in the Floorplanner. This locked placement state is somewhat similar in concept to the fixed placement state. (Instances with fixed placement status, shown in the Floorplanner with a light yellow fill color by default, are instances with user-assigned placement constraints, usually defined in a .pdc file. These fixed instances are not allowed to be moved from their constrained placements during the flow.) The locked placement state indicates instances that are locked in place because they are in a partition that was not recompiled. Only instances with the default (or soft) placement state (light-grey fill color by default) were allowed to have their placement changed during the flow.

The visibility of the instance locked placement state and the associated locked fill color can be chosen within the ACE GUI preferences. To see/edit these, select Window → Preferences → Floorplanner View Colors. In particular, ensure the Instances → Show Locked Color on Instances with Locked Placement box is checked, and that the Locked Instances View Color is set to the desired color (dark yellow by default).
To get a feel for the amount of re-routing that was required, select (add to the ACE Selection Set) the instances in the partitions that were recompiled and then view the flylines representing the nets for those instances. To do this, check the Selected Instance Flylines box in the Floorplanner view fly-out palette. Then in the Partitions view, choose the rows for the partitions that were recompiled, and click ( ) Add Instances to Selection in the Partitions View toolbar. Blue flylines are drawn for the nets of the selected instances (or rather for the first 200 selected instances, since the selection set contains more than 200 objects). In the Selection View (see page 136) click the gold left-arrow ( ) and right-arrow ( ) buttons in the view header to cycle visibility between different subsets of 200 of the selection set instances at a time.

There are many more than 200 nets that are actually re-routed. However, by using the selection set to filter the visible connectivity in this manner, the amount of visible change to the design has been minimized to just the instances of the module that was changed.
This information is helpful in understanding the effect of any placement and routing changes during the second pass. Instances in a failing critical path with wayward placement could indicate that changes in the RTL were too extensive for effective incremental recompilation. This situation can occur when one of the partitions grows significantly in size and no longer fits in the area between locked neighboring partitions, for example. The placement for this recompiled partition may be squeezed into an undesirable aspect ratio, forcing long routing detours. In situations such as this, it may be best to force the entire design to be recompiled by enabling **Force Recompile on Next Run** for all of the partitions in the Partitions View.

![Figure 191: ACE Floorplanner Perspective with Selected Instance Flylines (rtl_V1)](image)

**Partitions View (rtl_V1)**

In the Partitions View (see page 115) of the Floorplanner Perspective, note that only 4 of the 37 partitions have a check mark in the Re-Compiled column.
Click ( ) **Deselect all** in the Selection view to remove the routing flylines, and then click ( ) **Auto-Highlight** **Partitions** in the Partitions View to observe any changes in the placement of the changed partitions. Unchanged partitions can also be manually unhighlighted to only see (highlight) those that were not re-placed. This technique can help in understanding the effectiveness of incremental compilation on the design.

**Figure 192: Highlighting Partitions in ACE After Second Incremental Compile Iteration**

**Step 13: Additional Incremental Iterations**

Steps 8–12 can be rerun with additional RTL changes if desired. This tutorial design contains additional directories with additional RTL change examples. Or modify the existing RTL files by adding or deleting module pins, add or remove partitions from the .fdc file, or rename module instances, to further explore the incremental compile flow.
### Table 147: Additional Tutorial Examples

<table>
<thead>
<tr>
<th>Directory</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>rtl_V1</td>
<td>Flopped the signal mul_exc_out in fpu_mul_ctl.v</td>
</tr>
<tr>
<td>rtl_V2</td>
<td>Reverts the changes from rtl_V1, adds a new 6-bit counter in place of a constant</td>
</tr>
<tr>
<td>rtl_V3</td>
<td>Modifies the partition fpu_div_ctl by adding an enable check</td>
</tr>
<tr>
<td>rtl_V4</td>
<td>Modifies the top-level partition fpu.v by inverting one net</td>
</tr>
</tbody>
</table>

### Step 14: Review ACE Results (rtl_V2)

After rerunning the synplify_pro and ace flows, review the perturbation of the design in ace by looking at the Partition Report and the Floorplanner views with and without flylines.

#### Partition Report (rtl_V2)

Maximize the Partition Report tab in the Editor Area of the Projects perspective. In the summary section, only 4 of the 37 partitions (10.81%) were recompiled by ACE, resulting in 3.12% of the instances being re-placed and 3.54% of the nets being rerouted. Also note in the Details section that only 4 fpu_mul_ctl partitions were recompiled, and their new timestamps are displayed. The counts of instances and nets in those partitions have changed by a small amount.
**Figure 193: ACE Partition Report After the rtl_V2 Incremental Compile Iteration**
Floorplanner View (rtl_V2)

Figure 194: ACE Floorplanner Perspective After rtl_V2 Incremental Compile Iteration
Figure 195: ACE Floorplanner Perspective with Selected Instance Flylines (rtl_V2)

Step 15: Review ACE Results (rtl_V3)

After rerunning the synplify_pro and ace flows, review the perturbation of the design in ace by looking at the Partition Report and the Floorplanner views with and without flylines.
Partition Report (rtl_V3)

Figure 196: ACE Partition Report After the rtl_V3 Incremental Compile Iteration
Floorplanner View (rtl_V3)

Figure 197: ACE Floorplanner Perspective After rtl_V3 Incremental Compile Iteration
Step 16: Review ACE Results (rtl_V4)

After rerunning the synplify_pro and ACE flows, review the perturbation of the design in ACE by looking at the Partition Report and the Floorplanner views with and without flylines.
## Partition Report (rtl_V4)

### Details

<table>
<thead>
<tr>
<th>Partition Name</th>
<th>Module Name</th>
<th>Re-Compiled?</th>
<th>Imported?</th>
<th>Last?</th>
<th>Timestamp</th>
<th>Type</th>
<th>Nts</th>
<th>Intris</th>
<th>LUT6</th>
<th>Flipflop</th>
<th>M16K</th>
<th>M60K</th>
<th>J16K</th>
<th>L40K</th>
<th>DRAM</th>
<th>DSP2</th>
<th>ROM</th>
<th>CLK</th>
<th>CLX</th>
<th>RegFlags</th>
<th>Boundary Input Nets</th>
<th>Boundary Output Nets</th>
<th>Registered Input Nets</th>
<th>Registered Output Nets</th>
<th>Complex Flags</th>
<th>Complex Inputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>foo_k2_top</td>
<td>foo_k2_top</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Thu 21 Dec 2017 15:00:00</td>
<td>Locked</td>
<td>82</td>
<td>48</td>
<td>28</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3445</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>foo_k2_top</td>
<td>foo_k2_top</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Thu 21 Dec 2017 15:00:00</td>
<td>Locked</td>
<td>82</td>
<td>48</td>
<td>28</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3445</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>foo_k2_top</td>
<td>foo_k2_top</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Thu 21 Dec 2017 15:00:00</td>
<td>Locked</td>
<td>82</td>
<td>48</td>
<td>28</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3445</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>foo_k2_top</td>
<td>foo_k2_top</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Thu 21 Dec 2017 15:00:00</td>
<td>Locked</td>
<td>82</td>
<td>48</td>
<td>28</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3445</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>foo_k2_top</td>
<td>foo_k2_top</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Thu 21 Dec 2017 15:00:00</td>
<td>Locked</td>
<td>82</td>
<td>48</td>
<td>28</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3445</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>foo_k2_top</td>
<td>foo_k2_top</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Thu 21 Dec 2017 15:00:00</td>
<td>Locked</td>
<td>82</td>
<td>48</td>
<td>28</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3445</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>foo_k2_top</td>
<td>foo_k2_top</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Thu 21 Dec 2017 15:00:00</td>
<td>Locked</td>
<td>82</td>
<td>48</td>
<td>28</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3445</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>foo_k2_top</td>
<td>foo_k2_top</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Thu 21 Dec 2017 15:00:00</td>
<td>Locked</td>
<td>82</td>
<td>48</td>
<td>28</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3445</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>foo_k2_top</td>
<td>foo_k2_top</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Thu 21 Dec 2017 15:00:00</td>
<td>Locked</td>
<td>82</td>
<td>48</td>
<td>28</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3445</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>foo_k2_top</td>
<td>foo_k2_top</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Thu 21 Dec 2017 15:00:00</td>
<td>Locked</td>
<td>82</td>
<td>48</td>
<td>28</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3445</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>foo_k2_top</td>
<td>foo_k2_top</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Thu 21 Dec 2017 15:00:00</td>
<td>Locked</td>
<td>82</td>
<td>48</td>
<td>28</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3445</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Figure 199: ACE Partition Report After rtl_V4 Incremental Compile Iteration
Floorplanner View (rtl_V4)

Figure 200: ACE Floorplanner Perspective After rtl_V4 Incremental Compile Iteration
Figure 201: ACE Floorplanner Perspective with Selected Instance Flylines (rtl_V4)

Note

For details how to run a set of changes in order to select an optimal implementation, continue on the Multiprocess Incremental Compile Tutorial (see page 424). This second tutorial expands upon concepts from this tutorial.

Multiprocess Incremental Compile Tutorial

Using the incremental compile flow with the multiprocess GUI can be a powerful combination to help with timing closure. The Multiprocess GUI is used to try multiple experiments with different implementation options and/or sets of design constraints. The best implementation can then be selected to be the source for unchanged partitions in a subsequent incremental run. Across all implementations, the locked placement and routing data for all unchanged partitions is then merged from that best implementation. This merging is accomplished by copying the best_impl/output/<design>.icdb file from the best implementation to all other implementations before starting the next incremental iteration. All file copying is handled automatically by the multiprocess GUI. If you have not yet completed the Single-Process Incremental Compile Tutorial (see page 384), please complete Steps 1 through 5 of that tutorial now before proceeding.

Below are the step-by-step actions of using the multiprocess GUI inside the incremental compile flow.
**Step 1: Compile the Design in Synplify Pro or Clear the ACE Project**

If you have previously completed the Single-Process Incremental Compile Tutorial (see page 384), clear the ACE project and begin again from the beginning. Clear the project by deleting all of the files and subdirectories under the Ace directory of the tutorial work area. Otherwise, the first time ACE is run, it performs an incremental compile and the results do not match those described below.

**Step 2: Create Multiprocess Implementations and Run ACE**

From the ACE Home Screen, Use Window → Show View → Multiprocess to open the multiprocess GUI. Then select the Generate Implementations from Option Sets radio button. This action generates a large set of implementations automatically using a number of predefined implementation option variables. Optionally, set the “Parallel Job Count” option and configure the job submission system in the Ace preferences. Next click the RUN button (three stacked green triangles) to start running all implementations in parallel in the background. See the following screenshot of the Multiprocess View menus.

![Multiprocess View Menus](image)

**Figure 202: Multiprocess View Menus**

As in the single-process incremental compile flow, during the first pass through ACE, all implementations have their partitions compiled from scratch, as seen in the following screenshot of the partition report from one of the completed implementations.
Step 3: Select the Implementation with Best Performance

After all of the parallel runs have completed, select the implementation with the best performance on the most timing-critical clock domain. A summary of the frequency, setup slack, and hold slack for each implementation is provided in the Multiprocess Summary Report (see the following screenshot).

|---------|----------------|-------------|------------|---------------------|---------|--------|---------------|---------------|---------------|----------------|------------|-------------------|-------------|
### Timing Results Summary

This section shows the high-level timing results obtained from the timing reports that were generated during this multi-process run. For further timing details, see the linked individual timing reports (in each implementation's own reports directory).

#### Timing Analysis Summary

<table>
<thead>
<tr>
<th>Impl Name</th>
<th>Clock Domain</th>
<th>Target Frequency</th>
<th>Post-Route</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Upper Limit Frequency</td>
<td>Setup Slack</td>
</tr>
<tr>
<td>good</td>
<td>gdk</td>
<td>125.0 MHz</td>
<td>145.9 MHz (+16.7%)</td>
<td>+1.14 ns</td>
</tr>
<tr>
<td>all opt</td>
<td>gdk</td>
<td>125.0 MHz</td>
<td>150.0 MHz (+20.0%)</td>
<td>+1.393 ns</td>
</tr>
<tr>
<td>all opt</td>
<td>gdk</td>
<td>125.0 MHz</td>
<td>145.5 MHz (+18.8%)</td>
<td>+1.267 ns</td>
</tr>
<tr>
<td>all opt</td>
<td>gdk</td>
<td>125.0 MHz</td>
<td>151.1 MHz (+24.1%)</td>
<td>+1.553 ns</td>
</tr>
<tr>
<td>all opt</td>
<td>gdk</td>
<td>125.0 MHz</td>
<td>144.2 MHz (+16.8%)</td>
<td>+1.252 ns</td>
</tr>
<tr>
<td>fan500 seed util</td>
<td>gdk</td>
<td>125.0 MHz</td>
<td>152.1 MHz (+21.7%)</td>
<td>+1.424 ns</td>
</tr>
<tr>
<td>fan500 seed util</td>
<td>gdk</td>
<td>125.0 MHz</td>
<td>153.5 MHz (+22.9%)</td>
<td>+1.496 ns</td>
</tr>
<tr>
<td>fan500 seed util</td>
<td>gdk</td>
<td>125.0 MHz</td>
<td>154.4 MHz (+23.3%)</td>
<td>+1.524 ns</td>
</tr>
<tr>
<td>fan500 seed util</td>
<td>gdk</td>
<td>125.0 MHz</td>
<td>154.5 MHz (+23.4%)</td>
<td>+1.527 ns</td>
</tr>
<tr>
<td>fan500 seed util</td>
<td>gdk</td>
<td>125.0 MHz</td>
<td>151.1 MHz (+20.0%)</td>
<td>+1.382 ns</td>
</tr>
<tr>
<td>fan500 seed util</td>
<td>gdk</td>
<td>125.0 MHz</td>
<td>148.5 MHz (+18.0%)</td>
<td>+1.296 ns</td>
</tr>
<tr>
<td>fan500 seed util</td>
<td>gdk</td>
<td>125.0 MHz</td>
<td>151.1 MHz (+20.0%)</td>
<td>+1.383 ns</td>
</tr>
<tr>
<td>fan500 seed util</td>
<td>gdk</td>
<td>125.0 MHz</td>
<td>143.5 MHz (+14.5%)</td>
<td>+1.031 ns</td>
</tr>
<tr>
<td>fan500 seed util</td>
<td>gdk</td>
<td>125.0 MHz</td>
<td>125.5 MHz (-34.0%)</td>
<td>-4.122 ns</td>
</tr>
<tr>
<td>fan500 seed util</td>
<td>gdk</td>
<td>125.0 MHz</td>
<td>144.9 MHz (+15.9%)</td>
<td>+1.098 ns</td>
</tr>
<tr>
<td>fan500 seed util</td>
<td>gdk</td>
<td>125.0 MHz</td>
<td>149.7 MHz (+19.7%)</td>
<td>+1.326 ns</td>
</tr>
</tbody>
</table>

Figure 204: Multiprocess Summary Report from the First Incremental Run
The following screenshot shows the critical path in the best implementation of the run, `impl_1_acx_cls_pro_seed` (actual results may differ).

![Critical Path Diagram](image)

**Figure 205: Critical Path (green) in the Best Multiprocess Implementation**

Return to the Multiprocess View and check the Copy Incremental Flow DB from Template Impl checkbox. Optionally, change the radio button to Existing Implementations if desired (though this is not necessary). See the following screenshot.
The Template implementation referred to in the checkbox is the implementation to be used as the source for all unchanged partitions in the next incremental compile. The Template implementation is the same as the Active implementation. From the Projects View of the Projects Perspective, click the triangle to the left of the Project name to expand the list of implementations. Then left-click on the desired implementation (the one with the best performance) to make it the Active implementation. The implementation name of the active implementation turns bold and is highlighted as in the following screenshot.
Step 4: Change the RTL and Recompile the Design in Synplify Pro

Repeat Steps 8-10 of the Single-Process Incremental Compile Tutorial (see page 384) to modify the RTL and force Synplify Pro to recompile the partitions in at least one of the defined compile points.

Step 5: Recompile the Multiprocess Implementations in ACE

Click the three stacked green triangle icon in the Multiprocess view to start a new incremental compile iteration on all implementations in parallel. ACE automatically copies the output/<design>.icdb file from the Template implementation into all other implementations and uses that as the source for the tear-and-stitch operation on all unchanged partitions during the run_prepare flow step.

As seen in the following screenshot from the impl_1_acx_mux_utl_seed implementation, only 8 of the 37 partitions have been recompiled in this iteration.
Figure 208: Partition Report from Second Incremental Multiprocess Compile

After all of the parallel runs complete, return to the updated Multiprocess Summary Report in the Multiprocess View to examine the critical path reports for each implementation.

As seen in the example below, the impl_1_acx_clk_pro_seed implementation achieved 155.1 MHz in the first iteration and 148.2 MHz in the second iteration. One of the incremental compiles, for impl_acx_fan_pro_seed, failed to route and returned a Flow Error.
Finally, select **File→Restore Implementation** to restore the routed.acxdb database for the Template implementation, and select **Actions→Timing→Run Post-Route Timing Analysis** to observe the new critical path. The following screenshot shows the critical path in the Template implementation after recompiling all of the changed partitions. As usual, the instances of all unchanged partitions are highlighted in a dark yellow color to indicate that they are locked.
Figure 210: Critical Path (Green) from the Best Multiprocess Implementation of the Second Incremental Run

All timing paths inside the unchanged partitions can be observed to remain the same. Once timing closure of a critical block in at least one of the multiprocess implementations is achieved, this flow allows timing closure to be maintained until that block must be recompiled.
Automatic Flop Pushing into I/O Pads

The term “flop pushing” refers to the process of converting an unregistered pad and one or more attached DFFs into a registered pad for Speedcore devices. ACE performs this operation in the reconditioner during the run_prepare step. The purpose of this operation is to help with chip I/O timing closure. By avoiding the pad-to-flop, or flop-to-pad, delays, extra margin is achieved for off-chip timing paths.

Background

The flop-pushing feature is necessary in ACE because Synplify does not support inferencing of registered pads. The following Verilog source code describes a simple design consisting of black-box I/O pads, IPIN and OPIN instances, and two flip-flops. All three levels of a typical eFPGA design hierarchy are shown.
module DTM_TEST (in, clk, rst, ce, out)
    input in, rst, ce, clk;
    output out;

    wire in_d, rst_d, ce_d, clk_d, out_d;

    BB_PAD_IN ipad_in  (.padin(in),   .dout(in_d) );
    BB_PAD_IN ipad_rst (.padin(rst),  .dout(rst_d));
    BB_PAD_IN ipad_ce  (.padin(ce),   .dout(ce_d) );
    BB_PAD_CLK ipad_clk (.padin(clk),  .dout(clk_d));
    BB_PAD_OUT opad_out (.padout(out), .din(out_d) );

    STM_TEST stm_test (.in(in_d), .rst(rst_d), .ce(ce_d), .clk(clk_d), .out(out_d));
endmodule

module STM_TEST (in, rst, ce, clk, out)
    input in, rst, ce, clk;
    output out;

    IPIN     ipin_in  (.din(in),  .dout(in_p) );
    IPIN     ipin_rst (.din(rst), .dout(rst_p));
    IPIN     ipin_ce  (.din(ce),  .dout(ce_p) );
    CLK_IPIN ipin_clk (.din(clk), .dout(clk_p));
    OPIN     opin_out (.din(out), .dout(out_p));

    UCM_TEST ucm_test (.in(in_p), .rst(rst_p), .ce(ce_p), .clk(clk_p), .out(out_p));
endmodule

module UCM_TEST (in, rst, ce, clk, out)
    input in, rst, ce, clk;
    output out;
    reg out;

    wire dff_q;

    ACX_DFFER dff (.d(in), .clk(clk), .ce(ce), .rn(rst), .q(dff_q));

    always @(posedge clk or negedge rst)
    begin
        if (!rst)
            out <= 0;
        else
            if (ce) out <= dff_q;
    end
endmodule

Since the DIFFER instance is driven directly by an input port, and the behavioral flip-flop directly drives an output port, one might expect RTL synthesis to generate registered input and output pads (with reset and enable). However, Synplify Pro generates an input pad, an output pad, and separate DIFFER instances.

By placing the flops in the device core as separate instances, extra delay from the pad to the flop is required by the ring-to-core routing path. If the device I/O timing is tight, that could result in a setup timing failure. On the other hand, the presence of separate DIFFER instances allows the flops to be placed in the core near their fanin/fanout logic, possibly reducing the routing delay to intermediate logic in the design. Flop pushing can therefore be viewed as a form of retiming, allowing the designer the ability to trade off-chip for on-chip delays between the pad and the flop.
Capabilities

In ACE, flop pushing is performed by the reconditioner during the run_prepare flow step. Flop pushing happens very early in the flow, after flattening but before I/O elaboration so that the reconditioner can operate directly on the IPAD and OPAD instances before they are elaborated into networks of separate io_buffers and datapath instances in the traditional Speedster FPGA flow. After elaboration, ACE would require detailed knowledge of the IPAD and OPAD implementations to convert an unregistered pad into a registered pad. For a Speedcore eFPGA instance, there are no PAD instances. Instead, there are IPIN and OPIN instances. Flop pushing in ACE operates on Speedcore IPIN and OPIN instances in the same way it operates on IPAD and OPAD instances in a traditional Speedster FPGA.

In the simplest case, ACE performs flop pushing by:

1. Finding an IPIN that drives a DFF, or a DFF that drives an OPIN
2. Deleting the DFF
3. Converting the IPIN/OPIN into a flopped IPIN/OPIN (by setting the "mode" parameter), connecting the DFF clock input to the IPIN/OPIN clock input, and optionally connecting the DFF reset and enable inputs to the IPIN/OPIN reset and enable inputs.

Flop pushing is supported for flops connected to IPIN data output pins, and OPIN data input pins. ACE also supports more complex cases:

- IPINs that drive more than one DFF
- Chains of buffer LUTs and inverter LUTs between the pad and the DFF
- OPINs in which the data input and the clock-enable input are both driven by DFFs

The reconditioner checks for many possible scenarios that prevent flops pushing, especially in the above complex cases. A partial list includes:

- The IPIN or OPIN is already registered
- DFFs in the IPIN fanout do not all share the same clock input nets
- DFFs in the IPIN fanout do not all share the same set, reset, or enable input nets
- DFFs in the IPIN fanout are a mixture of DFF, DFFC, DFFP, DFFR, and/or DFFS instances
- DFFs in the IPIN fanout have a mixture of synchronous and asynchronous resets
- DFFs in the IPIN fanout are a mixture of positive/negative edge triggered
- DFFs in the IPIN fanout have different init parameter values
- A DFF in the IPIN fanout is driven by more than one input pad, or drives more than one output pad
- A DFF clock is driven by a generated clock or reset that can only be routed in the core
- LUTs between the IPIN/OPIN and DFF are configured as anything but a buffer or inverter
- Nets on the path between the IPIN/OPIN and DFF (including intermediate buffers or inverters) have a fanout greater than one
- DFFs driven by a IPIN/OPIN through a chain of buffers and/or inverters that have different inversion (odd vs. even number of inverters)

ACE Attributes

The behavior of ACE with respect to flop pushing can be controlled for individual input/output pads by attributes in the RTL or PDC constraints.

Depending on the value of the push_flops_into_pads implementation option (see Implementation Options (see page 441)), ACE looks for an attribute named syn_useioff with the following semantics:
• If the `syn_useioff` attribute associated with an I/O pin has a non-zero value, ACE pushes flip-flops into that pin when possible. This behavior is useful when the `push_flops_into_pads` implementation option has the value 1 (manual mode).

• If the `syn_useioff` attribute associated with an I/O pin has the value 0, ACE prevents flip-flops from being automatically pushed into that pin. This behavior is useful when the `push_flops_into_pads` implementation option has a value of 15 (automatic mode).

The `syn_useioff` attribute can be placed in several different locations in your RTL code, as described and shown in the following.

**Figure 211: Valid Locations to Place the syn_useioff Attribute in an eFPGA Design Hierarchy**

- On an STM port (A) connected to an IPIN/OPIN (but only if the STM is targeted as the top-level module in ACE)
- On the net (B) connecting an IPIN/OPIN to an STM port
- On an IPIN/OPIN instance (C)
- On a net (D) connecting an IPIN/OPIN to a UCM port
- On a net (E) connecting a UCM port to one or more flip-flop instances
- On the flip-flop instances (F) driven by an IPIN instances or driving an OPIN instance

If there is more than one flip-flop driven by the same IPIN, all DFF instances must have a `syn_useioff` attribute with the same value. Specifically, the `syn_useioff` cannot be placed in the following locations:

- On a DTM port (1) connected to a black-box instance or directly driving the STM port because ACE does not trace through the DTM black-box network searching for the `syn_useioff` attributes
- On a black-box instance (2)
- On the net (3) connecting an STM pin to the black-box network in the DTM
- On the UCM port (4) separating the STM and the UCM hierarchies because Synplify does forward annotate attributes on intermediate output ports, but when placed on intermediate input ports they are lost during flattening, so this method is not recommended
Placing the `syn_useioff` attribute directly on the top-level module ports (A) is useful in Speedster designs, where the top-level ports directly connect to the I/O pads. That technique can also be used for Speedcore eFPGA designs when the STM level of hierarchy is targeted as the top-level module in ACE and can be user modified. For Speedcore designs in which the STM level of hierarchy is fixed by the ASIC integrator, and only the UCM hierarchy can be user modified, the most convenient locations to place the `syn_useioff` attribute may be the UCM port-to-core nets (E) or the DFF instances (F).

Be careful not to add the `syn_useioff` attributes in more than one location. A conflict occurs when some attributes associated with particular I/O pad or pin have the value "1", and some have the value "0". When a conflict is detected, ACE issues a warning message, the value "0" is assumed, and flop pushing is disabled for that I/O. Be especially careful to avoid conflicts when the attributes are placed on DFF instances, and an IPIN drives more than one DFF.

The `syn_useioff` attributes can be specified by the user in the Verilog/VHDL source code, or in the physical design constraints (.pdc) file, as follows. An advantage of specifying the attribute in the .pdc file is that it is not necessary to re-synthesize the design in order to experiment with different flop-pushing strategies. An advantage of specifying the attribute in the HDL source code is that the intent of the designer is more self-documenting, as readers do not have to refer to a separate .pdc file and cross-reference the port/net-instance names between the files.

Examples

Several examples follow demonstrating how to set the `syn_useioff` attribute on:

- top-level ports
- I/O pin instances
- boundary wires
- DFF instances

also demonstrated is whether to use either Verilog, VHDL, or a PDC constraint. For more information about the use of attributes in Synplify see the section "Forward Annotation of RTL Attributes to Netlist" in the Synthesis Optimization Recommendations chapter of the Synthesis User Guide (UG018).

**Verilog Example of a Port attribute**

```verilog
module flop_push_test1 (ina, inb, sel, clk, z0);
  input [3:0] ina /* synthesis syn_useioff=1 */;
  input [3:0] inb /* synthesis syn_useioff=0 */;
  input sel       /* synthesis syn_useioff=1 */;
  input clk;
  output z0       /* synthesis syn_useioff=1 */;
endmodule
```

**VHDL Example of a Port Attribute**

```vhdl
entity flop_push_test1 is
port(
  ina : in signed( 3 downto 0 );
  inb : in signed( 3 downto 0 );
  sel : in std_logic;
  clk : in std_logic;
  z0  : out std_logic
);

attribute syn_useioff : boolean;
attribute syn_useioff of ina : signal is TRUE;
attribute syn_useioff of inb : signal is FALSE;
```
attribute syn_useioff of sel : signal is TRUE;
attribute syn_useioff of z0 : signal is TRUE;
end entity;

Physical Design Constraints (.pdc) File of Port Attributes

set_property syn_useioff "1" [find -ports {ina\[*\]}]
set_property syn_useioff "0" [find -ports {inb\[*\]}]
set_property syn_useioff "1" {p:sel p:z0}

Note
In the above three examples, the input PortBus ina, the input port sel, and the output port z0 are selected for flop pushing. The input PortBus inb, the input port clk, are not.

If the attribute has the value "1", ACE tries to push a flip-flop into the pad connected to the given port even when flop pushing is disabled by default. If the attribute has the value "0", ACE prevents flop pushing on that pad, even if flop pushing is enabled by default. Of course flop pushing may be prevented by any of the exceptions listed above (see page 436).

It is not possible, using RTL attributes, to apply different values of the syn_useioff attribute to different ports in a port bus (e.g., giving in_a[2] a syn_useioff value of "0"). It cannot even be done by applying an attribute to a wire that is assigned the value of the bus (see the following example, flop_push_test5). The solution requires bit-blasting the bus into separate ports or assigning different values of syn_useioff to different bus ports using PDC.

Verilog Example of an IPIN Instance Attribute

module flop_push_test2 (in, clk);
input [38:0] in;
input clk;

wire ipad_dout_37;
BB_IPAD ipad_37 (.pad(in[37]), .dout(ipad_dout_37) );
wire ipin_dout_37;
IPIN ipin_37( .din(ipad_dout_37), .dout(ipin_dout_37) ) /* synthesis syn_useioff = 0 */;

reg data_37 = 1'b0;
always @(posedge clk)
begin
    data_37 <= ipin_dout_37;
end
endmodule

Physical Design Constraints (.pdc) File of IPIN Instance Attributes

set_property syn_useioff "1" [find -insts {ipin_*}]
set_property syn_useioff "0" {i:ipin_37}

Verilog Example of a Boundary Wire Attribute

module flop_push_test3 (in, clk);

```verilog
attribute syn_useioff of sel : signal is TRUE;
attribute syn_useioff of z0 : signal is TRUE;
end entity;

Physical Design Constraints (.pdc) File of Port Attributes

set_property syn_useioff "1" [find -ports {ina\[*\]}]
set_property syn_useioff "0" [find -ports {inb\[*\]}]
set_property syn_useioff "1" {p:sel p:z0}

Verilog Example of an IPIN Instance Attribute

module flop_push_test2 (in, clk);
input [38:0] in;
input clk;

wire ipad_dout_37;
BB_IPAD ipad_37 (.pad(in[37]), .dout(ipad_dout_37) );
wire ipin_dout_37;
IPIN ipin_37( .din(ipad_dout_37), .dout(ipin_dout_37) ) /* synthesis syn_useioff = 0 */;

reg data_37 = 1'b0;
always @(posedge clk)
begin
    data_37 <= ipin_dout_37;
end
endmodule

Physical Design Constraints (.pdc) File of IPIN Instance Attributes

set_property syn_useioff "1" [find -insts {ipin_*}]
set_property syn_useioff "0" {i:ipin_37}

Verilog Example of a Boundary Wire Attribute

module flop_push_test3 (in, clk);
```
input [38:0] in;
input clk;

(* syn_keep *) wire ipin_dout_37 /* synthesis syn_useioff=0 */;
IPIN ipin_37 (.pad(in[37]), .dout(ipin_dout_37));

reg level1_37 = 1'b0;
always @(posedge clk[0])
  begin
    level1_37 <= iпад_dout_37;
  end
endmodule

Physical Design Constraints (.pdc) File of Wire Attributes

set_property syn_useioff "1" [find -nets {ipin_dout_*}]
set_property syn_useioff "0" {n:ipin_dout_37}

Verilog Example of a DFF Instance Attribute

module flop_push_test4 (in, clk);
  input [38:0] in;
  input clk;
  wire iпад_dout_37;
  BB_IPAD iпад_37 (.pad(in[37]), .dout(iпад_dout_37));
  wire iпin_dout_37;
  IPIN ipin_37(.дин(iпад_dout_37), .dout(ipin_dout_37) );
endmodule

Physical Design Constraints (.pdc) File of DFF Instance Attributes

set_property syn_useioff "1" [find -insts {dff*}]
set_property syn_useioff "0" {i:dff1 i:dff2}

The following is an example of a boundary wire attribute that does not work as expected.

Verilog Example of a Boundary Wire Attribute that DOES NOT work

module flop_push_test5 (in, clk);
  input [38:0] in;
  input clk;

  (* syn_keep *) wire iпin_din_37 /* synthesis syn_useioff=0 */;
  assign iпin_din_37 = in[37];

  wire iпin_dout_37;
  IPIN ipin_37 (.pad(iпin_din_37) , .dout(ipin_dout_37) );
endmodule
always @(posedge clk[0])
begin
  data_37 <= ipad_dout_37;
end
endmodule

Caution!
As noted above, it is not possible using RTL attributes to apply different values of the syn_useioff attribute to different ports in a port bus. The above example, flop_push_test5, appears to be a clever way to apply the syn_useioff attribute to the net connecting the UCM port to a single IPIN in the 39-bit port bus in.
Unfortunately, this technique does not work. Synplify Pro optimizes away the wire ipin_din_37, despite the presence of the syn_keep attribute, and the syn_useioff attribute is not forward-annotated into the ACE input netlist. One can use PDC, however, to apply the syn_useioff attribute to the IPIN instance as in the following example.

Physical Design Constraints (.pdc) For Example flop_push_test5 That DOES Work
set_property syn_useioff "1" [find -nets \{in\[*\]\}]
set_property syn_useioff "0" [n:in\[37\]]

Implementation Options
The behavior of ACE with respect to flop pushing is controlled by the implementation options push_flops_into_pads and pad_flop_pushing_clock_type, described in the following section. Also, see Options View (see page 106).

push_flops_into_pads
The implementation option, push_flops_into_pads, controls whether flop pushing is performed automatically or manually. This implementation option has the following legal settings:

- "0" – flop pushing is completely disabled
- "1" – (manual mode) push flops into pads that have the syn_useioff attribute set to "1"
- "15" – (automatic mode) push flops into all pads except those that have the syn_useioff attribute set to "0"

Example Setting
set_impl_option push_flops_into_pads 15

pad_flop_pushing_clock_type
The implementation option, pad_flop_pushing_clock_type, enables automatic flop pushing to be controlled by the routing type of the pushed clock. The option only applies when the implementation option push_flops_into_pads has the value "15" (automatic mode). This implementation option has the following legal settings:

- "boundary" – automatically push flops into pads only when the flops are clocked by a boundary clock
- "trunk" – automatically push flops into pads only when the flops are clocked by a trunk clock
- "all" – automatically push flops into all pads regardless of the clock routing type
The routing type of a clock net is controlled by the `set_clock_type` command.

```plaintext
set_clock_type Examples

set_clock_type clk1 -boundary
set_clock_type clk2 -trunk
set_impl_option pad_flop_pushing_clock_type "boundary"
```

In the above example, only flops clocked by the boundary clock `clk1` are automatically pushed in the pads.

**Timing Analysis Implications**

As discussed above, flop pushing can be viewed as a form of retiming. Pushing a flop into a boundary pin reduces the off-chip timing path at the flop input by reducing the wiring delay. But it increases the on-chip timing path at the flop output, possibly by a large amount depending on how closely the driven logic is placed to the boundary pin. On small designs, especially when the logic is placed near the center of the chip, the increased delay can be significant.

Enabling flop pushing by default across a suite of designs often causes QoR to degrade significantly. This degradation happens because the off-chip delays are often not modeled well in the design timing constraints. The off-chip delay must be modeled using a `set_input_delay` or `set_output_delay` timing constraint. If those delays are zero, the improvement in off-chip delay may not be evident, and the increase in on-chip delay may be dominant.

More commonly, constraints are not even given, causing the timer to completely ignore timing paths that start or end off-chip. Pushing a flop into a pad with unspecified input/output delay could cause new setup/hold violations to appear that were not previously modeled.

**Working with Virtual I/O**

The role of I/O virtualization is to take a design with too many I/O pads (or boundary pins in the case of a Speedcore fabric) and reduce the number of I/Os until the design fits in the given fabric. This option is only run in evaluation flow mode.

**Behavior**

I/O virtualization is performed automatically as part of the `run_prepare` flow step in evaluation flow mode. It is not permitted to export a bitstream for a design with virtualized I/Os. If there are a sufficient number of boundary pin sites to place the design, then the command is a no-op. If the design has more boundary pin instances than available sites, I/O virtualization modifies the netlist by reducing the number of boundary pins until the design fits. When virtualizing I/O, no attempt is made to maintain logical equivalency with the original netlist. Rather, the goal is to perturb the behavior of the placement and routing tools as little as possible and, therefore, make an evaluation run correspond as closely as possible to a production run of a similar design.

I/O virtualization operates by collapsing multi-bit bused boundary pins as well as single non-bused boundary pins. By default, pins are selected automatically for virtualization, starting with the widest pin bus until enough boundary pin sites are available to fit the remaining number of boundary pin instances. If that number is insufficient, individual non-bused pins are also virtualized. Pin buses and individual pins can also be manually selected for virtualization through top-level port attributes in the RTL or PDC constraints (see Port Attributes, see page 444, below). Depending on the virtualization mode, some serialization boundary pins may be inserted, so it is possible for the process to fail and leave too many boundary pins in the design.

The pins are collapsed using one of three user-specified styles:
- **stubout** – each IPIN is replaced with a "stub" LUT that drives a constant zero onto the IPIN output net. Similarly, each OPIN is replaced with a "stub" LUT, driven by the OPIN input net, with a floating output pin. These stub LUTs are given `must_keep` attributes so that ACE does not optimize them away.
serialize_dff – bused IPINs are replaced with a single IPIN that drives a scan chain implemented with DFFs. The output of each DFF drives the output net from its original corresponding IPIN as well as the next stage in the scan chain. Bused OPINs are replaced with a single OPIN that is driven by a scan chain implemented with DFFs. The input of each DFF is driven by a 2-input MUX, one input of which is driven by the input net from its original corresponding OPIN. The other input of the MUX is driven by the output of the DFF in the previous stage of the scan chain. One additional IPIN per port bus is also added which drives the select line of the MUXes.

serialize_lut – this style is the same as the serialize_dff style, except that the scan chain is implemented with LUTs instead of DFFs.

The stubout style is the simplest and has the greatest rate of pad compression. However, it is the least realistic since there are no connections pulling the stub LUTs toward the edge of the chip. The placer pulls them into the chip core, placing them at the center of gravity of the loads that they drive. The two serialize styles keep one representative boundary pin and are, therefore, more realistic, though of course the strength of the placement forces pulling the scan chain toward the chip edge are significantly reduced. The main reason to use the serialize_dff style over the serialize_lut style is that, in the former style, the timer only sees a path that starts or ends at the last stage of the scan chain, while in the former the entire scan chain (possibly hundreds of LUT delays) contributes to the length of the timing path.

For the serialize_dff style, a clock must be connected to the DFFs that make up the scan chain. By default, that clock is selected automatically to be the clock in the chip core with the largest number of load pins. The clock can be user-specified either through a global implementation option, or on a per-port basis through an attribute on the port. These options are discussed in Implementation Options (see page 443) and Port Attributes (see page 444).

Implementation Options

The behavior of I/O virtualization can be controlled on a global basis by the following implementation options:

- **virtual_io_style** – controls the style, or method, used to virtualize excess I/O pad or boundary pin buses in the top-level netlist. Legal enumeration values are:
  - stubout (the default)
  - serialize_dff
  - serialize_lut

  See above for a definition of the behavior of each of these styles.

- **virtual_io_utilization** – sets the I/O pad or boundary pin utilization percentage targeted by I/O virtualization. Legal values are integers between 0 and 100. An error is returned if the given utilization cannot be met. A target utilization of zero percent requests that all possible port buses and non-bused ports are to be virtualized to achieve the smallest possible number of pins. A target utilization of 100 percent requests that port busses and non-bussed ports are to be virtualized until the number of remaining ports fit into the target fabric. This option is mutually exclusive with the virtual_io_num_pads option (both cannot be specified).

- **virtual_io_num_pads** – sets the final number of I/O pad or boundary pin instances targeted by I/O virtualization. Legal values are 0 or larger. A target pad number of zero requests that all possible port buses and non-bused ports are to be virtualized to achieve the smallest possible number of pins. If the specified value is larger than the number of available I/O pad or boundary pin sites in the selected fabric, the number of available I/O pad or boundary pin sites are targeted. This option is mutually exclusive with the virtual_io_utilization option (both cannot be specified).

- **virtual_io_clock_port** – specifies the name of the clock, by its top-level port name, to be used by I/O virtualization to clock serialization flops. Only applies for the serialize_dff virtualization style. This option can also be specified individually for a given port with the RTL or PDC port attribute, ace_virtualize_clock_port, which overrides this option if given. If not specified, the virtualization clock is derived automatically as the core clock net driving the largest number of loads. This option is mutually exclusive with the virtual_io_clock_net option (both cannot be specified).
virtual_io_clock_net – specifies the name of the clock, by its net name, to be used by I/O virtualization to clock serialization flops. Only applies for the serializedff virtualization style. This option can also be specified individually for a given port with the RTL or PDC port attribute, ace_virtualize_clock_net, which overrides this option if given. If not specified, the virtualization clock is derived automatically as the core clock net driving the largest number of loads. This option is mutually exclusive with the virtual_io_clock_port option (both cannot be specified).

Port Attributes

By default, I/O virtualization selects port buses for virtualization automatically. They are virtualized in order of decreasing size until the netlist meets the given target boundary pin utilization. However, port buses which are virtualized through the use of the RTL port attribute ace_virtualize can be manually controlled. When the virtualization style is set to serializedff, either a top-level port name or net name to be connected to the clock input of the new serialization flop instances can also be specified. Use the RTL port attribute ace_virtualize_clock_port or ace_virtualize_clock_net respectively.

The attribute can be set in the Verilog/VHDL source code, or in the physical design constraints (.pdc) file, as follows. An advantage of setting the property in the .pdc file is that the design does not have to be re-synthesized in order to experiment with different virtualization strategies.

Verilog Example

```verilog
module pds (          clk_i,  (* ace_virtualize="1", ace_virtualize_clock_port="clk_i" *)
    input                                   clk_i,
    output  [63:0]                          tx_data_o,  (* ace_virtualize="1", ace_virtualize_clock_net="clk_i_c" *)
    output  [ 7:0]                          tx_ifg_delay_o
endmodule
```

VHDL Example

```vhdl
entity pds is
    port(                  clk_i          : in std_logic;
                        tx_data_o      : out signed( 63 downto 0);
                        tx_ifg_delay_o : out std_logic_vector(7 downto 0)
                );

attribute ace_virtualize : boolean;
attribute ace_virtualize of tx_data_o : signal is TRUE;
attribute ace_virtualize of tx_ifg_delay_o : signal is TRUE;

attribute ace_virtualize_clock_port : string;
attribute ace_virtualize_clock_net : string;
attribute ace_virtualize_clock_port of tx_data_o : signal is "clk_i"
attribute ace_virtualize_clock_net of tx_ifg_delay_o : signal is "clk_i_c"

end entity;
```
If the target boundary pin utilization is not met after all user-specified ports are virtualized, additional ports are selected automatically until the target boundary pin utilization is met.

**Physical Design Constraints (.pdc) File**

```plaintext
set_property ace_virtualize "1" [find -ports {sample_src\[*\]}]
set_property ace_virtualize_clock_port "clk" [find -ports {sample_src\[*\]}]
```

**Runtime Messages**

Below are the output messages from I/O virtualization using the example above with user-specified port buses and the `serialize_dff` virtualization style.

**Runtime Messages**

INFO: Virtualize IO: Serializing user-specified 512-bit output PortBus tx_data_o using clock clk_i_c
INFO: Virtualize IO: Serializing user-specified 64-bit output PortBus tx_data_valid_o using clock clk_i_c
INFO: Virtualize IO: Serializing user-specified 64-bit output PortBus tx_ifg_delay_o using clock clk_i_c
INFO: Virtualize IO: Serializing user-specified 512-bit input PortBus rx_data_i using clock clk_i_c
INFO: Virtualize IO: Serializing user-specified 128-bit output PortBus pause_val_o using clock clk_i_c
INFO: Virtualize IO: Serializing remaining 6 auto-selected input ports using clock clk_c
INFO: Virtualize IO: Serializing remaining 13 auto-selected output ports using clock clk_c

WARNING: Virtualize IO: Netlist pds had too many IOs to fit in the selected device. Merged and deleted 1280 of 1498 IO ports. Final number of ports is 227. This is for evaluation purposes only and will cause simulation mismatches.

**Schematic View**

The following images illustrate each of the available virtualization styles with schematic diagrams showing 4-bit busses of input pads and output pads. First shown is the input netlist before pad virtualization, followed by the output netlist for the stubout, serialize_dff, and serialize_lut styles.

**Input Netlist**

The following figure illustrates the input netlist for a 4-bit bus of input pads, and a 4-bit bus of output pads. The output pads have an output-enable driver.
Output Netlist Styles

**stubout**

The following two schematics illustrate the output of I/O virtualization when using the stubout style. Notice that none of the IPIN or OPIN instances remain. The new LUTs replacing the IPIN instances are all driven by constant zeros, and the new LUTs replacing the OPIN instances have unconnected outputs.
The following two schematics illustrate the output of I/O virtualization using the `serialize_dff` style. Notice that the 4-bit IPIN and OPIN buses have been replaced by a single IPIN or OPIN instance. On the input side, the input pads were previously driving a bus of four DFFs. Those DFFs are now driven by the intermediate outputs of a 4-bit shift chain built from DFFs. On the output side, observe that the 4-bit output DFF shift chain is driven by four 2-to-1 MUXes. One input of the MUX comes from the flops originally driving the outputs, while the other input of each MUX is driven by the output of the previous stage of the shift chain. A new IPIN instance has been created to drive the select pin if these MUXes.
**serialize_lut**

The following two schematics illustrate the output of I/O virtualization using the `serialize_lut` style. Notice that the 4-bit IPIN and OPIN buses have been replaced by a single IPIN or OPIN instance. On the input side, the input pads were previously driving a bus of four DFFs. Those DFFs are now driven by the intermediate outputs of a 4-bit shift chain built from LUTs. On the output side, observe that the 4-bit output LUT shift chain is driven by four 2-to-1 MUXes. One input of the MUX comes from the flops originally driving the outputs, while the other input of each MUX is driven by the output of the previous stage of the shift chain. A new IPIN instance has been created to drive the select pin if these MUXes.

**Figure 217: serialize_lut Style Input Pad**

**Figure 218: serialize_lut Style Output Pad**

### Managing I/Os

**Caution!**

The I/O Assignment View is only applicable for Speedster FPGA devices. The IO Assignment View should be ignored when developing for other Achronix product types.

I/O electrical properties are often iteratively adjusted at the final stages of design. Frequently, it is inconvenient to alter the source RTL to make these changes, because doing so would necessitate re-running the entire flow.

The I/O Assignment View was created to ease these last-minute adjustments. This view allows I/O electrical changes to be made without impacting place-and-route. Electrical settings can be iteratively adjusted, the bitstream regenerated, and the design tested, repeating until the design performs as desired. The set of changed property values can then be saved off in an `.sdc` file (see *Save Changed Properties Dialog (see page 177)*). This `.sdc` file may be added to the project as a design constraint file, or the desired property values contained in the file could be integrated back into the source RTL.

In addition to the I/O Assignment View, there are design rule checks that ensure all I/O instance parameters are valid. These checks are run at several points in the flow, and help to prevent creating a bitstream with any invalid I/O configurations.
Accessing Help

ACE provides a number of ways to access help information, including context-sensitive help and a built-in copy of this user guide document.

Accessing Context-Sensitive Help

ACE provides brief context-sensitive help for most parts of the application. This contextual help typically contains a brief description of the view, dialog, etc., followed by a list of hyperlinks to relevant sections within the ACE User Guide.

To cause the context-sensitive help to be shown, simply press the **F1** key in Windows, or **Shift+F1** in Linux, and the contextual help appears in a view on the right.

The following is an example of what appears when contextual help is opened while the Projects view (see page 123) has focus:

![Context-Sensitive Help Example](image)

**Figure 219: Context-Sensitive Help Example**

Navigating Help Topics

Help topics (corresponding to sections within the ACE User Guide) can be browsed using the Help window or Help view. Choosing which to use is a matter of preference; the Help view is displayed within the workbench like any other view, and is good for quick help lookups. The Help window is (as the name implies) a separate window from the rest of ACE and can be individually maximized, thus allowing easier reading of larger quantities of content.

Using the Help Window

The Help window is separate from the workbench, used exclusively for browsing and searching help content. To open the window, select **Help → Help Contents** from the main menu. This action opens the help window with the **Contents** tab visible in the left frame, which shows the table of contents.
**Navigating the Help Window**

**Table of Contents**

1. In the left frame, select the ( ) **Contents** tab.
2. To find the topic to be read in the table of contents:
   a. Click to expand the subtopics.
   b. Click in the desired topic to have it displayed in the frame on the right.
3. Some topics provide links to additional related topics within (or after) their content. Click these links to learn more.
4. Use the ( ) **Back** and ( ) **Forward** buttons (above the right frame) to navigate back and forth among the recently viewed topics. These buttons behave the same way as in Web browsers.
5. Use the ( ) **Home** button (above the right frame) to return to the help home page in the ( ) **Contents**.

**Searching**

To quickly locate topics on a particular subject in the documentation, enter a query in the Search field at the top of the window. Search results are displayed in the left frame on the ( ) **Search Results** tab. For more details, see Searching Help (see page 450).

**Synchronizing**

Clicking the ( ) **Show in Table of Contents** button above the right frame selects that topic for that page in the **Contents** tree in the left frame (useful when navigating search results when the tree may be out of sync). The ( ) **Link with Contents** button above the left frame in the **Contents** tab keeps the navigation tree synchronized to the current topic shown in the right frame.

**Maximizing and Restoring Help Frames**

The two main frames of the Help window can each be maximized to take up the entire window. To maximize a frame, click the ( ) **Maximize** button in the frame toolbar, or double-click any blank part of the toolbar for that frame. To return the frame to its original size, click the ( ) **Restore** button or double-click the toolbar again.

**Using the Help View**

The Help view provides the same features as the Help window, but does it in a single view panel within the **Workbench** (see page 24) instead of in a separate window.

**Searching Help**

The help system includes a search engine that can run simple or complex queries on the documentation to help locate the desired information. To search help:

1. From the main menu, select Help → Search.
2. Type the word or phrase for the search subject.
3. Click GO or press Enter. The list of results are displayed below in the left frame (within the Search Results tab).

4. Click the topic in the list of results to view the content.

Alternately, searches can be initiated within the Help window using the Search field at the top left of the window.

Refining the Search Results

Reducing the Scope of the Search
Sites licensed for both Speedcore and Speedster devices can narrow the Scope of a search by restricting the scope to only the preferred user guide(s).

Changing the Appearance of the Search Results
Two buttons on the search results toolbar can be used to change the way results are displayed:

- The ( ) Show result categories button, when clicked, causes the results to be grouped by book (this action only has a noticeable effect at sites licensed for both Speedcore and Speedster devices, i.e., when both ACE User Guides are available).
- The ( ) Show result descriptions button, when clicked, causes a brief description of each result to be shown.

Highlighting Search Terms
By default, when a search result is selected, the search terms used to find the document are highlighted in the document content. Clicking the ( ) Highlight Search Terms toolbar button toggles this feature on and off. This button is available in both the help window and the help view. The state of this button is remembered in both views when displaying subsequent search results.

Search Query Syntax
Follow these expression rules for searching local help content:

- The following stop words are common English words which are ignored (not searched for) if they appear in the search expression:
  - a, and, are, as, at, be, but,
    by, in, into, is, it, no, not,
    of, on, or, s, such, t, that,
    the, their, then, there, these,
    they, to, was, will, with
  
- The search engine ignores character case (i.e., "Workbench" returns topics that contain "workbench", "Workbench", "WorkBench", and "WORKBENCH")

- Unless otherwise stated, there is an implied AND between all search terms so that topics that contain all the search terms are returned (e.g., "verilog module" returns topics that contain the word "verilog" and the word "module" but does not return topics that contain only one of these words)

- Use "OR" before optional terms (e.g., "project OR implementation" returns topics that contain the word "project", or the word "implementation", or both)

- Use "NOT" before terms to exclude from search results (e.g., "verilog NOT module" returns topics that contain the word "verilog" and do not contain the word "module")

Note
The word "NOT" only works as a binary operator (e.g., "NOT module" is an illegal search query by itself).
Using the ACE SecureShare Tool to Create a Support Zip File

When encountering some problems, the Troubleshooting (see page 628) chapter and/or opening a case with Achronix Technical Support (at support.achronix.com/hc/en-us) might not be enough to find a solution. For these instances, ACE includes the SecureShare tool.

The Create a SecureShare Zip File dialog (see page 159) gathers all the important information from a user design and collects it into a single ZIP file. Sensitive files may be optionally excluded, or additional files included, before the ZIP file is created by the SecureShare tool. Optionally, the SecureShare tool can even encrypt the information in the ZIP file. Achronix technical support engineers can decrypt any files encrypted by the tool as they help track down and solve the problem.

To use the SecureShare tool:

1. Load (and activate) the project (see page 217) and implementation (see page 217) for which help is desired. (See also Active Project and Implementation (see page 223).) The SecureShare tool gathers the relevant files for whichever project and implementation are active when the tool is started.

   Note
   * If help is needed for multiple projects or implementations, each need to be handled using separate SecureShare ZIP files.

2. Open the Create a SecureShare Zip File dialog (see page 159) by selecting Help → Start SecureShare, or by using the keyboard shortcut Ctrl+Alt+Shift+S.

3. Examine each file category and Remove any files containing sensitive information which should not be transmitted to Achronix.

4. Add any additional files which might help Achronix track down the problem. Ideally, add the files to the appropriate categories. If no appropriate category exists, add the files to the "Other" category.

5. Make sure the ZIP file (under the Configure SecureShare heading at the top) is pointing to an appropriate directory/filename.

6. Select the Encrypt included files checkbox if desired.
7. Click the Finish button at the bottom of the dialog.

ACE then creates a ZIP file with the chosen name in the chosen directory. If the Encrypt option was chosen, an additional file with the .zip.encrypted file extension is created alongside the (not-encrypted) ZIP file. The resulting .zip or .zip.encrypted file can be attached to the support request ticket.

Importing and Exporting Preferences

Preference files can be both imported to and exported from ACE, allowing individual or group preferences to be shared or migrated from an existing version of ACE to a newer version when upgrading.

Import Preferences

The Import wizard can be used to import preferences from the file system into ACE. To import a preference file:

1. Select File → Import...
2. In the Import wizard, select Preferences and click Next.
3. Click Browse... and locate the Preferences file on the file system.
4. Select Import all to accept all of the preferences defined in the file.
5. Click Finish.
Export Preferences

The Export wizard can be used to export preferences from ACE to the file system. To export a preference file:

1. Select File → Export...
2. In the Export wizard select Preferences and click Next.
3. Select **Export all** to add all of the preferences to the file.
4. Click **Browse...** and locate the preferences file on the file system.
5. Click **Finish**.
Plotting SerDes Receiver Diagrams Using JTAG

Using an open JTAG connection to the SerDes hardware, it is possible to capture Rx diagnostic data and plot Eye diagrams, Histograms, and Bathtub plots.
Plotting a SerDes Diagram for a SerDes Lane

Diagrams can be plotted using the following simple steps. For advanced users, the `jtag::capture_serdes_diagram_data` and `jtag::plot_serdes_diagram_data_matlab` Tcl commands may be used directly.

1. Open an ACE project containing the I/O Ring design configuration, and switch to the IP Configuration perspective.
2. Open a valid JTAG connection to the FPGA using the JTAG Tcl commands in the Tcl Console view (see page 144):

   ```tcl
   set jtag_id "AC12345"
   jtag::open $jtag_id
   jtag::ac7t1500_initialize_fcu $jtag_id
   ```

3. With an open JTAG connection, right-click any configured (green) SerDes Lane in the I/O Layout Diagram view (see page 80):
4. Configure the diagram plotting options in the **Plot Serdes Diagram dialog** (see page 175):

![Plot SerDes Diagram Configuration Example](image)

**Figure 226: Plot SerDes Diagram Dialog Configuration Example**

5. Click **Finish**.
Note

Multiple diagrams can be plotted from the same capture data file using the `jtag::plot_serdes_diagram_data_matlab` Tcl command after completing these steps. The diagram plotting capture over JTAG takes a long time. For 500 samples, it typically takes upwards of 10 minutes to run.

Using Partial Reconfiguration

This section begins with a high-level overview, and then continues with detailed tutorials.

- Partial Reconfiguration Tutorial (see page 459)

Partial Reconfiguration Tutorial

Partial Reconfiguration tutorial examples are provided for two different flows. ACE currently supports Partial Reconfiguration for the Speedster7t AC7t1500ES0 FPGA only.

Partial Reconfiguration Flows

- PR Flow 1: Multi-Project PR Flow Using Partition Export/Import (see page 469)
- PR Flow 2: Multi-Project PR Flow Using Keep Out Regions (see page 494)

ACE currently supports 2 different partial reconfiguration flows. PR flow 1 is the recommended flow.

Overview of PR Flow 1

PR Flow 1 uses the ACE partitions feature. Familiarity with the ACE partition flow is recommended before proceeding with PR flow 1.

The partition import/export flow requires separate projects for the top-level design as well as each PR Core. The partition export flow must first be run in its own Synplify and ACE project for the PR core to be exported as a partition. After the partition export flow is run, ACE generates a placed and routed partition for the PR core. The partition import flow is next run in a separate Synplify and ACE project. In the partition import flow, the top-level design instantiates the previously exported PR core blackbox module and ACE imports the placed and routed data for the PR core into the top-level design.

Note

In the partition import flow, ACE only places and routes the top-level design and not the imported PR cores.

The base bitstream is created in the first partition import run where the previously exported PR cores are imported into the top-level design. On Silicon, the base bitstream is programmed onto the device first. The partial bitstream for the second set of PR Cores is subsequently programmed onto the device. The base bitstream includes the top-level logic as well as the PR Core logic. The partial bitstream is generated in the second partition import run where a different set of exported PR Cores are imported in the same top-level design.
Overview of PR Flow 2

The Multi-Project PR flow using keepout regions is another method to create designs that can be partially reconfigured. This flow involves using separate ACE projects to generate separate base and partial bitstreams for the top-level design and each PR core. On silicon, the base bitstream consisting of only the top-level logic is programmed first. The partial bitstreams for the other PR core can be programmed subsequently. Using this flow, the user design is stitched together at the bitstream level. There is no integration in ACE between the the top-level design and each PR core since the designs are stitched at the bitstream level. As such, this flow comes with a few pitfalls so that only high-level users are recommended to use this flow. PR flow 1 is therefore considered an improvement to PR flow 2.

Flow Comparisons

Table 148: Pros and Cons For Each PR Flow

<table>
<thead>
<tr>
<th>Item</th>
<th>PR Flow 1</th>
<th>PR Flow 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn-around Time</td>
<td><strong>Con:</strong> PR flow 1 has a slower turn-around time. The base bitstream consists of the top-level design as well as the PR cores. PR Cores must be exported in separate ACE sessions before being imported into the top-level design.</td>
<td><strong>Pro:</strong> PR Flow 2 has a faster turn-around time. The base bitstream consists only of the top-level design. PR cores place-and-route can be bypassed. Only a keep-out region is needed.</td>
</tr>
<tr>
<td>Integrating Third Party Accelerators</td>
<td><strong>Pro:</strong> PR flow 1, allows integrating third party accelerator cores at a bitstream level and also within ACE. The partition binary file for third-party accelerators can be integrated in an ACE project which allows running checks and timing analysis for the integrated design to ensure that the accelerator is compatible with the top-level design.</td>
<td><strong>Con:</strong> PR flow 2 enables integrating third party accelerator cores only at the bitstream level. Third party accelerators cannot be tested until programmed at the bitstream level.</td>
</tr>
<tr>
<td>Bitstream Stitching</td>
<td><strong>Pro:</strong> In PR flow 1, ACE integrates the PR core project together with the top-level project using the partitions feature. A series of checks are performed to ensure that the base and partial bitstreams can be stitched together without issue.</td>
<td><strong>Con:</strong> In PR Flow 2, bitstreams might not be stitched together correctly if any of the ACE projects are configured incorrectly. The base bitstream and partial bitstreams are created in separate independent ACE projects so if all user projects are not set up correctly, ACE cannot catch the errors. 1. Scenario 1 – if clock nets used in the partial bitstream are not pre-routed in the base bitstream, the clock signal cannot be correctly connected to the PR cores after partial reconfiguration. 2. Scenario 2 – if clock nets on different clock tracks are pre-routed in the partial and base bitstream, the clock signals cannot be correctly connected to the PR Cores after partial reconfiguration. 3. Scenario 3 – if keep-out regions are not set on clusters in the base bitstream that are used by PR cores, the top-level logic might be lost after partial reconfiguration.</td>
</tr>
<tr>
<td>Closing Timing</td>
<td><strong>Pro:</strong> In PR flow 1, ACE integrates the PR core project together with the top-level project during the partition import run and also performs timing analysis for the integrated design.</td>
<td><strong>Con:</strong> In PR Flow 2, the design might not meet timing on paths between the top-level and PR core after the partial bitstream is programmed because timing analysis is performed separately in projects for the top-level design and PR cores (timing delays are different on the east and west sides of the Speedster7t AC7t1500ES0 FPGA.)</td>
</tr>
<tr>
<td>Simulation</td>
<td><strong>Pro:</strong> Simulating the entire design is possible in the partition import run.</td>
<td><strong>Con:</strong> Simulating the entire design within an ACE project is difficult because there is no integration between separate ACE projects. Though not impossible, a lot of manual work is required.</td>
</tr>
</tbody>
</table>
Flow Diagrams

The following sequence outlines the high-level steps needed to partially reconfigure PR core A as PR core B.

**PR Flow 1: Multi-project PR Flow Using Partition Export/Import**

In the operating procedure for this example, the base bitstream in step 3 is programmed onto silicon first. This base bitstream includes the top-level logic and the PR Core A logic. To partially reconfigure PR Core A with PR Core B, the partial bitstream created in step 6 is programmed subsequently.

1. Export PR core A as a partition using ACE.

2. Import PR core A partition into top-level design.

3. Generate a base bitstream for the entire device.

![Figure 227: Export PR Core as a Partition Example](image-url)
4. Export PR core B as a partition using ACE.

5. Import the PR core B partition into the same top-level design.

6. Generate a partial bitstream only for PR core B.
Figure 230: Generate Partial Bitstream Example

**PR Flow 2: Multi-project PR Flow Using Keep Out Regions**

In the operating procedure for this example, the base bitstream created in step 3 is programmed onto silicon first. Unlike PR Flow 1, the base bitstream only contains the top-level logic (not the PR Core A logic). The partial bitstream for PR Core A (created in step 1) is programmed next. To partially reconfigure PR Core A with PR Core B, the partial bitstream for PR Core B (created in step 2) is programmed subsequently.

1. Generate a partial bitstream for PR core A using ACE.
2. Generate a partial bitstream for PR core B using ACE.

3. Generate a base bitstream for the top-level design using ACE with keep out regions for the PR cores.
Design Details

This tutorial uses a simple example design to illustrate running a design through PR Flow 1. In this tutorial, three separate bitstreams are created:

1. Base Bitstream (Top-level design)
2. Partial Bitstream 1 (PR Core 1)
3. Partial Bitstream 2 (PR Core 2)

**Base Bitstream (Top-level design)**

RTL files:

1. PR flow 1 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_top_a/src/rtl/...`
2. PR flow 2 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_top/src/rtl/...`

Constraint files:

1. PR flow 1 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_top_a/src/constraints/...`
2. PR flow 2 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_top/src/constraints/...`
The top-level design instantiates the user static logic. Static Logic refers to any user design logic which is not intended to be reconfigured in the PR flow. The base bitstream is generated using the top-level design. The top-level design in this tutorial demonstrates a 2-bit binary up-counting LED display to indicate that the board and FPGA are operating properly upon powerup. The RTL along with the device-specific netlists and constraints are available under the `<ACE_install_dir>/Achronix/examples/partial_reconfiguration directory).

Other than just instantiating the user static logic, the top-level design also must instantiate any shared system controller logic, I/O Ring, and I/O interfaces used in the other PR cores. Clock nets used in each PR core to be partially reconfigured must also be carefully pre-routed since clock nets are also routed on the core fabric HW clock network, which is not reconfigurable. Also, a keep-out region for each PR Core must be created to prevent any logic and routing from the top-level design from entering the cluster(s) used by the PR Cores in the partial bitstreams.

**Partial Bitstream 1 (PR Core 1A)**

RTL files:

1. PR flow 1 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_core_1a/src/rtl/...
2. PR flow 2 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_core_1a/src/rtl/...

Constraint files:

1. PR flow 1 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_core_1a/src/constraints/...
2. PR flow 2 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_core_1a/src/constraints/..

PR core 1 consists of a 32-bit adder with outputs connected to a 32-bit register. This 32-bit register is connected to the NAP initiator in the cluster. The NAP Initiator can be used to read the 32-bit adder output register via the 2D NoC with the JTAG interface or with PCIe. In this tutorial, the JTAG interface is used to read the user registers. There is also a reset register that can be written to in this design. The reset register drives all resets in PR core 1.

Partial bitstreams must not contain any I/O ring programming. Clock nets also must be pre-routed on the clock network on a specified track number. The top-level design must also pre-route the same clock net on the same track number to the same cluster where PR core 1 is placed. A cluster map also must be set to identify which core fabric cluster(s) are to be re-programmed. The following sections in this tutorial cover this in more detail.

**Partial Bitstream 1 (PR Core 1B)**

RTL files:

1. PR flow 1 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_core_1b/src/rtl/...
2. PR flow 2 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_core_1b/src/rtl/...

Constraint files:

1. PR flow 1 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_core_1b/src/constraints/...
2. PR flow 2 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_core_1b/src/constraints/..
PR core 1B is identical to PR core 1A except that the 32-bit adder increments by 2 instead of 1 during each read.

**Partial Bitstream 2 (PR Core 2A)**

RTL files:

1. PR flow 1 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_core_2a/src/rtl/...`
2. PR flow 2 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_core_2a/src/rtl/...`

Constraint files:

1. PR flow 1 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_core_2a/src/constraints/...`
2. PR flow 2 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_core_2a/src/constraints/...`

PR core 2A is identical to PR core 1A except that the 32-bit adder instead is implemented as a 32-bit subtractor. The 32-bit subtractor decrements by 1 at each NAP read.

**Partial Bitstream 2 (PR Core 2B)**

RTL files:

1. PR flow 1 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_core_2b/src/rtl/...`
2. PR flow 2 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_core_2b/src/rtl/...`

Constraint files:

1. PR flow 1 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_core_2b/src/constraints/...`
2. PR flow 2 – `<ACE_INSTALL_DIR>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_core_2b/src/constraints/...`

PR core 2B is identical to PR core 2A except that the 32-bit subtractor now decrements by 2 instead of 1 at each NAP read.

**Reset Configuration Options**

This tutorial uses option 1, below, but there are several ways resets for a partial reconfiguration design can be configured. The different methods are listed below, ordered by recommendation (1 being the most and 4 being the least recommended method).

1. Use a NAP to control reset via the 2D NoC. This can be performed using host software (e.g., `jtag::nap_axi_write` or PCIe), or top-level control logic.
   This reset scheme is utilized by the demo in this tutorial. All nets driven by reset are self contained within the PR zone.
2. Use a DFF chain to de-assert reset when the cluster enters user mode.
   • Use init values on DFFs to toggle the reset when a cluster enters user mode.
This is an example showing how to instantiate a DFF chain for an active-low reset design:

```verilog
wire rst_wire_1;
wire rst_wire_2;
wire i_rst;

// First DFF in chain
(* must_keep=1 *) ACX_DFF #(.
 .init   (1'b1)
 ) reset_dff_1 (.
 .q      (rst_wire_1),
 .d      (),
 .ck     (i_clk)
);

// Second DFF in chain
(* must_keep=1 *) ACX_DFF #(.
 .init   (1'b0)
 ) reset_dff_2 (.
 .q      (rst_wire_2),
 .d      (rst_wire_1),
 .ck     (i_clk)
);

// Third DFF in chain (q-pin drives the PR Core reset)
(* must_keep=1 *) ACX_DFF #(.
 .init   (1'b0)
 ) reset_dff_3 (.
 .q      (i_rst),
 .d      (rst_wire_2),
 .ck     (i_clk)
);
```

In this example, `reset_dff_3` drives the reset with `1'b0` for 2 clock cycles before being de-asserted to `1'b1`.

The disadvantage of this reset scheme is that the resets cannot be toggled by the user.

3. Use top-level CLK I/O pads to drive the reset to the global clock trunk using clock-preroute constraints.
   - Pre-route the reset net on a specified track on the global clock trunk.
   - PDC constraints:

```
#Create a clock IPIN for your reset and place it on a clock IPIN tile
create_boundary_pins {p:i_reset_n} {i_reset_n_ipin} -clock
set_placement -fixed -batch {p:i_reset_n} {d:i_user_06_00_trunk_00[16]}

#Pre-route the reset net on clock track 1 to the PR Zone defined for your PR Core.
#add_clock_preroute "i_reset_n_ipin_net" 1 -placement_regions "PR_ZONE_2_7"
```

Disadvantage: The reset net is routed over the clock network so there is one less clock track available.

4. Use top-level Data I/O pads to drive the reset and use the `data2clk` path to route the reset to the global clock trunk using clock-preroute constraints.
• Pre-route the reset net on a specified track on the global clock trunk.

• PDC constraints

```
#Create a data IPIN for your reset and place it on a data IPIN tile
create_boundary_pins {p:i_reset_n} {i_reset_n_ipin}
set_placement -fixed -batch {p:i_reset_n} {d:i_user_11_09_lut_13[15]}

#Pre-route the reset net on clock track 1 to the PR Zone defined for your PR Core.
#add_clock_preroute "i_reset_n_ipin_net" 1 -placement_regions "PR_ZONE_2_7"
```

• Disadvantages: There must be a path available from the data IPIN to the central clock trunk. If there are no paths available because all clusters are blocked off and in use, the router cannot pre-route this reset net.

PR Flow 1: Multi-Project PR Flow Using Partition Export/Import

Introduction

The Multi-Project flow with partition export/import is the recommended flow for partial reconfiguration.

The partition import/export flow requires separate projects for the top-level design as well as for each PR core. The partition export flow must first be run in its own Synplify and ACE project in order for a PR core to be exported as a partition. After the partition export flow is run, ACE generates a placed-and-routed partition for the PR core. The partition import flow is next run in a separate Synplify and ACE project in which the top-level design instantiates the PR core blackbox module that was previously exported. ACE imports the placed-and-routed data for the PR core into the top-level design.

Note

In the partition import flow, ACE does not place-and-route the imported PR cores, only the top-level design.

Moving Partitions

Partitions are also very useful for replicating and moving logic. Each PR core can be placed-and-routed, and the timing-closed, once in one location of the fabric, and then stamped down multiple times and relocated throughout the fabric. This is accomplished by instantiating multiple copies of the exported PR core partition in the top-level design. ACE then imports the timing-closed PR core partition database. Initially, each instance of the PR core is placed on top of each other but ACE has a special feature which allows partitions to be moved/re-mapped to other locations in the fabric. This is made possible using relative placement and routing to map to the repetitive cluster-based architecture of the fabric.

High-Level Design Flow

The bottom-up flow must be used for PR flow 1. This involves exporting a partition for each of the PR cores and importing them into the top-level design. The base bitstream can be generated for the top-level design to contain each of the PR cores. Subsequent partial bitstreams can be generated from the top-level design project or from each PR core project.

Please follow this high-level design flow carefully:

1. Export Partition for PR Core 1A (see page 470)
   a. Synthesize PR Core 1A Using Synplify (see page 470)
   b. Run PR Core 1A Through Run Prepare in ACE (see page 472)
   c. Set Up Region Constraints for PR Core 1A (see page 473)
   d. Set Up Clock Pre-Routing Constraints for PR Core 1A (see page 474)
1. Run PR Core 1A Through Place-and-Route in ACE (see page 475)
   f. Run Final Sign-Off Timing Analysis for PR Core 1A (see page 476)
   g. Save Region/Clock Pre-Routing Constraints Back to PDC File (see page 477)
   h. Ensure ACE Generated Blackbox File and Exported Partition for PR Core 1A (see page 477)

2. Export Partition for PR Core 2A (see page 478)
   a. Repeat Procedure for PR Core 2A (see page 478)

3. Importing PR Core 1A and 2A Partitions and Generating Base Bitstream for Top-Level Design (see page 478)
   a. Create I/O Ring Configuration for Target Board (see page 478)
   b. Synthesize Top-Level Design Using Synplify (see page 483)
   c. Run Top-Level Design Through Run Prepare in ACE (see page 484)
   d. Set Up Clock Pre-Routing Constraints (see page 485)
   e. Set Up Region Constraints (Optional) (see page 486)
   f. Run Top-Level Design Through Place-and-Route in ACE (see page 488)
   g. Run Final Sign-Off Timing Analysis in ACE (see page 489)
   h. Generate Base Bitstream for Top-level Design (see page 490)
   i. Save Region/Clock Pre-Routing and Partition Placement Constraints Back to PDC File (see page 490)

4. Generate Partial Bitstream for PR Core 1B and 2B (see page 491)
   a. Export PR Core 1B as Partition (see page 491)
   b. Export PR Core 2B as Partition (see page 491)
   c. Import PR Core 1B and 2B Into Top-Level Design (see page 492)
   d. Generate Partial Bitstream for PR Core 1B and 2B in Top-level Design (see page 493)

5. Bitstream Programming Sequence (see page 493)
   a. Apply Power to Board (see page 493)
   b. Program Top-Level Base Bitstream Containing PR Core 1A and 2A (see page 493)
   c. Run PR Core 1A and 2A Test Scripts (see page 494)
   d. Program Partial Bitstream for PR Core 1B and 2B (see page 494)
   e. Run PR Core 1B and 2B Test Scripts (see page 494)

**Export Partition for PR Core 1A**

**Synthesize PR Core 1A Using Synplify**

1. Navigate to the following directory:
   `<ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_core_1a/src`

   **Note**
   `<ace_install_dir>` is the directory path where ACE was installed.

   Below this directory should be the following two directories:
   - `rtl`
2. In the `rtl` directory, create a new Synplify project and add all of the RTL files.
3. Add the `pr_core_1a_timing.sdc` file to the `constraints` directory.
4. Create a compile point for the PR core 1 module to be exported as a partition.

   **Note**
   The compile point cannot be set for the top-level module.

5. Add the `pr_core_1a_export_partitions.fdc` file from the `constraints` directory to the project. The compile point is set in the file as follows:

   ```
   define_compile_point {v:work.pr_core_1a} -type {locked}
   ```

6. In the **Project → Implementation Options → Device** tab, set **Technology** to Achronix Speedster7t.
7. Set **Part** to AC7t1500ES0.
8. Set **Package** to F53.
9. Set **Speed** to C2.
10. In the **Project → Implementation Options → Implementation Results** tab, set **Result Base Name** to `pr_core_1a_top`.
11. In the **Project → Implementation Options → Verilog** tab, set **Top Level Module** to `pr_core_1a_top`.
12. Set **Include Path Order** to `<ace_install_dir>/libraries`.
13. Add the `AC7t1500ES0_synplify.sv` file to the project, this file is under `<ace_install_dir>/libraries/device_models`.

   ![Project Example](image)

   **Figure 234: Project Example**
14. Run and compile the design using Synplify.

15. After successful completion, Synplify generates a gate-level netlist under `<synplify_out_dir>/rev_1/pr_core_la_top.vm`.

16. Synplify also creates a .prt file indicating that the compile point was successfully set for PR core 1A. This file is generated under `<synplify_out_dir>/rev_1/pr_core_la_top_partition.prt`.

### Run PR Core 1A Through Run Prepare in ACE

1. In the **Projects** view, click the ( ) **Create a New Project** button.
2. Create a project using the pop-up dialog and click **Finish** when complete.
3. In the **Projects** view, click the ( ) **Add Source Files to Project** button.
4. Add the following files to the project:
   - `pr_core_la_top_partition.prt` (the partition info file created by Synplify in step 1a)
   - `pr_core_la_top.vm` (the synthesized netlist created by Synplify in step 1a)
   - `<ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_core_la/src/ioring_design/pr_core_la_ioring.pdc`
   - `<ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_core_la/src/ioring_design/pr_core_la_ioring.sdc`

5. In the **Options** view, navigate to the **Design Preparation** section and ensure that the **Export All Partitions** option is checked and all other options are correctly set.
6. Copy the option values as shown in the following figure.
7. In the **Flow** view, right-click **Run Prepare** and select **Run Selected Flow Step**:

![Image](image.png)

*Figure 235: Run Prepare Flow Step Example*
Set Up Region Constraints for PR Core 1A

1. Ensure that the `run_prepare` flow step has completed successfully.
2. On the Floorplanner view, click the Placement Region Tool button (highlighted in red in the following image).
3. Click and drag within the Floorplanner to create a PR zone for the PR core.

![Figure 236: Creating a Placement Region Zone Example](image)

4. After releasing the left mouse button, the Create Placement Region dialog appears.
5. In Region Name, enter a name for the PR zone.
6. Set Region Alignment to Snap to Fabric Clusters (a "fabric cluster" represents the lowest level of granularity at which the core fabric can be partially reconfigured).
7. Set the Region Type to Inclusive (ensures that all instances are constrained to the region).
8. Select Include Routing (ensures that all routed nets are constrained to the region).
9. Select Is Partial Reconfiguration Zone (indicates this region is a PR zone).
Figure 237: Create Placement Region Dialog Example

10. Click Finish. The Tcl console displays the following:

```
create_region "PR_ZONE_2_7" {29 40 53 78} -snap fabric_clusters -type inclusive -include_routing -pr_zone
```

11. Add all instances in the PR core to the region. A recommended quick way of doing so is to use the
`add_region_find_insts` Tcl command nested with the `find` Tcl command. Run the following example in the
Tcl Console to add all instances in PR core 1A to the PR zone (`i_pr_core_1a` is the instance name for the top-
level partial reconfigurable module).

```
add_region_find_insts "PR_ZONE_2_7" {find {*i_pr_core_1a*} -insts}
```

Set Up Clock Pre-Routing Constraints for PR Core 1A

1. In the **Partitions** view, right-click the cell below the **Clock Pre-Routes** column heading and select **Configure Clock Pre-Routes** as shown:
2. The **Configure Clock Pre-Routes** dialog appears with the `i_clk_pr_1_ipin_net` signal that drives the PR core 1A clock pins pre-routed on clock track 1.

![Configure Clock Pre-Routes Example](image)

**Figure 238: Configure Clock Pre-Routes Example**

3. Click **OK**. The Tcl console displays the following:

```tcl
add_clock_preroute i_clk_pr_1_ipin_net { 1 } -partitions { /pr_core_1a_top/i_pr_core_1a }
```

Run PR Core 1A Through Place-and-Route in ACE

1. In the **Flow** view, right-click **Place and Route** and select **Run Selected Flow Step** as shown:
Run Final Sign-Off Timing Analysis for PR Core 1A

1. Ensure that the place-and-route flow step completed successfully.

2. In the Flow view, right-click Design Completion and select Run Selected Flow Step as shown:
Save Region/Clock Pre-Routing Constraints Back to PDC File

1. Ensure that the Design Completion flow step completed successfully.
2. In the Placement Regions view, click the ( ) Save Placement Regions button.

![Placement Regions screenshot](image)

**Figure 242: Save Placement Regions Example**

3. The Save Placement Regions dialog appears.
4. Click Finish to save the PR zone region constraints.
5. The Tcl console displays the following and the placement_regions.pdc file is created.

```tcl
create_region "PR_ZONE_2_7" {32 41 87 92} -snap fabric_clusters -type inclusive -include_routing -pr_zone
add_region_find_insts "PR_ZONE_2_7" {find {*i_pr_core_1a*} -insts

6. ACE automatically generates a clock pre-route file to the output area under `<ace_output_dir>/ace/impl_1/output/partial_reconfig_core_1_top_clock_preroutes.pdc`

**Note**

This file should not be added to the ACE project as it is regenerated during each run. Make a copy of this file before adding it to the project.

Alternately, use the `save_clock_preroute` Tcl command to generate a .pdc file with the clock pre-route constraints.

Ensure ACE Generated Blackbox File and Exported Partition for PR Core 1A

ACE generates a blackbox file for the exported partition (PR core 1A). Ensure that this file exists in the following directory:

```
<ace_install_dir>/examples/partial_reconfig/tutorial/AC7t1500ES0/pr_flow_1/pr_core_1a/ace/impl_1/output/blackboxes/pr_core_1a_bb.v
```

ACE also exports a partition database file for the exported partition (PR core 1a). Ensure this file exists in the following directory:

```
<ace_install_dir>/examples/partial_reconfig/tutorial/AC7t1500ES0/pr_flow_1/pr_core_1a/ace/impl_1/output/partitions/pr_core_1a_top.i_pr_core_1a.epdb
```
**Export Partition for PR Core 2A**

**Repeat Procedure for PR Core 2A**

1. Repeat the steps in section 1 to export a partition for PR core 2A. PR core 2A is placed on a different cluster (row=7, col=6) than PR core 1A. Steps 1c, 1d and 1g are skipped by directly adding the following file to the project:

   `<ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_core_2a/pr_core_2a_ace_placements.pdc`

   This file contains all the correct region and clock pre-route constraints.

**Importing PR Core 1A and 2A Partitions and Generating Base Bitstream for Top-Level Design**

**Create I/O Ring Configuration for Target Board**

In this design, a simple clock input is driving a PLL to create clocks for the core fabric. Also, a simple GPIO interface to display LEDs is in the top-level design.

1. Navigate to the **IP Libraries** view.
2. Right-click the **Clock I/O Bank** IP and select **New IP Configuration**:

   ![New IP Configuration Example](image)

   **Figure 243: New IP Configuration Example**

3. Configure the Clock I/O Bank for the PR cores using the options shown in the following image:
3. In the IP Libraries view, right-click the PLL IP and select New IP Configuration.

4. Configure the PLL for the PR core using the options shown in the following image.
6. In the **IP Libraries** view, right-click the **NoC** IP and select **New IP Configuration**.
7. Configure the 2D NoC IP for the PR core using the options shown in the following image:

8. In the **IP Libraries** view, right-click the **Clock I/O Bank** IP and select **New IP Configuration**.
9. Configure the Clock I/O Bank for the top-level design using the options shown in the following image:

![Clock I/O Bank Configuration](image)

**Figure 247: Clock I/O Bank IP Configuration Example**

10. In the **IP Libraries** view, right-click the PLL IP and select **New IP Configuration**.

11. Configure the PLL for the top-level design using the options shown in the following image:

![PLL Configuration](image)

**Figure 248: PLL IP Configuration Example**

12. In the **IP Libraries** view, right-click the GPIO Bank IP and select **New IP Configuration**.

13. Configure the GPIO Bank for the top-level design using the options shown in the following image:
Configure the GPIO Bank for the top-level design using the options shown in the following image:

Figure 249: GPIO Bank IP Configuration Example

14. Click **Generate** to display the **Generate IO Ring Design Files** dialog and select **Add to active project**.

Figure 250: Generate IO Ring Design Files Dialog Example

15. Click **Finish** to generate the I/O ring design files.

16. When complete, the following files should be added to the ACE project:
Synthesize Top-Level Design Using Synplify

1. Create a new Synplify project and add all RTL files from the `<ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_top_a/src/rtl` directory.

2. Add the `pr_top_a_timing.sdc` file from the `<ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_top/src/constraints` directory.

3. Add the PR core 1A and PR core 2A blackboxes generated by ACE in the previous 2 steps as follows:
   - PR core 1A blackbox - `<ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_core_1a/ace/impl_1/output/blackboxes/pr_core_1a_bb.v`
   - PR core 2A blackbox - `<ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_core_2a/ace/impl_1/output/blackboxes/pr_core_2a_bb.v`

4. From the main menu, select `Project → Implementation Options → Device`.

5. Set `Technology` to Achronix Speedster7t.

6. Set `Part` to AC7t1500ES0.

7. Set `Package` to F53.

8. Set `Speed` to C2.

9. From the main menu, select `Project → Implementation Options → Implementation Results`.

10. Set `Result Base Name` to "pr_top_a".

11. Select `Project → Implementation Options → Verilog`.

12. Set `Top Level Module` to "pr_top_a".
13. Set Include Path Order to "<ace_install_dir>/libraries".
14. Add the AC7t1500ES0_synplify.sv file to the project from the <ace_install_dir>/libraries /device_models directory.

15. Verify that the Synplify project matches the following configuration:

![Project Hierarchy](image)

**Figure 252: Synplify Project Example**

16. Run and compile the design in Synplify.
17. When successfully completed, Synplify generates a gate-level netlist as <synplify_out_dir>/rev_1 /pr_top_a.vm.

**Run Top-Level Design Through Run Prepare in ACE**

1. Navigate to the Projects view and click the ( ) Create a New Project button.
2. Create a project using the pop-up dialog and click Finish when complete.
3. In the Projects view, click the ( ) Add Source Files to a Project button.
4. Add the following files to your project:
   - Blackbox file generated by ACE in step 1j –
     `<ace_install_dir>/examples/partial_reconfig/tutorial/AC7t1500ES0/pr_flow_1 /pr_core_1a/ace/impl_1/output/blackboxes/pr_core_1a_bb.v`
   - Blackbox file generated by ACE in step 2j –
     `<ace_install_dir>/examples/partial_reconfig/tutorial/AC7t1500ES0/pr_flow_1 /pr_core_2a/ace/impl_1/output/blackboxes/pr_core_2a_bb.v`
• Synthesized netlist created by Synplify in step 3a –
  <ace_install_dir>/examples/partial_reconfig/tutorial/AC7t1500ES0/pr_flow_1/pr_top_a/synplify/rev_1/pr_top_a.vm

5. Add all iring files created in step 3a to the project.

6. Ensure that the blackbox files pr_core_1a_bb.v and pr_core_2a_bb.v are both above the pr_top_a.vm file (click and drag the files to change the order).

7. In the Options view, navigate to the Design Preparation section and ensure that the Export All Partitions option is cleared and all other options are correctly set.

8. In the Flow view, right-click Run Prepare and select Run Selected Flow Step.

9. Ensure that the run_prepare flow step completed successfully.

Set Up Clock Pre-Routing Constraints

1. In the Partitions view, right-click the cell below the Clock Pre-Routes heading and select Configure Clock Pre-Routes as shown in the following image:

![Figure 253: Configure Clock Pre-routes Example]

2. In the Configure Clock Pre-Routes dialog, ensure that the clock net is pre-routed into the same track specified in step 1d:
3. Click OK. The Tcl Console displays the following:

```
add_clock_preroute i_clk_pr_1_ipin_net 2 -partitions (/pr_top_a/i_pr_core_1a)
```

**Set Up Region Constraints (Optional)**

1. In the Floorplanner view, navigate to the top section and click the ( ) **Placement Region Tool** button.
2. Click and drag in the Floorplanner to draw a region bounding box for the top-level logic:
Figure 255: Floorplanner Region Bounding Box Example

Note
ACE automatically creates a PR Zone for the imported partition.

3. In the Create Placement Region dialog, set Region Alignment to Snap to Fabric Clusters.
4. Set Region Type to Inclusive.
5. Clear the Is Partial Reconfiguration Zone checkbox.
Figure 256: Create Placement Region Dialog Example

6. Click Finish. The Tcl console displays the following:

```tcl
create_region "pr_top_region" (218 8 231 33) -snap fabric_clusters -type inclusive -include_routing
```

7. As before, add all instances in the PR core to the region using the `add_region_find_insts` Tcl command nested with the `find` command. `i_pr_shell` is the instance name for the top-level partial reconfigurable module:

```tcl
add_region_find_insts "pr_top_region" {find {*i_pr_shell*} -insts}
```

Run Top-Level Design Through Place-and-Route in ACE

1. In the Flow view, right-click Place and Route and select Run Selected Flow Step:
Run Final Sign-Off Timing Analysis in ACE

1. In the Flow view, right click the Design Completion step and select Run Selected Flow Step:
Generate Base Bitstream for Top-level Design

1. In the "Options" view, click the **Bitstream Generation** tab.
2. In the **FCU Configuration** section, check the **Lock FCU After Programming** checkbox:

   ![FCU Configuration Example](image)

   **Figure 259: Bitstream Generation FCU Configuration Example**

3. In the Flow view, right-click the **FPGA Programming** step and select **Run Selected Flow Step**:

   ![FPGA Programming Flow Step Example](image)

   **Figure 260: Run FPGA Programming Flow Step Example**

**Save Region/Clock Pre-Routing and Partition Placement Constraints Back to PDC File**

1. Repeat step 1g to save the placement region and clock pre-routing constraints to a pdc file.
2. In the **Partitions** view, click the (ὲ) **Save Partition Pre-Placement** button:
Figure 261: Save Partition Pre-Placement Example

3. In the **Save Partition Pre-Placement Data** dialog, ensure that the **Save Specific List of Partitions** checkbox is cleared in order to save the partition placement constraints for each partition.

![Save Partition Pre-Placement Data Dialog Example](image)

**Figure 262: Save Partition Pre-Placement Data Dialog Example**

**Generate Partial Bitstream for PR Core 1B and 2B**

**Export PR Core 1B as Partition**

1. Repeat all steps in section 1 to export PR core 1B as a partition.
PR core 1B is identical to PR core 1A except that the 32-bit adder increments by 2 instead of 1 at each NAP read.
The source files for PR core 1B are located in the following directory:

```plaintext
<ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_core_1b
/src/...
```

**Export PR Core 2B as Partition**

1. Repeat all steps in section 1 to export PR core 2B as a partition.
PR core 2B is identical to PR core 2A except that the 32-bit subtractor decrements by 2 instead of 1 at each NAP read.
The source files for PR core 2B are located in the following directory:

```plaintext
<ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_core_2b
/src/...
```
Import PR Core 1B and 2B Into Top-Level Design

1. Create an ACE Project named "pr_top_b".
2. In the Options view, set the same options used in step 3b.
3. In the Projects view, click the ( ) Add Source Files to Project button.
4. Add the following files to the project:
   - All ioring config files generated in step 3a (the I/O in pr_top_b is the same as pr_top_a so the files can be reused)
   - `<ace_install_dir>/examples/partial_reconfig/tutorial/AC7t1500ES0/pr_flow_1/pr_core_1b/ace/impl_1/output/blackboxes/pr_core_1b_bb.v` (blackbox file generated by ACE in step 4a).
   - `<ace_install_dir>/examples/partial_reconfig/tutorial/AC7t1500ES0/pr_flow_1/pr_core_2b/ace/impl_1/output/blackboxes/pr_core_2b_bb.v` (blackbox file generated by ACE in step 4b).
   - `<ace_install_dir>/examples/partial_reconfig/tutorial/AC7t1500ES0/pr_flow_1/pr_top_b/synplify/rev_1/pr_top_b.vm` (synthesized netlist created by Synplify in step 3a)
5. Ensure that the blackbox files `pr_core_1b_bb.v` and `pr_core_2b_bb.v` are both above the `pr_top_b.vm` file (drag and drop files to change the order):

![Figure 263: PR Core Source Files Example](image)

6. Run the design through "Place-and-Route" (remember to configure the clock pre-routes by repeating the step 3d).
7. Ensure that the clock nets are pre-routed on the same clock track.
Generate Partial Bitstream for PR Core 1B and 2B in Top-level Design

1. Ensure that the Place-and-Route flow step completed successfully.
2. Set the bitstream cluster mask and partial reconfiguration option for PR core 1B and 2B (set the mask for both partitions by selecting both in the **Partitions** view):

   ![Figure 264: Selecting PR Core 1B and 2B Example](image)

   - Click the button to set this implementation option. The Tcl Console displays the following:

     ```tcl
     set_impl_option bitstream_prc_cluster_map 00002100000000000000
     ```

4. In the **Options** view, click the **Bitstream Generation** tab.
5. In the **Partial Reconfiguration** section, Check the **Enable Partial Reconfiguration** checkbox.
6. Ensure that the **Partial Reconfig Cluster Map** (hex) is set to the same value as in the **Placement Regions** view:

   ![Figure 265: Partial Reconfiguration Settings Example](image)

   - In the **Options** view, click the **Bitstream Generation** tab.
8. In the **Partial Reconfiguration** section, check the **Lock FCU After Programming** checkbox:

   ![Figure 266: Partial Reconfiguration Settings Example](image)

9. Run the **FPGA Programming** flow step to generate a single partial bitstream for PR core 1B and 2B.

**Bitstream Programming Sequence**

**Apply Power to Board**

1. Apply power to the board and ensure cables are properly connected.

**Program Top-Level Base Bitstream Containing PR Core 1A and 2A**

1. Run the following commands.
   Remember that the `pr_top_a` base bitstream contains PR core 1A, 2A and the top-level logic.
1. Run the following commands.
   The scripts contain NAP reads from PR core 1A and 2A.

```
source <ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/test_scripts/read_pr_core_1a.tcl
source <ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/test_scripts/read_pr_core_2a.tcl
```

### Program Partial Bitstream for PR Core 1B and 2B

1. Run the following command.
   PR core 1B and 2B can be partially reconfigured onto the board at the same time since a single partial bitstream was generated for both PR core 1B and 2B in step 4d.

```
# Program partial bitstream
jtag::ac7t1500_program_bitstream $jtag_id <ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/pr_top_b/ace/impl_1/output/pr_top_b.hex
```

### Run PR Core 1B and 2B Test Scripts

1. Run the following commands.
   The scripts contain NAP reads from PR core 1B and 2B.

```
source <ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/test_scripts/read_pr_core_1b.tcl
source <ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_1/test_scripts/read_pr_core_2b.tcl
```

### PR Flow 2: Multi-Project PR Flow Using Keep Out Regions

**Introduction**

The Multi-project PR flow using keepout regions is an alternate method to create designs that can be partially reconfigured.

This flow involves using separate ACE projects to generate separate base and partial bitstreams for the top-level design and each PR core. On silicon, the base bitstream is programmed first. Partial bitstreams can be programmed subsequently. Using this flow, the user design is stitched together at a bitstream level. There is no integration in ACE between the the top-level design and each PR core since the designs are stitched at the bitstream level. As such, this flow has a few pitfalls and can only be recommended for advanced users.
Advantages of Using This PR Flow

- Very fast turn-around time in that the top-level design bypasses place-and-route of the PR cores requiring only a keep-out region
- Enables integrating third party accelerator cores at the bitstream level while not requiring any knowledge of the logic
- Instead of simulating the entire design together, partial bitstreams can be run/tested on the Achronix Virtual Lab which has a faster turn-around time than simulation

Possible Issues Encountered When Using This PR Flow

- The bitstream might not be stitched together correctly at the bitstream level if any of the ACE projects are configured incorrectly as in the following scenarios:
  1. In the base bitstream, clock nets to be used in the partial bitstream are not pre-routed. The clock signal is not correctly connected to the PR cores after partial reconfiguration.
  2. Clock nets are pre-routed on different clock tracks in the partial and base bitstreams. The clock signals are incorrectly connected to the PR cores after partial reconfiguration.
  3. In the base bitstream, keep-out regions are not set on clusters to be used by PR cores. The top-level logic might be lost after partial reconfiguration.

- The design might not meet timing on paths between the top-level and PR core after the partial bitstream is programmed since timing analysis is done separately in each ACE project.

  **Note**

  The timing delays on the east side are different than those on the west side of the AC7t1500ES0 device.

- Simulating the entire design within an ACE project is difficult as no integration exists between separate ACE projects. It is not impossible but requires a lot of manual work.

To avoid these issues, consider using the multi-project flow with partition export/import (PR flow 1) instead. In that flow, ACE can integrate separate projects created for both the top-level design and for each PR core by taking advantage of the partition export/import feature. This feature enables ACE to run checks to ensure that the top-level design and each PR core can be stitched together correctly. Timing can be closed and simulation run on the integrated design.

**High-level design flow**

The bottom-up flow is recommended for PR flow 2. This involves generating the partial bitstreams for each of the PR cores before generating the full bitstream for the top-level design. In the the top-level design, keep-out regions and clock pre-routes on each cluster where the PR cores are partially reconfigured, must be set. As such, it is easier to finish floor planning and generating the partial bitstream for each PR core before working on the top-level design used to create the full bitstream.

Please follow this high-level design flow carefully:

1. Partial Bitstream Generation for PR Core 1A (see page 496)
   a. Synthesize PR Core 1A Using Synplify (see page 496)
   b. Run PR Core 1A Through Run Prepare in ACE (see page 498)
   c. Set Up Region Constraints for PR Core 1A (see page 499)
   d. Set Up Clock Pre-Routing Constraints for PR Core 1A (see page 502)
   e. Run PR Core 1A Through Place-and-Route in ACE (see page 504)
f. Run Final Sign-Off Timing Analysis for PR Core 1A (see page 504)
g. Set Bitstream Cluster Mask and Partial Reconfiguration Option for PR Core 1A (see page 505)
h. Generate Partial Bitstream for PR Core 1A (see page 506)
i. Save Region and Clock Pre-Routing Constraints to PDC File (see page 507)

2. Generate Partial Bitstream for PR Cores 1B 2A and 2B (see page 508)
   a. Generate Partial Bitstream for PR Core 1B (see page 508)
   b. Generate Partial Bitstream for PR Core 2A (see page 508)
   c. Generate Partial Bitstream for PR Core 2B (see page 508)

3. Generate Full Bitstream for Top-Level Design (see page 509)
   a. Create I/O Ring Configuration for Target Board (see page 509)
   b. I/O Ring Configuration Steps (see page 509)
   c. Synthesize Top-Level Design Using Synplify (see page 515)
   d. Run Top-Level Design Through Run Prepare in ACE (see page 516)
   e. Set Up Keep Out Regions and Placement Region Constraints for Static Logic (see page 517)
   f. Set Up Clock Pre-Routing Constraints (see page 520)
   g. Run Place-and-Route in ACE for Top-Level Design (see page 521)
   h. Run Final Sign-Off Timing Analysis in ACE for Top-Level Design (see page 522)
   i. Generate Base Bitstream for Top-Level Design (see page 523)
   j. Save Placement Region and Clock Pre-Routing Constraints to PDC File (see page 523)

4. Bitstream Programming Sequence (see page 524)
   a. Apply Power to Board (see page 524)
   b. Program Top-Level Design Full Bitstream (see page 524)
   c. Program PR Core 1A Partial Bitstream (see page 524)
   d. Run PR Core 1A Test Scripts (see page 524)
   e. Program PR Core 2A Partial Bitstream (see page 524)
   f. Run PR Core 2A Test Scripts (see page 525)
   g. Program PR Core 1B Partial Bitstream (see page 525)
   h. Run PR Core 1B Test Scripts (see page 525)
   i. Program PR Core 2B Partial Bitstream (see page 525)
   j. Run PR Core 2B Test Scripts (see page 525)

Partial Bitstream Generation for PR Core 1A

Synthesize PR Core 1A Using Synplify

1. Navigate to the following directory:
   `<ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_core_1a/src`
Note

<ace_install_dir> is the directory path where ACE was installed.

Below this directory should be the following two directories:

- rtl
- constraints

2. In the rtl directory, create a new Synplify project and add all of the RTL files.
3. Add the pr_core_1a_timing.sdc file to the constraints directory.
4. In the Project → Implementation Options → Device tab, set Technology to Achronix Speedster7t.
5. Set Part to AC7t1500ES0.
6. Set Package to F53.
7. Set Speed to C2.
8. In the Project → Implementation Options → Implementation Results tab, set Result Base Name to pr_core_1a_top.
9. In the Project → Implementation Options → Verilog tab, set Top Level Module to pr_core_1a_top.
10. Set Include Path Order to <ace_install_dir>/libraries.
11. In the <ace_install_dir>/libraries/device_models directory, add the AC7t1500ES0_synplify.sv file to the project.

Run and compile the design using Synplify.

Figure 267: Project Example
12. Run and compile the design using Synplify.

13. After successful completion, Synplify generates a gate-level netlist under `<synplify_out_dir>/rev_1/pr_core_1a_top.vm`.

**Run PR Core 1A Through Run Prepare in ACE**

1. In the **Projects** view, click the ( ☐️ ) **Create a New Project** button.
2. Create a project using the pop-up dialog and click **Finish** when complete.
3. In the **Projects** view, click the ( ☐️ ) **Add Source Files to a Project** button.
4. Add the following files to your ACE project:
   - `<synplify_out_dir>/rev_1/pr_core_1a_top.vm`. *(synthesized netlist created by Synplify in step 1a)*
   - `<ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_core_1a/src/ioring_design/pr_core_1a_top_ioring.pdc`

   **Note**
   
   This file is required to generate a bitstream because all top-level core fabric pins need to be pre-placed.
   
   For partial bitstream projects, either create a dummy `.pdc` file for the top-level pins, or, use the `.pdc` file generated from the top-level design through the I/O Designer.

   - `<ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_core_1a/src/ioring_design/pr_core_1a_top_ioring.sdc`

5. In the **Options** view, navigate to the **Design Preparation** tab and make sure all options are correctly set.
6. Copy the option values shown in the following example.
7. In the **Flow** view, right click **Run Prepare** and select **Run Selected Flow Step**.
Figure 268: Run Prepare Flow Step Example

Set Up Region Constraints for PR Core 1A

1. Ensure that the run_prepare flow step has completed successfully.
2. In the Floorplanner view, click the ( ) Placement Region Tool button.
3. Click and drag on the Floorplanner to draw a PR Zone for the PR Core.
3. After releasing the left mouse button, the Create Placement Region dialogue appears.

4. In Region Name, enter a name for the PR zone.

5. Set Region Alignment to Snap to Fabric Clusters (a fabric cluster represents the lowest level of granularity at which the core fabric can be partially reprogrammed).

6. Set Region Type to Inclusive (ensures that all instances are constrained to the region).

7. Select Include Routing (ensures that all routed nets are constrained to the region).

8. Select Is Partial Reconfiguration Zone (must be selected to indicate this region is a PR Zone).
10. Click Finish. The Tcl console displays the following:

```
create_region "PR_ZONE_2_7" {32 41 48 77} -snap fabric_clusters -type inclusive -include_routing -pr_zone
```

11. Add all the instances in the PR Core to the region. A quick and recommended way of doing so is to use the `add_region_find_insts` Tcl command nested with the `find` Tcl command. Run the following example in the Tcl console to add all instances in PR Core 1A to the PR zone (i_pr_core_1a is the instance name for the top-level partial reconfigurable module).

```
add_region_find_insts "PR_ZONE_2_7" {find {*i_pr_core_1a*} -insts
```

12. In the GUI, drag the PR core 1A module in the netlist browser view to the PR_ZONE_2_7 to issue this Tcl command:

```
add_region_find_insts "PR_ZONE_2_7" {find {*i_pr_core_1a*} -insts
```

13. In the Floorplanner tab, the image should resemble the following (the red box represents the bounding box of the PR zone just created):
Set Up Clock Pre-Routing Constraints for PR Core 1A

There are several different methods for setting up clock pre-routing. For PR flow 2, the easiest way to configure clock pre-routes is to use the **Placement Regions** view.

1. In the **Placement Regions** view, right-click the box below the **Clock Pre-Routes** heading and select **Configure Clock Pre-Routes** as shown:

![Figure 271: PR Zone Bounding Box Example](image)
2. The **Configure Clock Pre-Routes** dialog appears with the `i_clk_pr_1_ipin_net` signal that drives PR core 1 clock pins pre-routed on clock track 1.

3. Click **OK**. The Tcl console displays the following:

```tcl
add_clock_preroute i_clk_pr_1_ipin_net { 1 } -placement_regions { PR_ZONE_2_7 }
```
Note
Each clock net used in the top-level design must be routed on a different clock track.

Run PR Core 1A Through Place-and-Route in ACE

1. In the Flow view, right-click the Place and Route step and select Run Selected Flow Step.

![Figure 274: Run Place and Route Flow Step Example](image)

Run Final Sign-Off Timing Analysis for PR Core 1A

1. In the Flow view, right-click Design Completion and select Run Selected Flow Step.
Set Bitstream Cluster Mask and Partial Reconfiguration Option for PR Core 1A

1. Ensure that the Design Completion flow step has run successfully.

2. In the Placement Regions view, check the Visibility checkbox for the PR_ZONE_2_7 region to be partially reconfigured (the partial reconfig cluster value is computed based on the placement regions having the Visibility item checked.

   At the bottom of the Placement Regions view, in the Partial reconfig cluster value section, the bitstream cluster mask value appears for the PR zone region created in step 1c. This value indicates which clusters are occupied by the PR zone. When the bitstream_prc_cluster_map implementation option is set to this value, a partial bitstream is generated for the clusters within the PR Zone.

3. Click the Send Tcl Command button to set this implementation option.
4. In the **Options** view, click the **Bitstream Generation** tab.

5. In the **Partial Reconfiguration** section, check the **Enable Partial Reconfiguration** checkbox and ensure that the **Partial Reconfig Cluster Map (hex)** is set to the value from the **Placement Regions** view:

   ![Placement Regions](image)

   **Figure 276: Send Tcl Command Example**

   ```
   Click to send Tcl command:
   set_impl_option bitstream_prc_cluster_map 00002000000000000000000000000000
   ```

   **Figure 277: Partial Reconfiguration Settings Example**

6. In the **FCU Reconfiguration** section, ensure that the **Lock FCU After Programming** item is checked:

   ![FCU Configuration](image)

   **Figure 278: FCU Configuration Settings Example**

**Generate Partial Bitstream for PR Core 1A**

1. In the **Flow** view, right-click the **FPGA Programming** step and select **Run Selected Flow Step**.
Save Region and Clock Pre-Routing Constraints to PDC File

Subsequent runs must use the same clock pre-routing and placement region constraints. These constraints must be saved to .pdc files and added to the ACE project.

**Warning!**

Adding .pdc files to an ACE project invalidates the flow and requires re-running the flow steps beginning with Run Prepare.

1. In the Placement Regions View, click the ( ) Save Placement Regions button:

![Figure 280: Save Placement Regions Example](image)

2. The Save Placement Regions dialog appears. Click Finish to save the PR zone region constraints:
3. The Tcl console displays the following and the placement_regions.pdc file is created.

```tcl
create_region "PR_ZONE_2_7" {32 41 48 77} -snap fabric_clusters -type inclusive -include_routing -pr_zone
add_region_find_insts "PR_ZONE_2_7" {find {*i_pr_core_1a*} -insts
```

4. ACE automatically generates a clock pre-route file to the output area under <ace_output_dir>/ace/impl_1/output/pr_core_1a_top_clock_preroutes.pdc.

**Note**

This file should not be added to the ACE project as it is regenerated during each run. Make a copy of this file before adding it to the project.

Alternately, use the `save_clock_preroute` Tcl command to generate a .pdc file with the clock pre-route constraints.

**Generate Partial Bitstream for PR Cores 1B 2A and 2B**

**Generate Partial Bitstream for PR Core 1B**

1. Repeat the same steps used in section 1 to generate the partial bitstream for PR Core 1 but use the following file:
   - `<ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_core_1a`

**Generate Partial Bitstream for PR Core 2A**

1. Repeat the same steps used in section 1 to generate the partial bitstream for PR Core 1 but use the following file:
   - `<ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_core_2a`

**Generate Partial Bitstream for PR Core 2B**

1. Repeat the same steps used in section 1 to generate the partial bitstream for PR Core 1 but use the following file:
Generate Full Bitstream for Top-Level Design

Create I/O Ring Configuration for Target Board

In this design, a simple clock input is driving a PLL to create clocks for the core fabric. Also, a simple GPIO interface to display LEDs is in the top-level design.

I/O Ring Configuration Steps

1. In the IP Libraries view, under IO Ring, right-click Clock I/O Bank and select New IP Configuration.

2. Configure the Clock I/O Bank for the PR Cores using the options shown in the following example:
3. In the **IP Libraries** view, under **IO Ring**, right-click the PLL and select **New IP Configuration**.

4. Configure the PLL for the PR core using the options shown in the following example:
4. In the **IP Libraries** view, under **IO Ring**, right-click **NoC** and select **New IP Configuration**.

5. Configure the 2D NoC IP for the PR Core using the options shown in the following example:

![Figure 284: SW PLL IP Configuration Example](image)

6. In the **IP Libraries** view, under **IO Ring**, right-click **NoC** and select **New IP Configuration**.

7. Configure the Clock I/O Bank for the top-level design using the options shown in the following example:

![Figure 285: 2D NoC IP Configuration Example](image)
8. In the IP Libraries view, under IO Ring, right-click PLL and select New IP Configuration.
9. Configure the PLL for the top-level design using the options shown in the following example:

![Figure 286: NE Clock I/O Bank IP Configuration Example](image)
### NE PLL IP Configuration Example

11. In the **IP Libraries** view, under **IO Ring**, right-click **GPIO Bank** and select **New IP Configuration**.

12. Configure the GPIO Bank for the top-level design using the options shown in the following example:
12. Click **Generate** to display the Generate IO Ring Design Files dialog and select **Add to active project**: 

![Generate IO Ring Design Files Dialog Example](image)

**Figure 289: Generate IO Ring Design Files Dialog Example**

13. Click **Finish** to generate the I/O ring design files.

14. When complete, the following files should be added to the ACE project:
Synthesize Top-Level Design Using Synplify

1. Navigate to the following directory:
   `<ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_top/src`
   Below this directory should be the following two directories:
   - rtl
   - constraints

2. Create a new Synplify project and add all RTL files from the `rtl` directory.

3. Add the `pr_top_timing.sdc` file from the `constraints` directory

4. In the `Project → Implementation Options → Device` tab, set `Technology` to Achronix Speedster7t.

5. Set `Part` to AC7t1500ES0.

6. Set `Package` to F53.

7. Set `Speed` to C2.

8. In the `Project → Implementation Options → Implementation Results` tab, set `Result Base Name` to `pr_top`.

9. In the `Project → Implementation Options → Verilog` tab, set `Top Level Module` to `pr_top`.

10. Set `Include Path Order` to `<ace_install_dir>/libraries`.

11. Add the `AC7t1500ES0_synplify.sv` file from the following directory:
    - `<ace_install_dir>/libraries/device_models`

---

**Figure 290: I/O Ring Design Files**
12. Run and compile the design using Synplify.

13. When the compile completes successfully, Synplify generates a gate-level netlist in the file:
   `<synplify_out_dir>/rev_1/pr_top.vm`.

Run Top-Level Design Through Run Prepare in ACE

1. In the Projects view, click the (هما) **Create a New Project** button.
2. Create a project using the pop-up dialog and click **Finish** when complete.
3. In the Projects view and click the (هما) **Add Source Files to a Project** button.
4. Add the following files to the ACE project:
   - All the ioring files created in step 3
   - `<synplify_out_dir>/rev_1/pr_top.vm` (synthesized netlist created by Synplify in step 3)
5. In the Options view, select **Design Preparation** and make sure all options are correctly set.
6. Copy the option values in the following example:
In the Flow view, right-click the Run Prepare step and select Run Selected Flow Step.

**Set Up Keep Out Regions and Placement Region Constraints for Static Logic**

Keep out regions must be created in order to define “holes” in the core fabric that the top-level logic should not enter. These holes are later filled by partial reconfiguration bitstreams.

1. Ensure that the Run Prepare flow step has completed successfully.
2. In the Floorplanner view, click the ( ) Placement Region Tool button.
3. Click and drag in the Floorplanner to draw a PR Zone for the PR Core.

**Note**
The bounding box of this keep out region must be the same as the one set for PR core 1A in section 1d.
3. After releasing the left mouse button, the Create Placement Region dialog appears.

4. Set Region Alignment to Snap to Fabric Clusters.

5. Set Region Type to Keepout.

**Note**

The bounding box of this region has to match that of the PR Zone for PR Core 1A created in step 1c.
6. Repeat steps 2 through 6 to create a keep out region for the PR zone for PR core 2A.

8. Optionally, create a region for the top-level logic. The floorplanner view should resemble the following example after performing these steps:
Red region – keep out region for PR core 1A.
Light blue region – keep out region for PR core 2A.
Yellow region – region for top-level logic.

**Figure 294: Create Placement Region Dialog Example**
Set Up Clock Pre-Routing Constraints

1. In the Placement Regions view, right-click the box below the Clock Pre-Routes heading and select Configure Clock Pre-Routes:

   ![Configure Clock Pre-Routes Example](image)

2. The Configure Clock Pre-Routes dialog appears.

3. Ensure that the clock net is pre-routed into the same track specified in step 1d.
3. Repeat steps 1 and 2 above to route the clock net for PR core 2 to the PR core 2A keep out region.

The Tcl Console displays the following:

```
add_clock_preroute i_clk_pr_2_ipin_net { 2 } -placement_regions { PR_ZONE_7_6 }
```

4. Click OK. The Tcl Console displays the following:

```
add_clock_preroute i_clk_pr_1_ipin_net { 1 } -placement_regions { PR_ZONE_2_7 }
```

5. Repeat steps 1 and 2 above to route the clock net for PR core 2 to the PR core 2A keep out region.

6. The Tcl Console displays the following:

```
add_clock_preroute i_clk_pr_2_ipin_net { 2 } -placement_regions { PR_ZONE_7_6 }
```

**Run Place-and-Route in ACE for Top-Level Design**

1. In the Flow view, right-click the Place and Route step and select Run Selected Flow Step.
Run Final Sign-Off Timing Analysis in ACE for Top-Level Design

1. Ensure that the Place and Route flow step completed successfully.
2. In the Flow view, right-click the Design Completion step and select Run Selected Flow Step.
Generate Base Bitstream for Top-Level Design

1. Ensure that the Design Completion flow step completed successfully.
2. In the Flow view, right-click the FPGA Programming step and select Run Selected Flow Step.
3. Ensure that the Enable Partial Reconfiguration option is NOT selected in order to create a base bitstream.

![Flow View](image)

Figure 300: Run FPGA Programming Flow Step Example

4. In the Options view, click the Bitstream Generation tab.
5. Scroll down to the Partial Reconfiguration section and ensure that the Lock FCU After Programming item is checked.

![Bitstream Generation Options](image)

Figure 301: Lock FCU After Programming Option Example

Save Placement Region and Clock Pre-Routing Constraints to PDC File

1. Repeat the steps in section 1i to save the region and clock pre-routing and placement region constraints to a .pdc file.
**Bitstream Programming Sequence**

**Apply Power to Board**

1. Apply power to the board and ensure cables are properly connected.

**Program Top-Level Design Full Bitstream**

1. Run the following commands.

```bash
set jtag_id [jtag::get_connected_devices]
jtag::open $jtag_id
jtag::configure_scan_chain $jtag_id AC7t1500ES0 0 0 0 -single_device
jtag::ac7t1500_initialize_fcu $jtag_id -reset
jtag::ac7t1500_program_bitstream $jtag_id <ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_top/ace/impl_1/output/pr_top.hex
```

**Program PR Core 1A Partial Bitstream**

1. Run the following commands.

```bash
#Program partial bitstream
jtag::ac7t1500_initialize_fcu $jtag_id
jtag::ac7t1500_program_bitstream $jtag_id <ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_core_1a/ace/impl_1/output/pr_core_1a.hex
```

**Run PR Core 1A Test Scripts**

1. Run the following command.
   The script contains NAP reads from PR core 1A.

```bash
source <ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/test_scripts/read_pr_core_1a.tcl
```

**Program PR Core 2A Partial Bitstream**

1. Run the following commands.

```bash
#Program partial bitstream
jtag::ac7t1500_initialize_fcu $jtag_id
jtag::ac7t1500_program_bitstream $jtag_id <ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_core_2a/ace/impl_1/output/pr_core_2a.hex
```
Run PR Core 2A Test Scripts

1. Run the following command.
   The script contains NAP reads from PR core 2A.

   ```
   source <ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/test_scripts/read_pr_core_2a.tcl
   ```

Program PR Core 1B Partial Bitstream

1. Run the following commands.

   ```
   #Program partial bitstream
   jtag::ac7t1500_initialize_fcu $jtag_id
   jtag::ac7t1500_program_bitstream $jtag_id <ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_core_1b/ace/impl_1/output/pr_core_1b.hex
   ```

Run PR Core 1B Test Scripts

1. Run the following command.
   The script contains NAP reads from PR core 1B.

   ```
   source <ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/test_scripts/read_pr_core_1b.tcl
   ```

Program PR Core 2B Partial Bitstream

1. Run the following commands.

   ```
   #Program partial bitstream
   jtag::ac7t1500_initialize_fcu $jtag_id
   jtag::ac7t1500_program_bitstream $jtag_id <ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/pr_core_2b/ace/impl_1/output/pr_core_2b.hex
   ```

Run PR Core 2B Test Scripts

1. Run the following command.
   The script contains NAP reads from PR core 2B.

   ```
   source <ace_install_dir>/examples/partial_reconfiguration/tutorial/AC7t1500ES0/pr_flow_2/test_scripts/read_pr_core_2b.tcl
   ```
Chapter - 4: Tcl Command Reference

The Tcl commands supported by ACE are broken into three subsets in this document:

- The **SDC Commands** (see page 526), timing constraints which are also supported by upstream tools like Synplify. These commands are used in the SDC project constraints files.
- The **Interactive Timing Commands** (see page 545), which are used to interact with the ACE STA timer. The commands are not constraints and can be used interactively in the ACE Tcl console.
- The **ACE Tcl Commands** (see page 551), which are unique to ACE.

**SDC Commands**

The following are the Tcl commands which are used to define timing constraints in both ACE and upstream tools like Synplify.

### all_clocks

#### all_clocks

**Returns a collection of all clocks in the design.**

**Description**

The `all_clocks` command will return a list of all of the clocks that have already been defined using either `create_clock` or `create_generated_clock`. It is often used in SDC files as an argument to commands that need a list of all of the clocks.

**Example**

To set all of the clocks to have the same setup timing uncertainty value, enter:

```
cmd> set_clock_uncertainty -setup .05 [all_clocks]
```

**Also See**

- `create_clock`
- `create_generated_clock`
- `get_clocks`
- `set_clock_uncertainty`

### all_inputs

#### all_inputs

**Returns a collection of all input ports (ports marked “in” and “inout”) at the top level of the design.**

**Description**

The `all_inputs` command returns a list of all of the input ports in the design. It is sometimes used as a command line argument to other SDC commands when a list of all of the input ports are needed.
Example

To set all of the inputs to have the same minimum input delay from the same clock, enter:

```
cmd> set_input_delay -min .01 [all_inputs] -clock clk
```

Also See

set_input_delay

all_outputs

Returns a collection of all output ports (ports marked "out" and "inout") at the top level of the design.

Description

The `all_outputs` command returns a list of all of the output ports in the design. It is sometimes used as a command line argument to other SDC commands when a list of all of the output ports are needed.

Example

To set output delay constraint to all outputs with respect to the same clock, enter:

```
cmd> set_output_delay -min .01 [all_outputs] -clock clk
```

Also See

set_output_delay

create_clock

```create_clock [<clock>] [-period <string>] [-name <string>] [-waveform <list>]
```

Define a clock

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[&lt;clock&gt;]</td>
<td>Y</td>
<td>nets, ports or pins (as 'inst/pin')</td>
</tr>
<tr>
<td>[-period &lt;string&gt;]</td>
<td>Y</td>
<td>clock period in ns (required)</td>
</tr>
<tr>
<td>[-name &lt;string&gt;]</td>
<td>Y</td>
<td>alternate name</td>
</tr>
<tr>
<td>[-waveform &lt;list&gt;]</td>
<td>Y</td>
<td>list of edges for clock rise and fall timings in the period</td>
</tr>
</tbody>
</table>

Description

The `create_clock` command is the main SDC constraint input to static timing analysis. In its simplest form it can define a clock and its associated period. This definition is used by the timer to start timing paths. The timing paths will take one of four possible paths:
1. Traverse from a `create_clock` statement, through the clock IPIN, through the clock tree to a source DFF/LRAM/BRAM clock pin, through the source device, through the whatever logic is between the source, to the capture logic or `set_output_delay` constraint.

2. Traverse from the `create_clock` statement, through a `set_input_delay` constraint defined on a given port, through the path from that port to the DFF/LRAM/BRAM data input pin. These paths are often referred to as I/O timing paths, and specifically, input timing paths.
   
   a. A `create_clock` statement can also be used strictly for IO timing, and not actually be placed and routed in the design. These are often refereed to as "virtual clocks".

3. Sometimes a `create_clock` statement will be assigned to an input port that will traverse to a data input pin of a DFF. If this is done, the arrival time of the rising and falling edges will be separated in time by the definitions of the first asserted edge and deasserted edge of the clock.

Example

To define a clock on an input clock port and assign it a period of 2 ns, enter:

```shell
<cmd> create_clock -period 2 [get_ports clock_in[0]]
```

To define a clock with a non-default (50/50) duty cycle, the `create_clock` `-waveform` option can be used:

```shell
set clock_period 10
set clock_asserted_edge 0
set clock_deasserted_edge [expr $clock_period / 5]
create_clock -name my_clock_name -period $clock_period -waveform "$clock Asserted Edge $clock Deasserted Edge" [get_ports my_clock_port_name]
```

To define a virtual clock you must use the `-name` option so that the clock name can be referenced by other SDC commands. Otherwise, the `-name` option is optional.

```shell
create_clock -name virtual_my_clock -period 10
```

The `virtual_my_clock` can then be used in IO timing constraints to define the arrival time of data at input ports based on a clock that will not have any design specific latency:

```shell
set_input_delay 1 -clock virtual_my_clock [get_ports i_user_data*]
```

Also See

`create_generated_clock`
`get_ports`
`report_clock_properties`
`report_clocks`
`report_checks`
`set_clock_latency`
`set_clock_groups`
`set_clock_uncertainty`
`set_input_delay`
set_output_delay

create_generated_clock

create_generated_clock <clock> [-source <string>] [-divide_by <int>] [-multiply_by <int>] [-name <string>]

Define a generated clock

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;clock&gt;</td>
<td></td>
<td>nets or pins (as 'inst/pin')</td>
</tr>
<tr>
<td>[-source &lt;string&gt;]</td>
<td>Y</td>
<td>(required argument) master clock source pin</td>
</tr>
<tr>
<td>[-divide_by &lt;int&gt;]</td>
<td>Y</td>
<td>factor</td>
</tr>
<tr>
<td>[-multiply_by &lt;int&gt;]</td>
<td>Y</td>
<td>factor</td>
</tr>
<tr>
<td>[-name &lt;string&gt;]</td>
<td>Y</td>
<td>alternate name for the generated clock</td>
</tr>
</tbody>
</table>

Description

The create_generated_clock defines a clock which is applied to an output pin of an instance, internal to the design, or an output port of the design. This SDC command must follow a previously defined create_clock definition, of which the port used to define that create_clock statement would be used as the argument to the -source option. There must be a valid timing path between the source clock node and the generated clock node, so that latency between these two nodes can be calculated. A generated clock can have one of three characteristics of the source clock:

1. The same period as the source clock (-divide_by 1)
2. A period less than the source clock (-divide_by integer value greater than 1)
3. A period greater than the source clock (-multiply_by integer value greater than 1)

The generated clock will typically have a positive latency (delay) from the source clock as there is typically logic between the source clock and the generated clock. Therefore, the arrival time of a generated clock pin at a clock leaf node is calculated taking into account the latency from the source clock to the generated clock, plus the latency of the logic between the generated clock node and the generated clock leaf pin in the timing path. If frequency division is done (-divide_by or -multiply_by) than the deasserted edge and the second asserted edge of the generated clock's arrival times will be adjusted to the period calculated by the specified -multiply_by or -divide_by the respective values.

Example

To create a generated clock on an top level output port in a design, which is derived from a top level input port where the path is non-inverting and not divided, the following can be used:

create_generated_clock [get_ports o_user_clkout_001_003] -name out_clk -divide_by 1 -source [get_ports i_user_clkin_001_003]

Also See

create_clock
get_ports
report_clock_properties
report_clocks
report_checks
set_clock_groups
set_clock_latency
set_clock_uncertainty

get_cells
get_cells pattern

Returns a collection of cells (instances) in the design. All cell names match the specified pattern. Wildcards may be used to select multiple cells at once.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pattern</td>
<td></td>
<td>The required &lt;pattern&gt; option is used to filter returned node names (string pattern is matched using Tcl string matching)</td>
</tr>
</tbody>
</table>

Description

The `get_cells` command can be use in conjunction with other SDC commands when those commands need a list of cell instance names as input. It accepts the use of the `***` wildcard will return a list of all cell instance names that match.

Example

To get all cell instances with the string "reg" in their name, enter:

```
get_cells *reg*
```

The output of the `get_cells` command can be passed to other commands, such as `set_multicycle_path`:

```
set_multicycle_path -from [get_cells top.*my_module.module_reg*] -setup -end 2
```

Also See

`set_multicycle_path`

`set_false_path`

get_clocks
get_clocks patterns [-nocase]

Returns a collection of clocks in the design. All clock names in the collection match the specified pattern. Wildcards may be used to select multiple clocks at once.
The required `<patterns>` option is used to filter returned node names (string patterns are matched using Tcl string matching).

The optional `-nocase` option specifies the matching of node names to the patterns should be case-insensitive.

### Description

The `get_clocks` command can be used after the `create_clock` command is used to define clocks. Additionally, if the `create_generated_clock` command is used, the `get_clocks` command will include them as well. The `get_clocks` command is used to get a sub-set of what would be returned by the `all_clocks` command. Typically, this command is used in conjunction with other SDC commands when a specific clock or specific group of clocks is needed as a command line argument.

### Example

To get all of the clocks with the string "in" in their name, enter:

```bash
get_clocks *in*
```

To define clock to clock relationships, such as an asynchronous relationships between two clocks the following can be done:

```bash
set_clock_groups -asynchronous -group [get_clocks system_clock] -group [get_clocks test_clk]
```

### Also See

- `create_clock`
- `create_generated_clock`
- `report_clock_properties`
- `report_clocks`
- `set_clock_groups`
- `set_clock_latency`
- `set_clock_uncertainty`

### get_fanout

`get_fanout [-flat] [-endpoints_only] [-only_cells] [-from <string>]`

Returns a collection of pins in the fanout of specified objects in the design.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>[-flat]</code></td>
<td>Y</td>
<td>Without this option, only pins at the same hierarchy level as the sinks are returned. With the option, pins in the fanout at any hierarchy level are returned.</td>
</tr>
</tbody>
</table>
### Argument Description

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-endpoints_only]</td>
<td>Y</td>
<td>Only return pins that are endpoints.</td>
</tr>
<tr>
<td>[-only_cells]</td>
<td>Y</td>
<td>Return the instances connected to the pins in the fanout.</td>
</tr>
<tr>
<td>[-from &lt;string&gt;]</td>
<td>Y</td>
<td>List of pins, ports, or nets to find the fanout of. For nets, the load pins on the nets are returned.</td>
</tr>
</tbody>
</table>

#### get_nets

get_nets pattern

Returns a collection of nets in the design. All net names in the collection match the specified pattern. Wildcards may be used to select multiple nets at once.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pattern</td>
<td></td>
<td>The required &lt;pattern&gt; option is used to filter returned node names (string pattern is matched using Tcl string matching)</td>
</tr>
</tbody>
</table>

#### Description

The `get_nets` command can be use in conjunction with other SDC commands when those commands need a list of net names as input. It accepts the use of the "*" wildcard will return a list of all net names that match.

#### Example

To get all nets that have a name containing the string "data" and ending with "[0]", enter:

```
get_nets *data*[0]
```

To define a false path through a net the following command style can be used:

```
set_multicycle_path 2 -setup -through [get_nets *reset_sync_n] -to [get_clocks sys_clk]
```

#### Also See

- create_generated_clock
- get_clocks
- set_false_path
- set_multicycle_path

### get_pins

get_pins pattern

Returns a collection of pins in the design. All pin names match the specified pattern. Wildcards may be used to select multiple pins at once.
<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pattern</td>
<td>Optional</td>
<td>The required &lt;pattern&gt; option is used to filter returned node names (string pattern is matched using Tcl string matching)</td>
</tr>
</tbody>
</table>

**Description**

The `get_pins` command can be used in conjunction with other SDC commands when those commands need a list of cell instance pin names as input. It accepts the use of the `**` wildcard will return a list of all net names that match.

**Example**

In order to define a pin as an argument to another SDC command such as `create_generated_clock`, you can do the following, where the pin "clk_out" of the CLKDIV instance "sub-module top.first_sub_module.second_sub_module" is the location of the generated clock:

```
create_generated_clock -divide_by 2 [get_pins top.first_sub_module.second_sub_module/clk_out]
```

Likewise, the same method can be used for any SDC command that takes a pin argument:

```
set_multicycle_path -from [get_pins top.first_sub_module/*reg*/q] -to [get_pins top.second_sub_module/*reg*/d] -setup 4
```

**Also See**

- `create_generated_clock`
- `set_false_path`
- `set_multicycle_path`

**get_ports**

get_ports pattern

Returns a collection of ports (design inputs and outputs) in the design. All port names match the specified pattern. Wildcards may be used to select multiple ports at once.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pattern</td>
<td>Optional</td>
<td>The required &lt;pattern&gt; option is used to filter returned node names (string pattern is matched using Tcl string matching)</td>
</tr>
</tbody>
</table>

**Description**

The `get_ports` command can be used in conjunction with other SDC commands when those commands need a list of top level port names as input. It accepts the use of the `**` wildcard will return a list of all ports names that match.
Example
To get all ports with the string "[0]" in their name, enter:

```
get_ports *[0]*
```

This command can also be used in an argument of other SDC commands that take a port and input. One of the most common is in the definition of a clock as it comes into the design:

```
create_clock -period 0.9 [get_ports {sys_clk}]
```

Also See
create_clock
create_generated_clock
set_false_path
set_input_delay
set_multicycle_path
set_output_delay

set_clock_groups

```
set_clock_groups [-name <string>] [-group <list>] [-asynchronous]
```

Define clock groups. With one -group, the clocks in that group have a false_path from/to all other clocks. With multiple -group options, the clocks in each group have a false_path from/to the clocks in the other groups. The groups have no meaning outside this command.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-name &lt;string&gt;]</td>
<td>Y</td>
<td>Name of clock group</td>
</tr>
<tr>
<td>[-group &lt;list&gt;]</td>
<td>Y</td>
<td>set of clocks</td>
</tr>
<tr>
<td>[-asynchronous]</td>
<td>Y</td>
<td>clocks are unrelated (default)</td>
</tr>
</tbody>
</table>

Description

The set_clock_groups command is defined in the SDC files after the create_clock and create_generated_clock statements have been defined. This command can be used to quickly define asynchronous relationships between clocks. This methodology replaced the older set_false_path based STA/SDC description methodology and is more efficient to write the SDC as well as enabling the timer to be more efficient.

Example
To assume a design has clocks system_clock and test_clk are asynchronous to all other clocks, enter:

```
set_clock_groups -asynchronous -group [get_clocks system_clock] -group [get_clocks test_clk]
```
This command specifies that A1 and B are unrelated to C. For instance, a path between A2 and C will not be timed. A path between A1 and A2, on the other hand, will be timed (unless there are other commands specifying a false path between them).

```
set_clock_groups -asynchronous -group [get_clocks A B] -group [get_clocks C]
```

Also See

create_clock
create_generated_clock
get_clocks
report_checks
set_false_path

set_clock_latency

```
```

Set latency of clock network

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>delay</td>
<td></td>
<td>delay_value</td>
</tr>
<tr>
<td>port_pin_list</td>
<td></td>
<td>port_pin_list (one or more ports)</td>
</tr>
<tr>
<td>[-clock &lt;string&gt;]</td>
<td>Y</td>
<td>clock list</td>
</tr>
<tr>
<td>[-rise]</td>
<td>Y</td>
<td>rise</td>
</tr>
<tr>
<td>[-fall]</td>
<td>Y</td>
<td>fall</td>
</tr>
<tr>
<td>[-min]</td>
<td>Y</td>
<td>min</td>
</tr>
<tr>
<td>[-max]</td>
<td>Y</td>
<td>max</td>
</tr>
<tr>
<td>[-late]</td>
<td>Y</td>
<td>late</td>
</tr>
<tr>
<td>[-early]</td>
<td>Y</td>
<td>early</td>
</tr>
<tr>
<td>[-source]</td>
<td>Y</td>
<td>source</td>
</tr>
</tbody>
</table>

Description

The `set_clock_latency` command is used to describe the arrival time of a clock at the top level port where it is defined using the `create_clock` command. The off-design latency of the clock will modify the timing of the IO logic. The impact of this can be seen in `report_checks` reports of IO timing where it will be reflected on both the reference clock path as well as the input data arrival times. It is common for there to be more than one `set_clock_latency` definitions for each clock in order to model the off design latency of the clock for both edges of the clock as well as the
early and late arrival times of the clock. Care should be taken to ensure that early and late arrival times, which model the range of arrival times that can occur due to off design events such as crosstalk or varying paths to the clock input port, are not replicated (double counted) in the use of the `set_clock_uncertainty` command.

**Example**

In order to define off chip clock latency, which will impact clock to IO and clock to other clock timing, use the following command, for "late" arriving clock edges at the port where the `acx_sc_i_user_clkin_000_001[0]_1` clock is defined:

```
set_clock_latency -source -late -rise 0.169006 [get_clocks acx_sc_i_user_clkin_000_001[0]_1]
```

**Also See**

- `create_clock`
- `get_clocks`
- `report_clock_properties`
- `report_clocks`
- `report_checks`
- `set_clock_uncertainty`

**set_clock_uncertainty**

```
```

Set uncertainty of clock network

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;uncertainty&gt;</code></td>
<td></td>
<td>clock uncertainty in ns</td>
</tr>
<tr>
<td><code>&lt;objects&gt;</code></td>
<td>Y</td>
<td>one or more clocks, ports, or pins</td>
</tr>
<tr>
<td><code>-from &lt;string&gt;</code></td>
<td>Y</td>
<td>source clock</td>
</tr>
<tr>
<td><code>-to &lt;string&gt;</code></td>
<td>Y</td>
<td>destination clock</td>
</tr>
<tr>
<td><code>-setup</code></td>
<td>Y</td>
<td>uncertainty applies to setup check</td>
</tr>
<tr>
<td><code>-hold</code></td>
<td>Y</td>
<td>uncertainty applies to hold check</td>
</tr>
</tbody>
</table>

**Description**

⚠️ **Caution!**

The `set_clock_uncertainty` command must be used with either the `<objects>` option or a pair of `-from` and `-to` options.

The `set_clock_uncertainty` command is generally used to model off design PLL jitter. This jitter is typically defined as "cycle to cycle" jitter, meaning that for one asserted edge to the next asserted edge there is some amount of +/-...
"uncertainty" in the arrival time of the second asserted edge. This uncertainty is used to shorten (-) the clock insertion delay to a capture device in setup paths, and to increase the clock insertion delay to a capture device in hold timing paths. Since setup timing is typically measured from the first asserted edge to the next asserted edge, this PLL jitter based clock uncertainty is directly applicable. However, typically hold timing is done with respect to the same clock edge. Therefore, the set_clock_uncertainty command has both -setup and -hold options to enable the user to use different constraint values as the -hold value is not modeling PLL jitter, but instead can be used to add general timing guard band, which is typically referred to as modeling "known unknowns" as well as "unknown unknowns". The values of these constraints work in conjunction with the values defined in both the create_clock definitions, as well as the set_clock_latency values.

Care should be taken to ensure that uncertainty defined in those other constraint commands are not duplicated in the set_clock_uncertainty command. The effect that set_clock_uncertainty has on timing is global. All timing paths, both core and IO, will be impacted by this constraint and will be visible in the report_checks reports in the capture or "reference" clock timing path on the "clock uncertainty" line. For setup paths, the value will be subtracted from the clock arrival time, and for hold timing the value will be added to the clock arrival time.

Example

To model PLL cycle to cycle jitter specification of 0.02nS for all of the clocks, the following command can be used:

```markdown
set_clock_uncertainty -setup .02 [all_clocks]
```

To define extra hold timing guard band the following command can be used:

```markdown
set_clock_uncertainty -hold .005 [all_clocks]
```

Also See

all_clocks
create_clock
create_generated_clock
report_clock_properties
report_clocks
report_checks
set_clock_latency

set_data_check

```
set_data_check value [-clock <string>] [-setup] [-hold] [-from <string>] [-to <string>]
```

Set data-to-data check values of setup and hold

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>value</td>
<td></td>
<td>check value</td>
</tr>
<tr>
<td>[-clock &lt;string&gt;]</td>
<td>Y</td>
<td>clock</td>
</tr>
<tr>
<td>[-setup]</td>
<td>Y</td>
<td>setup</td>
</tr>
</tbody>
</table>
### Description

The `set_data_check` command can be used to add timing constraint between two data signals arriving to different pins /ports. This added timing constraint is analogous to the standard setup/hold timing constraints between a clock and data modeled for a DFF/LRAM/BRAM, but in this case the `-from` related pins is defined as the reference or clock pin, and the `-to` related pin is the data pin. The command supports unique `-setup` and `-hold` values, but if neither `-setup` nor `-hold` options are used, the values are applied only to setup. Often this command is used to define "data skew" which is typically defined as a +/- delta between data bus arrival times. Therefore, both the `-setup` and `-hold` options must be used, in different command instantiations, to define one data bit in a bus as the reference to N number of other data bits. Both the `-from` pin and the `-to` pin must be singular. For a bus that is 16 bits wide, there needs to be 15 constraints.

The `-from` and `-to` nodes defined in these commands must have existing valid timing paths to them for the `set_data_check` command to function. Therefore, if these constraints are applied to output ports, there must also be a `set_output_delay` constraint applied to them. Additionally, if both `-setup` and `-hold` data checks are to be performed, there must be both `-min` and `-max` `set_output_delay` constraints defined.

### Example

In order to constrain the delay between two or more data pins, such as a "data skew" constraint, the following command can be used. This will define both a setup and hold timing relationship between the reference pin name and all of the other pin names.

```tcl
set_data_check -from [get_pins top.sub-module.instance1/reference_pin_name] -to [get_pins top.sub-module.instance1/another_pin_name] .1
```

If more than one clock can drive a signal to the `-from` related pin, than the command can be made more specific by using the `-clock` options.

```tcl
set_data_check -from [get_pins top.sub-module.instance1/pin_name] -to [get_pins top.sub-module.instance1/another_pin_name] .1 -clock [get_clocks my_clock]
```

To model a data skew constraint, a Tcl loop such as this can be used:

```tcl
set first_port 0
set plus_minus_constraint 0.05
foreach port_name [get_ports dout_gpio[*]] {  
    if ( $first_port == 0 ) {incr first_port;set reference_port $port_name;continue}  
    set_data_check -from $reference_port -to $port_name $plus_minus_constraint -hold  
    set_data_check -from $reference_port -to $port_name $plus_minus_constraint -setup  
}
```

### Also See

get_pins
set_disable_timing

set_disable_timing <objects> [-from <string>] [-to <string>]

Disable timing arcs in a circuit

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;objects&gt;</td>
<td></td>
<td>one or more instances, ports, or pins</td>
</tr>
<tr>
<td>[-from &lt;string&gt;]</td>
<td>Y</td>
<td>input pin name of instance &lt;object&gt;</td>
</tr>
<tr>
<td>[-to &lt;string&gt;]</td>
<td>Y</td>
<td>output pin name of instance &lt;object&gt;</td>
</tr>
</tbody>
</table>

Description

The `set_disable_timing` command is typically used to disable an existing timing arc. This is somewhat analogous to `set_false_path`, but with a much more limited scope. The `set_disable_timing` command requires a `-from` and a `-to` option to be used together, to bound the scope of its effect. Often, this command is used to break timing loops from an input pin to an output pin of the same cell instance. The pin names used in the `-from` and `-to` options must be just the pin name, as found in the cell library.

Example

In order to break all of the timing arcs for an instance (top.sub-module.instance1), the following command can be used:

```
set_disable_timing [get_cells top.sub-module.instance1]
```

To break a given timing arc between two pins of a given cell instance, the following can be done:

```
set_disable_timing -from input_pin_name -to input_pin_name [get_cells top.sub-module.instance1]
```

Also See

get_cells

set_false_path

set_false_path

set_false_path [-from <list>] [-to <list>] [-through <list>]

Define a false path exception (this declares that the clocks are unrelated)

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-from &lt;list&gt;]</td>
<td>Y</td>
<td>from_list (one or more clocks)</td>
</tr>
</tbody>
</table>
Description

The `set_false_path` command is used to create "timing exception" to the general STA paradigm that all timing paths are analyzed as a one cycle setup and zero cycle hold timing path. Another timing exception syntax is `set_multicycle_path` and the user must be sure if a path is truly never used, or if it is a multicycle path. Timing paths that are analyzed by STA, but found to not be valid for whatever reason can be removed from the analysis by using the `set_false_path` statement. This command has several options, and can define very wide ranging paths so care should always be taken to limit the scope of the these commands in order to ensure that only the paths known to be false are affected by these commands. To enable users to focus these statements on a finite number of paths there is syntax to define the path start point (`-from`), path intermediate points (`-through`) as well as path end points (`-to`). It is advisable to be as explicit in the timing path definition as possible to ensure that real or valid timing paths are not being suppressed. Often the process of defining timing exceptions is like "peeling an onion". The timing typically only shows the "worst case path", so as you eliminate that path, the next-worst path becomes the new worst case path. Therefore, the most effective timing exceptions are typically constructed after all of the timing paths have been validated and all of the resulting exceptions combined to minimize the number of exceptions.

The definition of the path can be very narrow or very broad depending on how it is constructed. Each statement can contain only one `-from` and one `-to` statement, but each of them can reference many "from" nodes and many "to" nodes. If there are more than one node for these, all combinations apply. All "from" nodes are applied to all "to" nodes. Additionally, the `-through` option can have multiple nodes defined in it. Each of the `-through` nodes apply independently so if a path goes through any of the matching nodes it applies. However, multiple `-through` statements can be used in series with each other. They are order dependent, so `-through a` and `-through b` implies that the path must first go through "a" and then go through "b". If the `-through` command has multiple nodes in it, than that one statement is define as an 'OR'; `-through a -through b c` `-through d` implies that the path must go through "a" and then go through either "b" or "c", and then go through "d".

Example

In order to remove a timing path between an "instance/clock pin name" to an "instance/input pin" from being analyzed by the timer, the following command can be used:

```bash
set_false_path -from [get_pins top.module1.reg_instance_name/clock_pin_name] -through [get_nets some_applicable_net] -to [get_pins top.module2.instance_name/input_pin_name]
```

In order to remove all timing from a given timing node such as an input port, the following can be done:

```bash
set_false_path -from [get_ports my_port_which_I_do_not_want_to_time]
```

A false path can also be define `-through a net`, as well as instances and pins:

```bash
set_false_path -through [get_nets my_net_of_interest_name]
```

Also See

`get_pins`
get_ports
get_nets
set_multicycle_path

**set_input_delay**

```
```

Specify an input delay constraint or clock

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>delay</td>
<td></td>
<td>delay_value</td>
</tr>
<tr>
<td>port_pin_list</td>
<td></td>
<td>port_pin_list (one or more ports)</td>
</tr>
<tr>
<td>[-clock &lt;string&gt;]</td>
<td>Y</td>
<td>clock_name</td>
</tr>
<tr>
<td>[-rise]</td>
<td>Y</td>
<td>rise</td>
</tr>
<tr>
<td>[-fall]</td>
<td>Y</td>
<td>fall</td>
</tr>
<tr>
<td>[-max]</td>
<td>Y</td>
<td>max</td>
</tr>
<tr>
<td>[-min]</td>
<td>Y</td>
<td>min</td>
</tr>
<tr>
<td>[-add_delay]</td>
<td>Y</td>
<td>add delay</td>
</tr>
<tr>
<td>[-clock_fall]</td>
<td>Y</td>
<td>delay with reference to falling edge of clock</td>
</tr>
</tbody>
</table>

**Description**

The `set_input_delay`, as well as the `set_output_delay` command, is fundamental to validating the correctness of a design's timing. It is defined after the clocks are define and it references the related clock using the `-clock` option. Typically, there will be four (4) definitions of `set_input_delay` for each data/clock combination, at each timing corner. The arrival time of the data at its design input port is relative to this clock's arrival time. Therefore, the `set_clock_latency` constraint will impact the arrival time of data related to that clock. The value of the `set_input_delay` constraint is used in the timing path which receives the data signal. This value can be seen in a `report_checks` report in the data path section under "input external delay".

**Example**

In order to constrain a design's input port, an arrival time for a signal at the input port, relative to the asserted edge of a specified clock, for both min and max data path timing, as well as having different values for rise and fall edges, can be defined using this command:

```
set_input_delay .1 -rise -max -clock [get_clocks my_clock_name] [get_ports my_input_port_name]
set_input_delay .13 -fall -max -clock [get_clocks my_clock_name] [get_ports my_input_port_name]
set_input_delay .05 -rise -min -clock [get_clocks my_clock_name] [get_ports my_input_port_name]
set_input_delay .055 -fall -min -clock [get_clocks my_clock_name] [get_ports my_input_port_name]
```
Also See
create_clock
get_clocks
get_ports
report_checks
set_clock_latency
set_output_delay

set_input_transition

set_input_transition slew port_pin_list [-clock <string>]
Specify an input slew/transition constraint

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>slew</td>
<td></td>
<td>slew_value</td>
</tr>
<tr>
<td>port_pin_list</td>
<td></td>
<td>port_pin_list (one or more ports)</td>
</tr>
<tr>
<td>[-clock &lt;string&gt;]</td>
<td>Y</td>
<td>clock_name</td>
</tr>
</tbody>
</table>

set_load

set_load load port_pin_list
Specify an output load/capacitance constraint

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>load</td>
<td></td>
<td>cap_value</td>
</tr>
<tr>
<td>port_pin_list</td>
<td></td>
<td>port_pin_list (one or more ports)</td>
</tr>
</tbody>
</table>

set_max_delay

set_max_delay delay [-from <list>] [-to <list>] [-through <list>]
Set a maximum delay for a path

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>delay</td>
<td></td>
<td>delay</td>
</tr>
<tr>
<td>[-from &lt;list&gt;]</td>
<td>Y</td>
<td>from_list (one or more clocks)</td>
</tr>
<tr>
<td>[-to &lt;list&gt;]</td>
<td>Y</td>
<td>to_list (one or more clocks)</td>
</tr>
<tr>
<td>[-through &lt;list&gt;]</td>
<td>Y</td>
<td>through_list (one or more clocks)</td>
</tr>
</tbody>
</table>
set_min_delay

set_min_delay delay [-from <list>] [-to <list>] [-through <list>]

Set a minimum delay for a path

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>delay</td>
<td></td>
<td>delay</td>
</tr>
<tr>
<td>[-from &lt;list&gt;]</td>
<td>Y</td>
<td>from_list (one or more clocks)</td>
</tr>
<tr>
<td>[-to &lt;list&gt;]</td>
<td>Y</td>
<td>to_list (one or more clocks)</td>
</tr>
<tr>
<td>[-through &lt;list&gt;]</td>
<td>Y</td>
<td>through_list (one or more clocks)</td>
</tr>
</tbody>
</table>

set_multicycle_path

set_multicycle_path multiplier [-setup] [-hold] [-start] [-end] [-from <list>] [-to <list>] [-through <list>]

Define multicycle path

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>multiplier</td>
<td></td>
<td>integer path multiplier</td>
</tr>
<tr>
<td>[-setup]</td>
<td>Y</td>
<td>Use the specified path multiplier for setup/max delay calculations. This is the default behavior</td>
</tr>
<tr>
<td>[-hold]</td>
<td>Y</td>
<td>Use the specified path multiplier for hold/min delay calculations</td>
</tr>
<tr>
<td>[-start]</td>
<td>Y</td>
<td>Use the start/source clock period in the calculations. This is the default behavior for hold checks</td>
</tr>
<tr>
<td>[-end]</td>
<td>Y</td>
<td>Use the end/target clock period in the calculations. This is the default behavior for setup checks</td>
</tr>
<tr>
<td>[-from &lt;list&gt;]</td>
<td>Y</td>
<td>list of path startpoints containing clock, primary input/inout port, sequential-cell instance, clock pin of sequential-cell instance, or pin with input delay constraint</td>
</tr>
<tr>
<td>[-to &lt;list&gt;]</td>
<td>Y</td>
<td>list of path endpoints containing clock, primary output/inout port, sequential-cell instance, data pin of sequential-cell instance, or pin with output delay constraint</td>
</tr>
<tr>
<td>[-through &lt;list&gt;]</td>
<td>Y</td>
<td>list of pins, ports, nets that the path must pass through</td>
</tr>
</tbody>
</table>

Description

The set_multicycle_path command is used to create "timing exception" to the general STA paradigm that all timing paths are analyzed as a one cycle setup and zero cycle hold timing path. Another timing exception syntax is set_false_path and the user must be sure if a path is truly used but in more than one cycle, or never used. Timing paths that are analyzed by STA, but found to not be only valid on more than one cycle, for whatever reason, can have it's analysis adjusted by using the set_multicycle_path statement. This command has several options, and can define very wide ranging paths so care should always be taken to limit the scope of the these commands in order to ensure that
only the paths known to be false are affected by these commands. To enable users to focus these statements on a finite number of paths there is syntax to define the path start point (-from), path intermediate points (-through) as well as path end points (-to). It is advisable to be as explicit in the timing path definition as possible to ensure that real or valid timing paths are not being suppressed. Often the process of defining timing exceptions is like "peeling an onion". The timing typically only shows the "worst case path", so as you eliminate that path, the next-worst path becomes the new worst case path. Therefore, the most effective timing exceptions are typically constructed after all of the timing paths have been validated and all of the resulting exceptions combined to minimize the number of exceptions.

The definition of the path can be very narrow or very broad depending on how it is constructed. Each statement can contain only one -from and one -to statement, but each of them can reference many "from" nodes and many "to" nodes. If there are more than one node for these, all combinations apply. All "from" nodes are applied to all "to" nodes. Additionally, the -through option can have multiple nodes defined in it. Each of the -through nodes apply independently so if a path goes through any of the matching nodes it applies. However, multiple -through statement can be used in series with each other. They are order dependent, so ' -through a' and ' -through b' implies that the path must first go through "a" and then go through "b". If the -through command has multiple nodes in it, then that one statement is define as an 'OR'; ' -through a -through b c -through d' implies that the path must go through "a" and then go through either "b" or "c", and then go through "d".

Example

To change the default STA one cycle timing paradigm for all paths between two DFFs, to being a two cycle path, the following can be done:

```
set_multicycle_path 2 -from [get_pins top.sub_module_name.register_name/ck] -to [get_pins top.
some_module_name.some_register_name/q] -setup
```

It is important to understand, that the changing of the default one cycle path for setup, usually requires a modification from the default zero (0) cycle hold timing constraint (but not always). In this case, the hold timing is changed to be a one (1) cycle hold check:

```
set_multicycle_path 1 -from [get_pins top.sub_module_name.register_name/ck] -to [get_pins top.
some_module_name.some_register_name/q] -hold
```

Also See

get_pins

set_output_delay

```
set_output_delay delay port_pin_list [-clock <string>] [-rise] [-fall] [-max] [-min] [-
add_delay] [-clock_fall]
```

Specify an output delay constraint or clock

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>delay</td>
<td></td>
<td>delay_value</td>
</tr>
<tr>
<td>port_pin_list</td>
<td></td>
<td>port_pin_list (one or more ports)</td>
</tr>
<tr>
<td>[-clock &lt;string&gt;]</td>
<td>Y</td>
<td>clock_name</td>
</tr>
<tr>
<td>[-rise]</td>
<td>Y</td>
<td>rise</td>
</tr>
</tbody>
</table>
## Argument Description

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-fall]</td>
<td>Y</td>
<td>fall</td>
</tr>
<tr>
<td>[-max]</td>
<td>Y</td>
<td>max</td>
</tr>
<tr>
<td>[-min]</td>
<td>Y</td>
<td>min</td>
</tr>
<tr>
<td>[-add_delay]</td>
<td>Y</td>
<td>add delay</td>
</tr>
<tr>
<td>[-clock_fall]</td>
<td>Y</td>
<td>delay with reference to falling edge of clock</td>
</tr>
</tbody>
</table>

### Description

The `set_output_delay`, as well as the `set_input_delay` command, is fundamental to validating the correctness of a design’s timing. It is defined after the clocks are defined and it references the related clock using the `-clock` option. Typically, there will be four (4) definitions of `set_output_delay` for each data/clock combination, at each timing corner. The required time of the data at its design output port is relative to this clock’s arrival time. Therefore, the `set_clock_latency` constraint will impact the required time of data related to that clock. The value of the `set_output_delay` constraint is used in the timing path which drives the output data signal. This value can be seen in a `report_checks` report in the data path section under "output external delay".

### Example

In order to constrain a design’s output port, a required time for a signal at the output port, relative to the asserted edge of a specified clock, can be defined using this command:

```plaintext
set_output_delay 1.1 -rise -max -clock [get_clocks my_clock_name] [get_ports my_output_port_name]
set_output_delay 1.3 -fall -max -clock [get_clocks my_clock_name] [get_ports my_output_port_name]
set_output_delay 0.05 -rise -min -clock [get_clocks my_clock_name] [get_ports my_output_port_name]
set_output_delay 0.055 -fall -min -clock [get_clocks my_clock_name] [get_ports my_output_port_name]
```

### Also See

- `get_ports`
- `get_clocks`
- `report_checks`
- `set_clock_latency`
- `set_output_delay`

### Interactive Timing Commands

These commands are used to query the ACE Static Timing Analyzer (STA) interactively, from the ACE command prompt. To use these commands, interactive timer mode must be enabled by calling `prepare_sta` (see page 547). To exit interactive timer mode, call `reset_st` (see page 550). While in interactive timer mode, regular ACE commands remain available, but the placement and routing of the design should not be changed.
check_setup

The check_setup command performs sanity checks on the design. Individual checks can be performed with the keywords. If no check keywords are specified all checks are performed.

Command Syntax


Table 149: Command-line Options for check_setup

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-verbose</td>
<td>✓</td>
<td>Show offending objects rather than just error counts.</td>
</tr>
<tr>
<td>-unconstrained_endpoints</td>
<td>✓</td>
<td>Check path endpoints for timing constraints (timing check or set_output_delay).</td>
</tr>
<tr>
<td>-multiple_clock</td>
<td>✓</td>
<td>Check register/latch clock pins for multiple clocks.</td>
</tr>
<tr>
<td>-no_clock</td>
<td>✓</td>
<td>Check register/latch clock pins for a clock.</td>
</tr>
<tr>
<td>-no_input_delay</td>
<td>✓</td>
<td>Check for inputs that do not have a set_input_delay command.</td>
</tr>
<tr>
<td>-no_output_delay</td>
<td>✓</td>
<td>Check for outputs that do not have a set_output_delay command.</td>
</tr>
<tr>
<td>-loops</td>
<td>✓</td>
<td>Check for combinational logic loops.</td>
</tr>
<tr>
<td>-generated_clocks</td>
<td>✓</td>
<td>Check that generated clock source pins have been defined as clocks.</td>
</tr>
<tr>
<td>&gt; filename</td>
<td>✓</td>
<td>Write output to file.</td>
</tr>
<tr>
<td>&gt;&gt; filename</td>
<td>✓</td>
<td>Append output to file.</td>
</tr>
</tbody>
</table>
Example
To check the effectiveness of the timing constraint to fully constrain all of the design's timing endpoints, the `check_setup` command can be run after `run_prepare`:

The following generates standard output summarizing any checks that violate:

```
check_setup
```

The following reports only a summary of the "unconstrained endpoints":

```
check_setup -unconstrained_endpoints
```

The following will create an "check_setup.rpt" file, and will indicate all of the information available for each violations:

```
check_setup -unconstrained_endpoints -verbose > check_setup.rpt
check_setup -multiple_clock -verbose >> check_setup.rpt
check_setup -no_clock -verbose >> check_setup.rpt
check_setup -no_input_delay -verbose >> check_setup.rpt
check_setup -no_output_delay -verbose >> check_setup.rpt
check_setup -loops -verbose >> check_setup.rpt
check_setup -generated_clocks -verbose >> check_setup.rpt
```

**prepare_stata**
The `prepare_stata` command prepares the ACE Static Timing Analyzer (STA) for interactive use. This step is required before other interactive timer commands can be used. Typically, `prepare_stata` is only used after place and route. If the netlist, or the placement or routing, is modified, run this command again before interactive timing commands are used.

**Command Syntax**
```
prepare_stata (-slowc | -fastc) [-unconstrained]
```

**Table 150: Command-line Options for prepare_stata**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-slowc</td>
<td></td>
<td>Use delays for the slow timing corner. This option is often used for verifying setup time requirements. (1)</td>
</tr>
<tr>
<td>-fastc</td>
<td></td>
<td>Use delays for the fast timing corner. This option is often used for verifying hold time requirements. (1)</td>
</tr>
<tr>
<td>-unconstrained</td>
<td>✓</td>
<td>Enable reporting of unconstrained paths.</td>
</tr>
</tbody>
</table>

**Table Notes**
1. Exactly one timing corner must be specified.
Example
To change the Tcl interface to be in STA interactive mode to analyze the slow timing arcs, enter the following from the ACE Tcl window, while in the ACE Tcl interface mode:

```
prepare_sta -slowc
```

When ACE is in STA "slowc" mode, to look at the fast timing arcs, enter the following:

```
reset_sta
prepare_sta -fastc
```

report_checks
The `report_checks` command reports the timing results for paths in the design.

**Command Syntax**

```
```

**Table 151: Command Line Options for report_checks**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-from &lt;list&gt;</td>
<td>✓</td>
<td>Report only paths starting at the specified objects: clocks, instances, ports, or pins.</td>
</tr>
<tr>
<td>-to &lt;list&gt;</td>
<td>✓</td>
<td>Report only paths ending at the specified objects: clocks, instances, ports, or pins.</td>
</tr>
<tr>
<td>-rise_to &lt;list&gt;</td>
<td>✓</td>
<td>Report only paths ending rising edge at the specified objects: clocks, instances, ports, or pins.</td>
</tr>
<tr>
<td>-fall_to &lt;list&gt;</td>
<td>✓</td>
<td>Report only paths ending falling edge at the specified objects: clocks, instances, ports, or pins.</td>
</tr>
<tr>
<td>-path_delay &lt;min,max&gt;</td>
<td>✓</td>
<td>The type of timing analysis. Currently only max (for setup analysis) and min (for hold time analysis) are supported. The default is max.</td>
</tr>
<tr>
<td>-group_count &lt;int&gt;</td>
<td>✓</td>
<td>The maximum number of paths to report, per clock group.</td>
</tr>
<tr>
<td>-endpoint_count &lt;int&gt;</td>
<td>✓</td>
<td>The number of paths to report per endpoint (default 1).</td>
</tr>
<tr>
<td>-through &lt;list&gt;</td>
<td>✓</td>
<td>Report only paths through the specified objects: instances, pins, or nets.</td>
</tr>
</tbody>
</table>
### Argument Table

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-rise_through &lt;list&gt;</td>
<td>✓</td>
<td>Report only paths through a rising edge at the specified objects: instances, pins, or nets.</td>
</tr>
<tr>
<td>-fall_through &lt;list&gt;</td>
<td>✓</td>
<td>Report only paths through a falling edge at the specified objects: instances, pins, or nets.</td>
</tr>
<tr>
<td>-slack_max &lt;float&gt;</td>
<td>✓</td>
<td>Report only paths with slack less than this number.</td>
</tr>
<tr>
<td>-slack_min &lt;float&gt;</td>
<td>✓</td>
<td>Report only paths with slack larger than this number.</td>
</tr>
<tr>
<td>-sort_by_slack</td>
<td>✓</td>
<td>Sort paths by slack across all path groups rather than by slack grouped for each path group (default).</td>
</tr>
<tr>
<td>-path_group &lt;list&gt;</td>
<td>✓</td>
<td>Report only paths in these groups.</td>
</tr>
<tr>
<td>-format &lt;type&gt;</td>
<td>✓</td>
<td>Specifies which format to report for each path. [end, full, short, summary].</td>
</tr>
<tr>
<td>-fields &lt;list&gt;</td>
<td>✓</td>
<td>Report extra fields to the path report: List of input_pins</td>
</tr>
<tr>
<td>-digits &lt;int&gt;</td>
<td>✓</td>
<td>Number of digits to print after the decimal point.</td>
</tr>
<tr>
<td>-no_line_split</td>
<td>✓</td>
<td>Do not break long lines.</td>
</tr>
<tr>
<td>-unconstrained</td>
<td>✓</td>
<td>Report unconstrained paths.</td>
</tr>
<tr>
<td>&gt; filename</td>
<td>✓</td>
<td>Write output to file.</td>
</tr>
<tr>
<td>&gt;&gt; filename</td>
<td>✓</td>
<td>Append output to file.</td>
</tr>
</tbody>
</table>

### report_clock_properties

The `report_clock_properties` command reports the clock defined for the timer in the design.

#### Command Syntax

```
report_clock_properties
```
Table 152: Command-line Options for report_clock_properties

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; filename</td>
<td>✓</td>
<td>Write output to file.</td>
</tr>
<tr>
<td>&gt;&gt; filename</td>
<td>✓</td>
<td>Append output to file.</td>
</tr>
</tbody>
</table>

Example

```shell
cmd> report_clock_properties

Clock  Period  Waveform
------------------------
clk[0] 2.500  0.000  1.250
clk[1] 2.500  0.000  1.250
clk[2] 2.500  0.000  1.250
clk[3] 2.500  0.000  1.250
clk[4] 2.500  0.000  1.250
clk[5] 2.500  0.000  1.250
clk[6] 2.500  0.000  1.250
clk[7] 2.500  0.000  1.250
clk[8] 2.500  0.000  1.250
clk[9] 2.500  0.000  1.250
```

reset_sta

The reset_sta command exits interactive timer mode. This command should be used before changing placement or routing, otherwise the STA might use stale data.

**Command Syntax**

```shell
reset_sta
```

**Example**

When in ACE interactive timing mode (slowc or fastc), to run non-timing related commands, enter the following:

```shell
cmd> reset_sta
```
To switch from interactive timing mode (slowc) to (fastc), enter the following:

```
reset_sta
prepare Sta -fastc
```

**ACE Tcl Commands**

The following commands are used only within ACE. These are not available within Synplify, etc.

### add_clock_preroute

```
add_clock_preroute <net_name> <track_list> [-clock_regions <list>] [-clusters <list>] [-placement_regions <list>] [-partitions <list>] [-data_region]
```

This command will take a clock or reset net, and constrain it to be routed it over the clock tracks specified into the clock regions, fabric clusters, partition bounding boxes, or placement regions depending on what the user specifies.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;net_name&gt;</code></td>
<td></td>
<td>The name of the clock or reset net to be pre-routed.</td>
</tr>
<tr>
<td><code>&lt;track_list&gt;</code></td>
<td></td>
<td>The list of integer clock track numbers to pre-route this net on. Valid clock track numbers are device-specific.</td>
</tr>
<tr>
<td><code>-clock_regions &lt;list&gt;</code></td>
<td>Y</td>
<td>The list of clock region names to pre-route this net into. Valid clock region names are device-specific.</td>
</tr>
<tr>
<td><code>-clusters &lt;list&gt;</code></td>
<td>Y</td>
<td>The list of cluster names to pre-route this net into. Valid cluster names are device-specific.</td>
</tr>
<tr>
<td><code>-placement_regions &lt;list&gt;</code></td>
<td>Y</td>
<td>The list of placement region names to pre-route this net into. Valid placement region names are device-specific.</td>
</tr>
<tr>
<td><code>-partitions &lt;list&gt;</code></td>
<td>Y</td>
<td>The list of partition names to pre-route this net into. Valid partition are device-specific.</td>
</tr>
<tr>
<td><code>-data_region</code></td>
<td></td>
<td>The -data_region option is only valid for non-clock nets. You can optionally use -data_region to route the net using region resources. &quot;data_center&quot; is applied by default if this option isn't used.</td>
</tr>
</tbody>
</table>

### add_project_constraints

```
add_project_constraints <file> [-project <string>] [-corner <string>] [-temperature <string>] [-voltage <string>]
```

This command adds a link to an SDC, PDC, or TCL constraint file to a project.
Argument | Optional | Description
---|---|---
<file> |  | The required <file> argument is used to specify the file path to the SDC, PDC, or TCL constraint file.
[-project <string>] | Y | The optional -project <projectName> option is used to specify an alternate project (by name) for the SDC constraint file to be added to.
[-corner <string>] | Y | The optional -corner <corner> option is used to mark an SDC constraints file (containing only delays) as being applicable only to the given process corner. Valid values are "fast" and "slow".
[-temperature <string>] | Y | The optional -temperature <temp> option is used to mark an SDC constraints file (containing only delays) as being applicable only to the given temperature corner. Valid values are device-specific and must match a value from the junction_temperature impl option list.
[-voltage <string>] | Y | The optional -voltage <v> option is used to mark an SDC constraints file (containing only delays) as being applicable only to the given core voltage corner. Valid values are device-specific and must match a value from the core_voltage impl option list.

After a project has been created, you can point to a constraint file (SDC or PDC) using the following command. In this example, there is an existing file located at ..\constraints/top.sdc:

```
add_project_constraints -project [get_active_project] "../constraints/top.sdc"
```

Also See

create_project
get_active_project

add_project_ip

add_project_ip <list_of_files> [-project <string>]

This command associates one or more IP settings files with a project.

Argument | Optional | Description
---|---|---
<list_of_files> |  | The required <list_of_files> argument is used to specify the file paths to the IP settings files. The file paths may be absolute, or may be relative to the acxprj file's directory.
[-project <string>] | Y | The optional -project <projectName> option is used to specify an alternate project (by name) for the IP settings file to be added to. The named project must already be opened in ACE.

add_project_netlist

add_project_netlist <file> [-project <string>] [-impl <string>]

This command adds a link to a verilog netlist file to a project.
### Argument | Optional | Description
---|---|---
<file> |  | The required <file> argument is used to specify the file path to the verilog netlist.

[-project <string>] | Y | The optional -project <projectName> option is used to specify an alternate project (by name) for the verilog netlist to be added to.

[-impl <string>] | Y | The optional -impl <implName> options is used to select an alternate netlist for a different impl, i.e. due to varied synthesis tools or options.

---

#### add_region_find_insts

`add_region_find_insts <region> <find_command> [-flops_only] [-clocks_only] [-include_constants] [-batch] [-verbose]`

Add user design instances to a placement region constraint using a find command

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;region&gt;</td>
<td></td>
<td>Name of the region</td>
</tr>
<tr>
<td>&lt;find_command&gt;</td>
<td></td>
<td>Find command used to get list of user design instances</td>
</tr>
<tr>
<td>[-flops_only]</td>
<td>Y</td>
<td>When adding instances, filter out all instances except flops</td>
</tr>
<tr>
<td>[-clocks_only]</td>
<td>Y</td>
<td>When adding instances, filter out all instances with no connected clock</td>
</tr>
<tr>
<td>[-include_constants]</td>
<td>Y</td>
<td>When adding instances, do not filter out power/ground constants</td>
</tr>
<tr>
<td>[-batch]</td>
<td>Y</td>
<td>Postpone application of this constraint until apply_placement is called (this avoids frequent GUI updates). This option is only relevant if you manually apply placement constraints after the design has been prepared.</td>
</tr>
<tr>
<td>[-verbose]</td>
<td>Y</td>
<td>Print additional command status messages.</td>
</tr>
</tbody>
</table>

---

#### add_region_insts

`add_region_insts <region> <insts> [-flops_only] [-clocks_only] [-include_constants] [-batch] [-verbose]`

Add user design instances to a placement region constraint

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;region&gt;</td>
<td></td>
<td>Name of the region</td>
</tr>
<tr>
<td>Argument</td>
<td>Optional</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>&lt;insts&gt;</td>
<td></td>
<td>List of user design instances</td>
</tr>
<tr>
<td>[-flops_only]</td>
<td>Y</td>
<td>When adding instances, filter out all instances except flops</td>
</tr>
<tr>
<td>[-clocks_only]</td>
<td>Y</td>
<td>When adding instances, filter out all instances with no connected clock</td>
</tr>
<tr>
<td>[-include_constants]</td>
<td>Y</td>
<td>When adding instances, do not filter out power/ground constants</td>
</tr>
<tr>
<td>[-batch]</td>
<td>Y</td>
<td>Postpone application of this constraint until apply_placement is called (this avoids frequent GUI updates). This option is only relevant if you manually apply placement constraints after the design has been prepared.</td>
</tr>
<tr>
<td>[-verbose]</td>
<td>Y</td>
<td>Print additional command status messages.</td>
</tr>
</tbody>
</table>

**apply_highlights**

apply_highlights [-insts] [-nets] [-paths]

This command updates the GUI with highlighting information on the present design.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-insts]</td>
<td>Y</td>
<td>Update highlighting of all instances in the design</td>
</tr>
<tr>
<td>[-nets]</td>
<td>Y</td>
<td>Update highlighting of all nets in the design</td>
</tr>
<tr>
<td>[-paths]</td>
<td>Y</td>
<td>Update highlighting of all paths in the design</td>
</tr>
</tbody>
</table>

**apply_placement**

apply_placement [-batch] [-defparams] [-partition]

Apply batched pre-placement commands

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-batch]</td>
<td>Y</td>
<td>Specifies that placement should be applied from batched placement commands</td>
</tr>
<tr>
<td>[-defparams]</td>
<td>Y</td>
<td>Specifies that placement should be applied from defparams</td>
</tr>
<tr>
<td>[-partition]</td>
<td>Y</td>
<td>Specifies that placement should be applied on partition anchor instances before calling move_partition</td>
</tr>
</tbody>
</table>

**check_project_status**

check_project_status
This command checks if any project source files have changed since running the prepare flow step on the active implementation. If the source files are consistent, no message is printed. Otherwise, warnings are printed for each out of sync file.

**clean_project**

clean_project [-project <string>] [-impl_names <list>]

This command deletes output files from multiple implementations on the file system. The implementations' output directories on the file system are not deleted.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; option is used to specify an alternate project (by name) from which the implementations' output files will be removed. If no projectName is specified, the active project will be used by default.</td>
</tr>
<tr>
<td>[-impl_names &lt;list&gt;]</td>
<td>Y</td>
<td>The optional -impl_names &lt;list&gt; argument is used to specify the names of the implementations to remove. If no list is specified, the output files for all implementations under the project will be deleted.</td>
</tr>
</tbody>
</table>

**clear_arcs**

clear_arcs [-id <int>]

This command allows you to clear a custom arc or all the arcs on the GUI's Floorplanner view.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-id &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -id &lt;id&gt; option specifies a unique id for a single arc to clear. If this option is not used, all arcs will be cleared.</td>
</tr>
</tbody>
</table>

**clear_drawing**

clear_drawing

This command clears the current custom drawing on the GUI's Floorplanner view.

**clear_flow**

clear_flow

This command clears user design DB and the completion status of all flow steps.

**clear_lines**

clear_lines [-id <int>]

This command allows you to clear a custom line or all the lines on the GUI's Floorplanner view.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-id &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -id &lt;id&gt; option specifies a unique id for a single line to clear. If this option is not used, all lines will be cleared.</td>
</tr>
</tbody>
</table>
clear_ovals

clear_ovals [-id <int>]

This command allows you to clear a custom oval or all the ovals on the GUI's Floorplanner view.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-id &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -id &lt;id&gt; option specifies a unique id for a single oval to clear. If this option is not used, all ovals will be cleared.</td>
</tr>
</tbody>
</table>

clear_polygons

clear_polygons [-id <int>]

This command allows you to clear a custom polygon or all the polygons on the GUI's Floorplanner view.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-id &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -id &lt;id&gt; option specifies a unique id for a single polygon to clear. If this option is not used, all polygons will be cleared.</td>
</tr>
</tbody>
</table>

clear_rectangles

clear_rectangles [-id <int>]

This command allows you to clear a custom rectangle or all the rectangles on the GUI’s Floorplanner view.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-id &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -id &lt;id&gt; option specifies a unique id for a single rectangle to clear. If this option is not used, all rectangles will be cleared.</td>
</tr>
</tbody>
</table>

clear_strings

clear_strings [-id <int>]

This command allows you to clear a custom string or all the strings on the GUI’s Floorplanner view.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-id &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -id &lt;id&gt; option specifies a unique id for a single string to clear. If this option is not used, all strings will be cleared.</td>
</tr>
</tbody>
</table>

clock_info


Return information from the clock database. If a domain is specified, by default the name of the domain is returned. If no domain is specified, by default a list of domains is returned. Options may modify the type of value that is returned.
<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-domain &lt;string&gt;]</td>
<td>Y</td>
<td>specifies name of domain</td>
</tr>
<tr>
<td>[-pin &lt;string&gt;]</td>
<td>Y</td>
<td>use the domain of this pin</td>
</tr>
<tr>
<td>[-net &lt;string&gt;]</td>
<td>Y</td>
<td>use the domain of this net</td>
</tr>
<tr>
<td>[-all]</td>
<td>Y</td>
<td>even report uninteresting domains</td>
</tr>
<tr>
<td>[-unique]</td>
<td>Y</td>
<td>use a unique domain for domains with the same frequency</td>
</tr>
<tr>
<td>[-multi]</td>
<td>Y</td>
<td>with -net or -pin: report a list of domains instead of a single domain</td>
</tr>
<tr>
<td>[-freq]</td>
<td>Y</td>
<td>return the frequency (MHz); requires a domain</td>
</tr>
<tr>
<td>[-period]</td>
<td>Y</td>
<td>return the period (ps); requires a domain</td>
</tr>
<tr>
<td>[-phase]</td>
<td>Y</td>
<td>return the phase; requires a domain</td>
</tr>
<tr>
<td>[-edge_type]</td>
<td>Y</td>
<td>1 for pos-edge, -1 for neg-edge, 0 for combinational; requires a domain</td>
</tr>
<tr>
<td>[-routing_props]</td>
<td>Y</td>
<td>list of strings denoting the routing properties (if set); requires a domain</td>
</tr>
<tr>
<td>[-core]</td>
<td>Y</td>
<td>1 if used in the core, otherwise 0; or list of domains used in core</td>
</tr>
<tr>
<td>[-driver]</td>
<td>Y</td>
<td>name of the driving pin or port; requires a domain</td>
</tr>
<tr>
<td>[-clock_net]</td>
<td>Y</td>
<td>name of the clock net; requires a domain</td>
</tr>
<tr>
<td>[-is_clock]</td>
<td>Y</td>
<td>true if net is a clock net; requires a pin or net</td>
</tr>
<tr>
<td>[-info]</td>
<td>Y</td>
<td>list as for 'array set'; requires a domain</td>
</tr>
<tr>
<td>[-equal]</td>
<td>Y</td>
<td>list of domains with same frequency; requires a domain</td>
</tr>
<tr>
<td>[-names]</td>
<td>Y</td>
<td>list of all names for the domain; requires a domain</td>
</tr>
<tr>
<td>[-sdc]</td>
<td>Y</td>
<td>return list of sdc commands</td>
</tr>
</tbody>
</table>

**clock_relation**

clock_relation <domain1> <domain2> [-default] [-group] [-sdc]

Return relation between clocks. For related clocks the return is a list with 5 values: the word "related" followed by T1 T2 e1 e2. T is the abstract period: T1/T2 = period1/period2. e is an abstract offset (in the same units as T). By default the numbers are as small as possible, but with -group all related clocks use the same units.
<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;domain1&gt;</td>
<td></td>
<td>first domain</td>
</tr>
<tr>
<td>&lt;domain2&gt;</td>
<td></td>
<td>second domain</td>
</tr>
<tr>
<td>[-default]</td>
<td>Y</td>
<td>apply current default_relation rule</td>
</tr>
<tr>
<td>[-group]</td>
<td>Y</td>
<td>values are in group units</td>
</tr>
<tr>
<td>[-sdc]</td>
<td>Y</td>
<td>return list of sdc commands</td>
</tr>
</tbody>
</table>

create_boundary_pins

create_boundary_pins <name> <boundary_pin_names> [-clock] [-data] [-purpose <string>]

This command instantiates IPIN/OPINs at the Core/IO Ring boundary

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;name&gt;</td>
<td></td>
<td>A reference to a net in the design where the boundary pins should be inserted (&lt;p:toplevel_portname&gt;</td>
</tr>
<tr>
<td>&lt;boundary_pin_names&gt;</td>
<td></td>
<td>A list of one or more instance names for the boundary pins to be inserted on the given net</td>
</tr>
<tr>
<td>[-clock]</td>
<td>Y</td>
<td>Create a clock pin even if the specified net is a data net</td>
</tr>
<tr>
<td>[-data]</td>
<td>Y</td>
<td>Create a data pin even if the specified net is a clock net</td>
</tr>
<tr>
<td>[-purpose &lt;string&gt;]</td>
<td>Y</td>
<td>Set the PURPOSE property on the created boundary pin instances. Legal values are: 'USER' (the default), 'JTAG', 'CFG'.</td>
</tr>
</tbody>
</table>

create_equivalent_regions

create_equivalent_regions <source>

Create non-overlapping placement regions which have the same tiles in the same order as the provided <source>

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;source&gt;</td>
<td></td>
<td>Name of the source. May be a region or a partition name.</td>
</tr>
</tbody>
</table>

create_flow_step


This command creates a flow step definition, which is basically a wrapper around an existing command or script that manages flow status and dependencies.
<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;id&gt;</td>
<td></td>
<td>The required &lt;id&gt; string argument specifies the identifier of the flow step to create. The &lt;id&gt; argument must be unique among all flow step ids in ACE.</td>
</tr>
<tr>
<td>&lt;label&gt;</td>
<td></td>
<td>The required &lt;label&gt; argument specifies the label string to display in the GUI for this flow step. The label should be as short as possible.</td>
</tr>
<tr>
<td>[-command &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -command &lt;command&gt; option specifies the TCL command to run when this flow step is invoked.</td>
</tr>
<tr>
<td>[-parent_id &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -parent_id &lt;parentId&gt; option specifies the flow step id of an existing flow step (which does not have a command of its own) that this new flow step will be grouped under in the flow hierarchy.</td>
</tr>
<tr>
<td>[-required]</td>
<td>Y</td>
<td>The optional -required option specifies whether or not this flow step is required for further processing of the flow. If this option is not used, the user may optionally enable or disable this flow step for use in running the flow with run_flow.</td>
</tr>
<tr>
<td>[-skip_for_eval_mode]</td>
<td>Y</td>
<td>The optional -skip_for_eval_mode option specifies whether or not this flow step will be skipped when flow_mode is set to evaluation.</td>
</tr>
<tr>
<td>[-offset &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -offset &lt;offset&gt; option specifies the position (as a positive integer) under the parent flow step (or top level) at which this flow step should be inserted. Without this option, the flow step will be appended to the end of the flow steps under the parent flow step (or top level).</td>
</tr>
<tr>
<td>[-description &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -description &lt;description&gt; option specifies the description text to display in the GUI for this flow step.</td>
</tr>
</tbody>
</table>

**create_impl**

create_impl <implName> [-project <string>] [-copy] [-not_active]

This command creates a new implementation in a project. This command causes the new implementation to become the active implementation.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;implName&gt;</td>
<td></td>
<td>The required &lt;implName&gt; argument is used to specify the name for the new implementation.</td>
</tr>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; option is used to specify an alternate project (by name) for the implementation to be added to.</td>
</tr>
<tr>
<td>[-copy]</td>
<td>Y</td>
<td>The optional -copy option is used to copy the implementation options of the active implementation into the newly created implementation.</td>
</tr>
<tr>
<td>[-not_active]</td>
<td>Y</td>
<td>If this option is set, the new project impl will not be activated and the active impl in the current ACE session will not be changed.</td>
</tr>
</tbody>
</table>
create_path

create_path <pins> [-id <string>] [-rgb <list>]

This command creates a user-defined pin path that may be used for selection or highlighting.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;pins&gt;</td>
<td></td>
<td>The required &lt;pins&gt; list argument specifies the ordered list of instance pins.</td>
</tr>
<tr>
<td>[-id &lt;id&gt;]</td>
<td>Y</td>
<td>The optional -id &lt;id&gt; option specifies the string id to use for this path. If an id is not specified, a unique id will be automatically generated.</td>
</tr>
<tr>
<td>[-rgb &lt;rgb&gt;]</td>
<td>Y</td>
<td>The optional -rgb &lt;rgb&gt; option is used to specify the RGB (Red-Green-Blue) color value to use for highlighting the specified objects as a 3 element list of integers (red green blue). If the -rgb option is not used, then the objects in the list will be un-highlighted.</td>
</tr>
</tbody>
</table>

create_project

create_project <projectFile> [-impl <string>] [-not_active]

This command creates a new project in ACE.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;projectFile&gt;</td>
<td></td>
<td>The required &lt;projectFile&gt; argument is used to specify the project file location for the new project. The file name is used as the project's name in ACE.</td>
</tr>
<tr>
<td>[-impl &lt;implName&gt;]</td>
<td>Y</td>
<td>The optional -impl &lt;implName&gt; option is used to specify the name of the initial implementation for this new project.</td>
</tr>
<tr>
<td>[-not_active]</td>
<td>Y</td>
<td>If this option is set, the new project impl will not be activated and the active impl in the current ACE session will not be changed.</td>
</tr>
</tbody>
</table>

create_region


This command creates a placement region in the Core with the given name and bounding box of tiles. Instances may be added to this placement region to create a region constraint for the placer.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;name&gt;</td>
<td></td>
<td>Name of the region</td>
</tr>
<tr>
<td>&lt;bounds&gt;</td>
<td></td>
<td>List of bounding box coordinates {x1 y1 x2 y2}. x1 and y1 are the upper left corner of the box. x2 and y2 are the lower right corner of the box.</td>
</tr>
<tr>
<td>Argument</td>
<td>Optional</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>----------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>[-find_insts &lt;string&gt;]</td>
<td>Y</td>
<td>Pass in a find command string to create the list of user design instances to constrain into this region's bounding box for the placer.</td>
</tr>
<tr>
<td>[-insts &lt;list&gt;]</td>
<td>Y</td>
<td>List of user design instances to constrain into this region's bounding box for the placer.</td>
</tr>
<tr>
<td>[-snap_to_clock_regions]</td>
<td>Y</td>
<td>Snap the bounding box to clock region boundaries (deprecated, use <code>-snap_clock_regions</code>)</td>
</tr>
<tr>
<td>[-snap_to_fabric_clusters]</td>
<td>Y</td>
<td>Snap the bounding box to fabric cluster boundaries (deprecated, use <code>-snap_fabric_clusters</code>)</td>
</tr>
<tr>
<td>[-snap &lt;string&gt;]</td>
<td>Y</td>
<td>How to snap the region bounding box coordinates. Legal values are: 'none', 'tiles' (the default), 'fabric_clusters', 'clock_regions'.</td>
</tr>
<tr>
<td>[-soft]</td>
<td>Y</td>
<td>Create a 'soft' placement region, which attempts to pull instance placement to its center, but allows instance placement to overflow the bounds of the region (deprecated, use '-type soft')</td>
</tr>
<tr>
<td>[-type &lt;string&gt;]</td>
<td>Y</td>
<td>What type of placement region this is. Legal values are: 'inclusive' (the default), 'keepout', 'soft'. Instances added to an 'inclusive' region (and attached routing wires when '-include_routing' is set) will be placed within the region bounding box. An 'inclusive' region permits instances to be placed inside the region even if they do not belong to the region. A 'keepout' region prevents any instances (and routing wires when '-include_routing' is set) from being placed inside the region. No instances may be added to a 'keepout' region. Instances added to an 'soft' region will be pulled toward the region's center during placement, but instances are permitted to overflow the bounds of the 'soft' region.</td>
</tr>
<tr>
<td>[-flops_only]</td>
<td>Y</td>
<td>When adding instances, filter out all instances except flops.</td>
</tr>
<tr>
<td>[-clocks_only]</td>
<td>Y</td>
<td>When adding instances, filter out all instances that do not have a connected clock pin.</td>
</tr>
<tr>
<td>[-include_routing]</td>
<td>Y</td>
<td>Constrain routing wires, as well as instances, to stay within the region boundary box.</td>
</tr>
<tr>
<td>[-include_constants]</td>
<td>Y</td>
<td>When adding instances, do not filter out power/ground constants.</td>
</tr>
<tr>
<td>[-pr_zone]</td>
<td>Y</td>
<td>This will indicate that the placement region is intended to be used for partial reconfiguration.</td>
</tr>
<tr>
<td>[-batch]</td>
<td>Y</td>
<td>Postpone application of this constraint until apply_placement is called (this avoids frequent GUI updates). This option is only relevant if you manually apply placement constraints after the design has been prepared.</td>
</tr>
</tbody>
</table>
### deselect

deselect [-objects <list>]

This command removes objects from the current list of selected objects.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-objects &lt;list&gt;]</td>
<td>Y</td>
<td>The optional -objects &lt;objects&gt; option is used to specify a list of objects to remove from the current selection. Objects must be prepended with object type prefixes (see &quot;find&quot; command). Objects in the &lt;objects&gt; list that are not in the current selection are silently ignored. Without this option, the deselect command will remove all objects from the current selection.</td>
</tr>
</tbody>
</table>

### disable_flow_step

disable_flow_step <id>

This command disables an existing optional flow step from being run during a "run" command.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;id&gt;</td>
<td></td>
<td>The required &lt;id&gt; argument specifies the id of the flow step to disable.</td>
</tr>
</tbody>
</table>

### disable_project_constraints

disable_project_constraints [-project <string>] [-impl <string>] <file>

This command disables project constraints files for a project implementation. If no project or impl names are specified, the currently active project implementation is used.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; and -impl &lt;implName&gt; options are used to specify an alternate project implementation (by name) to disable constraints for.</td>
</tr>
<tr>
<td>[-impl &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; and -impl &lt;implName&gt; options are used to specify an alternate project implementation (by name) to disable constraints for.</td>
</tr>
<tr>
<td>&lt;file&gt;</td>
<td></td>
<td>The project constraints file to disable for a project implementation.</td>
</tr>
</tbody>
</table>

### display_file

display_file <file> [-line_number <int>] [-search <string>]

This command automatically opens a file in the GUI. This command has no effect in batch mode.
### display_netlist

**display_netlist <object>**

This command attempts to open the gate level netlist file in the GUI for the given user design instance or net. This command has no effect when ACE is running in batch mode.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;object&gt;</td>
<td></td>
<td>The required &lt;object&gt; argument specifies the instance (i:) or net (n:) name for which the netlist file will be opened in the GUI.</td>
</tr>
</tbody>
</table>

### display_properties

**display_properties <object> [-print]**

This command displays detailed properties of the specified object in the GUI, and optionally prints the details to the console.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;object&gt;</td>
<td></td>
<td>The required &lt;object&gt; argument specifies the object to get properties for.</td>
</tr>
<tr>
<td>[-print]</td>
<td>Y</td>
<td>The -print option will print all the object property details to the TCL console in addition to sending the data to the GUI.</td>
</tr>
</tbody>
</table>

### draw_arc

**draw_arc <x> <y> <width> <height> <startAngle> <arcAngle> [-layer <int>] [-id <int>] [-rgb <list>] [-batch] [-thickness <int>] [-fill]**

This command allows you to draw a custom arc on the GUI's Floorplanner view.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;x&gt;</td>
<td></td>
<td>The required &lt;x&gt; argument specifies the upper-left x coordinate for the arc.</td>
</tr>
<tr>
<td>&lt;y&gt;</td>
<td></td>
<td>The required &lt;y&gt; argument specifies the upper-left y coordinate for the arc.</td>
</tr>
<tr>
<td>&lt;width&gt;</td>
<td></td>
<td>The required &lt;width&gt; argument specifies the width of the arc.</td>
</tr>
</tbody>
</table>
### Argument Table

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;height&gt;</td>
<td></td>
<td>The required &lt;height&gt; argument specifies the height of the arc.</td>
</tr>
<tr>
<td>&lt;startAngle&gt;</td>
<td></td>
<td>The required &lt;startAngle&gt; argument specifies the starting angle of the arc.</td>
</tr>
<tr>
<td>&lt;arcAngle&gt;</td>
<td></td>
<td>The required &lt;arcAngle&gt; argument specifies the angle of the arc.</td>
</tr>
<tr>
<td>[-layer &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -layer &lt;layer&gt; option specifies the drawing layer for the arc.</td>
</tr>
<tr>
<td>[-id &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -id &lt;id&gt; option specifies a unique id for the arc.</td>
</tr>
<tr>
<td>[-rgb &lt;list&gt;]</td>
<td>Y</td>
<td>The optional -rgb &lt;rgb&gt; option specifies the rgb color value for the arc.</td>
</tr>
<tr>
<td>[-batch]</td>
<td>Y</td>
<td>The optional -batch option causes the GUI to not refresh after the command.</td>
</tr>
<tr>
<td>[-thickness &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -thickness &lt;pixels&gt; option specifies the arc thickness in pixels. If this option is not used, a thickness of 1 will be used.</td>
</tr>
<tr>
<td>[-fill]</td>
<td>Y</td>
<td>The optional -fill option specifies whether the arc should be filled.</td>
</tr>
</tbody>
</table>

### draw_line

draw_line <x1> <y1> <x2> <y2> [-layer <int>] [-id <int>] [-rgb <list>] [-batch] [-thickness <int>]

This command allows you to draw a custom line on the GUI's Floorplanner view.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;x1&gt;</td>
<td></td>
<td>The required &lt;x1&gt; argument specifies the first x coordinate for the line.</td>
</tr>
<tr>
<td>&lt;y1&gt;</td>
<td></td>
<td>The required &lt;y1&gt; argument specifies the first y coordinate for the line.</td>
</tr>
<tr>
<td>&lt;x2&gt;</td>
<td></td>
<td>The required &lt;x2&gt; argument specifies the second x coordinate for the line.</td>
</tr>
<tr>
<td>&lt;y2&gt;</td>
<td></td>
<td>The required &lt;y2&gt; argument specifies the second y coordinate for the line.</td>
</tr>
<tr>
<td>[-layer &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -layer &lt;layer&gt; option specifies the drawing layer for the line.</td>
</tr>
<tr>
<td>[-id &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -id &lt;id&gt; option specifies a unique id for the line.</td>
</tr>
<tr>
<td>[-rgb &lt;list&gt;]</td>
<td>Y</td>
<td>The optional -rgb &lt;rgb&gt; option specifies the rgb color value for the line.</td>
</tr>
</tbody>
</table>
The optional -batch option causes the GUI to not refresh after this command. This is useful when running many draw commands in a row. Afterwards, refresh_drawing can be called.

The optional -thickness <pixels> option specifies the line thickness in pixels. If this option is not used, a thickness of 1 will be used.

draw_oval

draw_oval <x> <y> <width> <height> [-layer <int>] [-id <int>] [-rgb <list>] [-batch] [-thickness <int>] [-fill]

This command allows you to draw a custom oval on the GUI's Floorplanner view.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;x&gt;</td>
<td></td>
<td>The required &lt;x&gt; argument specifies the upper-left x coordinate for the oval.</td>
</tr>
<tr>
<td>&lt;y&gt;</td>
<td></td>
<td>The required &lt;y&gt; argument specifies the upper-left y coordinate for the oval.</td>
</tr>
<tr>
<td>&lt;width&gt;</td>
<td></td>
<td>The required &lt;width&gt; argument specifies the width of the oval.</td>
</tr>
<tr>
<td>&lt;height&gt;</td>
<td></td>
<td>The required &lt;height&gt; argument specifies the height of the oval.</td>
</tr>
<tr>
<td>[-layer &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -layer &lt;layer&gt; option specifies the drawing layer for the oval.</td>
</tr>
<tr>
<td>[-id &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -id &lt;id&gt; option specifies a unique id for the oval.</td>
</tr>
<tr>
<td>[-rgb &lt;list&gt;]</td>
<td>Y</td>
<td>The optional -rgb &lt;rgb&gt; option specifies the rgb color value for the oval.</td>
</tr>
<tr>
<td>[-batch]</td>
<td>Y</td>
<td>The optional -batch option causes the GUI to not refresh after this command.</td>
</tr>
<tr>
<td>[-thickness &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -thickness &lt;pixels&gt; option specifies the oval thickness in pixels. If this option is not used, a thickness of 1 will be used.</td>
</tr>
<tr>
<td>[-fill]</td>
<td>Y</td>
<td>The optional -fill option specifies whether the oval should be filled with color or not. If this option is not used, the oval will be hollow.</td>
</tr>
</tbody>
</table>

draw_polygon

draw_polygon <points> [-layer <int>] [-id <int>] [-rgb <list>] [-batch] [-thickness <int>] [-fill]

This command allows you to draw a custom polygon on the GUI's Floorplanner view.
<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;points&gt;</td>
<td></td>
<td>The required &lt;points&gt; argument specifies the list of x-y coordinates for polygon, starting with the x coordinate and alternating. For example: {1 1 2 2 3 5 1 6}.</td>
</tr>
<tr>
<td>[-layer &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -layer &lt;layer&gt; option specifies the drawing layer for the arc. If this option is not used, the top layer (5) will be used. Using a value of 0 will draw on the background.</td>
</tr>
<tr>
<td>[-id &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -id &lt;id&gt; option specifies a unique id for the arc. If this option is not used, a unique id will be automatically generated and returned by the command.</td>
</tr>
<tr>
<td>[-rgb &lt;list&gt;]</td>
<td>Y</td>
<td>The optional -rgb &lt;rgb&gt; option specifies the rgb color value for the polygon as a 3 element list of integers (red green blue). If this option is not used, the color blue will be used.</td>
</tr>
<tr>
<td>[-batch]</td>
<td>Y</td>
<td>The optional -batch option causes the GUI to not refresh after this command. This is useful when running many draw commands in a row. Afterwards, refresh_drawing can be called.</td>
</tr>
<tr>
<td>[-thickness &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -thickness &lt;pixels&gt; option specifies the arc thickness in pixels. If this option is not used, a thickness of 1 will be used.</td>
</tr>
<tr>
<td>[-fill]</td>
<td>Y</td>
<td>The optional -fill option specifies whether the arc should be filled with color or not. If this option is not used, the arc will be hollow.</td>
</tr>
</tbody>
</table>

**draw_rectangle**

draw_rectangle <x> <y> <width> <height> [-layer <int>] [-id <int>] [-rgb <list>] [-batch] [-thickness <int>] [-fill]

This command allows you to draw a custom rectangle on the GUI's Floorplanner view.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;x&gt;</td>
<td></td>
<td>The required &lt;x&gt; argument specifies the upper-left x coordinate for the rectangle.</td>
</tr>
<tr>
<td>&lt;y&gt;</td>
<td></td>
<td>The required &lt;y&gt; argument specifies the upper-left y coordinate for the rectangle.</td>
</tr>
<tr>
<td>&lt;width&gt;</td>
<td></td>
<td>The required &lt;width&gt; argument specifies the width of the rectangle.</td>
</tr>
<tr>
<td>&lt;height&gt;</td>
<td></td>
<td>The required &lt;height&gt; argument specifies the height of the rectangle.</td>
</tr>
<tr>
<td>[-layer &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -layer &lt;layer&gt; option specifies the drawing layer for the rectangle. If this option is not used, the top layer (5) will be used. Using a value of 0 will draw on the background.</td>
</tr>
<tr>
<td>[-id &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -id &lt;id&gt; option specifies a unique id for the rectangle. If this option is not used, a unique id will be automatically generated and returned by the command.</td>
</tr>
<tr>
<td>[-rgb &lt;list&gt;]</td>
<td>Y</td>
<td>The optional -rgb &lt;rgb&gt; option specifies the rgb color value for the rectangle as a 3 element list of integers (red green blue). If this option is not used, the color blue will be used.</td>
</tr>
</tbody>
</table>
Argument | Optional | Description
--- | --- | ---
[-batch] | Y | The optional -batch option causes the GUI to not refresh after this command. This is useful when running many draw commands in a row. Afterwards, refresh_drawing can be called.

[-thickness <int>] | Y | The optional -thickness <pixels> option specifies the rectangle thickness in pixels. If this option is not used, a thickness of 1 will be used.

[-fill] | Y | The optional -fill option specifies whether the rectangle should be filled with color or not. If this option is not used, the rectangle will be hollow.

draw_string
draw_string <x> <y> <string> [-layer <int>] [-id <int>] [-rgb <list>] [-batch]
This command allows you to draw a custom string on the GUI's Floorplanner view.

Argument | Optional | Description
--- | --- | ---
<x> |  | The required <x> argument specifies the x coordinate for the string.
<y> |  | The required <y> argument specifies the y coordinate for the string.
<string> |  | The required <string> argument specifies the string text.

[-layer <int>] | Y | The optional -layer <layer> option specifies the drawing layer for the string. If this option is not used, the top layer (5) will be used. Using a value of 0 will draw on the background.

[-id <int>] | Y | The optional -id <id> option specifies a unique id for the string. If this option is not used, a unique id will be automatically generated and returned by the command.

[-rgb <list>] | Y | The optional -rgb <rgb> option specifies the rgb color value for the string as a 3 element list of integers {red green blue}. If this option is not used, the color blue will be used.

[-batch] | Y | The optional -batch option causes the GUI to not refresh after this command. This is useful when running many draw commands in a row. Afterwards, refresh_drawing can be called.

enable_flow_step
enable_flow_step <id>
This command enables an existing optional flow step to be run during a "run" command.

Argument | Optional | Description
--- | --- | ---
{id} |  | The required <id> argument specifies the id of the flow step to enable.

enable_project_constraints
enable_project_constraints [-project <string>] [-impl <string>] <file>
This command enables project constraints files for a project implementation. If no project or impl names are specified, the currently active project implementation is used.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; and -impl &lt;implName&gt; options are used to specify an alternate project implementation (by name) to enable constraints for.</td>
</tr>
<tr>
<td>[-impl &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; and -impl &lt;implName&gt; options are used to specify an alternate project implementation (by name) to enable constraints for.</td>
</tr>
<tr>
<td>&lt;file&gt;</td>
<td></td>
<td>The project constraints file to enable for a project implementation.</td>
</tr>
</tbody>
</table>

**export_all_partitions**

eexport_all_partitions [-info_list]

Command to export the place-and-route database and blackbox Verilog model for all leaf-level partitions in the design.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-info_list]</td>
<td>Y</td>
<td>Return a Tcl list containing {&lt;partition&gt; &lt;view&gt; &lt;epdb filename&gt; &lt;blackbox filename&gt;} for each partition</td>
</tr>
</tbody>
</table>

**export_partition**

export_partition <partition> [-dboutputfile <string>] [-bboutputfile <string>] [-info_list]

Command to export the place-and-route database and blackbox Verilog model for a partition.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;partition&gt;</td>
<td></td>
<td>Export the place-and-route database and blackbox Verilog model for the specified partition</td>
</tr>
<tr>
<td>[-dboutputfile &lt;string&gt;]</td>
<td>Y</td>
<td>Specifies the output file name for the partition database (default is &lt;active_impl_dir&gt;/output/partitions/&lt;cellname&gt;_&lt;partition&gt;.epdb)</td>
</tr>
<tr>
<td>[-bboutputfile &lt;string&gt;]</td>
<td>Y</td>
<td>Specifies the output file name for the partition blackbox Verilog model (default is &lt;active_impl_dir&gt;/output/blackboxes/&lt;cellname&gt;_bb.v)</td>
</tr>
<tr>
<td>[-info_list]</td>
<td>Y</td>
<td>Return a Tcl list containing {&lt;partition&gt; &lt;view&gt; &lt;epdb filename&gt; &lt;blackbox filename&gt;} for each partition</td>
</tr>
</tbody>
</table>

**filter**


This command takes a TCL list of DB objects and returns a filtered TCL list of objects that match the filter options passed in. Each object name in the returned list is prepended with an object type indicator (unless -no_prefix is used). Object types prefixes are: p: = port (top level user design), t: = pin, i: = instance, n: = net. Find results may contain a mixture of...
object types. The -insts, -nets, -ports, and -pins object type options may be used to filter the results to just those object types. Specifying no object type options will result in a search of all object types.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;objects&gt;</td>
<td></td>
<td>The required &lt;objects&gt; argument specifies a list of object names to filter.</td>
</tr>
<tr>
<td>[-patterns &lt;list&gt;]</td>
<td>Y</td>
<td>The optional -patterns argument specifies a list of pattern strings to match object names against. Each pattern string in the list may use '*' and '?' wildcard characters for matching.</td>
</tr>
<tr>
<td>[-insts]</td>
<td>Y</td>
<td>The optional -insts object type option is used to specify that the results may include instance object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -insts option is not used, then the results will not contain any instance objects.</td>
</tr>
<tr>
<td>[-nets]</td>
<td>Y</td>
<td>The optional -nets object type option is used to specify that the results may include net object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -nets option is not used, then the results will not contain any net objects.</td>
</tr>
<tr>
<td>[-ports]</td>
<td>Y</td>
<td>The optional -ports object type option is used to specify that the results may include top level user design port object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -ports option is not used, then the results will not contain any top level user design port objects.</td>
</tr>
<tr>
<td>[-pins]</td>
<td>Y</td>
<td>The optional -pins object type option is used to specify that the results may include pin object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -pins option is not used, then the results will not contain any pin objects.</td>
</tr>
<tr>
<td>[-paths]</td>
<td>Y</td>
<td>The optional -paths object type option is used to specify that the results may include path object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -paths option is not used, then the results will not contain any path objects.</td>
</tr>
<tr>
<td>[-sites]</td>
<td>Y</td>
<td>The optional -sites object type option is used to specify that the results may include site object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -sites option is not used, then the results will not contain any site objects.</td>
</tr>
<tr>
<td>[-filter &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -filters option may be used to specify a boolean expression of object properties to filter the results with. Each property filter in the expression must follow the filter syntax of @&lt;propertynname&gt;&lt;operator&gt;&lt;value&gt;. Multiple property filters may be used in the expression by using boolean operators. For example: &quot;find * -filter {@type=DIFF</td>
</tr>
</tbody>
</table>
See also: Object Type Prefixes (see page 313), Search Filter Builder Dialog (see page 183), Filter Properties (see page 246), find, Search View. (see page 132)

## find

This command returns a TCL list of object names that match any of the pattern strings passed in. Each object name in the returned list is prepended with an object type indicator (unless -no_prefix is used). Object types prefixes are: p: = port (top level user design), t: = pin, i: = instance, n: = net. Find results may contain a mixture of object types. The -insts, -nets, -ports, and -pins object type options may be used to filter the results to just those object types. Specifying no object type options will result in a search of all object types.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;patterns&gt;</td>
<td></td>
<td>The required &lt;patterns&gt; argument specifies a list of pattern strings to match object names against. The pattern for matching with specific pins must have separator '/' in the form of &lt;instance pattern&gt;/&lt;pin pattern&gt;. Each pattern string in the list may use '*' and '?' wildcard characters for matching.</td>
</tr>
<tr>
<td>[-insts]</td>
<td>Y</td>
<td>The optional -insts object type option is used to specify that the results may include instance object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -insts option is not used, then the results will not contain any instance objects.</td>
</tr>
<tr>
<td>[-nets]</td>
<td>Y</td>
<td>The optional -nets object type option is used to specify that the results may include net object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -nets option is not used, then the results will not contain any net objects.</td>
</tr>
<tr>
<td>[-ports]</td>
<td>Y</td>
<td>The optional -ports object type option is used to specify that the results may include top level user design port object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -ports option is not used, then the results will not contain any top level user design port objects.</td>
</tr>
<tr>
<td>[-pins]</td>
<td>Y</td>
<td>The optional -pins object type option is used to specify that the results may include pin object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -pins option is not used, then the results will not contain any pin objects.</td>
</tr>
<tr>
<td>[-paths]</td>
<td>Y</td>
<td>The optional -paths object type option is used to specify that the results may include path object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -paths option is not used, then the results will not contain any path objects.</td>
</tr>
<tr>
<td>Argument</td>
<td>Optional</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>[-sites]</td>
<td>Y</td>
<td>The optional -sites object type option is used to specify that the results may include site object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -sites option is not used, then the results will not contain any site objects.</td>
</tr>
<tr>
<td>[-filter &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -filters option may be used to specify a boolean expression of object properties to filter the results with. Each property filter in the expression must follow the filter syntax of @&lt;propname&gt;&lt;operator&gt;&lt;value&gt;. Multiple property filters may be used in the expression by using boolean operators. For example: &quot;find &quot; -filter {@type=DFF</td>
</tr>
<tr>
<td>[-sort &lt;string&gt;]</td>
<td>Y</td>
<td>The -sort option allows the user to specify the type of sort performed on the find results list. The default is &quot;dictionary&quot;. Other options are &quot;ascii&quot; or &quot;none&quot;.</td>
</tr>
<tr>
<td>[-sort_order &lt;string&gt;]</td>
<td>Y</td>
<td>The -sort_order option allows the user to specify the direction of sort performed on the find results list. You may specify either &quot;increasing&quot; or &quot;decreasing&quot;. The default is &quot;increasing&quot;.</td>
</tr>
<tr>
<td>[-no_prefix]</td>
<td>Y</td>
<td>The optional -no_prefix option is used to remove the object type prefix from the names returned in the results.</td>
</tr>
<tr>
<td>[-no_refresh]</td>
<td>Y</td>
<td>The optional -no_refresh option is used to prevent sending an update to the GUI Search View to optimize speed.</td>
</tr>
<tr>
<td>[-handle]</td>
<td>Y</td>
<td>The optional -handle option is used to return the reserve string &quot;@@FindResults&quot; instead of the TCL list of object names. This handle can then be used in the highlight command to speed up processing by avoiding extra name parsing.</td>
</tr>
<tr>
<td>[-warning]</td>
<td>Y</td>
<td>Print warning message if the find command does not find any objects.</td>
</tr>
<tr>
<td>[-error]</td>
<td>Y</td>
<td>Print message and error out if the find command does not find any objects.</td>
</tr>
</tbody>
</table>

The ACE GUI provides a graphical interface for the find command through the Search View (see page 132). See also: Object Type Prefixes (see page 313), Search Filter Builder Dialog (see page 183), Filter Properties (see page 246), filter, select, Selection View (see page 136), trace_connections (see page 624).

generate_ioring_design_files

generate_ioring_design_files <outputDir> [-add_to_project]

This command generates the all IO Ring design files for the active ACE project, using all ACXIP files that have been added to the active project.
**generate_ip_design_files**

generate_ip_design_files <acxipFile>

This command generates the enabled design files for a given IP configuration (.acxip file).

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;acxipFile&gt;</td>
<td></td>
<td>The required &lt;acxipFile&gt; argument specifies the IP configuration (.acxip file) to generate design files for.</td>
</tr>
</tbody>
</table>

**generate_route_delay_table**

generate_route_delay_table [-outputfile <string>]  

This command extracts route delay numbers on nets for estimating the cell-cell route delays vs fanout.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-outputfile &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -outputfile &lt;file&gt; option may be used to specify an output file name or file path. If this option is not present, the output is written to the default implementation .debug directory and is named &lt;design_name&gt;_route_delay.log.</td>
</tr>
</tbody>
</table>

**get_ace_cputime**

get_ace_cputime

This command returns the cumulative cpu time of this ACE process.

**get_ace_current_memory_usage**

get_ace_current_memory_usage

This command returns the current memory usage (in kB) of this ACE process.

**get_ace_ext_dir**

get_ace_ext_dir

This command returns the path to the ACE Extensions directory if one has been enabled.

**get_ace_ext_lib**

get_ace_ext_lib <partName>
This command returns the blackbox library path in the ACE Extensions directory for the specified partname if one has been enabled.

### Argument

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;partName&gt;</td>
<td></td>
<td>The required &lt;partName&gt; argument is used to specify the name of the target device to find the blackbox library file for. The part name specified must exist among the valid part names in the ACE installation.</td>
</tr>
</tbody>
</table>

### get_ace_peak_memory_usage

This command returns the maximum memory usage (in kB) of this ACE process during the current session.

### get_ace_version

This command returns the version of ACE.

### get_active_impl

This command returns the name of the active implementation in the current ACE session.

### Argument

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-quiet]</td>
<td>Y</td>
<td>do not print a message if the active project is not defined</td>
</tr>
</tbody>
</table>

### Example

To automatically set the value of the `set_impl_option -impl` option, after the `create_project -impl` command has been run, which defines the name of the active impl, the following command can be used:

```
set_impl_option -project [get_active_project] -impl [get_active_impl] "partname" "AC16tSC01HI01C"
```

### Also See

`create_project`

`get_active_project`

`set_impl_option`
get_active_project
get_active_project [-quiet] [-path]
This command returns the name of the active project (which contains the active implementation) in the current ACE session.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-quiet]</td>
<td>Y</td>
<td>do not print a message if there is no active project</td>
</tr>
<tr>
<td>[-path]</td>
<td>Y</td>
<td>Return the file path to the active project's acxprj project file, instead of the project name</td>
</tr>
</tbody>
</table>

get_best_multiprocess_impl
get_best_multiprocess_impl
This command finds the best impl from the MultiProcess Summary Report in the active project.

get_clock_region_bounds
get_clock_region_bounds <region>
Returns the bounding box for a clock region

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;region&gt;</td>
<td>Name of the region</td>
</tr>
</tbody>
</table>

get_clock_regions
get_clock_regions
Returns the list of clock region names for the device

get_clock_type
get_clock_type <clock>
Get properties of a clock. For a non-driving (target) clock pin, this is a combination of local properties and properties of the clock domain.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;clock&gt;</td>
<td>net or pin ('inst/pin')</td>
</tr>
</tbody>
</table>

get_compatible_ordering_codes
get_compatible_ordering_codes
This command returns a list of compatible ordering codes for the active project based on it's device, package, and speed grade.

get_compatible_placements
get_compatible_placements <source> [-anchor <string>] [-outputfile <string>]

Get a list of compatible placements for the given <source> partition

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;source&gt;</td>
<td></td>
<td>Name of the source partition</td>
</tr>
<tr>
<td>[-anchor &lt;string&gt;]</td>
<td>Y</td>
<td>Name of the anchor instance. An anchor instance will be chosen automatically if not given.</td>
</tr>
<tr>
<td>[-outputfile &lt;string&gt;]</td>
<td>Y</td>
<td>Name of optional output file. If given, the compatible placements will be written out as a series of set_placement commands.</td>
</tr>
</tbody>
</table>

get_current_design

get_current_design [-quiet]

This command returns the name of the top module in the current design. This command returns an error if no current design is loaded.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-quiet]</td>
<td>Y</td>
<td>do not print a message if there is no active project</td>
</tr>
</tbody>
</table>

get_current_partname

get_current_partname [-quiet]

This command returns the name of the currently loaded device.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-quiet]</td>
<td>Y</td>
<td>do not warn if there is no current part</td>
</tr>
</tbody>
</table>

get_efd_file_path

get_efd_file_path <partName>

This command returns the path to the efd file for the given part.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;partName&gt;</td>
<td></td>
<td>The required &lt;partName&gt; argument is used to specify the name of the part to find the efd file for. The part name specified must exist among the valid part names in the ACE installation.</td>
</tr>
</tbody>
</table>

get_enabled_constraints

get_enabled_constraints [-project <string>] [-impl <string>]

This command returns a list of all the enabled constraint files for an implementation.
get_fabricdb_path
get_fabricdb_path <partName>
This command returns the path to the fabric db file for the given part.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;partName&gt;</td>
<td></td>
<td>The required &lt;partName&gt; argument is used to specify the name of the part to find the fabric db for. The part name specified must exist among the valid part names in the ACE installation.</td>
</tr>
</tbody>
</table>

get_file_line
get_file_line <object>
This command returns the file path and line offset into to the source netlist for the given user design instance or net.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;object&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The required &lt;object&gt; argument specifies the instance (i:) or net (n:) name for which the file line will be retrieved.</td>
</tr>
</tbody>
</table>

get_flow_steps
get_flow_steps
This command returns a list of all the currently defined flow step id strings.

get_impl_names
get_impl_names [-project <string>]
This command returns a list of all the implementation names for an existing project.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-project &lt;string&gt;]</td>
<td></td>
<td>The optional -project &lt;projectName&gt; option is used to specify an alternate project (by name) to get the implementation names from.</td>
</tr>
</tbody>
</table>

get_impl_option
get_impl_option <option_name> [-project <string>] [-impl <string>] [-syn]
This command returns the current value of a project implementation option. Only one option value may be retrieved at a time.
Argument | Optional | Description
---|---|---
<option_name> | | The name of the impl option to retrieve a value for. To see a list of valid impl options, use the report_impl_options TCL command.
[-project <string>] | Y | The optional -project <projectName> and -impl <implName> options are used to specify an alternate project implementation (by name) to get options for.
[-impl <string>] | Y | The optional -project <projectName> and -impl <implName> options are used to specify an alternate project implementation (by name) to get options for.
[-syn] | Y | option is synthesis option

get_impl_option_is_supported

get_impl_option_is_supported <option_name> [-project <string>] [-impl <string>]

Returns '1' if the impl option is supported on the current device, otherwise returns '0'

Argument | Optional | Description
---|---|---
<option_name> | | The name of the impl option to retrieve a value for. To see a list of valid impl options, use the report_impl_options TCL command.
[-project <string>] | Y | The optional -project <projectName> and -impl <implName> options are used to specify an alternate project implementation (by name) to get options for.
[-impl <string>] | Y | The optional -project <projectName> and -impl <implName> options are used to specify an alternate project implementation (by name) to get options for.

get_inst_partition

get_inst_partition <instance>

Returns the Partition associated with a user design instance

Argument | Optional | Description
---|---|---
<instance> | | Name of the instance

get_inst_region

get_inst_region <instance>

Returns the region associated with a user design instance

Argument | Optional | Description
---|---|---
<instance> | | Name of the instance
get_installation_directory
get_installation_directory
This command returns the path to the root of the ACE installation.

get_location
get_location <object>
This command allows you to get the location of an object (i:instance, s:site, or t:pin) on the GUI's Floorplanner view.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;object&gt;</td>
<td></td>
<td>The required &lt;object&gt; argument specifies the object to get coordinates for. The correct object type prefix is required.</td>
</tr>
</tbody>
</table>

get_part_names
get_part_names
This command returns the list of valid part names in the installed library.

get_partition_changed
get_partition_changed <name>
Get the changed flag of a partition with the given name

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;name&gt;</td>
<td></td>
<td>Name of the Partition</td>
</tr>
</tbody>
</table>

get_partition_force_changed
get_partition_force_changed <name>
Get the force changed flag of a partition with the given name

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;name&gt;</td>
<td></td>
<td>Name of the Partition</td>
</tr>
</tbody>
</table>

get_partition_info
Get info of a partition with the given name

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;name&gt;</td>
<td></td>
<td>Name of the Partition</td>
</tr>
<tr>
<td>[-timestamp]</td>
<td>Y</td>
<td>get timestamp</td>
</tr>
</tbody>
</table>
## Argument Table

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-comment]</td>
<td>Y</td>
<td>get comment</td>
</tr>
<tr>
<td>[-view]</td>
<td>Y</td>
<td>get view name</td>
</tr>
<tr>
<td>[-type]</td>
<td>Y</td>
<td>get partition type</td>
</tr>
<tr>
<td>[-is_import]</td>
<td>Y</td>
<td>was the partition imported (0 or 1)?</td>
</tr>
<tr>
<td>[-import_from]</td>
<td>Y</td>
<td>file the partition was imported from</td>
</tr>
<tr>
<td>[-changed]</td>
<td>Y</td>
<td>has the partition timestamp changed</td>
</tr>
<tr>
<td>[-id]</td>
<td>Y</td>
<td>unique partition id number</td>
</tr>
<tr>
<td>[-disabled]</td>
<td>Y</td>
<td>is the partition disabled (0 or 1)?</td>
</tr>
<tr>
<td>[-parent]</td>
<td>Y</td>
<td>name of the partition's parent partition</td>
</tr>
<tr>
<td>[-is_top]</td>
<td>Y</td>
<td>is this the top partition (0 or 1)?</td>
</tr>
<tr>
<td>[-is_parent]</td>
<td>Y</td>
<td>is this partition a parent of another (0 or 1)?</td>
</tr>
</tbody>
</table>

### get_partition_insts

**get_partition_insts <name>**

Returns the list of user design instances in a partition

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;name&gt;</td>
<td></td>
<td>Name of the Partition</td>
</tr>
</tbody>
</table>

### get_partition_names

**get_partition_names**

Returns the list of user design partition names

### get_partition_timestamp

**get_partition_timestamp <name>**

Get the timestamp of a partition with the given name

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;name&gt;</td>
<td></td>
<td>Name of the Partition</td>
</tr>
</tbody>
</table>
get_partition_type

get_partition_type <name>

Get the type of a partition with the given name

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;name&gt;</td>
<td></td>
<td>Name of the Partition</td>
</tr>
</tbody>
</table>

get_path_property


This command returns path properties.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;id&gt;</td>
<td></td>
<td>The required &lt;id&gt; argument specifies the id of the path to get properties for.</td>
</tr>
<tr>
<td>[-pins]</td>
<td>Y</td>
<td>The optional -pins option returns the list of pin names that make up this path.</td>
</tr>
<tr>
<td>[-insts]</td>
<td>Y</td>
<td>The optional -insts option returns the list of instance names on this path.</td>
</tr>
<tr>
<td>[-nets]</td>
<td>Y</td>
<td>The optional -nets option returns the list of net names on this path.</td>
</tr>
<tr>
<td>[-frequency]</td>
<td>Y</td>
<td>The optional -frequency option returns the frequency of this path in MHz. If no frequency is defined, -1 is returned.</td>
</tr>
<tr>
<td>[-type]</td>
<td>Y</td>
<td>The optional -type option returns the type of path: Setup Check Met, Setup Check Violated, Hold Check Met, Hold Check Violated, Hardware Limit, or User-Defined.</td>
</tr>
<tr>
<td>[-rgb]</td>
<td>Y</td>
<td>The optional -rgb option returns the integer rgb highlight color value for the path. A value of -1 means it is not highlighted.</td>
</tr>
<tr>
<td>[-text]</td>
<td>Y</td>
<td>The optional -text option returns the details text for this path.</td>
</tr>
<tr>
<td>[-slack]</td>
<td>Y</td>
<td>The optional -slack option returns the slack for this path.</td>
</tr>
</tbody>
</table>

get_placement

get_placement <objName>

This command returns the site of the specified placed instance

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;objName&gt;</td>
<td></td>
<td>The required &lt;objName&gt; argument is used to specify the instance or port to get placement for.</td>
</tr>
</tbody>
</table>
get_pod_names

get_pod_names [-all] [-usb] [-ethernet] [-list <list>]

Returns a list of names of available Bitporter pods.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-all]</td>
<td>Y</td>
<td>(default behavior) returns USB and detected Ethernet pods.</td>
</tr>
<tr>
<td>[-usb]</td>
<td>Y</td>
<td>(optional) returns only the USB pods.</td>
</tr>
<tr>
<td>[-ethernet]</td>
<td>Y</td>
<td>(optional) returns only the detected Ethernet pods.</td>
</tr>
<tr>
<td>[-list &lt;list&gt;]</td>
<td>Y</td>
<td>(optional) specifies a list of podnames whose availability should be checked.</td>
</tr>
</tbody>
</table>

get_project_constraint_files

get_project_constraint_files [-project <string>]

This command returns a list of all the constraint file paths for a project.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; option is used to specify an alternate project (by name) to get the constraint file paths from.</td>
</tr>
</tbody>
</table>

get_project_directory

get_project_directory [-project <string>]

This command returns the path to a project file's parent directory.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; option is used to specify an alternate project (by name) to get the directory path from.</td>
</tr>
</tbody>
</table>

get_project_ip_files

get_project_ip_files [-project <string>]

This command returns a list of all the IP settings file paths for a project.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; option is used to specify an alternate project (by name) to get the IP settings file paths from.</td>
</tr>
</tbody>
</table>

get_project_names

get_project_names

This command returns a list of all the project names loaded in the current ACE session.
get_project_netlist_files

get_project_netlist_files [-project <string>] [-noimpl]

This command returns a list of all the netlist file paths for a project.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; option is used to specify an alternate project (by name) to get the netlist file paths from.</td>
</tr>
<tr>
<td>[-noimpl]</td>
<td>Y</td>
<td>Do not list impl-specific files, even with active impl.</td>
</tr>
</tbody>
</table>

get_properties

get_properties <object>

This command returns the list of option-value pairs for the specified object.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;object&gt;</td>
<td></td>
<td>The required &lt;object&gt; argument specifies the object to get properties for.</td>
</tr>
</tbody>
</table>

get_property

get_property <object> <propName> [-object_type <string>]

This command returns the specified property value for the specified object.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;object&gt;</td>
<td></td>
<td>The required &lt;object&gt; argument specifies which object will be queried.</td>
</tr>
<tr>
<td>&lt;propName&gt;</td>
<td></td>
<td>The required &lt;propName&gt; argument specifies the name of the property whose value will be retrieved.</td>
</tr>
<tr>
<td>[-object_type &lt;string&gt;]</td>
<td>Y</td>
<td>type of object: cell</td>
</tr>
</tbody>
</table>

get_pvt_corners

get_pvt_corners [<partName>]

This command returns a list of the valid PVT corners for the specified part.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[&lt;partName&gt;]</td>
<td>Y</td>
<td>Name of part</td>
</tr>
</tbody>
</table>

get_region_bounds

get_region_bounds <region>

Returns the bounding box for a placement region constraint.
<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;region&gt;</td>
<td></td>
<td>Name of the region</td>
</tr>
</tbody>
</table>

**get_region_insts**

*get_region_insts <region>*

Returns the list of user design instances in a placement region constraint.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;region&gt;</td>
<td></td>
<td>Name of the region</td>
</tr>
</tbody>
</table>

**get_regions**

*get_regions [-verbose]*

Returns the list of placement region constraint names.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-verbose]</td>
<td>Y</td>
<td>print region information with each region</td>
</tr>
</tbody>
</table>

**get_report_sweep_temperature_corners**

*get_report_sweep_temperature_corners [-quiet]*

This command returns a list of the valid junction temperatures for the target device at the given speed grade and core voltage level.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-quiet]</td>
<td>Y</td>
<td>do not print a message if there is no active project</td>
</tr>
</tbody>
</table>

**get_selection**


This command returns the current list of selected objects.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-insts]</td>
<td>Y</td>
<td>The optional -insts object type option is used to specify that the results may include instance object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -insts option is not used, then the results will not contain any instance objects.</td>
</tr>
<tr>
<td>[-nets]</td>
<td>Y</td>
<td>The optional -nets object type option is used to specify that the results may include net object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -nets option is not used, then the results will not contain any net objects.</td>
</tr>
<tr>
<td>Argument</td>
<td>Optional</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>[-ports]</td>
<td>Y</td>
<td>The optional -ports object type option is used to specify that the results may include top level user design port object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -ports option is not used, then the results will not contain any top level user design port objects.</td>
</tr>
<tr>
<td>[-pins]</td>
<td>Y</td>
<td>The optional -pins object type option is used to specify that the results may include pin object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -pins option is not used, then the results will not contain any pin objects.</td>
</tr>
<tr>
<td>[-paths]</td>
<td>Y</td>
<td>The optional -paths object type option is used to specify that the results may include path object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -paths option is not used, then the results will not contain any path objects.</td>
</tr>
<tr>
<td>[-sites]</td>
<td>Y</td>
<td>The optional -sites object type option is used to specify that the results may include site object types. If no other object type option is used, all object types will be included in the results by default. If another object type option is used, and the -sites option is not used, then the results will not contain any site objects.</td>
</tr>
<tr>
<td>[-handle]</td>
<td>Y</td>
<td>The optional -handle option is used to return the reserve string &quot;@@Selection&quot; instead of the TCL list of object names. This handle can be used in the highlight command to speed up processing by avoiding extra name parsing.</td>
</tr>
</tbody>
</table>

get_stapl_actions

get_stapl_actions <staplfile>

Returns a list of Actions found in the specified STAPL file, along with the Procedures making up each Action. The listed Procedures within each Action will indicate whether they are Required, Recommended (run by default, but may be disabled by the user), or Optional (not run by default, but may be enabled by the user).

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;staplfile&gt;</td>
<td></td>
<td>The STAPL file whose Actions should be returned.</td>
</tr>
</tbody>
</table>

get_synprj_from_netlist

get_synprj_from_netlist [⟨filename⟩]

This command returns the name of the synthesis prj-file associated with the ace project, if available.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⟨filename⟩</td>
<td>Y</td>
<td>Name of file whose prj-file you want to find [any]</td>
</tr>
</tbody>
</table>

get_synprj_from_project

get_synprj_from_project

This command returns the name of the synthesis prj-file associated with the ace project, if available.
get_techlib_name

get_techlib_name <partName>

This command returns the name of the black box verilog library for the given part.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;partName&gt;</td>
<td></td>
<td>The required &lt;partName&gt; argument is used to specify the name of the part to find the library for. The part name specified must exist among the valid part names in the ACE installation.</td>
</tr>
</tbody>
</table>

get_techlib_path

get_techlib_path <partName>

This command returns the path to the black box verilog library file for the given part.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;partName&gt;</td>
<td></td>
<td>The required &lt;partName&gt; argument is used to specify the name of the part to find the library for. The part name specified must exist among the valid part names in the ACE installation.</td>
</tr>
</tbody>
</table>

get_techlibdb_path

get_techlibdb_path <partName>

This command returns the path to the techlib db file for the given part.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;partName&gt;</td>
<td></td>
<td>The required &lt;partName&gt; argument is used to specify the name of the part to find the techlib db for. The part name specified must exist among the valid part names in the ACE installation.</td>
</tr>
</tbody>
</table>

get_techlibt_name

get_techlibt_name <partName>

This command returns the name of the transmuted black box verilog library for the given part.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;partName&gt;</td>
<td></td>
<td>The required &lt;partName&gt; argument is used to specify the name of the part to find the library for. The part name specified must exist among the valid part names in the ACE installation.</td>
</tr>
</tbody>
</table>

get_techlibt_path

get_techlibt_path <partName>

This command returns the path to the transmuted black box verilog library file for the given part.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;partName&gt;</td>
<td></td>
<td>The required &lt;partName&gt; argument is used to specify the name of the part to find the library for. The part name specified must exist among the valid part names in the ACE installation.</td>
</tr>
</tbody>
</table>
get_techlibx_name
get_techlibx_name <partName>
This command returns the name of the expanded black box verilog library for the given part.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;partName&gt;</td>
<td></td>
<td>The required &lt;partName&gt; argument is used to specify the name of the part to find the library for. The part name specified must exist among the valid part names in the ACE installation.</td>
</tr>
</tbody>
</table>

get_techlibx_path
get_techlibx_path <partName>
This command returns the path to the expanded black box verilog library file for the given part.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;partName&gt;</td>
<td></td>
<td>The required &lt;partName&gt; argument is used to specify the name of the part to find the library for. The part name specified must exist among the valid part names in the ACE installation.</td>
</tr>
</tbody>
</table>

has_ace_ext_lib
has_ace_ext_lib <partName>
This command returns a 1 if the blackbox library path is configured in the ACE Extensions directory for the specified partname.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;partName&gt;</td>
<td></td>
<td>The required &lt;partName&gt; argument is used to specify the name of the target device to find the blackbox library file for. The part name specified must exist among the valid part names in the ACE installation.</td>
</tr>
</tbody>
</table>

has_partitions
has_partitions
Check if partitions have been defined on the design via the *.prt file

highlight
highlight <objects> [-rgb <list>] [-batch] [-clear]
This command is used to highlight or un-highlight a list of objects in the GUI’s physical view.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;objects&gt;</td>
<td></td>
<td>The required &lt;objects&gt; argument is used to specify a list of objects which will have their highlight color set. Highlight of instance, net, and path object types is currently supported. All other object types passed in will be silently ignored. Objects must be prepended with object type prefixes (see “find” command).</td>
</tr>
</tbody>
</table>
**Argument** | **Optional** | **Description**
---|---|---
[-rgb <list>] | Y | The optional -rgb <rgb> option is used to specify the RGB (Red-Green-Blue) color value to use for highlighting the specified objects as a 3 element list of 8-bit (0-255) integers {red green blue}. If the -rgb option is not used, then the objects in the list will be un-highlighted.
[-batch] | Y | The optional -batch option is used to suppress the refresh of highlighting information to the GUI. This can be useful (faster) if highlighting multiple groups of nets in a loop, since each highlight command that affects a net will otherwise refresh the entire routing data set in the GUI.
[-clear] | Y | The optional -clear option is used to clear all prior highlighting.

**ignore_cancel**

`ignore_cancel <script>`

Temporarily ignore cancel button. Useful to execute cleanup commands in a flow step after a cancel has been caught.

**initialize_flow**

`initialize_flow`

This command clears the current flow model, then sources the master flow.tcl script. The master flow.tcl script uses these flow TCL commands to define the default flow.

**insert_delay**

`insert_delay <pinlist>`

This command parses the user directive to add extra delays for paths that require additional delay for alleviating timing violations.

**Argument** | **Optional** | **Description**
---|---|---
<pinlist> | | The required (pinlist) option is used to specify the load pins of a net that need to be driven by inserted gates. For each pin, you can optionally specify an integer delay value by using the format <delay>,<pin_name>. The default delay value is 1.

**is_incremental_compile**

`is_incremental_compile`

Check if the Incremental Compile Impl Option is set to 1, and that partitions have been defined on the design via the *.prt file.

**is_labmode**

`is_labmode`

This command returns 1 if we are in labmode.
load_flowscripts

load_flowscripts [-bitstream]

This command loads all of the encrypted flow scripts.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-bitstream]</td>
<td>Y</td>
<td>load only scripts relevant for bitstream</td>
</tr>
</tbody>
</table>

load_project

load_project <projectFile> [-not_active] [-force]

This command loads a project file into ACE. Loading a project file does not load the design files, it just sets up a project for later use.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;projectFile&gt;</td>
<td></td>
<td>The required &lt;projectFile&gt; argument specifies the path to a project file.</td>
</tr>
<tr>
<td>[-not_active]</td>
<td>Y</td>
<td>If this option is set, no impl in the project will be activated and the active impl in ACE will not be changed.</td>
</tr>
<tr>
<td>[-force]</td>
<td>Y</td>
<td>The -force option can be used to override a project lock that has been set by another ACE session. Using -force causes the current ACE session to take ownership of the project lock for the project being restored. DO NOT use this option to run multiple ACE sessions on the same project at the same time, or else output files (acxprj, acxdb, icdb, jam, etc) and log files may become corrupted!</td>
</tr>
</tbody>
</table>

message


This command prints a status message to the console and the log file.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;msg&gt;</td>
<td></td>
<td>The message to be printed.</td>
</tr>
<tr>
<td>[-info]</td>
<td>Y</td>
<td>Make this message an informational message.</td>
</tr>
<tr>
<td>[-warning]</td>
<td>Y</td>
<td>Make this message a warning message.</td>
</tr>
<tr>
<td>[-error]</td>
<td>Y</td>
<td>Make this message an error message.</td>
</tr>
<tr>
<td>[-none]</td>
<td>Y</td>
<td>Make this message a none message (no prefix).</td>
</tr>
<tr>
<td>[-console_off]</td>
<td>Y</td>
<td>turn off console io</td>
</tr>
<tr>
<td>[-console_on]</td>
<td>Y</td>
<td>turn on console io</td>
</tr>
</tbody>
</table>
move_project_constraints

```
move_project_constraints [-project <string>] <file> <offset>
```

This command moves a project constraints file to the specified offset to allow re-ordering of constraints within a project.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; option is used to specify an alternate project (by name) to move constraints for.</td>
</tr>
<tr>
<td>&lt;file&gt;</td>
<td></td>
<td>The project constraints file to move.</td>
</tr>
<tr>
<td>&lt;offset&gt;</td>
<td></td>
<td>The offset to move the project constraints file to. Other constraints files will be moved down automatically.</td>
</tr>
</tbody>
</table>

move_project_netlists

```
move_project_netlists [-project <string>] <file> <offset>
```

This command moves a project netlist file to the specified offset to allow re-ordering of netlists within a project.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; option is used to specify an alternate project (by name) to move netlists for.</td>
</tr>
<tr>
<td>&lt;file&gt;</td>
<td></td>
<td>The project netlist file to move.</td>
</tr>
<tr>
<td>&lt;offset&gt;</td>
<td></td>
<td>The offset to move the project netlist file to. Other netlist files will be moved down automatically.</td>
</tr>
</tbody>
</table>

move_relative_paths

```
move_relative_paths <line> <source> <target>
```

Change relative paths in input string; starting out relative to parameter source ,returned as relative to parameter target.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;line&gt;</td>
<td></td>
<td>line containing a quoted string of paths.</td>
</tr>
<tr>
<td>&lt;source&gt;</td>
<td></td>
<td>The location of the original script containing &lt;line&gt;</td>
</tr>
<tr>
<td>&lt;target&gt;</td>
<td></td>
<td>The script that will contain &lt;line&gt; and still work.</td>
</tr>
</tbody>
</table>

optimize_tile

```
optimize_tile [-verbose] [-timing <int>] [-optimize_fixed]
```

optimize placement of single tile or tiles seperately
redirect

**redirect <command> [-variable <string>]**

redirect messages to variable.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;command&gt;</td>
<td></td>
<td>command to run</td>
</tr>
<tr>
<td>[-variable &lt;string&gt;]</td>
<td>Y</td>
<td>name of variable</td>
</tr>
</tbody>
</table>

refresh_drawing

**refresh_drawing**

This command refreshes the current custom drawing on the GUI's Floorplanner view.

regenerate_all_ip_design_files

**regenerate_all_ip_design_files [-ioringOutputDir <string>] [-add_to_project]**

This command re-generates design files the all ACXIP files in the active ACE project, for both Core fabric IP and IO Ring design.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-ioringOutputDir &lt;string&gt;]</td>
<td>Y</td>
<td>The -ioringOutputDir option allows the user to specify a non-default directory path to output the IO Ring design files into.</td>
</tr>
<tr>
<td>[-add_to_project]</td>
<td>Y</td>
<td>Using the -add_to_project option automatically adds the required generated IO Ring design files to your ACE project. This includes utilization XML, SDC constraints, PDC constraints, and IO Ring bitstream files.</td>
</tr>
</tbody>
</table>

remap_partial_bitstream

**remap_partial_bitstream <hex_file> <original_clusters> <new_clusters> [-output_file <string>]**

This command returns a list of compatible ordering codes for the active project based on it's device, package, and speed grade.
### remove_clock_preroute

remove_clock_preroute <net_name> <track_list> [-clock_regions <list>] [-clusters <list>] [-placement_regions <list>] [-partitions <list>]

This command will remove the pre-routing constraints from a clock or reset net on the clock tracks and regions specified.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;net_name&gt;</td>
<td></td>
<td>The name of the clock or reset net to remove from pre-routing.</td>
</tr>
<tr>
<td>&lt;track_list&gt;</td>
<td></td>
<td>The list of integer clock track numbers to remove from pre-route on this net. Valid clock track numbers are device-specific.</td>
</tr>
<tr>
<td>[-clock_regions &lt;list&gt;]</td>
<td>Y</td>
<td>The list of clock region names to remove from pre-route on this net. Valid clock region names are device-specific.</td>
</tr>
<tr>
<td>[-clusters &lt;list&gt;]</td>
<td>Y</td>
<td>The list of cluster names to remove from pre-route on this net. Valid cluster names are device-specific.</td>
</tr>
<tr>
<td>[-placement_regions &lt;list&gt;]</td>
<td>Y</td>
<td>The list of placement region names to remove from pre-route on this net. Valid placement region names are device-specific.</td>
</tr>
<tr>
<td>[-partitions &lt;list&gt;]</td>
<td>Y</td>
<td>The list of partition names to remove from pre-route on this net. Valid partition are device-specific.</td>
</tr>
</tbody>
</table>

### remove_flow_step

remove_flow_step <id>

This command removes an existing flow step from ACE only if the flow step is a user-defined flow step.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;id&gt;</td>
<td></td>
<td>The required &lt;id&gt; argument specifies the id of the flow step to remove.</td>
</tr>
</tbody>
</table>
remove_impl

remove_impl <implNames_list> [-project <string>]

This command removes multiple implementations from a project. The implementations' output directories on the file system are not deleted.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;implNames_list&gt;</td>
<td></td>
<td>The required &lt;implNames_list&gt; argument is used to specify the names of the implementations to remove.</td>
</tr>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; option is used to specify an alternate project (by name) for the implementation to be removed from.</td>
</tr>
</tbody>
</table>

remove_path

remove_path [<id>] [-all]

This command removes a user-defined pin path.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[&lt;id&gt;]</td>
<td>Y</td>
<td>Specifies the id of the path to remove</td>
</tr>
<tr>
<td>[-all]</td>
<td>Y</td>
<td>Removes all paths</td>
</tr>
</tbody>
</table>

remove_project

remove_project <projectName>

This command removes a project from ACE. The project file on disk is not deleted.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;projectName&gt;</td>
<td></td>
<td>The required &lt;projectName&gt; argument is used to specify the project to be removed (by name).</td>
</tr>
</tbody>
</table>

remove_project_constraints

remove_project_constraints <files> [-project <string>]

This command removes the link to an SDC, PDC, or TCL constraint file from a project. The SDC constraint file on disk is not deleted.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;files&gt;</td>
<td></td>
<td>The required &lt;files&gt; argument is used to specify the SDC, PDC, or TCL constraint files (by file path).</td>
</tr>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; option is used to specify an alternate project (by name) for the SDC constraint file to be removed from.</td>
</tr>
</tbody>
</table>
remove_project_constraints_pvt

remove_project_constraints_pvt <file>

This command allows the user to remove all PVT conditions from an SDC constraint file.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;file&gt;</td>
<td></td>
<td>The required &lt;file&gt; argument is used to specify the file path to the SDC constraint file.</td>
</tr>
</tbody>
</table>

remove_project_ip

remove_project_ip <list_of_files> [-project <string>]

This command removes the association from a project to one or more IP settings files. The IP settings files on disk are not deleted.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;list_of_files&gt;</td>
<td></td>
<td>The required &lt;list_of_files&gt; argument is used to specify the IP settings files (by file path). The file paths may be absolute, or may be relative to the acxprj file's directory.</td>
</tr>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; option is used to specify an alternate project (by name) for the IP settings file to be removed from. The named project must already be opened in ACE.</td>
</tr>
</tbody>
</table>

remove_project_netlist

remove_project_netlist <files> [-project <string>] [-impl <string>]

This command removes the link to a verilog netlist file from a project. The verilog netlist file on disk is not deleted.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;files&gt;</td>
<td></td>
<td>The required &lt;file&gt; argument is used to specify the verilog netlists (by file path).</td>
</tr>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; option is used to specify an alternate project (by name) for the verilog netlist to be removed from.</td>
</tr>
<tr>
<td>[-impl &lt;string&gt;]</td>
<td>Y</td>
<td>If a file belongs to an impl and should be removed only from that impl, specify that impl here.</td>
</tr>
</tbody>
</table>

remove_region

remove_region [-region <string>] [-all]

This command removes a placement region constraint specification.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-region &lt;string&gt;]</td>
<td>Y</td>
<td>Name of the region to delete</td>
</tr>
<tr>
<td>[-all]</td>
<td>Y</td>
<td>Remove all region constraints</td>
</tr>
</tbody>
</table>
remove_region_insts

remove_region_insts <region> [-insts <list>] [-all] [-flops_only] [-clocks_only] [-verbose]

Remove user design instances from an existing placement region constraint

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;region&gt;</td>
<td></td>
<td>name of the region to clear</td>
</tr>
<tr>
<td>[-insts &lt;list&gt;]</td>
<td>Y</td>
<td>List of user design instances to remove from this placement region constraint.</td>
</tr>
<tr>
<td>[-all]</td>
<td>Y</td>
<td>Clear all user design instances from this region constraint</td>
</tr>
<tr>
<td>[-flops_only]</td>
<td>Y</td>
<td>When removing instances, filter out all instances except flops</td>
</tr>
<tr>
<td>[-clocks_only]</td>
<td>Y</td>
<td>When removing instances, filter out all instances with no connected clock</td>
</tr>
<tr>
<td>[-verbose]</td>
<td>Y</td>
<td>Print additional debug messages.</td>
</tr>
</tbody>
</table>

rename_impl

rename_impl <newImplName> [-project <string>] [-impl <string>]

This command renames an implementation. Changing the name of an implementation also changes the name of the implementation output directory on disk (even without calling "save_project").

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;newImplName&gt;</td>
<td></td>
<td>The required &lt;newImplName&gt; argument is used to specify the new implementation name.</td>
</tr>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; and -impl &lt;implName&gt; options are used to specify an alternate project implementation (by name) to change the name for.</td>
</tr>
<tr>
<td>[-impl &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; and -impl &lt;implName&gt; options are used to specify an alternate project implementation (by name) to change the name for.</td>
</tr>
</tbody>
</table>

report_clock_regions

report_clock_regions [-outputfile <string>] [-text] [-csv]

This command generates and writes a formatted report showing which clock nets are routed in each clock region

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-outputfile &lt;string&gt;]</td>
<td>Y</td>
<td>The -outputfile &lt;file&gt; option may be used to specify an output file name or file path. If this option is not present, the output is written to the default implementation debug directory and is named &lt;design_name&gt;_regions.html.</td>
</tr>
<tr>
<td>[-text]</td>
<td>Y</td>
<td>The -text option is used to specify whether the file should be output to the console as plain text</td>
</tr>
</tbody>
</table>
### report_clocks

**report_clocks**

Report clocks in the current design

### report_coverage

**report_coverage**

```
```

Generate and write a coverage report for pins.

#### Argument Table

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-csv]</td>
<td>Y</td>
<td>The -csv option is used to specify whether the file should be output as a CSV file for use in Excel spreadsheets</td>
</tr>
</tbody>
</table>

#### Argument Details

- **[-outputfile <list>]**
  - Y
  - The optional -outputfile <file> option may be used to specify an output file name or file path. If this option is not present, the output is written to the default implementation reports directory and is named <design_name>__pins.html.

- **[-text]**
  - Y
  - The optional -text option is used to specify whether the file should be output as plain text.

- **[-csv]**
  - Y
  - The optional -csv option is used to specify whether the file should be output as a CSV file for use in Excel spreadsheets.

- **[-html]**
  - Y
  - The optional -html option is used to specify whether the file should be output as html-file.

- **[-columns <list>]**
  - Y
  - The optional -columns option is used to specify a customized ordered list of columns names to output in the pin assignment report.

- **[-verbose]**
  - Y
  - The optional -verbose option is used to specify whether the file should report ALL attributes and parameters for each IO port/pad.

### report_design_stats

**report_design_stats**

```
report_design_stats [-outputfile <list>] [-html] [-csv] [-text]
```

This command generates and writes a formatted report about various design statistics

#### Argument Table

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-outputfile &lt;list&gt;]</td>
<td>Y</td>
<td>The -outputfile &lt;file&gt; option specifies a Tcl list of one or more output file names or file path names. If this option is not present, the output depends on the -text, -html, and -csv options. If -text is given the output is written to the GUI console and Ace logfile. If -html or -csv is given, the output is written to the default implementation reports directory in a file named &lt;design_name&gt;__design_stats, with the extension .html or .csv (respectively).</td>
</tr>
<tr>
<td>Argument</td>
<td>Optional</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>[-html]</td>
<td>Y</td>
<td>The -html option specifies that the output file(s) are written in HTML format (this is the default)</td>
</tr>
<tr>
<td>[-csv]</td>
<td>Y</td>
<td>The -csv option specifies that the output file(s) are written in CSV format for import into Excel spreadsheets</td>
</tr>
<tr>
<td>[-text]</td>
<td>Y</td>
<td>The -text option specifies that the output file(s) are written in plain text format</td>
</tr>
</tbody>
</table>

**report_impl_options**


Output a report of the current impl options defined in ACE. If no -project and/or -impl options are specified, the active impl will be reported.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-outputfile &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -outputfile option may be used to specify an output file name or file path. If this option is not present, the output is written to the default implementation reports directory and is named &lt;design_name&gt;_impl_options.html.</td>
</tr>
<tr>
<td>[-text]</td>
<td>Y</td>
<td>The optional -text option is used to specify that the file should be output as plain text.</td>
</tr>
<tr>
<td>[-csv]</td>
<td>Y</td>
<td>The optional -csv option is used to specify that the file should be output as a CSV file for use in Excel spreadsheets.</td>
</tr>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; option must be used with -impl &lt;implName&gt;. These options are used to specify an alternate project implementation (by name).</td>
</tr>
<tr>
<td>[-impl &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -impl &lt;implName&gt; option can be used with or without the -project &lt;projectName&gt; option to specify an impl. Without -project &lt;projectName&gt;, -impl &lt;implName&gt; finds the impl in the active project.</td>
</tr>
<tr>
<td>[-hide_values]</td>
<td>Y</td>
<td>If the -hide_values flag is used, the report will NOT output an additional column to display the current values for the given impl.</td>
</tr>
<tr>
<td>[-show_standard]</td>
<td>Y</td>
<td>If the -show_standard flag is used, the report and optional diff options Tcl file will ONLY output standard options that show in the GUI. If this flag is not set, by default, all available options for the active impl will be output.</td>
</tr>
<tr>
<td>[-diff_options]</td>
<td>Y</td>
<td>The optional -diff_options flag is used to create a Tcl file containing the full set of implementation options with values which vary from the default values. Each impl option's default value is listed as a comment.</td>
</tr>
</tbody>
</table>

**report_partitions**

`report_partitions [-outputfile <list>] [-html] [-csv] [-text]`

This command generates and writes a formatted partition report.
**Argument** | **Optional** | **Description**
---|---|---
[-outputfile <list>] | Y | The -outputfile <file> option specifies a Tcl list of one or more output file names or file path names. If this option is not present, the output depends on the -text, -html, and -csv options. If -text is given the output is written to the GUI console and Ace logfile. If -html or -csv is given, the output is written to the default implementation reports directory in a file named <design_name>_partitions, with the extension .html or .csv (respectively).

[-html] | Y | The -html option specifies that the output file(s) are written in HTML format (this is the default)

[-csv] | Y | The -csv option specifies that the output file(s) are written in CSV format for import into Excel spreadsheets

[-text] | Y | The -text option specifies that the output file(s) are written in plain text format

---

**report_performance**

`report_performance [-outputfile <list>] [-html] [-csv] [-text] [<num_paths>] [-setup_pass_only]`

Generate a report detailing the estimated design performance and the quality of the mapping in ACE, including a critical path breakdown

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
</table>
| [-outputfile <list>] | Y | The -outputfile <file> option specifies a Tcl list of one or more output file names or file path names. If this option is not present, the output depends on the -text, -html, and -csv options. If -text is given the output is written to the GUI console and Ace logfile. If -html or -csv is given, the output is written to the default implementation reports directory in a file named <design_name>_performance_report, with the extension .html or .csv (respectively).

| [-html] | Y | The -html option specifies that the output file(s) are written in HTML format (this is the default)

| [-csv] | Y | The -csv option specifies that the output file(s) are written in CSV format for import into Excel spreadsheets

| [-text] | Y | The -text option specifies that the output file(s) are written in plain text format

| [<num_paths>] | Y | The number of critical paths to analyze in each clock domain (default is 3)

| [-setup_pass_only] | Y | If set, only paths that meet timing are logged

---

**report_pins**


Generate and write a pin to package assignment report
### Argument

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-outputfile &lt;list&gt;]</td>
<td>Y</td>
<td>The optional -outputfile &lt;file&gt; option may be used to specify an output file name or file path. If this option is not present, the output is written to the default implementation reports directory and is named &lt;design_name&gt;_pins.html.</td>
</tr>
<tr>
<td>[-text]</td>
<td>Y</td>
<td>The optional -text option is used to specify whether the file should be output as plain text.</td>
</tr>
<tr>
<td>[-csv]</td>
<td>Y</td>
<td>The optional -csv option is used to specify whether the file should be output as a CSV file for use in Excel spreadsheets.</td>
</tr>
<tr>
<td>[-html]</td>
<td>Y</td>
<td>The optional -html option is used to specify whether the file should be output as html-file.</td>
</tr>
<tr>
<td>[-columns &lt;list&gt;]</td>
<td>Y</td>
<td>The optional -columns option is used to specify a customized ordered list of columns names to output in the pin assignment report.</td>
</tr>
</tbody>
</table>

### report_placement

`report_placement [-outputfile <list>] [-html] [-csv] [-text]`

This command generates and writes a formatted placement QoR report.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-outputfile &lt;list&gt;]</td>
<td>Y</td>
<td>The -outputfile &lt;file&gt; option specifies a Tcl list of one or more output file names or file path names. If this option is not present, the output depends on the -text, -html, and -csv options. If -text is given the output is written to the GUI console and Ace logfile. If -html or -csv is given, the output is written to the default implementation reports directory in a file named &lt;design_name&gt;_placement, with the extension .html or .csv (respectively).</td>
</tr>
<tr>
<td>[-html]</td>
<td>Y</td>
<td>The -html option specifies that the output file(s) are written in HTML format (this is the default)</td>
</tr>
<tr>
<td>[-csv]</td>
<td>Y</td>
<td>The -csv option specifies that the output file(s) are written in CSV format for import into Excel spreadsheets</td>
</tr>
<tr>
<td>[-text]</td>
<td>Y</td>
<td>The -text option specifies that the output file(s) are written in plain text format</td>
</tr>
</tbody>
</table>

### report_power


This command generates and writes a formatted power dissipation report.
### \[-outputfile <list>] Y

The\[-outputfile <file>\] option specifies a Tcl list of one or more output file names or file path names. If this option is not present, the output depends on the\[-text, -html, and -csv\] options. If\[-text\] is given the output is written to the GUI console and Ace logfile. If\[-html\] or\[-csv\] is given, the output is written to the default implementation reports directory in a file named <design_name>_power, with the extension .html or .csv (respectively).

### \[-html\] Y

The\[-html\] option specifies that the output file(s) are written in HTML format (this is the default)

### \[-csv\] Y

The\[-csv\] option specifies that the output file(s) are written in CSV format for import into Excel spreadsheets

### \[-text\] Y

The\[-text\] option specifies that the output file(s) are written in plain text format

### \[-temperature <string>] Y

Override the junction temperature printed in the report header

### \[-clocks <string>] Y

The\[-clocks \{ {clk1 freq} {clk2 freq} .. {clkn freq} \}\] option may be used to specify the operating frequency (in MHz) of all the clocks in the design. If this option is not present, the frequencies from the design constraints will be used by default. If no constraints are found, the best achieved frequency will be used.

### \[-achieved\] Y

The\[-achieved\] option may be used to specify that achieved static timing results be used to calculate the power dissipation report for each clock

### \[-saif_file <string>] Y

The\[-saif_file\] option may be used to specify the path to a .saif file. Switching Activity Interchange Format (saif) files can be used to provide a more accurate power profile of a design.

### \[-saif_top_level <string>] Y

The\[-saif_top_level\] option may be used to specify the name of the top level instance in the saif file. Default name used is "DUT".

---

**report_routing**

```
```

This command generates and writes a formatted routing report.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-outputfile &lt;list&gt;]</td>
<td>Y</td>
<td>The optional [-outputfile &lt;file&gt;] option may be used to specify an output file name or file path. If this option is not present, the output is written to the default implementation debug directory and is named &lt;design_name&gt;_routing.html.</td>
</tr>
<tr>
<td>[-text]</td>
<td>Y</td>
<td>The optional [-text] option is used to specify whether the file should be output as plain text ( Default is autodetect )</td>
</tr>
</tbody>
</table>
### Argument Details

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-csv]</td>
<td>Y</td>
<td>The optional -csv option is used to specify whether the file should be output as a CSV file for use in Excel spreadsheets.</td>
</tr>
<tr>
<td>[-html]</td>
<td>Y</td>
<td>The optional -html option is used to specify whether the file should be output as html-file.</td>
</tr>
<tr>
<td>[-nonterse]</td>
<td>Y</td>
<td>normal information level.</td>
</tr>
<tr>
<td>[-terse]</td>
<td>Y</td>
<td>terse info level.</td>
</tr>
<tr>
<td>[-wl]</td>
<td>Y</td>
<td>wire length report.</td>
</tr>
<tr>
<td>[-overflowreportlimit &lt;int&gt;]</td>
<td>Y</td>
<td>limit on the number of overflows. Defaults to 11.</td>
</tr>
</tbody>
</table>

### report_utilization

`report_utilization [-outputfile <list>] [-html] [-csv] [-text]`

This command generates and writes a formatted device utilization report.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-outputfile &lt;list&gt;]</td>
<td>Y</td>
<td>The -outputfile &lt;file&gt; option specifies a Tcl list of one or more output file names or file path names. If this option is not present, the output depends on the -text, -html, and -csv options. If -text is given the output is written to the GUI console and Ace log file. If -html or -csv is given, the output is written to the default implementation reports directory in a file named &lt;design_name&gt;_utilization, with the extension .html or .csv (respectively).</td>
</tr>
<tr>
<td>[-html]</td>
<td>Y</td>
<td>The -html option specifies that the output file(s) are written in HTML format (this is the default)</td>
</tr>
<tr>
<td>[-csv]</td>
<td>Y</td>
<td>The -csv option specifies that the output file(s) are written in CSV format for import into Excel spreadsheets</td>
</tr>
<tr>
<td>[-text]</td>
<td>Y</td>
<td>The -text option specifies that the output file(s) are written in plain text format</td>
</tr>
</tbody>
</table>

### reset_impl_option

`reset_impl_option [<option_name>] [-all] [-project <string>] [-impl <string>]`

This command resets a project implementation option to its (device-specific) default value. Only one option may be reset at a time.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[&lt;option_name&gt;]</td>
<td>Y</td>
<td>The name of the impl option to reset to its default. To see a list of valid impl options, use the report_impl_options TCL command.</td>
</tr>
<tr>
<td>[-all]</td>
<td>Y</td>
<td>The optional -all option resets all impl options to their device-specific default values.</td>
</tr>
</tbody>
</table>
## Argument Table

### Argument | Optional | Description
--- | --- | ---
[-project <string>] | Y | The optional -project <projectName> and -impl <implName> options are used to specify an alternate project implementation (by name) to set options for.

[-impl <string>] | Y | The optional -project <projectName> and -impl <implName> options are used to specify an alternate project implementation (by name) to set options for.

---

### restore_impl

**restore_impl <filename> [-project <string>] [-impl <string>]**

The `restore_impl` command loads an ACXDB file to restore the state of the DB and impl options for a given impl. Restoring an impl automatically makes that impl the active impl. If no -impl and -project options are specified, then the ACXDB file is loaded for the current active impl. By default, the DB will be restored using all saved information in the ACXDB file, including placement and routing information. Restoring an impl overrides the current impl option values with the impl option values saved in the ACXDB file. Restoring an impl clears the current state of the DB for the current active impl, so be sure to save your active impl before restoring an impl.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;filename&gt;</td>
<td></td>
<td>Specifies the ACXDB file path to restore the state of the active impl from</td>
</tr>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>Specifies an alternate project name to use instead of the active project when using the -impl &lt;implname&gt; option</td>
</tr>
<tr>
<td>[-impl &lt;string&gt;]</td>
<td>Y</td>
<td>Specifies an alternate impl name to restore instead of restoring the current active impl</td>
</tr>
</tbody>
</table>

This functionality is also accessible through buttons/menus in the ACE GUI as described in **Restoring Implementations (see page 280).**

---

**Restoring an Implementation clears current data**

Restoring an Implementation (see page 217) will first clear all data in memory before beginning the restore process. Any data that has not been saved will be lost. The restored implementation (and project) will become the Active Project and Active Implementation, and all Implementation Options will also be restored from file, overwriting any values currently in memory.

See also: **save_impl** and Saving Implementations (see page 279).

---

### restore_project

**restore_project <projectFile> [-reload] [-not_active] [-no_db] [-activeimpl <string>] [-acxdb <string>] [-force]**

The `restore_project` command loads an ACE project (.acxprj) file and restores the project's implementation options. The -acxdb option can be used to specify the file path of the ACXDB file to restore the DB state for the active implementation. The -activeimpl option can be used to specify the impl name to activate and restore. If -not_active is used, no impl in the project will be activated or restored from its ACXDB file and the active impl in ACE will not be changed.
### Argument | Optional | Description
--- | --- | ---
<projectFile> |  | Specifies the ACE project (.acxprj) file path to load and restore.
[-reload] | Y | Use this option to re-load the ACE project (.acxprj) file from disk. This will clear the design DB and flow status, requiring the design to be re-run from the beginning of the flow.
[-not_active] | Y | If this option is set, no impl in the project will be activated or restored from its ACXDB file and the active impl in ACE will not be changed.
[-no_db] | Y | If this option is set, the DB state of the active impl for the project will not be restored.
[-activeimpl <string>] | Y | The -activeimpl option can be used to specify an alternate impl name to activate and restore. By default, the last active impl during the session the project was saved in will be activated.
[-acxdb <string>] | Y | Specifies an ACXDB file path from which to restore the state of the active impl.
[-force] | Y | The -force option can be used to override a project lock that has been set by another ACE session. Using -force causes the current ACE session to take ownership of the project lock for the project being restored. **DO NOT use this option to run multiple ACE sessions on the same project at the same time, or else output files (acxprj, acxdb, icdb, jam, etc) and log files may become corrupted!**

### run

run [-step <string>] [-stop_at_step <string>] [-resume] [-ic <string>]

This command runs the steps of the design flow. It can be used to run the entire flow from the beginning, run a specific flow step, or resume the flow from the last incomplete step. Using no options will run the entire flow from the beginning. The default Achronix flow step IDs (for those options requiring them) are: {prepare run_prepare report_timing_prepared write_netlist_prepared place_and_route run_place report_timing_placed run_route report_timing_routed design_completion post_process final_drc_checks report_timing_final write_netlist_final fpga_program write_bitstream fpga_download} Because advanced users may create their own flow steps, a complete list of all flow step IDs can be retrieved with the Tcl command ‘get_flow_steps’.

### Argument | Optional | Description
--- | --- | ---
[-step <string>] | Y | The optional -step <id> option is used to run the specified flow step, by ID, (along with any incomplete required pre-requisite steps,) and all of its children. See ‘get_flow_steps’ for a list of all IDs.
[-stop_at_step <string>] | Y | The optional -stop_at_step <id> option is used to stop the flow after running the specified flow step, by ID. See ‘get_flow_steps’ for a list of all IDs.
[-resume] | Y | The optional -resume option is used to run the entire flow from the last successfully completed flow step.
The optional `-ic <string>` option specifies incremental compilation flow modes. 'init' implies beginning of the flow without using previous state of compiled design and 'continue' implies incrementally compiling of previous state of design.

### run_fanout_control

run_fanout_control [-physical <int>] [-fanout_limit <int>] [-fanout_limit_clone <int>]

This command does fanout control for high fanout control nets.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-physical &lt;int&gt;</code></td>
<td>Y</td>
<td>Clone Critical Instances that have slack lower than this limit</td>
</tr>
<tr>
<td><code>-fanout_limit &lt;int&gt;</code></td>
<td>Y</td>
<td>Apply fanout control on nets with fanout greater than this limit</td>
</tr>
<tr>
<td><code>-fanout_limit_clone &lt;int&gt;</code></td>
<td>Y</td>
<td>Apply fanout cloning on nets with fanout greater than this limit</td>
</tr>
</tbody>
</table>

### run_final_drc_checks

run_final_drc_checks

This command performs final DRC checks on the active design. If there is currently no active project/implementation, the reportsdir and debugdir must be specified.

### run_fpga_download

run_fpga_download [-hex_file <string>]

This command downloads the generated bitstream to the target device for the active implementation.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-hex_file &lt;string&gt;</code></td>
<td>Y</td>
<td>Optional hex file to download. The default hex file in your output directory will be used if this is not specified</td>
</tr>
</tbody>
</table>

### run_generate_bitstream

run_generate_bitstream [-outputdir <string>] [-aeskey <string>]

This command generates a bitstream file for programming the target device.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-outputdir &lt;string&gt;</code></td>
<td>Y</td>
<td>Output directory name</td>
</tr>
<tr>
<td><code>-aeskey &lt;string&gt;</code></td>
<td>Y</td>
<td>Key used for encryption. If not given, key is taken from impl. If not active in impl, the bitstream is not encrypted.</td>
</tr>
</tbody>
</table>
run_generate_final_reports

run_generate_final_reports [-name_postfix <string>] [-format <string>]

This command generates various report files, including clocks, pins, power, etc. Implementation options are used to control which report files are generated.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-name_postfix &lt;string&gt;]</td>
<td>Y</td>
<td>Postfix added to report file name (e.g., to distinguish multiple 'placed' reports)</td>
</tr>
<tr>
<td>[-format &lt;string&gt;]</td>
<td>Y</td>
<td>Specify report formats; default is { text html csv }</td>
</tr>
</tbody>
</table>

run_generate_fullchip_sim

run_generate_fullchip_sim [-debugdir <string>] [-modelsdir <string>]

This command generates the files necessary for fullchip simulation.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-debugdir &lt;string&gt;]</td>
<td>Y</td>
<td>The -debugdir &lt;dir&gt; option is used to override the default location for debug files during this step.</td>
</tr>
<tr>
<td>[-modelsdir &lt;string&gt;]</td>
<td>Y</td>
<td>The -modelsdir &lt;dir&gt; option is used to override the default location for the fullchip sim top-level models.</td>
</tr>
</tbody>
</table>

run_generate_netlist

run_generate_netlist [-outputfile <string>] [-final] [-compress]

This command generates a verilog netlist for simulation.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-outputfile &lt;string&gt;]</td>
<td>Y</td>
<td>Output netlist file name.</td>
</tr>
<tr>
<td>[-final]</td>
<td>Y</td>
<td>Output DRC-free final netlist</td>
</tr>
<tr>
<td>[-compress]</td>
<td>Y</td>
<td>Compress output file with gzip</td>
</tr>
</tbody>
</table>

run_insert_holdbuffers

run_insert_holdbuffers [-margin <int>] [-io_buffers <int>] [-typebased_buffers <int>]

This command generates extra gate delays by inserting a buffer per target pin if that pin has a hold time slack value that is less than the margin specified.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-margin &lt;int&gt;]</td>
<td>Y</td>
<td>Insert a delay buffer per target pin whose hold time slack is less than the specified value</td>
</tr>
</tbody>
</table>
### Argument | Optional | Description
---|---|---
`[-io_buffers <int>]` | Y | Insert a delay buffer per target pin when driven directly by a flopped IO Pad/Pin.
`[-typebased_buffers <int>]` | Y | Insert a delay buffer per target pin according to the given cell-type bitfield specification (2^0 = DFF inputs, 2^1 = DFF outputs, 2^2 = clocked OPIN inputs, 2^3 = clocked IPIN outputs, 2^4 = BRAM inputs, 2^5 = BRAM outputs, 2^6 = LRAM inputs, 2^7 = LRAM outputs, 2^8 = DSP inputs, 2^9 = DSP outputs, 2^10 = MLP inputs, 2^11 = MLP outputs, 2^12 = NAP inputs, 2^13 = NAP outputs). All other values are reserved for future use and should be unset."

#### run_multiprocess


This command runs the ACE multiprocess flow for the active implementation. To generate new implementations from option sets and run multiprocess, use `create_option_sets`. NOTE: For any optional arguments that are not specified, the current Multiprocess configuration from the ACE GUI User Preferences will be used as defaults.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
</table>
| `[-use_existing_impls <list>]` | Y | The `use_existing_impls` option allows the user to specify a list of existing impl names to run in multiprocess, instead of using seed sweep or generating impls from option sets. To run all existing impls, you can specify `use_existing_impls [ace::get_impl_names]`.
| `[-use_seeds <list>]` | Y | The `use_seeds` option allows the user to specify a list of PnR seed values to run in multiprocess, instead of using existing impls or generating impls from option sets.
| `[-parallel_job_count <int>]` | Y | (optional) Sets the number of implementations to run in parallel. If not specified, defaults to the GUI's preference setting.
| `[-use_job_submission <int>]` | Y | (optional) Set to a 0 to run background jobs on the local machine, or set to a 1 to submit jobs to a cloud/grid/batch submission system. If not specified, defaults to the GUI's preference setting.
| `[-stop_flow_at <string>]` | Y | (optional) If a valid flow step ID is specified, that flow step will be enabled and will be the last flow step executed by all implementations. If not specified, ACE will run the entire flow (ignores user's GUI preference setting).
| `[-copy_icdb <int>]` | Y | (optional) Set to a 1 to copy the incremental flow DB from the template impl, or set to a 0 to not copy. Defaults to 0 (no file copy) if not specified (ignores user's GUI preference setting).
| `[-jobs_exec <string>]` | Y | (optional) Specify the job submission system executable. Relevant only when a job submission system is in use. If not specified, defaults to the GUI's preference setting.
<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-jobs_wd &lt;string&gt;]</td>
<td>Y</td>
<td>(optional) Specify the job submission system working directory argument. Relevant only when a job submission system is in use. If not specified, defaults to the GUI's preference setting.</td>
</tr>
<tr>
<td>[-jobs_name &lt;string&gt;]</td>
<td>Y</td>
<td>(optional) Specify the job submission system job name argument. Relevant only when a job submission system is in use. If not specified, defaults to the GUI's preference setting.</td>
</tr>
<tr>
<td>[-jobs_log &lt;string&gt;]</td>
<td>Y</td>
<td>(optional) Specify the job submission system job log argument. Relevant only when a job submission system is in use. If not specified, defaults to the GUI's preference setting.</td>
</tr>
<tr>
<td>[-jobs_args &lt;list&gt;]</td>
<td>Y</td>
<td>(optional) Specify the job submission system list of additional arguments, each with at most one optional value, formatted as a list of TCL lists in the form: {(arg1 val1) (arg2 (arg3 val3) ...}. Relevant only when a job submission system is in use. If not specified, defaults to the GUI's preference setting.</td>
</tr>
<tr>
<td>[-jobs_nfs_latency &lt;int&gt;]</td>
<td>Y</td>
<td>(optional) Specify the allowed seconds of NFS write latency (how long to wait between process completion and reading the files generated by the just-finished process). This is relevant both to local background jobs, and job submission systems. If not specified, defaults to the GUI's preference setting.</td>
</tr>
<tr>
<td>[-create_option_sets]</td>
<td>Y</td>
<td>(optional) Auto-generate option sets relevant to the active implementation, which will appear the active impl's option_sets directory. Note that this is only relevant when neither -use_existing_impls nor -use_seeds are active (meaning we're in the default mode, generating new impls for option sets).</td>
</tr>
<tr>
<td>[-remove_nonbest]</td>
<td>Y</td>
<td>(optional) Removes all recently generated implementations from the Projects View, except for the base impl and best impl, at the end of the Multiprocess run.</td>
</tr>
</tbody>
</table>

**Default Values**

For any parameters that are not specified, the ACE GUI user preferences will be used. For example, if -parallel_job_count is not explicitly specified, and if your ACE GUI user preferences are currently configured to use four (4) jobs, that value will be used for your batch multiprocess run.

A more detailed description of the use of run_multiprocess can be found in the Multiprocess Batch Mode (see page 295) section.

The GUI provides a graphical interface for multiprocess through the Multiprocess View (see page 86). See also: Running Multiple Flows in Parallel (see page 285), Attempting Likely Optimizations Using Option Sets (see page 369).

**run_multiprocess_iterator**

This command runs the ACE multiprocess flow for the active implementation for 5 (default) iterations, each time selecting
the 'best' impl option for the subsequent multiprocess run. To run the same multiprocess flow as run_multiprocess, this
command is exposed to all options from run_multiprocess. To run multiprocess with option sets, use -create_option_sets.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-use_existing_impls &lt;list&gt;]</td>
<td>Y</td>
<td>The use_existing_impls option allows the user to specify a list of existing impl names to run in multiprocess, instead of using seed sweep or generating impls from option sets. To run all existing impls, you can specify -use_existing_impls [ace::get_impl_names]</td>
</tr>
<tr>
<td>[-use_seeds &lt;list&gt;]</td>
<td>Y</td>
<td>The use_seeds option allows the user to specify a list of PnR seed values to run in multiprocess, instead of using existing impls or generating impls from option sets.</td>
</tr>
<tr>
<td>[-parallel_job_count &lt;int&gt;]</td>
<td>Y</td>
<td>(optional) Sets the number of implementations to run in parallel. If not specified, defaults to the GUI's preference setting.</td>
</tr>
<tr>
<td>[-use_job_submission &lt;int&gt;]</td>
<td>Y</td>
<td>(optional) Set to a 0 to run background jobs on the local machine, or set to a 1 to submit jobs to a cloud/grid/batch submission system. If not specified, defaults to the GUI's preference setting.</td>
</tr>
<tr>
<td>[-stop_flow_at &lt;string&gt;]</td>
<td>Y</td>
<td>(optional) If a valid flow step ID is specified, that flow step will be enabled and will be the last flow step executed by all implementations. If not specified, ACE will run the entire flow (ignores user's GUI preference setting).</td>
</tr>
<tr>
<td>[-copy_icdb &lt;int&gt;]</td>
<td>Y</td>
<td>(optional) Set to a 1 to copy the incremental flow DB from the template impl, or set to a 0 to not copy. Defaults to 0 (no file copy) if not specified (ignores user's GUI preference setting).</td>
</tr>
<tr>
<td>[-jobs_exec &lt;string&gt;]</td>
<td>Y</td>
<td>(optional) Specify the job submission system executable. Relevant only when a job submission system is in use. If not specified, defaults to the GUI's preference setting.</td>
</tr>
<tr>
<td>[-jobs_wd &lt;string&gt;]</td>
<td>Y</td>
<td>(optional) Specify the job submission system working directory argument. Relevant only when a job submission system is in use. If not specified, defaults to the GUI's preference setting.</td>
</tr>
<tr>
<td>[-jobs_name &lt;string&gt;]</td>
<td>Y</td>
<td>(optional) Specify the job submission system job name argument. Relevant only when a job submission system is in use. If not specified, defaults to the GUI's preference setting.</td>
</tr>
<tr>
<td>[-jobs_log &lt;string&gt;]</td>
<td>Y</td>
<td>(optional) Specify the job submission system job log argument. Relevant only when a job submission system is in use. If not specified, defaults to the GUI's preference setting.</td>
</tr>
<tr>
<td>[-jobs_args &lt;list&gt;]</td>
<td>Y</td>
<td>(optional) Specify the job submission system list of additional arguments, each with at most one optional value, formatted as a list of TCL lists in the form: {{arg1 val1} {arg2 val2} {arg3 val3} ...}. Relevant only when a job submission system is in use. If not specified, defaults to the GUI's preference setting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(optional) Specify the allowed seconds of NFS write latency (how long to wait between process completion and reading the files generated by the just-finished</td>
</tr>
</tbody>
</table>
### Argument Table

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>[-jobs_nfs_latency &lt;int&gt;]</code></td>
<td>Y</td>
<td>process. This is relevant both to local background jobs, and job submission systems. If not specified, defaults to the GUI's preference setting.</td>
</tr>
<tr>
<td><code>[-create_option_sets]</code></td>
<td>Y</td>
<td>(optional) Auto-generate option sets relevant to the active implementation, which will appear the active impl's option_sets directory. Note that this is only relevant when neither <code>-use_existing_impls</code> nor <code>-use_seeds</code> are active (meaning we're in the default mode, generating new impls for option sets).</td>
</tr>
<tr>
<td><code>[-remove_nonbest]</code></td>
<td>Y</td>
<td>(optional) Removes all recently generated implementations from the Projects View, except for the base impl and best impl, at the end of the Multiprocess run.</td>
</tr>
<tr>
<td><code>[-iterations &lt;int&gt;]</code></td>
<td>Y</td>
<td>The iterations option allows the user to specify the number of iterations between 1 and 5. Default is 5.</td>
</tr>
</tbody>
</table>

#### Warning: Early Access Functionality

This multiprocess iterator (along with the QoR sorting of the Multiprocess Summary Report (see page 240)) should currently be considered early-access functionality. Future ACE releases may improve QoR, reduce runtimes, and require fewer iterations to achieve similar results.

See also: `run_multiprocess`, Multiprocess View (see page 86), Running Multiple Flows in Parallel (see page 285), Attempting Likely Optimizations Using Option Sets (see page 369), Multiprocess Batch Mode (see page 295)

---

**run_place**

`run_place`

This command clears all routing and places the design.

**run_post_process**

`run_post_process`

This command post-processes the routed design to insert reset and other Achronix-specific technologies.

**run_prepare**

`run_prepare [-ic <string>]`

This command clears the current netlist and constraints data, then loads all the design files for the active implementation, runs design checks, and compiles the design into an Achronix design.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>[-ic &lt;string&gt;]</code></td>
<td>Y</td>
<td>The optional `-ic init</td>
</tr>
</tbody>
</table>

**run_route**

`run_route`

This command routes the design.
run_secureshare


Read or generate a SecureShare Manifest File, and create a zipped (and optionally encrypted) archive containing project source, database, log, report, and debug files. To receive better support, please attach this zip to your Achronix support ticket.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-read_manifest &lt;string&gt;</code></td>
<td>Y</td>
<td>Manifest file path read to generate an archive (unless <code>-no_archive</code> is specified). Cannot be used with <code>-generate_manifest</code>.</td>
</tr>
<tr>
<td><code>-generate_manifest &lt;string&gt;</code></td>
<td>Y</td>
<td>Manifest file output path, and default archive output path (unless <code>-archive_path</code> is specified). Cannot be used with <code>-read_manifest</code>.</td>
</tr>
<tr>
<td><code>-archive_path &lt;string&gt;</code></td>
<td>Y</td>
<td>Archive output path, which can override the output directory within a manifest when using <code>-read_manifest</code>.</td>
</tr>
<tr>
<td><code>-encrypt</code></td>
<td>Y</td>
<td>Encrypt the archive. With <code>-read_manifest</code>, the archive is always encrypted (unless <code>-no_archive</code> is specified). With <code>-generate_manifest</code>, the manifest is marked for encryption, and the generated archive is encrypted (unless <code>-no_archive</code> is specified).</td>
</tr>
<tr>
<td><code>-wizard</code></td>
<td>Y</td>
<td>Generate a manifest and then open the GUI file-picker.</td>
</tr>
<tr>
<td><code>-force</code></td>
<td>Y</td>
<td>Overwrite generated output files.</td>
</tr>
</tbody>
</table>

**Why is this command taking so long?**

In some cases, such as when the home directory is mounted to a network drive, reading the log files can be quite slow. To skip this step run, add the following flag to the `run_secureshare` command:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-skip_home_directory_logs</code></td>
<td>Y</td>
<td>When generating a manifest, do not search the home directory for log files.</td>
</tr>
</tbody>
</table>

**Example**

Running the command with no arguments will automatically generate a SecureShare manifest and archive using the current active impl:

```
run_secureshare
```

If you'd like to create the archive in a specific location, rather than the project default, use:

```
run_secureshare -archive_path <output_path>
```

⚠️ The file extension for a regular SecureShare archive will always be .zip
To encrypt the archive, use:

```
run_secureshare -encrypt
```

---

The file extension for an encrypted SecureShare archive will always be .zip.encrypted

---

To generate an archive from a previously created manifest, use:

```
run_secureshare -read_manifest <manifest_path.acxssm>
```

This will read the .acxssm manifest file, which includes the archive output directory and encryption status, and generate an archive using these options. You can override the manifest with the -archive_path <output_path> and -encrypt options.

If you'd like to automatically create a manifest without generating an archive, use:

```
run_secureshare -no_archive
```

---

To specify the manifest path, use:

```
run_secureshare -generate_manifest <manifest_path>
```

---

The file extension for a SecureShare manifest will always be .acxssm

---

To overwrite manifest and archive outputs, as well as create missing directories, use:

```
run_secureshare -force
```

---

**run_snapshot**

```
```

This command runs the Snapshot Debugger for a given Snapshot configuration (.snapshot file). This command outputs a VCD file and a Log file. The file paths are specified in the Snapshot configuration file.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;snapshotFile&gt;</code></td>
<td></td>
<td>The required <code>&lt;snapshotFile&gt;</code> argument specifies the Snapshot configuration (.snapshot file) to be used by Snapshot debugger.</td>
</tr>
<tr>
<td><code>-pod_name &lt;string&gt;</code></td>
<td>Y</td>
<td>(optional) specifies which JTAG pod connection to use. (If not specified, the current JTAG Connection configuration from the GUI User Preferences will be the default.)</td>
</tr>
<tr>
<td><code>-ir_bits_before &lt;int&gt;</code></td>
<td>Y</td>
<td>(optional) Sets the (decimal) number of instruction register bits between the board JTAG TDI pin and the target device. Use 0 for single-device JTAG scan chains. (If not specified, the current JTAG Connection configuration from the GUI User Preferences will be the default.)</td>
</tr>
</tbody>
</table>
### run_stapl_action


This command executes the given stapl program action.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;stapl_file&gt;</code></td>
<td>R</td>
<td>(required) specifies which STAPL file will contain the Action to be run.</td>
</tr>
<tr>
<td><code>&lt;action&gt;</code></td>
<td>R</td>
<td>(required) specifies which STAPL Action will be run.</td>
</tr>
<tr>
<td>[-pod_name &lt;string&gt;]</td>
<td>Y</td>
<td>(optional) specifies which JTAG pod connection to use. (If not specified, autodetection will be attempted.)</td>
</tr>
<tr>
<td>[-ir_bits_before &lt;int&gt;]</td>
<td>Y</td>
<td>(optional) Sets the (decimal) number of instruction register bits between the board JTAG TDI pin and the target device. Use 0 for single-device JTAG scan chains. (If not specified, the value embedded within the STAPL will be used.)</td>
</tr>
<tr>
<td>[-ir_bits_after &lt;int&gt;]</td>
<td>Y</td>
<td>(optional) Sets the (decimal) number of instruction register bits between the target device and the board JTAG TDO pin. Use 0 for single-device JTAG scan chains. (If not specified, the value embedded within the STAPL will be used.)</td>
</tr>
<tr>
<td>[-target_offset &lt;int&gt;]</td>
<td>Y</td>
<td>(optional) Sets the device count (in decimal) between the board JTAG TDI pin and target FPGA device. Use 0 for single-device JTAG scan chains. (If not specified, the value embedded within the STAPL will be used.)</td>
</tr>
<tr>
<td>[-disabled_procs &lt;list&gt;]</td>
<td>Y</td>
<td>(optional) specifies which recommended STAPL Procedures in the specified Action should be skipped.</td>
</tr>
<tr>
<td>[-enabled_procs &lt;list&gt;]</td>
<td>Y</td>
<td>(optional) specifies which optional STAPL Procedures in the specified Action should be executed.</td>
</tr>
</tbody>
</table>
run_timing_analysis


This command runs timing analysis on the design.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-prepared]</td>
<td>Y</td>
<td>Indicates that the design has only been prepared (this is the default)</td>
</tr>
<tr>
<td>[-placed]</td>
<td>Y</td>
<td>Indicates that the design has been placed but not routed</td>
</tr>
<tr>
<td>[-routed]</td>
<td>Y</td>
<td>Indicates that the design has been placed and routed</td>
</tr>
<tr>
<td>[-final]</td>
<td>Y</td>
<td>Indicates that this is sign-off timing (this involves some extra checks)</td>
</tr>
<tr>
<td>[-name_postfix &lt;string&gt;]</td>
<td>Y</td>
<td>Postfix added to report file name (e.g., to distinguish multiple ‘placed’ reports)</td>
</tr>
<tr>
<td>[-format &lt;string&gt;]</td>
<td>Y</td>
<td>Specify report formats; default is { text html csv }</td>
</tr>
<tr>
<td>[-temperature &lt;string&gt;]</td>
<td>Y</td>
<td>The temperature selection to do timing analysis at a PVT corner</td>
</tr>
<tr>
<td>[-voltage &lt;string&gt;]</td>
<td>Y</td>
<td>The voltage selection to do timing analysis at a PVT corner</td>
</tr>
<tr>
<td>[-grade &lt;string&gt;]</td>
<td>Y</td>
<td>The speed grade selection to do timing analysis at a PVT corner</td>
</tr>
</tbody>
</table>

run_tool

run_tool <id> [-args <string>]

This command runs a registered tool executable by tool ID, as specified in the ACE extensions config.xml file.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;id&gt;</td>
<td></td>
<td>The required &lt;id&gt; argument must match a registered tool executable by tool ID, as specified in the ACE extensions config.xml file.</td>
</tr>
<tr>
<td>[-args &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -args &lt;tool_args&gt; option is used to pass commandline arguments to the underlying tool.</td>
</tr>
</tbody>
</table>
run_un_post_process
run_un_post_process [-reportsdir <string>] [-debugdir <string>] [-reroute]

This command removes design post-processing.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-reportsdir &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -reportsdir &lt;dir&gt; option is used to override the default location for report files during this step.</td>
</tr>
<tr>
<td>[-debugdir &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -debugdir &lt;dir&gt; option is used to override the default location for debug files during this step.</td>
</tr>
<tr>
<td>[-reroute]</td>
<td>Y</td>
<td>The optional -reroute option is used to re-route the affected nets after un_post_process</td>
</tr>
</tbody>
</table>

run_unplace
run_unplace [-fixed] [-boundary] [-core] [-constants] [-insts <list>]

Unplace instances in the design

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-fixed]</td>
<td>Y</td>
<td>Unplace instances with fixed placement constraints as well as movable instances</td>
</tr>
<tr>
<td>[-boundary]</td>
<td>Y</td>
<td>Only unplace boundary instances</td>
</tr>
<tr>
<td>[-core]</td>
<td>Y</td>
<td>Only unplace core elements</td>
</tr>
<tr>
<td>[-constants]</td>
<td>Y</td>
<td>Only unplace constant sources</td>
</tr>
<tr>
<td>[-insts &lt;list&gt;]</td>
<td>Y</td>
<td>Only unplace the instances specified in this list</td>
</tr>
</tbody>
</table>

run_unroute

Remove all or parts of a routing.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-net &lt;string&gt;]</td>
<td>Y</td>
<td>Only remove routing for given net</td>
</tr>
<tr>
<td>[-pin &lt;string&gt;]</td>
<td>Y</td>
<td>Only remove routing for given pin</td>
</tr>
</tbody>
</table>
### Argument Table

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-nets &lt;list&gt;]</td>
<td>Y</td>
<td>unroute only the nets specified in this list</td>
</tr>
<tr>
<td>[-regions &lt;list&gt;]</td>
<td>Y</td>
<td>unroute only the nets in the given regions</td>
</tr>
<tr>
<td>[-regionarea &lt;list&gt;]</td>
<td>Y</td>
<td>unroute only the nets in the given regions</td>
</tr>
<tr>
<td>[-nocore]</td>
<td>Y</td>
<td>unroute only nets in the I/O-ring</td>
</tr>
<tr>
<td>[-clock_only]</td>
<td>Y</td>
<td>only unroute clock nets</td>
</tr>
<tr>
<td>[-core]</td>
<td>Y</td>
<td>only unroute core nets</td>
</tr>
<tr>
<td>[-keepsametile]</td>
<td>Y</td>
<td>keep all same-tile - connections</td>
</tr>
<tr>
<td>[-uniqify]</td>
<td>Y</td>
<td>make constants unique again</td>
</tr>
<tr>
<td>[-consts]</td>
<td>Y</td>
<td>only unroute constants</td>
</tr>
<tr>
<td>[-keepconsts]</td>
<td>Y</td>
<td>do NOT unroute constants</td>
</tr>
</tbody>
</table>

#### save_clock_preroute

**save_clock_preroute** [-outputfile <string>] [-add_to_project]

This command will save the pre-routing constraints to a PDC file.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-outputfile &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -outputfile &lt;file&gt; option is used to specify the file path to which the add_clock_preroute commands will be saved. If this option is not used, the file will be saved to <code>&lt;project_dir&gt;/&lt;impl_dir&gt;/output/&lt;project_name&gt;_clock_preroutes.pdc</code></td>
</tr>
<tr>
<td>[-add_to_project]</td>
<td>Y</td>
<td>The optional -add_to_project option is used to specify that the file should be automatically added to the active project. If this is omitted, the generated PDC file is not automatically added to any project.</td>
</tr>
</tbody>
</table>

#### save_impl

**save_impl** <filename> [-no_log]

The save_impl command always uses the active impl, since only the active impl is connected to the live DB state. All other impls have no live DB state. The save_impl command saves the state of an impl (impl options and db state) to a .acxdb file. By default, the .acxdb file will save the entire state of the current DB, including placement and routing information. If an impl is saved before running the prepare flow step, a warning message will be printed and only the impl options will be saved, since the DB has not been prepared.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;filename&gt;</td>
<td></td>
<td>Specifies the ACXDB file path where the active impl state should be saved</td>
</tr>
</tbody>
</table>
This functionality is also accessible through buttons/menus in the ACE GUI – see Saving Implementations (see page 279) . See also: restore_impl and Restoring Implementations (see page 280).

**save_partition_placements**

```bash
save_partition_placements [-outputfile <string>] [-partition <string>] [-add_to_project]
```

Save the partition placement constraints to a PDC file which can be added to the active project.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-outputfile &lt;string&gt;]</td>
<td>Y</td>
<td>The name of the output file</td>
</tr>
<tr>
<td>[-partition &lt;string&gt;]</td>
<td>Y</td>
<td>The name of the specific partition to save.</td>
</tr>
<tr>
<td>[-add_to_project]</td>
<td>Y</td>
<td>The optional -add_to_project option is used to specify whether the generated PDC file should automatically be added to the active project or not.</td>
</tr>
</tbody>
</table>

**save_placement**

```bash
```

Save the current placement to one or more files as a set of pre-placement commands

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-iofile &lt;string&gt;]</td>
<td>Y</td>
<td>The -iofile &lt;file&gt; option is used to specify the file path to save the IO Ring Boundary instance pre-placement commands to. If this option is not used, the file will be saved to the active project's directory as io_preplacement.pdc.</td>
</tr>
<tr>
<td>[-corefile &lt;string&gt;]</td>
<td>Y</td>
<td>The -corefile &lt;file&gt; option is used to specify the file path to save the Core instance pre-placement commands to. If this option is not used, the file will be saved to the active project's directory as core_preplacement.pdc.</td>
</tr>
<tr>
<td>[-add]</td>
<td>Y</td>
<td>The -add option specifies that the outputfile should be automatically added to the active project's constraints. (It will be added to the end of the constraints list, and will thus be the last constraints file loaded.)</td>
</tr>
<tr>
<td>[-output_regions]</td>
<td>Y</td>
<td>The -output_regions option is used to enable output of region constraints into the Core PDC file (or IO Ring Boundary PDC file if -io_only is used).</td>
</tr>
</tbody>
</table>
### Argument

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-create_iopins]</td>
<td>Y</td>
<td>The <code>-create_iopins</code> option is used to enable output of <code>create_boundary_pin</code> commands into the IO Ring Boundary PDC file</td>
</tr>
<tr>
<td>[-io_only]</td>
<td>Y</td>
<td>The <code>-io_only</code> option is used to specify whether only the IO Ring Boundary pre-placement file is output or not</td>
</tr>
<tr>
<td>[-iopins_only]</td>
<td>Y</td>
<td>The <code>-iopins_only</code> option allows you to save only the placement of the boundary pin instances</td>
</tr>
<tr>
<td>[-core_only]</td>
<td>Y</td>
<td>The <code>-core_only</code> option is used to specify whether only the Core pre-placement file is output or not</td>
</tr>
<tr>
<td>[-fixed_only]</td>
<td>Y</td>
<td>The <code>-fixed_only</code> option is used to specify whether only Fixed Instance placement data is output or not</td>
</tr>
<tr>
<td>[-fix]</td>
<td>Y</td>
<td>The <code>-fix</code> option forces all saved placements to be &quot;fixed&quot; placement, allowing you to lock down all of your placed instances</td>
</tr>
<tr>
<td>[-device_port_names]</td>
<td>Y</td>
<td>The <code>-device_port_names</code> option is used to specify whether device port names should be output for IPINs/OPINs instead of site names</td>
</tr>
<tr>
<td>[-instances &lt;list&gt;]</td>
<td>Y</td>
<td>The <code>-instances &lt;instances&gt;</code> option is used to specify a specific list of design instances you want to save placement for. You can call the find command to pass its results to this option</td>
</tr>
</tbody>
</table>

### save_project

`save_project [-project <string>] [-outputfile <string>] [-acxdb <string>] [-no_log]`

The `save_project` command saves the state of an ACE project to a `.acxprj` project file. By default, the active project is saved, unless the `-project` option is specified. The project is saved to the original project file path unless `-outputfile` is used. If the project contains the current active impl, the state of the DB can optionally be saved to an `.acxdb` file using the `-acxdb` option.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional <code>-project &lt;projectName&gt;</code> option may be used to specify a project to write out.</td>
</tr>
<tr>
<td>[-outputfile &lt;string&gt;]</td>
<td>Y</td>
<td>The optional <code>-outputfile &lt;projectFile&gt;</code> option may be used to specify an output file location.</td>
</tr>
<tr>
<td>[-acxdb &lt;string&gt;]</td>
<td>Y</td>
<td>Enables output of an ACXDB file for the active implementation and requires a file path to save the state of the active impl to</td>
</tr>
<tr>
<td>[-no_log]</td>
<td>Y</td>
<td>If the <code>-no_log</code> option is set, no additional debug information will be saved in the ACXDB file, including log files from the current ACE session</td>
</tr>
</tbody>
</table>
**save_properties**

`save_properties [-outputfile <string>] [-add]`

This command is used to save all changed properties on objects in the DB after prepare has been run.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-outputfile &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -outputfile &lt;file&gt; option is used to specify the file path to which the set_property commands will be saved. If this option is not used, the file will be saved to the active project's directory as properties.sdc</td>
</tr>
<tr>
<td>[-add]</td>
<td>Y</td>
<td>The optional -add option is used to specify that the file should be automatically added to the active project. If this is omitted, the file of changed properties is not automatically added to any project.</td>
</tr>
</tbody>
</table>

**save_regions**

`save_regions [-outputfile <string>] [-region <string>] [-all] [-explicit] [-add]`

Save the placement region constraints to a file, using a TCL command history list approach by default.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-outputfile &lt;string&gt;]</td>
<td>Y</td>
<td>The name of the output file</td>
</tr>
<tr>
<td>[-region &lt;string&gt;]</td>
<td>Y</td>
<td>The name of the region to save. Saves explicit instance list.</td>
</tr>
<tr>
<td>[-all]</td>
<td>Y</td>
<td>Save all regions (default)</td>
</tr>
<tr>
<td>[-explicit]</td>
<td>Y</td>
<td>Save explicit lists of instances constrained to each region, as opposed to saving the sequence of TCL commands used to build up the region constraints</td>
</tr>
<tr>
<td>[-add]</td>
<td>Y</td>
<td>The optional -add option is used to specify whether the file automatically added to the active project or not.</td>
</tr>
</tbody>
</table>

**select**

`select <objects> [-clear]`

This command is used to control the current object selection.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;objects&gt;</td>
<td></td>
<td>The required &lt;objects&gt; argument specifies a list of objects to append to the current selection. Objects must be prepended with object type prefixes (see &quot;find&quot; command).</td>
</tr>
<tr>
<td>[-clear]</td>
<td>Y</td>
<td>The optional -clear flag is used to deselect all objects before performing the select action.</td>
</tr>
</tbody>
</table>
The ACE GUI provides a graphical interface for this command through the Selection View (see page 136). See also: Object Type Prefixes (see page 313), Search View (see page 132), find, Selecting Objects in the Floorplanner (see page 321), trace_connections (see page 624).

**set_active_impl**

set_active_impl <implName> [-project <string>]

This command sets the active implementation for the current ACE session. The active implementation controls which implementation the flow and project management commands are operating on.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;implName&gt;</td>
<td></td>
<td>The required &lt;implName&gt; argument is used to specify the name of the implementation to set as the active implementation.</td>
</tr>
<tr>
<td>[-project &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -project &lt;projectName&gt; option is used to specify an alternate project (by name) for the active implementation to be set in.</td>
</tr>
</tbody>
</table>

**set_clock_type**


Set properties of a clock. If a non-driving (target) clock pin is specified, a local property is set for that pin only.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;clock&gt;</td>
<td></td>
<td>net or pin ('inst/pin')</td>
</tr>
<tr>
<td>[-batch]</td>
<td>Y</td>
<td>Postpone application of this constraint until apply_placement is called at the end of run_prepare. This is useful for nets that are created or renamed by ACE during run_prepare</td>
</tr>
<tr>
<td>[-boundary]</td>
<td>Y</td>
<td>boundary clock (not routed through the trunk)</td>
</tr>
<tr>
<td>[-trunk]</td>
<td>Y</td>
<td>trunk clock</td>
</tr>
<tr>
<td>[-minitrunk]</td>
<td>Y</td>
<td>routed via minitrunk instead of main trunk</td>
</tr>
<tr>
<td>[-data_region]</td>
<td>Y</td>
<td>data as clock, using region resources</td>
</tr>
<tr>
<td>[-data_center]</td>
<td>Y</td>
<td>data as clock, using center resources</td>
</tr>
<tr>
<td>[-data_local]</td>
<td>Y</td>
<td>data as clock, using local resources</td>
</tr>
<tr>
<td>Argument</td>
<td>Optional</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>[-data_column]</td>
<td>Y</td>
<td>data as clock, using branch base resources</td>
</tr>
</tbody>
</table>

**set_cluster**

```
set_cluster <cluster> [-id <int>] [-wt <int>]
```

Pre-placement command to generate user-defined clusters. This clustering command directs the ACE Placer to keep the specified instances together.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;cluster&gt;</td>
<td></td>
<td>The required &lt;cluster&gt; list argument is a list of instances which should be clustered in an RLB half</td>
</tr>
<tr>
<td>[-id &lt;int&gt;]</td>
<td>Y</td>
<td>Optional 2nd level cluster id</td>
</tr>
<tr>
<td>[-wt &lt;int&gt;]</td>
<td>Y</td>
<td>Optional 2nd level cluster weight {2, ..., 5} - higher weights signify cluster importance</td>
</tr>
</tbody>
</table>

**set_equivalent_pins**

```
set_equivalent_pins <equivalent_pin_names>
```

This command marks multiple nets or instance pins as functionally equivalent

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;equivalent_pin_names&gt;</td>
<td></td>
<td>A list of pin names or net names that are to be marked as functionally equivalent (&lt;p:toplevel_port_name&gt;</td>
</tr>
</tbody>
</table>

**set_flyline_direction**

```
set_flyline_direction <direction>
```

This command is used to control whether selected instance flylines are shown for loads of the selected instance, drivers, or both.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;direction&gt;</td>
<td></td>
<td>The required &lt;direction&gt; argument specifies whether selected instance flylines are shown for loads of the selected instance, drivers, or both. Valid values are loads_only, drivers_only, both and all</td>
</tr>
</tbody>
</table>

**set_impl_option**

```
set_impl_option <option_name> [<value>] [-project <string>] [-impl <string>]
```

This command sets options for a project implementation. Only one option may be set at a time.
### Argument | Optional | Description
--- | --- | ---
<option_name> |  | The name of the impl option to set a value for. To see a list of valid impl options, use the report_impl_options TCL command.
[value] | Y | The new value to set the impl option to.
[-project <string>] | Y | The optional -project <projectName> and -impl <implName> options are used to specify an alternate project implementation (by name) to set options for.
[-impl <string>] | Y | The optional -project <projectName> and -impl <implName> options are used to specify an alternate project implementation (by name) to set options for.

**set_max_flyline_fanout**

`set_max_flyline_fanout <limit>`

This command is used to hide selected instance flylines for nets with fanout greater than the limit passed in.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
</table>
| <limit> |  | The required <limit> argument specifies the maximum fanout for flylines to be displayed for a net.

**set_partition_force_changed**

`set_partition_force_changed <name> <changed>`

Set the force changed flag of a partition with the given name. This command should be called at the end of the incremental compile flow. Setting the flag will force the partition to be recompiled the next time that the flow is run, even if the partition timestamp has not changed.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;name&gt;</td>
<td></td>
<td>Name of the Partition</td>
</tr>
<tr>
<td>&lt;changed&gt;</td>
<td></td>
<td>Set to 1 to mark this partition as force changed, set to 0 to reset the flag and mark the partition as not forced changed</td>
</tr>
</tbody>
</table>

**set_partition_info**

`set_partition_info [-name <string>] [-view <string>] [-cp_type <string>] -timestamp <string> -import <string> [-comment <string>] [-exclusive_placement]`

Set partition (compile point) information on the design. This command creates a new partition definition if one does not already exist in the design. This usually comes from the synthesis tool in <design>_partition.tcl

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-name &lt;string&gt;]</td>
<td>Y</td>
<td>Hierarchical pathname of the partition in the netlist (e.g. /top_module/instance1/instance2)</td>
</tr>
</tbody>
</table>
### Argument

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-view &lt;string&gt;]</td>
<td>Y</td>
<td>Module name of the partition in the original RTL. Will be used as the name of the blackbox module if the partition is exported.</td>
</tr>
<tr>
<td>[-cp_type &lt;string&gt;]</td>
<td>Y</td>
<td>Compile point type (hard, locked, or soft)</td>
</tr>
<tr>
<td>-timestamp &lt;string&gt;</td>
<td></td>
<td>Timestamp in seconds to indicate when this partition was last synthesized. Default is current time in seconds. The options -timestamp and -import are mutually exclusive</td>
</tr>
<tr>
<td>-import &lt;string&gt;</td>
<td></td>
<td>Pathname to the .epdb file containing the placed and routed partition database to be imported. The options -timestamp and -import are mutually exclusive</td>
</tr>
<tr>
<td>[-comment &lt;string&gt;]</td>
<td>Y</td>
<td>User specified comment string describing the partition</td>
</tr>
<tr>
<td>[-exclusive_placement]</td>
<td>Y</td>
<td>Sets the given partition with an exclusive placement property. Instances belonging to the current partition will not be placed together with non partition instances</td>
</tr>
</tbody>
</table>

### set_placement

*set_placement* <objName> <siteName> [-fixed] [-batch] [-partition] [-warning] [-auto_place_neighbors <int>]

This command assigns the placement of an instance to a site.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;objName&gt;</td>
<td></td>
<td>The required &lt;objName&gt; argument is used to specify the name of an instance (i:) or port (p:) to be placed. If multiple objects are to be placed at once, a TCL list of objectnames may be specified. NOTE: Ports (p:) may not be used if the port is connected to a black box IO Ring instance. The port (p:) may only be used to place boundary pins (IPIN, OPIN, CLK_IPIN, CLK_OPIN) that are connected to the port.</td>
</tr>
<tr>
<td>&lt;siteName&gt;</td>
<td></td>
<td>The required &lt;siteName&gt; argument is used to specify the site (s:) to place the instance on. In the case of IO pin placement, a device port name (d:) may be specified instead of a site name. If multiple objects are to be placed at once, a TCL list of sitenames may be specified.</td>
</tr>
<tr>
<td>[-fixed]</td>
<td>Y</td>
<td>The -fixed option specifies that the placement of the instance should be fixed to this site and not movable by the placer</td>
</tr>
<tr>
<td>[-batch]</td>
<td>Y</td>
<td>Postpone application of this constraint until apply_placement is called at the end of run_prepare. This option is useful for instances that are created or renamed by Ace during run_prepare.</td>
</tr>
<tr>
<td>[-partition]</td>
<td>Y</td>
<td>Use this instance as an anchor to specify the placement of an entire partition relative to the specified site</td>
</tr>
</tbody>
</table>
### set_project_constraints_pvt

```plaintext
set_project_constraints_pvt <file> [-corner <string>] [-temperature <string>] [-voltage <string>]
```

This command allows the user to set the specific PVT conditions in which an SDC constraint file is applied.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;file&gt;</code></td>
<td></td>
<td>The required <code>&lt;file&gt;</code> argument is used to specify the file path to the SDC constraint file.</td>
</tr>
<tr>
<td>[-corner &lt;string&gt;]</td>
<td>Y</td>
<td>The -corner <code>&lt;corner&gt;</code> option is used to mark an SDC constraints file (containing only delays) as being applicable only to the given process corner. Valid values are &quot;fast&quot; and &quot;slow&quot;</td>
</tr>
<tr>
<td>[-temperature &lt;string&gt;]</td>
<td>Y</td>
<td>The -temperature <code>&lt;temp&gt;</code> option is used to mark an SDC constraints file (containing only delays) as being applicable only to the given temperature corner. Valid values are device-specific and must match a value from the junction_temperature impl option list.</td>
</tr>
<tr>
<td>[-voltage &lt;string&gt;]</td>
<td>Y</td>
<td>The -voltage <code>&lt;v&gt;</code> option is used to mark an SDC constraints file (containing only delays) as being applicable only to the given core voltage corner. Valid values are device-specific and must match a value from the core_voltage impl option list.</td>
</tr>
</tbody>
</table>

### set_property

```plaintext
set_property <propName> <propValue> <objects> [-warning] [-quiet]
```

This command is used to set properties on objects in the DB.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;propName&gt;</code></td>
<td></td>
<td>The required <code>&lt;propName&gt;</code> argument specifies property name to set on the objects passed in.</td>
</tr>
<tr>
<td><code>&lt;propValue&gt;</code></td>
<td></td>
<td>The required <code>&lt;propValue&gt;</code> argument specifies property value to set on the objects passed in.</td>
</tr>
<tr>
<td><code>&lt;objects&gt;</code></td>
<td></td>
<td>The required <code>&lt;objects&gt;</code> argument specifies a list of objects to set the property for. Objects must be prepended with object type prefixes (see &quot;find&quot; command).</td>
</tr>
<tr>
<td>[-warning]</td>
<td>Y</td>
<td>The optional -warning option allows you to downgrade error messages about missing netlist objects to warning messages</td>
</tr>
<tr>
<td>[-quiet]</td>
<td>Y</td>
<td>The optional -quiet option allows you to disable printing of info messages</td>
</tr>
</tbody>
</table>
**set_region_bounds**

```
set_region_bounds <region> <bounds> [-snap_to_clock_regions] [-snap_to_fabric_clusters] [-snap <string>]
```

This command updates a placement region's bounding box of tiles.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;region&gt;</td>
<td></td>
<td>Name of the region</td>
</tr>
<tr>
<td>&lt;bounds&gt;</td>
<td></td>
<td>List of bounding box coordinates {x1 y1 x2 y2}. x1 and y1 are the upper left</td>
</tr>
<tr>
<td></td>
<td></td>
<td>corner of the box. x2 and y2 are the lower right corner of the box.</td>
</tr>
<tr>
<td>[-snap_to_clock_regions]</td>
<td>Y</td>
<td>Snap the bounding box to clock region boundaries (deprecated, use <code>-snap clock_regions</code>)</td>
</tr>
<tr>
<td>[-snap_to_fabric_clusters]</td>
<td>Y</td>
<td>Snap the bounding box to fabric cluster boundaries (deprecated, use -snap fabric_clusters')</td>
</tr>
<tr>
<td>[-snap &lt;string&gt;]</td>
<td>Y</td>
<td>How to snap the region bounding box coordinates. Legal values are: 'none', tiles' (the default), 'fabric_clusters', 'clock_regions'</td>
</tr>
</tbody>
</table>

**set_region_type**

```
set_region_type <region> [-type <string>] [-soft] [-include_routing]
```

This command updates a placement region's type.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;region&gt;</td>
<td></td>
<td>Name of the region</td>
</tr>
<tr>
<td>[-type &lt;string&gt;]</td>
<td>Y</td>
<td>What type of placement region this is. Legal values are: 'inclusive' (the default), 'keepout', 'soft'. Instances added to an 'inclusive' region (and attached routing wires when <code>-include_routing</code> is set) will be placed within the region bounding box. An 'inclusive' region permits instances to be placed inside the region even if they do not belong to the region. A 'keepout' region prevents any instances (and routing wires when <code>-include_routing</code> is set) from being placed inside the region. No instances may be added to a 'keepout' region. Instances added to an 'soft' region will be pulled toward the region's center during placement, but instances are permitted to overflow the bounds of the 'soft' region.</td>
</tr>
<tr>
<td>[-soft]</td>
<td>Y</td>
<td>A 'soft' placement region attempts to pull instance placement to its center, but allows instance placement to overflow it's bounds</td>
</tr>
<tr>
<td>[-include_routing]</td>
<td>Y</td>
<td>Constrain routing wires, as well as instances, to stay within the region boundary box</td>
</tr>
</tbody>
</table>

**set_units**

```
set_units
```

Set the default units for timing constraints.
sleep
sleep <seconds>
sleep for number seconds.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;seconds&gt;</td>
<td></td>
<td>number of seconds to sleep</td>
</tr>
</tbody>
</table>

source_encrypted
source_encrypted <tclfile> [-nodigest] [-untar]
source encrypted tcl file.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;tclfile&gt;</td>
<td></td>
<td>encrypted tcl file to source</td>
</tr>
<tr>
<td>[-nodigest]</td>
<td>Y</td>
<td>no digest is also OK</td>
</tr>
<tr>
<td>[-untar]</td>
<td>Y</td>
<td>encrypted file is tar archive, untar first</td>
</tr>
</tbody>
</table>

trace_connections
trace_connections <insts> [-drivers_only] [-targets_only] [-include_clocks] [-include_resets]
This command is used to find instances that are connected to the list of instances passed in. By default, this command traces to find all (drivers and targets) connected instances, except for those connected via clock or reset pins.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;insts&gt;</td>
<td></td>
<td>The required &lt;insts&gt; argument specifies a list of instance objects to trace connectivity from. Objects must be prepended with object type prefixes (see &quot;find&quot; command).</td>
</tr>
<tr>
<td>[-drivers_only]</td>
<td>Y</td>
<td>If you want to select only upstream logic that drives the instances in the current selection, use -drivers_only</td>
</tr>
<tr>
<td>[-targets_only]</td>
<td>Y</td>
<td>If you want to select only downstream logic driven by the currently selected instances, use -targets_only.</td>
</tr>
<tr>
<td>[-include_clocks]</td>
<td>Y</td>
<td>To include tracing connectivity on clock nets, use -include_clocks.</td>
</tr>
<tr>
<td>[-include_resets]</td>
<td>Y</td>
<td>To include tracing connectivity on reset nets, use -include_resets.</td>
</tr>
</tbody>
</table>

Similar to the find command, this functionality is especially useful when creating lists as input to other Tcl commands, like select and highlight.
untar

untar <tarfile> [-member <string>] [-list] [-lz]

extract content from tar file.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;tarfile&gt;</td>
<td></td>
<td>tarfile from which to extract</td>
</tr>
<tr>
<td>[-member &lt;string&gt;]</td>
<td>Y</td>
<td>member to extract, default: none</td>
</tr>
<tr>
<td>[-list]</td>
<td>Y</td>
<td>list files in archive</td>
</tr>
<tr>
<td>[-lz]</td>
<td>Y</td>
<td>uncompressed first</td>
</tr>
</tbody>
</table>

write_bitstream


This command generates a programming bitstream for a fully placed and routed design in .hex format.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-outputfile &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -outputfile &lt;file&gt; option may be used to specify an output file name or file path. If this option is not present, the output is written to the default implementation output directory and is named &lt;design_name&gt;.hex.</td>
</tr>
<tr>
<td>[-debugdir &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -debugdir &lt;dir&gt; option is used to override the default location for debug files during this step.</td>
</tr>
<tr>
<td>[-reportsdir &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -reportsdir &lt;dir&gt; option is used to override the default location for report files during this step.</td>
</tr>
<tr>
<td>[-flash]</td>
<td>Y</td>
<td>The optional -flash option may be used to output an additional serial flash binary file format output</td>
</tr>
<tr>
<td>[-max_size &lt;int&gt;]</td>
<td>Y</td>
<td>The optional -max_size option may be used to set the maximum size of the bitstream for use with the -flash option</td>
</tr>
<tr>
<td>[-pcie]</td>
<td>Y</td>
<td>The optional -pcie option may be used to output an additional pcie file format output</td>
</tr>
<tr>
<td>[-cpu]</td>
<td>Y</td>
<td>The optional -cpu option may be used to output an additional CPU Mode file format output</td>
</tr>
<tr>
<td>Argument</td>
<td>Optional</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>[-cpu_width &lt;int&gt;]</td>
<td>Y</td>
<td>This option controls the bit width of the CPU Mode formatted output file. If you are using the CPU interface in x8 mode, set this value to 8. If you are using the CPU interface in x128 mode, set this to 128.</td>
</tr>
<tr>
<td>[-flash_clock_div &lt;int&gt;]</td>
<td>Y</td>
<td>This option specifies the Serial Flash clock divider value to be used when programming the chip from Serial Flash</td>
</tr>
<tr>
<td>[-two_stage]</td>
<td>Y</td>
<td>The optional -two_stage option may be used to output bitstream files divided by user mode</td>
</tr>
<tr>
<td>[-nocompress]</td>
<td>Y</td>
<td>write output as plain-text file</td>
</tr>
<tr>
<td>[-compress]</td>
<td>Y</td>
<td>compress output-file</td>
</tr>
<tr>
<td>[-chainfile &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -chainfile &lt;file&gt; may be used to override the chainfile set in the active Impl</td>
</tr>
</tbody>
</table>

**write_critical_paths_script**

`write_critical_paths_script [-outputfile <string>]`

This command writes a tcl script that may be used for viewing critical paths in the synthesis tool.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-outputfile &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -outputfile &lt;file&gt; option may be used to specify an output file name or file path. If this option is not present, the output is written to the default implementation output directory and is named &lt;design_name&gt;_critical_paths.tcl.</td>
</tr>
</tbody>
</table>

**write_netlist**

`write_netlist [-outputfile <string>] [-debugdir <string>] [-final] [-compress]`

This command generates a verilog netlist for simulation (same as run_generate_netlist).

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-outputfile &lt;string&gt;]</td>
<td>Y</td>
<td>Output netlist file name.</td>
</tr>
<tr>
<td>[-debugdir &lt;string&gt;]</td>
<td>Y</td>
<td>The optional -debugdir &lt;dir&gt; option is used to override the default location for debug files during this step.</td>
</tr>
<tr>
<td>[-final]</td>
<td>Y</td>
<td>Output DRC-free final netlist</td>
</tr>
<tr>
<td>[-compress]</td>
<td>Y</td>
<td>Compress output file with gzip</td>
</tr>
</tbody>
</table>
write_partition_blackbox

write_partition_blackbox <partition> [-library <string>] [-outputfile <string>]

Command to write a verilog blackbox model for a partition

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;partition&gt;</td>
<td></td>
<td>Export a blackbox netlist for the specified partition as a verilog file</td>
</tr>
<tr>
<td>[-library &lt;string&gt;]</td>
<td>Y</td>
<td>Specifies the name of the blackbox model library (default is &quot;blackbox&quot;)</td>
</tr>
<tr>
<td>[-outputfile &lt;string&gt;]</td>
<td>Y</td>
<td>Specifies the output file name for the blackbox netlist (default is &lt;cellname&gt;_bb.v in the implementation output directory)</td>
</tr>
</tbody>
</table>

write_partition_db

write_partition_db <partition> [-outputfile <string>] [-include_pr_zone]

Command to export the place-and-route database for a partition

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;partition&gt;</td>
<td></td>
<td>Export the place-and-route database for the specified partition into an .epdb file</td>
</tr>
<tr>
<td>[-outputfile &lt;string&gt;]</td>
<td>Y</td>
<td>Specifies the output file name for the partition database (default is partitions/&lt;instname&gt;.epdb in the implementation output directory)</td>
</tr>
<tr>
<td>[-include_pr_zone]</td>
<td>Y</td>
<td>Search for Placement Region that corresponds to partition and use it in splitting routing for nets</td>
</tr>
</tbody>
</table>

write_tcl_history

write_tcl_history <outputfile>

Dump the TCL command history for this ACE session to a file

<table>
<thead>
<tr>
<th>Argument</th>
<th>Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;outputfile&gt;</td>
<td></td>
<td>The file to save the TCL script to</td>
</tr>
</tbody>
</table>
### Chapter - 5: Troubleshooting

This chapter is intended to cover some areas where users frequently report problems, along with solutions. Your Achronix FAE likely can point you to a more recent FAQ.

This chapter will also cover some known ACE issues, with current workarounds where possible.

## ACE Exit Error Codes

The following are some of the known exit codes that can be reported by ACE.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Generic error code; catchall for unexpected problem states.</td>
<td>Contact Achronix Technical Support</td>
</tr>
<tr>
<td>2</td>
<td>Invalid command line options for ACE or acx</td>
<td>See <a href="https://achronix.com">Running ACE (see page 262)</a> for a list of valid user command-line options. Contact Achronix Technical Support if problems persist.</td>
</tr>
<tr>
<td>3</td>
<td>License failure. ACE was unable to obtain a required license.</td>
<td>See the <a href="https://achronix.com">ACE License &amp; Installation Quickstart Guide (UG002)</a> for more details about configuring ACE license management. Contact Achronix Technical Support if problems persist.</td>
</tr>
<tr>
<td>5</td>
<td>GUI startup failure: incomplete installation: compatible Java release not found. This error typically indicates that the included version of Java used by the ACE GUI is improperly configured.</td>
<td>Contact Achronix Technical Support</td>
</tr>
<tr>
<td>13</td>
<td>GUI startup failure. This typically indicates that there's a problem in Linux with the LD_LIBRARY_PATH environment variable, though it can also occur due to crashes when loading the 64-bit WebKitGTK+ HTML browser.</td>
<td>Linux users: Unset the LD_LIBRARY_PATH environment variable and try running ACE again. Also, ensure there is a compatible 64-bit HTML browser (WebKit or WebKit2 for GTK+2 or GTK+3) installed. If problems persist, contact Achronix Technical Support. See <a href="https://achronix.com">Linux: Incompatible Default Web Browser (see page 643)</a> for more details.</td>
</tr>
<tr>
<td>100 / 101</td>
<td>The GUI is attempting to workaround a number of known startup issues through automated forced restarts (which display these exit codes). If restarts fail and the GUI did not start successfully, this is an error.</td>
<td>Contact Achronix Technical Support if the GUI did not start.</td>
</tr>
<tr>
<td>values ≤ 136</td>
<td>Various license management error codes from RLM.</td>
<td>See the <a href="https://achronix.com">ACE License &amp; Installation Quickstart Guide (UG002)</a> for more details on ACE license management. Contact Achronix Technical Support if problems persist.</td>
</tr>
<tr>
<td>201</td>
<td>The GUI detected a socket communication error with the acx backend.</td>
<td>Contact Achronix Technical Support</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Solution</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td>202</td>
<td>When the GUI was attempting to exit gracefully (due either to user request or a fatal error), critical errors occurred, forcing the GUI to perform a hard kill of itself.</td>
<td>Contact Achronix Technical Support if problems persist.</td>
</tr>
<tr>
<td>203</td>
<td>The GUI is unable to start due to underlying framework errors.</td>
<td>Contact Achronix Technical Support. (This is most likely due to an attempt to execute ACE in an unsupported OS.)</td>
</tr>
<tr>
<td>404</td>
<td>ACE was attempted to run on an obsolete OS; the GUI is known to be incompatible, so this is disallowed.</td>
<td>Run ACE on a supported operating system.</td>
</tr>
<tr>
<td>504</td>
<td>An error occurred while interpreting the Tcl script file passed to ACE.</td>
<td>The Tcl script contains errors or encountered an unhandled error condition. Either fix the bug in the Tcl script, or enhance the error handling in the Tcl script to better handle/report the error condition. Contact Achronix Technical Support if problems persist.</td>
</tr>
<tr>
<td>505</td>
<td>No home directory is defined for the current user. By default, ACE places log files and occasional temp files in locations under the user's home directory, so when no home directory is defined, ACE is unable to proceed safely.</td>
<td>Define a home directory for the userid which starts ACE, or change to a userid with a valid home directory before starting ACE. Consult a local system administrator if necessary.</td>
</tr>
<tr>
<td>506</td>
<td>ACE is unable to open a socket connection between the GUI and the acx backend. (Specifically, the acx backend is unable to bind a socket port needed for communications with the GUI.)</td>
<td>See the Troubleshooting section below titled: Startup Error — ACE is Unable to Connect on Port NNNN of Localhost (see page 633)</td>
</tr>
<tr>
<td>507</td>
<td>The ACE acx backend detected an unexpected GUI socket closure, likely due to a fatal GUI error, when then has caused the acx backend to exit.</td>
<td>Contact Achronix Technical Support</td>
</tr>
</tbody>
</table>

**Duplicate Names for Arrays**

If the following error message is seen during the prepare stage of ACE, it indicates the occurrence of a duplicate net name in the RTL. The RTL must be modified to clear the error.

```
ERROR: int_cnt[1] is already declared (VNLR-1044)
```

**Note**

This situation only occurs when one of the duplicates is a single-dimensional array, and the other is a two-dimensional array.
**Clock Definitions/Constraints**
At least one clock must be defined. Clocks should not be redefined.

**Asynchronous Reset of I/O from the Core**
If an I/O is not clocked by a boundary clock, use synchronous reset only.

**Multi-process Functionality License Requirements**
Multi-process functionality requires a license for each background process; therefore users with a single license cannot access this functionality. When encountering this limit, contact your FAE for current workarounds.

```
Note
Node-locked licenses support multi-process flows without issues. Floating licenses require a new license for each process.
```

**Non-ASCII Characters in Path**
Do not use non-ASCII characters in paths. For example, if the username includes German extended characters (e.g. umlauts), Chinese, etc., ACE might function incorrectly. To remedy this, ensure that all paths only contain ASCII characters.

**Unable to Load Project: Project is Locked**

```
Example error message for locked project

cmd> restore_project "~/output/quickstart/quickstart.acxprj" -activeimpl "impl_1"
Project: "~/output/quickstart/quickstart.acxprj" is locked by another ACE session and cannot be loaded.
This project is locked by user: Docs on host: hostname. You can use restore_project -force to override the lock. To manually unlock this project, delete the lock file: ~/output/quickstart/quickstart.lock
```

ACE locks the Project File (see page 218)s every time it loads a project to prohibit corruption of the project's data. If project locks were not used, and more than one ACE session was allowed to open the same files (or write to the same files) simultaneously, the results would be inconsistent and project data files could become corrupted.
### Warning!

Do not use this forced unlock procedure to run multiple ACE sessions on the same project simultaneously, or file corruption might occur!

Project definitions, implementation definitions, saved implementation states (for both normal flow and incremental compilation), log files, and output directories might get corrupted from having two or more ACE sessions writing to the same files.

Most notably, do not start another ACE session on a project while Multiprocess is already running on that same project; the Multiprocess session must own the project lock (which also locks all implementations) to ensure consistent results and avoid file corruption.

**Achronix does not support simultaneously running multiple ACE sessions on the same project (directory). This is known to cause problems. Do not do this! The project lock files are there to protect users; do not attempt to bypass them.**

In rare cases, ACE can crash, mistakenly leaving a project in the locked state. The easiest way to unlock a mistakenly-still-locked project (which has just failed to load in the GUI) is the following:

1. Double-check that there are no other legitimate users of the project file, including yourself in another desktop!

2. In the Tcl Console View (see page 144), click on the empty `cmd>` line.

3. Click the up arrow (↑) on the keyboard. Each click of the up arrow moves one step backwards through the Tcl command history. Keep moving backwards through the Tcl command history until the Tcl command which attempted to load the locked project is displayed. The failed command should be a call to `load_project` or `restore_project`.

    **Note**
    
    If you regularly load multiple Projects into ACE at the same time, you might have to go back several commands to reach the one that failed.

4. Move to the end of the Tcl command line (press the `End` key on the keyboard), press the space bar, then add the argument `"-force"` to the end of the command. This argument forces ACE to load (or restore) the project despite the presence of a lock, and this session of ACE re-locks the project, taking ownership using a new lock.

    **Example workaround**

    ```tcl
    cmd> restore_project "~/output/quickstart/quickstart.acxprj" -activeimpl "impl_1" -force
    ```

5. Press the `Enter` key to issue the Tcl command to load or restore the project.

### Changing ACE Font Sizes

#### Fonts in Views

Some views in ACE (particularly diagrams) allow users to specify the exact font/size which will be used. These are typically defined in the ACE preferences, under `Window → Preferences → General → Appearance → Colors and Fonts`. There are categorical groupings for each such view allowing its own font and color definitions.

Views that lack their own specific font definition will inherit the font definitions in the `Basic` category, almost always using the Dialog Font. A very few views may also use the Banner Font and Header Font (also found in the `Basic` category) for limited rendering.
The Dialog Font used in most ACE views is directly inherited from the underlying GUI application framework stack, typically called the Application Font in Linux/GTK, or Message Box Font in Windows.

The various views within ACE often accept font changes immediately, but, in some cases, it might be necessary to restart ACE to see the font changes inherited from the OS propagate completely as the new Dialog Font value throughout the application.

Caution!

It is highly recommended that a plain font (not bold, not italics) be chosen as the Dialog Font! There is no font naming standard followed across all OS flavors (or even within a single OS), so these plain font varieties are often called "Regular", sometimes "Book", sometimes "Medium", and sometimes don't have a particular designation.

Linux:

The config location can vary in every Linux desktop / version / distro. In Linux, ACE uses the GTK+ widgets and fonts, so changes should be restricted to those settings.

For example, in the RHEL/CentOS 7.x KDE Plasma desktop, it can be configured from the main desktop (not ACE) menu under System Settings → Application Appearance → GTK+ Appearance → GTK+ Fonts.

As another example, in the RHEL8 Gnome3 desktop, it can be configured from the Gnome Tweaks tool (``gnome-tweaks``), under Tweaks → Fonts → Interface.

Windows:

In Windows 10 and 11, users are no longer allowed direct control of the font at a system-wide level through the Control Panel. (Though some third-party tools still allow this to be configured). Windows users will be best served by changing the Basic → Dialog Font value directly in the ACE Colors and Fonts preferences, as mentioned in the beginning of this troubleshooting entry.

Fonts in HTML Reports

The font used in the HTML Reports is directly inherited from the system's HTML browser's font settings. The system HTML browser can be Internet Explorer (Windows) or WebKit2GTK3 (Linux). The HTML reports typically use the "Proportional" (sometimes called "Web Page") font and Monospace (also called "Plain Text") font types — change these settings in the operating system's HTML browser settings to make the fonts change in the ACE HTML Report viewer.

Unable to Initialize Reserved Module Name List

This problem is reported by the ACE GUI at startup with the following dialog.

Note

The exact library name, "Speedster7t" in the screenshot, differs based upon the customer's specific license /installation.
Typically this error indicates that the device overlay files have been installed incorrectly. The list of reserved module names is contained in the overlay files for each Achronix device/library. In very rare cases, the file may exist in the expected location but ACE might lack read permissions for the file.

The file ACE is attempting to read should be located at:

```
<ace_install_directory>/libraries/<library_name>/reserved_module_names.txt
```

where `<ace_install_directory>` is the directory where ACE has been installed and the `ace` executable is found, and `<library_name>` is the name of the library from the error dialog (though forced to all lowercase letters).

Thus, if the Linux user "tester" has installed ACE in their home directory under

```
/home/tester/ace/Achronix-linux
```

and saw the error dialog captured above about the Speedster7t library, then ACE was unable to find (or potentially experienced permission issues when attempting to read) the file:

```
/home/tester/ace/Achronix-linux/libraries/speedster7t/reserved_module_names.txt
```

To solve the problem, contact Achronix technical support for help on correctly installing both ACE and the associated device overlay file(s) in the appropriate location.

**Startup Error — ACE is Unable to Connect on Port NNNNN of Localhost**

This problem is reported by the ACE GUI at startup with the following (rather verbose) "Startup Error" dialog:
To Determine the Root Cause

Attempting to run ACE in batch mode (with `ace -batch`, see Running ACE (see page 262)) can help determine the source of the problem. In batch mode, the GUI is not used; therefore, no socket connection is needed between the GUI and the acx backend.

If batch mode ACE does not start, or takes more than 60 seconds before providing the Tcl command prompt (regardless of whether or not ACE reports license errors), then there's typically a licensing configuration problem.

If batch mode ACE starts successfully in less than 60 seconds, then there is a firewall configuration problem.

In very rare cases, usually when ACE is installed in a remote NFS location with many device overlays, poor filesystem (HDD) or network (NFS) performance may also cause these timeouts. In these rare cases, simply trying to start ACE in GUI mode a second time will often succeed where the first attempt had a timeout, because for the second attempt the information will now be found in the filesystem cache in memory, which is much faster to access.

Caution!

Though unlikely, realize it is possible for multiple causes to occur for the same user. It might be necessary to first fix a firewall problem, and then fix a licensing problem. After attempting one kind of fix, if the dialog continues to appear, re-diagnose the problem to verify whether the same issue is still occurring, or whether a new issue is occurring but showing the same symptom.

If it is a Firewall Problem

ACE always uses localhost (IPv4 address 127.0.0.1) TCP sockets to communicate between the ACE GUI program and the ACE backend program `acx` (the pure textual TCL interface when ACE is started with `ace -b` or `ace -batch`; see Running ACE (see page 262) for details). In most cases, the required localhost sockets are already configured to be available, but in highly restricted network environments, the required localhost sockets might need special permissions to be added to the firewall of the workstation running ACE. Obtain help from your local system administrator and/or network administrator to properly configure the firewall to allow the necessary network traffic.
**Note**

If the system/network administrator needs to know exactly which executables require firewall permissions, tell them:

**(Windows)**
- `<ace_install_dir>/system/gui/ACE_GUI_Launcher.exe`
- `<ace_install_dir>/system/cmd64/acx.exe`

**(Linux)**
- `<ace_install_dir>/system/gui/ACE_GUI_Launcher`
- `<ace_install_dir>/system/classic_gui/ACE_GUI_Launcher`
- `<ace_install_dir>/system/cmd64/acx`

By default, ACE uses an automatically chosen unused (free) TCP port socket somewhere in the range 1024-65535. This automatically chosen port number can change every time ACE is started.

To force ACE to use a specific TCP port number (and thus require only a single hole poked in the firewall for each executable), add the "-acxport `<portnumber>`" commandline option when starting ACE (where `<portnumber>` is the desired TCP port number in decimal). Ask your network or system administrator exactly which port number should be specified — this is the same port number the administrator opened for each executable in the firewall.

Please contact Achronix Technical Support if problems persist.

---

In some licensing configurations, additional firewall ports might need to be opened specifically for the licensing software. Refer to the *ACE Installation and Licensing Guide* (UG002) for details.

The following executables may require firewall access for the licensing software:

**(Windows)**
- `<ace_install_dir>/system/cmd64/acx.exe`
- `<ace_install_dir>/ace.exe`

**(Linux)**
- `<ace_install_dir>/system/cmd64/acx`
- `<ace_install_dir>/ace`

---

**If it is a Licensing Problem**

A socket connection timeout can also occur when the GUI is attempting to open a connection to the acx backend before the acx backend is ready. This situation can occur if the acx backend is having trouble finding licenses for ACE itself, or for the FPGA/eFPGA devices currently installed for ACE. This long, slow license search is most often seen when ACE is configured to find its license on one or more license servers, and one of those specified servers is not actually a license server (typos and license server migrations being the frequent causes).

Refer to the *ACE Installation and Licensing Guide* (UG002) for details on how to determine the workstation's current RLM license configuration, and how to diagnose and fix what might be going wrong. Frequently, it is simply a matter of correcting or removing the incorrect license server setting in the "RLM_LICENSE" environment variable. Contact Achronix Technical Support if problems persist.
**Workaround: Extending the Timeout**

This workaround is not generally recommended, but in cases where there are transient networking or license server problems, it might be necessary to extend the ACE socket initialization timeout value to be more permissive. To extend the timeout, set the environment variable "ACX_GUI_INIT_TIMEOUT_SECONDS" to a decimal number > 60. Invalid numeric values cause a non-fatal warning to be logged, and the default value of 60 seconds will be used instead. Please work with your IT department for help configuring the environment variable such that it will be set for every ACE startup.

**If it is a Filesystem or Network Performance Problem**

Again, this is rarely the case – licensing configuration problems are much more likely. But if it proves to be a performance problem, installing ACE locally, particularly on an SSD (instead of an HDD), will eliminate network filesystem performance problems. If a local installation is impossible, there are some potential workarounds available.

**Workaround: Extending the Timeout**

It might be necessary to extend the ACE socket initialization timeout value to be more permissive. To extend the timeout, set the environment variable "ACX_GUI_INIT_TIMEOUT_SECONDS" to a decimal number > 60. Invalid numeric values cause a non-fatal warning to be logged, and the default value of 60 seconds will be used instead. Please work with your IT department for help configuring the environment variable such that it will be set for every ACE startup.

**Alternate Workaround: Multiple Parallel ACE Installs**

Alternately, if there are too many device overlays installed at the same time (the exact value of "too many" will vary based on drive and network performance, but so far this problem has only been reported with more than six device overlays installed on a slow NFS mount), users could install ACE in two (or more) separate locations, with a subset of the device overlays applied in each install location. This would reduce the amount of device (and related license) processing that occurs at ACE startup, to the extent that a timeout will no longer occur.

**Unexpected ACE GUI problem: java.lang.NoClassDefFoundError: com/achronix/api/APIPlugin**

This typically indicates that a local file cache (maintained by the frameworks underlying ACE) has become corrupted. There are a variety of potential causes, with the most frequent being if network file system (NFS) problems occur when programs (like ACE) access the user’s home directory.

Thankfully the fix for ACE is relatively simple; start ACE with an additional command-line argument: "-clean". This will cause ACE to immediately discard the old file cache as it starts, and rebuild the cache from scratch. Note that it is not recommended to use the -clean option every time ACE is started, because rebuilding the cache can significantly increase ACE startup times.

```
ace -clean
```

If the user normally starts ACE from an application/start menu or a desktop shortcut (instead of from a command prompt), and/or the user does not know how to start ACE from the command prompt, attempt the next recommended fix, described below.

**If the problem persists after -clean, or if the command prompt is unfamiliar**

There's a more drastic and thorough solution, manually deleting a sub-directory under the user's home directory. Be warned, this not only clears the cache, but also resets all ACE GUI preferences to their default values, so this is not recommended unless the "-clean" option has already been attempted.
The ACE GUI filecache is stored in the user's home directory under a sub-directory named ".achronix", with a separate sub-directory used by each version of ACE, named with the prefix "workspace_ " and the suffix being the version number of ACE. For example, when using ACE v9.1.1, the sub-directory will be named "workspace_9.1.1".

The full path for our example would be "<user_home_directory>/achronix/workspace_9.1.1". Delete this subdirectory, and ACE should then be able to start normally.

**Detailed instructions:**

1. Open your preferred graphical file manager.
   
   a. **Linux:** The exact program name will vary by the user's choice of Desktop Environment, but the five most commonly used program names would probably be Files, nautilus, dolphin, thunar, or caja.
   
   b. **Windows:** The program provided by Microsoft for all versions of Windows is File Explorer.

2. Navigate to your home directory.
   
   a. **Linux:** For example username "acxuser", this would typically be the directory "/home/acxuser/". (Replace "acxuser" with your own username.)
   
   b. **Windows:** For example username "acxuser", this would typically be:

   ![Folder Structure](image)
   
   also known as "C:\Users\acxuser". (Replace "acxuser" with your own username.)

3. Double-click (or expand) the sub-directory (under your home directory) named ".achronix".

4. Find the sub-directory under ".achronix" with the prefix "workspace_" and the suffix matching the version of ACE that fails to start. Continuing our prior example, for ACEv9.1.1, this would be the directory name "workspace_9.1.1".

   Right-click that workspace directory and in the resulting context menu, choose "Delete".

The ACE workspace directory (containing the corrupted file cache) has now been deleted/cleaned. The next time ACE is started, the file cache (and the rest of the workspace) will be recreated from scratch, with default values.

(If the same error message occurs the next time ACE is started, even after you've deleted the workspace directory, contact Achronix technical support.)

**Multiprocess Summary Report Shows "No Timing Results Found" for Successfully Run Implementations with Existing Timing Reports**

In cases of high network file system read/write latency, it is possible that the multiprocess system might not find the required timing information within the allowed period after the external process has completed execution (most likely to occur when using external job submission systems). Sometimes the file writes occurring on the remote machine might be cached for a while, and not immediately written to the NFS drive, so that when the ACE Multiprocess system notices that the spawned process has completed, it does not find the needed timing information on the NFS drive. Therefore, the file read attempt times out, and Multiprocess gives up looking.

For these cases, there is a user preference on the Multiprocess: Configure Custom Job Submission Tool Preference Page (see page 202) called *Allowed seconds of NFS write latency*. To fix the problem, increase the value of this preference to allow more time between the completion of the implementation's flow process and when ACE gives up looking for the expected timing information for that completed implementation.
Windows: ACE Incorrectly Reports Read/Write File Permission Problems

In some cases, the ACE GUI might report a file permissions error when attempting to read or write a file on a network drive, when the permissions should actually allow the attempted read or write. As a workaround, please move the affected project to a local, non-network drive location.

Windows: ACE GUI Shown as "Not Responding"

In rare cases, when the Floorplanner Perspective is first changed, the ACE GUI window can become solid grey, and the title bar can change to read something like "ACE - Achronix CAD Environment - designName - implementationName - (deviceName) - (Not Responding)". When this problem has been reported, it has always been the case that the Floorplanner is taking too long to repaint.

The Windows operating system requires that applications check-in every five seconds, or the application is deemed non-responsive. Non-responsive applications are given a figurative kick-in-the-pants by Windows, and asked to repaint the screen. When the screen paint itself is taking more than five seconds, as can happen with poor Floorplanner Optimization settings, an application can be forced into an effective infinite-loop of paint requests from the operating system.

If, in Windows, it is ever noticed that the ACE GUI is being called non-responsive by Windows (check the application title bar), ACE has most likely entered this looped painting state. To escape this state, change back to the Project perspective (or any other perspective without the Floorplanner view visible), then navigate to the the Floorplanner View Optimizations Preference Page (see page 196), (Window → Preferences → Floorplanner View Optimizations) and ensure that Enable Incremental Rendering and Render large areas as smaller tiled areas are both enabled for the current design's complexity level.

**Note**

Both are enabled by default for everything except trivial designs. Press the Restore Defaults button to return to the default settings. If both are already enabled, and the non-responsive state still occurs, please call Achronix Technical Support for guidance on further Floorplanner Optimization tweaks.

Windows: Garbage sometimes appears in the Floorplanner View during panning operations (and remains after panning is completed)

In some cases customers are reporting Floorplanner render errors during/after panning operations.

While Achronix works to fix these rendering errors, there are two potential workarounds to mitigate the render problem.

- Whenever render errors appear in the Floorplanner, first ensure the Floorplanner View has the application focus, then press the backtick (') key on the keyboard to force the Floorplanner to perform a complete repaint of the full render area.

- In the Floorplanner preferences (Window → Preferences → Floorplanner View Optimizations) enable the When panning, show only background layer checkboxes for both the High and Medium complexity columns. Now, when the panning operation completes, the full view will be automatically re-rendered, eliminating any mid-pan render errors.
Windows: ACE Startup Error Due to Missing DLL Component in Windows 10

In some Windows 10 configurations, the following error dialog might appear when invoking the ACE GUI. This error occurs due to a missing DLL component from the Visual Studio redistributable installer. This situation can be resolved by reinstalling the `vc_redist.x64.exe` executable. This executable can be downloaded from the following link: https://www.microsoft.com/en-ca/download/details.aspx?id=48145.

![ACE Startup Error](image)

**Figure 302: ACE Startup Error**

Windows: The icons and buttons in ACE are too small

There are two main ways to deal with this. You can ask Windows to scale everything, which will affect all applications (not just ACE), and if that's not good enough, you can additionally make just ACE further alter the icon (and potentially font) scaling.

**Asking Windows to upscale images and fonts for all applications**

See the Microsoft documentation here for related information: https://support.microsoft.com/en-us/windows/make-text-and-apps-bigger-c3095a80-6edd-4779-9282-623c4d721d64

**Asking just ACE to upscale images and fonts**

ACE already scales fonts (and to a lesser extent images) according to what Windows tells it to do, following the settings from the OS, as described above. But by default ACE uses a very coarse scaling granularity for images, and only doubles or triples icon sizes (like 200% or 300%), and does not upscale images/icons by smaller fractions (like 125% or 150%). This is because the fractional scaling can reportedly cause the (Eclipse) frameworks underlying ACE to crash with some video drivers. Thus to maximize stability, ACE disables framework-based fractional scaling by default.

Windows itself has more advanced scaling in the Compatibility Settings area which some users may prefer, but this can also make fonts and images blocky or blurry, so ACE does not enable these settings by default either.

Users having trouble due to the icons/buttons being too small may choose to try either alternate scaling option below (or both in combination) *at their own risk*.

**Asking Windows to alter the scaling settings for just ACE (which may make text and fonts blurry/blocky)**

Close ACE if it is running. Open *Windows Explorer* and navigate to the directory where ACE was installed. (By default this will be `C:\Program Files\Achronix CAD Environment`) In that directory find the `ace.exe` file, right-click that file, and select Properties. A dialog titled *ace.exe Properties* will open. Turn to the Compatibility tab, and near the bottom of the dialog press the Change high DPI settings button, which will cause a new smaller dialog to appear, also
titled **ace.exe Properties**. Near the bottom of this dialog select the checkbox **Override high DPI scaling behavior. Scaling performed by:** and then in the combobox below, select the value **System (Enhanced)** instead of the default value of **Application**. Press the **OK** button to close the small properties dialog, and then press the **OK** button to close the larger properties dialog as well. Start ACE, and observe that image and font scaling may now occur in a more granular /fractional fashion, though things may now be blurry and/or blocky.

![Screenshot showing the sequence to change the DPI settings](image)

**Figure 303:** Screenshot showing the sequence to change the DPI settings

**To revert this change, disable this supplemental scaling functionality and return ACE to the default behavior:**

Close ACE if it is running. Open **Windows Explorer** and navigate to the directory where ACE was installed. (By default this will be C:\Program Files\Achronix CAD Environment) In that directory find the ace executable, right-click that file, and select **Properties**. A dialog titled **ace.exe Properties** will open. Turn to the **Compatibility** tab, and near the bottom of the dialog press the **Change high DPI settings** button, which will cause a new smaller dialog to appear, also titled **ace.exe Properties**. Near the bottom of this dialog change the setting **System (Enhanced)** back to the default of **Application**, and then deselect (uncheck) the checkbox **Override high DPI scaling behavior. Scaling performed by:**. Press the **OK** button to close the small properties dialog, and then press the **OK** button to close the larger properties dialog as well. The next time ACE is started the scaling will be back to the default behavior.

**Enabling ACE's application framework's fractional scaling (fonts remain crisp, but icons may become blurry and ACE may experience instability with some video drivers)**

Close all running instances of ACE. Open the file <ace_installation_directory>\system\gui\ACE_GUI_Launcher.ini in a text editor (like notepad), and at the bottom of the file add a new line:

```ini
-Dswt.autoscale=quarter
```

---

ACE User Guide (UG070)
And then save the changes to the file. Note that saving the file may require Administrator access; work with IT or MIS personnel to make this change if required.

The next time ACE is started, this will allow ACE to scale images and icons to the more granular fractional values requested by Windows, like 125%, 150%, 175%, 200%, 225%, etc.

If after making this change, some images within ACE vanish, or if ACE experiences crashes (or even silently vanishes), simply remove that new line from the bottom of the ACE_GUI_Launcher.ini file to return to the prior (much more stable) behavior.

Linux: Resource Limits: ACE Reports an OutOfMemory Error, But There is Plenty of Free Memory Available

When an OutOfMemory error is reported by ACE, always verify that there is sufficient physical and virtual memory available to run ACE. Running out of physical or virtual memory is the true cause of the error message in >95% of the cases reported.

Consult an Achronix FAE if the ACE memory requirements are unknown for the available licensed Achronix target devices.

There are several types of resource exhaustion in Linux that can be reported as an OutOfMemoryError. Insufficient thread and/or file resources may have similar error reports in some cases.

In some OS configurations, Linux can create a new thread for each file opened, so even when thread resource limits are mentioned in the detailed error message, it could be a case where the file limits (max files open simultaneously) are set too low for the user.

A quick fix attempt would be, before starting ACE, close all other running programs which could have files open. If this works, then the file limits are very likely the problem. But even if this doesn't help on the first attempt, the root problem could still be due to file limits.

In the bash shell, (other shells use different, but often similar, commands,) this is typically managed with the 'ulimit' command. All current ulimit settings can be queried using 'ulimit -a', or query just the open file limit with 'ulimit -n'.

To see if a higher file limit helps, if (for example) the current open files value is 1000, try raising it to 2000, then run ACE. To increase the file limit in this way using the bash shell, use the command 'ulimit -n 2000'. It might be possible to remove the limit entirely with 'ulimit -n unlimited'. (Again, users of other shells need to use a different command.)

It is highly recommended that these file limit changes be performed under the supervision of the system administrator. System administrators often apply upper bounds for such ulimit assignments, and individual users cannot exceed those upper bounds without system administrator assistance.

If raising the open files limit does allow ACE to launch correctly, the new raised limit should be applied to the user's '.bashrc' (or similar) files loaded at shell startup, again with help from the system administrator if necessary.
(Alternately, if permissions allow it, create a script used to start ACE. In that script, the file limit could be temporarily raised before starting ACE, and then lowered again when ACE completes execution.)
Linux: In the TWM Window Manager, the First Time the ACE GUI is Started After Installation, the ACE Window is So Small Users Might Not See it

Currently, twm is ignoring the ACE GUI's attempts to set its own initial application window size and location. After ACE is installed (and until the window is moved and resized), the ACE window is in the upper-left corner of the screen, with tiny dimensions (we've seen it as small as 7 pixels wide by 7 pixels tall). This tiny window is often not noticed, especially if there already is a minimized application icon in that region of the screen.

When ACE is running in that tiny window, the ACE window can be moved and enlarged in the same manner as with any other running application window in twm.

ACE does not support the twm standard of choosing the application window's position and dimensions at startup with command-line arguments. Instead, ACE remembers the position and dimensions at application shutdown, and the next time the application is started, ACE returns to that same position and dimension from the last ACE session.

Linux: Odd Behavior When Using X DISPLAY Forwarding if the X Client and X Server Are More than One Major Revision Apart

When running the ACE GUI, the host workstation and display workstation must be at most one OS major revision apart (RHEL7 can talk to RHEL8, but RHEL7 should not talk to RHEL9).

RHEL only supports X DISPLAY redirection across adjacent major operating system revisions. There are known problems when (for example) applications like the ACE GUI are running on RHEL7 but having their X DISPLAY redirected to a RHEL9 workstation, or vice-versa. Users attempting to bridge multiple OS revisions in this way see GUI painting errors and mouse handling errors, especially for drag-and-drop operations. Some users have also reported hung GUIs and application crashes when they attempted to host ACE on RHEL7 and display on RHEL9.

Because the operating system vendor does not support this behavior, Achronix is unable to support it.

Linux: ACE Menus Do Not Show Icons Next to the Action Names

Most actions within ACE are intended to have an associated graphical icon. This icon is able to be displayed in the drop-down menus within ACE. If no icons are displayed next to actions in menus, this behavior is caused by a GTK+ configuration that has disabled the icons.

To re-enable icons for all GTK+ applications (not just ACE), the following command should reset the display. As this issue is the result of GTK+ functionality, and not ACE functionality, this tweak is not officially supported by Achronix.

```bash
gconftool-2 --type boolean --set /desktop/gnome/interface/menus_have_icons true
```

Linux: ACE Ignores LD_LIBRARY_PATH

In the majority of cases, the ACE GUI crashes when it encounters custom/obsolete libraries through an assigned LD_LIBRARY_PATH environment variable.

Because of this, by default ACE intentionally ignores preassigned LD_LIBRARY_PATH values when it starts.

⚠️ Warning!

Achronix does not support ACE when forced to run using LD_LIBRARY_PATH.
Linux: ACE forces the use of the GDK X11 rendering engine even while running under Wayland

Technically this is not a bug, but an intentional design choice. But because some users prefer the new features in Wayland despite the known stability of X11 on all Achronix-supported versions of Linux, we'll include an entry for this detail.

At present, the Eclipse framework underlying ACE has a high number of bugs when rendering natively under Wayland. Mouse actions, particularly relating to drag-and-drop, are especially problematic. Custom diagram rendering performance (as used in the Floorplanner, for example) has been observed to be much slower under Wayland.

To work around these limitations while the Eclipse framework developer community learns how to best use GTK/GDK under Wayland, Achronix currently forces ACE to render in GTK/GDK using X11 programming interfaces at all times, even while running on Wayland.

If users really want to allow the Eclipse frameworks underlying ACE to render GTK/GDK natively under Wayland, they do so at their own risk – this is unsupported by Achronix due to all the known framework issues.

UNSUPPORTED call to allow ACE to use the known-buggy Wayland GTK/GDK rendering

./ace -allow_wayland

Note that using the above startup command does not force ACE to use Wayland. There's a large number of details that must already be in place before using Wayland rendering is even possible, which are outside the scope of this document. When ACE is started in this manner, the Eclipse frameworks underlying ACE will automatically choose whether to use X11 or Wayland based on a number of factors, also beyond the scope of this document. This command simply ensure ACE will no longer enforce the use of X11 rendering in all cases.

To help convince any optimists that it truly is a bad idea to start ACE this way, the list of the Eclipse framework’s Wayland bugs can be viewed online at the links below.

(recently reported issues:)
https://github.com/eclipse-platform/eclipse.platform.swt/issues?q=is%3Aissue+label%3AWayland+

(older issues:)

When viewing the issues lists, readers should keep in mind that the current ACE release is using Eclipse framework version 4.28, also known as version 2023-06.
Linux: Incompatible Default Web Browser

At startup, ACE tries to find a compatible 64-bit embeddable HTML browser already installed on the system for ACE to use to display HTML reports and help content. If no such embeddable browser is detected within the Linux installation, ACE shows the warning dialog above and reverts to a primitive fallback HTML browser (which has slightly reduced functionality and known stability issues on some platforms, but is still better than nothing). RHEL/CentOS v7.9 and RHEL/Rocky v8.x, SUSE15, Ubuntu 20.04LTS, and Ubuntu22.04LTS customers are not expected to experience any problems with web browser support. Customers running on unsupported Linux distros might need to perform additional steps to ensure ACE has a compatible web browser framework available if the fallback (reduced-functionality) browser proves to be unstable.

Solution

To solve reported web browser incompatibility problems, work with your IT department to install an ACE-compatible 64-bit web browser in your distribution.

For all Achronix-supported Linux operating systems, any WebKit2GTK packages compiled for GTK+3 support are expected to work, regardless of version number, though the latest versions from the official distro repositories are expected to be the fastest and most stable.

Warning!

ACE Linux web browser support requires GTK+3 and WebKit2
Starting in ACE v8.4, ACE is no longer compatible with GTK+2. In Linux ACE requires GTK+3. GTK+4 is not yet supported.
Starting in ACE v8.4, ACE is no longer compatible with WebKit (unofficially also known as WebKit1). In Linux ACE requires WebKit2 (the successor to WebKit).

Details

GTK+2
Starting in ACEv8.4, ACE no longer supports GTK+2.

GTK+3
For GTK+3 Linux distros (like RHEL/CentOS7 and later, SUSE15 and later, and Ubuntu 20.04LTS and later), with the assistance of a system administrator, install a GTK+3 compatible version of WebKit2GTK (not WebKitGTK).
These are expected to be the following package names, all of which are available within the official distribution repositories and are often installed by default.

- (RHEL/CentOS7) a package named "webkitgtk4.x86_64", which contains WebKit2 compiled for GTK+3
- (RHEL/Rocky8) a package named "webkit2gtk3", which contains WebKit2 compiled for GTK+3
- (SUSE15) a package with a name starting with "libwebkit2gtk-4.0", which contains WebKit2 compiled for GTK+3
- (Ubuntu, all supported versions) a package with a name starting with "libwebkit2gtk-4.0", which contains WebKit2 compiled for GTK+3

GTK+4

ACE does not support GTK+4 at this time.

When Nothing Else Works

When nothing else works, or when all the available GTK+3 versions of WebKit2 fail to be found or start (due to crashes), one more choice exists. An ancient fallback HTML3 browser is shipped within ACE. This fallback browser appears to be stable on supported Linux distros (while using X11), but it has reduced functionality and performance, renders without antialiasing (the fonts often look ugly), the fonts can be illegible (too small) on HiDPI monitors, it occasionally might not show the entire report on the first try (though scrolling the report or resizing the report usually causes it to fully paint), and it does not directly support the Wayland display server (instead of X11).

ACE automatically tries this fallback browser when it cannot find any compatible embeddable browser within the OS. But if it finds a compatible browser (that subsequently crashes), ACE might not get a chance to automatically try the fallback browser.

It is possible to force the use of the fallback browser, which can get around crashes in the various WebKit and/or GTK frameworks. Start ACE with the appropriate argument to force the use of the fallback browser.

```bash
./ace -force_fallback_html_browser
```

**Note**

This fallback browser is NOT an ideal solution. It is always a much better idea to work with the local IT/MIS support team to get the latest stable version of WebKit2 and GTK+3 installed and working together on the Linux workstation instead.

**NOTE: Do not use both -allow_wayland and -force_fallback_html_browser at the same time**

The fallback html browser is known to have multiple display and mouse interaction errors if you try using both -allow_wayland and -force_fallback_html_browser at the same time. (ACE defaults to disallowing Wayland rendering in favor of X11 rendering, so the -force_fallback_html_browser argument is expected to work in all cases, as long as -allow_wayland is not used at the same time.)
Additional Information

RHEL/CentOS7

RHEL/CentOS7 includes versions of WebKit2GTK+3 (the package "webkit4.x86_64") within the official release repositories. These are compatible with ACE when running on RHEL/CentOS7. These packages are often installed by default, and must be installed for full functionality to be available in ACE.

RHEL8

RHEL8 includes versions of WebKit2GTK+3 (the package "webkit2gtk3.x86_64") within the official release repositories. These are compatible with ACE when running on RHEL8. These packages are often installed by default, and must be installed for full functionality to be available in ACE.

WebKit and WebKitGTK Technical Details

There are two main APIs for WebKit development. These are known as WebKit2 (the latest edition), and its predecessor known as WebKit (also sometimes referred to for clarity as WebKit(1) or WebKit[1]). There are many released versions of each, including (confusingly) WebKit(1) version 2.x.y, which is incompatible with WebKit2.

Versions of WebKit and WebKit2 can be compiled to support GTK+2 or GTK+3, and recent versions of WebKit2 may also support GTK+4, which are then all grouped under the WebKitGTK name/prefix in some distros like RHEL7. (Other Linux distributions including RHEL8 have chosen a clearer delineation by using the names WebKitGTK and WebKit2GTK.)

Over time, WebKitGTK has been made available as several package names for RHEL, corresponding to the various combinations of support for GTK+2/GTK+3/GTK+4 and WebKit(1)/WebKit2. Versions which are struck will not work with ACE.

- webkitgtk: WebKit(1) compiled for GTK+2 (found in non-official community repositories for RHEL7)
- webkitgtk2: WebKit2 compiled for GTK+2 (only briefly available for RHEL7; this appears to have been a short-lived option during the very early development of WebKit2)
- webkitgtk3: WebKit(1) compiled for GTK+3 (found in the official RHEL7 repositories)
- webkitgtk4: WebKit2 compiled for GTK+3 (found in the official RHEL7 repositories; this is the WebKitGTK package most actively developed/supported for RHEL7/CentOS7)
- webkit2gtk3: WebKit2 compiled for GTK+3 (found in the official RHEL8 and RHEL9 repositories; this is the WebKitGTK package most actively developed/supported for RHEL/Rocky8 and RHEL/Rocky9)
- libwebkit2gtk-4_0 and libwebkit2gtk-4.0: WebKit2 compiled for GTK+3 using libsoup2 (found in the official SUSE 15 and Ubuntu repositories). This is the preferred version to be used with ACE on these distros.
- libwebkit2gtk-4_1 and libwebkit2gtk-4.1: WebKit2 compiled for GTK+3 using libsoup3 (found in the official SUSE 15 and Ubuntu 22.04LTS repositories). ACE has not yet been tested with this library.
- libwebkit2gtk-5_0: WebKit2 compiled for GTK+4 (found in the official SUSE 15 repositories)

Other Linux Distros

Note

For unsupported Linux distros:
Alternate distributions of Linux may use different package naming schemes than those shown above.
The naming standards for WebKitGTK packages targeting GTK+2, GTK+3, GTK+4, WebKit, and WebKit2 are non-obvious, and are thus difficult to understand. It is unfortunately very easy to confuse versions of WebKitGTK(1) v2.x with versions of WebKit2GTK, even though they're incompatible.

A package management tool (like ‘yum’ on RHEL, ‘zypper’ on SUSE, or ‘apt’ on Ubuntu) is the best way to research these versions/dependencies, as well as perform the eventual package installation.

A website that can assist with the navigation of the confusing WebKitGTK names and versions is https://pkgs.org/download/webkitgtk. At that site, search for "webkit2gtk" in your chosen Linux distribution, find one that works with GTK+3, and then install it with the local package management tool appropriate for your Linux distro.

**Linux: ACE Requires an Unusually Large Amount of Virtual Memory (Due to WebKit2)**

In Linux, the Eclipse framework underlying ACE uses the WebKit2GTK+3 HTML browser framework. This framework uses large amounts of virtual memory (sometimes more than 100GB), apparently as part of the browser's javascript security model. At the present time, there appears to be no way for Achronix to ask/force WebKit2 to use less virtual memory in ACE.

**Linux: ACE forces the use of the Adwaita GTK+3 Theme; Can I Change This?**

The Eclipse GUI framework underlying ACE only guarantees correct behavior and appearance on GTK+3 when the Adwaita GTK+3 theme is in use. Thus ACE is only officially supported running on the Adwaita GTK+3 theme. Because the Adwaita GTK+3 theme is available by default on all supported Linux distributions, this restriction is not expected to be a problem in most cases.

**Themes**

ACE currently always uses the GTK+3 widgets library in Linux, regardless which desktop environment and/or window manager is being used. The GTK+3 widgets support theme customization. Thus the look and feel of ACE can be modified by changing what is called the "application GTK widgets theme/style/appearance" (the exact name varies based on distro/version/desktop) setting in Linux. By default, to ensure accurate rendering and behavior, as well as optimal rendering performance, ACE forces itself to use the Adwaita theme, even if another theme has been explicitly chosen for other GTK+3 applications running on that Linux desktop.

⚠️ **The default GTK+3 theme "Adwaita" is the only theme supported by ACE.**

The Eclipse GUI framework underlying ACE only guarantees correct behavior and appearance in Linux when the Adwaita GTK+3 theme is in use. Thus ACE is also only officially supported in Linux when running on the Adwaita GTK+3 theme. At startup, ACE overrides the user/system GTK+3 theme choice and forces itself to use Adwaita, even if the user has chosen a different theme to be used by all GTK+3 applications. Because Adwaita is the default GTK+3 theme provided by the GTK team themselves, and because Adwaita ships as a part of GTK+3 by default, this restriction is not expected to be a problem for ACE users on Achronix-supported Linux distros.

At this time, the default GTK+3/Gnome theme "Adwaita" is the only supported GTK+3 Theme choice for ACE. Customers running Linux distributions other than RHEL and/or SUSE (and their respective clones), which all use Adwaita by default, might also have good results with whatever GTK+3 Theme is enabled by default with their distro, but this is only recommended if the preferred Adwaita theme is not available.
When trying alternate themes, Achronix requires that GTK+ v3.22 or later be used with ACE, because those GTK+ versions are reportedly the "final, stable" versions of GTK+3, and are thus the most stable. All releases of GTK+3 prior to v3.22 were considered by the GTK+ team to be (unstable) development releases.

By starting ACE with the command-line argument `-keep_user_gtk_theme`, ACE stops enforcing the usage of the Adwaita theme, and allows the use of alternate system GTK+3 themes. Be warned that the use of alternate GTK+3 themes can cause illegible foreground/background color combinations, graphical performance issues, drag-and-drop issues, loss of accessibility functionality (like screen readers), and in rare cases can even cause ACE to crash. In all cases that were backtracked to the Themes frameworks, when the user reverted back to allowing ACE to use the (default) Adwaita theme, these problems did not reoccur in ACE.

**Changing the GTK+3 Theme**

"Dark" themes are not supported in ACE.

At this time, ACE does not support any dark themes. Customers desiring ACE support for dark themes should request "dark theme support" as an ACE feature enhancement so it can be prioritized appropriately.

The exact setting to change the GTK application widgets theme varies by Linux distribution and version, as well as by desktop manager and version.

Under CentOS7 Gnome, for example:

**Gnome Tweak Tool → Appearance → Theme → GTK+**

Under CentOS7 KDE, for example:

**System Settings → Application Appearance → GTK+ Appearance → GTK+ Styles → Widget Style**

Under CentOS7 MATE, for example:

**System → Preferences → Look and Feel → Appearance → Theme → Customize... → Controls**

Consult with your local System Administrator for additional details regarding the configuration of GTK+3 and themes for your local Linux installation.

**Animations and Other Effects**

While desktop, application/window, and widget animations can improve the feel of applications for some users, other users want to avoid the negative performance impacts.

Animations and special effects are not managed by ACE itself. Often these are controlled within the Desktop Environment, Compositor, and/or Window Manager (exact locations of these settings vary significantly, with some settings available only through the manual editing of Linux configuration files), and some animations may vary even with the user's choice of GTK Theme.

Under CentOS7 Gnome, for example, animations settings can be found at:

**Tweak Tool → Appearance → Enable animations**

Under CentOS7 KDE, for example, multiple animation settings can be found at:

**System Settings → Desktop Effects**

Consult with your local System Administrator for additional details regarding the configuration of desktop, application, and widget animations and special effects for your local Linux installation.
Linux: Views and Editors Detach when Dragged Instead of Docking in the Workbench

There is currently a known GTK theme bug (Linux-only) in the Eclipse application frameworks underlying ACE that causes view/editor tab docking (including tab re-arrangement) to fail when the Help Window is used. This bug can occur even when the Help Window is minimized; some part of the underlying frameworks is remembering the window size/location despite minimization.

This bug currently appears to be dependent upon which GTK Theme is being used by the Linux window manager. (This theme choice is configured outside ACE.) We have not yet heard any reports of the bug being observed when the system default GTK themes (Adwaita on RHEL/CentOS7 and RHEL8) were in use.

There are three workarounds to allow docking when this bug occurs:

- Close the Help Window while performing the view/editor tab movement operations, and then re-open the Help Window when the movements are completed. (Minimizing the Help Window is not enough. The Help Window must be closed.)
- Shrink and move both the ACE window and the Help Window to a size/location where they do not intersect, then change the view/editor tab locations within the Workbench, then restore the desired Workbench and Help window sizes/locations.
- Work with the local Linux system administrator to change the GTK theme being used, or try to update to a newer/patched version of the chosen GTK theme.

Some versions of the Clearlooks and Glider themes seem most likely to exhibit the problem.

See the previous section titled Themes (see page 647) for more information on choosing an alternative theme in Linux.

Linux: CDE: Dialogs and Wizards Sometimes Appear Behind the Main ACE Window, Especially After Minimize/Maximize

This problem has only been observed at sites running an X server on RHEL/CentOS and the X client on CDE running within SunOS/Solaris. This configuration is not officially supported. (Achronix does not support running ACE where either the X server or the X client are on anything except supported operating systems. See the release notes accompanying ACE to determine the exact supported OS versions for a given ACE release.)

CDE has known inter-window focus issues when displaying GTK applications using the default CDE configuration. This problem is not unique to ACE, nor is it something over which ACE has any control whatsoever.

As an example, IBM tools also experience similar problems. A good description of a fix for the issue is in the IBM support forums at: http://www-1.ibm.com/support/docview.wss?uid=swg21124274.

Note

Paraphrased workaround from the IBM support forums:

Basically, the problem is caused by an awkward default setting of CDE that allows modal dialogs to be hidden behind other (parent) windows.

To replace this default setting with a more sane one, the following line needs to be added to $HOME/.Xdefaults:

Dtwm*secondariesOnTop: True
After that, reload the Xdefaults and restart the window manager. Finally, it might be necessary to also update CDE Style Manager → Windows where "Allow Primary windows on top" should not be enabled (uncheck the checkbox).

If this specific workaround from IBM tech support does not solve the problem in the local CDE configuration, please perform a web search (using similar terminology) with the assistance of a local system administrator to find and apply the fix/workaround for the local Linux window manager configuration.

**Warning!**

Achronix does not support running ACE on any combinations of Solaris/SunOS/CDE. Consult with a local System Administrator before making these or similar changes on SunOS or Solaris or CDE.

Linux: "Failed to create the part's controls": Some Views and IP Editors may fail to initialize

When this problem occurs, an error message will appear similar to the following screenshot:

![Failed to create the part's controls](image)

The problem has only been observed on older versions of RHEL/CentOS7 (versions prior to RHEL/CentOS7.7), and only with specific Desktop or Window Managers, and only at very high resolutions (when GTK+3 font scaling may become enabled). The error currently appears to be related to bugs in the various graphical library dependencies provided by Linux itself (these are not shipped within ACE).

All customers experiencing the problem have reported that upgrading the version of their preferred Desktop or Window Manager, or changing to another Desktop or Window Manager, or upgrading to newer releases of RHEL/CentOS7 (versions 7.7 or later) has fixed their problem and allowed all ACE Views and IP Editors to once again work as expected.

**Upgrading an ACE Installation**

**Note**

This is also supposed to be covered in the *ACE Installation Guide (UG002)*.

**On Windows**

Each version of ACE should ideally be installed into a new, empty directory! Never install ACE in the same directory as a prior install, unless that prior version has already been uninstalled first.

1. Disconnect any USB Bitporters
2. (If a node-locked license is being used for ACE:) Copy the `license/* .lic` file from the ACE installation directory to another location (somewhere not under the ACE installation directory).
3. Optionally, uninstall the prior version of ACE
4. Install the desired version of ACE to a new directory
5. (If a node-locked license is being used for ACE:) Copy the `license/*.lic` file back to the proper location within the new ACE installation directory.

6. Re-connect any USB Bitporters

7. Run ACE

On Linux

Each version of ACE must be installed into a new, empty directory! Never install ACE in the same directory as a prior install.

1. Create a new directory to contain the new version of ACE
2. Untar ACE into the new directory
3. Run ACE

GUI Problems after Upgrading?

In rare cases after an upgrade, (almost always when a different version of ACE is mistakenly installed on top of an existing prior installation,) ACE GUI errors or crashes might occur, especially in the IP Editors.

If you do not wish to perform an uninstall/reinstall of ACE, the following steps often solve the problem:

1. Delete the ".eclipse" subdirectory (the leading '.' is important!) in the your home directory.
   - (Windows:) typically "C:Users\username\.eclipse"
   - (Linux:) typically "/home/username/.eclipse/

   **Caution!**
   This subdirectory is hidden in Linux; if unsure what this means or how to find it, please ask your system administrator for help.

2. Try running ACE again

If problems persist:

1. Contact Achronix Technical Support, providing the following log files along with a description of the problem encountered:
   - (Windows):
     a. "C:Users\username\achronix\ace_timestamp.log"
        where `timestamp` is `year_month_day_hour_minute_second`. (Typically the crash occurred in the most recent log file.) For example:
        "C:Users\patsmith\achronix\ace_2018_12_02_16_06_58.log"
     b. "C:Users\username\achronix\workspace_version\framework\metadata\.log"
        where `version` is the version of ACE which is being run, and `framework` is the Eclipse framework version underlying ACE. For example:
        "C:Users\patsmith\eclipse\workspace_7.1\e46\metadata\.log"
   - (Linux)
     a. "\home\username\achronix\ace_timestamp.log"
        where `timestamp` is `year_month_day_hour_minute_second`. (Typically the crash occurred in the most recent log file.) For example:
        "\home\patsmith\achronix\ace_2018_12_02_16_06_58.log"
b. "\home\username\achronix\workspace_version\framework\.metadata\log"

where *version* is the version of ACE which is being run, and *framework* is the Eclipse framework version underlying ACE. For example:
"\home\patsmith\eclipse\workspace_7.1\e46\.metadata\log"

2. Delete the ".achronix" subdirectory (the leading '.' is important!) in your home directory.

3. Run ACE
# Revision History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>02 Jul 2016</td>
<td>Initial Speedcore document release.</td>
</tr>
<tr>
<td>1.1</td>
<td>30 Oct 2016</td>
<td><strong>Additions:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Added new tasks detailing Automatic Flop Pushing into I/O Pads (see page 434) and Working with Virtual I/O (see page 442).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Added the page Filter Properties (see page 246) showing all supported filters for the Search Filter Builder Dialog (see page 183), and the find (see page 570), and filter (see page 568) Tcl commands.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Added new Speedster16t IP Configuration Editor sections</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Added JTAG support for FTDI FT2232H (in addition to Bitporter)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Added Strict Flow Mode in addition to Evaluation and Normal modes to the Options View (see page 106)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Added new Task content with additional info about Highlighting Objects in the Floorplanner View (see page 323), and updated cross-references for Views providing Highlight functionality.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Added the page Detecting Changes to Project Source Files (see page 300)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Integrated the formerly standalone Incremental Compile Tutorial into this guide, under Using Incremental Compilation (Partitions) (see page 380)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Updates:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Updated the Options View (see page 106) to reflect the latest implementation options.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The Clock Domains View (see page 36), Clock Regions View (see page 39), Partitions View (see page 115), and Placement Regions View (see page 118) have all been updated to mention support for new actions, and dynamic per-device site type columns</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Updated the Floorplanner View (see page 57) to reflect the device awareness for Labels and Tooltips in the fly-out palette.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Split the Tcl Command Reference (see page 526) into two sections: SDC Commands (see page 526) and ACE Tcl Commands (see page 551).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Renamed all occurrences of &quot;SnapShot&quot; to &quot;Snapshot&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Removals:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- In the Critical Path Diagram View (see page 49), the Layers choices specific to obsolete fabrics have been removed. Associated screenshots and text were be updated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Obsolete commands were removed from the ACE Tcl Commands. (see page 551)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Additions:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Concepts (see page 24): Added ECC support to the Speedster16t BRAM Configuration Editor and Speedster16t FIFO Configuration Editor.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Tcl Command Reference (see page 526): Added a new Tcl commands category, Interactive Timing Commands. (see page 545)</td>
</tr>
<tr>
<td>Version</td>
<td>Date</td>
<td>Updates</td>
</tr>
<tr>
<td>-----------</td>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1.2</td>
<td>30 Nov 2016</td>
<td><strong>Concepts</strong> <em>(see page 24)</em>:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• In the <strong>Floorplanner View</strong> <em>(see page 57)</em>, the choice &quot;IO Port Names&quot; has been re-added to the Labels and Tooltips options for eFPGA/Speedcore products.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Misc flop pushing clarifications in the <strong>Options View</strong> <em>(see page 106)</em> and <strong>Automatic Flop Pushing into I/O Pads</strong> <em>(see page 434)</em> pages.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Enhanced the description of strict mode error checking on the <strong>Flow Mode</strong> <em>(see page 228)</em> page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Tcl Command Reference</strong> <em>(see page 526)</em>: Clarified when the &quot;p:&quot; port name may be used with the <strong>set_placement</strong> <em>(see page 621)</em> Tcl command.</td>
</tr>
<tr>
<td>1.2.1</td>
<td>23 Dec 2016</td>
<td><strong>Tasks</strong> <em>(see page 262)</em>:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Minor updates for clarity on <strong>Automatic Flop Pushing into I/O Pads</strong> <em>(see page 434)</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Removed references to obsolete <strong>Bitporter and acx_stapl_player Software Release Notes</strong> <em>(RN007)</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Tcl Command Reference</strong> <em>(see page 526)</em>:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added details to <strong>get_pins</strong> <em>(see page 532)</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Corrected error in <strong>set_clock_latency</strong> <em>(see page 535)</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Add details for the option <code>-cpu_width &lt;int&gt;</code> to <strong>write_bitstream</strong> <em>(see page 625)</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Concepts</strong> <em>(see page 24)</em>: Removed references to obsolete <strong>Bitporter and acx_stapl_player Software Release Notes</strong> <em>(RN007)</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Views</strong> <em>(see page 33)</em>: Added details on the <strong>CPU Bus Width</strong> option under the <strong>Options View</strong> <em>(see page 106)</em>.</td>
</tr>
<tr>
<td>2.0_beta</td>
<td>01 Feb 2017</td>
<td><strong>Troubleshooting</strong> <em>(see page 628)</em>: Added section about ACE startup errors regarding localhost TCP ports.</td>
</tr>
<tr>
<td>2.0_beta2</td>
<td>28 Feb 2017</td>
<td><strong>Concepts</strong> <em>(see page 24)</em>:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added seventeen new Bitstream generation Implementation Options to the <strong>Options View</strong> <em>(see page 106)</em> for Speedcore eFPGAs (two options specific to Speedster FPGAs were hidden).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added new preferences to the <strong>Project Management Preference Page</strong> <em>(see page 211)</em> to disable and/or change the frequency of project source file consistency checks.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Tasks</strong> <em>(see page 262)</em>: Updated <strong>Automatic Flop Pushing into I/O Pads</strong> <em>(see page 434)</em>: The port attribute <code>syn_useiff</code> should no longer be used.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Tcl Command Reference</strong> <em>(see page 526)</em>:</td>
</tr>
<tr>
<td>Version</td>
<td>Date</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2.0</td>
<td>02 May 2017</td>
<td>Additions:&lt;br&gt;• add_project_constraints (see page 551) now supports filtering constraints by corner, temperature, and voltage.&lt;br&gt;• run_stapl_action (see page 611) now supports STAPL variable initialization overrides with the new -defines option.&lt;br&gt;• write_bitstream (see page 625) now supports configurable bit widths for CPU Mode formatted output files.&lt;br&gt;• Updated help text for get_pins (see page 532), set_clock_latency (see page 535), set_equivalent_pins. (see page 619)</td>
</tr>
<tr>
<td>2.5</td>
<td>01 Jul 2017</td>
<td>Additions:&lt;br&gt;• Views (see page 33): Added new Implementation Options &quot;Move Flip-flop Reset&quot;, &quot;Pad Flop Pushing Clock Type&quot;, and &quot;Report all temperature corners&quot; to the Options View (see page 106).&lt;br&gt;• Tcl Command Reference (see page 526): Added create_boundary_pins (see page 558), export_partition (see page 568), get_ace_ext_dir (see page 572), get_ace_ext_lib (see page 572), get_flow_steps (see page 576), get_report_sweep_temperature_corners (see page 583).&lt;br&gt;Updates:&lt;br&gt;• Concepts (see page 24): New IP Configuration Dialog (see page 174) now prohibits IP module name collisions with Achronix's reserved module names.&lt;br&gt;• Concepts (see page 24): The Flow Steps (see page 223) page now includes a table of flow step names and IDs.&lt;br&gt;• Concepts (see page 24): The Speedster16t BRAM Configuration Editor now supports &quot;Simple Dual Port with Soft ECC&quot;.</td>
</tr>
<tr>
<td>2.9</td>
<td>24 Sep 2017</td>
<td>Additions:&lt;br&gt;• Tcl Command Reference (see page 526): Added get_partition_names (see page 579), move_project_netlists (see page 589), write_partition_blackbox (see page 627), write_partition_db (see page 627).&lt;br&gt;Updates:&lt;br&gt;• Concepts (see page 24):&lt;br&gt;  • The Multiprocess Summary Report (see page 240) now supports the Timing Analysis &quot;Report all temperature corners&quot; implementation option, and shows additional columns of timing data for each reported PVT combination. Peak memory usage is now reported alongside the runtimes. Clarity of results is improved in cases where the report contains a mix of Sign-Off timing data for some implementations and Post-Route timing data for other implementations.</td>
</tr>
<tr>
<td>Version</td>
<td>Date</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
|         |           | - The Snapshot Debugger View (see page 139) has been significantly updated to reflect the latest Snapshot Version 3 enhancements.  
|         |           | - Configure JTAG Connection Preference Page (see page 187) updated with details regarding multi-device scan chains.  
|         |           | - Tasks (see page 262): The entire section regarding Running the Snapshot Debugger (see page 344) has been updated to reflect the latest Snapshot Version 3 enhancements. These include new features like: Startup Trigger; Edge Triggering; configurable monitor, trigger, and stimuli widths; Repetitive Trigger mode; etc. For complete details, see the Snapshot User Guide appropriate to each Achronix device family.  
|         |           | Additions:  
|         |           | - Concepts (see page 24): Added supplemental information describing Timing Across All Temperature Corners (see page 248)  
|         |           | - Tcl Command Reference (see page 526): Added new commands: `export_all_partitions` (see page 568), `generate_route_delay_table` (see page 572), `insert_delay` (see page 587)  
|         |           | Updates:  
|         |           | - Concepts (see page 24):  
|         |           | - On the Configure JTAG Connection Preference Page (see page 187), corrected misleading information regarding multi-device scan chains, and removed now-obsolete configuration settings (for pod type and connection type).  
|         |           | - Removed now-obsolete information from the Options View (see page 106) regarding JTAG configuration settings.  
|         |           | - In the Flow View (see page 67), added the Warning icon to the icons table. The icon is primarily used to indicate out-of-sync files, as described in Detecting Changes to Project Source Files (see page 300).  
|         |           | - Tasks (see page 262):  
|         |           | - The Configuring the JTAG Connection (see page 339) page was updated to further clarify details regarding multi-device scan chains, and to remove mention of now-obsolete configuration settings (for pod type and connection type).  
|         |           | - The Generating Timing Reports (see page 333) page was updated with additional information about multiple temperature corners and related Tcl commands.  
|         |           | - The Running Multiple Flows in Parallel (see page 285) page was updated to clarify why external job submission systems must use synchronous/blocking commands, and why asynchronous/non-blocking commands can potentially cause serious problems.  
|         |           | - The Single-Process Incremental Compile Tutorial (see page 384) was updated for clarity  
|         |           | - The Snapshot Design Flow (see page 344) received an updated diagram  
|         |           | - Tcl Command Reference (see page 526): Updated `create_boundary_pins` (see page 558), `create_flow_step` (see page 558), `export_partition` (see page 568), `run_fpga_download` (see page 603), `save_properties` (see page 617), `write_partition_blackbox` (see page 627), `write_partition_db` (see page 627)
<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.0</td>
<td>19 Aug 2018</td>
<td>• Troubleshooting (see page 628): enhanced information regarding ACE error codes</td>
</tr>
</tbody>
</table>

**Additions:**

- Concepts (see page 24):
  - Added new page describing various supported ACE Verilog Attributes (see page 242) that can be applied to instances, nets, pin, ports, or other objects in the ACE datamodel.
  - Described the new Properties View (see page 127)
  - Added a description of the Implementation Options Report (see page 242)

- Tasks (see page 262)
  - Added content regarding Applying and Checking Properties (see page 337)

- Tcl Command Reference (see page 526):
  - Added new Tcl commands `get_clock_regions` (see page 574), `get_clock_region_bounds` (see page 574), `get_file_line` (see page 576), `get_regions` (see page 583), `get_region_bounds` (see page 582), `report_coverage` (see page 595-595)
  - Added new Interactive Timing Commands (see page 545) pages for `check_timing` and `report_clock`. Reminder: these are stand-alone timer commands, enabled only after `prepare_sta` (see page 547) is run, and disabled after `reset_sta` (see page 550) is run.

**Updates:**

- Concepts (see page 24):
  - The JTAG Browser View was updated to include a new "Word Step" field.
  - Corrected the Critical Path Diagram View (see page 49) to reflect the removal of the now-obsolete Layers section of the palette
  - The configuration of the Floorplanner View (see page 57)'s Rendering Mode has been moved from the view’s fly-out palette to the Floorplanner View Colors and Layers Preference Page (see page 191)
  - Clarified how the ! icon in the Flow View (see page 67) relates to Detecting Changes to Project Source Files (see page 300)
  - Documented the new ease-of-use feature/button ( ) on the Multiprocess View (see page 86) allowing users to re-open a pre-existing Multiprocess Summary Report (see page 240).
  - For the Options View (see page 106), updated the listings of common options, and improved the content describing the Tcl interactions for viewing/changing implementation options in general
  - Improved the description of the Power Dissipation Report (see page 230), including clarification of the ramifications of Timing Across All Temperature Corners (see page 248)
  - The Projects View (see page 123) gained a new action: Reload Project ( ); added a screenshot and description showing how disabled constraints will be greyed out in this view; clarified details regarding the load order of constraint files.

- Tasks (see page 262):
<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
</table>
|         |      | • Clarified details regarding Adding Source Files (see page 275) to ACE projects, how the source file load order may be changed, and the ways in which constraint files may be enabled/disabled (instead of added/removed) for implementations  
• Mentioned that it is also possible to disable constraint files in implementations, instead of completely Removing Source Files (see page 278) from projects  
• Enhanced the instructions for Assigning Placement Region Constraints (see page 374)  
• Renamed the section 'Getting Floorplanner Object Tooltips' to Choosing Floorplanner Object Tooltips (see page 323) for clarity  
• Enhanced the descriptions of Loading Projects (see page 273) to cover both GUI and Tcl interactions, with new explanations of project locking and lock files.  
• Added more thorough discussion of the license ramifications of Running Multiple Flows in Parallel (see page 285), and added a cautionary note describing how multiple implementations can unexpectedly generate identical results after upgrading ACE, along with the recommended fix.  
• Tcl Command Reference (see page 526):  
  • Updated `report_timing` with newly supported command line options.  
  • Renamed `display_rtl` to `display_netlist` (see page 563) which will better reflect the command's actual functionality  
• Troubleshooting (see page 628): updated discussion of project locking and when forcing locked projects to load is acceptable; updated descriptions of font management; updated content for ACE startup error diagnosis (firewall vs license issues); added new content regarding missing icons for actions in menus. |

ACE v7.0 is the first combined release, supporting both Speedster FPGA devices and Speedcore eFPGA devices. Rather than parallel releases, there is now a single release, thus the change in numbering schemes (to be more in sync with the higher-versioned Speedster software, which was in the 6.x release sequence).

**Additions:**

• Tasks (see page 262): added several pages describing the ACE help system: Accessing Help (see page 449); added a new page about Detaching Views and Editors (see page 267); added a new page describing Multiprocess Batch Mode (see page 295) (using the new `run_multiprocess` (see page 605) Tcl command), including the new seed sweep functionality  
• ACE Tcl Commands (see page 551): added new command `run_multiprocess` (see page 605)  
• Troubleshooting (see page 628): added a section regarding changing Linux GTK theme and animation settings to affect the render performance as well as the look and feel of the ACE GUI; added a section describing the known (GTK theme-dependent) bug where views/editors may detach (instead of move) while the Help Window is open; added a section about the impacts of Linux resource limits; added a section about the twm Window Manager in Linux; added a section regarding Linux LD_LIBRARY_PATH concerns; added a section about dialogs in the CDE Window Manager

**Updates:**
<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
</table>
| 7.0     | 07 Dec 2018| • Concepts (see page 24): The Floorplanner View (see page 57) has changed the presentation of routing errors (open connections, open pins, and route overflows); the Critical Path Diagram View (see page 49) now has right-click context menu items similar to the other views within the Floorplanner Perspective; the Options View (see page 106) section was updated to match the latest lists of options, but now includes only those options which are common to all target devices – implementation options which are unique to specific libraries or devices will now be documented elsewhere, including within the on-demand Implementation Options Report (see page 242).  
• Tasks (see page 262): The Moving and Docking Views and Editors (see page 266) page and Rearranging Tabbed Views and Editors (see page 267) page have been re-titled and have had their content updated to reflect that Editors can now be moved around just like Views. The user feedback has changed during movement and docking, and the descriptions/tables have been updated accordingly.  
• ACE Tcl Commands (see page 551): added "-verbose" option to add_region_find_insts (see page 553), add_region_insts (see page 553), create_region (see page 560), and remove_region_insts (see page 593); find (see page 570) added "-warning" and "-error" options; run_generate_fullchip_sim (see page 604) added "-modelsdir" option; set_false_path (see page 539) has improved description of various options; add_dd_region_find_insts (see page 553), add_region_insts (see page 553), create_region (see page 560), and remove_region_insts (see page 593) added a new "-clocks_only" option; remove_region_insts (see page 593) added a new "-flops_only" option; run_insert_holdbuffers (see page 604) added a new option "-io_buffers".  
• Troubleshooting: (see page 628): the Linux web browser section has been updated to reflect the change from the Mozilla XulRunner to the WebKitGTK+ HTML browser framework.  
**Removals:**  
• Deleted Concepts and Tasks pages made obsolete by the updated GUI frameworks: "Fast Views", "Opening Perspectives" |
| 7.1     | 27 Mar 2019| Additions:  
• Advanced Concepts (see page 242): added a new page describing ECO Commands (see page 249)  
Updates:  
• Reports (see page 229): updated information on the Implementation Options Report (see page 242) page to improve clarity and accuracy  
• Views (see page 33): added info to the Properties View (see page 127) page covering double-click shortcut gestures and context-menu actions; updated the table of Actions to match the latest functionality on the Projects View (see page 123) page  
• Tasks (see page 262): updated content on the Multiprocess Batch Mode (see page 294) page for improved clarity  
• Troubleshooting (see page 628): removed obsolete content and updated content for new potential problems and workarounds, now that ACE has added official support for GTK3 and WebKit2 (both new as of this release, see new content for technical details)  
**Updates:**
<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
</table>
| 7.2     | 06 Jun 2019| - Tcl Command Reference (see page 526): Updated the descriptions for all SDC Commands (see page 526), and provided/updated usage examples where applicable. To avoid command naming collisions with other tools, updated the names and descriptions for the Interactive Timing Commands (see page 545).  
- Views (see page 33): updated the Netlist Browser view (see page 92) actions table, adding missing actions and updating icons that have changed; updated the Flo orplanner View (see page 57) to mention the new Allow Tooltip toggle checkbox; updated the Critical Paths View (see page 52) to mention the new Show Clock Paths action; updated the Multiprocess view (see page 86) page, updating the screen shot and the text to include the new Seed Sweep functionality; updated the Flow View (see page 67) page, updating the screen shot and icon images to match recent updates.  
- Advanced Concepts (see page 242): updated the ECO Commands (see page 249) section, moving each related dialog into its own page and updating screen shots  
- Troubleshooting (see page 628): updated the section about Themes to explain that ACE will now enforce the usage of the Adwaita theme when running on GTK3.14+ (to maximize performance and stability). |
| 8.0     | 17 Sep 2019| Additions:  
- Concepts (see page 24): added pages for the new I/O Designer Toolkit Views (see page 74) and Generate I/O Ring Design Files Dialog (see page 169).  
- ACE Tcl Commands (see page 551): added new command `generate_soc_design_files` *(renamed `generate_ip_design_files` (see page 572) in the 8.1 release)*.  
Updates:  
- Concepts: The Projects View (see page 123) page removed the obsolete Remove All Projects action and added the new actions to Clone IP and Rename IP.  
- Tasks (see page 262): The Single-Process Incremental Compile Tutorial (see page 384) content has had its formatting tweaked.  
- ACE Tcl Commands (see page 551): The interactive timing command `report_checks` (see page 548) removed the unsupported argument "-input_pins". The interactive timing command `reset_sta` (see page 550) had a typo in the examples. |
| 8.1     | 24 Jan 2020| Additions:  
- Concepts (see page 24): What was previously a single I/O Designer View (with multiple inner tabs) has now been split into multiple independent-but-related views, grouped under the I/O Designer Toolkit Views (see page 74) page. The new pages are for the I/O Core Pin Assignment View (see page 78), I/O Layout Diagram View (see page 80), I/O Package Diagram View (see page 76), I/O Pin Assignment View (see page 77), and I/O Utilization View (see page 75). (As a reminder, these I/O Designer Toolkit views are only relevant for Achronix Speedster7t FPGAs such as the AC7t1500.)  
- Troubleshooting (see page 628): Added a section dealing with the most common symptom of improperly installed device overlays: Unable to initialize reserved module names list.  
Updates:  
- Concepts (see page 24): updated I/O Designer Toolkit Views (see page 74) page with info about cloning and double-clicking. |
<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>ACE Tcl Commands</strong> (see page 551): The command <code>generate_soc_design_files</code> was renamed <code>generate_ip_design_files</code> (see page 572). The command <code>run_unrout e</code> (see page 613) has gained arguments to deal with regions.</td>
</tr>
<tr>
<td>8.1.1</td>
<td>21 Feb 2020</td>
<td>Updates:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>ACE Tcl Commands</strong> (see page 551): The command <code>run_insert_holdbuffers</code> (see page 604) was updated to support a new optional argument: &quot;-typebased_buffers&quot;.</td>
</tr>
<tr>
<td>8.2</td>
<td>17 Jul 2020</td>
<td>Additions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Concepts</strong> (see page 24): Added info about 'Add [copies of] IP to another project...' to Projects View (see page 123). Added info about &quot;active editor highlighting&quot; to I/O Layout Diagram View (see page 80). Added info about 'Remap Port/Signal Name' to I/O Pin Assignment View (see page 77), I/O Core Pin Assignment View (see page 78).</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>ACE Tcl Commands</strong> (see page 551): added new commands: <code>get_fanout</code> (see page 531), <code>run_multiprocess_iterator</code> (see page 606)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Updates:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>ACE Tcl Commands</strong> (see page 551): the <code>run_multiprocess</code> (see page 605) command has a new flag <code>-create_option_sets</code>; the <code>save_placement</code> (see page 615) command can now save placement of just a subset of the design, using the new option <code>-instances</code>; the <code>run_insert_holdbuffers</code> (see page 604) command has a new option <code>-typebased_buffers</code>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Concepts</strong> (see page 24): The Multiprocess Summary Report (see page 240) is now automatically sorted by quality of results, instead of alphabetically. The Multiprocess View (see page 86) (and <code>run_multiprocess</code> (see page 605)) can now optionally generate customized option sets for any chosen template implementation. The Netlist Browser View (see page 92) now has convenience filters to hide instances of the cell types of boundary pins, power, and ground. The Save Placement Dialog (see page 179) can now optionally accept Tcl lists (or Tcl statement that generate lists) of instance names whose placements shall be saved, and can be pre-populated from the Search View (see page 132) and the Selection View (see page 136).</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Tasks</strong> (see page 262): The Single-Process Incremental Compile Tutorial (see page 384) has been updated to improve phrasing/clarity.</td>
</tr>
<tr>
<td>8.3</td>
<td>16 Dec 2020</td>
<td>Additions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Concepts</strong> (see page 24): created a page for the new Create a SecureShare Zip File Dialog (see page 159)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Tasks</strong> (see page 262): created a page for Using the ACE SecureShare Tool to Create a Support Zip File (see page 452)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>ACE Tcl Commands</strong> (see page 551): added <code>get_best_multiprocess_impl</code> (see page 574), <code>report_performance</code> (see page 597),</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Updates:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Concepts</strong> (see page 24): The old &quot;global&quot; option sets have been removed in favor of the improved custom-generated option sets based on design analysis; the Multiprocess View (see page 86) and Active Project and Implementation (see page 223) pages have been updated accordingly. Added more details about Log Files (see page 220) generated during Multiprocess.</td>
</tr>
<tr>
<td>Version</td>
<td>Date</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 8.3.2   | 11 Mar 2021| - **Tasks** (see page 262): Misc clarifications for Multiprocess Batch Mode (see page 295 ), option set updates for the Attempting Likely Optimizations Using Option Sets (see page 369).  
- **ACE Tcl Commands** (see page 551): remove_impl (see page 591) now supports working on a list of imps instead of just a single impl; clarified help text for run_multiprocess (see page 605) and run_multiprocess_iterator (see page 606);  
- **Additions**:  
  - Concepts (see page 24): added a page to describe the new NoC Performance View (see page 98)  
  - **ACE Tcl Commands** (see page 551): added new commands: get_compatible_partitions (see page 574), move_partition process_move_partition, redirect (see page 590)  
- **Updates**:  
  - Concepts (see page 24): Under ACE Verilog Attributes (see page 242), renamed "ace_useioff" to "syn_useioff"; on the Perspectives (see page 24) page described the new NoC Performance Perspective;  
  - **Tasks** (see page 262): The Automatic Flop Pushing into I/O Pads (see page 434) page was updated to use the latest Verilog attributes.  
  - **ACE Tcl Commands** (see page 551): renamed "report_regions" to report_clock_regions (see page 594), the add_project_ip (see page 552) and remove_project_ip (see page 593) commands now require Tcl lists of acxip filenames to improve behavior with paths containing spaces; apply_placement (see page 554) and set_placement (see page 621) now accept partition names (to be used in combination with move_partition); the report_checks (see page 548) command now supports a new option "-unconstrained"; report_impl_options (see page 596) now supports new arguments "-hide_values", "-show_standard", and "-diff_options";  

| 8.5     | 03 Aug 2021| - **Additions**:  
  - **ACE Tcl Commands** (see page 551): Added new commands create_equivalentRegions (see page 558), remove_project_constraints_pvt (see page 592), and untar (see page 625).  
  - Concepts (see page 24): Added a new Advanced Concept description for Fabric Clusters (see page 261).  
- **Updates**:  
  - SmartSupport™ has been renamed SecureShare™, affecting several pages.  
  - The Create Placement Region Dialog (see page 165) concept and Creating a New Placement Region (see page 371) task have been updated to reflect new functionality, allowing (not just instance placement, but also) routing to be restricted to the placement region.  
  - Concepts (see page 24): The NoC Performance View (see page 98) now supports drag-scrolling.  
  - **ACE Tcl Commands** (see page 551):  
    - The get_property (see page 582) command has been updated with a new "-object_type" argument.  
    - The message (see page 588) command now allows console logging support to be toggled on and off. |
The report_checks (see page 548) command now warns that the report generated by this command may include less information than the regular Timing Report.

The restore_project (see page 601) description has been updated for clarity.

The set_clock_type (see page 618) command now supports a new "-batch" argument.

The set_partition_info (see page 620) command arguments and descriptions have been updated for clarity.

The write_bitstream (see page 625) command has new arguments "-max_size" and "-two_stage".

Troubleshooting (see page 628): Commentary regarding now-obsolete/unsupported Windows7 and CentOS6 (along with the associated GTK2 details) have been removed.

Additions:
- ACE Tcl Commands (see page 551): added new commands optimize_tile, reorganize_all_ip_design_files

Updates:
- Lots of pages throughout the document have been updated with very minor edits to improve grammar and clarity of phrasing, as well as fixing typos.
- Concepts (see page 24): The Views (see page 33) page has been updated to note that the view context menu icon used by all Views has changed from a tiny down-arrow to a vertical ellipsis – (most View screenshots have not yet been updated to reflect this icon change).
- ACE Tcl Commands (see page 551): The set_partition_info command gained a new argument -exclusive_placement. The set_placement command gained a new argument -auto_place_neighbors. The run_securshare command removed the argument -no_archive and gained the argument -wizard.

Deletions:
- Removed remaining content regarding the (no longer supported) 22i and 16t IP Configuration Editors.
- Removed remaining content regarding the (no longer supported) JTAG Browser View and JTAG Diagram View.

Additions:
- A new Clusters View (see page 45) has been added to the Floorplanner Perspective.

Updates:
- Concepts (see page 24): The Properties View (see page 127) has gained an action /dialog to Save Changed Properties. The Create Placement Region Dialog (see page 165) has been updated with new groupings for the available Region Alignments and Region Types, with new options for each. The Floorplanner View (see page 57) can now show Cluster information in the tooltips. The NoC Performance View (see page 98) now includes tooltip information reporting the comparative "blocked" and "transferred" percentages for the "trying" times, and includes a brief table describing the Preferences for this view.
### Version 8.7

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
</table>
| 8.7     | 25 May 2022| - Tasks (see page 262): The Creating a New Placement Region (see page 371) page has been updated to show the latest Region Alignment (-snap) and Region Type (-type) choices for the associated dialog.  
- ACE Tcl Commands (see page 551):  
  - The `create_region` (see page 560) command has been updated with new options `-snap [none|tiles|fabric_clusters|clock_regions]` and `-type [inclusive|keepout|soft]. The former `-snap_to*` and `-soft` options are now deprecated.  
  - The `highlight` (see page 586) command has added a new option `-clear`.  
  - The `set_region_bounds` (see page 622) command has added new options `-snap [none|tiles|fabric_clusters|clock_regions]` and `-type [inclusive|keepout|soft]. |

### Version 8.8

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
</table>
| 8.8     | 18 Jul 2022| - Concepts: Added a page for the new `Load Acxdb Dialog` (see page 172). Added a page for the new `NoC Time Slice View` (see page 103). Added a page for the new `Plot SerDes Diagram Dialog` (see page 175). Added a page for the `Configure Clock Pre-Routes Dialog` (see page 153).  
- Tasks: Added a new page for `Cleaning Projects` (see page 282) under `Working with Projects and Implementations` (see page 271). Added a new page for `Plotting SerDes Receiver Diagrams Using JTAG` (see page 456).  
- ACE Tcl Commands: added new commands `add_clock_preroute` (see page 551), `remove_clock_preroute` (see page 591), `save_clock_preroute` (see page 614), `clean_project` (see page 555), `get_compatible_ordering_codes` (see page 574), `get_pvt_corners` (see page 582), `is_labmode` (see page 587), `set_region_type` (see page 623).  
- Note: Early access support for Partial Reconfiguration has been added, relevant documentation will be included in a future release. |

Additions:

- Concepts: The `Netlist Browser View` (see page 92) has three new boolean toggle filters for the Instance Names column for Constants, Duplicates/Clones, and Feedthroughs. The `Clock Regions View` (see page 39), `Clusters View` (see page 45-45), `Partitions View` (see page 115), and `Placement Regions View` (see page 118) now display and allow configuration of Clock Pre-Route information when relevant. The `NoC Performance View` (see page 98) page was updated with the latest changes to the related preferences. The `Floorplanner View Colors and Layers Preference Page` (see page 191) was updated to reflect the Always Show Highlighted Instances option, as well as the latest locations/names of several preferences.  
- Tasks: Updated the `Running ACE` (see page 262) page to reflect the changes to Lab Mode functionality (lab mode now allows a restricted subset of Tcl functionality, specifically the commands necessary for JTAG operations). Added a section describing ACE Startup Arguments to the `Running ACE` (see page 262) page. Updated `Running the Entire Flow` (see page 283) to mention the new `Load Acxdb Dialog` (see page 172) which can appear when a run is canceled.  
- Troubleshooting: Added a new section describing a "Failed to create the part's controls" error message, along with a workaround. Added a new section about font and image scaling (for high resolution/DPI monitors) in Windows. |
<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
</table>
| 9.0     | 10 Feb 2023| **Additions:**

- **Tasks:** Added new section for the Partial Reconfiguration Tutorial (see page 459)(s)
- **ACE Tcl Commands:** Added new commands `get_synprj_from_project` (see page 584), `move_relative_paths` (see page 589), `run_generate_final_reports` (see page 604), `save_partition_placements` (see page 615)

**Updates:**

- **Concepts:** On the Flow Steps (see page 223) page, added the new flow step named 'Generate Final Reports'. Updated Design Completion Steps (see page 226) page to add description for the new flow step 'Generate Final Reports'. Updated Clock Domains View (see page 36), Clock Regions View (see page 39), Clusters View (see page 45), Partitions View (see page 115), and Placement Regions View (see page 118) with refreshed screenshots and descriptions for the new functionality to support Partial Reconfiguration. Updated the Save Placement Dialog (see page 179) page to reflect the latest options.
- **Tasks:** Updated the Multiprocess task page Running Multiple Flows in Parallel (see page 285) to mention node-locked license management; the page previously only mentioned floating license concerns.
- **ACE Tcl Commands:** `add_clock_preroute` (see page 551) has a new argument `-data_region`; `add_project_netlist` (see page 552) and `remove_project_netlist` (see page 593) have a new argument `-impl`; `create_boundary_pins` (see page 558) has a new argument `-purpose`; `find` (see page 570) has improved help text describing pin pattern matching; `get_impl_option` (see page 576) has a new argument `-syn`; the help content for `report_checks` (see page 548) has been tweaked to improve clarity; `report_power` (see page 598) now has added support for saif files; `report_routing` (see page 599) has a new argument `-wl`; `source_encrypted` (see page 624) has a new argument `-untar`; `write_bitstream` (see page 625) has a new argument `-pcie`; `write_partition_db` (see page 627) has a new argument `-include_pr_zone`
- Throughout the document, hyperlinks that point outside the document have been updated to static text to prevent outside content from appearing in the GUI help. Throughout the document, content has been edited to improve clarity and consistency.

**Deletions:**

- **ACE Tcl Commands:** The obsolete `move_partition` command has been removed; use `set_placement -partition` instead.

**Additions:**

- **ACE Tcl Commands:** The `create_region` (see page 560) command has a new `-pr_zone` argument to designate partial reconfiguration zones. The `get_regions` (see page 563) commands has a new `-verbose` argument to print region information. The `load_flowscripts` (see page 587) command has a new `-bitstream` argument to load only those scripts relevant to bitstream manipulations. The `move_partition` command’s arguments have changed.

Deletions:

- **ACE Tcl Commands:** The obsolete `process_move_partition` command has been removed; use `set_placement -partition` instead.

Minor enhancements to document style added throughout.
<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
</table>
| 9.1     | 26 Apr 2023| - **Concepts:** Created a new page describing the Project concept of Port Mapping Files (see page 220) (as used in IO Designer). Created info covering the new I/O Designer Preference Page (see page 200), new Netlist Browser Preference Page (see page 204), and new NoC Performance View Preference Page (see page 204).  
- **ACE Tcl Commands** (see page 551): Added new command `remap_partial_bitstream` (see page 590)  

**Updates:**  
- **Concepts:** Updated the `Save Placement Dialog` (see page 179) page to reflect the latest options. Updated the `Configure Clock Pre-Routes Dialog` (see page 153) to reflect the latest functionality.  
- **Troubleshooting** (see page 628): Removed info related to obsolete versions of Windows. Updated Linux usage directions for the fallback html browser (to improve functionality under Wayland). Updated Windows info related to upgrading ACE and multiple parallel installs of ACE.  
- **ACE Tcl Commands** (see page 551): Updated the arguments for `run_timing_analysis`; Clarified the usage description of `set_partition_force_changed` (see page 620).  
- Throughout the document, content has been edited to improve clarity and consistency.  

**Additions:**  
- **Concepts:** Created a page describing the `Create a New Flow Step dialog` (see page 158). Created a page describing the new Register Browser View (see page 130).  
- **Tasks:** Created a new page Viewing the Captured VCD Waveform (see page 357) to better describe the uses of the VCD Waveform Editor (see page 29). Created a new page describing the creation (and removal) of Custom Flow Steps (see page 306).  

**Updates:**  
- **Concepts:** Updated the `Download View` (see page 55) page to reflect the changes that occurred as the bitstream files migrate from STAPL *.jam files to simpler *.hex files: the lists of procedures and actions are no longer relevant. Updated the `Connect JTAG Connection Preference Page` (see page 187) to remove mentions of the obsolete Bitporter pod, now mentioning the newer Bitporter2 pod and FTDI FT2232H /FT4232H connectivity options. Updated `Save Placement Dialog` (see page 179) page to reflect the latest options, and to ensure the field names in the dialog are consistent with the arguments for the Tcl command `save_placement` (see page 615). Updated the `VCD Waveform Editor` (see page 29) page with the new actions to copy signal name or value to the clipboard, as well as mentioning all the new waveform color and font preferences, with an updated screenshot showing the current default colors and the new signal row highlight color, as well as a new screenshot example showing users how to achieve a green-on-black color configuration (similar to a traditional oscilloscope) using the new color preferences. Updated the `Flow View` (see page 67) page to mention the new per-flow-step error count tracking and filtered error message dialog. Updated the `Projects View` (see page 123) page to include the new context menu actions for report grouping and filtering. Updated the Project Management Preference Page (see page 211) with a new screenshot and descriptions of each available setting. Floorplanner View (see page 57) was updated with a new dedicated Panning Tool, a quick toggle between placement/panning modes, and automatic panning during drag-and-drop operation. F
Version | Date       | Description
--- | --- | ---
9.2 | 27 Oct 2023 | Floorplanner View Colors and Layers Preference Page (see page 191) describes the new "drag scroll" settings. I/O Layout Diagram View (see page 80) now mentions the support for double-click and drag-and-drop operations. The list of supported filters (used in the find (see page 570) and filter (see page 568) Tcl commands, and in the Search View (see page 132)) has been updated on the Filter Properties (see page 246) page.

- Tasks: Updated the Programming a Device (see page 367) page and child pages (Selecting a Bitstream File (see page 367), Selecting Bitstream Programming Options (see page 368), and Downloading the Bitstream to the Target Device (see page 368)) to reflect the changes/simplifications to the Download view's functionality as part of the migration from STAPL *.jam files to *.hex files. Updated the Configuring the JTAG Connection (see page 339) page now that STAPL files, the acx_stapl_player, and the classic Bitporter(1) pod are deprecated, mentioning the replacements instead where relevant. Updated the Snapshot-related Collecting Samples of the User Design (see page 355) page to mention the need for JTAG preferences to be pre-configured before use, and to reflect the migration from using STAPL to the new Tcl jtag:: libraries, and the related impact to manual connection management. Flo orplanner Panning (see page 321) was updated to mention the new Pan/Place toggle behavior, the new dedicated Panning Tool, and the new support for panning during drag-and-drop. The Running ACE (see page 262) page now describes how to use the optional ACE_INIT_SCRIPT functionality.

- Tcl Command Reference (see page 526): The display_file (see page 562) command now supports an optional -search argument. The get_project_netlist_files (see page 582) command supports a new argument -noimpl. The logging command message (see page 588) supports a new argument -none. The report_check (see page 548) command clarified the description of the -sort_by_slack argument. The run_fpga_download (see page 603) command has been updated to work with *.hex files instead of STAPL *.jam files, and no longer produces a separate log file (the standard ACE log file is used instead during the download). The run_timing_analysis (see page 612) command supports new arguments for -voltage and -grade. The set_clock_type (see page 618) command supports a new option -data_column. The write_bitstream (see page 625) command now creates *.hex files instead of STAPL *.jam files.

- Troubleshooting (see page 628): Added a new entry describing how to deal with a rare file cache corruption problem, seen as the symptom NoClassDefFoundError. Tweaked several entries to acknowledge that ACE now supports additional Linux distros/versions beyond RHEL.

- Throughout the document, content has been edited and some screenshots have been updated to improve clarity and consistency.